Cisco MDS 9000 Family
Troubleshooting Guide, Release 3.x

Cisco MDS SAN-OS for Release 3.3(1)

May 2008
CONTENTS

New and Changed Information

Preface

Document Organization

Document Conventions

Related Documentation

Release Notes

Compatibility Information

Regulatory Compliance and Safety Information

Hardware Installation

Cisco Fabric Manager

Command-Line Interface

Troubleshooting and Reference

Installation and Configuration Note

Obtaining Documentation, Obtaining Support, and Security Guidelines

CHAPTER 1

Troubleshooting Overview

Overview of the Troubleshooting Process

Best Practices

Troubleshooting Basics

General Steps

Gathering Information Using Common Fabric Manager Tools and CLI Commands

Common Fabric Manager Tools

Common CLI Commands

Verifying Basic Connectivity

Verifying SAN Element Registration

Fibre Channel End-to-End Connectivity

Fabric Issues

Port Issues

Primary Troubleshooting Flowchart

System Messages

System Message Text

Syslog Server Implementation

Implementing Syslog with Fabric Manager
Recovering the Administrator Password  2-32
Miscellaneous Software Image Issues  2-32
   All Ports Down Because of System Health Failure  2-33
   Switch Reboots after FCIP Reload  2-33
   FCIP Link Fails to Come Up  2-33
   Cannot Create, Modify, or Delete Admin Role  2-34
   FC IDs Change after Link Reset  2-34
   Switch Displays Wrong User  2-34

CHAPTER 3
Managing Storage Services Modules  3-1
   SSM Overview  3-1
   Initial Troubleshooting Checklist  3-3
      Common Troubleshooting Tools in Fabric Manager  3-3
      Common Troubleshooting Commands in the CLI  3-3
   SSM Issues  3-3
      SSM Fails to Boot  3-4
         Upgrading the SSI Image  3-4
         Verifying the SSI Boot Image  3-5
         Using the install ssi Command  3-6
         Recovering a Replacement SSM  3-8
      SSM Upgrade Is Disruptive  3-9
         Installing EPLD Images on Modules  3-9

CHAPTER 4
Troubleshooting Hardware  4-1
   Overview  4-1
      SNMP Traps  4-2
   Troubleshooting Startup Issues  4-2
   Troubleshooting Power Supply Issues  4-3
      All Power Supply LEDs Are Off  4-4
      Power Supply Input Ok LED is Red  4-5
      Power Supply Output Failed LED is On  4-6
      Power Supply Fan Ok LED is Red  4-6
         Troubleshooting the Power Supplies  4-7
   Troubleshooting Fan Issues  4-8
      Fan Is Not Spinning  4-8
      Fan Is Spinning; Fan LED is Red  4-8
         Troubleshooting a Fan Failure Using Device Manager  4-9
         Troubleshooting a Fan Failure Using the CLI  4-10
Contents

Send documentation comments to mdsfeedback-doc@cisco.com

Temperature Threshold Violations 4-11
Troubleshooting Clock Module Issues 4-12
Troubleshooting Other Hardware Issues 4-13
Troubleshooting Supervisor Issues 4-14
  Active Supervisor Reboots 4-15
  Standby Supervisor Not Recognized by Active Supervisor 4-17
    Verifying That a Standby Supervisor Failed to Synchronize Using the CLI 4-17
  Standby Supervisor Stays in Powered-Up State 4-19
    Verifying That a Standby Supervisor Is in the Powered-Up State Using Device Manager 4-20
    Verifying That a Standby Supervisor Is in Powered-Up State Using the CLI 4-20
Troubleshooting Supervisor Modules 4-20
Troubleshooting Switching and Services Modules 4-21
  Overview of Module Status 4-21
  Module Initialization Overview 4-22
    Module Bootup 4-23
    Image Download 4-23
    Runtime Diagnostics 4-24
    Runtime Configuration 4-24
    Online and Operational 4-24
    Analyzing The Logs 4-25
  Troubleshooting Module Issues 4-25
  Troubleshooting Powered-Down Modules 4-26
    Diagnosing a Powered-Down Module 4-28
  Troubleshooting Reloaded Modules 4-31
    Diagnosing a Reloaded Module 4-33
  Troubleshooting Modules in an Unknown State 4-34
    Diagnosing a Module in the Unknown State 4-34
  Troubleshooting Modules Not Detected by the Supervisor 4-35
    Diagnosing a Module Not Detected by the Supervisor 4-35
  Reinitializing a Failed Module Using Fabric Manager 4-36
  Reinitializing a Failed Module Using the CLI 4-37
  Module Resets 4-38

Chapter 5

Troubleshooting Mixed Generation Hardware 5-1
  Overview 5-1
    Port Groups 5-2
    Port Speed Mode 5-3
    Dynamic Bandwidth Management 5-3
    Out-of-Service Interfaces 5-4
Send documentation comments to mdsfeedback-doc@cisco.com

Port Index Availability 5-4
Combining Modules and Supervisors 5-7
Initial Troubleshooting Checklist 5-7
Generation 1 and Generation 2 Issues 5-7
Module Does Not Come Online 5-8
  Verifying Port Index Allocation Using Device Manager 5-8
  Verifying Port Index Allocation Using the CLI 5-9
Cannot Configure Port in Dedicated Mode 5-10
  Verifying Bandwidth Utilization in a Port Group Using Device Manager 5-11
  Verifying Bandwidth Utilization in a Port Group Using the CLI 5-12
Cannot Enable a Port 5-13
Cannot Upgrade Supervisor System Image 5-13
  Selecting the Correct Software Images 5-13

CHAPTER 6
Troubleshooting Licensing 6-1
License Overview 6-1
  Chassis Serial Numbers 6-2
  Grace Period 6-2
Initial Troubleshooting Checklist 6-3
  Displaying License Information Using Fabric Manager 6-3
  Displaying License Information Using Device Manager 6-4
  Displaying License Information Using Fabric Manager Web Client 6-4
  Displaying License Information Using the CLI 6-4
Licensing Installation Issues 6-6
  One-Click License Install Fails or Cannot Connect to Licensing Website 6-6
  Serial Number Issues 6-6
  RMA Chassis Errors or License Transfers Between Switches 6-7
  Receiving Grace Period Warnings After License Installation 6-7
  Incorrect Number of Licenses in Use for Multiple Modules 6-8
  Grace Period Alerts 6-9
  Checking in the Fabric Manager Server License From Device Manager 6-10
  License Listed as Missing 6-11

CHAPTER 7
Troubleshooting Cisco Fabric Services 7-1
Overview 7-1
Initial Troubleshooting Checklist 7-2
  Verifying CFS Using Fabric Manager 7-3
  Verifying CFS Using the CLI 7-3
Contents

Merge Failure Troubleshooting  7-5
  Recovering from a Merge Failure with Fabric Manager  7-6
  Recovering from a Merge Failure with the CLI  7-6

Lock Failure Troubleshooting  7-7
  Resolving Lock Failure Issues Using Fabric Manager  7-7
  Resolving Lock Failure Issues Using the CLI  7-8
  System State Inconsistent and Locks Being Held  7-9
    Clearing Locks Using Fabric Manager  7-9
    Clearing Locks Using the CLI  7-9

Distribution Status Verification  7-9
  Verifying Distribution Using Fabric Manager  7-9
  Verifying Distribution Using the CLI  7-9

CFS Regions Troubleshooting  7-10
  Distribution Failure  7-10
  Regions for Conditional Service  7-11
  Changing Regions  7-11

CHAPTER 8

Troubleshooting Ports  8-1
  Overview  8-1
  Initial Troubleshooting Checklist  8-1
    Limitations and Restrictions  8-4
  Overview of the FC-MAC Driver and the Port Manager  8-4
    Port Manager Overview  8-5
    Troubleshooting Port States with the Device Manager  8-6
      Device View  8-6
      Device Manager: Summary View  8-6
      Device Manager: Port Selection  8-7
      Device Manager: Port Monitoring  8-8
      Isolating Port Issues Using Device Manager  8-9
    Troubleshooting Port States from the CLI  8-10
      Using Port Debug Commands  8-10
      Useful Commands at the FC-MAC Level  8-11
      Isolating Port Issues Using the CLI  8-12
  Common Problems with Port Interfaces  8-13
    Port Remains in a Link Failure or Not Connected State  8-13
      Troubleshooting Port Problems  8-15
    Port Remains in Initializing State  8-16
      Troubleshooting Port Registration Issues Using the CLI  8-17
    Unexpected Link Flapping Occurs  8-21
Link Initialization Flow  8-23
Viewing Port Counters  8-25
Port Bounces Between Initializing and Offline States  8-26
Troubleshooting ELP Issues Using the CLI  8-27
E Port Bounces Remains Isolated After a Zone Merge  8-28
Troubleshooting E port Isolation using Fabric Manager  8-29
Troubleshooting E port Isolation Using the CLI  8-30
Port Cycles Through Up and Down States  8-31
Port Is in ErrDisabled State  8-31
Verifying the ErrDisable State Using the CLI  8-31
Troubleshooting Fx Port Failure  8-32
Overview of Symptoms  8-32

CHAPTER

9

Troubleshooting N-Port Virtualization  9-1
Overview  9-1
Initial Troubleshooting Checklist  9-2
Limitations and Restrictions  9-2
Common CLI Commands for NPV  9-2
Common Problems with NPV  9-4
Moving the Login of an End Device  9-4
NPIV Is Not Enabled  9-5
VSAN Mismatches  9-5
Core NPV Device Is Not a Switch  9-6
NPIV Core Switch Port Is Down  9-6
Server Interface is Down  9-6
Waiting on FLOGI from the Server or Target  9-7
Waiting on External Link to Come Up  9-7

CHAPTER

10

Troubleshooting PortChannels and Trunking  10-1
PortChannel Overview  10-1
Trunking Overview  10-2
Initial Troubleshooting Checklist  10-2
Common Troubleshooting Tools in Fabric Manager  10-2
Common Troubleshooting Commands in the CLI  10-3
PortChannel Issues  10-3
Cannot Configure a PortChannel  10-3
Newly Added Interface Does Not Come Online In a PortChannel  10-4
Configuring Port Channel Modes Using Fabric Manager  10-4
Trunking Issues  10-4
Send documentation comments to mdsfeedback-doc@cisco.com

Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x

Contents

Could not configure Trunking 10-5
VSAN Traffic does not traverse trunk 10-5

Troubleshooting VSANs, Domains, and FSPF 11-1

Overview 11-1
Initial Troubleshooting Checklist 11-1
Common Troubleshooting Tools in Fabric Manager 11-2
Common Troubleshooting Commands in the CLI 11-2
VSAN Issues 11-3
Host Cannot Communicate with Storage 11-3
Verifying VSAN Membership using Fabric Manager 11-4
Verifying VSAN Membership using the CLI 11-4
E Port Is Isolated in a VSAN 11-5
Resolving an Isolated E Port using Fabric Manager 11-6
Resolving an Isolated E Port using the CLI 11-6
Resolving an Isolated ISL using Fabric Manager 11-7
Resolving an Isolated ISL using the CLI 11-7
Resolving Fabric Timer Issues using Fabric Manager 11-9
Resolving Fabric Timer Issues using the CLI 11-9
Troubleshooting Interop Mode Issues 11-9
Dynamic Port VSAN Membership Issues 11-9
Troubleshooting DPVM using Fabric Manager 11-10
Troubleshooting DPVM using the CLI 11-11
DPVM Configuration Not Available 11-11
DPVM Database Not Distributed 11-12
DPVM Autolearn Not Working 11-12
No Autolearn Entries in Active Database 11-13
VSAN Membership Not Added to Database 11-13
DPVM Config Database Not Activating 11-14
Cannot Copy Active to Config DPVM Database 11-14
Port Suspended or Disabled After DPVM Activation 11-15
DPVM Merge Failed 11-15
DPVM Process Terminates 11-16
Disabling DPVM 11-16
Domain Issues 11-17
Domain ID Conflict Troubleshooting 11-17
Switch Cannot See Other Switches in a VSAN 11-18
FC Domain ID Overlap 11-18
Assigning a New Domain ID using Fabric Manager 11-19
Assigning a New Domain ID Using the CLI 11-19
Using Fabric Reconfiguration for Domain ID Assignments 11-20
CFS Distribution of Domain ID List Fails 11-22
Allowed Domain ID List Incorrect After a VSAN Merge 11-23
Changes to fcdomain Do Not Take Effect 11-23
FSPF Issues 11-24
Troubleshooting FSPF 11-24
  Troubleshooting FSPF Using Device Manager 11-25
  Troubleshooting FSPF Using the CLI 11-25
Loss of Two-Way Communication 11-28
  Resolving a Wrong Hello Interval on an ISL Using Device Manager 11-28
  Resolving a Wrong Hello Interval on an ISL Using the CLI 11-29
  Resolving a Mismatched Retransmit Interval on an ISL Using Device Manager 11-30
  Resolving a Mismatched Retransmit Interval on an ISL Using the CLI 11-30
  Resolving a Mismatch in Dead Intervals on an ISL Using Fabric Manager 11-31
  Resolving a Mismatch in Dead Intervals on an ISL Using the CLI 11-31
  Resolving a Region Mismatch Using Fabric Manager 11-32
  Resolving a Region Mismatch Using the CLI 11-32

CHAPTER 12
Troubleshooting SAN Device Virtualization 12-1
Overview 12-1
  Initial Troubleshooting Checklist 12-1
  Debugging and Verifying SDV Configuration Using the CLI 12-2
  SDV Limitations and Restrictions 12-2
  SDV Issues 12-3
    SDV Commit Fails 12-3
    SDV Commit Partially Fails 12-4
    Host Cannot Locate Disk 12-5
    SDV Merge Fails When ISL Comes Up 12-6
    Zone Activation Fails in a SDV Zone 12-6

CHAPTER 13
Troubleshooting IVR 13-1
Overview 13-1
  Configuration Guidelines 13-1
    Transit VSANs 13-2
    Border Switches 13-2
  Limitations and Restrictions 13-2
  Initial Troubleshooting Checklist 13-3
    Verifying IVR Configuration Using Fabric Manager 13-3
Verifying IVR Configuration Using the CLI 13-4
IVR Enhancements by Cisco SAN-OS Release 13-5

IVR Issues 13-6
IVR Licensing Issues 13-6
Cannot Enable IVR 13-7
IVR Network Address Translation Fails 13-8
IVR Zone Set Activation Fails 13-8
Border Switch Fails 13-10
Traffic Does Not Traverse IVR Path 13-11
Link Isolated 13-12
Persistent FC ID for IVR Failed 13-12
LUN Configuration Failure in IVR Zoning 13-13
Host Does Not Have Write Access to Storage 13-13
Locked IVR CFS Session 13-13
CFS Merge Failed 13-14

Troubleshooting the IVR Wizard 13-15
Warning: Not All Switches Are IVR NAT Capable or Are Unmanageable 13-16
Error: The Following Switches Do Not Have Unique Domain IDs 13-16
Error: Pending Action/ Pending Commits 13-17
Error: Fabric Is Changing. Please Retry the Request Later 13-17

CHAPTER 14
Troubleshooting Zones and Zone Sets 14-1

Overview 14-1
Troubleshooting Checklist 14-1
Troubleshooting Zone Configuration Issues with Fabric Manager 14-2
Troubleshooting Zone Configuration Issues with the CLI 14-2

Zone and Zone Set Issues 14-4
Host Cannot Communicate with Storage 14-5
  Resolving Host Not Communicating with Storage Issue Using Fabric Manager 14-5
  Resolving Host Not Communicating with Storage Using the CLI 14-6
Troubleshooting Zone Set Activation 14-8
  Troubleshooting Zone Activation Using Fabric Manager 14-9
  Troubleshooting Zone Activation Using the CLI 14-10
Troubleshooting Full Zone Database Synchronization Across Switches 14-11
  Resolving Out of Sync Full Zone Database Using Fabric Manager 14-11
  Resolving an Out of Sync Full Zone Database Using the CLI 14-11
Mismatched Default Zone Policy 14-12
  Resolving Mismatched Default Zone Policies Using Fabric Manager 14-12
  Resolving Mismatched Default Zone Policies Using the CLI 14-13
Zone Merge Failure 14-13
  Recovering from Link Isolation 14-15
    Resolving a Link Isolation Because of a Failed Zone Merge Using Fabric Manager 14-15
    Resolving a Link Isolation Because of a Failed Zone Merge Using the CLI 14-16
  Mismatched Active Zone Sets Within the Same VSAN 14-17
    Resolving Mismatched Active Zone Sets Within the Same VSAN Using Fabric Manager 14-17
    Resolving Mismatched Active Zone Sets Within the Same VSAN Using the CLI 14-18
  Deactivating a Zone Set and Restarting the Zone Merge Process Using Fabric Manager 14-20
  Deactivating a Zone Set and Restarting the Zone Merge Process Using the CLI 14-20

Enhanced Zoning Issues 14-21
  Resolving Enhanced Zoning Lock Issues with Fabric Manager 14-23
  Resolving Enhanced Zoning Lock Issues with the CLI 14-23

CHAPTER 15
Troubleshooting Distributed Device Alias Services 15-1
  Overview 15-1
    Initial Troubleshooting Checklist 15-1
      Merge Failure Messages 15-2
      Merge Validation Failure Messages 15-2
      Commit Failure Messages 15-3
      Verifying Device Alias Database Status Using the CLI 15-3
      Limitations and Restrictions 15-3
    Merge Failure Issues 15-4
      Resolving Duplicate Device Alias Names 15-5
      Resolving Mapping a pWWN to Different Device Alias Names 15-6
      Resolving Mode Mismatch 15-6
      Resolving Merge Failures in Mixed Fabric 15-7
      Resolving a Validation Failure 15-8
      Resolving Merge in Progress Issues 15-9
    Validation and Commit Failure Issues 15-11
      Resolving Database Conflicts 15-12
      Resolving Application Busy Situations 15-13
      Resolving Database Size Issues 15-14
      Resolving Mode Issues 15-15

CHAPTER 16
Troubleshooting FICON 16-1
  FICON Overview 16-1
    FICON Port Numbering 16-2
      Default FICON Port Numbering Scheme 16-2
      Reserved FICON Port Numbering Scheme 16-4
Send documentation comments to mdsfeedback-doc@cisco.com

FICON Configuration Files 16-5
CUP In-Band Management 16-6
Fabric Binding 16-6

FICON Configuration Requirements 16-6
Initial Troubleshooting Checklist 16-7

Common Troubleshooting Tools in Fabric Manager or Device Manager 16-8
Common Troubleshooting Commands in the CLI 16-8
Port Swapping 16-8
Swapping Ports 16-9

FICON Issues 16-9
Cannot Enable FICON 16-10
Switch ISL Isolated 16-10
Fabric Manager or Device Manager Cannot Configure FICON 16-10
Mainframe Cannot Configure FICON 16-11
Cannot Enable FICON Port 16-11
Cannot Configure FCIP or PortChannel for FICON 16-12
FCIP fails for FICON 16-12
FICON Tape Acceleration Not Working 16-12

Troubleshooting RADIUS and TACACS+ 17-1

AAA Overview 17-1
Initial Troubleshooting Checklist 17-1

Common Troubleshooting Tools in Fabric Manager 17-2
Common Troubleshooting Commands in the CLI 17-2
AAA Issues 17-2
Switch Does Not Communicate with AAA Server 17-2

Verifying RADIUS Configuration Using Fabric Manager 17-4
Verifying RADIUS Configuration Using the CLI 17-4
Verifying TACACS+ Configuration Using Fabric Manager 17-5
Verifying TACACS+ Configuration Using the CLI 17-5
Verifying RADIUS Server Monitor Configuration Using Fabric Manager 17-6
Verifying RADIUS Server Monitor Configuration Using the CLI 17-6
Verifying TACACS+ Server Monitor Configuration Using Fabric Manager 17-7
Verifying TACACS+ Server Monitor Configuration Using the CLI 17-7
User Authentication Fails 17-8

Verifying RADIUS Server Groups Using Fabric Manager 17-9
Verifying RADIUS Server Groups Using the CLI 17-9
Verifying TACACS+ Server Groups Using Fabric Manager 17-9
Verifying TACACS+ Server Groups Using the CLI 17-10
Contents

User Is Not in Any Configured Role  17-10
User Cannot Access Certain Features  17-11
Troubleshooting RADIUS and TACACS+ With Cisco ACS  17-11

CHAPTER  18

Troubleshooting Users and Roles  18-1

Overview  18-1
   User Accounts  18-1
   Role-Based Authorization  18-2
   Rules and Features for Each Role  18-3

Initial Troubleshooting Checklist  18-4
   Common Troubleshooting Tools in Fabric Manager  18-4
   Common Troubleshooting Commands in the CLI  18-4

User and Role Issues  18-4
   User Cannot Log into Switch  18-5
      Verifying User Login with System Messages Using Device Manager  18-5
      Verifying User Login with System Messages Using the CLI  18-6
   User Cannot Create Roles  18-7
   User Cannot Create Other Users With Fabric Manager or Device Manager  18-7
   User Cannot Access Certain Features  18-8
      Verifying Roles Using Device Manager  18-8
      Verifying Roles Using the CLI  18-9
   User Has Too Much Access  18-10
   User Cannot Configure Some VSANs  18-10
      Verifying VSAN-Restricted Roles Using Fabric Manager  18-10
      Verifying VSAN-Restricted Roles Using the CLI  18-11
   User Cannot Configure E Ports  18-11
   Unexpected User Displayed in Logs  18-12

Troubleshooting Users and Roles with Cisco ACS  18-12

CHAPTER  19

Troubleshooting FC-SP, Port Security, and Fabric Binding  19-1

FC-SP Overview  19-1
Port Security Overview  19-2
Fabric Binding Overview  19-2

Initial Troubleshooting Checklist  19-2
   Common Troubleshooting Tools in Fabric Manager  19-3
   Common Troubleshooting Commands in the CLI  19-3

FC-SP Issues  19-4
   Switch or Host Blocked from Fabric  19-4
IP Issues 20-5
- Verifying Basic Connectivity 20-5
  - Verifying Basic Connectivity Using Device Manager 20-5
  - Verifying Basic Connectivity Using the CLI 20-5
- Verification of Switch Connectivity 20-7
  - Verifying Switch Connectivity Using Fabric Manager 20-7
  - Verifying Switch Connectivity Using the CLI 20-7
- Verification of Static IP Routing 20-8
  - Verifying Static IP Routing Using Device Manager 20-8
  - Verifying Static IP Routing Using the CLI 20-8
- Cannot Assign IP Address to an Interface 20-9

FCIP Issues 20-9
- One-to-One FCIP Tunnel Creation and Monitoring 20-10
  - Configuring the First Switch with the CLI 20-10
  - Displaying the Default Values Using the CLI 20-11
  - Setting the Static Route for FCIP Tunnels Using the CLI 20-11
  - Debugging the Configuration of the Second Switch Using the CLI 20-11
  - Displaying the Debug Output from FCIP Tunnel Supervisor Using the CLI 20-13
  - Displaying the Debug Output from the FCIP Tunnel IPS Module Using the CLI 20-14
  - Verifying the Configuration of the Profiles Using the CLI 20-15
  - Verifying the Establishment of the FCIP Tunnel Using the CLI 20-15
  - Verifying the Establishment of Default TCP Connections for Each Configured FCIP Tunnel Using the CLI 20-17
  - Verifying the Statistics of the ASIC Chip on Each Gigabit Ethernet Port Using the CLI 20-17
  - Ethereal Screen Captures of the TCP Connection and FCIP Tunnels 20-18
- One-to-Three FCIP Tunnel Creation and Monitoring 20-20
  - Displaying the Configuration of the First Switch Using the CLI 20-20
  - Creating the FCIP Interface for the Second Tunnel Using the CLI 20-21
- FCIP Profile Misconfiguration Examples 20-21
  - Displaying Incorrect or Nonexistent IP Address for an FCIP Profile Using the CLI 20-21
  - Displaying Configuration Errors When Bringing Up a Tunnel on a Selected Port Using the CLI 20-22
- FCIP Interface Misconfiguration Examples 20-24
  - Displaying FCIP Misconfiguration Examples Using the CLI 20-24
  - Displaying the FCIP Interface as Administratively Shut Down Using the CLI 20-25
  - Displaying the Debug Output from the Second Switch Using the CLI 20-26
  - Displaying Passive Mode Set on Both Sides of the FCIP Tunnel with the CLI 20-27
  - Displaying a Time Stamp Acceptable Difference Failure Using the CLI 20-28
- FCIP Special Frame Tunnel Creation and Monitoring 20-30
  - Configuring and Displaying an FCIP Tunnel with Special Frame Using the CLI 20-31
Special Frame Misconfiguration Example 20-33
Troubleshooting FCIP Link Flaps 20-34
Troubleshooting FCIP ISL Link Failures 20-34
Troubleshooting FCIP and Compression 20-35

iSCSI Issues 20-35
Troubleshooting iSCSI Authentication 20-35
Displaying iSCSI Authentication Using Fabric Manager 20-36
Displaying iSCSI Authentication Using the CLI 20-36
Troubleshooting User Name and Password Configuration 20-37
  Verifying iSCSI User Account Configuration Using Fabric Manager 20-37
  Verifying iSCSI User Account Configuration Using the CLI 20-37
RADIUS Configuration Troubleshooting 20-38
  Verifying RADIUS Key and Port for Authentication and Accounting 20-38
Troubleshooting RADIUS Routing Configuration 20-40
  Displaying the Debug Output for RADIUS Authentication Request Routing Using the CLI 20-40
Troubleshooting Dynamic iSCSI Configuration 20-41
  Checking the Configuration 20-41
  Performing Basic Dynamic iSCSI Troubleshooting 20-41
  Useful Show Commands to Debug Dynamic iSCSI Configuration 20-42
  Virtual Target Access Control 20-43
  Useful Show Commands to Debug Static iSCSI Configuration 20-43

iSCSI TCP Performance Issues 20-48
  CLI Commands Used to Access Performance Data 20-49
  Understanding TCP Parameters for iSCSI 20-49
Lab Setup 20-50
  Configuring from the Bottom Switch Using the CLI 20-50
    Verifying Connectivity Between Client and IPS iSCSI Service 20-51
  TCP Parameter Changes 20-54
    Displaying the Gigabit Ethernet Interface 20-54
    Verifying that the Host Is Configured for High MTU or MSS with the CLI 20-57

iSLB Issues 20-58
  iSLB Configuration Not Distributed to All Switches in the Fabric 20-58
  iSCSI Initiator and Virtual Target Configuration Not Distributed 20-59
  iSLB Configuration, Commit, or Merge Failed—“VSAN ID is Not Yet Configured” 20-59
  iSLB Configuration, Commit, or Merge Failed—“Failed to Allocate WWN” 20-60
  iSLB Configuration, Commit, or Merge Failed—“Duplicate WWN Found as...” 20-60
  iSLB Configuration, Commit, or Merge Failed—“Duplicate Node Name” 20-60
  iSLB Configuration Failed—“Pending iSLB CFS Config Has Reached Its Limit...” 20-61
  iSCSI Disable Failed—“Cannot Disable Iscsi - Large Iscsi Config Present...” 20-61
Send documentation comments to mdsfeedback-doc@cisco.com

iSLB Commit Timeout 20-61
Session Down—“pWWN in Use At Remote Switch” 20-62
Redirected Session Does Not Come Up 20-62
iSLB Zones Not Present in Active Zone Set 20-63
Traffic Description After iSLB Commit or Activation of Zone Set 20-63
VRRP Master Overutilized 20-64
iSLB Zone Set Activation Failed 20-64
iSLB CFS Commit Fails 20-65
Resolving an iSLB Merge Failure 20-65

CHAPTER 21
Troubleshooting IP Access Lists 21-1
Overview 21-1
Protocol Information 21-1
Address Information 21-2
Port Information 21-2
ICMP Information 21-3
ToS Information 21-3
Initial Troubleshooting Checklist 21-4
Common Troubleshooting Tools in Fabric Manager 21-4
Common Troubleshooting Commands in the CLI 21-4
IP-ACL Issues 21-4
All Packets Are Blocked 21-5
Re-creating IP-ACLs Using Fabric Manager 21-5
Re-creating IP-ACLs Using the CLI 21-6
No Packets Are Blocked 21-7
PortChannel Not Working with ACL 21-8
Cannot Remotely Connect to Switch 21-8

CHAPTER 22
Troubleshooting IPsec 22-1
Overview 22-1
IPsec Compatibility 22-1
Supported IPsec and IKE Algorithms for Microsoft Windows and Linux Platforms 22-2
IKE Allowed Transforms 22-3
IPsec Allowed Transforms 22-4
Initial Troubleshooting Checklist 22-4
Common Troubleshooting Tools in Fabric Manager 22-4
Common Troubleshooting Commands in the CLI 22-5
IPsec Issues 22-5
Verifying IKE Configuration Compatibility 22-6
Send documentation comments to mdsfeedback-doc@cisco.com

Verifying IPsec Configuration Compatibility Using Fabric Manager 22-6
Verifying IPsec Configuration Compatibility Using the CLI 22-7
Verifying Security Policy Databases Compatibility 22-8
Verifying Interface Status Using Fabric Manager 22-9
Verifying Interface Status Using the CLI 22-9
Verifying Security Associations 22-12
Security Associations Do Not Re-Key 22-15
Clearing Security Associations 22-15
Debugging the IPsec Process 22-15
Debugging the IKE Process 22-15
Obtaining Statistics from the IPsec Process 22-15

CHAPTER 23
Troubleshooting SANTap 23-1
Overview 23-1
Definitions 23-2
Limitations 23-2
Interface Restrictions 23-3
Initial Troubleshooting Checklist 23-3
Common Troubleshooting Tools in Fabric Manager 23-4
Common Troubleshooting Commands in the CLI 23-4
Messages, Logs and Databases 23-6
SANTap Issues 23-6
Host Login Problems 23-7
ITL Problems 23-7
Common Mismatch Problems 23-7

CHAPTER 24
Troubleshooting Digital Certificates 24-1
Overview 24-1
Digital Certificates 24-1
Certificate Authorities 24-1
RSA Key Pairs and Identity Certificates 24-2
Peer Certificate Verification 24-2
CRLs and OCSP Support 24-2
Import and Export Support for Certificates and Associated Key Pairs 24-2
PKI Enrollment Support 24-2
Maximum Limits 24-3
Initial Troubleshooting Checklist 24-3
Common Troubleshooting Tools in Fabric Manager 24-3
Common Troubleshooting Commands in the CLI 24-4
Digital Certificate Issues 24-4
   CA Will Not Generate Identity Certificate 24-4
   Cannot Export Identity Certificate in PKCS#12 Format 24-5
   Certificate Fails at Peer 24-5
      Configuring Certificates on the MDS Switch Using Fabric Manager 24-5
      Configuring Certificates on the MDS Switch Using the CLI 24-7
   PKI Fails After Reboot 24-10
   Cannot Import Certificate and RSA Key Pairs from Backup 24-10
      Importing Certificate and RSA Key Pairs from Backup Using Fabric Manager 24-11
      Importing Certificate and RSA Key Pairs from Backup Using the CLI 24-11

CHAPTER 25
Troubleshooting Call Home 25-1
   Overview 25-1
      Destination Profiles 25-1
      Alert Groups 25-2
      Customized Alert Group Messages 25-2
      Call Home Message Level Feature 25-2
   Initial Troubleshooting Checklist 25-3
      Common Troubleshooting Tools in Fabric Manager 25-3
      Common Troubleshooting Tools in Device Manager 25-3
      Common Troubleshooting Commands in the CLI 25-3
   Call Home Issues 25-4
      Not Receiving Call Home Alerts 25-4
         Configuring an Alert Group Using Fabric Manager 25-4
         Configuring an Alert Group Using the CLI 25-5
         Configuring the Message Level for a Destination Profile Using Fabric Manager 25-5
         Configuring the Message Level for a Destination Profile Using the CLI 25-5
         Configuring an E-mail Server for Call Home Using Fabric Manager 25-6
         Configuring an E-mail Server for Call Home Using the CLI 25-6
      Not Receiving Call Home Alerts From All Configured Switches 25-6
         Configuring Call Home Contact Information Using Fabric Manager 25-7
         Configuring Call Home Contact Information Using the CLI 25-7
      Receiving Too Many Call Home Alerts 25-8
      Not Receiving Syslog-based Call Home Alerts 25-8
      Periodic Inventory Notification Does Not Reflect Current Inventory 25-9

CHAPTER 26
Troubleshooting Fabric Manager 26-1
   Overview 26-1
   Guidelines 26-2
Contents

Send documentation comments to mdsfeedback-doc@cisco.com

Initial Troubleshooting Checklist 26-2
Common Troubleshooting Tools in Fabric Manager 26-2
Troubleshooting Fabric Manager Issues 26-2
  Cannot Log Into Fabric Manager 26-3
  Cannot Upgrade Fabric Manager 26-3
  The Map Shows Two Switches Where Only One Switch Exists 26-3
  Old Devices Appear on the Map 26-3
  Red Line Through the Switch 26-4
  Dotted Orange Line Through the Switch 26-4
  Fabric Manager Not Receiving Traps 26-4
Tips for Using Fabric Manager 26-4
  Setting the Map Layout So It Stays After Restarting the Fabric Manager 26-4
  Fabric Manager Upgrade Without Losing Map Settings 26-5
  Restrictions When Using Fabric Manager Across FCIP 26-5
  Running Cisco Fabric Manager with Network Multiple Interfaces 26-5
    Specifying an Interface for Fabric Manager Server 26-5
    Specifying an Interface for Fabric Manager Client or Device Manager 26-6
  Configuring a Proxy Server 26-6
  Clearing Topology Maps 26-6
  Using Fabric Manager in a Mixed Software Environment 26-7
Troubleshooting Fabric Manager Web Client 26-7
  Cannot Download Fabric Manager Web Client 26-7
    Allowing network-open Users to Download Fabric Manager Web Client 26-8
    Clearing Java Cache 26-8
  Cannot Access Fabric Manager Web Client 26-8
    Verifying TCP port for Fabric Manager Web Client 26-9
  Cannot Launch Fabric Manager Web Client 26-9
    Enabling the Java Runtime Console 26-10
    Allowing the Java Web Start ActiveX Control to Run 26-10
    Trusting the Remote Fabric Manager Web Site 26-10
    Clearing Java Web Start Cache 26-11
  Cannot Log Into Fabric Manager Web Client 26-11
    Recovering a Web Client Password 26-11
    Setting Fabric Manager Authentication Method 26-12
Troubleshooting Performance Manager 26-12
  Performance Manager Generates Java Error 26-13
  Performance Manager Not Working 26-13
Troubleshooting Device Manager 26-13
  Wrong Version of Device Manager is Launched 26-14
# Contents

**Before Contacting Technical Support**

- Steps to Perform Before Calling TAC
- Copying Files to or from the Switch
- Copying Files Using Device Manager
- Copying Files Using the CLI
- Using Core Dumps
- Setting Up Core Dumps Using the CLI

**Troubleshooting Tools and Methodology**

- Using Cisco MDS 9000 Family Tools
  - Command-Line Interface Troubleshooting Commands
  - CLI Debug
  - FC Ping and FC Traceroute
    - Using FC Ping
    - Using FC Traceroute
  - Monitoring Processes and CPUs
    - Viewing Running Processes on Device Manager
    - Using the show processes CLI Command
    - Viewing CPU Time In Device Manager
    - Using the show processes cpu CLI Command
    - Using the show system resource CLI Command
  - Using On-Board Failure Logging
    - Configuring OBFL for the Switch
    - Configuring OBFL for a Module
    - Displaying OBFL Logs
  - Fabric Manager Tools
    - Fabric Manager and Device Manager
    - Analyzing Switch Device Health
    - Analyzing End-to-End Connectivity
    - Analyzing Switch Fabric Configuration
    - Analyzing the Results of Merging Zones
    - Alerts and Alarms
    - Device Manager: RMON Threshold Manager
  - Fibre Channel Name Service
  - SCSI Target Discovery
  - SNMP and RMON Support
  - Using RADIUS
  - Using Syslog
  - Logging Levels
New and Changed Information

This chapter provides release-specific information for each new and changed troubleshooting guideline for the Cisco MDS SAN-OS Release 3.x software. The Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x is updated to address each new and changed guideline in the Cisco MDS SAN-OS Release 3.x software. The latest version of this document is available at the following Cisco Systems website:

Tip

The troubleshooting guides created for previous releases are also listed in the website mentioned above. Each guide addresses the features introduced in or available in those releases. Select and view the troubleshooting guide pertinent to the software installed in your switch.

To check for additional information about Cisco MDS SAN-OS Release 3.x, refer to the Cisco MDS 9000 Family Release Notes available at the following Cisco Systems website:

Table 1 summarizes the new and changed features for the Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x, and tells you where they are documented. The table includes a brief description of each new feature and the release in which the change occurred.

Note

This updated version of the Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x has been reorganized from earlier versions to better address the most common troubleshooting issues in Cisco SAN-OS Release 3.x.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Changed in Release</th>
<th>Where Documented</th>
</tr>
</thead>
<tbody>
<tr>
<td>SANTap</td>
<td>Not supported in 3.3(1).</td>
<td>3.3(1)</td>
<td>Chapter 23, “Troubleshooting SANTap”</td>
</tr>
<tr>
<td>CFS Regions</td>
<td>Added troubleshooting information for CFS Regions feature.</td>
<td>3.2(1)</td>
<td>Chapter 7, “Troubleshooting Cisco Fabric Services”</td>
</tr>
<tr>
<td>Configuration Limits</td>
<td>Updated configuration limits for Cisco SAN-OS features.</td>
<td>3.2(1)</td>
<td>Appendix C, “Configuration Limits for Cisco MDS SAN-OS Release 3.x”</td>
</tr>
<tr>
<td>Fabric Manager</td>
<td>Updated troubleshooting information for Fabric Manager Web Client.</td>
<td>3.2(1)</td>
<td>Chapter 26, “Troubleshooting Fabric Manager”</td>
</tr>
</tbody>
</table>
**New and Changed Information**

**Table 1  New and Changed Features for Release 3.x (continued)**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Changed in Release</th>
<th>Where Documented</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICON</td>
<td>Updated FICON port numbering information.</td>
<td>3.2(1)</td>
<td>Chapter 16, “Troubleshooting FICON”</td>
</tr>
<tr>
<td>N-Port Virtualization</td>
<td>Added troubleshooting information for NPV.</td>
<td>3.2(1)</td>
<td>Chapter 9, “Troubleshooting N-Port Virtualization”</td>
</tr>
<tr>
<td>SANTap</td>
<td>Added troubleshooting information for SANTap.</td>
<td>3.2(1)</td>
<td>Chapter 23, “Troubleshooting SANTap”</td>
</tr>
<tr>
<td>Device Alias Services</td>
<td>Added troubleshooting information for device aliases.</td>
<td>3.1(2)</td>
<td>Chapter 15, “Troubleshooting Distributed Device Alias Services”</td>
</tr>
<tr>
<td>IP Network Simulator</td>
<td>Added IP Network Simulator as a troubleshooting tool.</td>
<td>3.1(2)</td>
<td>Appendix B, “Troubleshooting Tools and Methodology”</td>
</tr>
<tr>
<td>Nondisruptive upgrades on Cisco MDS 9124 Fabric Switch</td>
<td>Added information about troubleshooting nondisruptive upgrades on the Cisco MDS 9124 Fabric Switch.</td>
<td>3.1(2)</td>
<td>Chapter 2, “Troubleshooting Installs, Upgrades, and Reboots”</td>
</tr>
<tr>
<td>SAN Device Virtualization</td>
<td>Added troubleshooting information for SAN device virtualization.</td>
<td>3.1(2)</td>
<td>Chapter 12, “Troubleshooting SAN Device Virtualization”</td>
</tr>
<tr>
<td>SNMP test traps</td>
<td>Added SNMP test trap information</td>
<td>3.1(2)</td>
<td>Chapter 4, “Troubleshooting Hardware”</td>
</tr>
<tr>
<td>Digital Certificates</td>
<td>Added troubleshooting options for digital certificates.</td>
<td>3.0(1)</td>
<td>Chapter 24, “Troubleshooting Digital Certificates”</td>
</tr>
<tr>
<td>iSCSI Load Balancing</td>
<td>Added troubleshooting options for iSCSI load balancing (iSLB).</td>
<td>3.0(1)</td>
<td>Chapter 20, “Troubleshooting IP Storage Services”</td>
</tr>
<tr>
<td>Mixed Generation Hardware</td>
<td>Added troubleshooting Generation 1 and Generation 2 hardware configuration.</td>
<td>3.0(1)</td>
<td>Chapter 5, “Troubleshooting Mixed Generation Hardware”</td>
</tr>
<tr>
<td>AAA</td>
<td>Added troubleshooting RADIUS and TACACS+.</td>
<td>2.x</td>
<td>Chapter 17, “Troubleshooting RADIUS and TACACS+”</td>
</tr>
<tr>
<td>Call Home</td>
<td>Added troubleshooting for Call Home.</td>
<td>2.x</td>
<td>Chapter 25, “Troubleshooting Call Home”</td>
</tr>
<tr>
<td>FC-SP, port security, fabric binding</td>
<td>Added troubleshooting options for FC-SP, port security, and fabric binding.</td>
<td>2.x</td>
<td>Chapter 19, “Troubleshooting FC-SP, Port Security, and Fabric Binding”</td>
</tr>
<tr>
<td>IP Access Lists</td>
<td>Describes troubleshooting IP Access Control Lists (ACLs).</td>
<td>2.x</td>
<td>Chapter 21, “Troubleshooting IP Access Lists”</td>
</tr>
<tr>
<td>Users and Roles</td>
<td>Added troubleshooting users and roles based access.</td>
<td>2.x</td>
<td>Chapter 18, “Troubleshooting Users and Roles”</td>
</tr>
</tbody>
</table>
Preface

This document is intended to provide guidance for troubleshooting issues that may appear when deploying a storage area network (SAN) using the Cisco MDS 9000 Family of switches. This document introduces tools and methodologies to recognize a problem, determine its cause, and find possible solutions.

Document Organization

This document is organized into the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Troubleshooting Overview</td>
<td>Describes basic concepts, methodology, and tools to use for troubleshooting.</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Troubleshooting Installs, Upgrades, and Reboots</td>
<td>Describes how to identify and resolve problems that might occur when installing, upgrading, or rebooting Cisco MDS 9000 Family hardware.</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Managing Storage Services Modules</td>
<td>Describes how to identify and resolve problems that might occur when installing, replacing, or upgrading storage services modules (SSMs).</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Troubleshooting Hardware</td>
<td>Describes how to identify and resolve problems that might occur when replacing modules, fans, chassis, power supplies or other hardware.</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Troubleshooting Mixed Generation Hardware</td>
<td>Describes procedures used to troubleshoot mixed generation hardware.</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Troubleshooting Licensing</td>
<td>Describes procedures used to troubleshoot licensing issues.</td>
</tr>
<tr>
<td>Chapter 7</td>
<td>Troubleshooting Cisco Fabric Services</td>
<td>Describes procedures used to troubleshoot Cisco Fabric Services (CFS) problems.</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Troubleshooting Ports</td>
<td>Describes how to identify and resolve problems that might occur when using port interfaces.</td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Troubleshooting N-Port Virtualization</td>
<td>Describes how to identify and resolve problems that might occur when using NPV.</td>
</tr>
<tr>
<td>Chapter</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Chapter 10</td>
<td>Troubleshooting PortChannels and Trunking</td>
<td>Describes how to identify and resolve problems that might occur when using PortChannels or trunking.</td>
</tr>
<tr>
<td>Chapter 11</td>
<td>Troubleshooting VSANs, Domains, and FSPF</td>
<td>Describes how to identify and resolve problems that might occur when using Virtual Storage Area Networks (VSANs).</td>
</tr>
<tr>
<td>Chapter 12</td>
<td>Troubleshooting SAN Device Virtualization</td>
<td>Describes how to identify and resolve SAN device virtualization configuration issues.</td>
</tr>
<tr>
<td>Chapter 13</td>
<td>Troubleshooting IVR</td>
<td>Describes how to debug and resolve Inter-VSAN Routing (IVR) configuration issues.</td>
</tr>
<tr>
<td>Chapter 14</td>
<td>Troubleshooting Zones and Zone Sets</td>
<td>Describes how to identify and resolve problems that might occur while implementing zones and zone sets.</td>
</tr>
<tr>
<td>Chapter 15</td>
<td>Troubleshooting Distributed Device Alias Services</td>
<td>Describes how to troubleshoot and resolve problems that might occur when using device aliases.</td>
</tr>
<tr>
<td>Chapter 16</td>
<td>Troubleshooting FICON</td>
<td>Describes procedures to troubleshoot FICON.</td>
</tr>
<tr>
<td>Chapter 17</td>
<td>Troubleshooting RADIUS and TACACS+</td>
<td>Describes procedures to troubleshoot RADIUS and TACACS+.</td>
</tr>
<tr>
<td>Chapter 18</td>
<td>Troubleshooting Users and Roles</td>
<td>Describes procedures to troubleshoot role-based access control.</td>
</tr>
<tr>
<td>Chapter 19</td>
<td>Troubleshooting FC-SP, Port Security, and Fabric Binding</td>
<td>Describes procedures to troubleshoot FC-SP, port security, and fabric binding.</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Troubleshooting IP Storage Services</td>
<td>Describes how to identify and resolve problems that might occur when using IP Services.</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Troubleshooting IP Access Lists</td>
<td>Describes procedures to troubleshoot IP ACLs.</td>
</tr>
<tr>
<td>Chapter 22</td>
<td>Troubleshooting IPsec</td>
<td>Describes procedures used to troubleshoot IP security (IPsec) and Internet Key Exchange (IKE) encryption issues.</td>
</tr>
<tr>
<td>Chapter 23</td>
<td>Troubleshooting SANTap</td>
<td>Describes procedures to troubleshoot SANTap Intelligent Storage Services feature.</td>
</tr>
<tr>
<td>Chapter 24</td>
<td>Troubleshooting Digital Certificates</td>
<td>Describes procedures to troubleshoot IKE digital certificates.</td>
</tr>
<tr>
<td>Chapter 25</td>
<td>Troubleshooting Call Home</td>
<td>Describes procedures to troubleshoot Call Home.</td>
</tr>
<tr>
<td>Chapter 26</td>
<td>Troubleshooting Fabric Manager</td>
<td>Describes procedures used to troubleshoot Fabric Manager.</td>
</tr>
<tr>
<td>Appendix A</td>
<td>Before Contacting Technical Support</td>
<td>Describes the steps to perform before calling for technical support with any Cisco MDS 9000 Family product.</td>
</tr>
</tbody>
</table>
Document Conventions

Command descriptions use these conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface font</strong></td>
<td>Commands and keywords are in boldface.</td>
</tr>
<tr>
<td><em>italic font</em></td>
<td>Arguments for which you supply values are in italics.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Elements in square brackets are optional.</td>
</tr>
<tr>
<td>[ x</td>
<td>y</td>
</tr>
<tr>
<td><strong>string</strong></td>
<td>A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.</td>
</tr>
</tbody>
</table>

Screen examples use these conventions:

| **screen font** | Terminal sessions and information the switch displays are in screen font. |
| **boldface screen font** | Information you must enter is in boldface screen font. |
| **italic screen font** | Arguments for which you supply values are in italic screen font. |
| < >             | Nonprinting characters, such as passwords, are in angle brackets.               |
| [ ]             | Default responses to system prompts are in square brackets. |
| !, #         | An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line. |

This document uses the following conventions:

**Note**

Means reader *take note*. Notes contain helpful suggestions or references to material not covered in the manual.

**Caution**

Means reader *be careful*. In this situation, you might do something that could result in equipment damage or loss of data.
Related Documentation

The documentation set for the Cisco MDS 9000 Family includes the following documents. To find a document online, use the Cisco MDS SAN-OS Documentation Locator at this website: http://www.cisco.com/en/US/docs/storage/san_switches/mds9000/roadmaps/doclocater.htm

For information on IBM TotalStorage SAN Volume Controller Storage Software for the Cisco MDS 9000 Family, refer to the IBM TotalStorage Support website.

Release Notes

- Cisco MDS 9000 Family Release Notes for Cisco MDS SAN-OS Releases
- Cisco MDS 9000 Family Release Notes for Storage Services Interface Images
- Cisco MDS 9000 Family Release Notes for Cisco MDS SVC Releases
- Cisco MDS 9000 Family Release Notes for Cisco MDS 9000 EPLD Images

Compatibility Information

- Cisco MDS 9000 SAN-OS Hardware and Software Compatibility Information
- Cisco MDS 9000 Family Interoperability Support Matrix
- Cisco MDS 9000 Storage Services Module Interoperability Support Matrix
- Cisco MDS SAN-OS Release Compatibility Matrix for IBM SAN Volume Controller Software for Cisco MDS 9000
- Cisco MDS SAN-OS Release Compatibility Matrix for Storage Service Interface Images

Regulatory Compliance and Safety Information

- Regulatory Compliance and Safety Information for the Cisco MDS 9000 Family

Hardware Installation

- Cisco MDS 9124 Multilayer Fabric Switch Quick Start Guide
- Cisco MDS 9500 Series Hardware Installation Guide
- Cisco MDS 9200 Series Hardware Installation Guide
- Cisco MDS 9100 Series Hardware Installation Guide
- Cisco MDS 9020 Fabric Switch Hardware Installation Guide
Send documentation comments to mdsfeedback-doc@cisco.com

Cisco Fabric Manager

- Cisco MDS 9000 Family Fabric Manager Quick Configuration Guide
- Cisco MDS 9000 Family Fabric Manager Configuration Guide
- Cisco MDS 9000 Fabric Manager Online Help
- Cisco MDS 9000 Fabric Manager Web Services Online Help
- Cisco MDS 9000 Family Fabric Manager Database Schema

Command-Line Interface

- Cisco MDS 9000 Family Software Upgrade and Downgrade Guide
- Cisco MDS 9000 Family Storage Services Module Software Installation and Upgrade Guide
- Cisco MDS 9000 Family CLI Quick Configuration Guide
- Cisco MDS 9000 Family CLI Configuration Guide
- Cisco MDS 9000 Family Command Reference
- Cisco MDS 9000 Family Quick Command Reference
- Cisco MDS 9020 Fabric Switch Configuration Guide and Command Reference
- Cisco MDS 9000 Family SAN Volume Controller Configuration Guide

Troubleshooting and Reference

- Cisco MDS 9000 Family Troubleshooting Guide
- Cisco MDS 9000 Family MIB Quick Reference
- Cisco MDS 9020 Fabric Switch MIB Quick Reference
- Cisco MDS 9000 Family SMI-S Programming Reference
- Cisco MDS 9000 Family System Messages Reference
- Cisco MDS 9020 Fabric Switch System Messages Reference

Installation and Configuration Note

- Cisco MDS 9000 Family SSM Configuration Note
- Cisco MDS 9000 Family Port Analyzer Adapter Installation and Configuration Note
- Cisco 10-Gigabit Fibre Channel X2 Transceiver Module Installation Note
Obtaining Documentation, Obtaining Support, and Security Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, security guidelines, and also recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:

Troubleshooting Overview

This chapter introduces the basic concepts, methodology, and general troubleshooting guidelines for problems that may occur when configuring and using the Cisco MDS 9000 Family of multilayer directors and fabric switches.

This chapter includes the following sections:

- Overview of the Troubleshooting Process, page 1-1
- Best Practices, page 1-2
- Troubleshooting Basics, page 1-2
- Primary Troubleshooting Flowchart, page 1-9
- System Messages, page 1-10
- Troubleshooting with Logs, page 1-13
- Contacting Customer Support, page 1-15

Overview of the Troubleshooting Process

To troubleshoot your fabric environment, follow these general steps:

---

**Step 1** Gather information that defines the specific symptoms.

**Step 2** Identify all potential problems that could be causing the symptoms.

**Step 3** Systematically eliminate each potential problem (from most likely to least likely) until the symptoms disappear.

---

To identify the possible problems, you need to use a variety of tools and understand the overall storage environment. For this reason, this guide describes a number of general troubleshooting tools in Appendix B, “Troubleshooting Tools and Methodology,” including those that are specific to the Cisco MDS 9000 Family. This chapter also provides a plan for investigating storage issues. See other chapters in this book for detailed explanations of specific issues.
Best Practices

Best practices are the recommended steps you should take to ensure the proper operation of your fabric. We recommend the following general best practices for most SAN fabrics:

- Maintain a consistent Cisco SAN-OS release across all your Cisco MDS switches.
- Refer to the release notes for your Cisco SAN-OS release for the latest features, limitations, and caveats.
- Enable system message logging. See the “System Messages” section on page 1-10.
- Troubleshoot any new configuration changes after implementing the change.
- Use Fabric Manager and Device Manager to proactively manage your fabric and detect possible problems before they become critical.

Troubleshooting Basics

This section provides a series of questions that may be useful when troubleshooting a problem with a Cisco MDS 9000 Family switch or connected devices. Use the answers to these questions to plan a course of action and to determine the scope of the problem. For example, if a host can only access some, but not all, of the logical unit numbers (LUNs) on an existing subsystem, then fabric-specific issues (such as FSPF, ISLs, or FCNS) do not need to be investigated. The fabric components can therefore be eliminated from possible causes of the problem.

This section contains the following topics:

- General Steps, page 1-2
- Gathering Information Using Common Fabric Manager Tools and CLI Commands, page 1-3
- Verifying Basic Connectivity, page 1-4
- Verifying SAN Element Registration, page 1-5
- Fibre Channel End-to-End Connectivity, page 1-5

General Steps

The two most common symptoms of problems in a storage network are:

- A host cannot access its allocated storage
- An application does not respond after attempting to access the allocated storage

By answering the questions in the following subsections, you can determine the paths you need to follow and the components that you should investigate further. These questions are independent of host, switch, or subsystem vendor.

Answer the following questions to determine the status of your installation:

- Is this a newly installed system or an existing installation? (It could be a new SAN, host, or subsystem, or new LUNs exported to an existing host.)
- Has the host ever been able to see its storage?
- Does the host recognize any LUNs in the subsystem?
- Are you trying to solve an existing application problem (too slow, too high latency, excessively long response time) or did the problem show up recently?
What changed in the configuration or in the overall infrastructure immediately before the applications started to have problems?

To discover a SAN problem, use the following general SAN troubleshooting steps:

**Step 1** Gather information on problems in your fabric. See the “Gathering Information Using Common Fabric Manager Tools and CLI Commands” section on page 1-3.

**Step 2** Verify physical connectivity between your switches and end devices. See the “Verifying Basic Connectivity” section on page 1-4.

**Step 3** Verify registration to your fabric for all SAN elements. See the “Verifying SAN Element Registration” section on page 1-5.

**Step 4** Verify the configuration for your end devices (storage subsystems and servers).

**Step 5** Verify end-to-end connectivity and fabric configuration. See the “Fibre Channel End-to-End Connectivity” section on page 1-5.

---

**Gathering Information Using Common Fabric Manager Tools and CLI Commands**

This section highlights the Fabric Manager tools and CLI commands that are commonly used to troubleshoot problems within your fabric. These tools and commands are a subset of what you may use to troubleshoot your specific problem.

Each chapter in this guide may include additional tools and commands specific to the symptoms and possible problems covered in that chapter.

**Common Fabric Manager Tools**

Use the following navigation paths in Fabric Manager or Device Manager to access common troubleshooting information:

- **Overview of switch status**—In Fabric Manager, click the Switch Health Analysis icon.
- **End-to-end connectivity**—In Fabric Manager, click the End-to-End Connectivity Analysis icon.
- **Fabric configuration**—In Fabric Manager, click the Fabric Configuration Analysis icon.
- **Module status**—In Device Manager, choose Physical > Modules.
- **Cisco SAN-OS version**—In Device Manager, choose Physical > System.
- **View logs**—In Device Manager, choose Logs > FM Server or Logs > Switch Resident.
- **View Fabric Manager events**—In Fabric Manager, click the Events tab at the bottom of the fabric pane.
- **Interface status**—In Fabric Manager, choose Switches > Interfaces and select the port type you are interested in.
- **View name server information**—In Device Manager, choose FC > Name Server.
- **View FLOGI information**—In Fabric Manager, choose Switches > Interfaces > FC Physical > FLOGI.
- **Analyze the results of merging zones**—In Fabric Manager, choose Zone > Merge Analysis.
Send documentation comments to mdsfeedback-doc@cisco.com

- View traffic statistics—in Device Manager, click the Device tab, select one or more ports, right-click and choose Monitoring from the pop-up menu.

Fabric Manager and Device Manager also provide the following tools to proactively monitor your fabric:
- ISL performance—in Fabric Manager, click the ISL Performance icon.
- Network monitoring—in Device Manager, click the Summary tab.
- Performance monitoring—in Fabric Manager, choose Performance > Start Collection.

Common CLI Commands

Issue the following commands and examine the outputs:
- show module
- show version
- show running-config
- show logging log
- show interfaces brief
- show fcns
- show flogi
- show hardware internal errors
- show zoneset active
- show accounting log

Note: Use the show running interface CLI command to view the interface configuration in Cisco SAN-OS Release 3.0(1) or later. The interface configuration as seen in the show running-config CLI command is no longer consolidated.

Note: To issue commands with the internal keyword, you must have an account that is a member of the network-admin group.

Verifying Basic Connectivity

Answer the following questions to verify basic connectivity between your end devices:
- Are you using the correct fiber (SM or MM)?
- Did you check for a broken fiber?
- Is the Fibre Channel port LED on the connected module green, and do the LEDs on any host bus adapter (HBA)/storage subsystem ports indicate normal functionality?
- Is there a LUN masking policy applied on the storage subsystem? If yes, is the server allowed to see the LUNs exported by the storage array?
- Is there a LUN masking policy configured on the host? Did you enable the server to see all the LUNs it can access?
- If LUN masking software is used, is the host’s pWWN listed in the LUN masking database?
Verifying SAN Element Registration

Answer the following questions to verify that your end devices are registered to the fabric:

- Are the HBAs and subsystem ports successfully registered with the fabric name server?
  - In Device Manager, choose FC > Name Server.
  - In the CLI, use the `show fcns` commands.
- Does the correct pWWN for the HBAs and the storage subsystem ports show up on the correct port in the FLOGI database?
  - In Fabric Manager, choose Switches > Interfaces > FC Physical > FLOGI.
  - In the CLI, use the `show flogi` commands.
- Are the HBA and storage subsystem on the same VSAN?
  - In Fabric Manager, choose End Devices and verify the VSAN IDs are identical.
  - From the CLI, use the `show vsan membership` command.
- Does any single zone contain both devices?
  - In Fabric Manager, choose the Zone > Edit Full Zone Database and select the active zone set (in bold) for the VSAN that contains the end devices. Verify that both devices are members of the same zone.
  - From the CLI, use the `show zoneset active` command.

Fibre Channel End-to-End Connectivity

Answering the following questions will help to determine if end-to-end Fibre Channel connectivity exists from a host or subsystem perspective:

- Does the host list the subsystem’s port WWN (pWWN) or FC ID in its logs?
- Does the subsystem list the host’s pWWN or FC ID in its logs or LUN masking database?
- Can the host complete a port login (PLOGI) to the storage subsystem?
- Is there any SCSI exchange that takes place between the server and the disk array?
- Is the HBA configured for N port?

You can use the HBA configuration utilities or the host system logs to determine if the subsystem pWWN or FC ID is listed as a device. This can validate that FSPF is working correctly.

Fabric Issues

Answering the following questions will help to determine the status of the fabric configuration:
Send documentation comments to mdsfeedback-doc@cisco.com

- Are both the HBA and the subsystem port successfully registered with the fabric name server?
- Does the correct pWWN for the server HBA and the storage subsystem port show up on the correct port in the FLOGI database? In other words, is the device plugged into the correct port?
- Does any single zone contain both devices? The zone members can be WWNs or FC IDs.
- Is the zone correctly configured and part of the active configuration or zone set within the same VSAN?
- Do the ISLs show any VSAN isolation?
- Do the host and storage belong to the same VSAN?
- Are any parameters, such as FSPF, static domain assignment, VSAN, or zoning, mismatched in the configuration of the different switches in the fabric?

Port Issues

Initial tasks to perform while investigating port connectivity issues include:
- Verify correct media: copper or optical; single-mode (SM) or multimode (MM).
- Is the media broken or damaged?
- Is the LED on the switch green?
- Is the active LED on the HBA for the connected device on?

Basic port monitoring using Device Manager begins with the visual display in the Device View. (See Figure 1-1.) Port display descriptions include:
- Green box: A successful fabric login has occurred; the connection is active.
- Red X: A small form-factor pluggable (SFP) transceiver is present but there is no connection. This could indicate a disconnected or faulty cable, or no active device connection.
- Red box: An SFP is present but fabric login (FLOGI) has failed. Typically there is a mismatch in port or fabric parameters with the neighboring device. For example, a port parameter mismatch would occur if a node device were connected to a port configured as an E port. An example of a fabric parameter mismatch would be differing timeout values.
- Yellow box: In Device Manager, a port has been selected.
- Gray box: The port is administratively disabled.
- Black box: An SFP is not present.
Device Manager: Summary View

In Device Manager, selecting the Summary View expands the information available for port monitoring. (See Figure 1-2.) The display includes the following:

- VSAN assignment
- For N ports, the port World Wide Name (pWWN) and Fibre Channel ID (FC ID) of the connected device
- For ISLs, the IP address of the connected switch
- Speed
- Frames transmitted and received
- Percentage utilization for the CPU, dynamic memory, and Flash memory

Figure 1-2 Device Manager: Summary View
Device Manager: Port Selection

To drill down for additional port information, use the Device View or Summary View. Select and double-click any port. The initial display shows administrative settings for Mode, Speed, and Status, plus current operational status, failure cause, and date of the last configuration change.

Additional tabs include the following:

- Rx BB Credit—Configure and view buffer-to-buffer credits (BB_credits).
- Other—View PortChannel ID, WWN, and maximum transmission unit (MTU), and configure maximum receive buffer size.
- FLOGI—View FC ID, pWWN, nWWN, BB_credits, and class of service for N port connections.
- ELP—View pWWN, nWWN, BB_credits, and supported classes of service for ISLs.
- Trunk Config—View and configure trunk mode and allowed VSANs.
- Trunk Failure—View the failure cause for ISLs.
- Physical—Configure beaconing; view SFP information.
- Capability—View current port capability for hold-down timers, BB credits, maximum receive buffer size.

Device Manager: Port Monitoring

To display additional details about port traffic, use the Device View or Summary View. In Device View, choose one or more ports, right-click and choose Monitoring from the pop-up menu. In Summary View, choose one or more interfaces, and click the Monitor tool. The initial display shows traffic statistics for the selected interval, including bytes and frames transmitted and received.

Additional tabs include the following:

- Protocol—View protocol-related traffic and error statistics, including link reset counts, offline and non-operational sequence errors, reset protocol errors, and statistics related to buffer-to-buffer flow control.
- Discards—View the number of frames discarded by the port, including Class 2, Class 3, and Class F frames, EISL frames, and totals.
- Link Errors—View the number of link errors, including link failures, signal losses, synchronization failures, invalid transmission words, and delimiter and address identifier errors.
- Frame Errors—View frame error statistics, including the number of frames with invalid CRC, Class 3 frames that were discarded upon reception, FBSY returns for selected situations, and FRJT returns resulting from frame rejection by fabric.
- Class 2 Traffic—View the amount of Class 2 traffic for the selected interval.
- Class 2 Errors—View error statistics for Class 2 traffic, including busy frame responses and port rejects.
- FICON—View FICON error statistics, including pacing, disparity, EOF, OOF, and order sets errors.

Device Manager: Oversubscription Information

Device Manager provides oversubscription information for supported switching modules and line cards. Use the Device View to view an individual module and then right-click to select from the following tasks:
**Send documentation comments to mdsfeedback-doc@cisco.com**

- Configure (enable or disable restrictions on oversubscription ratios and bandwidth fairness)
- Check port group oversubscription (display includes group and ports, port speed, and send and receive speed and includes possible oversubscription indicators)
- Show port resources
- Reset the module

**Note**

Port group oversubscription is supported on 24-port and 48-port 4-Gbps Fibre Channel switching modules, the 32-port 2-Gbps Fibre Channel switching module, the Cisco MDS 9120 20-port 1/2-Gbps Fibre Channel module, and the Cisco MDS 9140 40-port 1/2-Gbps Fibre Channel module.

---

**Primary Troubleshooting Flowchart**

The flowchart in Figure 1-3 shows the overall troubleshooting process. Begin any troubleshooting investigation by checking one of the following four areas:

- Physical port issues
- Physical switch issues
- Fx port issues
- Fabric services

**Figure 1-3  Troubleshooting Process Flowchart**

```
<table>
<thead>
<tr>
<th>Physical port issues</th>
<th>Physical switch issues</th>
<th>Fx port</th>
<th>Fabric services issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port state</td>
<td>Modules up?</td>
<td>FLOGI</td>
<td>Name server</td>
</tr>
<tr>
<td>Hardware</td>
<td>Power</td>
<td>Host HBA</td>
<td>EISL, PortChannel</td>
</tr>
<tr>
<td>Flapping</td>
<td>Environment</td>
<td>Device HBA</td>
<td>VSAN</td>
</tr>
<tr>
<td>Analyze link events</td>
<td>Hardware issues?</td>
<td></td>
<td>Zoning</td>
</tr>
<tr>
<td></td>
<td>Software image issues</td>
<td></td>
<td>FSPF</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Domain Manager</td>
</tr>
</tbody>
</table>
```
System Messages

The system software sends these syslog (system) messages to the console (and, optionally, to a logging server on another system) during operation. Not all messages indicate a problem with your system. Some messages are purely informational, while others might help diagnose problems with links, internal hardware, or the system software.

This section contains the following topics:
- System Message Text, page 1-10
- Syslog Server Implementation, page 1-10
- Implementing Syslog with Fabric Manager, page 1-11
- Implementing Syslog with the CLI, page 1-12

System Message Text

Message-text is a text string that describes the condition. This portion of the message might contain detailed information about the event, including terminal port numbers, network addresses, or addresses that correspond to locations in the system memory address space. Because the information in these variable fields changes from message to message, it is represented here by short strings enclosed in square brackets ([ ]). A decimal number, for example, is represented as [dec].

PORT-3-IF_UNSUPPORTED_TRANSCEIVER: Transceiver for interface [chars] is not supported.

Use this string to find the matching system message in the Cisco MDS 9000 Family System Messages Reference.

Each system message is followed by an explanation and recommended action. The action may be as simple as “No action required.” It may involve a fix or a recommendation to contact technical support as shown in the following example:

**Error Message** PORT-3-IF_UNSUPPORTED_TRANSCEIVER: Transceiver for interface [chars] is not supported.

**Explanation** Transceiver (SFP) is not from an authorized vendor.

**Recommended Action** Enter the show interface transceiver CLI command or similar Fabric Manager/Device Manager command to determine the transceiver being used. Please contact your customer support representative for a list of authorized transceiver vendors.

Syslog Server Implementation

The syslog facility allows the Cisco MDS 9000 Family platform to send a copy of the message log to a host for more permanent storage. This can be useful if the logs need to be examined over a long period of time or when the Cisco MDS switch is not accessible.

This example will demonstrate how to configure a Cisco MDS switch to utilize the syslog facility on a Solaris platform. Although a Solaris host is being used, syslog configuration on all UNIX and Linux systems is very similar.
Syslog uses the concept of a facility to determine how it should be handled on the syslog server (the Solaris system in this example), and the message severity. Therefore, different message severities can be handled differently by the syslog server. They could be logged to different files or e-mailed to a particular user. Specifying a severity determines that all messages of that level and greater severity (lower number) will be acted upon.

Note

The Cisco MDS messages should be logged to a different file from the standard syslog file so that they cannot be confused with other non-Cisco syslog messages. The logfile should not be located on the / file system, to prevent log messages from filling up the / file system.

Syslog Client: switch1
Syslog Server: 172.22.36.211 (Solaris)
Syslog facility: local1
Syslog severity: notifications (level 5, the default)
File to log MDS messages to: /var/adm/MDS_logs

Implementing Syslog with Fabric Manager

To configure system message logging servers, follow these steps:

**Step 1**
In Fabric Manager, choose **Switches > Events > Syslog** in the Physical pane, and then click the **Servers** tab in the Information pane.
In Device Manager, choose **Logs > Syslog > Setup** and click the **Servers** tab in the Syslog dialog box.

**Step 2**
Click the **Create Row** icon in Fabric Manager or **Create** in Device Manager to add a new syslog server.

**Step 3**
Enter the name or IP address in dotted decimal notation (for example, 192.168.2.12) of the syslog server in the **Name or IP Address** field.

**Step 4**
Set the message severity threshold by clicking the **MsgSeverity** radio button, and set the facility by clicking the **Facility** radio button.

**Step 5**
Click **Apply Changes** in Fabric Manager or click **Create** in Device Manager to save and apply your changes.

**Step 6**
If CFS is enabled in Fabric Manager for the syslog feature, click **CFS** to commit these changes to propagate the configuration through the fabric.

Device Manager allows you to view event logs on your local PC as well as those on the switch. For a permanent record of all events that occur on the switch, you should store these messages off the switch. To do this the Cisco MDS switch must be configured to send syslog messages to your local PC and a syslog server must be running on that PC to receive those messages. These messages can be categorized into four classes:

- **Hardware**—Line card or power supply problems
- **Link incidents**—FICON port condition changes
- **Accounting**—User change events
- **Events**—All other events
You should avoid using PCs that have IP addresses randomly assigned to them by DHCP. The switch continues to use the old IP address unless you manually change it; however the Device Manager prompts you if it does detect this situation. UNIX workstations have a built-in syslog server. You must have root access (or run the Cisco syslog server as setuid to root) to stop the built-in syslog daemon and start the Cisco syslog server.

Implementing Syslog with the CLI

To configure a syslog server using the CLI, follow these steps:

**Step 1** Configure the Cisco MDS switch:

```
switch1# config terminal
Enter configuration commands, one per line. End with CNTL/Z.
switch1(config)# logging server 172.22.36.211 6 facility local1
```

To display the configuration:

```
switch1# show logging server
Logging server: enabled
{172.22.36.211}
server severity: notifications
server facility: local1
```

**Step 2** Configure the syslog server:

a. Modify `/etc/syslog.conf` to handle local1 messages. For Solaris, there needs to be at least one tab between the facility.severity and the action (`/var/adm/MDS_logs`).

```
# Below is for the MDS 9000 logging
local1.notice /var/adm/MDS_logs
```

b. Create the log file.

```
# touch /var/adm/MDS_logs
```

c. Restart syslog.

```
# /etc/init.d/syslog stop
# /etc/init.d/syslog start
syslog service starting.
```

d. Verify syslog started.

```
ps -ef | grep syslogd
root  23508  1  0 11:01:41 ?  0:00 /usr/sbin/syslogd
```

**Step 3** Test the syslog server by creating an event on the Cisco MDS switch. In this case, port fc1/2 was bounced and the following was listed on the syslog server. Notice that the IP address of the switch is listed in brackets.

```
# tail -f /var/adm/MDS_logs
Sep 17 11:07:41 [172.22.36.142.2.2] : 2004 Sep 17 11:17:29 pacific: %PORT-5-IF_DOWN_INITIALIZING: %$VSAN 1%$ Interface fc1/2 is down (Initializing)
Sep 17 11:07:49 [172.22.36.142.2.2] : 2004 Sep 17 11:17:36 pacific: %PORT-5-IF_UP: %$VSAN 1%$ Interface fc1/2 is up in mode TE
Sep 17 11:07:51 [172.22.36.142.2.2] : 2004 Sep 17 11:17:39 pacific: %VSHD-5-VSHD_SYSLOG_CONFIG_I: Configuring console from pts/0
(dhcp-171-71-49-125.cisco.com)
```
Troubleshooting with Logs

Cisco SAN-OS generates many types of system messages on the switch and sends them to a syslog server. These messages can be viewed using Fabric Manager or the CLI to determine what events may have led up to the current problem condition you are facing.

This section contains the following topics:

- Viewing Logs with Fabric Manager, page 1-13
- Viewing Logs with the CLI, page 1-13
- Viewing the Log from the Supervisor, page 1-14

Viewing Logs with Fabric Manager

Fabric Manager and Device Manager present concise views of the generated system messages and other logged events:

- In Device Manager, click Logs to set up and view logs.
- In Fabric Manager, select the Logs tab at the bottom of the fabric pane to view log information.
- Learn to use Threshold Manager to alert you that critical statistics have exceeded a set threshold.

Viewing Logs with the CLI

The following CLI commands are available to access and view logs on a switch:

Musky-9506# show logging ?

console Show console logging configuration
info Show logging configuration
last Show last few lines of logfile
level Show facility logging configuration
logfile Show contents of logfile
module Show module logging configuration
monitor Show monitor logging configuration
nvram Show NVRAM log
server Show server logging configuration
<cr> Carriage Return

Example 1-1 shows an example of the show logging CLI command output.

**Example 1-1  show logging Command**

Musky-9506# show logging server
Logging server: enabled
(10.91.51.204)
server severity: critical
server facility: user
Viewing the Log from the Supervisor

You can view system messages from Device Manager if Device Manager is running from the same workstation as the Fabric Manager Server. Choose Logs > Events > current to view the system messages on Device Manager. The columns in the events table are sortable. In addition, you can use the Find button to locate text within the table.

You can view switch-resident logs even if you have not set up your local syslog server or your local PC is not in the switch's syslog server list. Because of memory constraints, these logs will wrap when they reach a certain size. The switch syslog has two logs: an NVRAM log that holds a limited number of critical and greater messages and a nonpersistent log that contains notice or greater severity messages. Hardware messages are part of these logs.

Use the **show logging** CLI command to view the logs on the supervisor.

Viewing NVRAM logs

System messages that are priority 0, 1, or 2 are logged into NVRAM on the supervisor module. After a switch reboots, you can display these syslog messages in NVRAM using the **show logging nvram** CLI command. See Example 1-2.

**Example 1-2  Show logging nvram**

```
switch# show logging nvram
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-PS_OK: Power supply 2 ok (Serial number )
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-PS_FANOK: Fan in Power supply 2 ok
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-FANMOD_FAN_OK: Fan module 1 (Front fan) ok
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-FANMOD_FAN_OK: Fan module 2 (Rear fan) ok
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-CHASSIS_CLKMODOK: Chassis clock module A ok
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-CHASSIS_CLKMODOK: Chassis clock module B ok
2005 Sep 16 13:19:20 172.20.150.82 %PLATFORM-2-CHASSIS_CLKSRC: Current chassis clock source is clock-A
2005 Sep 16 13:19:36 172.20.150.82 %PLATFORM-2-PFM_STDBY_BIOS_STUCK: standby supervisor bios failed
2005 Sep 16 13:20:19 172.20.150.82 %IMAGE_DNLDP-SLOT13-2-IMG_DNLDP_STARTED:  Module image download process. Please wait until completion...
2005 Sep 16 15:44:46 172.20.150.82 %PLATFORM-2-PFM_STDBY_BIOS_STUCK: standby supervisor bios failed
2005 Sep 16 15:44:53 172.20.150.82 %PLATFORM-2-MOD_ALL_PWRDN_NOXBAR: All modules powered down due to non-availability of xbar modules
2005 Sep 16 15:45:41 172.20.150.82 %PLATFORM-2-MOD_PWRUP_XBAR: Modules powered up due to xbar availability
2005 Sep 18 15:12:07 172.20.150.82 %MODULE-2-MOD_FAIL: Initialization of module 14 (serial: JAB092501FC) failed
```
Contacting Customer Support

If you are unable to solve a problem after using the troubleshooting suggestions in this guide, contact a customer service representative for assistance and further instructions. Before you call, have the following information ready to help your service provider assist you as quickly as possible:

- Date you received the switch
- Chassis serial number (located on a label on the right side of the rear panel of the chassis)
- Type of software and release number
- Maintenance agreement or warranty information
- Brief description of the problem
- Brief explanation of the steps you have already taken to isolate and resolve the problem

After you have collected this information, see the “Obtaining Documentation, Obtaining Support, and Security Guidelines” section on page xxxii.

For more information on steps to take before calling Technical Support, see the “Before Contacting Technical Support” section on page A-1.
Troubleshooting Installs, Upgrades, and Reboots

This chapter describes how to identify and resolve problems that might occur when installing, upgrading, or restarting Cisco MDS 9000 Family products.

It includes the following sections:

- **Overview**, page 2-1
- **Guidelines**, page 2-2
- **Disruptive Module Upgrades**, page 2-4
- **Troubleshooting a Nondisruptive Upgrade on a Fabric Switch**, page 2-4
- **Troubleshooting a Nondisruptive Upgrade on a Fabric Switch**, page 2-4
- **Verifying Cisco SAN-OS Software Installations**, page 2-6
- **Troubleshooting Cisco SAN-OS Software Upgrades and Downgrades**, page 2-7
- **Troubleshooting Cisco SAN-OS Software System Reboots**, page 2-13
- **Recovering the Administrator Password**, page 2-32
- **Miscellaneous Software Image Issues**, page 2-32

**Overview**

Each Cisco MDS 9000 switch ships with an operating system (Cisco SAN-OS) that consists of two images—the kickstart image and the system image. There is also a module image if the Storage Services Module (SSM) is present.

Installations, upgrades, and reboots are ongoing parts of SAN maintenance activities. It is important to minimize the risk of disrupting ongoing operations when performing these operations in production environments and to know how to recover quickly when something does go wrong.

**Note**

For documentation purposes, we use the term upgrade in this document. However, upgrade refers to both upgrading and downgrading your switch, depending on your needs.
Guidelines

This section lists general guidelines for performing Cisco SAN-OS software installations, image upgrade and downgrade procedures, and reboots, and it includes the following topics:

- Guidelines for Installations, page 2-2
- Guidelines for Upgrading, page 2-2
- Guidelines for Reboots, page 2-4

Guidelines for Installations

Follow these guidelines when installing Cisco SAN-OS software images:

- Ensure that an FTP or TFTP server is available and can be accessed via the IP address of the default gateway (rather than any other IP address on the defined subnet).
- Use the `show install all impact` CLI command to verify that the new image is healthy and the impact that new load will have on any hardware with regards to compatibility. Check for compatibility.
- Choose `Admin > Show Image Version` in the Device Manager to view information on images in the directories of the MDS file system.

Guidelines for Upgrading

Not all images need to be updated during an upgrade. Use the following checklist to prepare for an upgrade:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy the new Cisco SAN-OS image onto your supervisor modules in bootflash: or slot0:</td>
<td>□</td>
</tr>
<tr>
<td>Save your running configuration to the startup configuration</td>
<td>□</td>
</tr>
<tr>
<td>Backup a copy of your configuration to a remote TFTP server</td>
<td>□</td>
</tr>
<tr>
<td>Schedule your upgrade during an appropriate maintenance window for your fabric</td>
<td>□</td>
</tr>
<tr>
<td>Verify that you have the correct image for your supervisor module type</td>
<td>□</td>
</tr>
<tr>
<td>Verify that no SSM ports are configured in auto mode</td>
<td>□</td>
</tr>
</tbody>
</table>

After you have completed the checklist, you are ready to upgrade the switches in your fabric.

_Note_

It is normal for the active supervisor to become the standby supervisor during an upgrade.

Follow these guidelines when upgrading or downgrading Cisco SAN-OS software images:

- Read the Cisco SAN-OS Release Notes for the release you are upgrading or downgrading to. Cisco SAN-OS Release Notes are available at the following website: http://cisco.com/en/US/products/ps5989/prod_release_notes_list.html
- Ensure that an FTP or TFTP server is available.
Copy the startup-config to a snapshot config in NVRAM. This step creates a backup copy of the startup-config.

- In Device Manager, Choose Admin > Copy Configuration and select the startupConfig radio button for the From: field and the serverFile radio button for the To: field. Set the other fields, and click Apply.
- From the CLI, use the `copy nvram:startup-config nvram-snapshot-config` command.

Where possible, choose to do a nondisruptive upgrade. In general, you can nondisruptively upgrade to Cisco SAN-OS Release 3.x software from any Cisco SAN-OS software Release 2.x or later.

- Review the upgrade table in the Cisco SAN-OS Release Notes for the version you will be installing.
- Use the `show install all impact upgrade-image` CLI command to determine if your upgrade will be nondisruptive.

Establish a PC serial connection to each supervisor console to record upgrade activity to a file. This serial connection catches any error messages or problems during bootup.

In Fabric Manager, choose Tools > Other > Software Install or click the Software Install icon on the toolbar to use the Software Install Wizard.

From the CLI, use the `install all [{asm-sfn | kickstart | ssi | system} URL]` command to run a complete script, test the images, and verify the compatibility with the hardware. See the “Installing Cisco SAN-OS Software from the CLI” section on page 2-11. Using the `install all` command offers the following advantages:

- You can upgrade the entire switch using the least disruptive procedure with just one command.
- You can receive descriptive information on the intended changes to your system before you continue with the command.
- You have the option to cancel the command. Once the effects of the command are presented, you can continue or cancel when you see this question (the default is no):
  
  Do you want to continue (y/n) [n] : y

- You can view the progress of this command on the console, Telnet, and SSH screens.
- The image integrity is automatically checked, including the running kickstart and system images.
- The command performs a platform validity check to verify that a wrong image is not used. For example, the command verifies that an MDS 9500 Series image is not used inadvertently to upgrade an MDS 9200 Series switch.
- After issuing the `install all` command, if any step in the sequence fails, the command completes the step in progress and ends.

  For example, if a switching module fails to be updated for any reason (for example, due to an unstable fabric state), then the command sequence disruptively updates that module and ends. In such cases, you can verify the problem on the affected switching module and upgrade the other switching modules.

- If you run the setup script after issuing a write erase CLI command, you must set the default zone policy for VSAN 1 after the setup script completes. In Fabric Manager, choose Fabricxx > VSAN 1 > Default Zone, select the Policies tab and set the Default Zone Behavior drop-down menu to permit or deny. In the CLI, use the `zone default-zone` command.
Cisco SAN-OS allows for three different types of system restarts:

- **Recoverable**—A process restarts and service is not affected.
- **Unrecoverable**—A process has restarted more than the maximum restart times within a fixed period of time (seconds) and will not be restarted again.
- **System hung/crashed**—No communications of any kind is possible with the system.

Schedule the reboot to avoid possible disruption of services during critical business hours.

Log messages are not saved across system reboots. However, a maximum of 100 log messages with a severity level of critical and below (levels 0, 1, and 2) are saved in NVRAM. You can view this log at any time with the `show logging nvram` CLI command.

Disruptive Module Upgrades

Software upgrades for the SSM, MPS-14/2, MSM-18/4 module, or the IP Storage (IPS) services modules are disruptive. These modules use a rolling upgrade install mechanism where the modules are upgraded in sequence. After the first module upgrade finishes, and before the next module upgrade begins, Cisco SAN-OS introduces a time delay to ensure that all applications in the module reach a steady state. The IPS modules require a five-minute delay before the next IPS module upgrade can guarantee a stable state.

SSM supports nondisruptive upgrades for the Layer 1 and Layer 2 protocols under the following conditions:

- SSM is running Cisco SAN-OS Release 2.1(2) or later and upgrading to a later release.
- The SSM hardware has the ELPD image for Release 2.1(2) installed. Use the `show version module <module number> epld` CLI command, and verify that the epld version is 0x07 or later.
- You have turned off all Layer 3 services on the SSM by deprovisioning the DPPs for Layer 3 service.

Troubleshooting a Nondisruptive Upgrade on a Fabric Switch

When a nondisruptive upgrade begins, the system notifies all services that an upgrade is about to start, and finds out whether or not the upgrade can proceed. If a service cannot allow the upgrade to proceed at this time (for example, FSPF timers are not configured to the default value, or a CFS operation is in progress), then the service will abort the upgrade. If this occurs, you will be prompted to enter the `show install all failure-reason` command to determine the reason why the upgrade cannot proceed.

Do you want to continue with the installation (y/n)?  [n]  y

Install is in progress, please wait.

Notifying services about the upgrade.

[0% -- FAIL. Return code 0x401E0066 (request timed out)].

Please issue "show install all failure-reason" to find the cause of the failure.

Install has failed. Return code 0x401E0066 (request timed out).
Please identify the cause of the failure, and try 'install all' again.

```
switch# show install all failure-reason
Service: "cfs" failed to respond within the given time period.
switch#
```

If there are any failures for whatever reason (a save runtime state failure or linecard upgrade failure) once the upgrade is already in progress, then the switch will be rebooted disruptively because the changes cannot be rolled back. In such cases the upgrade has failed; you are not prompted to enter the `show install all failure-reason` command, and entering it will not yield any useful information.

If you need additional assistance to determine why an upgrade is unsuccessful, collect the details from the `show tech-support` command output and the console output from the installation, if available.

## Troubleshooting Fabric Manager Installations

This section describes possible problems and solutions for a Fabric Manager installation failure. Fabric Manager requires that the appropriate version of Sun JAVA JRE be installed, based on the Fabric Manager release. Table 2-1 shows the recommended JRE for Fabric Manager 2.x and later releases.

### Table 2-1 Fabric Manager and Recommended JRE Version

<table>
<thead>
<tr>
<th>Fabric Manager Release</th>
<th>Recommended JRE Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0(1b) through 2.1(1b)</td>
<td>1.4.2_05</td>
</tr>
<tr>
<td>2.1(2) through 3.3(1)</td>
<td>1.5.x</td>
</tr>
</tbody>
</table>

1. Release 3.3(1) includes support for JRE version 1.6.

Fabric Manager and Device Manager do not operate properly with JRE 1.4.2_03 on Windows 2003.

### Symptom

Fabric Manager or Device Manager will not start.

### Table 2-2 Fabric Manager or Device Manager Will Not Start

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Manager will not start.</td>
<td>Device Manager proxied through Fabric Manager Server.</td>
<td>Uncheck the Proxy SNMP through FM Server check box in the Device Manager startup dialog box, and restart Device Manager.</td>
</tr>
</tbody>
</table>
Verifying Cisco SAN-OS Software Installations

In Fabric Manager you can watch the progress of your software installation using the Software Install Wizard. From the CLI you can use the `show install all status` command to watch the progress of your software installation.

You can also use the `show install all status` CLI command to view the on-going `install all` command or the log of the last installed `install all` command from a console, SSH, or Telnet session.

This command presents the `install all` output on both the active and standby supervisor module even if you are not connected to the console terminal. It only displays the status of an `install all` command that is issued from the CLI (not the GUI). See Example 2-1.

### Example 2-1 install all Command Output

```
switch# show install all status
There is an on-going installation...  ---------- in progress installation
Enter Ctrl-C to go back to the prompt.
Verifying image bootflash:/b-1.3.0.104
  -- SUCCESS
Verifying image bootflash:/i-1.3.0.104
  -- SUCCESS
Extracting "system" version from image bootflash:/i-1.3.0.104.
  -- SUCCESS
Extracting "kickstart" version from image bootflash:/b-1.3.0.104.
  -- SUCCESS
Extracting "loader" version from image bootflash:/b-1.3.0.104.
  -- SUCCESS
switch# show install all status
This is the log of last installation.  ---------- log of last install
Verifying image bootflash:/b-1.3.0.104
  -- SUCCESS
```

### Table 2-2 Fabric Manager or Device Manager Will Not Start

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fabric Manager will not start.</td>
<td>Using incorrect Fabric Manager Server.</td>
<td>Verify that you are choosing the appropriate Fabric Manager Server from the FMServer pull-down menu. If you have not already done so, download Fabric Manager Server.</td>
</tr>
<tr>
<td>Fabric Manager Server not running.</td>
<td>On a Windows PC, click Start &gt; Control Panel &gt; Administrative Tools &gt; Services to verify that Fabric Manager Server and Fabric Manager database have started. The default setting for the Fabric Manager Server is that the server is automatically started when the PC is rebooted.</td>
<td></td>
</tr>
<tr>
<td>Incompatible JRE version.</td>
<td>Verify that you have the correct JRE version installed for the Fabric Manager release you installed. Refer to the release notes for the software version you installed to determine which JRE version is compatible.</td>
<td></td>
</tr>
<tr>
<td>Improperly installed.</td>
<td>If the problem remains, then remove the application using the Cisco MDS 9000/Uninstall program, then reinstall Fabric Manager.</td>
<td></td>
</tr>
</tbody>
</table>

Verifying Cisco SAN-OS Software Installations

In Fabric Manager you can watch the progress of your software installation using the Software Install Wizard. From the CLI you can use the `show install all status` command to watch the progress of your software installation.

You can also use the `show install all status` CLI command to view the on-going `install all` command or the log of the last installed `install all` command from a console, SSH, or Telnet session.

This command presents the `install all` output on both the active and standby supervisor module even if you are not connected to the console terminal. It only displays the status of an `install all` command that is issued from the CLI (not the GUI). See Example 2-1.
Troubleshooting Cisco SAN-OS Software Upgrades and Downgrades

This section discusses possible causes and solutions for a software installation upgrade or downgrade failure. It includes the following symptoms:

- Software Installation Reports an Incompatibility, page 2-7
- Software Installation Ends with Error, page 2-9

Software Installation Reports an Incompatibility

**Symptom**  The software installation reports an incompatibility.

<table>
<thead>
<tr>
<th>Table 2-3</th>
<th>Software Installation Report Incompatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>The software installation reports an incompatibility.</td>
<td>The running image may have a feature enabled that is not compatible with the proposed new image.</td>
</tr>
</tbody>
</table>

Diagnosing Compatibility Issues

To view the results of a dynamic compatibility check, use the `show incompatibility system bootflash:filename` CLI command.

Use the `show incompatibility` CLI command for diagnosis when the `install all` CLI command warns of compatibility issues.

During an attempted upgrade, the `install all` CLI command may return the following warning:

Warning: The startup config contains commands not supported by the system image; as a result, some resources might become unavailable after an install.

Do you wish to continue? (y/ n) [y]: n
Use the `show incompatibility` CLI command to identify the problem.

Message 1 indicates that the remote SPAN (RSPAN) feature is in use, but it is not supported by the image that was installed. The incompatibility is strict because continuing the upgrade might cause the switch to move into an inconsistent state—that is, configured features might stop working.

```
switch# show incompatibility system bootflash:new-image
The following configurations on active are incompatible with the system image
1) Feature Index : 67 , Capability : CAP_FEATURE_SPAN_FC_TUNNEL_CFG
   Description : SPAN - Remote SPAN feature using fc-tunnels
   Capability requirement : STRICT
```

Message 2 indicates that the Fibre Channel tunnel feature is not supported in the new image. The RSPAN feature uses Fibre Channel tunnels.

```
2) Feature Index : 119 , Capability : CAP_FEATURE_FC_TUNNEL_CFG
   Description : fc-tunnel is enabled
   Capability requirement : STRICT
```
# Software Installation Ends with Error

**Symptom**  The software installation ends with an error.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The installation ends with an error.</td>
<td>The standby supervisor module bootflash: file system does not have sufficient space to accept the updated image.</td>
<td>Remove unnecessary files from the filesystem. In Device Manager, choose <strong>Admin &gt; Flash Files</strong> and delete unnecessary files. From the CLI, use the <code>delete</code> command.</td>
</tr>
<tr>
<td>The specified system and kickstart images are not compatible.</td>
<td></td>
<td>Check the output of the installation process for details on the incompatibility. Possibly update the kickstart image before updating the system image.</td>
</tr>
<tr>
<td>The <strong>install all</strong> command is issued on the standby supervisor module.</td>
<td></td>
<td>Issue the command on the active supervisor module only.</td>
</tr>
<tr>
<td>A module was inserted while the upgrade was in progress.</td>
<td></td>
<td>Restart the installation. See the “Installing SAN-OS Software Using Fabric Manager” section on page 2-10 or the “Installing Cisco SAN-OS Software from the CLI” section on page 2-11.</td>
</tr>
<tr>
<td>The fabric or switch was configured while the upgrade was in progress.</td>
<td></td>
<td>Wait until the upgrade is complete before configuring the switch. In Device Manager, choose <strong>Admin &gt; CFS</strong> or from the CLI, use the <code>show cfs lock</code> command to check that there are no CFS commit operations in progress.</td>
</tr>
<tr>
<td>The switch experienced a power disruption while the upgrade was in progress.</td>
<td></td>
<td>Restart the installation. See the “Installing SAN-OS Software Using Fabric Manager” section on page 2-10 or the “Installing Cisco SAN-OS Software from the CLI” section on page 2-11.</td>
</tr>
<tr>
<td>Incorrect software image path specified.</td>
<td></td>
<td>Specify the entire path for the remote location accurately.</td>
</tr>
<tr>
<td>Another installation is already in progress.</td>
<td>Verify the state of the switch at every stage and restart the installation after 10 seconds. If you restart the installation within the 10-second span, the command is rejected with an error message indicating that an installation is currently in progress.</td>
<td></td>
</tr>
<tr>
<td>Module failed to upgrade.</td>
<td>Restart the installation. See the “Installing SAN-OS Software Using Fabric Manager” section on page 2-10 or the “Installing Cisco SAN-OS Software from the CLI” section on page 2-11. Or, use the <strong>install module</strong> CLI command to upgrade the failed module.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting Cisco SAN-OS Software Upgrades and Downgrades

Send documentation comments to mdsfeedback-doc@cisco.com

Installing SAN-OS Software Using Fabric Manager

To use the Software Install Wizard to install a new software image using Fabric Manager, follow these steps:

---

Step 1  Open the Software Install Wizard by clicking its icon in the toolbar (see Figure 2-1).

Figure 2-1  Software Install Wizard Icon

---

You see the Software Install Wizard.

Step 2  Select the switches you want to install images on. You must select at least one switch in order to proceed. Click Next.

Step 3  Optionally, check the Skip Image Download check box and click Next to use images that are already downloaded (the file is already on the bootflash: file system). Proceed to Step 7.

Step 4  Click the row under the System, Kickstart, Asm-sfn, or ssi columns to enter image URIs. You must specify at least one image for each switch to proceed.

Step 5  Check the active (and standby, if applicable) bootflash: file system on each switch to see if there is enough space for the new images. You can see this information in the Flash Space column.

This screen shows the active (and standby, if applicable) bootflash: memory space on each switch, and shows the status (whether there is enough space for the new images). If any switch has insufficient space, you cannot proceed. Deselect the switch without enough bootflash: memory by going back to the first screen and unchecking the check box for that switch.

Step 6  Click Next. You see the Select Download Image screen.

Step 7  Double-click the table cell under System, Kickstart, Asm-sfn, or Ssi and select from a drop-down list of images available in the bootflash: file system on each switch. You must select at least one image for each switch to proceed.

---

Note  There is no limit on the number of switches you can upgrade. However, the upgrade is a serial process; that is, only a single switch is upgraded at a time.

---

Step 8  Click Next. You see the final verification screen.

Step 9  Click Finish to start the installation or click Cancel to leave the installation wizard without installing new images.

---

Note  On hosts where the TFTP server cannot be started, a warning is displayed. The TFTP server may not start because an existing TFTP server is running or because access to the TFTP port 69 has been denied for security reasons (the default setting on LINUX). In these cases, you cannot transfer files from the local host to the switch.
Troubleshooting Cisco SAN-OS Software Upgrades and Downgrades

Chapter 2  Troubleshooting Installs, Upgrades, and Reboots

Send documentation comments to mdsfeedback-doc@cisco.com

Before exiting the session, be sure that the upgrade process is complete. The wizard displays status messages as the upgrade proceeds. Check the lower-left-hand corner of the wizard for the status messages. First, the wizard displays the message Success followed a few seconds later by InProgress Polling. Then the wizard displays a second message Success before displaying the final Upgrade Finished.

Installing Cisco SAN-OS Software from the CLI

To perform an automated software upgrade on any switch from the CLI, follow these steps:

**Step 1** Log into the switch through the console, Telnet, or SSH port of the active supervisor.

**Step 2** Create a backup of your existing configuration file, if required.

**Step 3** Perform the upgrade by issuing the `install all` command.

The example below demonstrates upgrading from SAN-OS 2.0(2b) to 2.1(1a) using the `install all` command with the source images located on a SCP server.

```
Tip
Always carefully read the output of `install all` compatibility check. This compatibility check tells you exactly what needs to be upgraded (BIOS, loader, firmware) and what modules are not hitless. If there are any questions or concerns about the results of the output, select n to stop the installation and contact the next level of support.
```

c-9506# install all system scp://testuser@dino/tftpboot/rel/qa/2_1_1a/final/m9500-sf1ek9-mz.2.1.1a.bin kickstart scp://testuser@dino/tftpboot/rel/qa/2_1_1a/final/m9500-sf1ek9-kickstart-mz.2.1.1a.bin

For scp://testuser@dino, please enter password:
For scp://testuser@dino, please enter password:

Copying image from scp://testuser@dino/tftpboot/rel/qa/2_1_1a/final/m9500-sf1ek9-kickstart-mz.2.1.1a.bin to bootflash:///m9500-sf1ek9-kickstart-mz.2.1.1a.bin.
[####################] 100% -- SUCCESS

Copying image from scp://testuser@dino/tftpboot/rel/qa/2_1_1a/final/m9500-sf1ek9-mz.2.1.1a.bin to bootflash:///m9500-sf1ek9-mz.2.1.1a.bin.
[####################] 100% -- SUCCESS

Verifying image bootflash:///m9500-sf1ek9-kickstart-mz.2.1.1a.bin
[####################] 100% -- SUCCESS

Verifying image bootflash:///m9500-sf1ek9-mz.2.1.1a.bin
[####################] 100% -- SUCCESS

Extracting "slc" version from image bootflash:///m9500-sf1ek9-mz.2.1.1a.bin.
[####################] 100% -- SUCCESS

Extracting "ips" version from image bootflash:///m9500-sf1ek9-mz.2.1.1a.bin.
[####################] 100% -- SUCCESS

Extracting "svlc" version from image bootflash:///m9500-sf1ek9-mz.2.1.1a.bin.
[####################] 100% -- SUCCESS

Extracting "system" version from image bootflash:///m9500-sf1ek9-mz.2.1.1a.bin.
Troubleshooting Cisco SAN-OS Software Upgrades and Downgrades

Chapter 2 Troubleshooting Installs, Upgrades, and Reboots

Send documentation comments to mdsfeedback-doc@cisco.com

Extracting "kickstart" version from image bootflash:///m9500-sf1ek9-kickstart-mz.2.1.1a.bin.

Extracting "loader" version from image bootflash:///m9500-sf1ek9-kickstart-mz.2.1.1a.bin.

Compatibility check is done:

<table>
<thead>
<tr>
<th>Module</th>
<th>Bootable</th>
<th>Impact</th>
<th>Install-type</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>yes</td>
<td>non-disruptive</td>
<td>rolling</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>yes</td>
<td>non-disruptive</td>
<td>rolling</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>yes</td>
<td>disruptive</td>
<td>rolling</td>
<td>Hitless upgrade is not supported</td>
</tr>
<tr>
<td>4</td>
<td>yes</td>
<td>disruptive</td>
<td>rolling</td>
<td>Hitless upgrade is not supported</td>
</tr>
<tr>
<td>5</td>
<td>yes</td>
<td>non-disruptive</td>
<td>reset</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>yes</td>
<td>non-disruptive</td>
<td>reset</td>
<td></td>
</tr>
</tbody>
</table>

Images will be upgraded according to following table:

<table>
<thead>
<tr>
<th>Module</th>
<th>Image</th>
<th>Running-Version</th>
<th>New-Version</th>
<th>Upg-Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>slc</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>1</td>
<td>bios</td>
<td>v1.1.0(10/24/03)</td>
<td>v1.1.0(10/24/03)</td>
<td>no</td>
</tr>
<tr>
<td>2</td>
<td>bios</td>
<td>v1.1.0(10/24/03)</td>
<td>v1.1.0(10/24/03)</td>
<td>no</td>
</tr>
<tr>
<td>3</td>
<td>ips</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>3</td>
<td>bios</td>
<td>v1.1.0(10/24/03)</td>
<td>v1.1.0(10/24/03)</td>
<td>no</td>
</tr>
<tr>
<td>4</td>
<td>svccl</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>4</td>
<td>svcscb</td>
<td>1.3(5m)</td>
<td>1.3(5m)</td>
<td>no</td>
</tr>
<tr>
<td>4</td>
<td>svcscb</td>
<td>1.3(5m)</td>
<td>1.3(5m)</td>
<td>no</td>
</tr>
<tr>
<td>4</td>
<td>bios</td>
<td>v1.1.0(10/24/03)</td>
<td>v1.1.0(10/24/03)</td>
<td>no</td>
</tr>
<tr>
<td>5</td>
<td>system</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>5</td>
<td>kickstart</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>5</td>
<td>bios</td>
<td>v1.1.0(10/24/03)</td>
<td>v1.1.0(10/24/03)</td>
<td>no</td>
</tr>
<tr>
<td>5</td>
<td>loader</td>
<td>1.2(2)</td>
<td>1.2(2)</td>
<td>no</td>
</tr>
<tr>
<td>6</td>
<td>system</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>6</td>
<td>kickstart</td>
<td>2.0(2b)</td>
<td>2.1(1a)</td>
<td>yes</td>
</tr>
<tr>
<td>6</td>
<td>bios</td>
<td>v1.1.0(10/24/03)</td>
<td>v1.1.0(10/24/03)</td>
<td>no</td>
</tr>
<tr>
<td>6</td>
<td>loader</td>
<td>1.2(2)</td>
<td>1.2(2)</td>
<td>no</td>
</tr>
</tbody>
</table>

Do you want to continue with the installation (y/n)?  [n]  

y

Install is in progress, please wait.

Syncing image bootflash:///m9500-sf1ek9-kickstart-mz.2.1.1a.bin to standby.

Setting boot variables.

Performing configuration copy.

Module 5: Waiting for module online.
Step 4

Exit the switch console and open a new terminal session to view the upgraded supervisor module using the `show module` command.

If the configuration meets all guidelines when the `install all` command is issued, all modules (supervisor and switching) are upgraded.

---

**Troubleshooting Cisco SAN-OS Software System Reboots**

This section lists possible problems and solutions for software reboots and includes the following topics:

- Power On or Switch Reboot Hangs, page 2-13
- Corrupted Bootflash Recovery, page 2-14
- Recovery Using BIOS Setup for Supervisor-1, page 2-16
- Recovery from the `loader>` Prompt on Supervisor-2 Modules, page 2-19
- Recovery from the `loader>` Prompt on Supervisor-1 Modules, page 2-20
- Recovery from the `switch(boot)#` Prompt, page 2-21
- Recovery for Switches with Dual Supervisor Modules, page 2-22
- Recognizing Error States, page 2-25

**Power On or Switch Reboot Hangs**

### Symptom

Power on or switch reboot hangs.

### Table 2-5 Power-on or Switch Reboot Hangs

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power on or switch reboot hangs for dual supervisor configuration.</td>
<td>The bootflash is corrupted.</td>
<td>See the “Recovery for Switches with Dual Supervisor Modules” section on page 2-22.</td>
</tr>
<tr>
<td>Power on or switch reboot hangs for single supervisor configuration.</td>
<td>The loader is corrupted.</td>
<td>Interrupt the boot process and reconfigure the BIOS through the console port to load a new kickstart image that updates to BIOS image. See the “Recovery Using BIOS Setup for Supervisor-1” section on page 2-16.</td>
</tr>
</tbody>
</table>
Corrupted Bootflash Recovery

All switch configurations reside in the internal bootflash. If you have a corrupted internal bootflash you could potentially lose your configuration. Be sure to save and back up your configuration files periodically. The regular switch boot goes through the following sequence (see Figure 2-2):

1. The basic input/output system (BIOS) loads the loader.
2. The loader loads the kickstart image into RAM and starts the kickstart image.
3. The kickstart image loads and starts the system image.
4. The system image reads the startup configuration file.

If the images on your switch are corrupted and you cannot proceed (error state), you can interrupt the switch boot sequence and recover the image by entering the BIOS configuration utility described in the following section. Access this utility only when needed to recover a corrupted internal disk.

Caution

The BIOS changes explained in this section are required only to recover a corrupted bootflash.
Recovery procedures require the regular sequence to be interrupted. The internal switch sequence goes through four phases between the time you turn on the switch and the time the switch prompt appears on your terminal—BIOS, boot loader, kickstart, and system. (See Table 2-6 and Figure 2-3.)

### Table 2-6 Recovery Interruption

<table>
<thead>
<tr>
<th>Phase</th>
<th>Normal Prompt</th>
<th>Recovery Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIOS</td>
<td>loader&gt;</td>
<td>No bootable device</td>
<td>The BIOS begins the power-on self test, memory test, and other operating system applications. While the test is in progress, press Ctrl-C to enter the BIOS configuration utility and use the netboot option.</td>
</tr>
<tr>
<td>Boot loader</td>
<td>Starting kickstart</td>
<td>loader&gt;</td>
<td>The boot loader uncompresses loaded software to boot an image using its file name as reference. These images are made available through bootflash. When the memory test is over, press Esc to enter the boot loader prompt.</td>
</tr>
<tr>
<td>Kickstart</td>
<td>Uncompressing system</td>
<td>switch(boot)#</td>
<td>When the boot loader phase is over, press Ctrl-[3] (Control key plus right bracket key) to enter the switch(boot)# prompt. If the corruption causes the console to stop at this prompt, copy the system image and reboot the switch.</td>
</tr>
<tr>
<td>System</td>
<td>Login:</td>
<td>–</td>
<td>The system image loads the configuration file of the last saved running configuration and returns a switch login prompt.</td>
</tr>
</tbody>
</table>

1. This prompt or message appears at the end of each phase.
2. This prompt or message appears when the switch cannot progress to the next phase.
3. Depending on your Telnet client, these keys may be reserved, and you need to remap the keystroke. Refer to the documentation provided by your Telnet client.

### Figure 2-3 Regular and Recovery Sequence

Regular sequence:
- **Power on**
- **1 BIOS**
- **2 Bootloader**
- **3 Kickstart image**
- **4 System image**
- Access switch

Interrupt regular sequence:
- **Power on**
- **Ctrl-C**
- **No bootable device**
- **Esc**
- **Starting kickstart**
- **CTRL-[3]**
- Uncompressing image
- Access switch

Recovery:
- BIOS configuration
- Hanging state
- loader> prompt
- Hanging state
- Switch (boot)# prompt
- Power on and Ctrl-C
- Power on and Esc
- System image
Chapter 2  Troubleshooting Installs, Upgrades, and Reboots

Send documentation comments to mdsfeedback-doc@cisco.com

Recovery Using BIOS Setup for Supervisor-1

Note
Supervisor-2 modules do not provide access to the BIOS.

Caution
This procedure uses the init system command, which reformats the file system of the device. Be sure that you have made a backup of the configuration files before you begin this procedure.

To recover a corrupted bootflash: device (no bootable device found message) for a switch with a single supervisor-1 module, follow these steps:

Step 1 Connect to the console port of the required switch.
Step 2 Boot or reboot the switch.
Step 3 Press Ctrl-C to interrupt the BIOS setup during the BIOS memory test.

You see the netboot BIOS Setup Utility screen. (See Figure 2-4.)

Figure 2-4  BIOS Setup Utility

Note
Your navigating options are provided at the bottom of the screen.

Tab = Jump to next field
Ctrl-E = Down arrow
Ctrl-X = Up arrow
Ctrl-H = Erase (Backspace might not work if your terminal is not configured properly.)
Chapter 2  Troubleshooting Installs, Upgrades, and Reboots

Troubleshooting Cisco SAN-OS Software System Reboots

Send documentation comments to mdsfeedback-doc@cisco.com

Step 4  Press the Tab key to select the Basic CMOS Configuration.

You see the System BIOS Setup - Basic CMOS Configuration screen. (See Figure 2-5.)

**Figure 2-5  BIOS Setup Configuration (CMOS)**

```
----------------------------------------------------------
| System BIOS Setup - Basic CMOS Configuration           |
| (C) 2002 General Software Inc. All rights reserved     |
----------------------------------------------------------
| SERIAL PORT PARAMETERS:                                |
| Baud Rate:     9600                                     |
| Data Width:    8-bit                                    |
| Stop Bits:     1                                        |
| Parity:        None                                     |
| Flow Control:  None                                    |
| Date:          Dec 01, 2002                              |
| Time:          00: 01: 03                                |
| Show "Hit Del": Enabled                                |
| Config Box:    Enabled                                 |
| FI Error Wait: Enabled                                 |
| Boot 1st:      Bootflash                                |
| Boot 2nd:      TFTP                                    |
| Memory Test Tier: Enabled                              |
| Debug Breakpoints: Enabled                             |
| Debugger Hex Case: Upper                              |
| Memory Test:   StdLo FastHi                            |

Local IP Address : 000.000.000.000
Subnet Mask : 255.255.255.000
Default GW IP Address : 000.000.000.000
TFTP Server IP Address : 000.000.000.000
Filename: E/*/<CR>/<Tab> to select, <SPACE>/+- to modify, "H to backspace
<Esc> to return to main menu
```

Step 5  Change the Boot 1st: field to TFTP.

Step 6  Press the Tab key until you reach the Local IP Address field.

Step 7  Enter the local IP address for the switch, and press the Tab key.

Step 8  Enter the subnet mask for the IP address, and press the Tab key.

Step 9  Enter the IP address of the default gateway, and press the Tab key.

Step 10 Enter the IP address of the TFTP server, and press the Tab key.

Step 11 Enter the image name (kickstart), and press the Tab key. Use the full directory path from the TFTP server root directory.

**Caution**
The file name must be entered exactly as it is displayed on your TFTP server. For example, if you have a file named MDS9500-kickstart_mzg.10, then enter this name using the exact uppercase characters and file extensions as shown on your TFTP server.
You see the configured changes. (See Figure 2-6.)

**Figure 2-6 BIOS Setup Configuration (CMOS) Changes**

<table>
<thead>
<tr>
<th>System BIOS Setup - Basic CMOS Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERIAL PORT PARAMETERS:</td>
</tr>
<tr>
<td>Baud Rate: 9600</td>
</tr>
<tr>
<td>Data Width: 8-bit</td>
</tr>
<tr>
<td>Stop Bits: 1</td>
</tr>
<tr>
<td>Parity: None</td>
</tr>
<tr>
<td>Flow Control: None</td>
</tr>
<tr>
<td>Date: Dec 01, 2002</td>
</tr>
<tr>
<td>Time: 00 : 07 : 29</td>
</tr>
<tr>
<td>Show &quot;Hit Del&quot;: Enabled</td>
</tr>
<tr>
<td>Config Box: Enabled</td>
</tr>
<tr>
<td>FI Error Wait: Enabled</td>
</tr>
<tr>
<td>Local IP Address : 172.016.001.002</td>
</tr>
<tr>
<td>Subnet Mask: 255.255.255.000</td>
</tr>
<tr>
<td>Default GW IP Address : 172.016.001.001</td>
</tr>
<tr>
<td>TFTP Server IP Address : 172.016.010.100</td>
</tr>
<tr>
<td>Filename: /MD3500-kickstart_mz0_10</td>
</tr>
</tbody>
</table>

\^E/\^N/<CR>/<Tab> to select, <SPACE>/+/− to modify, \^H to backspace
\^Esc> to return to main menu

**Step 12** Press the Esc key to return to the main menu.

**Step 13** Choose **Write to CMOS and Exit** from the main screen to save your changes.

**Note** These changes are saved in the CMOS.

**Caution** The switch must have IP connectivity to reboot using the newly configured values.

You see the following prompt:

```
switch(boot)#
```

**Step 14** Enter the **init system** command at the switch(boot)# prompt, and press Enter to reformat the file system.

```
switch(boot)# init system
```

**Note** The **init system** command also installs a new loader from the existing (running) kickstart image.

**Caution** Be sure that you have made a backup of the configuration files before you issue this command.

**Step 15** Follow the procedure specified in the “Recovery from the switch(boot)# Prompt” section on page 2-21.
Recovery from the loader> Prompt on Supervisor-2 Modules

---

**Caution**
This procedure uses the `init system` command, which reformats the file system of the device. Be sure that you have made a backup of the configuration files before you begin this procedure.

The `loader>` prompt is different from the regular `switch#` prompt.
- The CLI command completion feature does not work at this prompt and may result in undesired errors. You must type the command exactly as you want the command to appear.
- The ICMP stack is not supported, so you cannot ping the TFTP server.
- The TFTP server must be configured with the IP address of the default gateway (rather than any other IP address on the defined subnet).

---

**Tip**
Use the `help` command at the `loader>` prompt to display a list of commands available at this prompt or to obtain more information about a specific command in that list.

---

To recover a corrupted kickstart image (system error state) for a switch with a single supervisor module, follow these steps:

---

**Step 1**
Enter the local IP address for the switch at the `loader>` prompt, and press `Enter`.

```bash
loader> net --ip=172.16.1.2
```

**Step 2**
Specify the subnet mask.

```bash
loader> net --nm=255.255.255.0
```

**Step 3**
Specify the IP address of the default gateway.

```bash
loader> net --gw=172.16.1.1
```

**Step 4**
Boot the kickstart image file from the required server.

```bash
loader> boot tftp://172.16.10.100/m9500-kickstart-3.0.bin
```

In this example, 172.16.10.100 is the IP address of the TFTP server, and m9500-kickstart-3.0.bin is the name of the kickstart image file that exists on that server.

The `switch(boot)#` prompt indicates that you have a usable Kickstart image.

**Step 5**
Issue the `init system` command at the `switch(boot)#` prompt.

```bash
switch(boot)# init system
```

---

**Caution**
Be sure that you have made a backup of the configuration files before you issue this command.

---

**Step 6**
Follow the procedure specified in the “Recovery from the switch(boot)# Prompt” section on page 2-21.
Recovery from the loader> Prompt on Supervisor-1 Modules

**Caution**

This procedure uses the `init system` command, which reformats the file system of the device. Be sure that you have made a backup of the configuration files before you begin this procedure.

The `loader>` prompt is different from the regular `switch#` prompt.

- The CLI command completion feature does not work at this prompt and may result in undesired errors. You must type the command exactly as you want the command to appear.
- The ICMP stack is not supported, so you cannot ping the TFTP server.
- The TFTP server must be configured with the IP address of the default gateway (rather than any other IP address on the defined subnet).

**Tip**

Use the `help` command at the `loader>` prompt to display a list of commands available at this prompt or to obtain more information about a specific command in that list.

To recover a corrupted kickstart image (system error state) for a switch with a single supervisor module, follow these steps:

**Step 1** Enter the local IP address and the subnet mask for the switch at the `loader>` prompt, and press Enter.

```
loader> ip address 172.16.1.2 255.255.255.0
```

```
Found Intel EtherExpressPro100 82559ER at 0xe800, ROM address 0xc000
Probing...[Intel EtherExpressPro100 82559ER]Ethernet addr: 00:05:30:00:52:27
Address: 172.16.1.2
Netmask: 255.255.255.0
Server: 0.0.0.0
Gateway: 0.0.0.0
```

**Step 2** Specify the IP address of the default gateway.

```
loader> ip default-gateway 172.16.1.1
```

```
Address: 172.16.1.2
Netmask: 255.255.255.0
Server: 0.0.0.0
Gateway: 172.16.1.1
```

**Step 3** Boot the kickstart image file from the required server.

```
loader> boot tftp://172.16.10.100/kickstart-image1
```

```
Address: 172.16.1.2
Netmask: 255.255.255.0
Server: 172.16.10.100
Gateway: 172.16.1.1
Booting: /kick-282 console=ttyS0,9600n8nn quiet loader_ver= "2.1(2)"....
............................................Image verification OK
Starting kernel...
INIT: version 2.78 booting
Checking all filesystems..... done.
Loading system software
INIT: Sending processes the TERM signal
Sending all processes the TERM signal... done.
Sending all processes the KILL signal... done.
Entering single-user mode...
INIT: Going single user
INIT: Sending processes the TERM signal
switch(boot)#
```
Send documentation comments to mdsfeedback-doc@cisco.com

Step 4 Issue the `init system` command at the `switch(boot)#` prompt.

```
switch(boot)# init system
```

**Caution** Be sure that you have made a backup of the configuration files before you issue this command.

Step 5 Follow the procedure specified in the “Recovery from the switch(boot)# Prompt” section on page 2-21.

---

**Recovery from the switch(boot)# Prompt**

To recover a system image using the kickstart image for a switch with a single supervisor module, follow these steps:

Step 1 Change to configuration mode.

```
switch(boot)# config t
switch(boot)(config)#
```

Step 2 Follow this step if you issued an `init system` command. Otherwise, skip to Step 3.

a. Issue the `ip default-gateway` command to configure the IP address of the default gateway.

```
switch(boot)(config)# ip default-gateway 209.165.200.226
```

b. Configure the IP address of the mgmt0 interface.

```
switch(boot)(config)# interface mgmt 0
switch(boot)(config-if)# ip address 209.165.200.227 255.255.255.0
```

Step 3 Issue the `no shutdown` command to enable the mgmt0 interface on the switch.

```
switch(boot)(config-mgmt0)# no shutdown
```

Step 4 Enter `end` to exit to EXEC mode.

```
switch(boot)(config-mgmt0)# end
```

Step 5 If you believe there are file system problems, issue the `init system checkfilesystem` command. As of Cisco MDS SAN-OS Release 2.1(1a), this command checks all internal file systems and fixes any errors that are encountered. This command takes considerable time to complete.

```
switch(boot)# init system checkfilesystem
```

Step 6 Copy the system image from the required TFTP server.

```
switch(boot)# copy tftp://172.16.10.100/system-image1 bootflash:system-image1
```

Step 7 Copy the kickstart image from the required TFTP server.

```
switch(boot)# copy tftp://172.16.10.100/kickstart-image1 bootflash:kickstart-image1
```

Step 8 Verify that the system and kickstart image files are copied to your bootflash: file system.

```
switch(boot)# dir bootflash:
46080  Nov 11 21:48:55 2008 lost+found/
14753280 Nov 11 21:39:49 2008 kickstart-image1
78473925 Nov 11 21:37:12 2008 system-image1
```
Usage for `bootflash://sup-local`
107465728 bytes used
78619648 bytes free
186085376 bytes total

**Step 9**  Load the system image from the `bootflash: files` system.

```
switch(boot)# load bootflash:system-image1
Uncompressing system image: bootflash:/system-image1
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC
Would you like to enter the initial configuration mode? (yes/no): yes
```

**Note**  If you enter **no**, you will return to the `switch#` login prompt, and you must manually configure the switch.

**Step 10**  Log in to the switch using the password configured in **Step 9**.

```
switch login: admin
Password:
```

Cisco Storage Area Networking Operating System (SAN-OS) Software
TAC support: http://www.cisco.com/tac
Copyright (c) 2002-2008, Cisco Systems, Inc. All rights reserved.
The copyrights to certain works contained herein are owned by other third parties and are used and distributed under license.
Some parts of this software may be covered under the GNU Public License or the GNU Lesser General Public License. A copy of each such license is available at
http://www.gnu.org/licenses/gpl.html and
http://www.gnu.org/licenses/lgpl.html

```
switch#
```

**Step 11**  Configure the boot variable.

```
switch #config t
switch(config)#boot kickstart bootflash:kickstart-image1
switch(config)#boot system bootflash:system-image1
switch(config)#end
switch#
```

**Step 12**  Save the configuration.

```
switch# copy running-config startup-config
[################################################] 100%
switch#
```

---

**Recovery for Switches with Dual Supervisor Modules**

This section describes how to recover when one or both supervisor modules in a dual supervisor switch have corrupted bootflash.
Recovering One Supervisor Module With Corrupted Bootflash

If one supervisor module has functioning bootflash and the other has corrupted bootflash, follow these steps:

**Step 1**  Boot the functioning supervisor module and log on to the switch.

**Step 2**  At the switch# prompt on the booted supervisor module, issue the reload module slot force-dnld command, where slot is the slot number of the supervisor module with the corrupted bootflash.

The supervisor module with the corrupted bootflash performs a netboot and checks the bootflash for corruption. When the bootup scripts discover that the bootflash is corrupted, it generates an init system command, which fixes the corrupt bootflash. The supervisor boots as the HA Standby.

**Caution**  If your system has an active supervisor module currently running, you must issue the system standby manual-boot command in EXEC mode on the active supervisor module before issuing the init system command on the standby supervisor module to avoid corrupting the internal bootflash. After the init system command completes on the standby supervisor module, issue the system no standby manual-boot command in EXEC mode on the active supervisor module.
Recovering Both Supervisor Modules With Corrupted Bootflash

If both supervisor modules have corrupted bootflash, follow these steps:

**Step 1**
Boot the switch and press the **Esc** key after the BIOS memory test to interrupt the boot loader.

**Note**
Press **Esc** immediately after you see the following message:

```
00000589K Low Memory Passed
00000000K Ext Memory Passed
Hit ^C if you want to run SETUP....
Wait....
```

If you wait too long, you will skip the boot loader phase and enter the kickstart phase.

You see the **loader>** prompt.

**Caution**
The **loader>** prompt is different from the regular **switch#** or **switch(boot)#** prompt. The CLI command completion feature does not work at this prompt and may result in undesired errors. You must type the command exactly as you want the command to appear.

**Tip**
Use the **help** command at the **loader>** prompt to display a list of commands available at this prompt or to obtain more information about a specific command in that list.

**Step 2**
Specify the local IP address and the subnet mask for the switch.

```
loader> ip address 172.16.1.2 255.255.255.0
```

**Step 3**
Specify the IP address of the default gateway.

```
loader> ip default-gateway 172.16.1.1
```

**Step 4**
Boot the kickstart image file from the required server.

```
loader> boot tftp://172.16.10.100/kickstart-latest
```

Booting: /kick-282 console=ttyS0,9600n8nn quiet loader_ver= "2.1(2)"....

Starting kernel...
INIT: version 2.78 booting
Checking all filesystems..... done.
Loading system software
INIT: Sending processes the TERM signal
Sending all processes the TERM signal... done.
Sending all processes the KILL signal... done.
Entering single-user mode...
INIT: Going single user
INIT: Sending processes the TERM signal
switch(boot)#

The switch(boot)# prompt indicates that you have a usable Kickstart image.

**Step 5** Issue the **init-system** command to repartition and format the bootflash.

**Step 6** Perform the procedure specified in the “Recovery from the switch(boot)# Prompt” section on page 2-21.

**Step 7** Perform the procedure specified in the “Recovering One Supervisor Module With Corrupted Bootflash” section on page 2-23 to recover the other supervisor module.

---

**Note**

If you do not issue the **reload module** command when a boot failure has occurred, the active supervisor module automatically reloads the standby supervisor module within 3 to 6 minutes after the failure.

---

## Recognizing Error States

If you see one or both of the error messages displayed in Figure 2-7 or Figure 2-8, follow the procedure specified in the “Recovery Using BIOS Setup for Supervisor-1” section on page 2-16.

**Figure 2-7 Error State if Powered On and Ctrl-C Is Entered**

```plaintext
System BIOS Configuration, (C) 2002 General Software, Inc.

System CPU : Pentium III  | Low Memory  : 638MB
L2 Cache      : Enabled     | Extended Memory : 957MB
Embedded BIOS Date : 03/10/02 | Adaptec Shadowing : Enabled

Boot network name is EDBC
Local IP address: 127.1.2.1

Bind to network device '/dev/TCPIP/EDBC/BootNet'
Could not bind to the network '/dev/TCPIP/EDBC/BootNet'
Could not get BOOTP response from the server.
BOOTNET: Dispatch duration could not be restored, reason=1.
Network boot failed, status=31?

No bootable device available.
A - REBOOT
S - SETUP
ESC - BIOS DEBUGGER
```
Switch or Process Resets

When a recoverable or nonrecoverable error occurs, the switch or a process on the switch may reset.

**Symptom**  The switch or a process on the switch reset.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The switch or a process on the switch resets.</td>
<td>A recoverable error occurred on the system or on a process in the system.</td>
<td>Cisco SAN-OS automatically recovered from the problem. See the “Recoverable System Restarts” section on page 2-27 and the “Switch or Process Resets” section on page 2-26.</td>
</tr>
<tr>
<td></td>
<td>A nonrecoverable error occurred on the system.</td>
<td>Cisco SAN-OS cannot recover automatically from the problem. See the “Unrecoverable System Restarts” section on page 2-31 to determine the cause.</td>
</tr>
<tr>
<td></td>
<td>A clock module failed.</td>
<td>Verify that a clock module failed. See the “Troubleshooting Clock Module Issues” section on page 4-12. Replace the failed clock module during the next maintenance window.</td>
</tr>
</tbody>
</table>
Recoverable System Restarts

Every process restart generates a syslog message and a Call Home event. Even if the event does not affect service, you should identify and resolve the condition immediately because future occurrences could cause service interruption.

To respond to a recoverable system restart, follow these steps:

**Step 1**

Enter the following command to check the syslog file to see which process restarted and why it restarted:

```
switch# show log logfile | include error
```

For information about the meaning of each message, refer to the *Cisco MDS 9000 Family System Messages Reference*.

The system output looks like the following example:

```
Sep 10 23:31:31 dot-6 % LOG_SYSMGR-3-SERVICE_TERMINATED: Service “sensor” (PID 704) has finished with error code SYSMGR_EXITCODE_SY.
switch# show logging logfile | include fail
Jan 27 04:08:42 88 %LOG_DAEMON-3-SYSTEM_MSG: bind() fd 4, family 2, port 123, ad dr 0.0.0.0, in_classd=0 flags=1 fails: Address already in use
Jan 27 04:08:42 88 %LOG_DAEMON-3-SYSTEM_MSG: bind() fd 4, family 2, port 123, ad dr 127.0.0.1, in_classd=0 flags=0 fails: Address already in use
Jan 27 04:08:42 88 %LOG_DAEMON-3-SYSTEM_MSG: bind() fd 4, family 2, port 123, ad dr 127.1.1.1, in_classd=0 flags=1 fails: Address already in use
Jan 27 04:08:42 88 %LOG_DAEMON-3-SYSTEM_MSG: bind() fd 4, family 2, port 123, ad dr 172.22.93.88, in_classd=0 flags=1 fails: Address already in use
Jan 27 23:18:59 88 % LOG_PORT-5-IF_DOWN: Interface fc1/13 is down (Link failure or not-connected)
Jan 27 23:18:59 88 % LOG_PORT-5-IF_DOWN: Interface fc1/14 is down (Link failure or not-connected)
Jan 27 00:55:12 88 % LOG_PORT-5-IF_DOWN: Interface fc1/1 is down (Link failure or not-connected)
Jan 27 00:58:06 88 % LOG_ZONE-2-ZS_MERGE_FAILED: Zone merge failure, Isolating port fc1/1 (VSAN 100)
Jan 27 00:58:44 88 % LOG_ZONE-2-ZS_MERGE_FAILED: Zone merge failure, Isolating port fc1/1 (VSAN 100)
Jan 27 03:26:38 88 % LOG_ZONE-2-ZS_MERGE_FAILED: Zone merge failure, Isolating port fc1/1 (VSAN 100)
Jan 29 19:01:34 88 % LOG_PORT-5-IF_DOWN: Interface fc1/1 is down (Link failure or not-connected)
switch#
```

**Step 2**

Enter the following command to identify the processes that are running and the status of each process.

```
switch# show processes
```

The following codes are used in the system output for the State (process state):

- **D** = uninterruptible sleep (usually I/O)
- **R** = runnable (on run queue)
- **S** = sleeping
- **T** = traced or stopped
- **Z** = defunct (“zombie”) process
- **NR** = notrunning
- **ER** = should be running but currently notrunning
Note

ER usually is the state a process enters if it has been restarted too many times and has been detected as faulty by the system and disabled.

The system output looks like the following example. (The output has been abbreviated to be more concise.)

<table>
<thead>
<tr>
<th>PID</th>
<th>State</th>
<th>PC</th>
<th>Start_cnt</th>
<th>TTY</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S</td>
<td>2ab8e33e</td>
<td>1</td>
<td>-</td>
<td>init</td>
</tr>
<tr>
<td>2</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>keventd</td>
</tr>
<tr>
<td>3</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>ksoftirqd_CPU0</td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>kswapd</td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>bdflush</td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>kupdated</td>
</tr>
<tr>
<td>71</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>kjournald</td>
</tr>
<tr>
<td>136</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>kjournald</td>
</tr>
<tr>
<td>140</td>
<td>S</td>
<td>0</td>
<td>1</td>
<td>-</td>
<td>kjournald</td>
</tr>
<tr>
<td>431</td>
<td>S</td>
<td>2abe333e</td>
<td>1</td>
<td>-</td>
<td>httpd</td>
</tr>
<tr>
<td>443</td>
<td>S</td>
<td>2abf433e</td>
<td>1</td>
<td>-</td>
<td>xinetd</td>
</tr>
<tr>
<td>446</td>
<td>S</td>
<td>2ac1e33e</td>
<td>1</td>
<td>-</td>
<td>sysmgr</td>
</tr>
<tr>
<td>452</td>
<td>S</td>
<td>2abe91a2</td>
<td>1</td>
<td>-</td>
<td>httpd</td>
</tr>
<tr>
<td>453</td>
<td>S</td>
<td>2abe91a2</td>
<td>1</td>
<td>-</td>
<td>httpd</td>
</tr>
<tr>
<td>456</td>
<td>S</td>
<td>2ac73419</td>
<td>1</td>
<td>S0</td>
<td>vsf</td>
</tr>
<tr>
<td>469</td>
<td>S</td>
<td>2abe91a2</td>
<td>1</td>
<td>-</td>
<td>httpd</td>
</tr>
<tr>
<td>470</td>
<td>S</td>
<td>2abe91a2</td>
<td>1</td>
<td>-</td>
<td>httpd</td>
</tr>
</tbody>
</table>

Step 3

Enter the following command to show the processes that have had abnormal exits and to show if there is a stack-trace or core dump:

```
switch# show process log
```

```
Process PID Normal-exit Stack-trace Core Log-create-time
---------------- ------ ----------- -------------- ------- ---------------
ntp       919      N           N              N       Jan 27 04:08
snsm      972      N           Y              N       Jan 24 20:50
```

Step 4

Enter the following command to show detailed information about a specific process that has restarted:

```
switch# show processes log pid 898
```

```
Service: idehsd
Description: ide hotswap handler Daemon
Started at Mon Sep 16 14:56:04 2002 (390923 us)
Stopped at Thu Sep 19 14:18:42 2002 (639239 us)
Uptime: 2 days 23 hours 22 minutes 22 seconds
Start type: SRV_OPTION_RESTART_STATELESS (23)
Death reason: SYSMGR_DEATH_REASON_FAILURE_SIGTERM (3)
Exit code: signal 15 (no core)
CWD: /var/sysmgr/work
Virtual Memory:
CODE  08048000 - 0804D660
DATA  0804E660 - 0804E824
BRK   0804E9A0 - 08050000
STACK 7FFFFFFD10
Register Set:
EBX  00000000  ECX  0804E994  EDX  00000000
EAX  00000000  EBX  00000000  EDX  7FFFFFFC9C
ESI  00000000  EDI  0804F990  EBX  7FFFFFFCAC
EAX  00000000  EBP  00000000  EDX  00000000
EAX  00000000  ESP  00000000  EDX  00000000
EAX  00000000  EBP  00000000  EDX  00000000
EAX  00000000  ESP  00000000  EDX  00000000
ESI  00000000  EDI  0804E941  EBX  7FFFFFFC9C
EBX  00000000  EDI  0804E941  EBX  7FFFFFFC9C
EBX  00000000  EDI  0804E941  EBX  7FFFFFFC9C
EBX  00000000  EDI  0804E941  EBX  7FFFFFFC9C
EBX  00000000  EDI  0804E941  EBX  7FFFFFFC9C
```
Step 5 Enter the following command to determine if the restart recently occurred:

```
switch# show system uptime
Start Time: Fri Sep 13 12:38:39 2002
Up Time: 0 days, 1 hours, 16 minutes, 22 seconds
```

To determine if the restart is repetitive or a one-time occurrence, compare the length of time that the system has been up with the timestamp of each restart.

Step 6 Enter the following command to view the core files:

```
switch# show cores
```

<table>
<thead>
<tr>
<th>Module-num</th>
<th>Process-name</th>
<th>PID</th>
<th>Core-create-time</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>fspf</td>
<td>1524</td>
<td>Jan 9 03:11</td>
</tr>
<tr>
<td>6</td>
<td>fcc</td>
<td>919</td>
<td>Jan 9 03:09</td>
</tr>
<tr>
<td>8</td>
<td>acltcam</td>
<td>285</td>
<td>Jan 9 03:09</td>
</tr>
<tr>
<td>8</td>
<td>fib</td>
<td>283</td>
<td>Jan 9 03:08</td>
</tr>
</tbody>
</table>

The output shows all cores that are presently available for upload from the active supervisor. The module-num column shows the slot number on which the core was generated. In the previous example, an FSPF core was generated on the active supervisor module in slot 5. An FCC core was generated on the standby supervisory module in slot 6. Core dumps generated on the module in slot 8 include ACLTCAM and FIB.

To copy the FSPF core dump in this example to a TFTP server with the IP address 1.1.1.1, enter the following command:

```
switch# copy core://5/1524 tftp::/1.1.1.1/abcd
```

The following command displays the file named zone_server_log.889 in the log directory:

```
switch# show pro log pid 1473
```

Service: ips
Description: IPS Manager

Started at Tue Jan 8 17:07:42 1980 (757583 us)
Stopped at Thu Jan 10 06:16:45 1980 (83451 us)
Uptime: 1 days 13 hours 9 minutes 9 seconds

Start type: SRV_OPTION_RESTART_STATELESS (23)
Death reason: SYSMGR_DEATH_REASON_FAILURE_SIGNAL (2)
Exit code: signal 6 (core dumped)
CWD: /var/sysmgr/work

Virtual Memory:

<table>
<thead>
<tr>
<th>CODE</th>
<th>DATA</th>
<th>BRK</th>
<th>STACK</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>08048000 - 080FB060</td>
<td>080FC060 - 080FCBA8</td>
<td>081795C0 - 081EC000</td>
<td>7FFFFFCF0</td>
<td>20952 KB</td>
</tr>
</tbody>
</table>
Troubleshooting Cisco SAN-OS Software System Reboots

Step 7 Enter the following command to configure the switch to use TFTP to send the core dump to a TFTP server:

```
     system cores tftp: //[servername][/path]
```

This command causes the switch to enable the automatic copy of core files to a TFTP server. For example, the following command sends the core files to the TFTP server with the IP address 10.1.1.1:

```
switch(config)# system cores tftp://10.1.1.1/cores
```

The following conditions apply:

- The core files are copied every 4 minutes. This time interval is not configurable.
- The copy of a specific core file to a TFTP server can be manually triggered, using the command `copy core://module#pid#/tftp://tftp_ip_address/file_name`.
- The maximum number of times a process can be restarted is part of the HA policy for any process. (This parameter is not configurable.) If the process restarts more than the maximum number of times, the older core files are overwritten.
- The maximum number of core files that can be saved for any process is part of the HA policy for any process. (This parameter is not configurable, and it is set to three.)

Step 8 Determine the cause and resolution for the restart condition by contacting your customer support representative and asking the representative to review your core dump.

See also the “Troubleshooting Supervisor Issues” section on page 4-14 or the “Troubleshooting Switching and Services Modules” section on page 4-21.
Unrecoverable System Restarts

An unrecoverable system restart might occur in the following cases:

- A critical process fails and is not restartable.
- A process restarts more times than is allowed by the system configuration.
- A process restarts more frequently than is allowed by the system configuration.

The effect of a process reset is determined by the policy configured for each process. Unrecoverable reset may cause loss of functionality, restart of the active supervisor, a supervisor switchover, or restart of the switch.

To respond to an unrecoverable reset, see the “Troubleshooting Cisco SAN-OS Software System Reboots” section on page 2-13.

The `show system reset-reason` CLI command displays the following information:

- In a Cisco MDS 9500 Series switch, the last four reset-reason codes for the supervisor module in slot 5 and slot 6 are displayed. If either supervisor module is absent, the reset-reason codes for that supervisor module are not displayed.
- In a Cisco MDS 9200 Series switch, the last four reset-reason codes for the supervisor module in slot 1 are displayed.
- The `show system reset-reason module number` command displays the last four reset-reason codes for a specific module in a given slot. If a module is absent, then the reset-reason codes for that module are not displayed.
- Find the overall history of when and why expected and unexpected reloads occur.
- Timestamp of when the reset or reload occurred
- Reason for the reset or reload of a module
- The service that caused the reset or reload (not always available)
- The software version that was running at the time of the reset or reload

**Example 2-2  show system reason-reset Command Output**

```
switch# show system reset-reason module 5
------- reset reason for module 5 -------
1) At 224801 usecs after Fri Jan 21 16:36:40 2005
   Reason: Reset Requested by CLI command reload
   Service: Version: 2.1(2)
2) At 922828 usecs after Fri Jan 21 16:02:48 2005
   Reason: Reset Requested by CLI command reload
   Service: Version: 2.1(2)
3) At 318034 usecs after Fri Jan 21 14:03:36 2005
   Reason: Reset Requested by CLI command reload
   Service: Version: 2.1(2)
4) At 255842 usecs after Wed Jan 19 00:07:49 2005
   Reason: Reset Requested by CLI command reload
   Service: Version: 2.1(2)
```
Recovering the Administrator Password

You can access the switch if you forget the administrator password by following the directions in Table 2-8.

Symptom: You forgot the administrator password for accessing a switch.

<table>
<thead>
<tr>
<th>Table 2-8 Recovering Administrator Password</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem</strong></td>
</tr>
<tr>
<td>You forgot the administrator password for accessing a Cisco MDS 9000 Family switch.</td>
</tr>
<tr>
<td><strong>Solution</strong></td>
</tr>
<tr>
<td>You can recover the password using a local console connection. For the latest instructions on password recovery, refer to the Cisco MDS 9000 CLI Family Configuration Guide at the following website: <a href="http://cisco.com/en/US/products/ps5989/products_installation_and_configuration_guides_list.html">http://cisco.com/en/US/products/ps5989/products_installation_and_configuration_guides_list.html</a></td>
</tr>
</tbody>
</table>

If you can access Device Manager, recover the administrator password by following these steps:

- **Step 1**: Create a text file on the TFTP server containing the desired user name and password:
  
  "username admin password 0 admin123"

- **Step 2**: Click Admin > Copy Configuration to copy the file from the TFTP server to the running configuration on the switch.

  **Note**: The clear text password "admin123" will be copied over the existing password and encrypted in the running configuration.

- **Step 3**: Click Device > Command Line Interface to log into the switch and verify the new password.

- **Step 4**: Click Admin > Save Configuration to save the running configuration to the startup configuration.

Miscellaneous Software Image Issues

This section includes software image issues reported by the relevant release notes and includes the following topics:

- All Ports Down Because of System Health Failure, page 2-33
- Switch Reboots after FCIP Reload, page 2-33
- FCIP Link Fails to Come Up, page 2-33
- Cannot Create, Modify, or Delete Admin Role, page 2-34
- FC IDs Change after Link Reset, page 2-34
- Switch Displays Wrong User, page 2-34
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 2  Troubleshooting Installs, Upgrades, and Reboots

All Ports Down Because of System Health Failure

**Symptom**  Console reports all ports on a module are down because of a system health failure.

**Table 2-9  All Ports are Down Because of a System Health Failure.**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system console reports that the module’s ports are down because of a system health failure.</td>
<td>An incorrect process on the Cisco MDS 9000 modules might have been reinitialized from an error recovery mechanism, leaving the module in an unusable state. In some cases, the module may reboot.</td>
<td>Downgrade to a Cisco SAN-OS Release 2.0(x) version supported by your OSM. Upgrade to Cisco SAN-OS Release 2.1.2 or 2.1(1b). Resetting the module will clear the problem, but the problem could reoccur unless you are using a SAN-OS version with the bug fix.</td>
</tr>
</tbody>
</table>

Switch Reboots after FCIP Reload

**Symptom**  Switch rebooted after FCIP module was reloaded, upgraded, or downgraded.

**Table 2-10  Switch Reboot after FCIP Reload**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch rebooted after FCIP module was reloaded, upgraded, or downgraded.</td>
<td>If an IPS module with operational FCIP PortChannels is reloaded, upgraded, or downgraded, the supervisor module might reload and cause the system to reboot.</td>
<td>Before reloading, upgrading, or downgrading an IPS module, shut down all FCIP PortChannels on the module.</td>
</tr>
</tbody>
</table>

FCIP Link Fails to Come Up

**Symptom**  A newly configured FCIP link may fail to come up when running on an MPS-14/2 module.

**Table 2-11  FCIP Link Fails to Come Up**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A newly configured FCIP link may fail to come up when running on an MPS-14/2 module.</td>
<td>This symptom may occur following an upgrade from Cisco MDS SAN-OS Release 2.0(1b) to Release 2.0(3) and following the configuration of a new FCIP link.</td>
<td>Reload the MPS-14/2 module using the reload module module-number command, where module-number is a specific module.</td>
</tr>
</tbody>
</table>
Cannot Create, Modify, or Delete Admin Role

**Symptom**
Cannot create, modify, or delete the admin role.

**Table 2-12** Cannot Create, Modify, or Delete Admin Role

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot create, modify, or delete the admin role.</td>
<td>After upgrading to Cisco SAN-OS Release 2.0, you cannot create, modify, or delete the admin role.</td>
<td>Create the admin role before upgrading to Cisco SAN-OS Release 2.0.</td>
</tr>
</tbody>
</table>

FC IDs Change after Link Reset

**Symptom**
FC IDs change after a link resets.

**Table 2-13** FC IDs Change after Link Reset

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC IDs change after a link resets.</td>
<td>Following an upgrade from Cisco SAN-OS Release 1.1 to Cisco SAN-OS Release 1.3 or later, with persistent FC ID enabled, the FC IDs for the storage arrays might change after a link flap.</td>
<td>Reconfigure the FC IDs as necessary.</td>
</tr>
</tbody>
</table>

Switch Displays Wrong User

**Symptom**
Switch displays the wrong user with the `show running-config` CLI command.

**Table 2-14** Switch Displays Wrong User

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch displays the wrong user with the <code>show running-config</code> CLI command.</td>
<td>When you perform a nondisruptive upgrade from Cisco SAN-OS Release 1.3(x) to Cisco SAN-OS Release 2.0(x) and then issue the <code>show running-config</code> command, the switch displays the wrong user. The user shown after the nondisruptive upgrade is different from the user shown when you issue the <code>show user-account</code> command.</td>
<td>Recreate the user.</td>
</tr>
</tbody>
</table>
Managing Storage Services Modules

This chapter describes how to manage the Storage Services Module (SSM) and provides information about SSI images.

This chapter includes the following sections:

- SSM Overview, page 3-1
- Initial Troubleshooting Checklist, page 3-3
- SSM Issues, page 3-3

SSM Overview

The 32-port Fibre Channel Storage Services Module (SSM) for the Cisco MDS 9000 Family supports up to 32 Fibre Channel ports and provides distributed intelligent storage services.

Note

Cisco MDS 9500 Series switches running Cisco MDS SAN-OS Release 2.0(2b) or later support the SSM module.

The SSI image for the SSM is downloaded from the supervisor module. The image for an SSM can be specified using the SSI boot variable.

Note

The SSM can operate as a 32-port Fibre Channel switching module with the standard Cisco SAN-OS images for Release 2.1(2) or later. You need the SSI image if you use intelligent storage services.
Table 3-1 lists the features supported for the SSM.

**Table 3-1  Cisco MDS SAN-OS Feature Support for the SSM.**

<table>
<thead>
<tr>
<th>Module</th>
<th>Cisco MDS SAN-OS Release</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2.0(1b)</td>
</tr>
<tr>
<td>SSM</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Requires EPLD version 2.1(2) (see “Installing EPLD Images on Modules” section on page 3-9) and SSI boot image version 2.1(2).

When you upgrade, or downgrade, the SSI boot image on an SSM, you might disrupt traffic through the module. Table 3-2 describes how updating the SSI boot image affects SSM traffic.

**Table 3-2  SSI Boot Image Updating Affects on SSM Traffic**

<table>
<thead>
<tr>
<th>Cisco MDS SAN-OS Release</th>
<th>Traffic Type</th>
<th>Disrupts Traffic?</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0(2b) through 2.1(1a)</td>
<td>All</td>
<td>Yes</td>
</tr>
<tr>
<td>2.1(2) and later</td>
<td>Layer 2 Fibre Channel switching only</td>
<td>No¹</td>
</tr>
<tr>
<td></td>
<td>Both Layer 2 Fibre Channel switching and Layer 3 Intelligent Storage Services (such as FCWA, NASB, SANTap, and ISAPI virtualization)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Layer 3 Intelligent Storage Services (such as FCWA, NASB, SANTap, ISAPI virtualization) only</td>
<td>Yes</td>
</tr>
</tbody>
</table>


As shown in Table 3-2, Layer 3 Intelligent Storage Services traffic is disrupted when you update the SSI boot image. If you configure Layer 3 Intelligent Storage Services on your SSM, we recommend that you shut down these services before upgrading the SSI boot image. You can use dual fabric configuration to minimize the impact of shutting down Layer 3 services.
Send documentation comments to mdsfeedback-doc@cisco.com

Initial Troubleshooting Checklist

Begin troubleshooting SSM issues by verifying that the following conditions are met:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that the SSI boot variable is set.</td>
<td></td>
</tr>
<tr>
<td>Verify that the SSI image is present and pointed to by the SSI boot variable.</td>
<td></td>
</tr>
<tr>
<td>Verify that the EPLD version is 2.1(2) or later for nondisruptive layer-2 upgrades.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have configured all SSM ports prior to upgrading to Cisco SAN-OS Release 3.0(1) or later. Do not use port mode auto.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have the appropriate licensing. The SSM can operate as a 32-port Fibre Channel switching module with no additional licensing requirements. The SSM requires the Storage Services Enabler package to provision intelligent storage services on the module.</td>
<td></td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

The following navigation paths may be useful in troubleshooting SSM issues using Fabric Manager:

- In Fabric Manager, choose \textbf{End Devices} > \textbf{SSM} to access the SSM configuration.
- In Device Manager, choose \textbf{Physical} > \textbf{Inventory} to determine the SSI image version.

Common Troubleshooting Commands in the CLI

The following commands may be useful in troubleshooting PortChannel and trunking issues:

- \texttt{show boot-variables}
- \texttt{show version}
- \texttt{install ssi}
- \texttt{show version module \textit{number} epld}
- \texttt{show version epld}
- \texttt{show ssm provisioning}

SSM Issues

This section describes troubleshooting issues for the SSM and SSI images, and it includes the following topics:

- SSM Fails to Boot, page 3-4
- SSM Upgrade Is Disruptive, page 3-9
SSM Fails to Boot

If the SSM fails to boot, you may see the following system message:

**Error Message**  IMAGE_DNLD-SLOT#-2-ADDON_IMG_DNLD_FAILED: Module image download process failed. [chars].

**Explanation**  The add-on image download to the module failed. This module is not operational until an add-on image has been successfully installed.

**Recommended Action**  Verify the location and version of your module image. Enter _install module_ CLI command or use a similar Fabric Manager/Device Manager procedure to download a new module image.

**Symptom**  SSM fails to boot.

<table>
<thead>
<tr>
<th>Table 3-3</th>
<th>SSM Fails to Boot</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>SSM fails to boot.</td>
<td>SSI boot variable is not set.</td>
</tr>
<tr>
<td></td>
<td>SSI image is not present.</td>
</tr>
<tr>
<td></td>
<td>SSI image is not compatible with Cisco SAN-OS image.</td>
</tr>
</tbody>
</table>

Upgrading the SSI Image

You can specify the SSI boot image for a Storage Services Module (SSM) to configure Fibre Channel switching and Intelligent Storage Services.

**Note**  A newly installed SSM initially operates in Fibre Channel switching mode by default.

**Note**  If you downgrade to a Cisco MDS SAN-OS release that does not support the SSM, you must power down the module. The boot variables for the SSM are lost.
To upgrade or downgrade the SSI boot image for SSM modules using the CLI, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that the correct SSI boot image is present on your switch (see the “Verifying the SSI Boot Image” section on page 3-5).</td>
</tr>
<tr>
<td>2</td>
<td>Use the <code>install ssi</code> command to upgrade or downgrade the SSI boot image on the module (see the “Using the <code>install ssi</code> Command” section on page 3-6).</td>
</tr>
</tbody>
</table>

**Note** The SSM must be running EPLD version 2.1(2) to use the `install ssi` command. You must install the SSM on a Cisco MDS 9500 Series switch to upgrade the EPLD. See the “Installing EPLD Images on Modules” section on page 3-9.

### Verifying the SSI Boot Image

To verify that you have the correct Cisco MDS SAN-OS release and SSI boot image file on your switch, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Log in to the switch through the console port, an SSH session, or a Telnet session.</td>
</tr>
<tr>
<td>2</td>
<td>If your SSM module boots, use the <code>dir modflash://slot-1/</code> command to verify that the SSI software image file corresponding to your Cisco MDS SAN-OS release is present on the SSM. For example, if your switch is running Cisco MDS SAN-OS Release 2.1(2), you must have <code>m9000-ek9-ssi-mz.2.1.2.bin</code> in bootflash: or slot0: on the active supervisor module. Refer to the <a href="http://www.cisco.com/application/pdf/en/us/guest/products/ps5989/c1683/ccmigration_09186a0080212dd0.pdf">Cisco MDS SAN-OS Release Compatibility Matrix for Storage Service Interface Images</a> at the following URL for more information: <a href="http://www.cisco.com/application/pdf/en/us/guest/products/ps5989/c1683/ccmigration_09186a0080212dd0.pdf">http://www.cisco.com/application/pdf/en/us/guest/products/ps5989/c1683/ccmigration_09186a0080212dd0.pdf</a>.</td>
</tr>
</tbody>
</table>

```plaintext
switch# dir modflash://4-1/  
4004128 Sep 26 13:43:02 2005 m9000-ek9-ssi-mz.2.1.2.bin  
...  
```

You can find the SSI boot images at the following URL:

http://www.cisco.com/cgi-bin/tablebuild.pl/mds9000-ssi-3des

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>If your SSM module does not boot, you need to check for the SSI image in bootflash instead of modflash: use the <code>dir bootflash://slot-1/</code> command to verify that the SSI software image file corresponding to your Cisco MDS SAN-OS release is present on the SSM. For example, if your switch is running Cisco MDS SAN-OS Release 2.1(2), you must have <code>m9000-ek9-ssi-mz.2.1.2.bin</code> in bootflash: or slot0: on the active supervisor module. Refer to the <a href="http://www.cisco.com/application/pdf/en/us/guest/products/ps5989/c1683/ccmigration_09186a0080212dd0.pdf">Cisco MDS SAN-OS Release Compatibility Matrix for Storage Service Interface Images</a> at the following URL for more information: <a href="http://www.cisco.com/application/pdf/en/us/guest/products/ps5989/c1683/ccmigration_09186a0080212dd0.pdf">http://www.cisco.com/application/pdf/en/us/guest/products/ps5989/c1683/ccmigration_09186a0080212dd0.pdf</a>.</td>
</tr>
</tbody>
</table>

```plaintext
switch# dir bootflash:  
40295206     Aug 05 15:23:51 1980  ilcl.bin  
12456448     Jul 30 23:05:28 1980  kickstart-image1  
12288       Jun 23 14:58:44 1980  lost+found/  
27602159     Jul 30 23:05:16 1980  system-image1  
12447232     Aug 05 15:08:30 1980  kickstart-image2  
28364853     Aug 05 15:11:57 1980  system-image2  
4004128      Sep 26 13:43:02 2005 m9000-ek9-ssi-mz.2.1.2.bin  
...  
```
**Send documentation comments to mdsfeedback-doc@cisco.com**

You can find the SSI boot images at the following URL:

http://www.cisco.com/cgi-bin/tablebuild.pl/mds9000-ssi-3des

**Step 4** If you need to obtain the appropriate SSI software image file, follow these steps:

a. Download the SSI software image file from Cisco.com to your FTP server.

b. If your SSM boots, then verify that you have enough free space available on the modflash: on the SSM using the `dir modflash://slot-1/` command. The download site on Cisco.com shows the size of the boot image file in bytes.

   The following example shows how to display the available memory for the modflash: for the SSM in slot 4:

   ```
   switch# dir modflash://4-1/
   3118535 Apr 25 15:35:06 2005 m9000-ek9-ssi-mz.2.0.4a.bin
   ...
   ```

c. If your SSM does not boot, then verify that you have enough free space available on the bootflash: on the active supervisor module using the `dir bootflash://slot-1/` command. The download site on Cisco.com shows the size of the boot image file in bytes.

   The following example shows how to display the available memory for the modflash: for the SSM in slot 4:

   ```
   switch# dir bootflash:
   40295206     Aug 05 15:23:51 1980  ilc1.bin
   12456448     Jul 30 23:05:28 1980  kickstart-image1
   12288        Jun 23 14:58:44 1980  lost+found/
   27602159     Jul 30 23:05:16 1980  system-image1
   12447232     Aug 05 15:08:30 1980  kickstart-image2
   28364853     Aug 05 15:11:57 1980  system-image2
   4004128      Sep 26 13:43:02 2005 m9000-ek9-ssi-mz.2.1.2.bin
   ...
   ```

d. Delete the unneeded files from modflash or bootflash if there is not enough space.

   ```
   switch# delete modflash://4-1/m95000-ek9-ssi-mz.2.0.4a.bin
   ```

e. Copy the boot image file from the FTP server to modflash or bootflash.

   ```
   switch# copy ftp://10.1.7.2/m9000-ek9-ssi-mz.2.1.2.bin modflash://4-1/m9000-ek9-ssi-mz.2.1.2.bin
   ```

**Note** If you are using bootflash to initially boot your SSM, you should copy the SSI image to modflash after the SSM boots and set the SSI boot variable to use the image in modflash.

### Using the install ssi Command

Use the `install ssi` command to update the boot image on an SSM. If the SSM is performing Fibre Channel switching and no Intelligent Storage Services are provisioned on the module, this operation does not disrupt traffic through the module. If the SSM is configured for Intelligent Storage Services, a warning displays at the command prompt indicating that the operation will disrupt traffic and you are then asked if you wish to continue.
To upgrade or downgrade the SSM boot image for Intelligent Storage Services, follow these steps:

**Step 1** Log in to the switch through the console port, an SSH session, or a Telnet session.

**Step 2** Verify that the SSM is physically installed in the switch. If the module is not physically installed, insert it into the desired slot. Issue a `show module` command to verify the status of the module.

```plaintext
switch# show module

---   -----  -------------------------------- ------------------ ------------
4     32    Storage Services Module          DS-X9032-SSM       ok
5     0     Supervisor/Fabric-1              DS-X9530-SF1-K9    active *
6     0     Supervisor/Fabric-1              DS-X9530-SF1-K9    ha-standby
...
```

Note the slot number for later reference.

**Step 3** Verify the Cisco MDS SAN-OS release that is running on the switch and verify the location and name of the SSI boot image that is on the switch by following the procedure described in the “Verifying the SSI Boot Image” section on page 3-5.

**Step 4** If the SSM boots, then install the SSI image on the SSM.

```plaintext
switch# install ssi modflash://4-1/m9000-ek9-ssi-mz.2.1.2.bin module 4
```

**Note** If the SSM is configured for Layer 3 Fibre Channel switching or Intelligent Storage Services, a warning displays at the command prompt indicating that the operation will disrupt traffic and you are then asked if you wish to continue.

**Step 5** If the SSM does not boot, install the SSI image in bootflash on the active supervisor module.

```plaintext
switch# install ssi bootflash:/m9000-ek9-ssi-mz.2.1.2.bin module 4
```

**Note** If the SSM is configured for Layer 3 Fibre Channel switching or Intelligent Storage Services, a warning displays at the command prompt indicating that the operation will disrupt traffic and you are then asked if you wish to continue.

**Step 6** Install the SSI image on the SSM.

```plaintext
switch# install ssi modflash://4-1/m9000-ek9-ssi-mz.2.1.2.bin module 4
```

**Note** If the SSM is configured for Layer 3 Fibre Channel switching or Intelligent Storage Services, a warning displays at the command prompt indicating that the operation will disrupt traffic and you are then asked if you wish to continue.

**Step 7** Issue the `show boot` command to display the current contents of the image boot variable for the SSM.

```plaintext
switch# show boot
sup-1
```
SSM Issues

Send documentation comments to mdsfeedback-doc@cisco.com

kickstart variable = bootflash:/boot-2-0-1-9
system variable =
bootflash:/isan-2-0-1-9;bootflash:/isan-2-0-0-181b;bootflash:/isan-2-0-0-181b
sup-2
kickstart variable = bootflash:/boot-2-0-1-9
system variable =
bootflash:/isan-2-0-1-9;bootflash:/isan-2-0-0-181b;bootflash:/isan-2-0-0-181b
Module 4
ssi variable = modflash://4-1/m9000-ek9-ssi-mz.2.1.2.bin

Step 8  Save the new boot variable configuration so that the new boot image is used when the switch reboots.

switch# copy running-config startup-config

Note  If you do not save this configuration, it is lost when the switch reboots. In addition, SSM restarts
in Fibre Channel switching mode. You must perform this procedure again to recover the SSI boot
image configuration.

Step 9  Issue the show module command to verify the status of the SSM.

switch# show module

<table>
<thead>
<tr>
<th>Mod</th>
<th>Ports</th>
<th>Module-Type</th>
<th>Model</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>32</td>
<td>Storage Services Module</td>
<td>DS-X9032-SSM</td>
<td>ok</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>Supervisor/Fabric-1</td>
<td>DS-X9530-SF1-K9</td>
<td>active *</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>Supervisor/Fabric-1</td>
<td>DS-X9530-SF1-K9</td>
<td>ha-standby</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mod</th>
<th>Sw</th>
<th>Hw</th>
<th>World-Wide-Name(s) (WWN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>2.1(2)</td>
<td>0.30</td>
<td>20:c1:00:05:30:00:06:de to 20:e0:00:05:30:00:06:de</td>
</tr>
<tr>
<td>5</td>
<td>2.1(2)</td>
<td>4.0</td>
<td>--</td>
</tr>
<tr>
<td>6</td>
<td>2.1(2)</td>
<td>4.0</td>
<td>--</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mod</th>
<th>Application Image Description</th>
<th>Application Image Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>SSI linecard image</td>
<td>2.1(2)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mod</th>
<th>MAC-Address(es)</th>
<th>Serial-Num</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>00-05-30-00-9e-b2 to 00-05-30-00-9e-b6</td>
<td>JAB06480590</td>
</tr>
<tr>
<td>5</td>
<td>00-0e-38-c6-2c-6c to 00-0e-38-c6-2c-70</td>
<td>JAB082504MQ</td>
</tr>
<tr>
<td>6</td>
<td>00-0f-34-94-4d-34 to 00-0f-34-94-4d-38</td>
<td>JAB083407D3</td>
</tr>
</tbody>
</table>

* this terminal session

Recovering a Replacement SSM

In Cisco MDS SAN-OS Release 2.1(2) and later, you use the CompactFlash memory (modflash:) on the
SSM to store the SSI image. If the SSM is replaced, the new SSM might not initialize.

To recover the SSM, follow these steps:

Step 1  Log in to the switch through the console port, an SSH session, or a Telnet session.

Step 2  Display the values assigned to the SSI image boot variable for each module and note the values for later reference.
Send documentation comments to mdsfeedback-doc@cisco.com

```
switch# show boot module
Module 2
ssi variable = modflash://2-1/m9000-ek9-ssi-mz.2.1.2.bin
Module 4
ssi variable = modflash://4-1/m9000-ek9-ssi-mz.2.1.2.bin
```

**Step 3** Clear the values assigned to the SSI image boot variable.

```
switch# config t
switch(config)# no boot ssi
```

**Step 4** Reload the SSM to initialize in Fibre Channel switching mode.

```
switch# reload module 4
reloading module 4 ...
```

**Step 5** After the SSM initializes, follow the procedure described in the “Upgrading the SSI Image” section on page 3-4.

### SSM Upgrade Is Disruptive

**Symptom** SSM upgrade disruptive.

<table>
<thead>
<tr>
<th><strong>Table 3-4 SSM Upgrade Disruptive</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>SSM upgrade disruptive.</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

### Installing EPLD Images on Modules

**Tip** Refer to the *Cisco MDS SAN-OS Release Notes for Cisco MDS 9000 EPLD Images* to verify whether or not the EPLD has changed for the Cisco SAN-OS image version being used.

**Caution** Do not insert or remove any modules while an EPLD upgrade or downgrade is in progress.
To install an EPLD image on a switching, services, or supervisor module, follow these steps:

**Step 1** Log in to the switch through the console port, an SSH session, or a Telnet session.

**Step 2** Issue the `show version` command to determine which Cisco MDS SAN-OS release is running on the MDS switch.

```
switch# show version
Cisco Storage Area Networking Operating System (SAN-OS) Software
TAC support: http://www.cisco.com/tac
Copyright (c) 2002-2005, Cisco Systems, Inc. All rights reserved.
The copyrights to certain works contained herein are owned by other third parties and are used and distributed under license.
Some parts of this software are covered under the GNU Public License. A copy of the license is available at http://www.gnu.org/licenses/gpl.html.

Software
  BIOS:      version 1.0.8
  loader:    version unavailable [last: 1.0(0.267c)]
  kickstart: version 2.1(2) [build 2.1(2.47)] [gdb]
  system:    version 2.1(2) [build 2.1(2.47)] [gdb]
```

**Step 3** If necessary, upgrade the Cisco MDS SAN-OS software that is running on your switch.

**Step 4** Issue the `dir bootflash:` or `dir slot0:` command to verify that the EPLD software image file corresponding to your Cisco MDS SAN-OS release is present on the active supervisor module. For example, if your switch is running Cisco MDS SAN-OS Release 2.1(2), you must have m9000-epld-2.1.2.img in bootflash: or slot0: on the active supervisor module.

```
switch# dir bootflash:
12288 Jan 01 00:01:07 1980 lost+found/
2337571 May 31 13:43:02 2005 m9000-epld-2.1.2.img
```

You can find the EPLD images at the following URL:

[http://www.cisco.com/cgi-bin/tablebuild.pl/mds-epld](http://www.cisco.com/cgi-bin/tablebuild.pl/mds-epld)

**Step 5** If you need to obtain the appropriate EPLD software image file, follow these steps:

a. Download the EPLD software image file from Cisco.com to your FTP server.

b. Verify that you have enough free space available on the active and standby supervisor memory devices that you plan to use, either bootflash: or slot0:. The download site on Cisco.com shows the size of the EPLD image file in bytes.

The following example shows how to display the available memory for the bootflash: devices on the active and standby supervisor module.

```
switch# dir bootflash:
12288 Jan 01 00:01:06 1980 lost+found/
14765056 Mar 21 15:35:06 2005 m9500-sf1ek9-kickstart-mz.2.1.1.bin
15944704 Apr 06 16:46:04 2005 m9500-sf1ek9-kickstart-mz.2.1.1a.bin
48063243 Mar 21 15:34:46 2005 m9500-sf1ek9-mz.2.1.1.bin
48036239 Apr 06 16:45:41 2005 m9500-sf1ek9-mz.2.1.1a.bin

Usage for bootflash://sup-local
141066240 bytes used
43493376 bytes free
184559616 bytes total
```
### SSM Issues

The `show module` command output shows that the standby supervisor module is in slot 6. Use the `attach` command to access the supervisor module.

```
switch# attach module 6

switch(standby)# dir bootflash:
12288 Jan 01 00:01:06 1980 lost+found/
14765056 Mar 21 15:35:06 2005 m9500-sf1ek9-kickstart-mz.2.1.1.bin
15944704 Apr 06 16:46:04 2005 m9500-sf1ek9-kickstart-mz.2.1.1a.bin
48063243 Mar 21 15:34:46 2005 m9500-sf1ek9-mz.2.1.1.bin
48036239 Apr 06 16:45:41 2005 m9500-sf1ek9-mz.2.1.1a.bin

Usage for bootflash://sup-local
141066240 bytes used
43493376 bytes free
184559616 bytes total

switch(standby)# exit
switch#
```

The following example shows how to display the available memory for the slot0: devices on the active and standby supervisor modules.

```
switch# dir slot0:
12288 Jan 01 00:01:06 1980 lost+found/
14765056 Mar 21 15:35:06 2005 m9500-sf1ek9-kickstart-mz.2.1.1.bin
15944704 Apr 06 16:46:04 2005 m9500-sf1ek9-kickstart-mz.2.1.1a.bin
48063243 Mar 21 15:34:46 2005 m9500-sf1ek9-mz.2.1.1.bin
48036239 Apr 06 16:45:41 2005 m9500-sf1ek9-mz.2.1.1a.bin

Usage for slot:
141066240 bytes used
43493376 bytes free
184559616 bytes total

switch# show module
Mod Ports Module-Type Model Status
--- ----- --------------------------------- ------------------ ------------
2 32 Storage Services Module DS-X9032-SSM ok
5 0 Supervisor/Fabric-1 DS-X9530-SF1-K9 active *
6 0 Supervisor/Fabric-1 DS-X9530-SF1-K9 ha-standby

The `show module` command output shows that the standby supervisor module is in slot 6. Use the `attach` command to access the supervisor module.

```
switch# attach module 6

switch(standby)# dir slot0:
12288 Jan 01 00:01:06 1980 lost+found/
14765056 Mar 21 15:35:06 2005 m9500-sf1ek9-kickstart-mz.2.1.1.bin
15944704 Apr 06 16:46:04 2005 m9500-sf1ek9-kickstart-mz.2.1.1a.bin
48063243 Mar 21 15:34:46 2005 m9500-sf1ek9-mz.2.1.1.bin
48036239 Apr 06 16:45:41 2005 m9500-sf1ek9-mz.2.1.1a.bin
```
Chapter 3      Managing Storage Services Modules

SSM Issues

Usage for slot0:
141066240 bytes used
43493376 bytes free
184559616 bytes total

switch(standby)# exit
switch#

c. If there is not enough space, delete unneeded files.

switch# delete bootflash:m9500-sf1ek9-kickstart-mz.2.1.1.bin
switch# attach module 6
switch(standby)#

The show module command output shows that the standby supervisor module is in slot 6. Use the attach command to access the supervisor module.

switch(standby)# delete bootflash:m9500-sf1ek9-kickstart-mz.2.1.1.bin
switch(standby)# exit
switch#

d. Copy the EPLD image file from the FTP server to the bootflash: or slot0: device in the active supervisor module. The following example shows how to copy to bootflash:

switch# copy ftp://10.1.7.2/m9000-epld-2.1.2.img bootflash:m9000-epld-2.1.2.img

Note The system will automatically synchronize the ELPD image to the standby supervisor module if automatic copying is enabled.

switch# config t
switch(config)# boot auto-copy

Step 6 Use the install module number epld url command on the active supervisor module to upgrade EPLD images for a module.

switch# install module 2 epld bootflash:m9000-epld-2.1.2.img

EPLD Curr Ver New Ver
---------------------------------------
XBUS IO 0x07 0x07
UD Flow Control 0x05 0x05
PCI ASIC I/F 0x05 0x05
PCI Bridge 0x07 0x05

WARNING: Upgrade process could take up to 15 minutes.
Module 2 will be powered down now!!
Do you want to continue (y/n) ? y

Module 2 EPLD upgrade is successful

If you forcefully upgrade a module that is not online, all EPLD images are forcefully upgraded. If the module is not present in the switch, an error returns. If the module is present, the command process continues. To upgrade a module that is not online but is present in the chassis, use the same command. The switch software prompts you to continue after reporting the module state. When you confirm your intention to continue, the upgrade continues.

switch# install module 2 epld bootflash:m9000-epld-2.1.2.img

Module 2 EPLD upgrade is successful
When you upgrade the EPLD module on Cisco MDS 9100 Series switches, you receive the following message:
Data traffic on the switch will stop now!!
Do you want to continue (y/n)?
Troubleshooting Hardware

This chapter describes how to identify and resolve problems that might occur in the hardware components of the Cisco MDS 9000 Family. It includes the following sections:

- Overview, page 4-1
- Troubleshooting Startup Issues, page 4-2
- Troubleshooting Power Supply Issues, page 4-3
- Troubleshooting Fan Issues, page 4-8
- Temperature Threshold Violations, page 4-11
- Troubleshooting Clock Module Issues, page 4-12
- Troubleshooting Other Hardware Issues, page 4-13
- Troubleshooting Supervisor Issues, page 4-14
- Troubleshooting Switching and Services Modules, page 4-21

Overview

The key to success when troubleshooting the system hardware is to isolate the problem to a specific system component. The first step is to compare what the system is doing to what it should be doing. Because a startup problem can usually be attributed to a single component, it is more efficient to isolate the problem to a subsystem rather than troubleshoot each separate component in the system.

Problems with the initial power up are often caused by a module that is not firmly connected to the backplane or a power supply that has been disconnected from the power cord connector.

Overheating can also cause problems with the system, though typically only after the system has been operating for an extended period of time. The most common cause of overheating is the failure of a fan module.

The Cisco MDS 9000 Family includes the following subsystems on most chassis:

- Power supply—This includes the power supply fans.
- Fan module—The chassis fan module should operate whenever system power is on. You should see the Fan LED turn green and should hear the fan module to determine whether or not it is operating. If the Fan LED is red, this indicates that one or more fans in the fan module is not operating. You
Troubleshooting Startup Issues

You can set SNMP traps to monitor fans, power supplies and temperature settings, or to test a call home application without risking adverse impact to your production SAN.

Use any of the following commands to set SNMP traps:

- test pfm test-SNMP-trap fan
- test pfm test-SNMP-trap powersupply
- test pfm test-SNMP-trap temp-sensor

You do not have to physically remove the fan or power supply, nor do you have to physically increase the temperature, to generate these traps.

Troubleshooting Startup Issues

LEDs indicate all system states in the startup sequence. By checking the LEDs, you can determine when and where the system failed in the startup sequence.

To identify startup problems, follow these steps:

**Step 1** Turn on the power supplies by turning the switch to the on position (\). You should immediately hear the system fan module begin to operate. If not, see the “Troubleshooting Power Supply Issues” section on page 4-3.

**Step 2** If you determine that the power supplies are functioning normally yet the fan module is faulty, see the “Troubleshooting Fan Issues” section on page 4-8.
Step 3 Verify that the LEDs on the supervisor module display as follows:

a. The Status LED flashes orange once and stays orange during diagnostic boot tests. It turns green when the module is operational (online). If the system software cannot start up, this LED stays orange.

b. The System LED turns green, indicating that all chassis environmental monitors are reporting that the system is operational. If one or more of the environmental monitors reports a problem, the System LED is orange or red.

c. The Active LED turns green, indicating that the supervisor module is operational and active. If the supervisor module is in standby mode, the Active LED is orange.

d. Each Link LED flashes orange once and stays orange during diagnostic boot tests, and it turns green when the module is operational (online). If no signal is detected, the Link LED turns off. The link LED blinks orange if the port is bad.

If any LEDs on the supervisor module front panel are red or orange after the initialization time, see the “Troubleshooting Supervisor Issues” section on page 4-14. If you have a redundant supervisor module, refer to the following website for the latest Cisco MDS 9000 Family configuration guides for descriptions of the supervisor module LEDs, how the redundant supervisor module comes online, and how the software images are handled:


Step 4 Verify that the Status LEDs on the supervisor module and on each switching module are green when the supervisor module completes initialization. This LED indicates that the modules are receiving power, have been recognized by the supervisor module, and contain a valid Flash code version. This LED does not indicate the state of the individual interfaces on the switching modules. If a Status LED is red or orange, see the “Troubleshooting Supervisor Issues” section on page 4-14.

Step 5 Verify that the terminal is set correctly and that it is connected properly to the supervisor module console port if the boot information and system banner are not displayed.

Troubleshooting Power Supply Issues

This section describes power supply problems and includes the following topics:

- All Power Supply LEDs Are Off, page 4-4
- Power Supply Input Ok LED is Red, page 4-5
- Power Supply Output Failed LED is On, page 4-6
- Power Supply Fan Ok LED is Red, page 4-6
All Power Supply LEDs Are Off

**Symptom**  All power supply LEDs are off.

The following system messages may be generated with this symptom:

**Error Message**  PLATFORM-2-PS_FAIL: Power supply [dec] failed or shutdown (Serial No. [chars]).

**Explanation**  Power supply failed or has been shut down.

**Recommended Action**  Enter the `show environment power` and `show platform internal info` CLI commands or similar Fabric Manager or Device Manager command to collect more information. Refer to power supply documentation in the relevant hardware installation guide to learn more on increasing or decreasing power supply capacity and configuring power supplies.

**Error Message**  PLATFORM-2-PS_MISMATCH: Detected power supply [chars]. This reduces the redundant power available to the system and can cause service disruptions (Serial No. [chars]).

**Explanation**  Detected a new power supply that has reduced capacity compared to an existing power supply.

**Recommended Action**  Refer to power supply document on increasing decreasing power supply capacity and configuring power supplies. Enter the `show environment power` and `show platform internal info` CLI command or similar Fabric Manager/Device Manager command to collect more information.

**Error Message**  PLATFORM-5-PS_REMOVE: Power supply [dec] removed (Serial No. [chars]).

**Explanation**  Power supply has been removed.

**Recommended Action**  No action is required.
Troubleshooting Power Supply Issues

Power Supply Input Ok LED is Red

**Table 4-1 All Power Supply LEDs Are Off**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>All power supply LEDs are off.</td>
<td>Power supply is not correctly seated in the chassis.</td>
<td>Remove and reinstall the power supply. Refer to the appropriate hardware installation guide for your chassis.</td>
</tr>
<tr>
<td></td>
<td>Power supply is shut down.</td>
<td>Choose Physical &gt; Power Supplies and check the OperStatus on Device Manager, or use the show environment power CLI command to determine if the power supply is shut down. If the status is shutdown, then the supervisor has shutdown the power supply. The supervisor shuts down the lower capacity power supply only if it detects a mismatched pair of power supplies and the mode is redundant or if there is a transition from combined to redundant mode. If both power supplies are the same capacity or the mode is combined, Cisco SAN-OS never shuts down a power supply.</td>
</tr>
<tr>
<td></td>
<td>Power supply is not operational.</td>
<td>Troubleshoot the power supplies. See the “Troubleshooting the Power Supplies” section on page 4-7.</td>
</tr>
</tbody>
</table>

**Table 4-2 Power Supply Input Ok LED Is Red**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply Input Ok LED is red.</td>
<td>Power supply is not correctly seated in the chassis.</td>
<td>Remove and reinstall the power supply. Refer to the appropriate hardware installation guide for your chassis.</td>
</tr>
<tr>
<td></td>
<td>PEMs on a Cisco MDS 9500 Series chassis are not correctly installed.</td>
<td>Remove and reinstall the power supply PEMs. Refer to the appropriate hardware installation guide for your chassis.</td>
</tr>
<tr>
<td></td>
<td>External power source is not operational.</td>
<td>Power down the switch and verify the external power source. Use independent power sources to each redundant power supply in a Cisco MDS 9500 Series director.</td>
</tr>
<tr>
<td></td>
<td>Power supply is not operational.</td>
<td>Troubleshoot the power supplies. See the “Troubleshooting the Power Supplies” section on page 4-7.</td>
</tr>
</tbody>
</table>
Power Supply Output Failed LED is On

**Symptom**  Power Supply Output Failed LED is on.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supply Output Failed LED is on.</td>
<td>Power supply is not operational.</td>
<td>Troubleshoot the power supplies. See the “Troubleshooting the Power Supplies” section on page 4-7.</td>
</tr>
</tbody>
</table>

Power Supply Fan Ok LED is Red

**Symptom**  Power supply Fan Ok LED is red.

The following system messages may be generated with this symptom:


**Explanation**  Fan module in the power supply has failed.

**Recommended Action**  Enter the show environment power and show platform internal info CLI command or similar Fabric Manager/Device Manager command to collect more information.

**Introduced**  Cisco MDS SAN-OS Release 1.3(1).

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply Fan Ok LED is red.</td>
<td>Fan has failed on the power supply.</td>
<td>Choose Physical &gt; Temperature sensors on Device Manager or use the show environment temperature CLI command to verify that the chassis temperature is normal. Verify that no temperature sensors are approaching the minor thresholds. If the temperature sensors are near or over a threshold value, you should replace the power supply.</td>
</tr>
<tr>
<td>Power supply is not operational.</td>
<td>Troubleshoot the power supplies. See the “Troubleshooting the Power Supplies” section on page 4-7.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting the Power Supplies

To isolate a power supply problem, follow these steps:

**Step 1** Verify that the Input Ok LED on the power supply is green. If the Input Ok LED is green, the AC or DC source is operational and the power supply is functional.

**Step 2** If the Input Ok LED is off, first ensure that the power supply is flush with the chassis. Turn the power switch off, tighten the captive screw(s), and then turn the power switch on (I). If the Input Ok LED remains off, there might be a problem with the AC source or the DC source, or with the power cable.

a. Turn off the power to the switch by pressing or turning both power switches to 0, connect the power cord to another power source if one is available, and turn the power on. If the Input Ok LED is now green, the problem was the first power source.

b. If the Input Ok LED fails to light after you connect the power supply to a new power source, replace the power cord and turn the switch on. If the Input Ok LED lights at this point, return the first power cord for replacement.

c. If the Input Ok LED still fails to light when the switch is connected to a different power source with a new power cord, the power supply is probably faulty. If a second power supply is available, install it in the second power supply bay and contact your customer service representative for further instructions.

**Note** If you purchased Cisco support through a Cisco reseller, contact the reseller directly. If you purchased support directly from Cisco, contact Cisco Technical Support at this URL: http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

**Step 3** Repeat Step 1 if you have a second (redundant) power supply.

**Step 4** Choose Physical > Power Supplies on Device Manager or use the show environment power command to verify the status of your power supplies. (See Example 4-1.)

**Example 4-1 Output of show environment power**

```
switch# show environment power

<table>
<thead>
<tr>
<th>PS Model</th>
<th>Power (Watts)</th>
<th>Power (Amp @42V)</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 DS-CAC-1900W</td>
<td>1019.34</td>
<td>24.27</td>
<td>ok</td>
</tr>
<tr>
<td>2 DS-CAC-1900W</td>
<td>1019.34</td>
<td>24.27</td>
<td>ok</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mod Model</th>
<th>Power Requested (Watts)</th>
<th>Power Requested (Amp @42V)</th>
<th>Power Allocated (Watts)</th>
<th>Power Allocated (Amp @42V)</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 DS-X9016</td>
<td>220.08</td>
<td>5.24</td>
<td>220.08</td>
<td>5.24</td>
<td>powered-up</td>
</tr>
<tr>
<td>4 DS-X9308-SMIP</td>
<td>210.00</td>
<td>5.00</td>
<td>210.00</td>
<td>5.00</td>
<td>powered-up</td>
</tr>
<tr>
<td>5 DS-X9530-SP1-K9</td>
<td>220.08</td>
<td>5.24</td>
<td>220.08</td>
<td>5.24</td>
<td>powered-up</td>
</tr>
</tbody>
</table>

Power Usage Summary:
--------------------
Power Supply redundancy mode: redundant
Total Power Capacity 1019.34 W
```
Troubleshooting Fan Issues

This section describes fan failure problems and includes the following topics:

- Fan Is Not Spinning, page 4-8
- Fan Is Spinning; Fan LED is Red, page 4-8

Fan Is Not Spinning

**Symptom**  Fan is not spinning.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan is not spinning.</td>
<td>Fan is not correctly seated in the chassis.</td>
<td>Loosen the captive screws, remove the fan module and reinstall it to ensure that the fan module is seated properly. Tighten all captive screws, and then restart the system.</td>
</tr>
<tr>
<td></td>
<td>Power supply is not operational.</td>
<td>Troubleshoot the power supplies. See the “Troubleshooting Power Supply Issues” section on page 4-3.</td>
</tr>
</tbody>
</table>

Fan Is Spinning; Fan LED is Red

**Symptom**  Fan is spinning, but fan LED is red.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan is spinning but fan LED is red.</td>
<td>Fan is not correctly seated in the chassis.</td>
<td>Loosen the captive screws, remove the fan module and reinstall it to ensure that the fan module is seated properly. Tighten all captive screws, and then restart the system.</td>
</tr>
<tr>
<td></td>
<td>Fan module has failed.</td>
<td>Troubleshoot the Fan Module. See the “Troubleshooting a Fan Failure Using the CLI” section on page 4-10.</td>
</tr>
</tbody>
</table>
To troubleshoot a fan module problem using Device Manager, follow these steps:

**Step 1** Choose **Physical > Fan**. You see the Fan Status dialog box.

**Step 2** If the OperStatus is failure, one or more fans are not operational. Replace the failed fan module before your switch overheats. You should see the following system message in the switch log:

- **Explanation**: Fan module failed and needs to be replaced. This can lead to overheating and temperature alarms.
- **Recommended Action**: Enter the `show platform internal info` command or similar Fabric Manager/Device Manager command to collect more information.

**Step 3** If the OperStatus is absent, the fan module has been removed. As soon as the fan module is removed, Cisco SAN-OS starts a five-minute countdown.

- **Caution**: If the fan module is not reinserted within five minutes, the entire switch is shutdown.

Software reads a byte on the SEEPROM to determine if the fan module is present. If the fan module is partially inserted or if software is unable to access the SEEPROM on the fan module for any other reason, then Cisco SAN-OS cannot distinguish this case from a real fan module removal. The switch will be shut down in five minutes. The following priority 0 syslog messages are printed every five seconds:

- **Error Message**: PLATFORM-0-FAIL_REMOVED: Fan module removed. Fan module has been absent for [dec] seconds.
- **Explanation**: Fan module was removed. This could lead to temperature alarms.
- **Recommended Action**: Replace the fan module immediately.

**Step 4** Remove and reinstall or replace the fan module. If the Fan LED is still red, the system detects a fan module failure. Contact your customer service representative for instructions.

- **Note**: If you purchased Cisco support through a Cisco reseller, contact the reseller directly. If you purchased support directly from Cisco, contact Cisco Technical Support at this URL: [http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml](http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml)
Troubleshooting a Fan Failure Using the CLI

To troubleshoot a fan module problem using the CLI, follow these steps:

---

**Step 1** Use the `show environment fan` command and verify the status of each fan type. (See Example 4-2.)

**Example 4-2 show environment fan Output**

```
switch# show environment fan
--------------------------------------------------------
Fan             Model           Hw         Status
--------------------------------------------------------
Chassis        DS-9SLOT-FAN    1.2          ok
PS-1            --              --          ok
PS-2            --              --          absent
```

**Step 2** If the fan status is failure, one or more fans are not operational. Replace the failed fan module before your switch overheats. You should see the following system message in the log:


**Explanation** Fan module failed and needs to be replaced. This can lead to overheating and temperature alarms.

**Recommended Action** Enter the `show platform internal info` command to collect more information.

**Step 3** If the fan status is absent, the fan module has been removed. As soon as the fan module is removed, Cisco SAN-OS starts a five-minute countdown.

**Caution** If the fan module is not reinserted within five minutes, the entire switch is shut down.

Software reads a byte on the SEEPROM to determine if the fan module is present. If the fan module is partially inserted or if software is unable to access the SEEPROM on the fan module for any other reason, then Cisco SAN-OS cannot distinguish this case from a real fan module removal. The switch will be shut down in five minutes. The following priority 0 syslog messages are printed every five seconds:

**Error Message** PLATFORM-0-FAIL_REMOVED: Fan module removed. Fan module has been absent for [dec] seconds.

**Explanation** Fan module was removed. This could lead to temperature alarms.

**Recommended Action** Replace the fan module immediately.

**Step 4** Remove and reinstall or replace the fan module. If the Fan LED is still red, the system detects a fan module failure. Contact your customer service representative for instructions.

**Note** If you purchased Cisco support through a Cisco reseller, contact the reseller directly. If you purchased support directly from Cisco, contact Cisco Technical Support at this URL:

Temperature Threshold Violations

Each module in the chassis has at least two temperature sensors. Each temperature sensor is configured with a minor and a major threshold. Example 4-3 gives the `show environment temperature` CLI command sample output. It shows how temperature information can be retrieved from the switch. Choose Physical > Temperature Sensors on Device Manager to view a similar output.

Example 4-3  Output of show environment temperature Command

```plaintext
switch# show environment temperature

<table>
<thead>
<tr>
<th>Module</th>
<th>Sensor</th>
<th>MajorThresh (Celsius)</th>
<th>MinorThres (Celsius)</th>
<th>CurTemp (Celsius)</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Outlet</td>
<td>75</td>
<td>60</td>
<td>36</td>
<td>ok</td>
</tr>
<tr>
<td>4</td>
<td>Intake</td>
<td>65</td>
<td>50</td>
<td>29</td>
<td>ok</td>
</tr>
<tr>
<td>5</td>
<td>Outlet</td>
<td>75</td>
<td>60</td>
<td>35</td>
<td>ok</td>
</tr>
<tr>
<td>5</td>
<td>Intake</td>
<td>65</td>
<td>50</td>
<td>34</td>
<td>ok</td>
</tr>
<tr>
<td>6</td>
<td>Outlet</td>
<td>75</td>
<td>60</td>
<td>35</td>
<td>ok</td>
</tr>
<tr>
<td>6</td>
<td>Intake</td>
<td>65</td>
<td>50</td>
<td>34</td>
<td>ok</td>
</tr>
<tr>
<td>9</td>
<td>Outlet</td>
<td>75</td>
<td>60</td>
<td>45</td>
<td>ok</td>
</tr>
<tr>
<td>9</td>
<td>Intake</td>
<td>65</td>
<td>50</td>
<td>40</td>
<td>ok</td>
</tr>
</tbody>
</table>
```

The intake sensor, located at the airflow intake on the module, is the most critical indicator of module temperature. All Cisco SAN-OS actions are taken when the major threshold of an intake sensor is exceeded.

A minor threshold violation or a major threshold violation on an outlet sensor results in the following system message:

**Error Message**  PLATFORM-0-MOD_TEMPMAJALRM: Module [dec] reported major temperature alarm.

**Explanation**  Module in the slot exceeded a major temperature threshold.

**Recommended Action**  Enter the `show environment temperature` CLI command or choose Physical > Temperature Sensors on Device Manager to collect more information.

This violation also generates a Call Home event and an SNMP notification.

A major temperature threshold violation on a module intake sensor results in the following system message:

**Error Message**  PLATFORM-0-MOD_TEMPSHUTDOWN: Module [dec] powered down due to major temperature alarm.

**Explanation**  Module shutdown due to temperature exceeding major threshold.

**Recommended Action**  Enter `show environment temperature` CLI command or similar Fabric Manager/Device Manager command to collect more information.
Troubleshooting Clock Module Issues

A Cisco MDS 9500 Series director has two clock modules: A and B. Use the `show environment clock` CLI command to view the clock module status. (See Example 4-4.)

**Example 4-4  Output of show environment clock Command**

```
switch# show environment clock
----------------------------------------------------------
Clock    Model         Hw    Status
----------------------------------------------------------
A        DS-C9500-CL   0.0    ok/active
B        DS-C9500-CL   0.0    ok/standby
```

On a clock module failure, the system switches over to the redundant clock module automatically. This also results in a hardware reset of the switch. When the switch reboots, it displays the current active clock module. The following syslog message is printed at switch boot-up time, indicating the current active clock module:

**Error Message**  PLATFORM-0-CHASSIS_CLKSWRESET: Switch reset due to clock switch.

**Explanation**  Chassis clock source has failed and system will be reset. System will automatically start using the redundant clock module.

**Recommended Action**  Replace the failed clock module during the next maintenance window.
Typically, clock module A is the active clock. On a failure of clock module A, clock module B becomes the active clock. Refer to the hardware installation guide for your platform at the following website to replace a clock module.


**Troubleshooting Other Hardware Issues**

**Note**

To issue commands with the **internal** keyword, you must have an account that is a member of the network-admin group.

To identify a hardware issue with a module using the CLI, follow these steps:

**Step 1**

Use the **show module internal exceptionlog** command.

The exception log is a wraparound log of all errors and exceptional conditions on each module. Some exceptions are catastrophic, some partially affect certain ports in a module, and others are for warning purposes. Each log entry includes the following fields:

- **device id**—The device that logged the exception. This is interpreted by your customer support representative.
- **device errorcode**—The error code that occurred on the device. This is interpreted by your customer support representative.
- **error type**—The severity level of the error. Software errors are typically minor or warning. All other errors may be hardware problems.
- **Number Ports that failed**—The number of ports on the module that are no longer operational.
- **system time**—The timestamp when the problem occurred.

The exception log is stored in the NVRAM on the supervisor module.

Most hardware errors are logged in this command output. If the error type field indicates anything other than minor or warning error, then it is most likely a hardware failure. (See **Example 4-5**.)

**Example 4-5  Output of show module internal exceptionlog Command**

```
switch# show module internal exceptionlog
******* Exception info for module 6 *******
exception information --- exception instance 1 ----
device id:          85
device errorcode:   0xc550120c
system time:        (1127748710 ticks) Mon Sep 26 15:31:50 2005
error type:         Minor error
Number Ports went bad: none

******* Exception info for module 8 ******* <---Possible failed module
exception information --- exception instance 1 ----
device id:          12
device errorcode:   0x80000080
system time:        (1127843531 ticks) Tue Sep 27 17:52:11 2005
error type:         FATAL error <------------------- Error Type field
```

Send documentation comments to mdsfeedback-doc@cisco.com
Troubleshooting Supervisor Issues

Supervisor initiation varies depending on whether or not you have a redundant supervisor present. When two supervisors are present in the system at poweredup, one of the supervisors will become active and the other standby. The active supervisor initialization differs from the standby supervisor.

If there is no active supervisor in the system, the supervisor that boots up first will default to the active supervisor. If there is an active supervisor in the system, the supervisor that is booting up will default to the standby supervisor state. The standby supervisor needs to mirror the state of the active supervisor. After all components on the standby are synchronized with those of the active supervisor, the standby supervisor is up.

Cisco SAN-OS maintains debug information during runtime. When a supervisor reboots, much of the debug information is lost. However, all critical information is stored in NVRAM and can be used to reconstruct the failure. When an active supervisor reboots, the information that is stored in its NVRAM cannot be obtained until it comes back up again. Once the supervisor reboots, use the following CLI commands to view the persistent log:

- `show logging nvram`
- `show system reset-reason`
- `show module internal exception-log`

This section describes how to diagnose when an active or standby supervisor fails to initialize properly. This section includes the following topics:

- **Active Supervisor Reboots**, page 4-15
- **Standby Supervisor Not Recognized by Active Supervisor**, page 4-17
- **Standby Supervisor Stays in Powered-Up State**, page 4-19

Step 2 View the error statistics from the `show hardware internal errors` command output.

Some error statistics reported under FC-MAC are not necessarily errors, but those counters normally do not increment for a port that is in an operational state.

Step 3 View the interrupt counts in the `show hardware internal errors` command output.

Note the following:

- Some interrupts are not necessarily error interrupts.
- Some interrupts have a threshold before the corresponding ports are declared as faulty. Do not conclude that the hardware is faulty because of some interrupt counts. However, these commands are useful for your customer support representative when debugging the problems.
- Some interrupt counts may show up under UP-XBAR and DOWN-XBAR ASICs, when one of Supervisors is pulled out or restarted.

Number Ports went bad:
1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16
Active Supervisor Reboots

**Symptom**  Active supervisor reboots.

**Table 4-7  Active Supervisor Reboots**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active supervisor reboots.</td>
<td>Supervisor process crashed, resulting in a supervisor reload.</td>
<td>Use the <code>show system reset-reason</code> CLI command to view the cause of the reset after the supervisor reboots. (See Example 4-6.) If you have a standby supervisor, the standby is now the active supervisor. Display the system message log on the standby supervisor to see the same information. (See Example 4-7.) Use the <code>show process log</code> CLI command to view a list of process restarts.</td>
</tr>
<tr>
<td>Runtime diagnostics failure detected.</td>
<td></td>
<td>Use the <code>show module internal exceptionlog</code> CLI command on the standby supervisor to view the cause of the reset after the supervisor reboots. (See Example 4-8.) If you have a standby supervisor, the standby is now the active supervisor. Display the system message log on the standby supervisor to see the same information. (See Example 4-9.) Optionally, when the supervisor reboots, use the <code>show system reset-reason</code> CLI command to view this same information. See also the “Troubleshooting Cisco SAN-OS Software System Reboots” section on page 2-13.</td>
</tr>
</tbody>
</table>

Example 4-6 displays the reason for the recent when a supervisor module reboots after a process crash.

**Example 4-6  Reset Reason for Supervisor Reboot Caused by Failed Process**

```
switch# show system reset-reason
------- reset reason for module 6 -------
1) At 94009 usecs after Tue Sep 27 18:52:13 2005
   Reason: Reset triggered due to HA policy of Reset
   Service: Service "xbar" Process that caused the reboot
   Version: 2.1(2)
```

Example 4-7 displays the system messages on the standby supervisor when a supervisor reboots after a process crash.

**Example 4-7  System Messages for Supervisor Reboot Caused by Failed Process**

```
Switch# show logging
2005 Sep 27 18:58:05 172.20.150.204 %SYSMGR-3-SERVICE_CRASHED: Service "xbar" (PID 1225) hasn't caught signal 9 (no core).
2005 Sep 27 18:58:06 172.20.150.204 %SYSMGR-3-SERVICE_CRASHED: Service "xbar" (PID 2349) hasn't caught signal 9 (no core).
2005 Sep 27 18:58:06 172.20.150.204 %SYSMGR-3-SERVICE_CRASHED: Service "xbar" (PID 2352) hasn't caught signal 9 (no core).
```
Example 4-8 displays the exception log that appears when a supervisor module reboots after a runtime diagnostic failure.

**Example 4-8 Exception Log for Supervisor Reboot Caused by Runtime Diagnostic Failure**

```
switch# show module internal exceptionlog module 6
********** Exception info for module 6 **********

exception information --- exception instance 1 ----
device id: 12
device errorcode: 0x80000020
system time: (1127917068 ticks) Wed Sep 28 14:17:48 2005

error type: FATAL error <-------------------------- exception that caused the reboot
Number Ports went bad:
1,2,3,4,5,6

exception information --- exception instance 2 ----
device id: 12
device errorcode: 0x00060a02
system time: (1127917067 ticks) Wed Sep 28 14:17:47 2005

error type: Warning
Number Ports went bad:
1,2,3,4,5,6
```

Example 4-9 displays the system messages on the standby supervisor module when a supervisor module reboots after a runtime diagnostic failure.

**Example 4-9 System Messages for Supervisor Reboot Caused by Runtime Diagnostic Failure**

```
Switch# show logging
2005 Sep 28 14:17:47 172.20.150.204 %XBAR-5-XBAR_STATUS_REPORT: Module 6 reported status for component 12 code 0x60a02.
2005 Sep 28 14:17:59 172.20.150.204 %PORT-5-IF_UP: Interface mgmt0 on slot 5 is up
2005 Sep 28 14:18:00 172.20.150.204 %CALLHOME-2-EVENT: SUP_FAILURE
```
Standby Supervisor Not Recognized by Active Supervisor

**Symptom**  Standby supervisor is not recognized by the active supervisor.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby supervisor not recognized by the active supervisor.</td>
<td>Standby supervisor did not synchronize properly with active supervisor.</td>
<td>See the “Standby Supervisor Not Recognized by Active Supervisor” section on page 4-17 to verify the problem. Observe the boot process to verify that the LEDs follow the proper boot sequence and verify that the standby supervisor goes through the proper power-up, initializing, and testing phases. If the standby supervisor is at the loader&gt; prompt, use the <code>reload module 6 force-dlnd</code> command from the active supervisor to force the standby supervisor to netboot off of the active supervisor.</td>
</tr>
</tbody>
</table>

**Verifying That a Standby Supervisor Failed to Synchronize Using the CLI**

To verify that a standby supervisor did not synchronize with the active supervisor using the CLI, follow these steps:

**Step 1**  Use the `show module` command on the active supervisor to verify that the active supervisor does not detect the standby supervisor. (See Example 4-10.)

**Example 4-10  show module Command Output**

```
switch# show module  
---  -----  -------------------------------- ------------------ ------------ 
5    0      Supervisor/Fabric-1              DS-X9530-SF1-K9    active * 
8    8      IP Storage Services Module                          powered-dn 
---  -----------  ------  -------------------------------------------------- 
5    2.1(2)       1.1     -- 
---  --------------------------------------  ---------- 
5    00-0b-be-f7-4d-1c to 00-0b-be-f7-4d-20  JAB070307XG 
* this terminal session 
```

**Step 2**  Telnet to the standby supervisor console port and verify that it is in standby mode. (See Example 4-11.)

**Example 4-11  Verify Standby Supervisor Mode**

```
runlog>telnet sw4-ts 2004
Trying 172.22.22.55. 
Connected to sw4-ts.cisco.com (172.22.22.55). 
Escape character is '^]'. 
```
Step 3  Use the `show system redundancy status` command on the active supervisor to verify that the standby supervisor did not complete the synchronization phase with the active supervisor.

```
switch# show system redundancy status
Redundancy mode
------------------
 administrative:   HA
 operational:   None

This supervisor (sup-1)
-----------------------
 Redundancy state:   Active
 Supervisor state:   Active
 Internal state:   Active with HA standby

Other supervisor (sup-2)
------------------------
 Redundancy state:   Standby
 Supervisor state:   HA standby
 Internal state:   HA synchronization in progress
```

The most likely reason for the synchronization to stall is that one of the software components on the standby supervisor failed to synchronize its state with the active supervisor.

Step 4  Use the `show system internal sysmgr gsyncstats` command on the active supervisor to determine which processes did not synchronize on the standby supervisor.

```
switch# show system internal sysmgr gsyncstats
Name              Gsync done  Gsync time(sec)
----------------  ----------  -------------
 aaa                   1        0
 ExceptionLog          1        0
 platform              1        1
 radius                1        0
 securityd             1        0
 SystemHealth          1        0
 tacacs                0        N/A
 acl                   1        0
 ascii-cfg             1        1
 bios_daemon           0        N/A
 bootvar               1        0
 callhome              1        0
 capability            1        0
 cdp                   1        0
 cfs                   1        0
 cimserver             1        0
 cimxmlserver          0        N/A
 confcheck             1        0
 core-dmon             1        0
 core-client           0        N/A
 device-alias          1        0
```
Step 5 Use the **show system internal sysmgr service all** command on the standby supervisor to determine whether or not any process is experiencing excessive restarts. (See Example 4-12.)

**Note** This command may not be available if the standby supervisor is at the `loader>` prompt.

### Example 4-12 Finding Excessive Restarts

```bash
switch(standby)# show system internal sysmgr service all
```

<table>
<thead>
<tr>
<th>Name</th>
<th>UUID</th>
<th>PID</th>
<th>SAP</th>
<th>state</th>
<th>Start count</th>
</tr>
</thead>
<tbody>
<tr>
<td>aaa</td>
<td>0x00000000B5</td>
<td>1458</td>
<td>111</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>ExceptionLog</td>
<td>0x0000000050</td>
<td>[NA]</td>
<td>[NA]</td>
<td>s0002</td>
<td>None</td>
</tr>
<tr>
<td>platform</td>
<td>0x000000018</td>
<td>1064</td>
<td>39</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>radius</td>
<td>0x00000000B7</td>
<td>1457</td>
<td>113</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>securityd</td>
<td>0x000000002A</td>
<td>1456</td>
<td>55</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>vsan</td>
<td>0x0000000029</td>
<td>1436</td>
<td>15</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>vshd</td>
<td>0x0000000028</td>
<td>1408</td>
<td>37</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>wwn</td>
<td>0x0000000030</td>
<td>1435</td>
<td>114</td>
<td>s0009</td>
<td>1</td>
</tr>
<tr>
<td>xbar</td>
<td>0x0000000017</td>
<td>[NA]</td>
<td>[NA]</td>
<td>s0017</td>
<td>23</td>
</tr>
<tr>
<td>xbar_client</td>
<td>0x0000000049</td>
<td>1434</td>
<td>917</td>
<td>s0009</td>
<td>1</td>
</tr>
</tbody>
</table>
```

Looking at the standby supervisor in Example 4-12 shows that the crossbar (xbar) software component has been restarted 23 times. This has probably prevented the standby from initializing properly.

Step 6 Use the **reload module** command to restart the standby supervisor. If the restart fails, use the **reload module 6 force-dlnd** command from the active supervisor to force the standby supervisor to netboot off of the active supervisor.

---

**Standby Supervisor Stays in Powered-Up State**

**Symptom** Standby supervisor stays in powered-up state.

### Table 4-9

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standby supervisor stays in powered-up state.</td>
<td>Standby supervisor did not synchronize properly with active supervisor.</td>
<td>See the “Verifying That a Standby Supervisor Is in the Powered-Up State Using Device Manager” section on page 4-20 or the “Verifying That a Standby Supervisor Is in Powered-Up State Using the CLI” section on page 4-20.</td>
</tr>
</tbody>
</table>
Verifying That a Standby Supervisor Is in the Powered-Up State Using Device Manager

To verify that a standby supervisor is in the powered-up state using Device Manager, follow these steps:

**Step 1** Choose **Physical > Modules** and verify that the operational status of the standby supervisor (OperStatus) is PoweredUp.

**Step 2** Right-click the standby supervisor and select **Reset** from the drop-down menu to restart the standby supervisor.

Verifying That a Standby Supervisor Is in Powered-Up State Using the CLI

To verify that a standby supervisor is in the powered-up state using the CLI, follow these steps:

**Step 1** Use the **show module** command on the active supervisor to verify that the standby supervisor in the powered-up state. (See Example 4-13.)

**Example 4-13 show module Command Output**

```
switch# show module
Mod Ports Module-Type                      Model              Status
---  -----  -------------------------------- ------------------ -------------
 5    0      Supervisor/Fabric-1              DS-X9530-SF1-K9   active *
 6    0      Supervisor/Fabric-1                          powered-up
 8    8      IP Storage Services Module                  powered-dn

Mod  Sw           Hw       World-Wide-Name(s) (WWN)
---  -----------  ------  --------------------------------------------------
 5    2.1(2)       1.1     --

Mod  MAC-Address(es)                         Serial-Num
---  --------------------------------------  ----------
 5    00-0b-be-f7-4d-1c to 00-0b-be-f7-4d-20  JAB070307XG

* this terminal session
```

**Step 2** Use the **show module internal event-history module** command to determine what component may have failed.

**Step 3** Use the **reload module** command to restart the standby supervisor.

Troubleshooting Supervisor Modules

**Note**

If only one supervisor module is installed, ensure that automatic synchronization is off before servicing the other module. This prevents the switch from attempting to fail over to an unavailable module.

This section provides a workaround for a failed supervisor under certain conditions. An example situation is used to describe the problem and the workaround.
In this sample case, the supervisor failed when the standby was reloaded or when the supervisor was replaced with a new one. It was discovered that the failed supervisor either had its version of code changed, or the running configuration on the active supervisor was not saved with the appropriate boot parameters. In either case, the problem was mismatched code on the active and standby supervisors. One clue that indicated the mismatched code was a heartbeat error on the active supervisor. Because of this error, the current Flash images were unable to be copied from the active supervisor to the standby.

The workaround was to copy the images to CompactFlash, switch consoles, and load code from CompactFlash onto the second supervisor. The second supervisor was at a loader prompt, which is indicative of missing boot statements. When a `dir slot0:` CLI command was entered, none of the images appeared. This may have been the result of mismatched images on supervisors or to not having current images in Flash memory on the supervisor. Entering a `copy slot0: bootflash:` CLI command copied the images anyway. Once the images were loaded on the second supervisor and the boot statements were confirmed and saved on the active supervisor, the supervisor loaded and came up in standby-ha mode.

Troubleshooting Switching and Services Modules

This section describes problems with switching and services modules and includes the following topics and symptoms:

- Overview of Module Status, page 4-21
- Module Initialization Overview, page 4-22
- Troubleshooting Powered-Down Modules, page 4-26
- Troubleshooting Reloaded Modules, page 4-31
- Troubleshooting Modules in an Unknown State, page 4-34
- Troubleshooting Modules Not Detected by the Supervisor, page 4-35
- Reinitializing a Failed Module Using Fabric Manager, page 4-36
- Reinitializing a Failed Module Using the CLI, page 4-37
- Module Resets, page 4-38

Overview of Module Status

Choose Physical > Modules... on Device Manager or use the `show module` CLI command to see the status of any module in a switch. (See Example 4-14.)

**Example 4-14 show module Command Output**

```
switch# show module 8
Mod Ports Module-Type --------------------------- Model Status
--- ----- ----------------------------------------- ------------
8 8     IP Storage Services Module DS-X9308-SMIP ok

Mod Sw Hw World-Wide-Name(s) (WWN)
--- ------ ------------------------------------- --------------------------------------------------
8 2.1(2) 0.206 21:c1:00:05:30:00:8f:5e to 21:c8:00:05:30:00:8f:5e

Mod MAC-Address(es) Serial-Num
--- ------------------------------------- ----------------- 
8 00-05-30-00-9e-fa to 00-05-30-00-9f-06 JAB064704LH
```
The module status indicates the state of the module. Table 4-10 identifies all of the different states that a module can experience and provides a brief description of the state.

### Table 4-10 Module States

<table>
<thead>
<tr>
<th>Module Status</th>
<th>Description</th>
<th>Module Status Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>The module is up and running.</td>
<td>Good</td>
</tr>
<tr>
<td>powered-down</td>
<td>The module has been powered down because of user configuration or because of an error. Use the `show running-config</td>
<td>include poweroff` CLI command to determine whether or not the module has been configured as powered-down. Otherwise, the module was powered down because of an error. If a module reports a FATAL error, the supervisor logs an exception and reboots the module. If the supervisor reboots the module for errors three times in a one-hour interval, the supervisor keeps the module permanently powered down.</td>
</tr>
<tr>
<td>pwr-denied</td>
<td>The chassis does not have enough remaining power to power up the module. Use the <code>show environment power</code> CLI command to show the current power status of the switch.</td>
<td>Failed</td>
</tr>
<tr>
<td>powered-up</td>
<td>The module powered up and the supervisor is waiting for the module to initialize.</td>
<td>Transient</td>
</tr>
<tr>
<td>pwr-cycled</td>
<td>The module reloaded.</td>
<td>Transient</td>
</tr>
<tr>
<td>testing</td>
<td>The module has powered up and doing runtime diagnostics.</td>
<td>Transient</td>
</tr>
<tr>
<td>initializing</td>
<td>The module is receiving configuration from the supervisor.</td>
<td>Transient</td>
</tr>
<tr>
<td>upgrading</td>
<td>The module is in the process of a nondisruptive upgrade.</td>
<td>Transient</td>
</tr>
<tr>
<td>failure</td>
<td>The module has experienced a failure, but the module has not been power cycled because the debug flag was configured. Use the debug flag to collect debug information from the module as required by your customer support representative. Once all necessary data is collected, reload the module by using the <code>reload module</code> CLI command.</td>
<td>Failed</td>
</tr>
</tbody>
</table>

### Module Initialization Overview

When a module is inserted into the switch, the module goes through an initial start up sequence. This sequence brings the module to a known good state before the module is declared online. The initialization sequence includes the following steps:

- Module Bootup, page 4-23
- Image Download, page 4-23
- Runtime Diagnostics, page 4-24
- Runtime Configuration, page 4-24
- Online and Operational, page 4-24

Most of the module related failures (such as the module not coming up, the module getting reloaded, and so on) can be analyzed by looking at the logs stored on the switch. Use the following CLI commands to view this information:

- `show system reset-reason module`
Module Bootup

When a module is inserted into the switch, the supervisor puts the module in powered-up state. In this state, the supervisor waits for the module to boot and send its identification to the active supervisor. If the supervisor does not receive the registration from the module within a given time frame, it power cycles the module. This failure is called a boot-up failure. The failure codes for boot-up failure can be obtained using the `show platform internal event-history errors` CLI command. (See Example 4-15.)

Example 4-15 Finding Boot-Up Failure Codes

```
switch# show platform internal event-history errors
The following error codes are defined
No Boot Device = 0xF1
Boot Failed= 0xC0
Net Boot Failed   = 0xD0
Unknown Status   = 0x1B
```

Image Download

Once the supervisor receives the registration message, it checks the image compatibility matrix. The image compatibility determines whether or not the version of code running on the supervisor is compatible with the version of code running on the module. If the versions do not match, the module downloads an updated version of the code, reboots, and sends a registration message again with the updated parameters.

If the module is unable to download the code, the supervisor generates the following system message:

**Error Message** MODULE-2-MOD_DNLD_FAIL: Image download failed for module [dec].

**Explanation** The module failed to download a new image from the supervisor module.

**Recommended Action** Collect module information by entering the `show module internal all module <dec>` command.
In addition, the module generates a system message indicating the exact reason why the image download failed:

Error Message  IMAGE_DNLD-SLOT#:2-ADDON_IMG_DNLD_FAILED: Module image download process failed. [chars].

Explanation  The add-on image download to the module failed. This module is not operational until an add-on image has been successfully installed.

Recommended Action  Verify the location and version of your module image. Enter install module CLI command or similar Fabric Manager/Device Manager command to download a new module image.

If the image download fails, the supervisor power cycles the module. Choose Logs > Switch Resident > Syslog > Since Reboot in Device Manager or use the show logging CLI command to view the failure messages.

Runtime Diagnostics

After the module successfully registers with the supervisor, the module checks the hardware. If this fails, the module reports the error to the supervisor and generates the following system message:


Explanation  The module reported a failure in the runtime diagnostic. Module manager is going to power cycle the module.

Recommended Action  Collect information about the module by entering the show module internal all module CLI command.

In addition, this information is stored in the exception log (which is persistent across reboots). The supervisor then power cycles the module. Choose Logs > Switch Resident > Syslog > Since Reboot in Device Manager or use the show logging and show module internal exception-log module CLI commands to retrieve failure information.

Runtime Configuration

After the runtime diagnostics complete successfully, the module informs the supervisor that it is ready for configuration. Individual supervisor components configure the module. If any component reports a problem during this stage, the supervisor reboots the module. Use the show module internal event-history module CLI command to determine which component reported the problem.

Online and Operational

After all the supervisor components have configured the module, the module goes to the ok state. In this state, the module is online and operational. The supervisor continues to monitor the module periodically to verify correct operation. The following events are monitored:

- Heartbeat message—Sent between the supervisor and the module to verify that the module is running.
Troubleshooting Switching and Services Modules

Chapter 4  Troubleshooting Hardware

Send documentation comments to mdsfeedback-doc@cisco.com

- Online health management (OHMS)—Sent from the supervisor to all the ports in the module to verify that traffic is flowing properly.

In addition, the module monitors itself and generates an exception if it detects an anomalous condition. If the exception is a FATAL error, the module is power cycled. Use the following CLI commands to view the conditions leading up to the problem:

- show logging
- show module diag
- show module internal exception-log module
- show module internal event-history module
- show hardware internal errors

Analyzing The Logs

In some instances, you may need to check other internal logs to verify the cause of a problem. You can use the state transition log and the error log in these instances. These logs may hold information not present in the system messages or in the exception log because of interactions between the module and the supervisor. The state transition log is sorted in ascending manner (that is, the latest state is at the end of the log). The error log is sorted in descending manner (that is, the latest error is at the beginning of the log).

Use the show module internal event-history module CLI command to view the state transition log for a module. Use the show module internal event-history errors CLI command to view the error log.

The state transition log indicates the current state of a given module. (See Example 4-16.) Each element of the transition log contains the following information:

- Timestamp
- Node that triggered the state transition
- Module state prior to transition
- Event that occurred
- Current state of module

Example 4-16  State Transition Log

7) FSM:<ID(2): Slot 8, node 0x0800> Transition at 14258 usecs after Mon Sep 26 17:50:56 2005

    Previous state: [LCM_ST_LC_POWERED_UP]
    Triggered event: [LCM_EV_PFM_LC_STATUS_POWERED_DOWN]
    Next state: [LCM_ST_LC_NOT_PRESENT]

Based on the above state transition you can infer that when the module was in the powered-up state, PFM triggered an event to power down the module. This trigger caused the state machine to go to the not present state.

Troubleshooting Module Issues

To isolate a module problem, follow these steps:

Step 1  Verify that all Status LEDs are green. If any status LED is red or off, the module might have shifted out of its slot.
Step 2  Reseat the module until both ejector levers are at 90 degrees to the rear of the chassis.

Step 3  Tighten the captive screws at the left and right of the module front panel.

Step 4  Restart the system.

If the Status LED on a switching module is orange, the module might be busy or disabled. Refer to the following website for the latest Cisco MDS 9000 Family configuration guides to configure or enable the interfaces:


After the system reinitializes the interfaces, the Status LED on the module should be green.

Step 5  If the module does not transition into the online state, see the symptoms listed in this section.

If you are unable to resolve a problem with the startup, gather the information listed under Appendix A, “Before Contacting Technical Support” and contact your technical support representative for assistance as directed in the “Obtaining Documentation, Obtaining Support, and Security Guidelines” section on page xxxii.

Troubleshooting Powered-Down Modules

Symptom  Module is in the powered-down state.

The following system messages may be present if a module fails to power up:

Error Message  PLATFORM-2-PFM_LC_BOOT_DEV_ABSENT: No bootflash found in Module [dec].

Explanation  No bootflash found.

Recommended Action  Put bootflash in the module and try again.

Error Message  PLATFORM-2-PFM_LC_BOOT_DEV_FAIL: BAD Bootflash found in Module [dec].

Explanation  Bad bootflash found.

Recommended Action  Replace the bootflash in the module and try again.


Explanation  Netboot failed.

Recommended Action  Replace the BIOS in the module. See the “Troubleshooting Cisco SAN-OS Software System Reboots” section on page 2-13.
Troubleshooting Switching and Services Modules

Chapter 4 Troubleshooting Hardware

Send documentation comments to mdsfeedback-doc@cisco.com

Error Message  PLATFORM-2-PFM_LC_REGISTRATION_FAIL: Could not register with Module [dec].

Explanation  Module registration failed.

Recommended Action  Replace the module.


Explanation  Status for module that failed registration.

Recommended Action  Replace the module.

Error Message  PLATFORM-3-MOD_PWRFAIL: Module [dec] failed to power up (Serial No. [chars]).

Explanation  The module failed to power up.

Recommended Action  Enter the show platform internal all module [dec] CLI command to collect more information.

Introduced  Cisco MDS SAN-OS Release 1.2(2a).

Error Message  PLATFORM-3-MOD_PWRIDPROMFAIL: Module [dec] failed to power up due to idprom read error.

Explanation  The module cannot be powered up because of an IDPROM read error.

Recommended Action  Enter the show platform internal all module [dec] and show module internal all module [dec] show sprom module [dec][dec] CLI command to read module IDPROM contents to collect more information.

Error Message  PLATFORM-5-MOD_PWRDN: Module [dec] powered down (Serial No. [chars]).

Explanation  The module is powered down.

Enter the show module, show platform internal all module[dec] and show module internal all module [dec] CLI command to collect more information if you suspect module has been powered down due to errors.
To diagnose the reason for a powered-down module using the CLI, follow these steps:

1. **Step 1**
   
   Use the `show system reset-reason module` command to show the reason for the last reload of the module.

2. **Step 2**
   
   Use the `show module` command to verify the status of the module.

```
switch# show module

Mod  Ports  Module-Type                      Model                    Status
---  -----  -------------------------------- ------------------ ------------
5    0      Supervisor/Fabric-1              DS-X9530-SF1-K9    ha-standby
6    0      Supervisor/Fabric-1              DS-X9530-SF1-K9    active *
8    8      IP Storage Services Module       ---------            powered-dn
```

### Table 4-11 Module is in the Powered-Down State

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module is in powered-down state.</td>
<td>Module experienced boot-up failures.</td>
<td>Choose Logs &gt; Switch Resident &gt; Syslog &gt; Sever Events on Device Manager or use the <code>show logging</code> CLI command to verify bootup problems. Right-click the module in Device Manager and select <code>Reset</code> or use the <code>reload module</code> CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37.</td>
</tr>
</tbody>
</table>
| Module failed to register with the supervisor. | Use the `show module internal event-history module` CLI command and look for:  
  ```
  Triggered event: [LCM_EV_LCP_REGISTRATION_TIMEOUT]
  ```  
  to verify that the module did not register. Right-click the module in Device Manager and select `Reset` or use the `reload module` CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37. |  |
| Module failed to connect to fabric. | Use the `show system internal xbar internal event-history module` CLI command and look for:  
  ```
  Triggered event: [XBM_MOD_EV_SYNC_FAILED]
  ```  
  to verify that the module could not connect to the fabric. Right-click the module in Device Manager and select `Reset` or use the `reload module` CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37. |  |
| Supervisor failed to configure the module. | Verify the cause of the failure. See the “Diagnosing a Powered-Down Module” section on page 4-28. Right-click the module in Device Manager and select `Reset` or use the `reload module` CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37. |  |
Step 3  Use the **show logging** command to see what events occurred on this module.

```
Switch# show logging
```

```
2005 Sep 27 15:26:02 172.20.150.204 %PLATFORM-5-MOD_DETECT: Module 8 detected (Serial number JAB064704LH)
2005 Sep 27 15:26:02 172.20.150.204 %PLATFORM-5-MOD_PWRUP: Module 8 powered up (Serial number JAB064704LH)
2005 Sep 27 15:27:03 172.20.150.204 %MODULE-5-MOD_REINIT: Re-initializing module 8
2005 Sep 27 15:27:09 172.20.150.204 %PLATFORM-5-MOD_DETECT: Module 8 detected (Serial number JAB064704LH)
2005 Sep 27 15:27:09 172.20.150.204 %PLATFORM-5-MOD_PWRUP: Module 8 powered up (Serial number JAB064704LH)
2005 Sep 27 15:28:10 172.20.150.204 %MODULE-5-MOD_REINIT: Re-initializing module 8
2005 Sep 27 15:28:15 172.20.150.204 %PLATFORM-5-MOD_DETECT: Module 8 detected (Serial number JAB064704LH)
2005 Sep 27 15:28:15 172.20.150.204 %PLATFORM-5-MOD_PWRUP: Module 8 powered up (Serial number JAB064704LH)
2005 Sep 27 15:29:16 172.20.150.204 %MODULE-5-MOD_REINIT: Re-initializing module 8
2005 Sep 27 15:29:22 172.20.150.204 %PLATFORM-5-MOD_DETECT: Module 8 detected (Serial number JAB064704LH)
```

Note that module 8 powered up and reinitialized three times. This indicates that the module was never able to go online. The supervisor powered down the module.

Step 4  Use the **show module internal exception module** command to view the exception log.

```
switch# show module internal exception log module 8
********* Exception info for module 8 *********
exception information --- exception instance 1 ----
device id: 8
device errorcode: 0x40000002
system time: (1127835023 ticks) Tue Sep 27 15:30:23 2005
error type: Warning
Number Ports went bad: none
```

```
exception information --- exception instance 2 ----
device id: 8
device errorcode: 0x40000002
system time: (1127834956 ticks) Tue Sep 27 15:29:16 2005
error type: Warning
Number Ports went bad: none
```

```
exception information --- exception instance 3 ----
device id: 8
device errorcode: 0x40000002
system time: (1127834890 ticks) Tue Sep 27 15:28:10 2005
error type: Warning
Number Ports went bad: none
```

```
exception information --- exception instance 4 ----
device id: 8
device errorcode: 0x40000002
system time: (1127834823 ticks) Tue Sep 27 15:27:03 2005
```
Note that the time when the module was reinitialized (from system messages) and the time when the exceptions were raised (in the exception log) are correlated. This means that device ID:8 had errors while bringing the module up.

**Step 5** Use the `show module internal activity module` and the `show module internal event-history module` commands to gather more information.

```
Switch# show module internal event-history module 8
    Instance:3, Seq Id:0x2710, Ret:success
    Seq Type:SERIAL

80) Event:ESQ_REQ length:32, at 667362 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x1, Ret:success
    [E_MTS_TX] Dst:MTS_SAP_ILC_HELPER(125), Opc:MTS_OPC_LC_INSERTED(2810)

81) Event:ESQ_REQ length:32, at 667643 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x2, Ret:success
    [E_MTS_TX] Dst:MTS_SAP_MIGUTILS_DAEMON(949), Opc:MTS_OPC_LC_INSERTED(1081)

82) Event:ESQ_RSP length:32, at 673004 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x2, Ret:success
    [E_MTS_RX] Src:MTS_SAP_MIGUTILS_DAEMON(949), Opc:MTS_OPC_LC_INSERTED(1081)

83) Event:ESQ_REQ length:32, at 673265 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x3, Ret:success
    [E_MTS_TX] Dst:MTS_SAP_XBAR_MANAGER(48), Opc:MTS_OPC_LC_INSERTED(1081)

85) Event:ESQ_RSP length:32, at 692394 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x3, Ret:(null)
    [E_MTS_RX] Src:MTS_SAP_XBAR_MANAGER(48), Opc:MTS_OPC_LC_INSERTED(1081)

86) FSM:<ID(3): Slot 8, node 0x0802> Transition at 692410 usecs after Tue Sep 27 15:30:23 2005
    Previous state: [LCM_ST_CHECK_INSERT_SEQUENCE]
    Triggered event: [LCM_EV_LC_INSERTED_SEQ_FAILED]
    Next state: [LCM_ST_CHECK_REMOVAL_SEQUENCE]

87) Event:ESQ_START length:32, at 692688 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x2710, Ret:success
    Seq Type:SERIAL

    Instance:3, Seq Id:0x1, Ret:success
    [E_MTS_TX] Dst:MTS_SAP_MIGUTILS_DAEMON(949), Opc:MTS_OPC_LC_REMOVED(1082)

89) Event:ESQ_RSP length:32, at 698390 usecs after Tue Sep 27 15:30:23 2005
    Instance:3, Seq Id:0x1, Ret:success
    [E_MTS_RX] Src:MTS_SAP_MIGUTILS_DAEMON(949), Opc:MTS_OPC_LC_REMOVED(1082)

    Instance:3, Seq Id:0xc, Ret:success
    [E_MTS_TX] Dst:MTS_SAP_XBAR_MANAGER(48), Opc:MTS_OPC_LC_REMOVED(1082)

    Instance:3, Seq Id:0xc, Ret:success
    [E_MTS_RX] Src:MTS_SAP_XBAR_MANAGER(48), Opc:MTS_OPC_LC_REMOVED(1082)

110) FSM:<ID(3): Slot 8, node 0x0802> Transition at 716643 usecs after Tue Sep 27 15:30:23 2005
    Previous state: [LCM_ST_CHECK_REMOVAL_SEQUENCE]
    Triggered event: [LCM_EV_ALL_LC_REMOVED_RESP_RECEIVED]
    Next state: [LCM_ST_LC_FAILURE]
Step 6
Starting with the most recent time (end of the log) and moving backwards in this example, you can infer the following:

- Curr state: [LCM_ST_LC_NOT_PRESENT] ---- Indicates that the module is not present.

- Index 112) Triggered event: [LCM_EV_FAILED_MORE3TIMES] ---- Indicates that the module failed repeatedly.

- Index 111) Triggered event: [LCM_EV_LC_INSERTED_SEQ_FAILED] ---- Indicates that the insertion sequence failed.

- Index 86) Previous state: [LCM_ST_CHECK_INSERT_SEQUENCE] Triggered event: [LCM_EV_LC_INSERTED_SEQ_FAILED] Next state: [LCM_ST_CHECK_REMOVAL_SEQUENCE] ---- Indicates that when module was being inserted, the insertion failed and the module was removed.

- Index 85) Event:ESQ_RSP length:32, at 692394 usecs after Tue Sep 27 15:30:23 2005 Instance:3, Seq Id:0x3, Ret:(null) [R_MTS_RX] Src::MTS_SAP_XBAR_MANAGER(48), Opc::MTS_OPC_LC_INSERTED(1081) ---- Indicates the event that caused the module insertion to fail. This indicates that xbar_manager failed.

In this example, you can conclude that module is not coming up, because the XBAR Manager is failing during the insertion of the module.

Troubleshooting Reloaded Modules

**Symptom**
Module is automatically reloaded.

The following system messages may be present if a module reloads:
Troubleshooting Switching and Services Modules

Send documentation comments to mdsfeedback-doc@cisco.com

Error Message  MODULE-2-MOD_NOT_ALIVE: Module [dec] not responding... resetting.

Explanation  The module is not replying to the hello message. The module manager will reset the module.

Recommended Action  No action is required.

Error Message  MODULE-2-MOD_SOMEPORTS_FAILED: Module [dec] reported failure on ports [dec]/[dec]-[dec]/[dec] ([chars]) due to [chars] in device [dec] (error [hex]).

Explanation  Module reported a failure in the runtime diagnostic because of a failure in some of the ports.

Recommended Action  Collect module information by entering the `show module internal all module` CLI command.


Explanation  The module reported a failure in the runtime diagnostic. Module manager is going to power cycle the module.

Recommended Action  Collect information about the module by entering the `show module internal all module` CLI command.


Explanation  Port loop-back test failure.

Recommended Action  No action is required.

Error Message  SYSTEMHEALTH-2-OHMS_MOD_SNAKE_TEST_FAILED: Module [dec] has failed snake loopback tests.

Explanation  Snake test failure.

Recommended Action  No action is required.
Diagnosing a Reloaded Module

To diagnose the reason for a reloaded module, follow these steps:

**Step 1** Right-click the module and select Module on Device Manager or use the show module CLI command to verify the status of the module.

**Step 2** Choose Logs > Switch Resident > Syslog > Sever Events on Device Manager or use the show logging CLI command to search for common reload problems.

**Step 3** Use the show module internal exception module CLI command to view the exception log.

```
switch# show module internal exception module 8
*********** Exception info for module 8 ***********
exception information --- exception instance 3 ----
device id: 0
device errorcode: 0x40730017
system time: (1127843486 ticks) Tue Sep 27 17:51:26 2005
error type: FATAL error
Number Ports went bad: 1,2,3,4,5,6,7,8

exception information --- exception instance 4 ----
device id: 5
```

Table 4-12 Module is Automatically Reloaded

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module is automatically reloaded.</td>
<td>Module experienced heartbeat failures.</td>
<td>Choose Logs &gt; Switch Resident &gt; Syslog &gt; Sever Events on Device Manager or use the show logging CLI command to verify bootup problems. Use the show module internal event-history module CLI command and look for Triggered event: [LCM_EV_LCP_ALIVE_TIMEOUT] to verify that the module did not respond to heartbeat requests. Right-click the module in Device Manager and select Reset or use the reload module CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37.</td>
</tr>
<tr>
<td>The module experienced runtime diagnostic failures.</td>
<td>Verify the cause of the failure. See the “Diagnosing a Reloaded Module” section on page 4-33. Right-click the module in Device Manager and select Reset or use the reload module CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37.</td>
<td></td>
</tr>
<tr>
<td>Module lost synchronize with the fabric.</td>
<td>Use the show system internal xbar internal event-history errors and look for something similar to: Rx MTS_OPC_SSA_LOST_SYNC_SERIAL slot 8 fabric 0 link 0 to verify that the module lost sync with the fabric. Right-click the module in Device Manager and select Reset or use the reload module CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting Modules in an Unknown State

Symptom  Module is in the unknown state.

Table 4-13  Module Is in an Unknown State

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module is in an unknown state.</td>
<td>Module experienced SPROM failures.</td>
<td>Verify the cause of the failure. See the “Diagnosing a Module in the Unknown State” section on page 4-34. Right-click on the module in Device Manager and select Reset or use the reload module CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37.</td>
</tr>
</tbody>
</table>

Diagnosing a Module in the Unknown State

To diagnose a module in the unknown state, follow these steps:

Step 1  Right-click the module and select Module on Device Manager or use the show module CLI command to verify the status of the module.

Step 2  Choose Logs > Switch Resident > Syslog > Sever Events on Device Manager or use the show logging CLI command to search for common problems.

Step 3  Use the show platform internal event-history errors CLI command to view possible causes for the unknown state.

switch# show platform internal event-history errors
1) Event:E_DEBUG, length:37, at 370073 usecs after Thu Sep 29 17:22:48 2005
   [103] unable to init 1c sprom 0 mod 8

switch# show platform internal event-history module 8
Inside pfm_show_eventlog
Troubleshooting Modules Not Detected by the Supervisor

**Module Is Not Detected by Supervisor**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module is not detected by the supervisor.</td>
<td>Module experienced SPROM failures.</td>
<td>Verify the cause of the failure. Right-click the module in Device Manager and select <strong>Reset</strong> or use the <strong>reload module</strong> CLI command to restart the module. See the “Reinitializing a Failed Module Using Fabric Manager” section on page 4-36 or the “Reinitializing a Failed Module Using the CLI” section on page 4-37.</td>
</tr>
<tr>
<td>Module is not supported by the current version of Cisco SAN-OS on the switch.</td>
<td></td>
<td>Upgrade the software version on the switch. See the “Installing SAN-OS Software Using Fabric Manager” section on page 2-10 or the “Installing Cisco SAN-OS Software from the CLI” section on page 2-11.</td>
</tr>
</tbody>
</table>

**Diagnosing a Module Not Detected by the Supervisor**

To diagnose a module that has not been detected by the supervisor, follow these steps:

**Step 1** Right-click the module and select **Module** on Device Manager or use the **show module** CLI command to verify the status of the module.

**Step 2** Choose **Logs > Switch Resident > Syslog > Server Events** on Device Manager or use the **show logging** CLI command to search for common problems.

**Step 3** Use the **show platform internal event-history errors** CLI command to view possible causes.

```
switch# show platform internal event-history errors
1) Event:E_DEBUG, length:42, at 703984 usecs after Thu Sep 29 17:46:20 2005
   [103] Module 8 pwr mgmt I/O cntrl reg 0x74
```
When a module is inserted into the switch, the supervisor module reads the SPROM contents of the module. If the module is supported by the current version of Cisco SAN-OS, the module will be powered-up by the supervisor module. If the power status does not show that the module has powered up properly, the module information is not relayed to the supervisor.

### Reinitializing a Failed Module Using Fabric Manager

To reinitialize a failed module using the Fabric Manager, follow these steps:

1. **Step 1** Choose **Switches > Copy Configuration** to save the running configuration to the startup configuration.
2. **Step 2** Choose **Switches > Hardware**. Then select the **Module Status** tab in the Information pane and check the **Reset** check box to reload the module. Click the **Apply Changes** icon.
3. **Step 3** If the module is not up, choose **Switches > Hardware** and check the S/W Rev column to verify the software image on the module.
4. **Step 4** If the software image on the module is not the latest, choose **Tools > Other > Software Install** to download the latest image to supervisor bootflash memory.
5. **Step 5** Use the CLI to force-download the software image from the supervisor to the module.
Send documentation comments to mdsfeedback-doc@cisco.com

Step 6 If the module is still not up, choose **Switches > Hardware** and view the Power Admin column to verify the power status for the module.

Step 7 If the module is not powered on, remove and reseat the module and select **on** from the Power Admin drop-down menu to power on the module.

Step 8 If the module is still not operating, right-click on the switch in the map pane and select **Reset** to reload the entire switch.

Reinitializing a Failed Module Using the CLI

To reinitialize a failed module using the CLI, follow these steps:

Step 1 Save the running configuration to the startup configuration.

```
switch# copy running-config start-config
```

Step 2 Reload the module.

```
switch# reload module 2
```

Step 3 If the module is not operating, verify the software image on the module.

```
switch# show module
```

Step 4 If the software image on the module is not the latest, download the latest image to supervisor bootflash memory.

```
switch# copy tftp: bootflash:
```

Step 5 Force-download the software image from the supervisor to the module.

```
switch# reload module 2 force-dnld
```

Step 6 If the module is still not operating, verify the power status for the module.

```
switch# show environment power
```

Step 7 If the module is not powered on, remove and reseat the module and then power on the module.

```
switch# config t
switch(config)# no poweroff module 2
switch(config)# exit
switch#
```

Step 8 If the module is still not operating, reload the entire switch.

```
switch# reload
```
Module Resets

Resets and reboots of modules are covered in detail in the “Troubleshooting Cisco SAN-OS Software System Reboots” section on page 2-13. If you use the `module reset-reason` CLI command and the output has an “unknown” reset reason, this may indicate a hardware problem. Some of the conditions that may cause this include the following:

- The switch experienced a power reset. This may be because you reset the power supplies or because of a power interruption or failure.
- The front panel reset button on the supervisor module was pressed.
- Any hardware failure that caused the processor, dynamic memory, or I/O to reset or hang.
Troubleshooting Mixed Generation Hardware

This chapter describes how to identify and resolve problems that might occur when you combine Generation 1 and Generation 2 hardware components of the Cisco MDS 9000 Family. It includes the following sections:

- Overview, page 5-1
- Combining Modules and Supervisors, page 5-7
- Initial Troubleshooting Checklist, page 5-7
- Generation 1 and Generation 2 Issues, page 5-7

Overview

Table 5-1 identifies the modules supported by the Cisco MDS 9500 Series switches and Cisco MDS 9216A and Cisco MDS 9216i switches, as well as the Generation 2 switches:

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modules</td>
<td></td>
</tr>
<tr>
<td>DS-X9148</td>
<td>48-port 4-Gbps Fibre Channel switching module</td>
</tr>
<tr>
<td>DS-9304-18K9</td>
<td>18-port 1/2/4-Gbps Fibre Channel ports with 4 Gigabit Ethernet ports</td>
</tr>
<tr>
<td>DS-X9112</td>
<td>12-port 4-Gbps Fibre Channel switching module</td>
</tr>
<tr>
<td>DS-X9704</td>
<td>4-port 10-Gbps Fibre Channel switching module</td>
</tr>
<tr>
<td>DS-X9530-SF2-K9</td>
<td>Supervisor-2 module (Cisco MDS 9500 Series switches only)</td>
</tr>
<tr>
<td>Switches</td>
<td></td>
</tr>
<tr>
<td>DS-C9222i-K9</td>
<td>10-port 4-Gbps Fibre Channel switch with 4 Gigabit Ethernet IP storage ports, and a modular expansion slot to host Cisco MDS 9000 Family Switching and Services Modules</td>
</tr>
<tr>
<td>DS-9134-K9</td>
<td>34-port 4-Gbps Fibre Channel switch</td>
</tr>
</tbody>
</table>
Chapter 5  Troubleshooting Mixed Generation Hardware

Overview

Note

Generation 2 Fibre Channel switching modules are not supported on the Cisco MDS 9216 switch; however, they are supported by both the Supervisor-1 module and the Supervisor-2 module.

The 4-port 10-Gbps Fibre Channel switching module supports 10-Gbps port rates. The rest of the Generation 2 modules support 1-Gbps, 2-Gbps, 4-Gbps, or autosensing port rates.

For detailed information about the installation and specifications for these modules, refer to the hardware installation guide or the Configuration guides at the following website:


This section explains the features of Generation 2 modules and includes the following topics:

- Port Groups, page 5-2
- Port Speed Mode, page 5-3
- Dynamic Bandwidth Management, page 5-3
- Out-of-Service Interfaces, page 5-4
- Port Index Availability, page 5-4

Port Groups

Each module has four groups of one or more ports in port groups that share common resources, such as bandwidth and buffer credits. Table 5-2 shows the port groups for the Generation 2 Fibre Channel switches and modules.

<table>
<thead>
<tr>
<th>Module or Switch</th>
<th>Description</th>
<th>Number of Ports Per Port Group</th>
<th>Bandwidth Per Port Group</th>
<th>Maximum Bandwidth Per Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS-X9148</td>
<td>48-port 4-Gbps</td>
<td>12</td>
<td>12.8</td>
<td>4-Gbps^1</td>
</tr>
<tr>
<td>DS-X9124</td>
<td>24-port 4-Gbps</td>
<td>6</td>
<td>12.8</td>
<td>4-Gbps^2</td>
</tr>
<tr>
<td>DS-9304-18K9</td>
<td>18-port/4-port 4-Gbps (MSM-18/4 module)</td>
<td>6</td>
<td>12.8</td>
<td>4-Gbps^1</td>
</tr>
<tr>
<td>DS-X9112</td>
<td>12-port 4-Gbps</td>
<td>3</td>
<td>12.8</td>
<td>4-Gbps^1</td>
</tr>
<tr>
<td>DS-X9704</td>
<td>4-port 10-Gbps</td>
<td>1</td>
<td>10</td>
<td>10-Gbps^2</td>
</tr>
<tr>
<td>DS-C9134-K9</td>
<td>32-port 4-Gbps</td>
<td>4</td>
<td>16</td>
<td>4-Gbps</td>
</tr>
<tr>
<td></td>
<td>2-port 10-Gbps</td>
<td>1</td>
<td>10</td>
<td>10-Gbps</td>
</tr>
</tbody>
</table>

Table 5-1  Generation 2 Modules and Switches (continued)

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS-X9124</td>
<td>24-port 4-Gbps Fibre Channel switch</td>
</tr>
<tr>
<td>DS-9304-K9</td>
<td>18-port 1/2/4-Gbps Fibre Channel switch with 4 Gigabit Ethernet ports in fixed slot1</td>
</tr>
</tbody>
</table>

Table 5-2  Bandwidth and Port Groups for Generation 2 Modules

---

Send documentation comments to mdsfeedback-doc@cisco.com
**Overview**

Port groups are defined by the hardware and consist of sequential ports. For example, ports 1 through 12, ports 13 through 24, ports 25 through 36, and ports 37 through 48 are the port groups on the 48-port 4-Gbps Fibre Channel switching modules.

**Port Speed Mode**

Table 5-3 shows the port speeds allowed on each Generation 2 switching module.

<table>
<thead>
<tr>
<th>Module or Switch</th>
<th>Description</th>
<th>Number of Ports Per Port Group</th>
<th>Bandwidth Per Port Group</th>
<th>Maximum Bandwidth Per Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS-C9124</td>
<td>24-port 4 Gbps</td>
<td>6</td>
<td>12.8</td>
<td>4-Gbps</td>
</tr>
<tr>
<td>DS-C9222i-K9</td>
<td>18-port 4-Gbps</td>
<td>6</td>
<td>12.8</td>
<td>4-Gbps</td>
</tr>
</tbody>
</table>

1. Dedicated bandwidth with no oversubscription
2. Dedicated bandwidth or oversubscribed using shared buffer resources.

**Dynamic Bandwidth Management**

Table 5-4 shows the bandwidth reserved based on port speed for ports in dedicated mode.

<table>
<thead>
<tr>
<th>Port Speed</th>
<th>Bandwidth Reserved per Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto / 4 Gbps</td>
<td>4 Gbps</td>
</tr>
<tr>
<td>Auto max 2000 / 2 Gbps</td>
<td>2 Gbps</td>
</tr>
<tr>
<td>1 Gbps</td>
<td>1 Gbps</td>
</tr>
<tr>
<td>10 Gbps</td>
<td>10 Gbps</td>
</tr>
</tbody>
</table>

1. Available only on the 4-port 10-Gbps switching module.

Table 5-5 shows the bandwidth reserved based on port speed for ports in shared mode.
Overview

Tip
When migrating a host only supporting up to 2-Gbps traffic to the 4-Gbps switching modules, use autosensing with 2-Gbps maximum bandwidth.

Note
The 4-port 10-Gbps switching module only supports 10-Gbps links.

Out-of-Service Interfaces

You can take interfaces out of service to release shared resources that are needed for dedicated bandwidth. This feature is especially useful for the 48-port 4-Gbps switching modules. When an interface is taken out of service, all shared resources are released and made available to the other interface in the port group or module.

Caution
If you need to bring an interface back into service, you might disrupt traffic if you need to release shared resources from other interfaces.

Port Index Availability

Each chassis in the Cisco MDS 9000 Series has a hardware-based maximum port availability based on internally assigned port indexes. When the maximum number of port indexes is reached in a chassis, any modules remaining or added to the chassis will not boot up. The number of physical ports on a Fibre Channel module is equal to its number of port indexes. However, for Gigabit Ethernet modules (IPS-8, IPS-4, and MPS-14/2), one physical port is equal to four port indexes (one port index for iSCSI and three port indexes for FC IP tunnels). Table 5-6 lists the physical ports and port indexes (virtual ports) allocated per Cisco MDS 9000 module.

<table>
<thead>
<tr>
<th>Table 5-5 Bandwidth Reserved for Shared Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module Type</strong></td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>24-port 4-Gbps</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>48-port 4-Gbps</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 5-6 Port Index Allocation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module</strong></td>
</tr>
<tr>
<td>---------------------------------</td>
</tr>
<tr>
<td>48-port 4-Gbps Fibre Channel switching module</td>
</tr>
<tr>
<td>24-port 4-Gbps Fibre Channel switching module</td>
</tr>
</tbody>
</table>
Overview

Using any combination of modules that include a Generation 1 module or a Supervisor-1 module limits the port index availability to 252 on all Cisco MDS 9500 Series directors. Generation 1 modules also require contiguous port indexes where the system assigns a block of port index numbers contiguously starting from the first port index reserved for the slot that the module is inserted in (See Table 5-7). This means that while there may be enough port indexes available for a Generation 1 module, the module may not boot up because the available port indexes are not in a contiguous range or the contiguous block does not start at the first port index for a given slot.

Example 5-1 shows a case with a Supervisor-1 module, where a 48-port Generation 2 module borrowed port indexes from the first slot. Slot 1 still has 16 port indexes available, but the full 32 indexes are no longer available (28-31 are used by the module in slot 4). This means that no Generation 1 module except a 16-port Fibre Channel switching module can be inserted into slot 1 because some of the port indexes for the slot are already in use.

**Example 5-1 Borrowing Port Indexes from Another Slot**

```
switch# show port index-allocation
Module index distribution:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Allowed range*</th>
<th>Allocated indices info</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0- 31</td>
<td>32-63</td>
</tr>
<tr>
<td>2</td>
<td>32- 63</td>
<td>32</td>
</tr>
<tr>
<td>3</td>
<td>64- 95</td>
<td>48</td>
</tr>
<tr>
<td>4</td>
<td>96-127</td>
<td>48</td>
</tr>
<tr>
<td>5</td>
<td>128- 159</td>
<td>32</td>
</tr>
<tr>
<td>6</td>
<td>160- 191</td>
<td>32</td>
</tr>
<tr>
<td>7</td>
<td>192- 223</td>
<td>32</td>
</tr>
<tr>
<td>SU</td>
<td>253-255</td>
<td>3</td>
</tr>
</tbody>
</table>

*Allowed range applicable only for Generation-1 modules
```

Table 5-6 Port Index Allocation (continued)

<table>
<thead>
<tr>
<th>Module</th>
<th>Physical Ports</th>
<th>Port Indexes Allocated</th>
</tr>
</thead>
<tbody>
<tr>
<td>12-port 4-Gbps Fibre Channel switching module</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>4-port 10-Gbps Fibre Channel switching module</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>16-port 2-Gbps Fibre Channel module</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>32-port 2-Gbps Fibre Channel module</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>8-port Gigabit Ethernet IP Storage services module</td>
<td>8</td>
<td>32</td>
</tr>
<tr>
<td>4-port Gigabit Ethernet IP Storage services module</td>
<td>4</td>
<td>32 (with Supervisor-1)</td>
</tr>
<tr>
<td>8-port Gigabit Ethernet IP Storage services module</td>
<td>8</td>
<td>32 (with Supervisor-2)</td>
</tr>
<tr>
<td>32-port 2-Gbps Fibre Channel Storage Services Module (SSM).</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>14-port Fibre Channel/2-port Gigabit Ethernet Multiprotocol Services (MPS-14/2) module</td>
<td>16</td>
<td>32 (with Supervisor-1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22 (with Supervisor-2)</td>
</tr>
</tbody>
</table>

1. All Generation 1 modules reserve port indexes on fixed boundaries with Supervisor-1. See Table 5-7.
2. Fourteen Fibre Channel ports and two Gigabit Ethernet ports.

Using any combination of modules that include a Generation 1 module or a Supervisor-1 module limits the port index availability to 252 on all Cisco MDS 9500 Series directors. Generation 1 modules also require contiguous port indexes where the system assigns a block of port index numbers contiguously starting from the first port index reserved for the slot that the module is inserted in (See Table 5-7). This means that while there may be enough port indexes available for a Generation 1 module, the module may not boot up because the available port indexes are not in a contiguous range or the contiguous block does not start at the first port index for a given slot.

Example 5-1 shows a case with a Supervisor-1 module, where a 48-port Generation 2 module borrowed port indexes from the first slot. Slot 1 still has 16 port indexes available, but the full 32 indexes are no longer available (28-31 are used by the module in slot 4). This means that no Generation 1 module except a 16-port Fibre Channel switching module can be inserted into slot 1 because some of the port indexes for the slot are already in use.
Overview

Using any combination of modules that include a Generation 1 module and a Supervisor-2 module limits the port index availability to 252 on all Cisco MDS 9500 Series directors. The Generation 1 modules can use any contiguous block of port indexes that start on the first port index reserved for any slot in the range 0-252. (See Table 5-7).

Using any combination of only Generation 2 with a Supervisor-2 module allows a maximum of 528 (with an architectural limit of 1020) port indexes on all Cisco MDS 9500 Series directors. Generation 2 modules do not need contiguous port indexes. Generation 2 modules use the available indexes in the slot that it is installed and then borrow available indexes from the supervisors. If the module requires more indexes, it starts borrowing available indexes from slot 1 of the chassis until it has the number of port indexes necessary.

Note

Use the purge module CLI command to free up reserved port indexes after you remove a module.

Table 5-7 Port Index Requirements

<table>
<thead>
<tr>
<th>Supervisor</th>
<th>Module</th>
<th>Port Index Requirements</th>
</tr>
</thead>
</table>
| Supervisor-1     | Generation 1 | Indexes must:  
|                  |         | - Be contiguous.  
|                  |         | - In the range assigned to the given slot.  
|                  |         | - Start with the lowest value assigned to that slot.  
|                  |         | - Have no port indexes above 256 allocated to any other operational modules.  
|                  |         | Maximum 252 assignable port indexes available.  
|                  | Generation 2 | Indexes can be any available number in the range 0-252.  
| Supervisor-2     | Generation 1 | Indexes must:  
|                  |         | - Be contiguous.  
|                  |         | - Start with the lowest value assigned to any slot.  
|                  |         | - Have no port indexes above 256 allocated to any other operational modules.  
|                  |         | Maximum 252 assignable port indexes available.  
|                  | Generation 2 | Indexes can be any available number in the range 0-1020 if all modules are Generation 2 modules. Otherwise, indexes can be any available number in the range 0-252.  

1. See the Allowed Ranges column in Example 5-1 for the port indexes assigned to each slot for Generation 1 modules.
2. 16-port Fibre Channel switching modules can use the upper 16 indexes within a slot (for example, 16-31).
Combining Modules and Supervisors

All the existing Generation 1 and Generation 2 switching modules are supported by Cisco MDS SAN-OS Release 3.0(1) and later. However, there are limitations to consider when combining the various modules and supervisors in the Cisco MDS 9500 Series platform chassis.

You can combine Generation 1 and Generation 2 switching modules with either Supervisor-1 modules or Supervisor-2 modules. However, combining switching modules and supervisor modules has the following limitations:

- Use a Supervisor-2 module and all Generation 2 modules in a chassis to get up to 1020 port indexes.
- Use the `show port index-allocation` CLI command to determine available port index values before inserting new modules in a chassis if you have a mix of Generation 1 and Generation 2 modules.
- Use only Supervisor-2 modules on a Cisco MDS 9513 director.

**Note**

You cannot downgrade from a Supervisor-2 module to a Supervisor-1 module.

Initial Troubleshooting Checklist

Begin troubleshooting Generation 1 and Generation 2 module issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify the port index allocation if a newly inserted module does not power up.</td>
<td>☐</td>
</tr>
<tr>
<td>Check that the interface that you plan to use is not set to out-of-service.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify appropriate port rate mode and port speed for your configuration.</td>
<td>☐</td>
</tr>
<tr>
<td>Ensure that both ends of a 10-Gbps link terminate in 10-Gbps ports.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that no Supervisor-1 modules are used in a Generation 2 switch.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Use the `show interface transceiver` CLI command to view enhanced diagnostics on the X2 transceivers for Generation 2 modules. This is supported on 4-Gbps and 10-Gbps ports. Use these diagnostics to isolate physical layer problems, like contact problems, major failures within SFPs, or abnormal error rates associated with excessive optical attenuation. The diagnostic information includes temperature, voltage and current, transmit power level, and receive power level.

Generation 1 and Generation 2 Issues

This section describes troubleshooting issues for Generation 1 and Generation 2 modules and includes the following topics:

- Module Does Not Come Online, page 5-8
- Cannot Configure Port in Dedicated Mode, page 5-10
- Cannot Enable a Port, page 5-13
- Cannot Upgrade Supervisor System Image, page 5-13
Module Does Not Come Online

**Symptom**  Module does not come online.

| Table 5-8  Module Does Not Come Online |
|-----------------|-----------------|-----------------|
| **Symptom** | **Possible Cause** | **Solution** |
| Module does not come online. | Not enough port indexes are available. | See the “Verifying Port Index Allocation Using Device Manager” section on page 5-8 or the “Verifying Port Index Allocation Using the CLI” section on page 5-9. If the switch has Generation 1 modules inserted, upgrade to all Generation 2 modules to gain higher total port index availability. |
| | Available port indexes are non-contiguous. | See the “Verifying Port Index Allocation Using Device Manager” section on page 5-8 or the “Verifying Port Index Allocation Using the CLI” section on page 5-9. |
| | Not enough power is available in the chassis. | Use the show environment CLI command to determine if you have enough available power for the module. Upgrade your power supply, if necessary. |

**Verifying Port Index Allocation Using Device Manager**

To verify port index allocation using Device Manager, follow these steps:

**Step 1** Choose Interfaces > Show Port Index Allocation > Current to display the allocation of port indexes on the switch.

```
Module index distribution:

Slot | Allowed | Allotted indices info |
----- |--------|-----------------------|
|      | range  | Total | Index values |
----- |--------|-------|--------------|
1     | 0-255  | 16    | 32-47        |
2     | 0-255  | 12    | 0-11         |
3     | 0-255  | -     | (None)       |
4     | 0-255  | -     | (None)       |
7     | 0-255  | -     | (None)       |
8     | 0-255  | -     | (None)       |
9     | 0-255  | -     | (None)       |
SUP   | ------ | 3     | 253-255      |
```

In some cases, the sequence in which switching modules are inserted into the chassis determines if one or more modules is powered up.
Step 2 Choose Interfaces > Show Port Index Allocation > Startup to display the index allocation that the switch uses when it reboots.

Startup module index distribution:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Allowed range</th>
<th>Alloted indices info Total</th>
<th>Index values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0-255</td>
<td>16</td>
<td>64-79</td>
</tr>
<tr>
<td>2</td>
<td>0-255</td>
<td>12</td>
<td>0-11</td>
</tr>
<tr>
<td>SUP</td>
<td>----</td>
<td>3</td>
<td>253-255</td>
</tr>
</tbody>
</table>

Step 3 Choose Physical > Modules to display the reason why a module does not power up.

Verifying Port Index Allocation Using the CLI

To verify port index allocation using the CLI, follow these steps:

Step 1 Use the show port index-allocation command to display the allocation of port indexes on the switch.

switch# show port index-allocation

Module index distribution:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Allowed range</th>
<th>Alloted indices info Total</th>
<th>Index values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0-255</td>
<td>16</td>
<td>32-47</td>
</tr>
<tr>
<td>2</td>
<td>0-255</td>
<td>12</td>
<td>0-11</td>
</tr>
<tr>
<td>3</td>
<td>0-255</td>
<td>-</td>
<td>(None)</td>
</tr>
<tr>
<td>4</td>
<td>0-255</td>
<td>-</td>
<td>(None)</td>
</tr>
<tr>
<td>7</td>
<td>0-255</td>
<td>-</td>
<td>(None)</td>
</tr>
<tr>
<td>8</td>
<td>0-255</td>
<td>-</td>
<td>(None)</td>
</tr>
<tr>
<td>9</td>
<td>0-255</td>
<td>-</td>
<td>(None)</td>
</tr>
<tr>
<td>SUP</td>
<td>----</td>
<td>3</td>
<td>253-255</td>
</tr>
</tbody>
</table>

In some cases, the sequence in which switching modules are inserted into the chassis determines if one or more modules is powered up.

Step 2 Use the show port index-allocation startup command to display the index allocation the switch uses when it reboots.

switch# show port index-allocation startup

Startup module index distribution:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Allowed range</th>
<th>Alloted indices info Total</th>
<th>Index values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0-255</td>
<td>16</td>
<td>64-79</td>
</tr>
<tr>
<td>2</td>
<td>0-255</td>
<td>12</td>
<td>0-11</td>
</tr>
<tr>
<td>SUP</td>
<td>----</td>
<td>3</td>
<td>253-255</td>
</tr>
</tbody>
</table>
Step 3  Use the show module command to display the reason why a module does not power up.

```
sw# show module
```

<table>
<thead>
<tr>
<th>Mod</th>
<th>Ports</th>
<th>Module-Type</th>
<th>Model</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>48</td>
<td>1/2/4 Gbps FC Module</td>
<td>DS-X9148</td>
<td>ok</td>
</tr>
<tr>
<td>2</td>
<td>48</td>
<td>1/2/4 Gbps FC Module</td>
<td>DS-X9148</td>
<td>ok</td>
</tr>
<tr>
<td>3</td>
<td>48</td>
<td>1/2/4 Gbps FC Module</td>
<td>DS-X9148</td>
<td>ok</td>
</tr>
<tr>
<td>4</td>
<td>32</td>
<td>1/2 Gbps FC Module</td>
<td>DS-X9032</td>
<td>ok</td>
</tr>
<tr>
<td>5</td>
<td>0</td>
<td>Supervisor/Fabric-1</td>
<td>DS-X9530-SF1-K9</td>
<td>active*</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>Supervisor/Fabric-1</td>
<td>DS-X9530-SF1-K9</td>
<td>ba-standby</td>
</tr>
<tr>
<td>7</td>
<td>16</td>
<td>1/2 Gbps FC Module</td>
<td>DS-X9016</td>
<td>ok</td>
</tr>
<tr>
<td>8</td>
<td>48</td>
<td>1/2/4 Gbps FC Module powered-dn</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>48</td>
<td>1/2/4 Gbps FC Module</td>
<td>DS-X9148</td>
<td>ok</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mod</th>
<th>Power-Status</th>
<th>Power Down Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>powered-dn</td>
<td>Insufficient resources (dest Index)</td>
</tr>
<tr>
<td></td>
<td>* this terminal session</td>
<td></td>
</tr>
</tbody>
</table>

Step 4  If the module is powered down because of port index issues, use the show module recovery-steps command to determine how to correct the problem.

```
switch# show module 4 recovery-steps
```

Failure Reason:
Contiguous and aligned indices unavailable for Generation-1 modules
Check "show port index-allocation" for more details
Please follow the steps below:
1. Power-off module in one of the following slots: 12
2. Power-on module in slot 4 and wait till it comes online
3. Power-on the module powered-off in step 1
4. Do "copy running-config startup-config" to save this setting

**Note**
Verify that the debug module no-power-down command is not turned on.

---

## Cannot Configure Port in Dedicated Mode

**Symptom** Cannot configure port in dedicated mode.

### Table 5-9 Cannot Configure Port in Dedicated Mode

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot configure a port in dedicated mode.</td>
<td>Not enough bandwidth is available in the port group.</td>
<td>See the “Verifying Bandwidth Utilization in a Port Group Using Device Manager” section on page 5-11 or the “Verifying Bandwidth Utilization in a Port Group Using the CLI” section on page 5-12.</td>
</tr>
</tbody>
</table>
Verifying Bandwidth Utilization in a Port Group Using Device Manager

To verify bandwidth utilization in a port group using Device Manager, follow these steps:

---

**Step 1**
Right-click the module and select **Show Port Resources...** to display the Generation 2 module shared resources configuration.

Module 2
Available dedicated buffers are 5164

Port-Group 1
Total bandwidth is **12.8 Gbps**
Total shared bandwidth is **4.8 Gbps**
Allocated dedicated bandwidth is **8.0 Gbps**

<table>
<thead>
<tr>
<th>Interfaces in the Port-Group</th>
<th>B2B Credit</th>
<th>Bandwidth (Gbps)</th>
<th>Rate Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>fc2/1</td>
<td>16</td>
<td>4.0</td>
<td>shared</td>
</tr>
<tr>
<td>fc2/2</td>
<td>16</td>
<td>4.0</td>
<td>shared</td>
</tr>
<tr>
<td>fc2/3</td>
<td>16</td>
<td>4.0</td>
<td>shared</td>
</tr>
<tr>
<td>fc2/4</td>
<td>16</td>
<td>4.0</td>
<td>shared</td>
</tr>
<tr>
<td>fc2/5</td>
<td>16</td>
<td>4.0</td>
<td>dedicated</td>
</tr>
<tr>
<td>fc2/6</td>
<td>16</td>
<td>4.0</td>
<td>dedicated</td>
</tr>
</tbody>
</table>

...  

In this example, there is not enough available shared bandwidth in Port-Group 1 to switch any more ports to 4-Gbps dedicated mode.

**Step 2**
Do one of the following to free up bandwidth for the port that you want to place in dedicated mode.

a. Right-click one or more ports and choose **Service > Out** to put a port in out-of-service mode to free up more resources.

b. Right-click a port and select **Configure**. Lower the port speed.

See the “Dynamic Bandwidth Management” section on page 5-3 for the minimum bandwidth requirements for port rate modes and port speeds.
Verifying Bandwidth Utilization in a Port Group Using the CLI

To verify bandwidth utilization in a port group using the CLI, follow these steps:

Step 1  Use the show port-resources module command to display the Generation 2 module shared resources configuration.

```
switch# show port-resources module 2
Module 2
Available dedicated buffers are 5164

Port-Group 1
Total bandwidth is 12.8 Gbps
Total shared bandwidth is 4.8 Gbps
Allocated dedicated bandwidth is 8.0 Gbps

---------------------------------
Interfaces in the Port-Group       B2B Credit  Bandwidth  Rate Mode
Buffers     (Gbps)                (Gbps)
---------------------------------
fc2/1                                      16        4.0  shared
fc2/2                                      16        4.0  shared
fc2/3                                      16        4.0  shared
fc2/4                                      16        4.0  shared
fc2/5                                      16        4.0  dedicated
fc2/6                                      16        4.0  dedicated

...  
```

In this example, there is not enough available shared bandwidth in Port-Group 1 to switch any more ports to 4 Gbps dedicated mode.

Step 2  Do one of the following to free bandwidth for the port that you want to place in dedicated mode.

a. Use the out-of-service command in interface mode to put one or more ports in out-of-service mode to free more resources.

b. Use the switchport speed command on one or more ports to change the port speed to a lower port speed. See the “Dynamic Bandwidth Management” section on page 5-3 for the minimum bandwidth requirements for port rate modes and port speeds.
### Cannot Enable a Port

**Symptom** Cannot enable a port.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Cannot enable a port. | Port is out of service. | In Device Manager, right-click the port and select **Configure** to see if the port is out of service.  
Using the CLI, use the **show interface brief** command to see if the port is out of service.  
See the “Verifying Bandwidth Utilization in a Port Group Using Device Manager” section on page 5-11 or the “Verifying Bandwidth Utilization in a Port Group Using the CLI” section on page 5-12 to free up enough port resources to bring the port in service. |
| | Not enough bandwidth is available in the port group. | See the “Verifying Bandwidth Utilization in a Port Group Using Device Manager” section on page 5-11 or the “Verifying Bandwidth Utilization in a Port Group Using the CLI” section on page 5-12. |

### Cannot Upgrade Supervisor System Image

**Symptom** Cannot upgrade supervisor system image.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Cannot upgrade supervisor system image. | Wrong Cisco SAN-OS image type. | Use the appropriate Cisco SAN-OS image for your supervisor. See the “Selecting the Correct Software Images” section on page 5-13. In Device Manager, choose **Physical > Modules** to find the supervisor type.  
Or use the **show module** CLI command to determine the supervisor type. |

### Selecting the Correct Software Images

The Supervisor-1 and Supervisor-2 modules supported by Cisco MDS 9100, 9200 and 9500 Series switches require different system and kickstart images. You can determine which images to use on your switch by the naming conventions shown in Table 5-12.
### Table 5-12  Supervisor Module Software Image Naming Conventions

<table>
<thead>
<tr>
<th>Cisco MDS 9500 Series Switch Type</th>
<th>Supervisor Module Type</th>
<th>Naming Convention</th>
</tr>
</thead>
<tbody>
<tr>
<td>9120 or 9140</td>
<td>Supervisor-1 module</td>
<td>Filename begins with m9100-s1ek9</td>
</tr>
<tr>
<td>9134</td>
<td>Supervisor-2 module</td>
<td>Filename begins with m9100-s2ek9</td>
</tr>
<tr>
<td>9221i</td>
<td>Supervisor-2 module</td>
<td>Filename begins with m9200-s2ek9</td>
</tr>
<tr>
<td>9216, 9216A or 9216i</td>
<td>Supervisor-1 module</td>
<td>Filename begins with m9200-s1k9</td>
</tr>
<tr>
<td>9506 or 9509</td>
<td>Supervisor-1 module</td>
<td>Filename begins with m9500-sf1ek9</td>
</tr>
<tr>
<td>9513</td>
<td>Supervisor-2 module</td>
<td>Filename begins with m9500-sf2ek9</td>
</tr>
</tbody>
</table>
Troubleshooting Licensing

Licensing functionality is available in all switches in the Cisco MDS 9000 Family. This functionality allows you to access specified premium features on the switch after you install the appropriate license for that feature. Licenses are supported, and enforced in Cisco MDS SAN-OS Release 1.3(1) and later.

This chapter includes the following topics:

- License Overview, page 6-1
- Initial Troubleshooting Checklist, page 6-3
- Licensing Installation Issues, page 6-6

License Overview

Cisco SAN-OS requires licenses for advanced features. These licenses have two options:

- Feature-based licensing—Features that are applicable to the entire switch. You need to purchase and install a license for each switch that uses the features you are interested in. The Enterprise license is an example of a feature-based license.
- Module-based licensing—Features that require additional hardware modules. You need to purchase and install a license for each module that uses the features you are interested in. The SAN Extension over IP license is an example of a module-based license.

Note

The Cisco MDS 9216i switch enables SAN Extension features on the two fixed IP services ports only. The features enabled on these ports are identical to the features enabled by the SAN Extension over IP license on the 14/2-port Multiprotocol Services (MPS-14/2) module. If you install a module with IP ports in the empty slot on the Cisco MDS 9216i, a separate SAN Extension over IP license is required to enable related features on the IP ports of the additional module.
License Overview

Chassis Serial Numbers

Licenses are created using the serial number of the chassis where the license file is to be installed. Once you order a license based on a chassis serial number, you cannot use this license on any other switch. If you use a license meant for another chassis, you may see the following system message:

**Error Message** LICMGR-3-LOG_LIC_INVALID_HOSTID: Invalid license hostid VDH=[chars] for feature [chars].

**Explanation** The feature has a license with an invalid license Host ID. This can happen if a supervisor module with licensed features for one switch is installed on another switch.

**Recommended Action** Reinstall the correct license for the chassis where the supervisor module is installed.

Grace Period

If you use a feature that requires a license but have not installed a license for that feature, you are given a 120 day grace period to evaluate the feature. You must purchase and install the number of licenses required for that feature before the grace period ends or Cisco SAN-OS will disable the feature at the end of the grace period. If you try to use an unlicensed feature, you may see the following system messages:

**Error Message** LICMGR-2-LOG_LIC_GRACE_EXPIRED: Grace period expired for feature [chars].

**Explanation** The unlicensed feature has exceeded its grace time period. Applications using this license will be shut down immediately.

**Recommended Action** Please install the license file to continue using the feature.

**Error Message** LICMGR-3-LOG_LICAPP_NO_LIC: Application [chars] running without [chars] license, shutdown in [dec] days.

**Explanation** The Application [chars1] has not been licensed. The application will work for a grace period of [dec] days after which it will be shut down unless a license file for the feature is installed.

**Recommended Action** Install the license to continue using the feature.

**Error Message** LICMGR-3-LOG_LIC_LICENSE_EXPIRED: Evaluation license expired for feature [chars].

**Explanation** The feature has exceeded its evaluation time period. The feature will be shut down after a grace period.

**Recommended Action** Install the license to continue using the feature.
Send documentation comments to mdsfeedback-doc@cisco.com

Error Message LICMGR-3-LOG_LIC_NO_LIC: No license(s) present for feature [chars]. Application(s) shutdown in [dec] days.

Explanation The feature has not been licensed. The feature will work for a grace period, after which the application(s) using the feature will be shutdown.

Recommended Action Install the license to continue using the feature.


Explanation The application will exceed its evaluation time period in the listed number of days and will be shut down unless a permanent license for the feature is installed.

Recommended Action Install the license file to continue using the feature.

License packages can contain several features. If you disable a feature during the grace period and there are other features in that license package that are still enabled, the clock does not stop for that license package. To suspend the grace period countdown for a licensed feature, you must disable every feature in that license package. Choose Switches > Licenses and select the Usage tab in Fabric Manager or use the show license usage CLI command to determine which features are enabled for a license package.

Initial Troubleshooting Checklist

Begin troubleshooting license issues by checking the following issues first:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Checkoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify the chassis serial number for all licenses ordered.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify the platform or module type for all licenses ordered.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the Product Authorization Key you used to order the licenses comes from the same chassis that you retrieved the chassis serial number on.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have installed all licenses on all switches that require the licenses for the features you enable.</td>
<td>☐</td>
</tr>
</tbody>
</table>

This section includes the following topics:
- Displaying License Information Using Fabric Manager, page 6-3
- Displaying License Information Using Device Manager, page 6-4
- Displaying License Information Using Fabric Manager Web Client, page 6-4
- Displaying License Information Using the CLI, page 6-4

Displaying License Information Using Fabric Manager

To view license information using Fabric Manager, follow these steps:

Step 1 Select Switches > Licenses from the Physical Attributes pane. You see the license information in the Information pane, one line per feature.
Chapter 6  Troubleshooting Licensing

Initial Troubleshooting Checklist

Send documentation comments to mdsfeedback-doc@cisco.com

Step 2  Click the **Feature Usage** tab to see the switch, name of the feature package, the type of license installed, the number of licenses used (Installed Count), the expiration date, the grace period (if you do not have a license for a particular feature), and any errors (for example, if you have a missing license). Click the **Keys** tab to display information about each of the License Key files installed on your switches.

Step 3  Click the **Usage** tab to see the applications using the feature package on each switch. Use this tab to determine which applications depend on each license you have installed.

---

**Displaying License Information Using Device Manager**

To view license information using Device Manager, follow these steps:

Step 1  Click **Admin > Licenses** from the menu. You see the License dialog box.

Step 2  Click the **Features** tab to see the license information, including the feature package, the type of license, expiration date and grace period (if any), and any errors (such as a missing license). Click the **Files** tab to display information about each License Key file installed on the switch.

Step 3  Click the **Usage** tab to see the applications using the feature package on each switch. Use this tab to determine which applications depend on each license that you have installed.

---

**Displaying License Information Using Fabric Manager Web Client**

Fabric Manager Release 2.1(2) or later supports viewing license use across the fabric from Fabric Manager Web Client. This view summarizes the licenses used on all switches in the fabric.

To view licenses using Fabric Manager Web Client, choose **Inventory > Licenses**.

---

**Displaying License Information Using the CLI**

Use the **show license** commands to display all license information configured on this switch (see Example 6-1 through Example 6-3).

**Example 6-1  Displays Information About Current License Usage**

```
switch# show license usage
Feature       Installed  Lic Count Status  Expiry Date    Comments
FM_SERVER_PKG No        - Unused  never      Grace 79D 16H
MAINFRAME_PKG No        - Unused  never      Grace expired
ENTERPRISE_PKG Yes      - InUse  never      -
DMM_FOR_SSM_PKG No        0 Unused  never      -
SAN_EXTN_OVER_IP No        0 Unused  never      -
PORT_ACTIVATION_PKG No        0 Unused  never      -
SMC_FOR_IPS_184_PKG No        0 Unused  never      Grace 86D 5H
SAN_EXTN_OVER_IP_18_4 No        0 Unused  never      -
SAN_EXTN_OVER_IP_IPS2 Yes      1 Unused  never      1 license(s) missing
SAN_EXTN_OVER_IP_IPS4 No        0 Unused  never      -
10G_PORT_ACTIVATION_PKG No        0 Unused  never      -
```
Chapter 6  Troubleshooting Licensing

---

Send documentation comments to mdsfeedback-doc@cisco.com

---

Example 6-2  Displays the List of Features in a Specified Package

```
switch# show license usage ENTERPRISE_PKG
Application
-----------
ivr
qos_manager
-----------
```

Example 6-3  Displays the Host ID for the License

```
switch# show license host-id
License hostid: VDH=FOX0646S017
```

Note  Use the entire ID that appears after the colon (:). The VHD is the Vendor Host ID.

Example 6-4  Displays All Installed License Key Files and Contents

```
switch# show license
Permanent.lic:
SERVER this_host ANY
VENDOR cisco
INCREMENT MAINFRAME_PKG cisco 1.0 permanent uncounted \ 
   HOSTID=VDH=FOX0646S017 \ 
   NOTICE="<LicFileID></LicFileID><LicLineID>0</LicLineID> \ 
   <PAK>dummyPak</PAK>" SIGN=EE9F91EA4B64
Evaluation.lic:
SERVER this_host ANY
VENDOR cisco
INCREMENT MAINFRAME_PKG cisco 1.0 30-Dec-2003 uncounted \ 
   HOSTID=VDH=FOX0646S017 \ 
   NOTICE="<LicFileID></LicFileID><LicLineID>0</LicLineID> \ 
   <PAK>dummyPak</PAK>" SIGN=EE9F91EA4B64
```

Example 6-5  Displays a List of Installed License Key Files

```
switch# show license brief
Enterprise.lic
Ficon.lic
FCIP.lic
```

Example 6-6  Displays the Contents of a Specified License Key File

```
switch# show license file Permanent.lic
Permanent.lic:
SERVER this_host ANY
VENDOR cisco
INCREMENT MAINFRAME_PKG cisco 1.0 permanent uncounted \ 
   HOSTID=VDH=FOX0646S017 \ 
   NOTICE="<LicFileID></LicFileID><LicLineID>0</LicLineID> \ 
   <PAK>dummyPak</PAK>" SIGN=EE9F91EA4B64
```
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 6  Troubleshooting Licensing

Licensing Installation Issues

Common problems with licenses usually stem from incorrectly ordering the license file, installing the license file on an incorrect switch, or not ordering the correct number of licenses for your fabric.

This section includes the following topics:

- One-Click License Install Fails or Cannot Connect to Licensing Website, page 6-6
- Serial Number Issues, page 6-6
- RMA Chassis Errors or License Transfers Between Switches, page 6-7
- Receiving Grace Period Warnings After License Installation, page 6-7
- Incorrect Number of Licenses in Use for Multiple Modules, page 6-8
- Grace Period Alerts, page 6-9
- Checking in the Fabric Manager Server License From Device Manager, page 6-10
- License Listed as Missing, page 6-11

One-Click License Install Fails or Cannot Connect to Licensing Website

The one-click license installation tries to open an HTTPS connection to the licensing website that matches the vendor you purchased your switch from.

**Symptom**  One-click license install fails or cannot connect to the licensing website.

<table>
<thead>
<tr>
<th>Table 6-1</th>
<th>One-Click License Install Fails or Cannot Connect to License Website</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>License website uses HTTP, not HTTPS.</td>
<td>Edit `&lt;install directory&gt;/bin/FabricManager.bat file to add the following lines to the JVMargs argument: -Dhttp.proxyHost=HOSTADDRESS -Dhttp.proxyPort=HOSTPORT.</td>
</tr>
<tr>
<td>Fabric Manager communicating through a proxy server.</td>
<td>Edit `&lt;install directory&gt;/bin/FabricManager.bat file to add the following lines to the JVMargs argument: -Dhttps.proxyHost=HOSTADDRESS -Dhttps.proxyPort=HOSTPORT.</td>
</tr>
<tr>
<td>Java versions 1.4.2_01 and later do not have the right set of Certificate Authority (CA) certificates to validate the SSL certificates on the EMC server (HTTPS).</td>
<td>The license wizard cannot make an HTTPS connection to the EMC servers. If the License Wizard fails to fetch the license keys, saying the connection failed, the workaround is to install the latest 1.4(x) version of Java, preferably 1.4.2_04 or later.</td>
</tr>
</tbody>
</table>

Serial Number Issues

A common problem with licenses stems from not using the correct chassis serial number when ordering your license.

To obtain the correct chassis serial number using Fabric Manager, follow these steps:
Step 1  Choose **Switches > Hardware** and select the **Inventory** tab.

Step 2  Copy down the SerialNo Primary field for the chassis that matches where you want to install a new license.

**Note**  If you are ordering a module-based license, such as the SAN Extension over IP license package, you still use the chassis serial number for the chassis where the module resides, not the module serial number.

Use the **show license host-id** CLI command to obtain the correct chassis serial number for your switch using the CLI.

When entering the chassis serial number during the license ordering process, do not use the letter “O” in place of any zeros in the serial number.

### RMA Chassis Errors or License Transfers Between Switches

A license is specific to the switch for which it is issued and is not valid on any other switch. If you need to transfer a license from one switch to another, contact your customer service representative.

**Note**  If you purchased Cisco support through a Cisco reseller, contact the reseller directly. If you purchased support directly from Cisco Systems, contact Cisco Technical Support at this URL: [http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml](http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml)

### Receiving Grace Period Warnings After License Installation

If the license installation does not proceed correctly, or if you are using a feature that exists in a license package that you have not installed, you will continue to get grace period warnings.
License Installation Issues

**Symptom** Receiving grace period warnings after a license installation.

<table>
<thead>
<tr>
<th>Table 6-2 Receiving Grace Period Warnings After License Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Receiving grace period warnings after a license installation.</td>
</tr>
<tr>
<td>License installation failed.</td>
</tr>
<tr>
<td>Not enough license files installed for a feature.</td>
</tr>
</tbody>
</table>

**Incorrect Number of Licenses in Use for Multiple Modules**

Module-based licenses require one license installed per module that uses a licensed feature. SAN Extension over IP is an example of a module based license. Installing a SAN Extension over IP license while two FCIP instances from different modules are present, may cause the system to return the following error message:

Installs license failed: Number of License in use is more than the number being installed.

This error message is generated because the license grace period is only applicable when no licenses are installed. The installation of one license terminates the grace period and will arbitrarily cause the second module to shut down, because this is not allowed by licensing.

The workaround for this scenario includes doing one of the following:

- Concatenate both licenses into one license file.
- Manually reduce the usage count by one.

To concatenate both licenses into one license file, follow these steps:

**Step 1** Open both license files using WordPad.

**Step 2** Copy both license files to one file:

```
Example
SERVER this_host ANY
VENDOR cisco
INCREMENT SAN_EXTN_OVER_IP_IPS2 cisco 1.0 permanent 1 \ 
VENDOR_STRING=<LIC_SOURCE>MDS_SWIFT</LIC_SOURCE><SKU>M9500EXT12EK9=</SKU> \ 
HOSTID=VDH=FOXYYYYYY \ 
NOTICE=”<LicFileID>2005082204514XXXX</LicFileID><LicLineID>1</LicLineID> \ 
<PAX>MDS-1X-JAB-0F1A81</PAX>” SIGN=F0652E02XXXX
INCREMENT SAN_EXTN_OVER_IP_IPS2 cisco 1.0 permanent 1 \
```
Send documentation comments to mdsfeedback-doc@cisco.com

VENDOR_STRING=<LIC_SOURCE>MDS_SWIFT</LIC_SOURCE><SKU>M9500EXT12EK9=</SKU> \\
HOSTID=VDH=FOXXYYYYY \\
NOTICE=\<LicFileID>2005082204572XXX</LicFileID><LicLineID>1</LicLineID> \\
<PAK>MDS-1X-JAB-0F1AD1</PAK>" SIGN=D222AE4AXXXX

Step 3  Save the new concatenated license file.

Step 4  Upload and install the concatenated license file on the MDS switch.

To reduce the usage count to one, follow these steps:

Step 1  Bring down one of the modules manually to reduce the usage count by one.

Step 2  Reinsert the module after installing both licenses.

Grace Period Alerts

Cisco SAN-OS gives you a 120 day grace period. This grace period starts or continues when you are evaluating a feature for which you have not installed a license.

The grace period stops if you disable a feature you are evaluating, but if you enable that feature again without a valid license, the grace period countdown continues where it left off.

The grace period operates across all features in a license package. License packages can contain several features. If you disable a feature during the grace period and there are other features in that license package that are still enabled, the countdown does not stop for that license package. To suspend the grace period countdown for a license package, you must disable every feature in that license package. To disable the grace period countdown for Fabric Manager Server, you must explicitly check in the license using Device Manager. See the “Checking in the Fabric Manager Server License From Device Manager” section on page 6-10.

The Cisco SAN-OS license counter keeps track of all licenses on a switch. If you are evaluating a feature and the grace period has started, you will receive console messages, SNMP traps, system messages, and Call Home messages on a daily basis.

Beyond that, the frequency of these messages become hourly during the last seven days of the grace period. The following example uses the FICON feature. On January 30th, you enabled the FICON feature, using the 120 day grace period. You will receive grace period ending messages as:

- Daily alerts from January 30th to May 21st.

- Hourly alerts from May 22nd to May 30th.

On May 31st, the grace period ends, and the FICON feature is automatically disabled. You will not be allowed to use FICON until you purchase a valid license.

Note  You cannot modify the frequency of the grace period messages.

Note  There is no grace period for licenses purchased for the On-Demand Port Activation license feature.
Caution

After the final seven days of the grace period, the feature is turned off and your network traffic may be disrupted. Any future upgrade will enforce license requirements and the 120-day grace period.

Use the `show license usage` command to display grace period information for a switch.

```
switch# show license usage
Feature                      Ins Lic Status Expiry Date Comments
Count
--------------------------------------------------------------------------------
FM_SERVER_PKG                No   -      Unused             Grace 79D 16H
MAINFRAME_PKG                No   -      Unused             Grace expired
ENTERPRISE_PKG               Yes  -      Unused never       license missing
DMM_FOR_SSM_PKG              No   0      Unused             -
SAN_EXTN_OVER.IP             Yes 16 Unused never       -
PORT_ACTIVATION_PKG          No   0      Unused             -
MAINFRAME_PKG                No   -      Unused             Grace expired
SAN_EXTN_OVER.IP_18_4        No   0      Unused             Grace 86D 5H
SAN_EXTN_OVER.IP_IPS2        Yes 1 Unused never        1 license(s) missing
SAN_EXTN_OVER.IP_IPS4        No   0      Unused             -
10G_PORT_ACTIVATION_PKG      No   0      Unused             -
SAN_EXTN_OVER_MPS_184_FIPS   No   0      Unused             -
STORAGE_SERVICES_ENABLER_PKG Yes 1 Unused never        1 license(s) missing
--------------------------------------------------------------------------------
**** WARNING: License file(s) missing. ****
ips-hacl#```

Checking in the Fabric Manager Server License From Device Manager

If you evaluated Fabric Manager Server without a license, you can stop the grace period countdown and disable all features using the Fabric Manager Server license package using Device Manager.

To stop the Fabric Manager Server evaluation using Device Manager, follow these steps:

**Step 1** Choose **Admin > Licenses** and select the **Features** tab.

**Step 2** Select the features to check in. When you select a feature, you see the Check In FM button at the bottom of the dialog box.

**Step 3** Click **Check In FM**.

**Note** This button appears only when FM_SERVER_PKG is unlicensed.

**Note** Because of Caveat CSCeg23889, you might still receive Call Home or system messages for an unused FM_SERVER_PKG license. This caveat describes how extraneous messages are sent after a Fabric Manager Server license is checked in.
License Listed as Missing

After a license is installed and operating properly, it may show up as missing if you modify your system hardware or encounter a bootflash: issue.

**Symptom**  License listed as missing.

**Table 6-3  License Listed as Missing**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>License listed as missing</td>
<td>Supervisor module was replaced after license was installed.</td>
<td>Reinstall the license.</td>
</tr>
<tr>
<td></td>
<td>Supervisor bootflash: is corrupted.</td>
<td>See the “Corrupted Bootflash Recovery” section on page 2-14 to recover from corrupted bootflash:. Reinstall the license.</td>
</tr>
</tbody>
</table>
Troubleshooting Cisco Fabric Services

This chapter describes procedures used to troubleshoot Cisco Fabric Services (CFS) problems in the Cisco MDS 9000 Family multilayer directors and fabric switches. It includes the following sections:

- Overview, page 7-1
- Initial Troubleshooting Checklist, page 7-2
- Merge Failure Troubleshooting, page 7-5
- Lock Failure Troubleshooting, page 7-7
- Distribution Status Verification, page 7-9
- CFS Regions Troubleshooting, page 7-10

Overview

Many features in the Cisco MDS 9000 Family switches require configuration synchronization in all switches in the fabric. It is important to maintain configuration synchronization across a fabric for consistency.

As of Cisco MDS SAN-OS Release 2.0(1b), Cisco Fabric Services (CFS) provides a common infrastructure for automatic configuration synchronization in the fabric. It provides the transport function as well as a rich set of common services to the applications. CFS can discover CFS-capable switches in the fabric as well as their application capabilities.

Some of the applications that can be synchronized using CFS include:

- IVR
- NTP
- DPVM
- user roles
- AAA server addresses, Radius and TACACS daemons
- SFM
- SDV
- syslog
- port-security
- call home
As of Cisco MDS SAN-OS Release 3.2(1), the scope of configuration synchronization can be restricted to a limited set of switches within the physical scope of an application. CFS regions are designed to:

- Fine tune the distribution of configuration for an application.
- Restrict synchronization or merging of configuration information from a switch to a region, rather than distributing information across the entire physical scope of the application.
- Span across some or all of the switches in the topology, within the physical scope of the application.

All switches in the fabric must be CFS capable. A Cisco MDS 9000 Family switch is CFS capable if it is running Cisco SAN-OS Release 2.0(1b) or later. Switches that are not CFS capable do not receive distributions and result in part of the fabric not receiving the intended distribution.

CFS has the following features:

- Implicit CFS usage—The first time you issue a CFS task for a CFS-enabled application, the configuration modification process begins and the application locks the fabric.
- Pending database—The pending database is a temporary buffer to hold uncommitted information. The uncommitted changes are not applied immediately to ensure that the database is synchronized with the database in the other switches in the fabric. When you commit the changes, the pending database overwrites the configuration database (also know as active database or the effective database).
- CFS distribution enabled or disabled on a per-application basis—The default (enable or disable) for CFS distribution state differs between applications. If CFS distribution is disabled for an application, then that application does not distribute any configuration nor does it accept a distribution from other switches in the fabric.
- Explicit CFS commit—Most applications require an explicit commit operation to copy the changes in the temporary buffer to the application database and distributes the new database to the fabric and releases the fabric lock. The changes in the temporary buffer are not applied if you do not perform the commit operation.
- Globally disable CFS distribution—Use the \texttt{no cfs enable} command, in config mode, to isolate the switch from the rest of the fabric. All other behaviors by the CFS and CFS enabled application are un-affected.
- Enable IPV4 and IPV6 distribution from Fabric Manager—Go to Physical Attributes> Switches > CFS. GLOBAL indicates CFS distribution and IP MULTICAST indicates IPV4 and IPV6 distributions.

As of Cisco SAN-OS Release 3.1(2), some applications, such as Inter-VSAN Routing (IVR), require configuration distribution over some specific VSANs. These applications can specify to CFS the set of VSANs over which to restrict the distribution.

### Initial Troubleshooting Checklist

Begin troubleshooting CFS issues by checking the following issues first:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Checkoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that CFS is enabled for the same applications on all affected switches.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that CFS distribution is enabled for the same applications on all affected switches.</td>
<td>☐</td>
</tr>
<tr>
<td>If the CFS Regions feature is in use, verify that the application is in the same region on all the affected switches.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Chapter 7  Troubleshooting Cisco Fabric Services

Send documentation comments to mdsfeedback-doc@cisco.com

This section includes the following topics:

- Verifying CFS Using Fabric Manager, page 7-3
- Verifying CFS Using the CLI, page 7-3

Verifying CFS Using Fabric Manager

To verify CFS using Fabric Manager or Device Manager, follow these steps:

**Step 1** Choose Admin > CFS on Device Manager to verify that an application is listed and enabled. Repeat this on all switches.

**Step 2** To list the set of switches in which an application is registered with CFS, choose the application configuration menu on Fabric Manager and select the CFS tab. For example, to verify that DPVM is enabled and global distribution is enabled on all switches, choose Fabricxx > All VSANs > DPVM and select the CFS tab. Verify that the Oper field is enabled and the Global field is enabled for all switches in the fabric.

**Step 3** To determine if all the switches in the fabric constitute one CFS fabric, or a multitude of partitioned CFS fabrics using Device Manager, follow these steps:

a. Choose Admin > CFS and highlight the application that you want to verify CFS on.

b. Click Details and select the Merge tab in the Details dialog box.

c. If you see multiple rows in the Merge status table, then the fabric is partitioned into multiple CFS fabrics. Some features enable CFS per VSAN and this is expected. If the selected feature should be fabric wide but you see multiple rows in the Merge status table, then the fabric may be partitioned, and the merge status may show that the merge has failed, is pending, or is waiting.

Verifying CFS Using the CLI

To verify CFS using the CLI, follow these steps:

**Step 1** To verify that an application is listed and enabled, issue the `show cfs application` command to all switches. An example of the `show cfs application` command follows:

```
Switch# show cfs application

-------------------------------------------
Application     Enabled  Scope
-------------------------------------------
ivr             Yes      Physical
ntp             No       Physical
dpvm            Yes      Physical
```

Verify that there are no pending changes for an application and that a CFS commit was issued for any configuration changes in a CFS enabled application.
Verify that there are no unexpected CFS locked sessions. Clear any unexpected locked sessions.

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Checkoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that there are no pending changes for an application and that a CFS commit was issued for any configuration changes in a CFS enabled application.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that there are no unexpected CFS locked sessions. Clear any unexpected locked sessions.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Chapter 7  Troubleshooting Cisco Fabric Services

Initial Troubleshooting Checklist

Send documentation comments to mdsfeedback-doc@cisco.com

<table>
<thead>
<tr>
<th>Application</th>
<th>Status</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>fscm</td>
<td>Yes</td>
<td>Physical</td>
</tr>
<tr>
<td>role</td>
<td>Yes</td>
<td>Physical</td>
</tr>
<tr>
<td>radius</td>
<td>Yes</td>
<td>Physical</td>
</tr>
<tr>
<td>fctimer</td>
<td>No</td>
<td>Physical</td>
</tr>
<tr>
<td>syslogd</td>
<td>No</td>
<td>Physical</td>
</tr>
<tr>
<td>callhome</td>
<td>No</td>
<td>Physical</td>
</tr>
<tr>
<td>device-alias</td>
<td>Yes</td>
<td>Physical</td>
</tr>
<tr>
<td>port-security</td>
<td>Yes</td>
<td>Logical</td>
</tr>
</tbody>
</table>

Total number of entries = 11

The Physical scope means that CFS applies the configuration for that application to the entire switch. The Logical scope means that CFS applies the configuration for that application to a specific VSAN.

**Step 2**

Verify the set of switches in which an application is registered with CFS, using the `show cfs peers name application-name` for physical scope applications, and the `show cfs peers name application-name vsan vsan-id` for logical scope applications.

An example command output for a physical scope application follows:

```
Switch# show cfs peers name dpvm
Scope : Physical
------------------------------------------
Switch WWN               IP Address
------------------------------------------
20:00:00:0e:d7:0e:bf:c0  10.76.100.51    [Local]
20:00:00:0e:d7:00:3c:9e  10.76.100.52
```

Total number of entries = 2

**Note**

The `show cfs peers name application-name` command displays the peers for all VSANs when applied to a logical application.

An example command output for a logical scope application follows:

```
Switch# show cfs peers name port-security
Scope   : Logical [VSAN 1]
------------------------------------------
Domain   Switch WWN               IP Address
------------------------------------------
236  20:00:00:0e:d7:00:3c:9e  10.76.100.52    [Local]
239  20:00:00:05:30:00:6b:9e  10.76.100.167
101  20:00:00:0d:ec:06:55:c0  10.76.100.205
```

Total number of entries = 3

```
Scope   : Logical [VSAN 2]
------------------------------------------
Domain   Switch WWN               IP Address
------------------------------------------
239  20:00:00:0e:d7:00:3c:9e  10.76.100.52    [Local]
211  20:00:00:05:30:00:6b:9e  10.76.100.167
110  20:00:00:0d:ec:06:55:c0  10.76.100.205
```

Total number of entries = 3

```
Scope   : Logical [VSAN 3]
------------------------------------------
```

Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x

OL-9285-05
Chapter 7  Troubleshooting Cisco Fabric Services

---

Send documentation comments to mdsfeedback-doc@cisco.com

---

Step 3

To determine if all the switches in the fabric constitute one CFS fabric, or a multitude of partitioned CFS fabrics, issue the show cfs merge status name application-name command and the show cfs peers name application-name command and compare the outputs. If the outputs contain the same list of switches, the entire set of switches constitutes one CFS fabric. When this is the case the merge status should always show success at all switches. Example command outputs follow:

Switch# show cfs merge status name dpvm
Physical Merge Status: Success [ Sat Nov 20 11:59:36 2004 ]
Local Fabric

Switch WWN               IP Address
---------------------------------
20:00:00:00:05:30:00:4a:de  10.76.100.51    [Merge Master]
20:00:00:0d:ec:0c:f1:40   10.76.100.204

Switch# show cfs peers name dpvm
Scope      : Physical

Switch WWN               IP Address
---------------------------------
20:00:00:00:05:30:00:4a:de  10.76.100.51
20:00:00:0d:ec:0c:f1:40   10.76.100.204

Total number of entries = 2

If the list of switches in the show cfs merge status name command output is shorter than that of the show cfs peers name command output, the fabric is partitioned into multiple CFS fabrics and the merge status may show that the merge has failed, is pending, or is waiting.

---

Merge Failure Troubleshooting

During a merge, the merge managers in the merging fabrics exchange their configuration databases with each other. The application on one of them merges the information, decides if the merge is successful, and informs all switches in the combined fabric of the status of the merge. When a merge is successful, the merged database is distributed to all switches in the combined fabric and the entire new fabric remains in a consistent state. A merge failure indicates that the merged fabrics contain inconsistent data that could not be merged.

If a new switch is added to the fabric and the merge status for any application shows "In Progress" for a prolonged period of time, then there may be an active session for that application in some switch. Check the lock status for that application on all the switches using the show cfs lock CLI command. If there are any locks, then the merge will not proceed. Commit the changes or clear the session lock so that the merge can proceed.
Recovering from a Merge Failure with Fabric Manager

To recover from a merge failure using Fabric Manager, follow these steps:

**Step 1** Select the CFS tab for the application that you are configuring and check the merge field to identify a switch that shows a merge failure. For example, choose Fabricxx > All VSANS > DPVM and select the CFS tab to determine if there is a merge failure for DPVM.

**Step 2** Set the Config Action drop-down menu to commit and click Apply Changes to restore all peers in the fabric to the same configuration database.

Recovering from a Merge Failure with the CLI

To recover from a merge failure using the CLI, follow these steps:

**Step 1** To identify a switch that shows a merge failure, issue the `show cfs merge status name application-name` command. Example command output follows:

```
Switch# show cfs merge status name ntp

Failure Reason: Conflicting entries in the compared databases
Local Fabric

<table>
<thead>
<tr>
<th>Switch WWN</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>20:00:00:05:30:00:6b:9e</td>
<td>10.76.100.167 [Merge Master]</td>
</tr>
<tr>
<td>20:00:00:0e:d7:00:3c:9e</td>
<td>10.76.100.52</td>
</tr>
</tbody>
</table>

Remote Fabric

<table>
<thead>
<tr>
<th>Switch WWN</th>
<th>IP Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>20:00:00:0d:ec:06:55:c0</td>
<td>10.76.100.205 [Merge Master]</td>
</tr>
</tbody>
</table>
```

**Step 2** For a more detailed description of the merge failure, issue the `show cfs internal session-history name application name detail` command. Example command output follows:

```
switch# show cfs internal session-history name ntp detail

<table>
<thead>
<tr>
<th>Time Stamp</th>
<th>Source WWN</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fri Aug 24 04:30:19</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>LOCK_REQUEST</td>
</tr>
<tr>
<td>admin</td>
<td>3848</td>
<td></td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>LOCK_ACQUIRED</td>
</tr>
<tr>
<td>admin</td>
<td>3848</td>
<td></td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>COMMIT</td>
</tr>
<tr>
<td>admin</td>
<td>3849</td>
<td></td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>LOCK_RELEASE_REQUEST</td>
</tr>
<tr>
<td>admin</td>
<td>3848</td>
<td></td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>LOCK_RELEASED</td>
</tr>
<tr>
<td>admin</td>
<td>3848</td>
<td></td>
</tr>
<tr>
<td>Fri Aug 24 04:33:07</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>LOCK_REQUEST</td>
</tr>
<tr>
<td>admin</td>
<td>3868</td>
<td></td>
</tr>
</tbody>
</table>
```
Lock Failure Troubleshooting

In order to distribute a configuration in the fabric, a lock must first be acquired on all switches in the fabric. Once this is accomplished a commit can be issued which will distribute the data to all switches in the fabric before releasing the lock.

When a lock has been acquired by another application peer, you cannot commit new configuration changes. This is normal operation and you should postpone any changes to an application until the lock is released. Use the troubleshooting steps in this section only if you believe the lock has not been properly released.

A lock occurs when an administrator configures a change for a CFS-enabled application. If two administrators on the same switch attempt to configure the same application, only one administrator is given the lock. The other administrator is prevented from making changes to that application until the first administrator commits a change or discards any changes. Use the `show cfs lock name` CLI command to determine the name of the administrator who holds the lock for an application. You should check with that administrator before clearing the lock.

A CFS lock can also be held by another switch in your fabric. Use the `show cfs peers name` CLI command to determine all switches that participate in the CFS distribution for this application. That use the `show cfs lock name` CLI command on each switch to determine who owns the CFS lock for that applications. You should check with that administrator before clearing the lock.

Use the CFS `abort` option to release the lock without distributing the data to the fabric.

Resolving Lock Failure Issues Using Fabric Manager

To resolve a lock failure using Fabric Manager, follow these steps:

Step 1 Select the CFS tab for the application that you are configuring and view the Master check box to identify the master switch for that CFS application. For example, choose Fabricxx > All VSANs > DPVM and select the CFS tab.

Step 2 Set the Config Action drop-down menu on the master switch to commit or abort and click Apply Changes to restore all peers in the fabric to the same configuration database and free the CFS lock.
Resolving Lock Failure Issues Using the CLI

To resolve a lock failure using the CLI, follow these steps:

**Step 1** Issue a `show cfs lock name` command to determine the lock holder. An example of the `show cfs lock name` command follows:

```
Switch# show cfs lock ntp
Application:ntp
Scope   :Physical
___________________________________________________________
Switch WWN       IP Address       User Name    User Type
___________________________________________________________
20:00:00:05:30:00:6b:9e  10.76.100.167    admin        CLI/SNMP v3
```

Total number of entries = 1

**Step 2** For a detailed description of the lock failure, issue the `show cfs internal session-history name application name detail` command. Example command output follows:

```
switch# show cfs internal session-history name ntp detail
_____________________________________________________________________
<table>
<thead>
<tr>
<th>Time Stamp</th>
<th>Source WWN</th>
<th>User Name</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fri Aug 24 04:30:19 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>LOCK_REQUEST</td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>LOCK_ACQUIRED</td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>COMMIT</td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>LOCK_RELEASE_REQUEST</td>
</tr>
<tr>
<td>Fri Aug 24 04:30:19 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>LOCK_RELEASE</td>
</tr>
<tr>
<td>Fri Aug 24 04:33:07 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>LOCK_REQUEST</td>
</tr>
<tr>
<td>Fri Aug 24 04:33:07 2007</td>
<td>20:00:00:0d:ec:04:99:c0</td>
<td>admin</td>
<td>LOCK_ACQUIRED</td>
</tr>
</tbody>
</table>
```

**Step 3** If the lock is being held by a remote peer, an `application-name commit` command or an `application-name abort` command must be executed at that switch. An example of the `application-name commit` command follows:

```
Switch# config terminal
Switch(config)# ntp commit
Switch(config)#
```

An example of the `application-name abort` command follows:

```
Switch# config terminal
Switch(config)# ntp abort
Switch(config)#
```
System State Inconsistent and Locks Being Held

An inconsistent system state occurs when locks are not held on all of the switches in the fabric, or when locks are held on all switches in the fabric, but a session does not exist with the lock holding switch. In either case, it may be necessary to use the `clear` option to release the locks.

Clearing Locks Using Fabric Manager

To clear a lock using Fabric Manager, follow these steps:

1. Select the CFS tab for the application that you are configuring and view the Master check box to identify the master switch for that CFS application. For example, choose Fabricxx > All VSANS > DPVM and select the CFS tab.
2. Set the Config Action drop-down menu on the master switch to clear and click Apply Changes to free the CFS lock.

Clearing Locks Using the CLI

When a lock is being held on a remote peer and issuing the `application-name commit` command or the `application-name abort` command does not clear the lock, issue the `clear application-name session` command to clear all locks in the fabric. After all locks are cleared, a new distribution must be started to restore all the switches in the fabric to the same state.

Example command output follows:

```
Switch# clear ntp session
Switch# config terminal
Switch(config)# ntp commit
Switch(config)#
```

Distribution Status Verification

After configuring an application and committing the changes, you may want to verify that CFS is distributing the configuration change throughout the fabric or VSAN.

Verifying Distribution Using Fabric Manager

In Fabric Manager, choose the CFS tab for the application that you are configuring and check the Last Results field to view the distribution status for your latest commit.

Verifying Distribution Using the CLI

In the CLI, use the `show cfs lock name application-name` command to determine if a distribution is in progress on the fabric. If the application does not show in the output, the distribution has completed.

Example command output follows:
CFS Regions Troubleshooting

The following rules apply to CFS Regions:

- When using CFS Regions, an application on a given switch can only belong to one region at a time.
- CFS Regions are only applicable to applications within physical scope. You cannot create a CFS Region in the logical scope of an application.
- Assigning a region to an application takes precedence in distribution over its initial physical scope.
- For backwards compatibility, all applications are in Region 0 by default. If you are running switches with previous SAN-OS releases on the same topology as switches running SAN-OS 3.2x, only applications in Region 0 are supported when those switches are synchronized. Only Region 0 applications on the switches running SAN-OS 3.2x synchronize or merge with switches running SAN-OS 3.1x. All applications in other regions on the switch running SAN-OS 3.2x are ignored by the switch running SAN-OS 3.1x.
- CFS Regions configuration is not supported for deregistered applications (conditional services) or a physical scope application that is currently locked.
- Regions 1 through 200 are available for user configuration. Regions 201 through 255 are reserved regions and are not available for user configuration.

Distribution Failure

To resolve a configuration distribution failure to all switches for a CFS Region, follow these steps:

**Step 1** Verify that application distribution is enabled. See “Initial Troubleshooting Checklist” section on page 7-2 for detailed instructions.

**Step 2** Verify that the application is in the same region on all switches. From Fabric Manager, select the application tab (for example, Physical Attributes > Switches > Clock > NTP), and then click the CFS tab. Find the region-id column and check that the source switch and destination switch are in the same region and click the Regions tab.

Using the CLI from each switch, issue the `show cfs application name application-name` command. For example, for the device-alias application:

```
Switch# show cfs application name device-alias
```

<table>
<thead>
<tr>
<th>Enabled</th>
<th>: Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeout</td>
<td>: 20s</td>
</tr>
<tr>
<td>Merge Capable</td>
<td>: Yes</td>
</tr>
<tr>
<td>Scope</td>
<td>: Physical-fc</td>
</tr>
<tr>
<td>Region</td>
<td>: 1</td>
</tr>
</tbody>
</table>

<<<<<< Application is capable of being merged.
<<<<<< Application is in Region 1
Regions for Conditional Service

When a conditional service goes down (deregisters with CFS), it loses its region configuration. When the conditional service is restarted, it will automatically be put into the default region. To avoid this situation, reconfigure the appropriate region information for the conditional service before it starting it again.

Changing Regions

If you move an application from one region to another, you may encounter a database mismatch when attempting a merge. Follow the steps outlined in the “Merge Failure Troubleshooting” section on page 7-5 to identify and resolve the conflicts.

Note

When an application is moved from one region to another (including the default region), it loses all histories.
Troubleshooting Ports

This chapter describes how to identify and resolve problems that can occur with ports in the Cisco MDS 9000 Family of multilayer directors and fabric switches. It includes the following sections:

- Overview, page 8-1
- Initial Troubleshooting Checklist, page 8-1
- Overview of the FC-MAC Driver and the Port Manager, page 8-4
- Common Problems with Port Interfaces, page 8-13

Overview

Before a switch can relay frames from one data link to another, the characteristics of the interfaces through which the frames are received and sent must be defined. The configured interfaces can be Fibre Channel interfaces, Gigabit Ethernet interfaces, the management interface (mgmt0), or VSAN interfaces (IPFC).

Each physical Fibre Channel interface in a switch can operate in one of several port modes: E port, F port, FL port, TL port, TE port, SD port, and B port. In addition to these modes, each interface can be configured in auto or Fx port modes. These modes determine the port type during interface initialization.

Each interface has an associated administrative configuration and operational status:

- The administrative configuration does not change unless you modify it. This configuration has various attributes that you can configure in administrative mode.
- The operational status represents the current status of a specified attribute like the interface speed. This status cannot be changed and is read-only. Some values may not be valid when the interface is down (such as the operation speed).

For a complete description of port modes, administrative states, and operational states, refer to the Cisco MDS 9000 Family Configuration Guide and the Cisco MDS 9000 Fabric Manager Configuration Guide.

Initial Troubleshooting Checklist

Troubleshooting a SAN problem involves gathering information about the configuration and connectivity of individual devices and the entire SAN fabric. In the case of port interfaces, begin your troubleshooting activity as follows:
### Checklist

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the physical media to ensure there are no damaged parts.</td>
<td></td>
</tr>
<tr>
<td>Verify that the SFP (small form-factor pluggable) devices in use are those authorized by Cisco and that they are not faulty.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have enabled the port by right-clicking the port in Device Manager and selecting <strong>enable</strong> or by using the <strong>no shut</strong> CLI command.</td>
<td></td>
</tr>
<tr>
<td>Right-click the port in Device Manager or use the <strong>show interface</strong> CLI command to verify the state of the interface. Refer to Table 8-1 for reasons why a port may be in a down operational state.</td>
<td></td>
</tr>
<tr>
<td>Verify that you if you have one host-optimized port configured as an ISL, you have not connected to the other three ports in the port group.</td>
<td></td>
</tr>
<tr>
<td>Verify that no ports on a Generation 2 module are out of service.</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Use the **show running interface** CLI command to view the interface configuration in Cisco SAN-OS Release 3.0(1) or later. The interface configuration as seen in the **show running-config** CLI command is no longer consolidated.
### Table 8-1 Reason Codes for Nonoperational States

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
<th>Applicable Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link failure or not connected</td>
<td>The physical layer link is not operational.</td>
<td>All</td>
</tr>
<tr>
<td>SFP not present</td>
<td>The small form-factor pluggable (SFP) hardware is not plugged in.</td>
<td></td>
</tr>
<tr>
<td>Initializing</td>
<td>The physical layer link is operational and the protocol initialization is in progress.</td>
<td></td>
</tr>
<tr>
<td>Reconfigure fabric in progress</td>
<td>The fabric is currently being reconfigured.</td>
<td></td>
</tr>
<tr>
<td>Offline</td>
<td>The Cisco SAN-OS software waits for the specified R_A_TOV time before retrying initialization.</td>
<td></td>
</tr>
<tr>
<td>Inactive</td>
<td>The interface VSAN is deleted or is in a suspended state.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To make the interface operational, assign that port to a configured and active VSAN.</td>
<td></td>
</tr>
<tr>
<td>Hardware failure</td>
<td>A hardware failure is detected.</td>
<td></td>
</tr>
<tr>
<td>Error disabled</td>
<td>Error conditions require administrative attention. Interfaces may be error-disabled for various reasons. For example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configuration failure.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Incompatible buffer-to-buffer credit configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To make the interface operational, you must first fix the error conditions causing this state; then, administratively shut down and reenable the interface.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to ELP failure</td>
<td>The port negotiation failed.</td>
<td>Only E ports and TE ports</td>
</tr>
<tr>
<td>Isolation due to ESC failure</td>
<td>The port negotiation failed.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to domain overlap</td>
<td>The Fibre Channel domains (fcdomain) overlap.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to domain ID assignment failure</td>
<td>The assigned domain ID is not valid.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to other side E port isolated</td>
<td>The E port at the other end of the link is isolated.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to invalid fabric reconfiguration</td>
<td>The port is isolated due to fabric reconfiguration.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to domain manager disabled</td>
<td>The fcdomain feature is disabled.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to zone merge failure</td>
<td>The zone merge operation failed.</td>
<td></td>
</tr>
<tr>
<td>Isolation due to VSAN mismatch</td>
<td>The VSANs at both ends of an ISL are different.</td>
<td></td>
</tr>
</tbody>
</table>
Overview of the FC-MAC Driver and the Port Manager

Note

We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the isolation problem.

Limitations and Restrictions

- You must administratively enable a port with the `no shut` command. When the interface is enabled, the administrative state of the port is up. If you administratively disable an interface with the `shut` command, the administrative state of the port is down, and the physical link layer state change is ignored.
- For a port to be in an up operational state where it can transmit or receive traffic, the interface must be administratively up, the interface link layer state must be up, and the interface initialization must be complete.
- The interface cannot transmit or receive data when a port’s operational state is down.
- The interface is operating in TE mode when a port’s operational state is trunking.

Overview of the FC-MAC Driver and the Port Manager

This section describes the internal details of port related components in Cisco SAN-OS. Use this section to understand the underlying functions that may be causing port related problems.

The FC-MAC driver resides in the module component of the Cisco MDS 9000 Family SAN-OS software. It performs the following functions:
- Initialization of FC-MAC ASIC.
- Speed negotiation.
- Link/loop port initialization and credit recovery.
- Statistics collection.
Overview of the FC-MAC Driver and the Port Manager

- Error handling (mainly by acting on error interrupts).
- SFP detection and housekeeping.
- Statistics collection.
- Debug command support under the `show hardware internal fc-mac` command on the module.

The FC-MAC driver does not handle FLOGI, RSCN, or configuration management.

This section includes the following topics:

- Port Manager Overview, page 8-5
- Troubleshooting Port States with the Device Manager, page 8-6
- Isolating Port Issues Using Device Manager, page 8-9
- Using Port Debug Commands, page 8-10
- Useful Commands at the FC-MAC Level, page 8-11

Port Manager Overview

The Port Manager is management software running on the supervisor module. The Port Manager handles the following tasks:

- Port configuration management.
- Link events, including notifying the registered application on the supervisor module.
- E or TE port initialization.
- SFP validation.

The FC-MAC detects the port is in one of the following states:

- Disable—The port is administratively disabled.
- Enable—The port is administratively enabled. In this state, the port may be in speed initialization, loop-initialization, link (point-to-point connection) initialization, or the link-up state.
- HW Failure—The port has been declared bad due to a hardware failure.
- Pause—An intermediate state after the link is down and subsequent enabling of the port to start the port initialization.

You can check the state of the port by attaching to the module using the command:

```
show hardware internal fc-mac port port-info
```

**Note**

You must use the `attach module` CLI command to access these FC-MAC show commands.

The FLOGI server is a separate application that handles the FLOGI processing for Nx ports.
Troubleshooting Port States with the Device Manager

Device Manager offers multiple ways to monitor ports, including:

- Device View
- Summary View
- Port Selection
- Port Monitoring

Device View

Basic port monitoring using Device Manager begins with the visual display in the Device View (Figure 8-1). Port display descriptions include:

- Green box—A successful fabric login has occurred; the connection is active.
- Red X—A small form-factor pluggable transceiver (SFP) is present but there is no connection. This could indicate a disconnected or faulty cable, or no active device connection.
- Red box—An FSP is present but fabric login (FLOGI) has failed. Typically a mismatch in port or fabric parameters with the neighboring device. For example, a port parameter mismatch would occur if a node device were connected to a port configured as an E port. An example of a fabric parameter mismatch would be differing timeout values.
- Yellow box—In Device Manager, a port was selected.
- Gray box—The port is administratively disabled.
- Black box—FSP is not present.

Device Manager: Summary View

In Device Manager, selecting the Summary View (Figure 8-2) expands on the information available for port monitoring. The display includes:

- VSAN assignment
- For N ports, the port world-wide name (pWWN) and Fibre Channel ID (FC ID) of the connected device
- For ISLs, the IP address of the connected switch
- Speed
- Frames transmitted and received
Send documentation comments to mdsfeedback-doc@cisco.com

- Percent utilization for the CPU, dynamic memory, and Flash memory

**Figure 8-2 Device Manager: Summary View**

---

**Device Manager: Port Selection**

To drill down for additional port information, use either the Device View or Summary View, and double-click any port. The initial display (Figure 8-3) shows administrative settings for Mode, Speed, and Status, plus current operational status, failure cause, and date of the last configuration change.

Additional tabs include:

- **Rx BB Credit**—Configure and view buffer-to-buffer credits (BB credits).
- **Other**—View PortChannel ID, WWN, Maximum Transmission Unit (MTU), configure maximum receive buffer size.
- **FLOGI**—View FC ID, pWWN, nWWN, BB credits and class of service for N port connections.
- **ELP**—View pWWN, nWWN, BB credits and supported classes of service for ISLs.
- **Trunk Config**—View and configure trunk mode and allowed VSANs.
- **Trunk Failure**—Failure cause for ISLs.
- **Physical**—Configure beaconing; view SFP information.
- **Capability**—View current port capability for hold-down timers, BB credits, maximum receive buffer size.
Device Manager: Port Monitoring

To display additional details about port traffic, use the Device View or Summary View. In Device View, choose one or more ports, right-click and choose Monitoring from the pop-up menu. In Summary View, choose one or more interfaces, and click the Monitor tool. The initial display (Figure 8-4) shows traffic information for the selected interval, including the number of bytes and frames received and transmitted.

Additional tabs include:

- **Protocol**—View protocol-related traffic and error statistics, including link reset counts, offline and non-operational sequence errors, reset protocol errors, and statistics related to buffer-to-buffer flow control.
- **Discards**—View the number of frames discarded by the port, including Class 2, Class 3, and Class F frames, EISL frames, and totals.
- **Link Errors**—View the number of link errors, including link failures, signal losses, synchronization failures, invalid transmission words, and delimiter and address identifier errors.
- **Frame Errors**—View frame error statistics, including the number of frames with invalid CRC, Class 3 frames that were discarded upon reception, FBSY returns for selected situations, and FRJT returns resulting from frame rejection by fabric.
- **Class 2 Traffic**—View the amount of Class 2 traffic for the selected interval.
- **Class 2 Errors**—View error statistics for Class 2 traffic, including busy frame responses and port rejects.
- **FICON**—View FICON error statistics, including pacing, disparity, EOF, OOF, and order sets errors.
Isolating Port Issues Using Device Manager

To isolate port issues using Device Manager, follow these steps:

**Step 1**  Choose **Interfaces > FC ALL** and verify that the Status Oper field is **up** to determine if the host HBA and the storage port can provide link level connectivity to their respective switches.

See Table 8-1 on page 8-3 for details on nonoperational interface reasons.

**Step 2**  If the port is down and offline, set Admin Status to **up** and click **Apply** to bring the port online.

**Step 3**  Repeat **Step 1** to determine if the port is online.

If either of the ports fails to remain in the online state, then you may have a faulty GBIC, cabling or HBA/subsystem port.
Overview of the FC-MAC Driver and the Port Manager

Send documentation comments to mdsfeedback-doc@cisco.com

Step 4 If both ports are online, select the FLOGI tab to verify that the Fibre Channel ports for the host and storage have performed a fabric login (FLOGI) and are communicating with their respective switches.

Step 5 Choose FC > Name Server to verify that the assigned FC ID during FLOGI exists in the name server database.

At this point the HBA and subsystem ports have successfully established link level connectivity and each one can communicate with its locally attached switch in the fabric. The next step is to verify zone membership. For a more detailed discussion and description of VSANs and zones see Chapter 14, “Troubleshooting Zones and Zone Sets.”

Troubleshooting Port States from the CLI

To display complete information for an interface, use the show interface command. In addition to the state of the port, this command displays:

- Port WWN
- Speed
- Trunk VSAN status
- Transmit and receive buffer-to-buffer credits configured and remaining
- Maximum receive buffer size
- Number of frames sent and received
- Transmission errors, including discards, errors, CRCs, and invalid frames

Example 8-1 displays the show interface command output.

Example 8-1 show interface Command Output

switch# show interface fc1/3
fc1/3 is trunking
Hardware is Fibre Channel, SFP is short wave laser
Port WWN is 20:03:00:0b:fd:8c:f8:80
Peer port WWN is 20:10:00:0b:fd:2c:8c:00
Admin port mode is auto, trunk mode is on
Port mode is TE
Port vsan is 161
Speed is 2 Gbps
Transmit B2B Credit is 255
Receive B2B Credit is 255
Receive data field Size is 2112

Using Port Debug Commands

Use the show hardware internal debug-info interface fc CLI command to debug ports.

Note To issue commands with the internal keyword, you must have an account that is a member of the network-admin group.
Examples of when to use these commands include:

- An Fibre Channel port fails to move to the up state after such events as link failures, admin-up operations, or new connections.
- Unexpected link flaps.
- The port moves to “error disabled” state.

Maintain a set of information for the module before these problems occur (if possible) and then gather another set of information after these problems occur.

**Useful Commands at the FC-MAC Level**

Troubleshooting a port problem involves analysis of the debug facilities provided by the FC-MAC driver, or the FC-MAC2 driver in the case of the MDS 9120, MDS 9140, MDS 9216i, and the MPS-14/2 module. Table 8-2 lists several CLI debugging commands at the FC-MAC level.

**Note** You must use the `attach module` CLI command to access these FC-MAC show commands.

**Note** Use the `fcmac2` keyword for the MDS 9120, MDS 9140, MDS 9216i, and the MPS-14/2 module.

<table>
<thead>
<tr>
<th>CLI Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show hardware internal fc-mac port</td>
<td>Performs a series of checks to isolate the problem.</td>
</tr>
<tr>
<td>link-status</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac2 port</td>
<td></td>
</tr>
<tr>
<td>link-status</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac port</td>
<td>Provides the current state and configuration of the port.</td>
</tr>
<tr>
<td>port-info</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac2 port</td>
<td></td>
</tr>
<tr>
<td>port-info</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac port</td>
<td>Gives all non-zero statistics for the port.</td>
</tr>
<tr>
<td>statistics</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac2 port</td>
<td></td>
</tr>
<tr>
<td>statistics</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac port</td>
<td>Displays the current state of the SFP.</td>
</tr>
<tr>
<td>gbic-info</td>
<td></td>
</tr>
<tr>
<td>show hardware internal fc-mac2 port</td>
<td></td>
</tr>
<tr>
<td>gbic-info</td>
<td></td>
</tr>
</tbody>
</table>
Overview of the FC-MAC Driver and the Port Manager

Note
To issue CLI commands with the `internal` keyword, you must have an account that is a member of the network-admin group.

Isolating Port Issues Using the CLI

To isolate port issues using the CLI, follow these steps:

Step 1 Use the `show interface` command to determine if the host HBA and the storage port can provide link level connectivity to their respective switches.

```
NPI1# show interface fc2/5 status
fc2/5 is down (Offline)

NPI2# show interface fc2/5 status
fc1/5 is up  Port mode is F
```

See Table 8-1 on page 8-3 for details on nonoperational interface reasons.

Step 2 If the port is down and offline, use the `no shutdown` command to bring the port online.

```
NPI1# config t
NPI1(config)# interface fc 2/5
NPI1(config-if)# no shutdown
```

Step 3 Repeat Step 1 to determine if the port is online.

If either of the ports fails to remain in the online state, then you may have a faulty GBIC, cabling or HBA/subsystem port.

Step 4 If both ports are online, use the `show flogi` command to verify that the Fibre Channel ports for the host and storage have performed a fabric login (FLOGI) and are communicating with their respective switches.

Example 8-2 Using the `show flogi` command

```
NPI1# sh flogi

INTERFACE       VSAN   FCID           PORT NAME               NODE NAME
-------------------- ---- -------- ----------------------- -----------------------
fc2/5       1 0x7e0200 21:00:00:e0:8b:08:d3:20 20:00:00:e0:8b:08:d3:20
fc2/7       1 0x7e0300 20:00:00:e0:69:41:98:93 10:00:00:e0:69:41:98:93
fc2/11      1 0x7e0100 21:00:00:e0:8b:07:ca:39 20:00:00:e0:8b:07:ca:39
fc8/31      1 0x7e0000 50:06:04:82:c3:a0:98:42 50:06:04:82:c3:a0:98:42
```
Common Problems with Port Interfaces

The following issues are commonly seen with port interfaces:

- Port Remains in a Link Failure or Not Connected State, page 8-13
- Port Remains in Initializing State, page 8-16
- Unexpected Link Flapping Occurs, page 8-21
- Port Bounces Between Initializing and Offline States, page 8-26
- E Port Bounces Remains Isolated After a Zone Merge, page 8-28
- Port Cycles Through Up and Down States, page 8-31
- Port Is in ErrDisabled State, page 8-31
- Troubleshooting Fx Port Failure, page 8-32

Port Remains in a Link Failure or Not Connected State

If a link does not come up, then the switch was unable to achieve bit or word synchronization with the node device. This situation may occur if nothing is connected to the interface, as in the case of a broken fibre, or if there is no bit synchronization between the switch interface and the directly connected Nx port. This problem may be the result of one or more of the possible causes listed in Table 8-3.
Common Problems with Port Interfaces

Send documentation comments to mdsfeedback-doc@cisco.com

**Symptom**  Port remains in a link-failure state.

### Table 8-3 Port Remains in a Link-Failure State

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Port remains in a link-failure state. | Port connection is bad. | Use the `show port internal info` CLI command to verify the port status is in link-failure. Use the `show hardware internal fc-mac port port gbic-info` CLI command to determine if there is a signal present.  

**Note**  You must use the `attach module` CLI command to access the FC-MAC show commands.  
Verify the type of media in use. Is it copper or optical, single-mode (SM) or multimode (MM)?  
Verify that the media is not broken or damaged. Is the LED on the switch green? Is the active LED on the host bus adapter (HBA) for the connected device on?  
Right-click on the port in Device Manager and select disable and then enable, or use the `shut` CLI command followed by the `no shut` command to disable and enable the port. If this does not clear the problem, try moving the connection to a different port on the same or another module. |
| There is no signal because of a transit fault in the SFP or the SFP may be faulty. | When this occurs, the port stays in a transit port state and you see no signal. There is no synchronization at the MAC level. The problem may be related to the port speed setting or autonegotiation. See the “Troubleshooting Port Problems” section on page 8-15. Verify that the SFP on the interface is seated properly. If reseating the SFP does not resolve the issue, replace the SFP or try another port on the switch. |
| Link is stuck in initialization state or the link is in a point-to-point state. | Choose Logs > Switch Resident > Syslog on Device Manager or use the `show logging` CLI command to check for a Link Failure, Not Connected system message.  
Right-click on the port in Device Manager and select disable and then enable, or use the `shut` CLI command followed by the `no shut` command to disable and enable the port. If this does not clear the problem, try moving the connection to a different port on the same or another module. |

**Note**  We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the problem.
Troubleshooting Port Problems

Start the debugging with the command `show hardware internal fc-mac port port link-status`. See the “Useful Commands at the FC-MAC Level” section on page 8-11 to understand how to use the FC-MAC information.

**Note**
You must use the `attach module` CLI command to access the FC-MAC show commands.

When this command executes, it performs the following checks in the order shown here and displays the appropriate information:

1. Checks whether the port was declared a failure because of an exception. For additional information, use the `show process exceptionlog` CLI command.
2. Checks whether the port is administratively enabled.
3. Checks whether the physical link state is up. If the state is up, then it does the following:
   - Checks for possible completion of the FLOGI process.

**Note**
FLOGI is transparent to the MAC driver and is based on some expected configuration. The MAC driver assumes that the FLOGI process is completed.

   - Checks for error counters.
4. Checks whether the port is in the offline state. The port goes to the offline state if the FLOGI or ELP (in case of auto mode) on the port does not succeed.
5. Checks for pause state. A pause state is in an intermediate state (as maintained by the FC-MAC driver) after the link goes down and before the port is enabled by the Port Manager.

**Note**
The link reinitializes after a link down event is initiated only if enable is issued by the Port Manager.

6. Checks for the presence of SFP/GBIC. If present, FC-MAC checks for loss of signal. The loss of signal state indicates either the physical connectivity between two end ports is bad or there is a transmit fault in the SFP. Use the `show hardware internal fc-mac port port gbic-info` command to check for the transmit fault.

**Note**
You must use the `attach module` CLI command to access the FC-MAC show commands.

7. Checks for the speed and sync state of the port. If the port is in the speed initialization state, then:
   - **Auto speed is in progress** is displayed if the port is in automode.
   - **Waiting for stable sync** is displayed if the port is configured for a fixed speed.
   - **Sync not acquired** is displayed if the MAC state indicates a loss of synchronization. In auto mode, this state is not necessarily an error. In any case, check the speed capabilities and configuration at both ends.
Common Problems with Port Interfaces

Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 8 Troubleshooting Ports

Port Remains in Initializing State

Symptom  Port remains in the initializing state.

A port goes into the initialization state after a successful completion of link level initialization. For Fx and FL types of ports, the next step is to complete the FLOGI process. The port remains in the initialization state until the FLOGI (fabric login) process completes.

For E or TE port types, the next step is to complete the ELP process. If the ELP fails the port is moved to the offline state after a timeout and the entire process repeats until the port comes online.

Table 8-4 lists possible causes for FLOGI to fail for a given port and possible solutions.

Table 8-4 Port Remains in the Initializing State

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Port remains in the initializing state. | The port is up because the link partner has put itself in a bypass mode. | Use the `show hardware internal fc-mac port port statistics` command to check whether the Class-3 input counter is increasing after the successful completion of link initialization.  
**Note** You must use the `attach module` CLI command to access the FC-MAC show commands. |
| The FLOGI packet was dropped somewhere in the data path, starting from FC-MAC to the FLOGI server. | Use the `show hardware internal fc-mac port port statistics` command to check for Class-3 packet counters.  
**Note** You must use the `attach module` CLI command to access the FC-MAC show commands. |
| A software bug resulted in an error while handling the FLOGI packet. | Analyze the output of the `show hardware internal error` command for a possible drop of FLOGI packets somewhere in the path. See the “**Note** We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the problem.” section on page 8-16.  
Right-click on the port in Device Manager and select `disable` and then `enable`, or use the `shut` CLI command followed by the `no shut` command to disable and enable the port. If this does not clear the problem, try moving the connection to a different port on the same or another module. |

**Note** We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the problem.
Troubleshooting Port Registration Issues Using the CLI

To troubleshoot Nx port registration in the CLI, follow these steps:

**Step 1**
Use the `show interface fc slot/port` command and verify that the fibre channel interface connected to the device in question is up and free of any errors. (See *Example 8-3*.)

*Example 8-3  show interface Command Output*

```bash
switch# show interface fc3/14
cf3/14 is up
    Hardware is Fibre Channel
    Port WWN is 20:8e:00:05:30:00:86:9e
    Admin port mode is FX
    Port mode is F, FCID is 0x780200 /* Operational State of the Port */
    Port vsan is 99 /* This is the vsan */
    Speed is 2 Gbps
    Receive B2B Credit is 16
    Receive data field size is 2112
    Beacon is turned off
    5 minutes input rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
    5 minutes output rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
    1700 frames input, 106008 bytes, 0 discards
        0 CRC, 0 unknown class
        0 too long, 0 too short
    2904 frames output, 364744 bytes, 0 discards
        0 input OLS, 0 LRR, 0 NOS, 0 loop inits
    1 output OLS, 1 LRR, 0 NOS, 0 loop inits
```

If the interface is not working correctly, check the cabling and the host or storage device interface for faults. If the interface is working correctly, proceed to the next step.

**Step 2**
Verify that the device in question appears in the FLOGI database. To do this, enter the following command:

`show flogi database vsan vsan-id`

The system output might look like this:

```bash
switch# show flogi database vsan 99
```

<table>
<thead>
<tr>
<th>INTERFACE</th>
<th>VSAN</th>
<th>FCID</th>
<th>PORT NAME</th>
<th>NODE NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>fc3/14</td>
<td>99</td>
<td>0x780200</td>
<td>21:00:00:e0:8b:07:a4:36</td>
<td>20:00:00:e0:8b:07:a4:36</td>
</tr>
</tbody>
</table>

If the device in question appears in this output, skip to Step 7. If the device does not appear in the output, go to the next step.

**Step 3**
Use the `shutdown` command in interface configuration mode to shut down the Fibre Channel interface connected to the device in question.

```bash
switch# config terminal
switch(config)# interface fc3/x
switch(config-if)# shutdown
```

**Note**
We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the problem.
Step 4  Use the `no shutdown` command on the Fibre Channel interface.

```
switch(config-if)# no shutdown
```

By shutting down the interface and bringing it back up, you can determine what happens when the connected device tries to log in to the interface.

Use the `show flogi internal event-history interface` command to view the events that occurred on the interface after you enabled it again. The comments that follow each section of output explain the meaning of the output.

**Note**  To issue commands with the `internal` keyword, you must have an account that is a member of the network-admin group.

```
switch# show flogi internal event-history interface fc3/14
>>>>FSM: <[99]21:00:00:e0:8b:07:a4:36> has 9 logged transitions<<<<
/* This is the [VSAN] followed by the pwn of the N/NL port */

1) FSM:<[99]21:00:00:e0:8b:07:a4:36> Transition at 321686 usecs after Sun Feb 1 04:18:15 1980
   Previous state: [FLOGI_ST_FLOGI_RECEIVED]
   Triggered event: [FLOGI_EV_VALID_FLOGI]
   Next state: [FLOGI_ST_GET_FCID]
/* The hba has sent an FLOGI to the switch */

2) FSM:<[99]21:00:00:e0:8b:07:a4:36> Transition at 322974 usecs after Sun Feb 1 04:18:15 1980
   Previous state: [FLOGI_ST_GET_FCID]
   Triggered event: [FLOGI_EV_VALID_FCID]
   Next state: [FLOGI_ST_PERFORM_CONFIG]
/* Port Manager Obtains a valid FC_ID from the Domain Mgr */

3) FSM:<[99]21:00:00:e0:8b:07:a4:36> Transition at 323731 usecs after Sun Feb 1 04:18:15 1980
   Previous state: [FLOGI_ST_PERFORM_CONFIG]
   Triggered event: [FLOGI_EV_CONFIG_DONE_PENDING]
   Next state: [FLOGI_ST_PERFORM_CONFIG]
/* ACLs are programmed and FIB (VSAN, FC_ID, portindex) is set */

4) FSM:<[99]21:00:00:e0:8b:07:a4:36> Transition at 323948 usecs after Sun Feb 1 04:18:15 1980
   Previous state: [FLOGI_ST_PERFORM_CONFIG]
   Triggered event: [FLOGI_EV_LCP_RESPONSE]
   Next state: [FLOGI_ST_PERFORM_CONFIG]
/* LineCard responds that it is done */

5) FSM:<[99]21:00:00:e0:8b:07:a4:36> Transition at 325962 usecs after Sun Feb 1 04:18:15 1980
   Previous state: [FLOGI_ST_PERFORM_CONFIG]
   Triggered event: [FLOGI_EV_NAME_SERVER_REG_RESPONSE]
   Next state: [FLOGI_ST_PERFORM_CONFIG]
/* Program the NameServer with wwn and FCID */

6) FSM:<[99]21:00:00:e0:8b:07:a4:36> Transition at 330381 usecs after Sun Feb 1 04:18:15 1980
   Previous state: [FLOGI_ST_PERFORM_CONFIG]
   Triggered event: [FLOGI_EV_ZS_CFG_RESPONSE]
   Next state: [FLOGI_ST_PERFORM_CONFIG]
/* Response from ZoneServer */
If the device logs in successfully, proceed to the next step. Otherwise, you may have a problem with the device or its associated software.

**Step 5**

Use the `shutdown` command in interface mode to shut down the Fibre Channel interface. Then use the `no shutdown` command after turning on the debug described in **Step 6** and **Step 7**.

**Note**

We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the problem.

**Step 6**

Use the `debug fcns events register vsan` command to watch the FLOGI process take place.

```
switch# debug fcns events register vsan 99
```

This command enables debug mode for name server registration. It generates messages on the switch console related to FCNS events. The system output may look something like this:

```
switch# config t
Enter configuration commands, one per line. End with CNTL/Z.
switch(config)# interface fc3/14
switch(config-if)# no shutdown /* enable the port */
```

```
switch(config-if)# Feb 17 04:42:54 fcns: vsan 99: Created entry for port-id 27800
Feb 17 04:42:54 fcns: vsan 99: Got Entry for port-id 27800
Feb 17 04:42:54 fcns: vsan 99: Registered port-name 36a4078be0000021 for port-id 780200
Feb 17 04:42:54 fcns: vsan 99: Registered node-name 36a4078be0000020 for port-id 780200
/* The wwpn and FCID for the port, note that the bytes in the world wide name are reversed */
Feb 17 04:42:54 fcns: vsan 99: Registered cos 8 for port-id 780200
/* Class of Service */
```

```
Feb 17 04:42:54 fcns: vsan 99: Registered port-type 1 for port-id 780200
/* Port Type */
Feb 17 04:42:54 fcns: vsan 99: Reading configuration for entry with port-name 36a4078be0000021, node-name 36a4078be0000020
Feb 17 04:42:54 fcns: vsan 99: No configuration present for this portname
Feb 17 04:42:54 fcns: vsan 99: No configuration present for this nodename
/* Port is now registered in nameserver, will send out RSCN to it */
```
Common Problems with Port Interfaces

Send documentation comments to mdsfeedback-doc@cisco.com

Feb 17 04:42:54 fcns: vsan 99: Trying to send RSCN; affected port 780200
Feb 17 04:42:54 fcns: vsan 99: rscn timer started for port 780200
Feb 17 04:42:54 fcns: vsan 99: Saving new entry into pss
Feb 17 04:42:54 fcns: vsan 99: Sending sync message to the standby
Feb 17 04:42:54 fcns: vsan 99: sending accept response to 780200
/* RSCN was received by N/NL port */

Feb 17 04:42:54 fcns: vsan 99: sending accept response to fffc61
/* Other switch in fabric is notified */
Feb 17 04:42:55 fcns: vsan 99: rscn timer expired for port 780200
Feb 17 04:42:55 fcns: vsan 99: Saving modified entry into pss
Feb 17 04:42:55 fcns: vsan 99: Sending sync message to the standby

Feb 17 04:42:55 fcns: vsan 99: Registered fc4-types for port-id 780200
Feb 17 04:42:55 fcns: vsan 99: Registered fc4-features for fc4_type 8 for port-id 780200
/* FC4 Type, type 8 FCP has been registered */

Additional lines similar to these will be listed if more name server objects are registered.

Step 7
If you are managing the switch over a Telnet connection, enable terminal monitoring by entering the terminal monitor command in exec mode.

The system output looks like this:

switch# show fcns database detail vsan 99
------------------------
VSAN:99   FCID:0x780200
------------------------
port-wwn (vendor)     :21:00:00:e0:8b:07:a4:36 (QLogic) /* Port world wide name */
node-wwn              :20:00:00:e0:8b:07:a4:36
class                 :3                     /* Fibrechannel class of service */
ode-ip-addr           :0.0.0.0               /* IP Address */
ipa                   :ff ff ff ff ff ff ff ff
fc4-types:fc4_features:scsi-fcp:init         /* Registered FC4 Types: example SCSI and initiator */
symbolic-port-name    :
symbolic-node-name    :
port-type             :N                     /* Fibrechannel port type (F,FL) */
port-ip-addr          :0.0.0.0
fabric-port-wwn       :20:8e:00:05:30:00:86:9e /* wwn of the switch port */
hard-addr             :0x000000

Other attribute objects of the Nx port are registered one per register operation after the FLOGI process is complete. The Nx port performs PLOGI to the well-known WWN of the Name Server, 0xFFFFFC. The FC_CT Common Transport protocol uses Request and Accept messages to conduct transactions. To verify that additional attributes are correctly registered and recorded in the database, you can use the SAN-OS debug facility.

Note
The command show fcns database detail vsan X displays a detailed list of all devices registered in the fabric.
Common Problems with Port Interfaces

Unexpected Link Flapping Occurs

**Symptom**  Unexpected link flapping occurs.

When a port is flapping, it cycles through the following states, in this order, and then starts over again:

1. Initializing - The link is initializing.
2. Offline - The port is offline.
3. Link failure or not connected - The physical layer is not operational and there is no active device connection.

When troubleshooting unexpected link flapping, it is important to know the following information:

- Who initiated the link flap.
- The actual link down reason.

Be sure to check the HBA, because a faulty HBA can manifest symptoms on the attached switch port. For example, if an Nx port is self-diagnosed as faulty by the HBA driver or firmware, the driver can place the port in optical bypass mode. This results in the receive and transmit paths being internally connected through the port. If this happens, the switch port connected to the faulty device will reach bit and word synchronization with itself. If the port is configured in auto mode, this will cause the port to issue an ELP and to try to initialize as an xE port, even if an end device is physically connected to that interface. In this case, a port reason code of isolation because of ELP failure can be displayed even if an ISL is not present.
Table 8-5 lists possible causes and solutions for link flapping.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexpected link flapping occurs.</td>
<td>The bit rate exceeds the threshold and puts the port into an error disabled state.</td>
<td>Right-click the port in Device Manager and select <strong>disable</strong> and then <strong>enable</strong>, or use the <strong>shut CLI</strong> command followed by the <strong>no shut</strong> command to return the port to the normal state.</td>
</tr>
<tr>
<td></td>
<td>The switch cannot complete the link reset. The link reset protocol failure results in a link flap that may be the result of:</td>
<td>The switch initiates the link reset when all credits are lost for more than four seconds or when there is a temporary signal or sync loss condition that lasts for less than 100msec. See the “Troubleshooting Port Problems” section on page 8-15 to verify this condition.</td>
</tr>
<tr>
<td></td>
<td>• The input buffer did not become empty within the link reset timeout period.</td>
<td>Right-click the port in Device Manager and select <strong>disable</strong> and then <strong>enable</strong>, or use the <strong>shut CLI</strong> command followed by the <strong>no shut</strong> command to disable and enable the port. If this does not clear the problem, try moving the connection to a different port on the same or another module.</td>
</tr>
<tr>
<td></td>
<td>• The link partner did not respond to a link reset initiated by the switch.</td>
<td></td>
</tr>
<tr>
<td>There is a credit loss condition on an FL port.</td>
<td></td>
<td>When credit loss or a transmit stuck condition is detected in the FL port, the FC-MAC drive flaps the link as a recovery process. See the “Troubleshooting Port Problems” section on page 8-15.</td>
</tr>
<tr>
<td>Some problem in the switch triggers the link flap action by the end device. Some of the causes are:</td>
<td></td>
<td>Determine link flap reason as indicated by the MAC driver. Use the debug facilities on the end device to troubleshoot the problem. An external device may choose to reinitialize the link upon encountering the error. In such cases, the exact method of reinitializing the link varies by device. See the “Troubleshooting Port Problems” section on page 8-15 for more information on externally triggered link flaps.</td>
</tr>
<tr>
<td>• Packet drop in the switch, because of either a hardware failure or an intermittent hardware error such as X-bar sync loss.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Packet drop resulting from a software error.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A control frame is erroneously sent to the device.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the problem.
Link Initialization Flow

Fibre Channel primitive sequences are used to establish and maintain a link and they continue to be transmitted until a response has been received. Four primitive sequences are used in the link initialization process:

- Not operational sequence (NOS)
- Offline sequence (OLS)
- Link reset sequence (LRS)
- Link reset response sequence (LRR)

Figure 8-6 uses the ordered sets of 8b/10 encoding in the primary operational states. They include:

- AC = Active state
- LR = Link recovery state
- LF = Link failure state
- OF = Offline state

**Figure 8-6  Link Initialization Flow**

Ordered sets of 8B/10B coding:

- NOS = Not Operational Sequence
- OLS = Offline Sequence
- LR = Link Reset
- LRR = Link Reset Response

Ordered sets of 8B/10B coding:

- RC = Active State
- LR = Link Recovery State
- LF = Link Failure State
- OL = Offline State

**Figure 8-6** shows the link initialization flow. It displays the ordered sets transmitted between the ports and the primary operational states of the port during the process. They include:

1. Active state.
2. Link recovery state (LR):
   a. LR transmit substate (LR1)
   b. LR receive substate (LR2)
   c. LRR receive substate (LR3)
Common Problems with Port Interfaces

3. Offline state (OLS):
   a. OLS transmit substate (OL1)
   b. OLS receive substate (OL2)
   c. Wait for OLS substate (OL3)

4. Link failure state:
   a. NOS receive substate (LF1)
   b. NOS transmit substate (LF2)

The Cisco MDS 9000 Family switch maintains port counters for link initialization ordered sets, including OLS, LRR, and NOS for fabric connections, as well as primitives for arbitrated loop connections on FL ports and TL ports. Understanding the link initialization flow and viewing the port counters using `show interface` can be useful when you troubleshoot port initialization problems.

Table 8-6 displays the reasons for a link flap.

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync Loss</td>
<td>A synchronization loss condition persisted for more than 100 milliseconds. Look at the Invalid Transmission Word Count to check whether the physical link is really bad and if that caused the loss of synchronization. Sometimes this is not necessarily a problem with the physical link, but with the way some devices initialize the link. Use <code>attach module</code> to connect to the module and then use the <code>show hardware internal debug-info interface</code> CLI command. See Table 8-2.</td>
</tr>
<tr>
<td>Loss of signal</td>
<td>A signal loss condition persisted for more than 100 milliseconds. Look at the Invalid Transmission Word Count to check whether the physical link is really bad and if that caused the loss of synchronization. Sometimes this is not necessarily a problem with the physical link, but with the way some devices initialize the link. If the link does not come up after a flap, then probably the other end is in a shutdown state or the cable is broken. You can check for the broken or disconnected optical link by using the <code>show hardware internal fc-mac port port gbic-info</code> CLI command. <strong>Note</strong> You must use the <code>attach module</code> CLI command to access the FC-MAC show commands.</td>
</tr>
</tbody>
</table>
| NOS received       | A NOS received condition is detected. If the other end is an MDS port, then the NOS is transmitted by the other end in one of the following conditions:  
   - A signal loss or sync loss condition is detected.  
   - The port is administratively shut down.  
   - The port is operationally down. |
| OLS received       | An OLS received condition is detected.                                      |
| LR received B2B    | Link reset (LR) failed because of the receive queue (in the queue engine) not being empty.                                        |
| Cr loss            | Too many credit loss events occurred.                                       |
Chapter 8  Troubleshooting Ports

Common Problems with Port Interfaces

Send documentation comments to mdsfeedback-doc@cisco.com

Table 8-6  Link Flap Reasons Initiated by a Device Connected to the Switch Port (continued)

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
</table>
| Rx queue overflow | The receive queue overflowed in the queue engine occurred. This can happen under the following conditions:  
|                   | • Improper credit configuration at one or both ends of the link.  
|                   | • A bad link can sometimes result in extra R_RDYs. Check for invalid transmission words at both ends. |
| LIP F* received   | An loop initialization procedure (LIP) was received. |
| LC port shutdown  | The port shutdown was invoked. Use the show process exception CLI command to check for any other errors. |
| LIP received B2B  | An LIP was received while the Rx queue was not empty. |
| OPNy tmo B2B      | An open circuit on a loop (OPNy) timeout occurred while the Rx queue was not empty. |
| OPNy Ret B2B      | An OPNy was returned while the Rx queue was not empty. |
| Cr Loss B2B       | Credit loss occurred while the Rx queue was not empty. |

Viewing Port Counters

You can use the show interface counters command to view port counters. Typically, you only observe counters while actively troubleshooting, in which case you should first clear the counters to create a baseline. The values, even if they are high for certain counters, can be meaningless for a port that has been active for an extended period. Clearing the counters provides a better idea of the link behavior as you begin to troubleshoot.

Use one of the following commands in EXEC mode to clear all port counters or counters for specified interfaces:

- clear counters interface all
- clear counters interface <range>

The counters can identify synchronization problems by displaying a significant disparity between received and transmitted frames. For example, in the case of a broken fiber, if only the Tx path from the F port to the N port is broken, then the switch interface will still have an operational Rx path and will still obtain bit synchronization from the bit stream received from the N port. The switch port will also be able to recognize an incoming NOS from the N port and reply with an OLS. However, because the transmitted OLS never reaches the N port, the R_T_TOV timer expires. In this scenario, the status of the port will also show Link failure or not connected.

The key difference between this case and the no bit synchronization case is that the input and output counts for OLS and NOS increment (as there is bit synchronization but no word synchronization). In such a state, you can check that the Tx path from the switch to the Rx input on the N port interface is properly connected. A faulty transmitter on the switch’s SFP or a faulty receiver on the N port’s SFP could also cause the issue.
Common Problems with Port Interfaces

The output in Example 8-4 also displays evidence of corrupt data on the wire if there are a high number of CRCs and errors. Discards may or may not indicate a problem. For example, a frame can be discarded because of an ACL violation.

**Example 8-4  show interface Command**

```
mds# show interface fc4/2
fc4/2 is up
...
5 minutes input rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
5 minutes output rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
322944 frames input, 19378384 bytes
0 discards, 0 errors <........................................ Errors
0 CRC, 0 unknown class
0 too long, 0 too short
20439797 frames output, 41780390808 bytes
0 discards, 0 errors
0 input OLS, 0 LRR, 0 NOS, 0 loop inits
2 output OLS, 2 LRR, 0 NOS, 0 loop inits <.................Link Initialization
12 receive B2B credit remaining
1 transmit B2B credit remaining
```

Port Bounces Between Initializing and Offline States

**Symptom** Port bounces between the initializing and offline states.

An ELP failure may result in a port bouncing between the initializing and offline states. Table 8-7 lists possible causes and solutions to this problem.

<table>
<thead>
<tr>
<th>Table 8-7</th>
<th>Port Bounces Between the Initializing and Offline States</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
</tr>
<tr>
<td>Port bounces between the initializing and offline states.</td>
<td>An ELP packet was dropped in one of the two switches.</td>
</tr>
<tr>
<td>There is a software bug or incompatibility in handling the ELP process.</td>
<td>Analyze the event history provided by the Port Manager after using the <code>show port internal event-history</code> CLI command. See the “Troubleshooting ELP Issues Using the CLI” section on page 8-27.</td>
</tr>
</tbody>
</table>
Troubleshooting ELP Issues Using the CLI

To troubleshoot ELP issues using the CLI, follow these steps:

**Step 1** Use the show interface command to verify E port isolation:

```
switch# show interface fc2/4
fc2/4 is down (Isolation due to ELP failure)
Hardware is Fibre Channel, WWN is 20:44:00:05:30:00:18:a2
vsan is 1
Beacon is turned off
1445517676 packets input, 727667035658 bytes, 0 discards
0 input errors, 0 CRC, 0 invalid transmission words
0 address id, 0 delimiter
Received 0 runts, 0 jabber, 0 too long, 0 too short
0 EOF abort, 0 fragmented, 0 unknown class
100 OLS, 67 LRR, 37 NOS, 0 loop inits
133283352 packets output, 1332969530 bytes
Transmitted 198 OLS, 50 LRR, 0 NOS, 10 loop inits
```

In this example the interface indicates a link isolation caused by an ELP failure on an E port. The ELP is a frame sent between two switches to negotiate fabric parameters.

**Step 2** Verify that the following parameters match on each switch in the VSAN using the `show fctimer` command:

- ED_TOV timer
- RA_TOV timer
- FS_TOV timer

**Note** Because fabric parameters are configured on a per VSAN basis, they are required to be the same for all switches within a VSAN.

```
switch# show fctimer
F_S_TOV : 5000 milliseconds
D_S_TOV : 5000 milliseconds
E_D_TOV : 2000 milliseconds
R_A_TOV : 10000 milliseconds
```

This sample output shows the default settings for these timeout values.

**Step 3** Optionally, use the `fctimer` command in config mode to globally set these timeout values across all VSANs or use the `fctimer D_S_TOV <timeout> vsan <vsan-id>` command for example, to set the D_S_TOV timeout for a particular VSAN to override the global values.

**Step 4** Use the `show port internal info interface fc` command to verify that Rx buffer size matches on both ends of the ISL.

**Note** To issue commands with the `internal` keyword, you must have an account that is a member of the network-admin group.

```
switch# show port internal info interface fc2/1
fc2/1 - if_index: 1080000
Admin Config - state(up), mode(Auto), speed(auto), trunk(no trunk)
beacon(off), snmp trap(on), tem(false)
```
E Port Bounces Remains Isolated After a Zone Merge

**Symptom**  E port remains isolated after a zone merge.

An E port may be isolated because of a zone merge failure. Table 8-8 lists possible causes and solutions to this problem.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E port remains isolated after a zone merge.</td>
<td>The active zone sets on the two switches differ from each other in terms of zone membership (provided there are zones at either side with identical names).</td>
<td>See the “Troubleshooting E port Isolation using Fabric Manager” section on page 8-29 or the “Troubleshooting E port Isolation using Fabric Manager” section on page 8-29.</td>
</tr>
<tr>
<td></td>
<td>The active zone set on both switches contains a zone with the same name but with different zone members.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting E port Isolation using Fabric Manager

To troubleshoot E port isolation due to zoning using Fabric Manager, follow these steps:

**Step 1** Choose **Switches > Interfaces > FC Physical** to verify that the E port did not come up because of a zone merge failure.

**Note** Zoning information exists on a per VSAN basis. Therefore, for a TE port, it may be necessary to verify that the zoning information does not conflict for any allowed VSAN.

**Step 2** Select **Zone > Edit Local Full Zone Database** to verify the zoning configuration.

**Step 3** Use one of the following two approaches to resolve a zone merge failure:

- Choose **File > Restore** from the Edit Local Full Zone Database dialog box to overwrite the zoning configuration of one switch with the other switch’s configuration.
  
  The **Restore** option overwrites the local switch’s active zone set with that of the remote switch.

- If the zoning databases between the two switches are overwritten, you cannot use the **Restore** option. To work around this, you can manually change the content of the zone database on either of the switches using the Edit Local Full Zone Database, and then choose **Switches > Interfaces > FC Physical** and select **down** and then **up** on the Admin Status drop-down menu for the isolated port.

**Step 4** If the isolation is specific to one VSAN and not on an E port, the correct way to issue the cycle up or down is to remove the VSAN from the list of allowed VSANs on that trunk port, and reinsert it.

  a. Choose **Switches > Interfaces > FC Physical** and select the **Trunk Config** tab.
  
  b. Remove the VSAN from the Allowed VSAN list and click **Apply Changes**.
  
  c. Add the VSAN back to Allowed VSAN list and click **Apply Changes**.

**Note** We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the isolation problem.

Using the Zone Merge Analysis tool in Fabric Manager, the compatibility of two active zone sets in two switches can be checked before actually merging the two zone sets. Refer to the *Cisco MDS 9000 Fabric Manager Configuration Guide* for more information.
Troubleshooting E port Isolation Using the CLI

To troubleshoot E port isolation due to zoning using the CLI, follow these steps:

**Step 1**  Use the `show interface` command output to verify that the E port did not come up because of a zone merge failure.

**Note**  Zoning information exists on a per VSAN basis. Therefore, for a TE port, it may be necessary to verify that the zoning information does not conflict for any allowed VSAN.

```
switch# show interface fc2/14
fc2/14 is down (Isolation due to zone merge failure)
   Hardware is Fibre Channel, WWN is 20:4e:00:05:30:00:63:9e
   vsan is 1
   Beacon is turned off
   40 frames input, 1056 bytes, 0 discards
   0 runts, 0 jabber, 0 too long, 0 too short
   0 input errors, 0 CRC, 3 invalid transmission words
   0 address id, 0 delimiter
   0 EOF abort, 0 fragmented, 0 unknown class
   79 frames output, 1234 bytes, 16777216 discards
   Received 23 OLS, 14 LRR, 13 NOS, 39 loop inits
   Transmitted 50 OLS, 16 LRR, 21 NOS, 25 loop inits
```

**Step 2**  Verify the zoning information using the following commands:

- `show zone vsan vsan-id`
- `show zoneset vsan vsan-id`

**Step 3**  Use one of the following two approaches to resolve a zone merge failure:

- Overwrite the zoning configuration of one switch with the other switch’s configuration. This can be done with the following commands:
  
  - `zone copy interface fc slot/port import vsan vsan-id`
  
  - `zone copy interface fc slot/port export vsan vsan-id`

  The `import` option of the command overwrites the local switch’s active zoneset with that of the remote switch. The `export` option overwrites the remote switch’s active zoneset with the local switch’s active zone set.

- If the zoning databases between the two switches are overwritten, you cannot use the `import` option. To work around this, you can manually change the content of the zone database on either of the switches, and then issue a `shutdown/no shutdown` command sequence on the isolated port.

**Step 4**  If the isolation is specific to one VSAN and not on an E port, the correct way to issue the cycle up or down is to remove the VSAN from the list of allowed VSANs on that trunk port, and reinsert it.

**Note**  We recommend that you do not disable and then enable a T or TE port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the isolation problem.
Port Cycles Through Up and Down States

**Symptom** Port cycles through the up and down states.

This problem may be attributable to an error experienced by the connected device. Table 8-9 lists the possible causes and solutions for this problem.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port cycles through the up and down states</td>
<td>One or more packets were dropped in the switch.</td>
<td>Analyze the debug log provided by the Nx port. Select <strong>Tools &gt; Traceroute</strong> using Fabric Manager or use the <strong>fctrace</strong> CLI command to analyze the link.</td>
</tr>
<tr>
<td></td>
<td>There is a problem in FLOGI processing.</td>
<td>Look for FLOGI messages in the logs for this port. See the “Troubleshooting Port Registration Issues Using the CLI” section on page 8-17</td>
</tr>
<tr>
<td></td>
<td>The device received unexpected packets.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>There was a higher layer software error.</td>
<td></td>
</tr>
</tbody>
</table>

Port Is in ErrDisabled State

The ErrDisabled state indicates that the switch detected a problem with the port and disabled the port. This state could be caused by a flapping port or a high amount of bad frames (CRC errors), potentially indicating something wrong with the media.

**Symptom** Port is in ErrDisabled state.

An E port may be isolated because of a zone merge failure. Table 8-10 lists possible causes and solutions to this problem.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port is in ErrDisabled state</td>
<td>Flapping port.</td>
<td>See the “Verifying the ErrDisable State Using the CLI” section on page 8-31. Verify the SFP, cable, and connections.</td>
</tr>
<tr>
<td></td>
<td>Switch detected a high amount of bad frames (CRC errors), potentially indicating something wrong with the media.</td>
<td></td>
</tr>
</tbody>
</table>

Verifying the ErrDisable State Using the CLI

To resolve the ErrDisable state using the CLI, follow these steps:

**Step 1** Use the **show interface** command to verify that the switch detected a problem and disabled the port. Check cables, SFPs, and optics.

```bash
mds# show interface fc1/14
fc1/14 is down (errDisabled)
```
Common Problems with Port Interfaces

Send documentation comments to mdsfeedback-doc@cisco.com

Step 2  Use the show port internal event-history interface command to view information about the internal state transitions of the port. In this example, port fc1/7 entered the ErrDisabled state because of a capability mismatch, or “CAP MISMATCH.” You might not know how to interpret this event, but you can look for more information with other commands.

```
mds# show port internal event-history interface fc1/7
>>>FSM: <fc1/7> has 86 logged transitions<<<<
1) FSM:<fc1/7> Transition at 647054 usecs after Tue Jan  1 22:44..
   Previous state: [PI_FSM_ST_IF_NOT_INIT]
   Triggered event: [PI_FSM_EV_MODULE_INIT_DONE]
   Next state: [PI_FSM_ST_IF_INIT_EVAL]
2) FSM:<fc1/7> Transition at 647114 usecs after Tue Jan  1 22:43..
   Previous state: [PI_FSM_ST_IF_INIT_EVAL]
   Triggered event: [PI_FSM_EV_IE_ERR_DISABLED_CAP_MISMATCH]
   Next state: [PI_FSM_ST_IF_DOWN_STATE]
```

Step 3  Use the show logging logfile command to display the switch log file and view a list of port state changes. In this example, an error was recorded when someone attempted to add port fc1/7 to PortChannel 3. The port was not configured identically to PortChannel 3, so the attempt failed.

```
mds# show logging logfile
Jan  4 06:54:04 switch %PORT_CHANNEL-5-CREATED: port-channel 17 created
Jan  4 06:54:24 switch %PORT-5-IF_DOWN_PORT_CHANNEL_MEMBERS_DOWN: Interface port-channel 17 is down (No operational members)
Jan  4 06:54:40 switch %PORT_CHANNEL-5-PORT_ADDED: fc1/8 added to port-channel 7
Jan  4 06:54:56 switch %PORT-5-IF_DOWN_ADMIN_DOWN: Interface fc1/7 is down (Administratively down)
Jan  4 06:55:59 switch %PORT_CHANNEL-3-COMPAT_CHECK_FAILURE: speed is not compatible
Jan  4 06:55:56 switch%PORT_CHANNEL-5-PORT_ADDED: fc1/7 added to port-channel 7
```

Troubleshooting Fx Port Failure

Fx port problems can be caused by a variety of configuration issues. While most issues can be solved by simply ensuring that the ports are configured properly, some issues require the use of more in-depth troubleshooting techniques.

Overview of Symptoms

An F port may be connected to a single N port, which is the mode used by peripheral devices (hosts or storage). In all the possible cases an administrator can encounter in troubleshooting an Fx port, two different scenarios can be recognized:

- The port does not come up (check the interface configuration, cabling, and the port connected to the switch).
- The port comes up, but the host cannot communicate with the storage subsystem (check the VSAN and zone configurations).

Typical end-user questions that lead to Fx port troubleshooting include:

- Why is no storage visible on my newly installed server?
- Why is previously assigned storage not visible to my server after reboot?
Typical administrator questions to investigate:

- Why does the server fail to complete FLOGI to the switch?
- Why does the storage device fail to complete FLOGI to the switch?

Figure 8-7 illustrates one possible methodology for troubleshooting Fx ports.

**Figure 8-7  Troubleshooting Methodology**

```
Begin

Server HBA and Storage FLOGI to their respective switch?
  No
    Troubleshoot physical ports
  Yes
    Troubleshoot HBA

Server and storage registered with Name Server in all switches?
  No
    Verify data path
  Yes
    Check VSAN membership
    Check zoning config and LUN masking
```
Overview

N-Port virtualization (NPV) reduces the number of Fibre Channel domain IDs in SANs. Switches operating in the NPV mode do not join a fabric; rather, they pass traffic between NPV core switch links and end-devices, which eliminates the domain IDs for these edge switches.

NPV is available only for the following Cisco MDS 9000 switches: the Cisco MDS 9124 Multilayer Fabric Switch, the Cisco MDS 9134 Fabric Switch, the Cisco Fabric Switch for HP c-Class BladeSystem and the Cisco Fabric Switch for IBM BladeCenter.

NPV makes a Fabric or Blade switch appear as a host to the core Fibre Channel switch, and as a Fibre Channel switch to the servers in the Fabric or Blade switch. NPV aggregates multiple locally-connected N-ports into one or more external NP links, thereby sharing the domain ID of the NPV core switch among multiple NPV switches. NPV also allows multiple devices to attach to same port on the NPV core switch.

NPV makes use of N port identifier virtualization (NPIV) to get multiple FCIDs allocated from the core switch on the NP-port.

A switch is in NPV mode after a user has enabled NPV and the switch has successfully rebooted. NPV mode applies to an entire switch. All end devices connected to a switch that is in NPV mode must log in as an N-port to utilize this feature (loop-attached devices are not supported). All links from the edge switches (in NPV mode) to the NPV core switches are established as NP-ports. NPIV is used by the switches in NPV mode to log in to multiple end-devices that share a link to the NPV core switch.

For a complete description of NPV, refer to the Cisco MDS 9000 Family CLI Configuration Guide.
Troubleshooting an NPV problem involves gathering information about the switch configuration and connectivity of individual devices and the entire SAN fabric. Begin your troubleshooting activity as follows:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that the NPV core switch supports NPIV and that NPIV is enabled.</td>
<td></td>
</tr>
<tr>
<td>Verify that NPV is enabled on the NPV device.</td>
<td></td>
</tr>
<tr>
<td>Verify that the ports are properly connected.</td>
<td></td>
</tr>
<tr>
<td>For all NPV core switch links, ensure that the port mode on the NPV device is NP Port, and ensure that the port mode on the NPV core switch is F Port.</td>
<td></td>
</tr>
<tr>
<td>Ensure that the VSAN values configured on both sides of NPV core switch link are the same.</td>
<td></td>
</tr>
<tr>
<td>For all the device links, ensure that the port mode on the NPV device is F port.</td>
<td></td>
</tr>
<tr>
<td>Ensure that the VSAN value configured on the device links is correct.</td>
<td></td>
</tr>
<tr>
<td>Verify the status of servers and external interfaces, using the show npv status command.</td>
<td></td>
</tr>
</tbody>
</table>

Limitations and Restrictions

- NPV core switches must support NPIV.
- You cannot manually assign the server interfaces to a specific NPV core switch link. If an NPIV capable module is connected to the server interface, all the logins from the NPIV capable module will use the same NPIV core switch link.
- Remote SPAN is not supported.
- A maximum of 16 VSANs are supported on an NPV device.
- Local switching is not supported; rather, all traffic is switched via the NPV core switch.
- Only F, NP, and SD ports are supported in NPV mode.
- CFS and QoS are not supported.
- IVR, SDV and FICON are not supported.
- If an NPV link failover occurs, servers that are booted over the SAN with NPV will temporarily lose access to their boot LUNs.

Common CLI Commands for NPV

**Note** Because the output is based on name server database information, the `show fcns database npv` commands can be run from any MDS switch running SAN-OS 3.2(1) or later. The switch does not need to be NPV enabled.
To display the status and VSAN membership of the different servers and external interfaces, and to verify that NPIV is enabled on the switch, enter the `show npv status` command.

```
switch# show npv status
npiv is enabled
```

**External Interfaces:**

```
Interface: fc1/1, VSAN: 1, FCID: 0xee0006, State: Up
Interface: fc1/9, VSAN: 1, FCID: 0xee0007, State: Up
```

Number of External Interfaces: 2

**Server Interfaces:**

```
Interface: fc1/19, VSAN: 1, NPIV: Yes, State: Up
```

Number of Server Interfaces: 1

To view all the NPV devices in the name server database, enter the `show fcns database npv` command.

```
switch# show fcns database npv
```

VSAN 1:

<table>
<thead>
<tr>
<th>NPV NODE-NAME</th>
<th>NPV IP_ADDR</th>
<th>NPV IF</th>
<th>CORE SWITCH WWN</th>
<th>CORE IF</th>
</tr>
</thead>
<tbody>
<tr>
<td>20:00:00:0d:ec:3d:62:80</td>
<td>10.1.96.24</td>
<td>fc1/20</td>
<td>20:00:00:0d:ec:2d:af:40</td>
<td>fc4/4</td>
</tr>
<tr>
<td>20:00:00:0d:ec:3d:62:80</td>
<td>10.1.96.24</td>
<td>fc1/19</td>
<td>20:00:00:0d:ec:2d:af:40</td>
<td>fc4/3</td>
</tr>
<tr>
<td>20:00:00:0d:ec:3d:62:80</td>
<td>10.1.96.24</td>
<td>fc1/17</td>
<td>20:00:00:0d:ec:2d:af:40</td>
<td>fc4/1</td>
</tr>
</tbody>
</table>

For additional details about the NPV devices you see in the `show fcns database npv` output (including IP addresses, switch names and interface names), enter the `show fcns database npv detail` command.

```
switch# show fcns database npv detail
```

VSAN:1  NPV Node Name: 20:00:00:0d:ec:3d:62:80

<table>
<thead>
<tr>
<th>NPV Fabric Port-WWN</th>
<th>class</th>
<th>NPV IP Address</th>
<th>ipa</th>
<th>fc4-types:fc4_features</th>
<th>NPV Switch Name:Interface</th>
<th>port-type</th>
<th>Core Switch fabric-port-wwn</th>
<th>permanent-port-wwn (vendor)</th>
</tr>
</thead>
</table>

For details about a specific node, including FCID, type and pWWN, enter the `show fcns database npv node_wwn node_wwn` command.

```
switch# show fcns database npv node_wwn node_wwn 20:00:00:0d:ec:3d:42:40
```

VSAN 1:

<table>
<thead>
<tr>
<th>FCID</th>
<th>TYPE</th>
<th>PWWN</th>
<th>(VENDOR)</th>
<th>FC4-TYPE:FEATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x330f00</td>
<td>N</td>
<td>2f:ff:00:06:2b:10:c7:b2 (LSI)</td>
<td>scsi-fcp:init</td>
<td></td>
</tr>
<tr>
<td>0x331000</td>
<td>N</td>
<td>2f:ff:00:06:2b:10:c7:b3 (LSI)</td>
<td>scsi-fcp:init</td>
<td></td>
</tr>
</tbody>
</table>
Total number of npv-attached entries = 2

If you need to contact support, enter the `show tech-support NPV` command and save the output so that support can use it to troubleshoot, if necessary.

To display a list of the NPV devices that are logged in, along with VSANs, source information, pWWNs, and FCIDs, enter the `show npv flogi-table` command.

```
switch# show npv flogi-table
--------------------------------------------------------------------------------
SERVER INTERFACE VSAN FCID PORT NAME NODE NAME INTERFACE
--------------------------------------------------------------------------------
fc1/19 1 0xee0008 10:00:00:00:c9:60:e4:9a 20:00:00:00:c9:60:e4:9a fc1/9
fc1/19 1 0xee0009 20:00:00:00:0a:00:00:01 20:00:00:00:c9:60:e4:9a fc1/1
fc1/19 1 0xee000a 20:00:00:00:0a:00:00:02 20:00:00:00:c9:60:e4:9a fc1/9
fc1/19 1 0xee000b 33:33:33:33:33:33:33:33 20:00:00:00:c9:60:e4:9a fc1/1
--------------------------------------------------------------------------------
Total number of flogi = 4.
```

**Common Problems with NPV**

This section includes common NPV issues and includes the following topics:

- Moving the Login of an End Device, page 9-4
- NPIV Is Not Enabled, page 9-5
- VSAN Mismatches, page 9-5
- Core NPV Device Is Not a Switch, page 9-6
- NPV Core Switch Port Is Down, page 9-6
- Server Interface is Down, page 9-6
- Waiting on FLOGI from the Server or Target, page 9-7
- Waiting on External Link to Come Up, page 9-7

**Moving the Login of an End Device**

If an uplink fails, then all the end devices that were logged in via the failed uplink are logged out. When the end devices log in again, the login requests are evenly distributed between all the operational uplink ports.

When a failed uplink comes back up, no existing logins are reassigned to that uplink. New logins are assigned to the operational uplink that has the least number of logins at the time; this is likely to be the previously failed uplink that has come back up.

You can move the login of an end device from its existing uplink to the one with least number of logins by performing the following tasks:

**Step 1** Enter the `shutdown` command on the server interface that needs to be migrated.
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 9  Troubleshooting N-Port Virtualization

Common Problems with NPV

Step 2  Enter the no shutdown command on the same server interface.

NPIV Is Not Enabled

If NPIV is not enabled on the NPV core switch:

Step 1  Enter the show npv status command to check the status of the link:

```
switch# show npv status
npiv is enabled
External Interfaces:
====================
Interface: fc1/2, VSAN: 1, FCID: 0xe00200,
State: Failed(NPIV is not enabled in upstream switch)
Number of External Interfaces: 1
```

Step 2  If the state is “Failed” with the reason “NPIV is not enabled in upstream switch,” then you must enable NPV on the core NPV switch.

The NPV core switch is defined as an upstream switch on which NPV is enabled. The NPV core switch receives traffic that is passed to it from a downstream switch that has NPV enabled on it. A switch that is in NPV mode does not switch traffic; instead, it passes traffic to the upstream NPV core switch on which NPV is enabled.

After NPV is enabled on the core NPV switch, the port should automatically come up (unless there are other issues).

VSAN Mismatches

If there is a VSAN mismatch in VSAN for the core NPV switch ports:

Step 1  Enter the show npv status command to check the status of the link.

```
switch# show npv status
npiv is enabled
External Interfaces:
====================
Interface: fc1/1, VSAN: 1, FCID: 0x110000, State: Failed(Mismatch in VSAN for this upstream port)
Number of External Interfaces: 1
```

Step 2  If the state is “Failed” with the reason “Mismatch in VSAN for this upstream port” then the external interface is configured to have different VSAN on both ends.
Correct the VSAN configuration. The VSAN configured on both ends of the NPV core switch link must be same.

### Core NPV Device Is Not a Switch

To confirm that the core NPV device is not a switch, perform the following tasks:

**Step 1** Enter the `show npv status` command to check the status of the link.

```
switch# show npv status
npiv is enabled
External Interfaces:
====================
Interface: ext17, FCID: 0x000000, State: Failed(neighbor on the upstream port is not fabric)
Number of External Interfaces: 3
```

**Step 2** If the state is “Failed” with the reason “neighbor on upstream port is not fabric,” then the external link is connected to non-fabric switch.

### NPV Core Switch Port Is Down

If the NPV core switch port is in the shutdown state, or it is not an F-port:

**Step 1** Enter the `show npv status` command to check the status.

```
switch# show npv status
npiv is enabled
External Interfaces:
====================
Interface: fc1/1, VSAN: 1, FCID: 0x000000, State: Other
Number of External Interfaces: 7
```

**Step 2** If the state is “Other,” verify that physical link to the NPV core switch or core port is in F port mode or is in administrative shutdown state.

### Server Interface is Down

If the server interface is down:

**Step 1** Check to ensure that the port is properly connected.
Common Problems with NPV

Chapter 9    Troubleshooting N-Port Virtualization

Send documentation comments to mdsfeedback-doc@cisco.com

Step 2    Check to ensure that the port mode on the NPV device side is set to “F-Port” and that the no shutdown command has been issued.

Waiting on FLOGI from the Server or Target

If you are waiting for the FLOGI from the server or target:

Step 1    Enter the show npv status command to check the status of the link.

switch# show npv status

npiv is enabled

Server Interfaces:
===================
Interface: fc1/6, VSAN: 1, NPIV: No, State: Waiting for FLOGI

Number of Server Interfaces: 7

Step 2    If the State is “Waiting for FLOGI,” then no FLOGI request was received from the server or target.

Waiting on External Link to Come Up

If you are waiting for the external link to come up:

Step 1    Enter the show npv status command to check the status of the link.

switch# show npv status

npiv is enabled

Server Interfaces:
===================
Interface: fc1/6, VSAN: 1, NPIV: No, State: Waiting for External Interface

Number of Server Interfaces: 7

Step 2    If the State is “Waiting for External Interface,” check the status of external link. At least one external link must be up for server interface to be up.
Common Problems with NPV

Send documentation comments to mdsfeedback-doc@cisco.com
Troubleshooting PortChannels and Trunking

PortChannels refer to the aggregation of multiple physical interfaces into one logical interface to provide higher aggregated bandwidth, load balancing, and link redundancy.

This chapter includes the following topics:
- PortChannel Overview, page 10-1
- Initial Troubleshooting Checklist, page 10-2
- PortChannel Issues, page 10-3
- Trunking Issues, page 10-4

PortChannel Overview

A PortChannel has the following functionality:
- Provides a point-to-point connection over ISL (E ports) or EISL (TE ports). Multiple links can be combined into a PortChannel.
- Increases the aggregate bandwidth on an ISL by distributing traffic among all functional links in the channel.
- Load balances across multiple links and maintains optimum bandwidth utilization. Load balancing is based on the source ID, destination ID, and exchange ID (OX ID).
- Provides high availability on an ISL. If one link fails, traffic previously carried on this link is switched to the remaining links. If a link goes down in a PortChannel, the upper protocol is not aware of it. To the upper protocol, the link is still there, although the bandwidth is diminished. The routing tables are not affected by link failure. PortChannels may contain up to 16 physical links and may span multiple modules for added high availability.

On switches with Generation 1 switching modules, or a combination of Generation 1 and Generation 2 switching modules, you can configure a maximum of 128 PortChannels. On switches with Generation 2 switching modules only, you can configure a maximum of 265 PortChannels.

A PortChannel number refers to the unique (to each switch) identifier associated with each channel group. This number ranges from 1 to 256.
Trunking Overview

Trunking, also known as VSAN trunking, is a feature specific to switches in the Cisco MDS 9000 Family. Trunking enables interconnected ports to transmit and receive frames in more than one VSAN, over the same physical link using extended ISL (EISL) frame format.

Trunking configurations are only applicable to E ports. If trunk mode is enabled in an E port and that port becomes operational as a trunking E port, it is referred to as a TE port. The trunk-allowed VSANs configured for TE ports are used by the trunking protocol to determine the allowed-active VSANs in which frames can be received or transmitted.

Trunking is a commonly used storage industry term. However, the Cisco SAN-OS software and switches in the Cisco MDS 9000 Family implement trunking and PortChannels as follows:

- PortChannel enables several physical links to be combined into one aggregated logical link.
- Trunking enables a link transmitting frames in the EISL format to carry (trunk) multiple VSAN traffic. When trunking is operational on an E port, that E port becomes a TE port. A TE port is specific to switches in the Cisco MDS 9000 Family. An industry standard E port can link to other vendor switches and is referred to as a nontrunking interface.

Initial Troubleshooting Checklist

Begin troubleshooting PortChannel and trunking issues by verifying that you have completed following actions first:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the <code>show port-channel compatibility-parameters</code> CLI command to determine PortChannel requirements.</td>
<td>☐</td>
</tr>
<tr>
<td>Ensure that one PortChannel is not connected to different sets of switches. PortChannels require point-to-point connections between the same set of switches.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that either side of a PortChannel is connected to the same number of interfaces.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that each interface is connected to the same type of interface on the other side.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that all required VSANS on a TE port are in the allowed-active VSAN list.</td>
<td>☐</td>
</tr>
</tbody>
</table>

**Note**

Use the `show running interface` CLI command to view the interface configuration in Cisco SAN-OS Release 3.0(1) or later. The interface configuration as seen in the `show running-config` CLI command is no longer consolidated.

Common Troubleshooting Tools in Fabric Manager

The following Fabric Manager navigation paths may be useful in troubleshooting any issues with PortChannel and trunking:

- Choose **ISLs > PortChannel** to access the PortChannel configuration.
- Choose **Switches > Interfaces > FC Logical** and select the **Trunk Config** tab to access the trunking configuration.
Common Troubleshooting Commands in the CLI

The following commands may be useful in troubleshooting PortChannel and trunking:

- `show port-channel compatibility-parameters`
- `show port-channel summary`
- `show port-channel database`
- `show port-channel consistency detail`
- `show port-channel usage`
- `show interface`
- `show interface trunk`
- `show trunk protocol`

PortChannel Issues

This section describes common PortChannel issues and includes the following topics:

- Cannot Configure a PortChannel, page 10-3
- Newly Added Interface Does Not Come Online In a PortChannel, page 10-4

Cannot Configure a PortChannel

**Symptom**  Cannot configure a PortChannel.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot configure a PortChannel.</td>
<td>PortChannel autocreation is enabled.</td>
<td>Disable autocreation if you want to manually configure PortChannels. In Device Manager, select <strong>Interfaces &gt; FC ALL...</strong>, select the <strong>Other</strong> tab, uncheck the <strong>AutoChannelCreate</strong> check box, and click Apply. Use the <code>no channel-group auto</code> CLI command.</td>
</tr>
</tbody>
</table>
Newly Added Interface Does Not Come Online In a PortChannel

Symptom Newly added interface does not come online in a PortChannel.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newly added interface does not come online in a PortChannel.</td>
<td>PortChannel mode is on.</td>
<td>Enable PortChannel manually or change PortChannel mode to active. See the “Configuring Port Channel Modes Using Fabric Manager” section on page 10-4. Or, use the <code>no shutdown</code> CLI command to enable the PortChannel manually or use the <code>channel-mode active</code> CLI command in the interface submode for the PortChannel interface.</td>
</tr>
<tr>
<td></td>
<td>Interface parameters are not compatible with existing PortChannel.</td>
<td>Use the force option to force the physical interface to take on the parameters of the PortChannel. In Fabric Manager, choose ISLs &gt; Port Channels, check the Force check box, and click Apply Changes. Or, use the <code>channel-group &lt;x&gt; force</code> CLI command in the interface submode for the physical interface.</td>
</tr>
</tbody>
</table>

Configuring Port Channel Modes Using Fabric Manager

To configure active mode using Fabric Manager, follow these steps:

**Step 1** Expand ISLs and then select Port Channels in the Physical Attributes pane. You see the PortChannels configured in the Information pane.

**Step 2** Click the Protocols tab and, from the Mode drop-down menu, select the appropriate mode for the Port Channel.

**Step 3** Click Apply Changes icon to save any modifications or click Undo Changes to discard any changes.

Trunking Issues

This section describes common trunking issues and includes the following topics:

- Cannot Configure Trunking, page 10-5
- VSAN Traffic Does Not Traverse Trunk, page 10-5
Cannot Configure Trunking

Symptom: Cannot configure trunking.

<table>
<thead>
<tr>
<th>Table 10-3 Cannot Configure Trunking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symptom</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>Cannot configure trunking.</td>
</tr>
</tbody>
</table>

VSAN Traffic Does Not Traverse Trunk

Symptom: VSAN traffic does not traverse trunk.

<table>
<thead>
<tr>
<th>Table 10-4 VSAN Traffic Does Not Traverse Trunk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symptom</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>VSAN traffic does not traverse trunk.</td>
</tr>
</tbody>
</table>
Troubleshooting VSANs, Domains, and FSPF

This chapter describes how to identify and resolve problems that might occur when implementing VSANs, domains, and FSPF. This chapter includes the following sections:

- Overview, page 11-1
- Initial Troubleshooting Checklist, page 11-1
- VSAN Issues, page 11-3
- Dynamic Port VSAN Membership Issues, page 11-9
- Domain Issues, page 11-17
- FSPF Issues, page 11-24

Overview

Virtual SANs (VSANs) provide a method of isolating devices that are physically connected to the same storage network, but are logically considered to be part of different SAN fabrics that do not need to be aware of one another. Each VSAN can contain up to 239 switches and has an independent address space that allows identical Fibre Channel IDs (FC IDs) to be used simultaneously in different VSANs.

VSANs provide the following capabilities:

- Isolate devices physically connected to the same fabric.
- Reduce the size of a Fibre Channel distributed database.
- Enable more scalable and secure fabrics.

Initial Troubleshooting Checklist

Most VSAN problems can be avoided by following the best practices for VSAN implementation. However, if needed, you can use the Fabric Analysis tool in Fabric Manager to verify different categories of problems such as VSANs, zoning, FCdomain, admin issues, or switch-specific or fabric-specific issues.

Fabric Manager provides the configuration consistency check tool. Refer to the Cisco MDS 9000 Fabric Manager Configuration Guide for more information about this tool.
When suspending or deleting VSANs, make sure that you suspend and unsuspend one VSAN at a time, and that you wait a minimum of 60 seconds after you issue the vsan suspend command before you issue any other config command. Failure to do so may result in some Fibre Channel interfaces or member ports in a PortChannel becoming suspended or error-disabled.

Troubleshooting a SAN problem involves gathering information about the configuration and connectivity of individual devices as well as the status of the entire SAN fabric. In the case of VSANs, begin your troubleshooting activity as follows:

**Common Troubleshooting Tools in Fabric Manager**

Use the following Fabric Manager procedures to verify the VSAN, FC domain, FSPF, and zones:

- Choose `Fabricxx > VSANxx` to view the VSAN configuration in the Information pane.
- Choose `Fabricxx > VSANxx` and select the Host or Storage tab in the Information pane to view the VSAN members.
- Choose `Fabricxx > VSANxx > Domain Manager` to view the FC domain configuration in the Information pane.
- Choose `Fabricxx > VSANxx > FSPF` to view the FSPF configuration in the Information pane.
- Choose `Fabricxx > VSANxx > zoneset-name` to view the zone configuration for this VSAN. Zone configuration problems may appear to be a VSAN problem.

**Common Troubleshooting Commands in the CLI**

Use the following CLI commands to display VSAN, FC domain, and FSPF information:

- `show vsan`
- `show vsan vsan-id`
- `show vsan membership`
- `show interface fc slot/port trunk vsan-id`
- `show vsan-id membership`
- `show vsan membership interface fc slot/port`
Send documentation comments to mdsfeedback-doc@cisco.com

- show fcdomain
- show fs pf
- show fs pf internal route vsan vsan-id
- show fcns database vsan vsan-id

Use the following zone CLI commands to validate your configuration:
- show zoneset name zoneset-name vsan vsan-id
- show zoneset active vsan vsan-id

Note An asterix (*) near the device listed by the show zoneset active command indicates that the device is logged into the name server.

- show zone vsan vsan-id
- show zone status show vsan vsan-range

Note For more information on zoning issues, see Chapter 14, “Troubleshooting Zones and Zone Sets.”

VSAN Issues

This section includes the following topics:
- Host Cannot Communicate with Storage, page 11-3
- E Port Is Isolated in a VSAN, page 11-5
- Troubleshooting Interop Mode Issues, page 11-9

Host Cannot Communicate with Storage

Communication problems between a host and storage devices can be caused by port, VSAN, or zone issues.

Symptom Host cannot communicate with storage.

<table>
<thead>
<tr>
<th>Table 11-1</th>
<th>Host Cannot Communicate with Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>Host cannot communicate with storage.</td>
<td>Host and storage are not in the same VSAN.</td>
</tr>
<tr>
<td>xE port connecting to the remote switch is isolated.</td>
<td>Host and storage are not in the same zone.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 11 Troubleshooting VSANs, Domains, and FSPF

Verifying VSAN Membership Using Fabric Manager

To verify VSAN membership for host and storage devices using Fabric Manager, follow these steps:

Step 1 Choose Fabricxx > VSANxx and select the Host or Storage tab in the Information pane. Verify that both devices are in the same VSAN.

Step 2 If the host and storage are in different VSANs, verify which port is not in the correct VSAN and then follow these steps to change the port VSAN:

a. Highlight the host or storage in the Information pane. You see the link to that end device highlighted in blue in the map pane.

b. Right-click on the highlighted link and select Interface Attributes from the pop-up menu.

c. Set the Port VSAN field to the VSAN that holds the other end device and click Apply Changes.

Step 3 Right-click any ISL between the switches and select Interface Attributes. Select the Trunk Config tab and verify that the allowed VSAN list includes the VSAN found in Step 1.

Step 4 If the trunk is not configured for the VSAN, set the Allowed VSANs field to include the VSAN that the host and storage devices are on and click Apply Changes.

Verifying VSAN Membership Using the CLI

To verify VSAN membership for host and storage devices using the CLI, follow these steps:

Step 1 Use the show vsan membership command to see all the ports connected to your host and storage, and verify that both devices are in the same VSAN. Use this command on the switches that connect to your host or storage devices.

```
switch# show vsan membership
vsan 1 interfaces:
  fc2/7   fc2/8   fc2/9   fc2/10  fc2/11  fc2/12  fc2/13  fc2/14
  fc2/15 fc2/16 fc7/1   fc7/2   fc7/3   fc7/4   fc7/5   fc7/6
  fc7/7   fc7/8   fc7/9   fc7/10  fc7/11  fc7/12  fc7/13  fc7/14
  fc7/15 fc7/16 fc7/17 fc7/18 fc7/19 fc7/20 fc7/21 fc7/22
  fc7/25 fc7/26 fc7/27 fc7/28 fc7/29 fc7/30 fc7/31 fc7/32
vsan 2 interfaces:
  fc2/6   fc7/23 fc7/24
vsan 3 interfaces:
  fc2/1   fc2/2   fc2/5
vsan 4 interfaces:
  fc2/3   fc2/4
```

Step 2 If the host and storage are in different VSANs, use the vsan database vsan vsan-id interface command to move the interface connected to the host and storage devices into the same VSAN.

Step 3 Use the show interface command to verify that the trunks connecting the end switches are configured to transport the VSAN found in Step 1.

```
switch# show interface fc2/14
fc2/14 is trunking
  Hardware is Fibre Channel, WWN is 20:4e:00:05:00:63:9e
  Port mode is TE
  Speed is 2 Gbps
```
Step 4  If the trunk is not configured for the VSAN, use the `interface` command and then the `switchport trunk allowed vsan` command in interface mode to add the VSAN to the allowed VSAN list for the interface that connects the host and storage devices.

## E Port Is Isolated in a VSAN

### Symptom
E port is isolated in a VSAN.

**Table 11-2  xE Port Is Isolated in a VSAN**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E port is isolated in a VSAN.</td>
<td>E port connecting to the remote switch is isolated.</td>
<td>Verify the VSAN. See the “Resolving an Isolated E Port Using Fabric Manager” section on page 11-6 or the “Resolving an Isolated E Port Using Fabric Manager” section on page 11-6.</td>
</tr>
<tr>
<td>TE port connecting to the remote switch is isolated.</td>
<td>See the “Resolving an Isolated ISL Using Fabric Manager” section on page 11-7 or the “Resolving an Isolated ISL Using the CLI” section on page 11-7.</td>
<td></td>
</tr>
<tr>
<td>Port parameters misconfigured.</td>
<td>See the “Common Problems with Port Interfaces” section on page 8-13.</td>
<td></td>
</tr>
<tr>
<td>Zoning mismatch.</td>
<td>See Chapter 14, “Troubleshooting Zones and Zone Sets.”</td>
<td></td>
</tr>
</tbody>
</table>
Resolving an Isolated E Port Using Fabric Manager

To resolve VSAN isolation on an E port using Fabric Manager, follow these steps:

1. Choose Switches > Interfaces > FC Physical and check the FailureCause column on the E port to verify that you have a VSAN mismatch.

2. Choose Switches > Interfaces > FC Physical and use the PortVSAN field to correct a VSAN mismatch.

Resolving an Isolated E Port Using the CLI

To resolve VSAN isolation on an E port using the CLI, follow these steps:

1. Use the show interface command to verify that the port is isolated because of a VSAN mismatch.

   switch# show interface fc2/4
   fc2/4 is down fc2/4 is down (isolation due to port vsan mismatch)
   Hardware is Fibre Channel, WWN is 20:44:00:05:30:00:63:5e
   vsan is 4
   Beacon is turned off
   30 frames input, 682 bytes, 0 discards
   0 runts, 0 jabber, 0 too long, 0 too short
   0 input errors, 0 CRC, 0 invalid transmission words
   0 address id, 0 delimiter
   0 EOF abort, 0 fragmented, 0 unknown class
   30 frames output, 583 bytes, 0 discards
   Received 2 OLS, 2 LRR, 2 NOS, 5 loop inits
   Transmitted 5 OLS, 3 LRR, 2 NOS, 4 loop inits

2. Use the show vsan membership command to verify that the ports are in separate VSANs.

   switch# show vsan membership
   vsan 3 interfaces:
   fc2/1   fc2/2   fc2/3   fc2/4   fc2/6   fc2/7   fc2/8   fc2/9
   fc2/10  fc2/11  fc2/12  fc2/14  fc2/15  fc2/16  fc7/1  fc7/2
   fc7/3   fc7/4   fc7/5   fc7/6   fc7/7   fc7/8   fc7/9   fc7/10
   fc7/11  fc7/12  fc7/13  fc7/14  fc7/15  fc7/16  fc7/17  fc7/18
   fc7/19  fc7/20  fc7/21  fc7/22  fc7/23  fc7/24  fc7/25  fc7/26
   fc7/27  fc7/28  fc7/29  fc7/30  fc7/31  fc7/32

   vsan 4 interfaces:
   fc2/5

   vsan 4094(isolated_vsan) interfaces:

   This sample output shows that all the interfaces on the switch belong to VSAN 3, with the exception of interface fc2/5 and fc2/13, which are part of VSAN 4.

3. Use the vsan database vsan vsan-id interface command to move the ports into the same VSAN.
Resolving an Isolated ISL Using Fabric Manager

Trunking E ports (TE ports) are similar to E ports except that they carry traffic for multiple VSANs. E ports carry traffic for a single VSAN. Because TE ports carry traffic for multiple VSANs, ISL isolation can affect one or more VSANs. For this reason, on a TE port you must troubleshoot for ISL isolation on each VSAN.

To resolve VSAN isolation on a TE port using Fabric Manager, follow these steps:

Step 1  Choose **Switches > Interfaces > FC Physical** and check the FailureCause column on the TE port to verify that you have a trunk problem.

Step 2  Choose **Switches > Interfaces > FC Physical** and select the **Trunk Failures** tab to determine the reason for the trunk problem.

Step 3  Correct the problem listed in the FailureCause column. See the “DPVM Config Database Not Activating” section on page 11-14 for domain misconfiguration problems. Choose **Switches > Interfaces > FC Physical** and use the PortVSAN field to correct the VSAN misconfiguration problems.

Step 4  Repeat this procedure for all isolated VSANs on this TE port.

Resolving an Isolated ISL Using the CLI

Trunking E ports (TE ports) are similar to E ports except that they carry traffic for multiple VSANs. E ports carry traffic for a single VSAN. Because TE ports carry traffic for multiple VSANs, ISL isolation can affect one or more VSANs. For this reason, on a TE port you must troubleshoot for ISL isolation on each VSAN.

To resolve VSAN isolation on a TE port using the CLI, follow these steps:

Step 1  Use the **show interface** command on the TE port to verify that you have an isolated VSAN.

```
switch# show interface fc2/14
fc2/14 is trunking
   Hardware is Fibre Channel, WWN is 20:4e:00:05:30:00:63:9e
   Port mode is TE
   Speed is 2 Gbps
   vsan is 2
   Beacon is turned off
   Trunk vsans (allowed active) (1-3,5)
   Trunk vsans (operational) (1-3,5)
   Trunk vsans (up) (2-3,5)
   Trunk vsans (**isolated**) (1)
   Trunk vsans (initializing) ()
   475 frames input, 8982 bytes, 0 discards
   0 runts, 0 jabber, 0 too long, 0 too short
   0 input errors, 0 CRC, 3 invalid transmission words
   0 address id, 0 delimiter
   0 EOF abort, 0 fragmented, 0 unknown class
   514 frames output, 7509 bytes, 16777216 discards
   Received 30 OLS, 21 LRR, 18 NOS, 53 loop inits
```

The example shows the output of the **show interface** command with one or more isolated VSANs. Here, the TE port has one VSAN isolated.
**Step 2** Use the `show interface fc slot/port trunk vsan vsan-id` command to verify the reason for VSAN isolation.

```
switch# show interface fc2/14 trunk vsan 1
fc2/15 is trunking
   Vsan 1 is down (Isolation due to zone merge failure)
```

This output shows that VSAN 1 is isolated because of a zone merge error.

**Step 3** Use the `show port internal info interface fc slot/port` command to determine the root cause of the VSAN isolation.

**Note** To issue commands with the `internal` keyword, you must have an account that is a member of the network-admin group.

```
switch# show port internal info interface fc2/14
fc2/14 - if_index: 0x0109C000, phy_port_index: 0x3c
   Admin Config - state(up), mode(TE), speed(auto), trunk(on)
      beacon(off), snmp trap(on), tem(false)
      rx_bb_credit(default), rx_bb_credit_multiplier(default)
      rxbufsize(2112), encap(default), user_cfg_flag(0x3)
      description()
      Hw Capabilities: 0xb
      trunk vsans (up) (7)
      trunk vsans (isolated) (1,8)
   TE port per vsan information
      fc2/29, Vsan 1 - state(down), state reason(Isolation due to domain other side eport isolated), fcid(0x0000000)
      port init flag(0x10000), current state [TE_FSM_ST_ISOLATED_DM_ZS]
      fc2/29, Vsan 7 - state(up), state reason(None), fcid(0x6902020)
      port init flag(0x3800000), current state [TE_FSM_ST_E_PORT_UP]
      fc2/29, Vsan 8 - state(down), state reason(Isolation due to vsan not configured on peer), fcid(0x0000000)
      port init flag(0x0), current state [TE_FSM_ST_ISOLATED_VSAN_MISMATCH]
```

The last few lines of the command output provide a description of the reason for VSAN isolation for every isolated VSAN.

In this example, VSAN 7 is up, while two VSANs are isolated. VSAN 1 is isolated because of domain ID misconfiguration, and VSAN 8 is isolated because of VSAN misconfiguration.

**Step 4** Correct the root cause. See the “DPVM Config Database Not Activating” section on page 11-14 for domain misconfiguration problems. Use the `vsan vsan-id interface` command to correct the VSAN misconfiguration problems.

**Step 5** Repeat this procedure for all isolated VSANs on this TE port.
Resolving Fabric Timer Issues Using Fabric Manager

Use caution when changing fabric timers.

To resolve fabric timer issues between VSANs using Fabric Manager, follow these steps:

Step 1 Choose Fabricxx > VSANxx > VSAN Attributes to verify that the fabric timers are inconsistent across the VSANs.

Step 2 Choose Switches > FC Services > Timers and Policies. You see the fabric timers in the Information pane.

Step 3 Click Change Timeout Values and set the timers and click Apply.

Resolving Fabric Timer Issues Using the CLI

Use caution when changing fabric timers.

To resolve fabric timer issues between VSANs using the CLI, follow these steps:

Step 1 Use the show fctimer command to verify that the fabric timers are inconsistent across the VSANs.

Step 2 Use the fctimer distribute command to enable CFS distribution for the fabric timers. Repeat this on all switches in this VSAN.

Step 3 Use the fctimer command to set each timer.

Step 4 Use the fctimer commit command to save these changes and distribute them to all switches in the VSAN.

Troubleshooting Interop Mode Issues

To troubleshoot interop modes, refer to the switch to switch interop guide at the following website:


Dynamic Port VSAN Membership Issues

You can dynamically assign VSAN membership to ports is achieved by assigning VSANs based on the device WWN. Dynamic port VSAN membership (DPVM) offers flexibility and eliminates the need to reconfigure the VSAN to maintain fabric topology when a host or storage device connection is moved between two switches or between ports on the same switch. It retains the configured VSAN regardless of where a device is connected or moved.
Dynamic Port VSAN Membership Issues

Verify the following requirements when using DPVM:

- The interface through which the dynamic device connects to the Cisco MDS switch must be configured as an F port. FL ports do not support DPVM and no entries will be learned through an FL port.
- The static port VSAN of the F port should be valid (not isolated, not suspended, and in existence).
- The dynamic VSAN configured for the device in the DPVM database should be valid (not isolated, not suspended, and in existence).

**Note**

The DPVM feature overrides any existing static port VSAN membership configuration. If the VSAN corresponding to the dynamic port is deleted or suspended, the port is shut down.

**Note**

If you copy the DPVM database and fabric distribution is enabled, you must commit the changes.

To begin configuring DPVM, you must explicitly enable DPVM on the required switches in the fabric. By default, this feature is disabled in all switches in the Cisco MDS 9000 Family.

For more information on enabling DPVM, refer to one of the following guides:

- *Cisco MDS 9000 Family Fabric Manager Configuration Guide*
- *Cisco MDS 9000 Family CLI Configuration Guide*

This section contains the following topics:

- Troubleshooting DPVM Using Fabric Manager, page 11-10
- Troubleshooting DPVM Using the CLI, page 11-11
- DPVM Configuration Not Available, page 11-11
- DPVM Database Not Distributed, page 11-12
- DPVM Autolearn Not Working, page 11-12
- No Autolearn Entries in Active Database, page 11-13
- VSAN Membership not Added to Database, page 11-13
- DPVM Config Database Not Activating, page 11-14
- Cannot Copy Active to Config DPVM Database, page 11-14
- Port Suspended or Disabled After DPVM Activation, page 11-15
- DPVM Merge Failed, page 11-15
- DPVM Process Terminates, page 11-16

### Troubleshooting DPVM Using Fabric Manager

To troubleshoot DPVM using Fabric Manager, follow these steps:

**Step 1** Choose Fabric > All VSANs > DPVM and select the CFS tab.

**Step 2** Verify that the Oper and Global columns are enabled. If not, set the Admin drop-down menu to enable and the Global drop-down menu to enable. Then click Apply Changes.

**Step 3** Select the Actions tab. Uncheck AutoLearn Enable if it is checked and click Apply Changes.
Step 4  Select the Active Database tab.

Step 5  Select Pending from the Compare To drop-down menu. You see a dialog box listing any differences between the active DPVM database and the pending database.

Step 6  Select the CFS tab and set Config Action to commit if there are any pending changes that you want to save. Click Apply Changes.

Step 7  Select the Actions tab and select activate from the Actions drop-down menu to activate the database. Click Apply Changes.

Troubleshooting DPVM Using the CLI

To troubleshoot DPVM using the CLI, follow these steps:

Step 1  Use the show dpvm command in EXEC mode to verify that CFS distribution is enabled for DPVM. Optionally, use the dpvm distribute command in config mode to enable CFS distribution if required.

Step 2  Use the show dpvm status command in EXEC mode to verify that autolearning is disabled. Optionally, use the no dpvm auto-learn command in config mode if you need to disable autolearning before activating the database.

Step 3  Use the show dpvm pending-diff command in EXEC mode to compare the active and pending databases. Optionally use the dpvm commit command in config mode to commit any pending entries to the config database.

Step 4  Use the dpvm activate command in config mode to activate the database.

DPVM Configuration Not Available

Symptom  DPVM configuration is not available on Fabric Manager or CLI.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPVM configuration is not available on Fabric Manager or CLI.</td>
<td>DPVM has not been enabled.</td>
<td>DPVM must be enabled before it can be configured. Choose Fabricxx &gt; All VSANs &gt; DPVM and check the Status field in Fabric Manager or use the show dpvm status CLI command to verify that DPVM is not enabled. Set the Status field to enable in Fabric Manager and then click Apply Changes or use the dpvm enable CLI command to enable DPVM.</td>
</tr>
</tbody>
</table>
**Dynamic Port VSAN Membership Issues**

**Send documentation comments to mdsfeedback-doc@cisco.com**

# DPVM Database Not Distributed

**Symptom** DPVM databases are not distributed.

<table>
<thead>
<tr>
<th>Table 11-4</th>
<th><strong>DPVM Database Not Distributed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>DPVM databases are not distributed.</td>
<td>DPVM distribution has not been enabled on the local switch.</td>
</tr>
<tr>
<td></td>
<td>DPVM distribution has not been enabled on one or more remote switches.</td>
</tr>
</tbody>
</table>

## DPVM Autolearn Not Working

The DPVM autolearn feature allows you to automatically populate the DPVM configuration database with all devices currently in the fabric. This feature is best used when you first turn on DPVM in a stable fabric. Once the devices are learned, you disable autolearning to populate the configuration database with these autolearned entries.

When you add a new device, it is a best practice to manually add that device to the DPVM configuration database. If you turn on autolearning for a new device, you may add other devices that you did not intend to add.

**Symptom** DPVM autolearn does not work or is not getting enabled.

<table>
<thead>
<tr>
<th>Table 11-5</th>
<th><strong>DPVM Autolearn Not Working</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>DPVM autolearn does not work or is not getting enabled.</td>
<td>DPVM active database may be absent.</td>
</tr>
</tbody>
</table>

**Note** When DPVM distribution is enabled, you must do an explicit commit for DPVM activate and autolearn to take effect.
No Autolearn Entries in Active Database

**Symptom**  There are no autolearn entries in the active database.

<table>
<thead>
<tr>
<th>Table 11-6</th>
<th><strong>No Autolearn Entries in Active Database</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td>Possible Cause</td>
</tr>
<tr>
<td>There are no autolearn entries in the active database.</td>
<td>Autolearn is not enabled.</td>
</tr>
<tr>
<td>Port type is not supported.</td>
<td></td>
</tr>
</tbody>
</table>

VSAN Membership not Added to Database

**Symptom**  The VSAN membership of the port is not added to the database.

<table>
<thead>
<tr>
<th>Table 11-7</th>
<th><strong>VSAN Membership Not Added to Database</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td>Possible Cause</td>
</tr>
<tr>
<td>The VSAN membership of the port is not added to the database.</td>
<td>Entry may be present in the config database.</td>
</tr>
<tr>
<td>DPVM distribution is enabled but a database change was not committed.</td>
<td></td>
</tr>
</tbody>
</table>
Dynamic Port VSAN Membership Issues

Table 11-8 DPVM Config Database Not Activating

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPVM config database is not getting activated.</td>
<td>Conflicting entries may be present between the DPVM config and active databases.</td>
<td>Determine if there are conflicting entries between the active and config databases. Use the <code>dpvm database diff active conf</code> CLI command. Override the active database with the config database. Choose Fabricxx &gt; All VSANs &gt; DPVM and select the Actions tab in Fabric Manager. Set the Actions drop-down menu to <code>forceActivate</code> and click Apply Changes. Or use the <code>dpvm activate force</code> and <code>dpvm commit</code> CLI commands to</td>
</tr>
</tbody>
</table>

Table 11-9 Cannot Copy Active to Config DPVM Database

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot copy the active DPVM database to the config database.</td>
<td>Active database may be absent.</td>
<td>Choose Fabricxx &gt; All VSANs &gt; DPVM and select the Active Database tab in Fabric Manager or use the <code>show dpvm database</code> CLI command to verify that DPVM is not enabled. Select the Actions tab and set the Action field to <code>activate</code> in Fabric Manager and then click Apply Changes. Or use the <code>dpvm activate</code> and <code>dpvm commit</code> CLI commands to create the DPVM active database. Then copy the active database again.</td>
</tr>
</tbody>
</table>
Port Suspended or Disabled After DPVM Activation

**Symptom**  A port in a static VSAN that was operational goes into suspended or disabled state after DPVM database activation.

### Table 11-10  Port Suspended or Disabled After DPVM Activation

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A port in a static VSAN that was operational goes into suspended or disabled state after DPVM database activation.</td>
<td>DPVM database maps a connected device to a nonexistent VSAN.</td>
<td>Choose <strong>Switches &gt; Interfaces &gt; FC Physical</strong> in Fabric Manager or use the <strong>show interface</strong> CLI command to check the interface status for a dynamic VSAN-related failure. Create the VSAN or map the device to another VSAN.</td>
</tr>
</tbody>
</table>

**DPVM Merge Failed**

**Symptom**  DPVM merge failed.

### Table 11-11  DPVM Merge Failed

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPVM merge failed.</td>
<td>DPVM operational parameters in the two merging fabrics are different.</td>
<td>Choose <strong>Fabricxx &gt; All VSANs &gt; DPVM</strong> in Fabric Manager or use the <strong>show dpvm</strong> CLI command to verify the DPVM configuration in both fabrics. Manually reconcile any differences before attempting to merge the fabrics. Use the <strong>show cfs merge status name dpvm</strong> CLI command to verify the merge status.</td>
</tr>
</tbody>
</table>
11-16
Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x

Chapter 11 Troubleshooting VSANs, Domains, and FSPF

Dynamic Port VSAN Membership Issues

DPVM Process Terminates

DPVM has the following vulnerabilities that could result in a process termination and possible switch reload.

**Symptom** DPVM process terminates. A switch reload may also occur.

<table>
<thead>
<tr>
<th>Table 11-12</th>
<th>DPVM Service Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>DPVM process may terminate, causing a possible switch reload.</td>
<td>If more than 64 devices login to a single switch, and a logged in device logs out and immediately logs in, the DPVM process may terminate. This can occur with SAN-OS 3.0(1) or earlier.</td>
</tr>
<tr>
<td></td>
<td>If multiple devices with the same NWWN login to a switch, and then one device logs out and immediately logs in, the DPVM process may terminate. This can occur with SAN-OS 3.0(2) or earlier.</td>
</tr>
<tr>
<td></td>
<td>If devices with NPIV / NPV enabled are connected to a switch, and one host behind this device logs out and the other performs a login, the DPVM process may terminate. This can occur with SAN-OS 3.1 or earlier.</td>
</tr>
</tbody>
</table>

Disabling DPVM

Before you disable DPVM on the switch, you must deactivate the DPVM database. You can deactivate the DPVM database on a switch without service disruption.

When you deactivate the database, the dynamic VSAN on a port is converted to a static VSAN on that port, ensuring that ports continue to be in the same VSANs and thus maintaining service continuity.

To disable DPVM, follow these steps:

**Note** No devices should login or logout during this entire process.

**Step 1** Use the `no dpvm activate` command in config mode to deactivate the DPVM database.

**Step 2** Use the `dpvm commit` command in config mode to commit the changes to the config database.

**Step 3** Use the `no dpvm enable` command in config mode to disable DPVM on the switch.
Domain Issues

This section includes the following topics:

- Domain ID Conflict Troubleshooting, page 11-17
- Switch Cannot See Other Switches in a VSAN, page 11-18
- FC Domain ID Overlap, page 11-18
- CFS Distribution of Domain ID List Fails, page 11-22
- Allowed Domain ID List Incorrect After a VSAN Merge, page 11-23
- Changes to fcdomain Do Not Take Effect, page 11-23

Domain ID Conflict Troubleshooting

In a Fibre Channel network, the principal switch assigns domain IDs when a new switch is added to an existing fabric. However, when two fabrics merge, the principal switch selection process determines which one of the preexisting switches becomes the principal switch for the merged fabric.

The election of the new principal switch is characterized by the following rules:

- A switch with a populated domain ID list takes priority over a switch that has an empty domain ID list. The principal switch becomes the one in the fabric with the populated domain ID list.
- If both fabrics have a domain ID list, the priority between the two principal switches is determined by the configured switch priority. This is a user-settable parameter. The lower the value is, the higher the priority.
- If the principal switch cannot be determined by the two previous criteria, the principal switch is then determined by the WWNs of the two switches. The lower the value of the WWN the higher the switch priority.

When merging two fabrics, the administrator can expect the following behavior:

- In Cisco SAN-OS Release 2.1(1a) and later releases, when connecting a single-switch fabric to a multi-switch fabric, a build fabric (BF) occurs and the switch with the better priority becomes the principal switch. In earlier releases, when connecting a single-switch fabric to a multi-switch fabric, the multi-switch fabric always retains its principal switch status regardless of the principal switch priority setting on the single switch fabric.
- In Cisco SAN-OS Release 2.1(1a) and later releases, when powering up a new switch in a multi-switch fabric, a BF occurs and the switch with the better priority becomes the principal switch. In earlier releases, when powering up a new switch in a multi-switch fabric, the multi-switch fabric always retains its principal switch status regardless of the principal switch priority setting on the single switch fabric.
- When powering up a new switch that is connected to a standalone switch, the new principal switch is determined by the administratively assigned priority if both switches are running Cisco SAN-OS Release 2.0(x) or earlier. If no priority is assigned (where the default priority is used in every switch), the principal switch is determined by the WWN. This also applies to connecting to two single-switch fabrics.
- When connecting a multi-switch fabric to another multi-switch fabric, the principal switch is determined by the administratively assigned priority. If no priority is assigned (where the default value is used by every switch), the principal switch is determined by the WWN of the existing principal switches of the two fabrics.
Domain Issues

Two switch fabrics might not merge. If two fabrics with two or more switches are connected, and they have at least one assigned domain ID in common, and the auto-reconfigure option is disabled (this option is disabled by default), then the E ports that are used to connect the two fabrics will be isolated due to domain ID overlap.

Switch Cannot See Other Switches in a VSAN

Symptom Switch cannot see other switches in a VSAN.

Table 11-13 Switch Cannot See Other Switches in a VSAN

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch cannot see other switches in a VSAN.</td>
<td>Switch is isolated because of a domain ID overlap.</td>
<td>Either change the overlapping static domain ID by manually configuring a new static domain ID for the isolated switch, or disable the static domain assignment and allow the switch to request a new domain ID after a fabric reconfiguration. See the “FC Domain ID Overlap” section on page 11-18.</td>
</tr>
<tr>
<td>Fabric timers are misconfigured.</td>
<td></td>
<td>See the “Resolving Fabric Timer Issues Using Fabric Manager” section on page 11-9 or the “Resolving Fabric Timer Issues Using the CLI” section on page 11-9.</td>
</tr>
</tbody>
</table>

FC Domain ID Overlap

To resolve an FC domain ID overlap, you can either change the overlapping static domain ID by manually configuring a new static domain ID for the isolated switch, or disable the static domain assignment and allow the switch to request a new domain ID after a fabric reconfiguration.

- To assign a static domain ID, see the “Assigning a New Domain ID Using Fabric Manager” section on page 11-19 or the “Assigning a New Domain ID Using the CLI” section on page 11-19.
- To assign a dynamic domain ID after a fabric reconfiguration, see the “Using Fabric Reconfiguration for Domain ID Assignments” section on page 11-20.

You may see the following system message in the message log when a domain ID overlap occurs:

Error Message PORT-5-IF_DOWN_DOMAIN_OVERLAP_ISOLATION: Interface [chars] is down (Isolation due to domain overlap).

Explanation The interface is isolated because of a domain overlap.

Recommended Action Use the show fcdomain domain-list to determine which domain IDs are overlapping. Use the fcdomain domain-id [static | preferred] vsan vsan-id CLI command or similar Fabric Manager procedure to change the domain ID for one of the overlapping domain IDs.
Assigning a New Domain ID Using Fabric Manager

All devices attached to the switch in the VSAN get a new FC ID when a new domain ID is assigned. Some hosts or storage devices may not function as expected if the FC ID of the host or storage device changes.

To verify FC domain ID overlap and reassign a new domain ID using Fabric Manager, follow these steps:

**Step 1** Choose **Switches > Interfaces > FC Physical** and check the FailureCause column for an isolation or domain overlap status.

**Step 2** Choose **Fabricxx > VSANxx > Domain Manager** to view which domains are currently in the VSAN.

**Step 3** Repeat **Step 2** on the other switch to determine which domain IDs overlap.

**Step 4** Select the **Configuration** tab and set Config Domain and Config Type to change the domain ID for one of the overlapping domain IDs.

- The static option tells the switch to request that particular domain ID. If it does not get that particular address, it will isolate itself from the fabric.
- The preferred option has the switch request a specified domain ID. If that ID is unavailable, it will accept another ID.

**Step 5** Set the Restart drop-down menu to **disruptive** and click **Apply Changes** to restart the Domain Manager.

**Note** While the static option can be applied to runtime after a disruptive or nondisruptive restart, the preferred option is applied to runtime only after a disruptive restart.

Assigning a New Domain ID Using the CLI

All devices attached to the switch in the VSAN get a new FC ID when a new domain ID is assigned. Some hosts or storage devices may not function as expected if the FC ID of the host or storage device changes.

To verify FC domain ID overlap and reassign a new domain ID using the CLI, follow these steps:

**Step 1** Issue the **show interface** command. The following example output shows the isolation error message.

```
switch# show interface fc2/14
fc2/14 is down (Isolation due to domain overlap)
    Hardware is Fibre Channel, WWN is 20:4e:00:05:30:00:63:9e
    vsan is 2
    Beacon is turned off
    192 frames input, 3986 bytes, 0 discards
    0 runts, 0 jabber, 0 too long, 0 too short
    0 input errors, 0 CRC, 3 invalid transmission words
    0 address id, 0 delimiter
    0 EOF abort, 0 fragmented, 0 unknown class
    231 frames output, 3709 bytes, 16777216 discards
    Received 28 OLS, 19 LRR, 16 NOS, 48 loop inits
    Transmitted 62 OLS, 22 LRR, 25 NOS, 30 loop inits
```
Step 2  Use the show fcdomain domain-list vsan vsan-id command to view which domains are currently in your fabric.

```
switch1# show fcdomain domain-list vsan 2
```

```
Number of domains: 2
Domain ID          WWN
----------------- -----------------------
0x4a(74)          20:01:00:05:30:00:13:9f [Local]
0x4b(75)          20:01:00:05:30:00:13:9e [Principal]
```

Step 3  Repeat Step 2 on the other switch to determine which domain IDs overlap.

```
switch2# show fcdomain domain-list vsan 2
```

```
Number of domains: 1
Domain ID          WWN
----------------- -----------------------
0x4b(75)          20:01:00:05:30:00:13:9e [Local][Principal]
```

In this example, switch 2 is isolated because of a domain ID 75 overlap.

Step 4  Use the fcdomain domain domain-id [static | preferred] vsan vsan-id command to change the domain ID for one of the overlapping domain IDs.

- The static option tells the switch to request that particular domain ID. If it does not get that particular address, it will isolate itself from the fabric.
- The preferred option has the switch request a specified domain ID. If that ID is unavailable, it will accept another ID.

Step 5  Use the fcdomain restart disruptive vsan command to restart the Domain Manager.

**Note**  While the static option can be applied to runtime after a disruptive or nondisruptive restart, the preferred option is applied to runtime only after a disruptive restart.

Using Fabric Reconfiguration for Domain ID Assignments

You can use a fabric reconfiguration to reassign domain IDs and resolve any overlapping domain IDs. If you enable the auto-reconfigure option on both switches before connecting the fabric, a disruptive reconfiguration (RCF) occurs. The RCF functionality would automatically force a new principal switch selection and cause new domain IDs to be assigned to the different switches.

**Caution**  A disruptive reconfiguration might affect data traffic.
Using Fabric Reconfiguration for Domain ID Assignments with Fabric Manager

To use fabric reconfiguration to reassign domain IDs for a particular VSAN using Fabric Manager, follow these steps:

**Step 1** Choose **Switches > Interfaces > FC Physical** and select the **Domain Manager** tab in the Information pane.

**Step 2** Uncheck the **RcfReject** check box and click **Apply Changes** to disable RCF rejection.

**Step 3** Choose **Fabricxx > VSANxx > Domain Manager** in the Logical Domain pane.

**Step 4** Click the **Configuration** tab in the Information pane and set the Config Type drop-down menu to **preferred** to remove any static domain ID assignments.

**Step 5** Check the **AutoReconfigure** check box to enable the auto-reconfiguration option.

**Step 6** Set the Restart drop-down menu to **disruptive** and click **Apply Changes** to restart the Domain Manager.

Using Fabric Reconfiguration for Domain ID Assignments with the CLI

To use fabric reconfiguration to reassign domain IDs for a particular VSAN using the CLI, follow these steps:

**Step 1** Use the **show fcdomain domain-list** command to determine if you have statically assigned domain IDs on the switches.

**Step 2** If you have statically assigned domain IDs, use the **no fcdomain domain** command to remove the static assignments.

**Step 3** Use the **show fcdomain vsan** command to determine if you have the RCF reject option enabled.

```bash
switch# show fcdomain vsan 1
The local switch is a Subordinated Switch
Local switch run time information:
  State: Stable
  Local switch WWN: 20:01:00:05:30:00:51:1f
  Running fabric name: 10:00:00:60:69:22:32:91
  Running priority: 128
  Current domain ID: 0x64(100) ß verify domain id

Local switch configuration information:
  State: Enabled
  Auto-reconfiguration: Disabled
  Contiguous-allocation: Disabled
  Configured priority: 128
  Configured domain ID: 0x64(100) (preferred)

Principal switch run time information:
  Running priority: 2

<table>
<thead>
<tr>
<th>Interface</th>
<th>Role</th>
<th>RCF-reject</th>
</tr>
</thead>
<tbody>
<tr>
<td>fc2/1</td>
<td>Downstream</td>
<td>Enabled</td>
</tr>
<tr>
<td>fc2/2</td>
<td>Downstream</td>
<td>Disabled</td>
</tr>
<tr>
<td>fc2/7</td>
<td>Upstream</td>
<td>Disabled</td>
</tr>
</tbody>
</table>
```
Domain Issues

Send documentation comments to mdsfeedback-doc@cisco.com

Step 4 If you have the rcf-reject option enabled, use the interface command and then the no fcdomain rcf-reject vsan command in interface mode.

Step 5 Use the fcdomain auto-reconfigure vsan command in the EXEC mode on both switches to enable auto-reconfiguration after a Domain Manager restart.

Step 6 Use the fcdomain restart disruptive vsan command to restart the Domain Manager.

CFS Distribution of Domain ID List Fails

Symptom CFS distribution of domain ID list fails.

Table 11-14 CFS Distribution of Domain ID List Fails

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFS distribution of domain ID list fails.</td>
<td>Configured domain ID in remote switch not present in domain ID list.</td>
<td>Add all domain IDs in the VSAN to the domain ID list. Choose Fabricxx &gt; VSANxx &gt; Domain Manager &gt; Allowed and select the Allowed DomainIDs tab to view the current allowed domain ID list in Fabric Manager. Choose Fabricxx &gt; VSANxx &gt; Domain Manager and select the Configuration tab to view the existing domain IDs for this VSAN. Choose Fabricxx &gt; VSANxx &gt; Domain Manager &gt; Allowed and select the Allowed DomainIDs tab to add any missing domain IDs, and then click Apply Changes. If CFS is enabled, select the CFS tab and select commit from the ConfigAction drop-down menu and click Apply Changes. Or use the show fcdomain domain-list to view the current allowed domain ID list. Compare this to any other switches in the VSAN to determine what domain IDs are missing. Use the fcdomain allowed CLI command to add any missing domain IDs.</td>
</tr>
</tbody>
</table>
Allowed Domain ID List Incorrect After a VSAN Merge

**Symptom**  Allowed domain ID list incorrect after a VSAN merge.

<table>
<thead>
<tr>
<th>Table 11-15</th>
<th>Allowed Domain ID List Incorrect After a VSAN Merge</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>Allowed domain ID list incorrect after a VSAN merge</td>
<td>Domain ID lists not manually updated before the merge.</td>
</tr>
</tbody>
</table>

Changes to `fcdomain` Do Not Take Effect

**Symptom**  Changes to `fcdomain` do not take effect.

<table>
<thead>
<tr>
<th>Table 11-16</th>
<th>Changes to <code>fcdomain</code> Do Not Take Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>Changes to <code>fcdomain</code> do not take effect.</td>
<td>Did not trigger a fabric reconfiguration.</td>
</tr>
</tbody>
</table>
FSPF Issues

The implementation of VSANs dictates that each configured VSAN support a separate set of fabric services. One such service is the FSPF routing protocol, which can be independently configured per VSAN. Therefore, within each VSAN topology, FSPF can be configured to provide a unique routing configuration and resulting traffic flow. Using the traffic engineering capabilities offered by VSANs allows greater control over traffic within the fabric and higher utilization of the deployed fabric resources.

This section describes how to identify and resolve Fabric Shortest Path First (FSPF) problems. It includes the following topics:

- Troubleshooting FSPF, page 11-24
- Loss of Two-Way Communication, page 11-28

Troubleshooting FSPF

Figure 11-1 shows a single VSAN topology.

For the purpose of this example, assume that all interfaces are located in VSAN 1.
Troubleshooting FSPF Using Device Manager

To troubleshoot FSPF using Device Manager, follow these steps:

### Step 1
Choose FC > Advanced > FSPF and select the LSDB LSRs tab to verify the link state records (LSRs) in the FSPF database.
- The VSANId/ DomainId column shows the domain’s view of the fabric topology.
- The AdvDomainId column shows which domain is the owner of the LSR.
- The Age value is a 16-bit counter starting at 0x0000, incremented by one for each switch during flooding and by one for each second held in the database. This field is used as a tie-breaker if incarnation numbers are the same.
- The IncarnationNumber is a 32-bit value between 0x80000001 and 0x7FFFFFFF that is incremented by one each time the originating switch transmits an LSR. This is used before the Age value.

### Step 2
Choose FC > Advanced > FSPF and select the LSDB Links tab to verify that each path is in the FSPF database.

### Step 3
Choose FC > Advanced > FSPF and select the Interfaces tab to verify that the FSPF parameters are correct for each interface and verify that the AdminStatus is up.
- The Cost column shows the cost of the path out of the interface.
- The Intervals column shows the configured FSPF timers for this interface, which must match on both sides.
- The State column shows the full or adjacent state if the interface has sent and received all database exchanges and required Acks. The port is now ready to route frames.
- The Neighbors column shows FSPF neighbor information.

### Step 4
Choose FC > Advanced > FSPF and select the Statistics or InterfaceStats tab to verify that there are no excessive errors present.

Troubleshooting FSPF Using the CLI

To troubleshoot FSPF using the CLI, follow these steps:

### Step 1
Use the `show fspf database vsan` command to verify that each path is in the FSPF database.

```
switch1# show fspf database
FSFP Link State Database for VSAN 2 Domain 1 ---------------1
LSR Type = 1
Advertising domain ID = 1 ---------------2
LSR Age = 81 ---------------3
LSR Incarnation number = 0x80000098 ---------------4
LSR Checksum = 0x2cd3
Number of links = 2
NbrDomainId IfIndex NbrIfIndex Link Type Cost
--------------------------------------------------
 237 0x00010002 0x00010001 1 1000 ---------------5
 238 0x00010003 0x00010002 1 1000 ---------------6

FSFP Link State Database for VSAN 2 Domain 237 ---------------LSR for another switch
LRSR Type = 1
Advertising domain ID = 237 ---------------7
LSR Age = 185
```

---

Send documentation comments to mdsfeedback-doc@cisco.com
### FSPF Issues

**LSR Incarnation number** = 0x8000000c
**LSR Checksum** = 0xe0a2
**Number of links** = 2

<table>
<thead>
<tr>
<th>NbrDomainId</th>
<th>IfIndex</th>
<th>NbrIfIndex</th>
<th>Link Type</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>239</td>
<td>0x000010000000</td>
<td>0x0000100003</td>
<td>1</td>
<td>1000</td>
</tr>
<tr>
<td>1</td>
<td>0x000010000003</td>
<td>0x0000100002</td>
<td>1</td>
<td>1000</td>
</tr>
</tbody>
</table>

FSPF Link State Database for VSAN 2 Domain 238

<table>
<thead>
<tr>
<th>LSR Type</th>
<th>Advertising domain ID</th>
<th>LSR Age</th>
<th>LSR Incarnation number</th>
<th>LSR Checksum</th>
<th>Number of links</th>
<th>NbrDomainId</th>
<th>IfIndex</th>
<th>NbrIfIndex</th>
<th>Link Type</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>238</td>
<td>1052</td>
<td>0x800000013</td>
<td>0xe294</td>
<td>2</td>
<td>239</td>
<td>0x00010003</td>
<td>0x00010001</td>
<td>1</td>
<td>1000</td>
</tr>
</tbody>
</table>

FSPF Link State Database for VSAN 2 Domain 239

<table>
<thead>
<tr>
<th>LSR Type</th>
<th>Advertising domain ID</th>
<th>LSR Age</th>
<th>LSR Incarnation number</th>
<th>LSR Checksum</th>
<th>Number of links</th>
<th>NbrDomainId</th>
<th>IfIndex</th>
<th>NbrIfIndex</th>
<th>Link Type</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>239</td>
<td>1061</td>
<td>0x800000013</td>
<td>0x66ac</td>
<td>4</td>
<td>237</td>
<td>0x00010003</td>
<td>0x00010003</td>
<td>1</td>
<td>1000</td>
</tr>
</tbody>
</table>

1. The domain 1 view of the fabric topology.
2. Domain 1 is owner of the LSR (link state record).
3. This is a 16-bit counter starting at 0x0000, incremented by one for each switch during flooding and by one for each second held in the database. This field is used as a tie-breaker if incarnation numbers are the same.
4. This is a 32-bit value between 0x80000001 and 0x7FFFFFFF, which is incremented by one each time the originating switch transmits an LSR. This is used before LSR Age.
5. The path to domainID 237, switch 1.
6. The path to domain ID 238, switch 5.
7. Switch 1, domain ID 237 is the owner.
8. The path to domain ID 239, switch 3.
9. The path to domain ID 1, switch 2.

**Step 2** Use the `show fspf vsan vsan-id interface` command to verify that the FSPF parameters are correct for each interface and verify that the interface is in the FSPF active state.

```
switch1# show fspf vsan 2 interface fc1/2
FSPF interface fc1/2 in VSAN 2
FSPF routing administrative state is active
Timer intervals configured, Hello 20 s, Dead 80 s, Retransmit 5 s
FSPF State is FULL
Neighbor Domain Id is 1, Neighbor Interface index is 0x00010002
```
FSPF Issues

Statistics counters:
Number of packets received: LSU 46 LSA 24 Hello 103 Error packets 0
Number of packets transmitted: LSU 24 LSA 45 Hello 104 Retransmitted LSU 0
Number of times inactivity timer expired for the interface = 0

This displays the number of packets; Hellos should be received every 20 seconds.

1. FSPF routing is active.
2. The cost of the path out this interface.
3. The configured FSPF timers for this interface, which must match on both sides.
4. Either Full State or Adjacent. Sent and received all database exchanges and required Acks. Port is now ready to route frames.
5. FSPF neighbor information.

Step 3 Use the `show fspf internal route vsan` command to verify that all Fibre Channel routes are available.

```
switch1# show fspf internal route vsan 2
FSPF Unicast Routes
------------------------------
<table>
<thead>
<tr>
<th>VSAN</th>
<th>Number</th>
<th>Dest Domain</th>
<th>Route Cost</th>
<th>Next hops</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0x01(1)</td>
<td>1000</td>
<td>fc1/2</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0xEF(239)</td>
<td>1000</td>
<td>fc1/1</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0xED(238)</td>
<td>2000</td>
<td>fc1/1</td>
<td>fc1/2</td>
</tr>
</tbody>
</table>
```

This shows the total cost of all links.
The next hop (238) has two interfaces. This indicates that both paths will be used during load sharing. Up to sixteen paths can be used by FSPF with a Cisco MDS 9000 Family switch.

With the implementation of VSANs used with Cisco MDS 9000 Family switches, a separate instance of FSPF runs within each VSAN, and each instance is independent of the others. For this reason, FSPF issues affecting one VSAN have no effect on FSPF running in other VSANs.

**Note** For all FSPF configuration statements and diagnostic commands, if the `vsan` keyword is not specified, VSAN 1 is used by default. When making configuration changes or issuing diagnostic commands in a multi-VSAN environment, be sure to explicitly specify the target VSAN by including the `vsan` keyword in the statement or command.
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 11  Troubleshooting VSANs, Domains, and FSPF

Loss of Two-Way Communication

If FSPF is misconfigured, then the switches will not reach the “two-way” state. The following events occur when two-way communication is lost:

- The port enters Init state and removes its neighbor’s domain ID from the Recipient Domain ID field and inserts 0xFFFFFFFF.
- FSPF removes the Inter-Switch Link (ISL) from the topology database.
- New link state records (LSRs) are flooded to adjacent switches to notify them that the FSPF database has changed.

Symptom  Traffic is not being routed through the fabric.

Table 11-17  Traffic Is not Being Routed Through the Fabric

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic is not being routed through the fabric.</td>
<td>FSPF hello interval misconfigured.</td>
<td>See the “Resolving a Wrong Hello Interval on an ISL Using Device Manager” section on page 11-28 or the “Resolving a Wrong Hello Interval on an ISL Using the CLI” section on page 11-29.</td>
</tr>
<tr>
<td>FSPF retransmit time misconfigured.</td>
<td></td>
<td>See the “Resolving a Mismatched Retransmit Interval on an ISL Using Device Manager” section on page 11-30 or the “Resolving a Mismatched Retransmit Interval on an ISL Using the CLI” section on page 11-30.</td>
</tr>
<tr>
<td>FSPF dead interval misconfigured.</td>
<td></td>
<td>See the “Resolving a Mismatch in Dead Intervals on an ISL Using Fabric Manager” section on page 11-31 or the “Resolving a Mismatch in Dead Intervals on an ISL Using the CLI” section on page 11-31.</td>
</tr>
<tr>
<td>There is a region mismatch on the switch.</td>
<td></td>
<td>See the “Resolving a Region Mismatch Using Fabric Manager” section on page 11-32 or the “Resolving a Region Mismatch Using the CLI” section on page 11-32.</td>
</tr>
</tbody>
</table>

Resolving a Wrong Hello Interval on an ISL Using Device Manager

To resolve a wrong hello interval on an ISL using Device Manager, follow these steps:

Step 1  Choose FC > Advanced > FSPF and select the Interfaces tab to verify that the FSPF parameters are correct for each interface and check the Hello interval column and the State column.

- The Intervals column shows the configured FSPF timers for this interface, which must match on both sides.
- The State column shows the full or adjacent state if the interface has sent and received all database exchanges and required Acks. The port is now ready to route frames.

Step 2  Repeat Step 1 to determine the value of the hello interval on the adjacent switch.

Step 3  Fill in the Hello field to change the hello interval and click Apply.
Resolving a Wrong Hello Interval on an ISL Using the CLI

To resolve a wrong hello interval on an ISL using the CLI, follow these steps:

**Step 1** Use the `debug fspf all` command and look for wrong hello interval messages.

```
switch1# debug fspf all
Jan 5 00:28:14 fspf: Wrong hello interval for packet on interface 100f000 in VSAN 1
Jan 5 00:28:14 fspf: Error in processing hello packet, error code = 4
```

**Tip** We recommend that you open a second Telnet or SSH session before entering any debug commands. If the debug output overwhelms the current session, you can use the second session to enter the `undebug all` command to stop the debug message output.

**Step 2** Use the `undebug all` command to turn off debugging.

**Step 3** Use the `show fspf internal route vsan` command to show FSPF information.

```
switch1# show fspf internal route vsan 1
FSPF Unicast Routes
---------------------------
VSAN Number Dest Domain Route Cost Next hops
----------------------------------------------------------------------
1 0xEF(239) 1000 fc1/1 <-----1
1 0xED(238) 2000 fc1/1
1 0x01(1) 3000 fc1/1 <-----2
```

1. There is no second path to domain 238, through domain 1 switch 2.
2. There is no direct path to domain 1 switch 2; traffic must travel through three ISLs. This is based on the route cost column.

**Step 4** Use the `show fspf vsan vsan-id interface` command to view the FSFP configuration.

```
switch1# show fspf vsan 1 interface fc1/16
FSPF interface fc1/16 in VSAN 1
FSPF routing administrative state is active
Interface cost is 500
Timer intervals configured, Hello 5 s, Dead 80 s, Retransmit 5 s <-----1
FSPF State is INIT <-----2
Statistics counters :
   Number of packets received : LSU 0 LSA 0 Hello 2 Error packets 1
   Number of packets transmitted : LSU 0 LSA 0 Hello 4 Retransmitted LSU 0
   Number of times inactivity timer expired for the interface = 0
```

1. The Hello timer is not set to the default, so you should check the neighbor configuration to make sure it matches.
2. FSPF is not in FULL state, indicating a problem.

**Step 5** Repeat **Step 4** to determine the value of the Hello timer on the adjacent switch.

```
switch2# show fspf v 1 interface fc2/16
FSPF interface fc2/16 in VSAN 1
FSPF routing administrative state is active
Interface cost is 500
```
FSPF Issues

Timer intervals configured, Hello 20 s, Dead 80 s, Retransmit 5 s
FSPF State is INIT
Statistics counters :
  Number of packets received : LSU 0 LSA 0 Hello 2 Error packets 1
  Number of packets transmitted : LSU 0 LSA 0 Hello 4 Retransmitted LSU 0
  Number of times inactivity timer expired for the interface = 0

1. The neighbor FSPF Hello interval is set to the default (20 seconds).
2. FSPF is not in full state, indicating a problem.

Step 6 Use the interface command and then the fspf hello-interval command in interface mode to change the default Hello interval.

Resolving a Mismatched Retransmit Interval on an ISL Using Device Manager

To resolve a mismatched retransmit interval on an ISL using Device Manager, follow these steps:

Step 1 Choose FC > Advanced > FSPF and select the Interfaces tab to verify that the FSPF parameters are correct for each interface and check the Retransmit interval column and the State column.

- The Intervals column shows the configured FSPF timers for this interface, which must match on both sides.
- The State column shows the full or adjacent state if the interface has sent and received all database exchanges and required Acks. The port is now ready to route frames.

Step 2 Repeat Step 1 to determine the value of the retransmit interval on the adjacent switch.

Step 3 Fill in the Retransmit field to change the retransmit interval and click Apply.

Resolving a Mismatched Retransmit Interval on an ISL Using the CLI

To resolve a mismatched retransmit interval on an ISL using the CLI, follow these steps:

Step 1 Use the show fspf vsan vsan-id interface command to view the FSPF configuration.

```
switch1# show fspf vsan 1 interface fc1/16
FSPF interface fc1/16 in VSAN 1
FSPF routing administrative state is active
Interface cost is 500
Timer intervals configured, Hello 5 s, Dead 80 s, Retransmit 10 s
FSPF State is INIT
Statistics counters :
  Number of packets received : LSU 0 LSA 0 Hello 2 Error packets 1
  Number of packets transmitted : LSU 0 LSA 0 Hello 4 Retransmitted LSU 0
  Number of times inactivity timer expired for the interface = 0
```

1. The retransmit interval is not set to the default, so you should check the neighbor configuration to make sure it matches.
2. FSPF is not in FULL state, indicating a problem.
Step 2 Repeat Step 1 to determine the value of the retransmit interval on the adjacent switch.

```text
switch2# show fspf v 1 interface fc2/16
FSPF interface fc2/16 in VSAN 1
FSPF routing administrative state is active
Interface cost is 500
Timer intervals configured, Hello 20 s, Dead 80 s, Retransmit 5 s
FSPF State is INIT

Statistics counters:
Number of packets received: LSU 0 LSA 0 Hello 2 Error packets 1
Number of packets transmitted: LSU 0 LSA 0 Hello 4 Retransmitted LSU 0
Number of times inactivity timer expired for the interface = 0
```

1. The neighbor retransmit interval interval is set to the default (5 seconds).
2. FSPF is not in FULL state, indicating a problem.

Step 3 Use the `interface` command and then the `fspf retransmit-interval` command in interface mode to change the retransmit interval.

---

### Resolving a Mismatch in Dead Intervals on an ISL Using Fabric Manager

To resolve a mismatch of dead intervals on an ISL using Fabric Manager, follow these steps:

Step 1 Choose FC > Advanced > FSPF and select the Interfaces tab to verify that the FSPF parameters are correct for each interface and check the Dead interval column and the State column.

- The Intervals column shows the configured FSPF timers for this interface, which must match on both sides.
- The State column shows the full or adjacent state if the interface has sent and received all database exchanges and required Acks. The port is now ready to route frames.

Step 2 Repeat Step 1 to determine the value of the dead interval on the adjacent switch.

Step 3 Fill in the Dead field to change the dead interval and click Apply.

---

### Resolving a Mismatch in Dead Intervals on an ISL Using the CLI

To identify a mismatch in dead intervals on an ISL, follow these steps:

Step 1 Use the `debug fspf all` command and look for wrong dead interval messages.

```text
switch1# debug fspf all
Jan 5 00:28:14 fspf: Wrong dead interval for packet on interface 100f000 in VSAN 1
Jan 5 00:28:14 fspf: Error in processing hello packet, error code = 4
```

**Tip** We recommend that you open a second Telnet or SSH session before entering any debug commands. If the debug output overwhelms the current session, you can use the second session to enter the `undebug all` command to stop the debug message output.

Step 2 Use the `undebug all` command to turn off debugging.
Chapter 11  Troubleshooting VSANs, Domains, and FSPF

FSPF Issues

Step 3  Use the `show fspf vsan vsan-id interface` command to show FSPF information.

Note  To issue commands with the `internal` keyword, you must have an account that is a member of the network-admin group.

```
switch1# show fspf vsan 1 interface fc1/16
FSPF interface fc1/16 in VSAN 1
FSPF routing administrative state is active
Interface cost is 500
Timer intervals configured, Hello 20 s, Dead 95 s, Retransmit 5 s <-----1
FSPF State is INIT <-----2
XStatistics counters :
   Number of packets received : LSU 0  LSA 0  Hello 2  Error packets 1
   Number of packets transmitted : LSU 0  LSA 0  Hello 4  Retransmitted LSU 0
   Number of times inactivity timer expired for the interface = 0

1. The dead timer is not set to the default, so you should check the neighbor configuration.
2. FSPF is not in full state, which indicates a problem.

Step 4  Use the `interface` command and then the `fspf dead-interval` command in interface mode to change the dead interval.

Resolving a Region Mismatch Using Fabric Manager

To identify a region mismatch problem on a switch using Fabric Manager, follow these steps:

Step 1  Choose FC > Advanced > FSPF and select the General tab to verify the RegionId.
Step 2  Repeat Step 1 to determine the value of the region on the adjacent switch.
Step 3  Fill in the RegionId field to change the region and click Apply.

Resolving a Region Mismatch Using the CLI

To identify a region mismatch problem on a switch using the CLI, follow these steps:

Step 1  Use the `show fspf vsan` command to display the currently configured region in a VSAN.

```
switch# show fspf vsan 99
FSPF routing for VSAN 99
FSPF routing administration status is enabled
FSPF routing operational status is UP
It is an intra-domain router
Autonomous region is 0 /* This is the region */
SPF hold time is 0 msec
MinLsArrival = 1000 msec , MinLsInterval = 5000 msec
Local Domain is 0x78(120)
Number of LSRs = 2, Total Checksum = 0x000133de
```
**Send documentation comments to mdsfeedback-doc@cisco.com**

**Step 2**  Use the `debug fspf all` command and look for nonexistent region messages.

```plaintext
switch1# debug fspf all
Jan  5 00:39:31 fspf: FC2 packet received for non existent region 0 in VSAN 1 <------1
Jan  5 00:39:33 fspf: FC2 packet received for non existent region 0 in VSAN 1
Jan  5 00:39:45 fspf: Interface fc1/1 in VSAN 1 : Event INACTIVITY , State change INIT -> INIT
Jan  5 00:39:45 fspf: Interface fc1/2 in VSAN 1 : Event INACTIVITY , State change INIT -> INIT <------2
```

1. The neighbor switch advertising region is 0.
2. FSPF is in init state for each ISL.

**Tip**  We recommend that you open a second Telnet or SSH session before entering any debug commands. If the debug output overwhelsms the current session, you can use the second session to enter the `undebug all` command to stop the debug message output.

**Step 3**  Use the `undebug all` command to turn off debugging.

**Step 4**  Use the `show fspf` command to show FSPF configuration and check the autonomous region.

**Step 5**  Use the `fspf config vsan` command to enter the FSPF configuration mode and use the `region` command to change the region.

The region must match on all switches in the VSAN.
Troubleshooting SAN Device Virtualization

This chapter describes how to troubleshoot and resolve SAN device virtualization (SDV) configuration issues in the Cisco MDS 9000 Family of multilayer directors and fabric switches. It includes the following sections:

- Overview, page 12-1
- Initial Troubleshooting Checklist, page 12-1
- SDV Issues, page 12-3

Overview

With Cisco SDV, you can create virtual devices that represent physical end-devices. The SAN devices that are virtualized can be either initiators or targets. Virtualization of SAN devices accelerates swapout or failover to a replacement disk array, and it also minimizes downtime when replacing host bus adapters (HBAs) or when re-hosting an application on a different server.

Troubleshooting SDV involves checking the configuration of virtual devices, domain IDs, and zone sets. Configuration problems with SDV can prevent devices from communicating properly.

Note

SDV is a distributed service and uses CFS (Cisco Fabric Services) distribution to synchronize the databases.

Initial Troubleshooting Checklist

Begin troubleshooting SDV issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See <em>Cisco MDS 9000 Family Fabric Manager</em></td>
<td></td>
</tr>
<tr>
<td>Configuration Guide.</td>
<td></td>
</tr>
<tr>
<td>Enable SDV on all the relevant switches.</td>
<td></td>
</tr>
<tr>
<td>Configure the virtual devices (with or without a persistent FC ID) in a</td>
<td></td>
</tr>
<tr>
<td>VSAN.</td>
<td></td>
</tr>
<tr>
<td>Link the virtual device with the primary real device.</td>
<td></td>
</tr>
<tr>
<td>Commit the configuration in the VSAN and check the commit status.</td>
<td></td>
</tr>
<tr>
<td>Ensure that the SDV database is consistent on all switches.</td>
<td></td>
</tr>
</tbody>
</table>
This section includes the following topics:

- Debugging and Verifying SDV Configuration Using the CLI, page 12-2
- SDV Limitations and Restrictions, page 12-2
- SDV Issues, page 12-3

Debugging and Verifying SDV Configuration Using the CLI

Several commands involving multiple configuration tasks can be used to debug and verify the SDV configuration. Table 12-1 lists debugging and verification CLI commands.

<table>
<thead>
<tr>
<th>CLI Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show sdv database</td>
<td>Displays the SDV virtual device configuration that has been committed.</td>
</tr>
<tr>
<td>show sdv session status</td>
<td>Displays the status of the last CFS operation in the SDV configuration.</td>
</tr>
<tr>
<td>show sdv merge status</td>
<td>Displays the status of the last CFS merge.</td>
</tr>
<tr>
<td>show sdv internal acl-cache dump</td>
<td>Displays SDV ACL entries programmed on interfaces.</td>
</tr>
<tr>
<td>show sdv zone active</td>
<td>Displays the SDV zones in the active zone set.</td>
</tr>
<tr>
<td>debug sdv all-sdv</td>
<td>Configures all filters for SDV debugging.</td>
</tr>
<tr>
<td>show tech-support sdv</td>
<td>Displays most SDV-related debugging information.</td>
</tr>
</tbody>
</table>

SDV Limitations and Restrictions

Be aware of the following limitations and restrictions of SDV:

- All SDV devices, and the real devices accessing the SDV devices, must be attached to SDV enabled switches.
- SDV does not work for devices connected to non-MDS switches.
- Broadcast zoning is not supported for a zone with a virtual device.
- IVR and SDV cannot be used for the same device. In other words, a SDV-virtualized device cannot be part of an IVR zone or zoneset.
- Virtual device names should be unique across VSANs because they are registered with the device alias server, which is unaware of VSANs. For example, if you have enabled SDV and have registered a name, vt1 in both VSAN 1 and VSAN 2, then the device alias server cannot store both entries because they have the same name.
You cannot specify the same primary device for different virtual devices.

SDV works in a hard zoning environment only. (Hard zoning is enforced using ACLs that are applied by the switch port ASIC to every Fibre Channel frame that is switched; hard zoning is also referred to as port zoning.) SDV does not work in the default zone, even if you set it to permit.

The real device-virtual device zone cannot coexist with the real device-real device zone. If the real devices are not already zoned together, then you can configure the real device-virtual device zone with no negative impact. If these devices are already zoned, then adding the real device-virtual device zone may cause the zone activation to fail. If this occurs, then you must delete one of the zones before activation.

There must be at least one rewrite-capable SDV-enabled MDS switch located between the server and the target that is being virtualized. The Cisco MDS 9124 Fabric Switch is not a rewrite-capable switch.

In other words, SDV does not work when real devices and primary virtual devices are connected to the same Cisco MDS 9124 Fabric Switch.

When restoring a configuration file from an ASCII file (for example, when you issue the `copy bootflash:saved-config running-config` command), ensure that the pWWNs in the device alias configuration portion of the file are consistent with the current fabric state. If pWWNs in the saved configuration file do not match the current fabric state, then it can result in inconsistencies and merge failures of SDV (which can occur if the file being used to restore the configuration was saved at some earlier point, and subsequent changes have been made to the device alias database). If this occurs, edit the saved configuration file to make the device-alias pWWNs consistent with the device aliases currently used in the fabric.

SDV Issues

This section describes potential problems associated with SDV, and includes the following topics:

- SDV Commit Fails, page 12-3
- SDV Commit Partially Fails, page 12-4
- Host Cannot Locate Disk, page 12-5
- SDV Merge Fails When ISL Comes Up, page 12-6
- Zone Activation Fails in a SDV Zone, page 12-6

SDV Commit Fails

Table 12-2 describes measures to take when an SDV commit fails.
Chapter 12  Troubleshooting SAN Device Virtualization

Symptom  SDV commit fails.

Table 12-2  SDV Commit Fails

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDV commit fails</td>
<td>Failure to register with device alias because the device alias database is locked.</td>
<td>Clear the device alias CFS session and then reconfigure the SDV device.</td>
</tr>
<tr>
<td></td>
<td>Failure to register with device alias because the same name is already in use.</td>
<td>Use a different name.</td>
</tr>
<tr>
<td></td>
<td>CFS distribution failure.</td>
<td>Check CFS commands to determine the cause of failure.</td>
</tr>
<tr>
<td></td>
<td>The session was created and is locked and in use by another user.</td>
<td>Use the same user credentials and issue the <strong>commit</strong> command.</td>
</tr>
</tbody>
</table>

SDV Commit Partially Fails

Table 12-3 describes measures to take when an SDV commit partially fails. A partial failure occurs when a commit operation fails beyond the rollback point. The commit operation will complete, but will have succeeded in one or more switches and failed in one or more.

Symptom  SDV commit partially fails.

Table 12-3  SDV Commit Partially Fails

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial failure of SDV</td>
<td>FC ID cannot be assigned because the persistent domain or FC ID is already in use.</td>
<td>The failing switches produce a syslog identifying the reason for the failure. View the syslog and identify the reason for the failure; rectify the problem and reissue the <strong>commit</strong> command.</td>
</tr>
<tr>
<td>commit.</td>
<td>FCID cannot be assigned because the domain cannot be reserved.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CFS distribution failure.</td>
<td></td>
</tr>
</tbody>
</table>
Host Cannot Locate Disk

Table 12-4 describes measures to take when a host cannot locate a disk.

Symptom SDV cannot locate disk.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host cannot locate disk.</td>
<td>Host and virtual device are not zoned correctly; not all zone members are resolved.</td>
<td>Enter the <code>show sdv zones active vsan</code> command to identify whether or not zoning is configured and resolving correctly. If it is not, make the necessary corrections to the zone and reactivate zoning.</td>
</tr>
<tr>
<td>Host or virtual device not connected to an SDV-enabled switch.</td>
<td></td>
<td>Enable SDV on those switches.</td>
</tr>
<tr>
<td>Rewrite entries are not programmed correctly.</td>
<td>To confirm that the ACL rewrite and capture entries are programmed correctly for the host and virtual device, enter the <code>show sdv internal acl-cache dump vsan</code> command on switches where the host and virtual devices are connected. If the host or virtual device is connected to the Cisco MDS 9124 Fabric Switch, check the director at the next hop to confirm that the rewrite and capture entries are programmed correctly on all the trunk ports to the switch. Enter the <code>show tech-support sdv</code> command and collect the data returned.</td>
<td></td>
</tr>
</tbody>
</table>
| There are no rewrite-capable switches in either the host-to-virtual device or virtual device-to-host direction. | Make sure that the topology mirrors the supported topologies for SDV to work. Between the host, the SDV, and the real device, there must be at least one of the following switches in the path:  
  * 95xx  
  * 9216  
  * 9216A  
  * 9216i  
  * 9120  
  * 9140  
SDV must also be enabled. |
SDV Merge Fails When ISL Comes Up

Table 12-5 describes the measures to take when an SDV merge fails and ISL comes up.

**Symptom**  SDV merge fails when the ISL comes up.

**Table 12-5  SDV Merge Fails When ISL Comes Up**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDV merge fails when ISL comes</td>
<td>Configuration mismatch in the merging</td>
<td>To forcefully recover from an SDV merge failure due to an ISL not coming</td>
</tr>
<tr>
<td>up</td>
<td>fabrics.</td>
<td>up, perform an empty commit from one of the involved fabrics.</td>
</tr>
<tr>
<td></td>
<td>Virtual device name and pWWN mismatch</td>
<td>Note  This should not only remedy name and pWWN mismatches, but also a</td>
</tr>
<tr>
<td></td>
<td>in the merging fabrics.</td>
<td>device alias failure.</td>
</tr>
<tr>
<td></td>
<td>Virtual device name and FC ID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>mismatch in the merging fabrics.</td>
<td></td>
</tr>
</tbody>
</table>

Zone Activation Fails in a SDV Zone

**Symptom**  Zone activation fails in a SDV zone.

If a zone activation fails in a SDV zone, enter the `show zone internal sdv-table` command to view the physical-virtual mapping maintained in the zone server. Devices should be zoned so that they cannot communicate to both the real device and its virtual component.
Troubleshooting IVR

This chapter describes how to troubleshoot and resolve inter-VSAN routing (IVR) configuration issues in the Cisco MDS 9000 Family of multilayer directors and fabric switches. It includes the following sections:

- Overview, page 13-1
- Limitations and Restrictions, page 13-2
- Initial Troubleshooting Checklist, page 13-3
- IVR Issues, page 13-6
- Troubleshooting the IVR Wizard, page 13-15

**Overview**

IVR allows resources to be shared across VSANs without compromising other VSAN benefits. Troubleshooting IVR involves checking the configuration of domain IDs, VSANs, border switches, and zone sets. Configuration problems with IVR can prevent devices from communicating properly.

Prior to Cisco MDS SAN-OS Release 2.1(1a), IVR required unique domain IDs for all switches in the fabric. As of Cisco MDS SAN-OS Release 2.1(1a), you can enable IVR Network Address Translation (NAT) to allow non-unique domain IDs. This feature simplifies the deployment of IVR in an existing fabric where non-unique domain IDs might be present.

**Note**

By default, IVR-NAT is not enabled.

**Configuration Guidelines**

This section provides guidelines for configuring components that can affect IVR, and includes the following topics:

- Transit VSANs, page 13-2
- Border Switches, page 13-2
Transit VSANs

Follow these guidelines when configuring transit VSANs:

- Besides defining the IVR zone membership, you can choose to specify a set of transit VSANs to provide connectivity between two edge VSANs:
  - If two edge VSANs in an IVR zone overlap, then a transit VSAN is not required (though not prohibited) to provide connectivity.
  - If two edge VSANs in an IVR zone do not overlap, you may need one or more transit VSANs to provide connectivity. Two edge VSANs in an IVR zone will not overlap if IVR is not enabled on a switch that is a member of both the source and destination edge VSANs.
- Traffic between the edge VSANs traverses only the shortest IVR path.
- Transit VSAN information is common to all IVR zones. Sometimes a transit VSAN can also be an edge VSAN in another IVR zone.

Border Switches

Always follow these guidelines when configuring border switches:

- Border switches require Cisco SAN-OS Release 1.3(1) or higher.
- A border switch must be a member of two or more VSANs.
- A border switch that facilities IVR communications must be IVR enabled.
- For redundant paths between active IVR zone members, IVR can (optionally) be enabled on additional border switches.
- The VSAN topology configuration must be updated before a border switch is added or removed.

Limitations and Restrictions

The following limitations apply to IVR:

- IVR is not supported on the Cisco MDS 9124 Fabric Switch, the Cisco Fabric Switch for HP c-Class BladeSystem, and the Cisco Fabric Switch for IBM BladeCenter.
- OX ID based load balancing of IVR traffic from IVR-enabled switches is not supported on Generation 1 switching modules. OX ID based load balancing of IVR traffic from a non-IVR MDS switch should work. Generation 2 switching modules support OX ID based load balancing of IVR traffic from IVR-enabled switches.
- You cannot configure IVR NAT and preferred Fibre Channel routes on Generation 1 module interfaces.
- You cannot run SANTap and IVR together. IVR and SANTap both perform straddling across VSANs and cannot be used together.

Table 13-1 describes the configuration limits for IVR. (See Appendix C, “Configuration Limits for Cisco MDS SAN-OS Release 3.x” for complete limitations to the IVR configuration based on the Cisco SAN-OS release.)
Initial Troubleshooting Checklist

Begin troubleshooting IVR issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See Cisco MDS 9000 Family Fabric Manager Configuration Guide.</td>
<td></td>
</tr>
<tr>
<td>Verify that IVR is enabled on all border switches involved in IVR.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have the correct license installed (SAN_EXTENSION for IVR over FCIP or ENTERPRISE_PKG for IVR over Fibre Channel).</td>
<td></td>
</tr>
<tr>
<td>Verify that the IVR configuration is the same on all IVR-enabled switches.</td>
<td></td>
</tr>
<tr>
<td>Verify that the IVR zone is part of the active IVR zone set.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have an active zone set or that you activate the IVR zone set using the force option.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have added IVR virtual domains to the allowed domain ID list if you have a Cisco SN5428 storage router or a Cisco MDS 9020 switch in your fabric.</td>
<td></td>
</tr>
</tbody>
</table>

If you change any FSPF link cost, ensure that the FSPF path cost (that is, the sum of the link costs on the path) of any IVR path is less than 30,000.

This section includes the following topics:
- Verifying IVR Configuration Using Fabric Manager, page 13-3
- Verifying IVR Configuration Using the CLI, page 13-4
- IVR Enhancements by Cisco SAN-OS Release, page 13-5

Verifying IVR Configuration Using Fabric Manager

To verify your IVR configuration using Fabric Manager, follow these steps:

<table>
<thead>
<tr>
<th>Table 13-1 IVR Configuration Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IVR Feature</strong></td>
</tr>
<tr>
<td>IVR zone members</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>IVR zones</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>IVR zone sets</td>
</tr>
</tbody>
</table>
Initial Troubleshooting Checklist

Step 1  Choose Fabricxx > All VSANs > IVR to verify your IVR configuration.
Step 2  Select the CFS tab to verify that the Oper column is enabled and the Global column is enabled for CFS distribution. Check the LastResult column for the status of the last CFS action.
Step 3  Select the Action tab to determine if auto topology and IVR NAT are enabled.
Step 4  Select the Local Topology and Active Topology tabs to verify your IVR VSAN topology.
Step 5  Choose Fabricxx > All VSANs > Domain Manager to verify unique domain IDs if IVR NAT is not enabled.
Step 6  Choose Zone > IVR > Edit Local Full Zone Database to verify your IVR zones and zone sets and to verify that you have activated your IVR zone set. The active IVR zone set name appears in bold.

Verifying IVR Configuration Using the CLI

Several commands involving multiple configuration tasks can be used to verify the IVR configuration.

Table 13-1  CLI Commands for Verification of IVR

<table>
<thead>
<tr>
<th>CLI Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show fcdomain</td>
<td>Verifies unique domain ID assignment. If a domain overlap exists, edit and verify the allowed-domains list or manually configure static, non-overlapping domains for each participating switch and VSAN.</td>
</tr>
<tr>
<td>domain-list</td>
<td></td>
</tr>
<tr>
<td>show interface brief</td>
<td>Verifies if the ports are operational, VSAN membership, and other configuration settings covered previously.</td>
</tr>
<tr>
<td>show fcns database</td>
<td>Verifies the name server registration for all devices participating in the IVR.</td>
</tr>
<tr>
<td>show zoneset active</td>
<td>Displays zones in the active zone set. This should include configured IVR zones.</td>
</tr>
<tr>
<td>show ivr fcdomain</td>
<td>Displays the IVR persistent fcdomain database.</td>
</tr>
<tr>
<td>show ivr internal</td>
<td>Shows the IVR internal troubleshooting information.</td>
</tr>
<tr>
<td>show ivr pending-diff</td>
<td>Shows the IVR pending configuration.</td>
</tr>
<tr>
<td>show ivr service-group</td>
<td>Shows the difference between the IVR pending and configured databases.</td>
</tr>
<tr>
<td>show ivr tech-support</td>
<td>Shows information that is used by your customer support representative to troubleshoot IVR issues.</td>
</tr>
<tr>
<td>show ivr virtual-domains</td>
<td>Shows IVR virtual domains for all local VSANs.</td>
</tr>
<tr>
<td>show ivr virtual-fcdomain-add-status</td>
<td>Shows IVR virtual fcdomain status.</td>
</tr>
<tr>
<td>show ivr vsan-topology</td>
<td>Verifies the configured IVR topology.</td>
</tr>
<tr>
<td>show ivr zoneset</td>
<td>Verifies the IVR zone set configuration.</td>
</tr>
</tbody>
</table>
Table 13-1  CLI Commands for Verification of IVR (continued)

<table>
<thead>
<tr>
<th>CLI Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show ivr zone</td>
<td>Verifies the IVR zone configuration.</td>
</tr>
<tr>
<td>clear ivr zone database</td>
<td>Clears all configured IVR zone information.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Clearing a zone set erases only the configured zone database, not the active zone database.</td>
</tr>
</tbody>
</table>

The following **show internal** commands can be useful for troubleshooting IVR issues.

- `add-rw`: Show ivr fcid rewrite fsm internals
- `adv_vsans`: Show IVR advertise VSANs for a native VSAN and domain
- `area-port-allocation`: Show IVR area-port allocation
- `capability-fsm`: Show IVR capability fsm internal debug information
- `commit-rw`: Show ivr fcid rewrite fsm internals
- `debug-log-buffer1`: Show IVR debug-log buffer
- `del-rw`: Show ivr fcid rewrite fsm internals
- `dep`: Show ivr dep internals
- `device-list`: Show ivr device list
- `distribution`: Show ivr distribution internals
- `domain-capture-list`: Show ivr domain controller capture list
- `drav-fsm`: Show DRAV FSM details
- `event-history`: Show ivr internal event history
- `fcid-rewrite-fsm`: Show ivr fcid rewrite fsm internals
- `fcid-rewrite-list`: Show ivr fcid rewrite entries
- `fsmtca`: Show IVR FSM transition statistics
- `global-data`: Show ivr global data
- `mem-stats`: Show memory statistics
- `nhvsan-change`: Show ivr fcid rewrite fsm internals
- `plogi-captured-list`: Show ivr PLOGI captured
- `pnat`: Show IVR payload NAT internal information
- `pvm`: Show IVR PV Master internal information
- `tu-fsm`: Show TU FSM internal debug information
- `vdri-fsm`: Show VDRI FSM internal debug information
- `virtual-domains`: Show IVR capability fsm internal debug information
- `vsan-rewrite-list`: Show ivr vsan rewrite list
- `vsan-topology`: Show internal information on IVR VSAN topology
- `vsan-topology-graph`: Show IVR VSAN Topology graph internal debug information
- `zone-fsm`: Show ivr zone fsm internals

### IVR Enhancements by Cisco SAN-OS Release

**Table 13-2** lists the IVR enhancements by Cisco SAN-OS release.

**Table 13-2  IVR Enhancements by Cisco SAN-OS Release**

<table>
<thead>
<tr>
<th>Cisco SAN-OS Release</th>
<th>IVR Enhancement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release 3.3(1)</td>
<td>Support for read-only LUN attribute in IVR zone configuration.</td>
</tr>
<tr>
<td>Release 2.1(2)</td>
<td>Persistent FC IDs and domains for IVR</td>
</tr>
</tbody>
</table>
IVR Issues

This section describes the problems associated with IVR. This section includes the following topics:

- IVR Licensing Issues, page 13-6
- Cannot Enable IVR, page 13-7
- IVR Network Address Translation Fails, page 13-8
- IVR Zone Set Activation Fails, page 13-8
- Border Switch Fails, page 13-10
- Traffic Does Not Traverse IVR Path, page 13-11
- Link Isolated, page 13-12
- Persistent FC ID for IVR Failed, page 13-12
- LUN Configuration Failure in IVR Zoning, page 13-13
- Host Does Not Have Write Access to Storage, page 13-13
- Locked IVR CFS Session, page 13-13
- CFS Merge Failed, page 13-14

IVR allows device discovery across VSANs. IVR also supports FC ping and FC traceroute across VSANs using the following criteria:

- Either FC ID or pWWN can be used.
- Must be initiated from a switch with an active IVR zone member.

IVR Licensing Issues

To use IVR, you must obtain the correct licenses for the IVR features you are using and install those licenses on every IVR-enabled switch in your fabric. Table 13-3 shows which license to purchase based on the IVR feature you are using and the module or chassis you have enabled IVR on.

### Table 13-2  IVR Enhancements by Cisco SAN-OS Release

<table>
<thead>
<tr>
<th>Cisco SAN-OS Release (continued)</th>
<th>IVR Enhancement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release 2.1(1a)</td>
<td>• IVR NAT</td>
</tr>
<tr>
<td></td>
<td>• AFIDs</td>
</tr>
<tr>
<td></td>
<td>• Auto-topology</td>
</tr>
<tr>
<td></td>
<td>• Virtual domains added to remote domain lists</td>
</tr>
<tr>
<td></td>
<td>• IVR LUN zoning</td>
</tr>
<tr>
<td></td>
<td>• IVR QoS zoning</td>
</tr>
<tr>
<td></td>
<td>• Service group</td>
</tr>
<tr>
<td>Release 2.0(1)</td>
<td>IVR with CFS support</td>
</tr>
<tr>
<td>Release 1.3(4a)</td>
<td>Virtual domains added to remote domain lists</td>
</tr>
<tr>
<td>Release 1.3(1)</td>
<td>IVR introduced</td>
</tr>
</tbody>
</table>

Send documentation comments to mdsfeedback-doc@cisco.com
Table 13-3  License Requirements for IVR

<table>
<thead>
<tr>
<th>IVR Feature</th>
<th>Chassis or Module Type</th>
<th>License Required</th>
<th>Number of Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>IVR over Fibre Channel and IVR NAT over Fibre Channel</td>
<td>All</td>
<td>ENTERPRISE_PKG</td>
<td>One per IVR-enabled chassis</td>
</tr>
<tr>
<td>IVR over FCIP</td>
<td>MDS 9216i ¹</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>MPS-14/2</td>
<td>SAN_EXTN_OVER_IPS2</td>
<td>One per module running IVR over FCIP</td>
</tr>
<tr>
<td></td>
<td>MPS-18/4 or MPS-18/4 FIPS</td>
<td>SAN_EXTN_OVER_MPS_184_FIPS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IPS-8</td>
<td>SAN_EXTN_OVER_IP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IPS-4</td>
<td>SAN_EXTN_OVER_IPS4</td>
<td></td>
</tr>
</tbody>
</table>

¹ Cisco MDS 9216i enables the SAN_EXTENSION features without a license for the two Gigabit Ethernet ports on the integrated supervisor card.

**Note**

If you are using IVR over FCIP and Fibre Channel, you need the ENTERPRISE_PKG as well as the appropriate SAN extension license as shown in Table 13-3.

**Tip**

Be sure to enter the correct chassis serial number when purchasing your license packages. Choose **Switches > Hardware** and check the SerialNo Primary for the switch chassis in Fabric Manager or use the `show license host-id` CLI command to obtain the chassis serial number for each switch that requires a license. Your license will not operate if the serial number used does not match the serial number of the chassis you are installing the license on.

See Chapter 6, “Troubleshooting Licensing,” for complete details on troubleshooting licensing issues.

### Cannot Enable IVR

**Symptom** Cannot enable IVR.

**Table 13-4  Cannot Enable IVR**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot enable IVR</td>
<td>License not installed and grace period has expired.</td>
<td>Purchase and install the appropriate licenses. See the “IVR Licensing Issues” section on page 13-6.</td>
</tr>
<tr>
<td></td>
<td>Switch not running Cisco SAN-OS Release 1.3(1) or later.</td>
<td>Upgrade to the Cisco SAN-OS release required for the IVR features you want to use. See Table 13-1 and Chapter 2, “Troubleshooting Installs, Upgrades, and Reboots.”</td>
</tr>
<tr>
<td></td>
<td>Using IVR auto topology but CFS distribution is not enabled.</td>
<td>Choose <strong>Fabricxx &gt; All VSANs &gt; IVR</strong>, set the Global drop-down menu to <strong>enable</strong>, and click <strong>Apply Changes</strong> in Fabric Manager. Or use the <code>ivr distribute</code> CLI command before enabling IVR.</td>
</tr>
</tbody>
</table>
IVR Network Address Translation Fails

**Symptom** IVR NAT fails.

<table>
<thead>
<tr>
<th>Table 13-5</th>
<th>IVR NAT Fails</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td>IVR NAT fails.</td>
</tr>
<tr>
<td><strong>Possible Cause</strong></td>
<td>Internal message payload uses destination ID.</td>
</tr>
<tr>
<td><strong>Solution</strong></td>
<td>IVR NAT modifies the destination ID in the Fibre Channel header. If this same destination ID appears inside the message payload, Cisco SAN-OS may not detect it and IVR NAT fails. Disable IVR NAT and ensure that all domain IDs are unique. Refer to the Cisco MDS 9000 Family configuration guides at the following website for a list of payloads that work with IVR NAT when the payload includes the destination ID: <a href="http://www.cisco.com/en/US/products/ps5989/products_installation_and_configuration_guides_list.html">http://www.cisco.com/en/US/products/ps5989/products_installation_and_configuration_guides_list.html</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some switches are running IVR without NAT.</td>
<td>You cannot combine IVR and IVR NAT in the same VSAN. Use the same IVR configuration on all switches. Deactivate the active zone set before converting to IVR or IVR NAT.</td>
<td></td>
</tr>
</tbody>
</table>

IVR Zone Set Activation Fails

If zone set activation fails, you may see the following system messages:


**Explanation** Inter-VSAN zone set activation failed in the listed VSAN. This could be an intermittent, regular zone set activation error. The activation will be retried after the number of seconds listed in the message.

**Recommended Action** No action is required.

**Introduced** Cisco MDS SAN-OS Release 2.1(2).

**Error Message** IVR-3-IVZ_ACTIVATION_FAILED: Inter-VSAN zoneset [chars] activation failed.

**Explanation** Inter-VSAN zone set activation failed.

**Recommended Action** No action is required.

**Introduced** Cisco MDS SAN-OS Release 1.3(1).
Chapter 13  Troubleshooting IVR

Send documentation comments to mdsfeedback-doc@cisco.com

13-9

Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x

IVR Issues

Error Message  IVR-3-IVZ_ACTIVATION_FAILED_VSAN: Inter-VSAN zoneset [chars] activation failed in VSAN [dec].

Explanation  Inter-VSAN zone set activation failed in the VSAN.

Recommended Action  No action is required.

Introduced  Cisco MDS SAN-OS Release 1.3(1).


Explanation  Inter-VSAN zone set activation failed with VSAN shown in the error message. This could be an intermittent regular zone set activation error. The activation retried in the number of seconds shown in the error message.

Recommended Action  No action is required.

Introduced  Cisco MDS SAN-OS Release 1.3(3).

Error Message  IVR-5-IVZS_WAITING_FOR_LOWEST_SWWN: Waiting for lowest switch WWN Inter-VSAN enabled switch in VSAN [dec].

Explanation  This switch does not have the lowest switch world wide name (sWWN) in the VSAN. Only the inter-VSAN (IVR) enabled switch with the lowest sWWN can add the IVR zones to the regular active zone set in a VSAN. This switch is waiting until the IVR switch with the lowest sWWN adds the IVR zone and reactivates the zone set.

Recommended Action  No action is required.

Introduced  Cisco MDS SAN-OS Release 2.0(1b).

Symptom  IVR zone set activation fails.

Table 13-6  IVR Activation Fails

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>IVR zone set activation fails.</td>
<td>Overlapping domain IDs.</td>
<td>Use static domain IDs to assign unique domain IDs to each switch in the VSAN or use IVR NAT. Choose Fabricx &gt; All VSANs &gt; Domain Manager in Fabric Manager or use the fcdomain domain domain-id [static</td>
</tr>
<tr>
<td></td>
<td>Default zone policy is permit.</td>
<td>Choose Zone &gt; IVR &gt; Edit Local Full Zone Database in Fabric Manager. Right-click the IVR zone set that you want to activate and select Activate. Check the Create Active Zone Set if none Present check box or use the force option with the ivr zoneset activate CLI command</td>
</tr>
<tr>
<td></td>
<td>Default zone policy is deny and no active zone set present.</td>
<td>No zone set has been activated. See the “Troubleshooting Zone Set Activation” section on page 14-8 to activate a zone set on an IVR-enabled switch, or use the force option when activating the IVR zone set.</td>
</tr>
<tr>
<td></td>
<td>No active zone set.</td>
<td>No zone set has been activated. See the “Troubleshooting Zone Set Activation” section on page 14-8 to activate a zone set on an IVR-enabled switch, or use the force option when activating the IVR zone set.</td>
</tr>
</tbody>
</table>
Border Switch Fails

If an IVR-enabled switch fails, you must update the IVR topology to reflect this change if you are not using auto topology.

**Symptom**  Border switch fails.

<table>
<thead>
<tr>
<th>Table 13-7  Border Switch Fails</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Border switch fails.</td>
</tr>
</tbody>
</table>
## Traffic Does Not Traverse IVR Path

**Symptom** Traffic does not traverse the IVR path.

### Table 13-8  Traffic Does Not Traverse IVR Path

<table>
<thead>
<tr>
<th><strong>Symptom</strong></th>
<th><strong>Possible Cause</strong></th>
<th><strong>Solution</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic does not traverse the IVR path.</td>
<td>Fabric includes an SN5428 or MDS 9020 switch and you have not added the IVR virtual domains to the remote VSAN domain lists.</td>
<td>Choose <code>Fabricxx &gt; All VSANs &gt; IVR</code> and select the Action tab in Fabric Manager. Fill in the Create Virtual Domains for VSAN field and click Apply Changes. Select the CFS tab, and set ConfigAction to commit, and click Apply Changes. Or use the <code>ivr virtual-fcdomain-add vsan-ranges</code> CLI command to add existing and future virtual domains to the domain list for the selected VSANs. Repeat this on all edge VSANs.</td>
</tr>
<tr>
<td>Internal message payload uses destination ID.</td>
<td>See the “IVR Network Address Translation Fails” section on page 13-8.</td>
<td></td>
</tr>
<tr>
<td>Devices are in different IVR service groups.</td>
<td>Verify the IVR service groups. Choose <code>Fabricxx &gt; All VSANs &gt; IVR</code> and select the Service Group tab in Fabric Manager. Or use the <code>show ivr service-group</code> CLI command. Move the VSANs into the same IVR service group. Choose <code>Fabricxx &gt; All VSANs &gt; IVR</code> and select the Service Group tab in Fabric Manager. Or use the <code>ivr service-group activate</code> CLI command. Use the <code>ivr service-group activate</code> CLI command to activate this change. If CFS is enabled, use the <code>ivr commit</code> CLI command to commit this change.</td>
<td></td>
</tr>
</tbody>
</table>
Link Isolated

**Symptom**  Link isolated.

**Table 13-9  Link Isolated**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link isolated.</td>
<td>Virtual domain overlap.</td>
<td>Choose Fabricxx &gt; All VSANs &gt; Domain Manager in Fabric Manager to verify a domain overlap.</td>
</tr>
<tr>
<td>Internal message payload uses</td>
<td></td>
<td><strong>See the “IVR Network Address Translation Fails” section on page 13-8.</strong></td>
</tr>
<tr>
<td>destination ID.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Persistent FC ID for IVR Failed

**Symptom**  Persistent FC ID for IVR failed.

**Table 13-10  Persistent FC ID for IVR Failed**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistent FC ID for IVR failed.</td>
<td>Selected virtual FC ID does not match the assigned virtual domain.</td>
<td>Use the <strong>show ivr fcdomain database</strong> CLI command to verify the virtual domain ID. Use the <strong>native-autonomous-fabric-num</strong> CLI command to assign the virtual domain and then use the <strong>pwwn</strong> CLI command to map the pWWN to an appropriate FC ID that matches the virtual domain ID. Refer to the Cisco MDS 9000 Family configuration guides for the related procedure to configure Persistent FC IDs for IVR.</td>
</tr>
</tbody>
</table>
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 13  Troubleshooting IVR

LUN Configuration Failure in IVR Zoning

**Symptom**  LUN configuration failed in IVR zoning.

**Table 13-11  LUN Configuration Failure in IVR Zoning**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>LUN configuration failed in IVR</td>
<td>One or more switches in the VSAN are not running Cisco MDS SAN-OS Release 2.1(1a) or later.</td>
<td>Upgrade to the Cisco SAN-OS release required for the IVR features you want to use. See Table 13-1 and Chapter 2, “Troubleshooting Installs, Upgrades, and Reboots.”</td>
</tr>
</tbody>
</table>

Host Does Not Have Write Access to Storage

**Symptom**  Host does not have write access to storage.

**Table 13-12  Host Does Not Have Write Access to Storage**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host does not have write access</td>
<td>Host is a member of a read-only zone.</td>
<td>If a host is a member of a read-only zone, the host has no write access to any IVR zone it may be a member of. Remove the host from the read-only zone.</td>
</tr>
<tr>
<td>to storage.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Locked IVR CFS Session

IVR uses CFS to distribute the IVR configuration. If you enable IVR auto topology, it also uses CFS to distribute and update the IVR VSAN topology on all switches. In rare cases, you may encounter problems where CFS locks IVR so that you cannot modify the configuration.

**Symptom**  Locked IVR CFS session.

**Table 13-13  Locked IVR CFS Session**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked IVR CFS session.</td>
<td>CFS did not give up the session lock for IVR after the last commit or an IVR configuration change is pending and has not been committed.</td>
<td>Choose Fabricxx &gt; All VSANs &gt; IVR and select the CFS tab in Fabric Manager. Set the ConfigView As drop-down menu to pending and verify the pending configuration changes. Set the ConfigAction drop-down menu to commit to save these changes, abort to discard the changes, or clear to clear the session lock. Click Apply Changes. Or use the show ivr pending-diff CLI command to determine if you have a pending configuration change. Use ivr commit to commit this change or ivr abort to discard the changes and free up the session lock. If you do not have pending configuration changes, use the clear ivr session CLI command to free the session lock.</td>
</tr>
</tbody>
</table>

OL-9285-05

Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x
CFS Merge Failed

If a CFS merge fails, you may see the following system messages:

**Error Message** IVR-2-CFS_PEER_LOST_WITHIN_SESSION: CFS peer with switch wwn [chars] was lost in the middle of an active CFS session. Abort the CFS session and re-enter the configuration changes.

**Explanation** Due to port flaps (enable and disable of the VSAN), link outages, switch restarts and so on, a CFS peer switch of IVR was lost. The current configuration changes would not be applied to this peer until the peer merges with this switch. The CFS merge may fail if the configuration at the lost peer conflicts with the changes made in this session. Also, IVR auto topology could be out of sync. with this peer. We recommend that you discard this CFS session using `ivr abort` command and then re-enter the configuration changes. You can alternatively use Fabric Manager and/or Device Manager instead of the command line method.

**Recommended Action** No action is required.

**Introduced** Cisco MDS SAN-OS Release 2.0(1b).

**Error Message** IVR-3-MERGE_FAILED: [chars].

**Explanation** An error occurred while merging the configuration. The reason for the failure is shown in the error message.

**Recommended Action** If you purchased Cisco support through a Cisco reseller, contact the reseller directly. If you purchased support directly from Cisco Systems, contact Cisco Technical Support.

**Introduced** Cisco MDS SAN-OS Release 2.0(1b).
Chapter 13      Troubleshooting IVR

Send documentation comments to mdsfeedback-doc@cisco.com

Symptom CFS merge failed.

Table 13-14   CFS Merge Failed

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFS merge failed.</td>
<td>IVR topology incorrect.</td>
<td>Choose Fabricxx &gt; All VSANs &gt; IVR and select the Action tab in Fabric Manager. Check the Auto Discover Topology check box and click Apply Changes. Select the CFS tab and set ConfigAction to commit and click Apply Changes. Or use either the ivr vsan topology auto CLI command to automatically reconfigure the IVR topology, or the ivr vsan topology database CLI command to manually reconfigure the IVR topology.</td>
</tr>
<tr>
<td>Maximum number of VSANs or IVR VSAN topology entries reached.</td>
<td>Reconfigure your fabric before merging to reduce the number of VSANs or topology entries. See Appendix C, “Configuration Limits for Cisco MDS SAN-OS Release 3.x.”</td>
<td></td>
</tr>
<tr>
<td>Conflicting entries in the AFID database.</td>
<td>Modify the conflicting entries in the AFID database.</td>
<td></td>
</tr>
<tr>
<td>Conflicting user-configured IVR VSAN topology database entries.</td>
<td>Enable IVR auto topology on both fabrics before the merge and remove any user-configured IVR VSAN topology database entries.</td>
<td></td>
</tr>
</tbody>
</table>

Troubleshooting the IVR Wizard

The IVR wizard in Fabric Manager simplifies the process of configuring IVR across your fabric. The IVR wizard automatically checks for the appropriate Cisco SAN-OS version across the switches in the VSAN and determines which IVR features the switches are capable of. (See Table 13-1.)

This section describes the following warning or error dialog boxes that display when you configure IVR using the Fabric Manager IVR wizard:

- **Warning: Not All Switches Are IVR NAT Capable or Are Unmanageable**, page 13-16
- **Error: The Following Switches Do Not Have Unique Domain IDs**, page 13-16
- **Error: Pending Action/Pending Commits**, page 13-17
- **Error: Fabric Is Changing. Please Retry the Request Later**, page 13-17
Warning: Not All Switches Are IVR NAT Capable or Are Unmanageable

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning: Not all switches are IVR NAT capable or are unmanageable.</td>
<td>One or more switches in the fabric are not running Cisco MDS SAN-OS Release 2.1(1a) or later.</td>
<td>Upgrade to the Cisco SAN-OS release required for the IVR features you want to use. See Table 13-1 and Chapter 2, “Troubleshooting Installs, Upgrades, and Reboots.”</td>
</tr>
<tr>
<td></td>
<td>One or more switches in the fabric cannot communicate with Fabric Manager or are not Cisco SAN-OS switches.</td>
<td>Determine if any of the problem switches are required in the IVR topology. If not, ignore this message and proceed with the IVR configuration. If they are required, choose Switches and check the Status column to determine the cause and address the problem.</td>
</tr>
</tbody>
</table>

Error: The Following Switches Do Not Have Unique Domain IDs

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following switches do not have unique domain IDs.</td>
<td>The listed switches have duplicate domain IDs in two or more VSANs in your proposed IVR configuration.</td>
<td>Choose Fabricxx &gt; All VSANS &gt; Domain Manager and set the ConfigDomainId to a unique number and set the Config Type drop-down menu to static in Fabric Manager. Set the Restart drop-down menu to disruptive and click Apply Changes. This triggers a disruptive restart to make the running domain ID match the configured domain ID. Use IVR NAT. This may require upgrading to Cisco MDS SAN-OS Release 2.1(1a) or later.</td>
</tr>
</tbody>
</table>

Choose Fabricxx > All VSANS > Domain Manager and set the ConfigDomainId to a unique number and set the Config Type drop-down menu to static in Fabric Manager. Set the Restart drop-down menu to disruptive and click Apply Changes. This triggers a disruptive restart to make the running domain ID match the configured domain ID.
Troubleshooting the IVR Wizard

Error: Pending Action/ Pending Commits

**Symptom** Pending action on pending commit error displays.

**Table 13-17 Pending Action/Pending Commits**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending action on pending commit error displays.</td>
<td>A separate IVR configuration change that was not committed.</td>
<td>IVR has pending changes that were not committed. Choose Fabricxx &gt; All VSANS &gt; IVR and select the CFS tab in Fabric Manager. Set the View Config As drop-down menu to pending and verify the pending configuration changes. Set the ConfigAction drop-down menu to commit to save these changes or abort to discard the changes. Click Apply Changes.</td>
</tr>
<tr>
<td>The IVR CFS session was not unlocked after the last commit.</td>
<td></td>
<td>Choose Fabricxx &gt; All VSANS &gt; IVR and select the CFS tab in Fabric Manager. Set the ConfigAction drop-down menu to clear to remove the session lock. Click Apply Changes.</td>
</tr>
</tbody>
</table>

**Error: Fabric Is Changing. Please Retry the Request Later**

This error may occur if there are different versions of Cisco SAN-OS on the IVR-enabled switches. You should upgrade all IVR-enabled switches to the same version of Cisco SAN-OS.
Troubleshooting Zones and Zone Sets

This chapter describes how to identify and resolve problems that might occur while implementing zones and zone sets on switches in the Cisco MDS 9000 Family. It includes the following sections:

- Overview, page 14-1
- Troubleshooting Checklist, page 14-1
- Zone and Zone Set Issues, page 14-4
- Zone Merge Failure, page 14-13
- Enhanced Zoning Issues, page 14-21

Overview

Zoning enables access control between storage devices and user groups. Creating zones increases network security and prevents data loss or corruption.

Zone sets consist of one or more zones in a VSAN. A zone set can be activated or deactivated as a single entity across all switches in the fabric, but only one zone set can be activated at any time in a VSAN. Zones can be members of more than one zone set. A zone consists of multiple zone members. Members in a zone can access each other; members in different zones cannot access each other.

Troubleshooting Checklist

The following criteria must be met for zoning to function properly:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that you have an active zone set.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have the correct hosts and storage devices in the same zone.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the zone is part of the active zone set.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the default zone policy is permit if you are not using zoning.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have only pWWN-based zoning if you have a Cisco MDS 9020 fabric switch in your fabric.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Chapter 14  Troubleshooting Zones and Zone Sets

Send documentation comments to mdsfeedback-doc@cisco.com

For zone configuration problems, use the following helpful tools:

- Cisco Fabric Analyzer. (See the “Cisco Fabric Analyzer” section on page B-25.)
- Cisco Fabric Manager and CLI system messages. (See the System Messages, page 1-10.)
- Log messages (See the “Troubleshooting with Logs” section on page 1-13.)

Troubleshooting Zone Configuration Issues with Fabric Manager

Much of the information accessible through Fabric Manager can also be accessed using the CLI. (See the “Troubleshooting Zone Configuration Issues with the CLI” section on page 14-2.)

To verify which devices belong to the active zone set on a specific VSAN using Fabric Manager, follow these steps:

Step 1  Choose Tools > Edit Full Zone Database. You see the Select VSAN dialog box.

Step 2  Select a VSAN and click OK. You see the Edit Local Full Zone Database dialog box for the selected VSAN.

Step 3  Click Zones in the left pane. The right pane lists the members for each zone.

Note  The active zone set appears in bold. If there is no zone set in bold, you have not activated a zone set for this VSAN.

Troubleshooting Zone Configuration Issues with the CLI

Much of the information accessed and summarized using Fabric Manager can also be found using CLI show commands. (See Table 14-1.)

Table 14-1  Zone Troubleshooting Commands in the CLI

<table>
<thead>
<tr>
<th>Command</th>
<th>Command Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show zone analysis [active] vsan vsan-id</td>
<td>Displays zone database information for a specific VSAN</td>
</tr>
<tr>
<td>show zone name zonename</td>
<td>Displays members of a specific zone.</td>
</tr>
<tr>
<td>show device-alias database</td>
<td>Displays any device aliases configured.</td>
</tr>
<tr>
<td>show fcalias vsan-id</td>
<td>Displays if and how FC aliases are configured.</td>
</tr>
<tr>
<td>show zone member pWWN-id, fcalias-id, or pWWN-id</td>
<td>Displays all zones to which a member belongs using the FC ID, the FC alias, or the pWWN.</td>
</tr>
<tr>
<td>show zone statistics</td>
<td>Displays the number of control frames exchanged with other switches.</td>
</tr>
<tr>
<td>show zone internal vsan-id</td>
<td>Displays the internal state of the zone server for a specific VSAN.</td>
</tr>
<tr>
<td>show zoneset zonesetname</td>
<td>Displays information about the named zone set.</td>
</tr>
</tbody>
</table>
To issue commands with the `internal` keyword, you must have a network-admin group account.

To better manage the zones and zone sets on your switch, you can display zone and zone set information using the `show zone analysis` command. (See Example 14-1 through Example 14-3.)

**Example 14-1  Full Zoning Analysis**

```bash
switch# show zone analysis vsan 1
Zoning database analysis vsan 1
Full zoning database
    Last updated at: 15:57:10 IST Feb 20 2006
    Last updated by: Local [ CLI ]
    Num zonesets: 1
    Num zones: 1
    Num aliases: 0
    Num attribute groups: 0
    Formattted size: 36 bytes / 2048 Kb

Unassigned Zones: 1
    zone name z1 vsan 1
```

**Example 14-2  Active Zoning Database Analysis**

```bash
switch# show zone analysis active vsan 1
Zoning database analysis vsan 1
Active zoneset: zs1 [*]
    Activated at: 08:03:35 UTC Nov 17 2005
    Activated by: Local [ GS ]
    Default zone policy: Deny
    Number of devices zoned in vsan: 0/2 (Unzoned: 2)
    Number of zone members resolved: 0/2 (Unresolved: 2)
    Num zones: 1
    Number of IVR zones: 0
    Number of IPS zones: 0
    Formattted size: 38 bytes / 2048 Kb
```
Example 14-3 Zone Set Analysis

```
switch# show zone analysis zoneset zs1 vsan 1
Zoning database analysis vsan 1
  Zoneset analysis: zs1
    Num zonesets: 1
    Num zones: 0
    Num aliases: 0
    Num attribute groups: 0
    Formatted size: 20 bytes / 2048 Kb
```

See the Cisco MDS 9000 Family Command Reference for the description of the information displayed in the command output.

The `debug zone change` CLI command followed by the zone name in question can help you get started debugging zones for protocol errors, events, and packets.

**Note**

To enable debugging for zones, use the `debug zone` command in EXEC mode. To disable a debug command, use the `no` form of the command or use the `no debug all` command to turn off all debugging.

For protocol errors, use:
```
debug zone change errors vsan-id
```

For protocol events, use:
```
debug zone change events vsan-id
```

For protocol packets, use:
```
debug zone change packets vsan-id
```

Other useful `debug` commands include:
```
debug zone {all | change {errors | events | packets} | database {detail | errors | events} | gs errors {errors | events | packets} | lun-zoning {errors | events | packets} | merge {errors | events | packets} | mts notifications | pss {errors | events} | read-only-zoning {errors | events | packets} | tcam errors {errors | events | packets} | transit {errors | events}} [vsan vsan-id]
```

Zone and Zone Set Issues

The section covers the following zone and zone set issues:

- Host Cannot Communicate with Storage, page 14-5
- Troubleshooting Zone Set Activation, page 14-8
- Troubleshooting Full Zone Database Synchronization Across Switches, page 14-11
- Mismatched Default Zone Policy, page 14-12
- Recovering from Link Isolation, page 14-15
- Mismatched Active Zone Sets Within the Same VSAN, page 14-17
Host Cannot Communicate with Storage

A host cannot see a storage device for the following reasons:

- The default zone policy does not allow the devices to communicate.
- Storage devices and host interfaces do not belong to the same zone or the zone is not part of the active zone set.

Symptom: Host cannot communicate with storage.

Table 14-2 Host Cannot Communicate with Storage

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host cannot communicate with storage.</td>
<td>Host and storage are not in the same zone.</td>
<td>See the “Resolving Host Not Communicating with Storage Issue Using Fabric Manager” section on page 14-5 or the “Resolving Host Not Communicating with Storage Using the CLI” section on page 14-6.</td>
</tr>
<tr>
<td>Zone is not in active zone set.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No active zone set and default zone policy is deny.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The xE port connecting to the remote switch is isolated.</td>
<td></td>
<td>See the “E Port Is Isolated in a VSAN” section on page 11-5.</td>
</tr>
<tr>
<td>Host and storage are not in the same VSAN.</td>
<td></td>
<td>Verify the VSAN membership. See the “Verifying VSAN Membership Using Fabric Manager” section on page 11-4 or the “Verifying VSAN Membership Using the CLI” section on page 11-4.</td>
</tr>
</tbody>
</table>

Resolving Host Not Communicating with Storage Issue Using Fabric Manager

To verify that the host is not communicating with storage using Fabric Manager, follow these steps:

Step 1 Verify that the host and storage device are in the same VSAN. See the “Verifying VSAN Membership Using Fabric Manager” section on page 11-4.

Step 2 Configure zoning, if necessary, by choose Fabricxx > VSANxx > Default Zone and selecting the Policies tab to determine if the default zone policy is set to deny.

The default zone policy of permit means all nodes can see all other nodes. Deny means all nodes are isolated when not explicitly placed in a zone.

Step 3 Optionally, select permit from the Default Zone Behavior drop-down menu to set the default zone policy to permit if you are not using zoning. Got to Step 8.

Step 4 Choose Zone > Edit Local Full Zone Database and select the VSAN you are interested in. Click on the zones folder and verify that the host and storage are both members of the same zone. If they are not in the same zone, see the “Resolving Host and Storage Not in the Same Zone Using Fabric Manager” section on page 14-6.

Step 5 Choose Zone > Edit Local Full Zone Database and select the VSAN you are interested in. Click on the active zone folder and determine if the zone in Step 3 and the host and disk appear in the active zone set. If the zone is not in the active zone set, see the “Resolving Zone is Not in Active Zone Set Using Fabric Manager” section on page 14-6.
**Zone and Zone Set Issues**

Send documentation comments to mdsfeedback-doc@cisco.com

---

**Step 6**  
If there is no active zone set, right-click the zone set you want to activate in the Edit Local Full Zone Database dialog box and select **Activate** to activate the zone set.

**Step 7**  
Verify that the host and storage can now communicate.

---

**Resolving Host and Storage Not in the Same Zone Using Fabric Manager**

To move the host and storage device into the same zone using Fabric Manager, follow these steps:

---

**Step 1**  
Choose **Zone > Edit Local Full Zone Database** and select the VSAN you are interested in. Click on the zones folder and find the zones that the host and storage are members of.

**Step 2**  
Click on the zone that contains the host or storage that you want to move. Right-click on the row that represents this zone member and select **Delete** from the pop-up menu to remove this end device from the zone.

**Step 3**  
Click on the zone that you want to move the end device to. Click and drag the row that represents the end device in the bottom table and add it to the zone in the top table.

**Step 4**  
Verify that you have an active zone set for this VSAN by selecting the zone set name that appears in bold. If you do not have an active zone set, right-click on the zone set you want to activate in the Edit Local Full Zone Database dialog box and select **Activate** to activate the zone set.

**Step 5**  
Expand the active zone set folder to verify that the zone in **Step 3** is in the active zone set. If it is not, see the “Resolving Zone is Not in Active Zone Set Using Fabric Manager” section on page 14-6.

**Step 6**  
Click **Activate...** to activate the modified zone set.

**Step 7**  
Verify that the host and storage can now communicate.

---

**Resolving Zone is Not in Active Zone Set Using Fabric Manager**

To add a zone to the active zone set using Fabric Manager, follow these steps:

---

**Step 1**  
Choose **Zone > Edit Local Full Zone Database** and select the VSAN you are interested in. Right-click on the active zone set, which is in bold, and select **Insert**.

**Step 2**  
Click on the zone that you want to add to this zone set and click **Add**.

**Step 3**  
Click **Activate...** to activate the modified zone set.

**Step 4**  
Verify that the host and storage can now communicate.

---

**Resolving Host Not Communicating with Storage Using the CLI**

To verify that the host is not communicating with storage using the CLI, follow these steps:

---

**Step 1**  
Verify that the host and storage device are in the same VSAN. See the “Verifying VSAN Membership Using the CLI” section on page 11-4.

**Step 2**  
Configure zoning, if necessary, by using the **show zone status vsan-id** command to determine if the default zone policy is set to **deny**.
Send documentation comments to mdsfeedback-doc@cisco.com

switch# show zone status vsan 1
VSAN: 1 default-zone: deny distribute: active only Interop: default
    mode: basic merge-control: allow session: none
    hard-zoning: enabled
Default zone:
    qos: low broadcast: disabled ronly: disabled
Full Zoning Database :
    Zonesets:0 Zones:0 Aliases: 0
Active Zoning Database :
    Name: Database Not Available
Status:

The default zone policy of permit means all nodes can see all other nodes. Deny means all nodes are isolated when not explicitly placed in a zone.

Step 3 Optionally, use the zone default-zone permit command to set the default zone policy to permit if you are not using zoning. Go to Step 7.

Step 4 Use the show zone member command for host and storage device to verify that they are both in the same zone. If they are not in the same zone, see the “Resolving Host and Storage Not in the Same Zone Using Fabric Manager” section on page 14-6.

Step 5 Use the show zoneset active command to determine if the zone in Step 4 and the host and disk appear in the active zone set.

v_188# show zoneset active vsan 2
zoneset name ZoneSet3 vsan 2
    zone name Zone5 vsan 2
        pwwn 10:00:00:00:77:99:7a:1b [Hostalias]

Step 6 If the zone is not in the active zone set, see the “Resolving Zone is Not in Active Zone Set Using Fabric Manager” section on page 14-6.

Step 7 If there is no active zone set, use the zoneset activate command to activate the zone set.

switch(config)# zoneset activate ZoneSet1 vsan 2.

Step 8 Verify that the host and storage can now communicate.

Resolving Host and Storage Not in the Same Zone Using the CLI

To move the host and storage device into the same zone using the CLI, follow these steps:

Step 1 Use the zone name zonename vsan-id command to create a zone in the VSAN if necessary, and add the host or storage into this zone.

c-9506(config)# zone name NewZoneName vsan 2
c-9506(config-zone)# member pwwn 22:35:00:0c:85:e9:d2:c2

c-9506(config-zone)# member pwwn 10:00:00:00:c9:32:8b:a8

Note The pWWNs for zone members can be obtained from the device or by issuing the show flogi database vsan-id command.

Step 2 Use the zone name command to verify that host and storage are now in the same zone.

switchA# show zone
zone name NewZoneName vsan 2
Step 3  Use the `show zoneset active` command to verify that you have an active zone set. If you do not have an active zone set, use the `zoneset activate` command to activate the zone set.

Step 4  Use the `show zoneset active` command to verify that the zone in Step 2 is in the active zone set. If it is not, use the `zoneset name` command to enter the zone set configuration submode, and use the `member` command to add the zone to the active zone set.

```
switch(config)# zoneset name zoneset1 vsan 2
cr-9506(config-zoneset)# member NewZoneName
```

Step 5  Use the `zoneset activate` command to activate the zone set.

```
switch(config)# zoneset activate ZoneSet1 vsan 2
```

Step 6  Verify that the host and storage can now communicate.

---

### Resolving Zone is Not in Active Zone Set Using the CLI

To add a zone to the active zone set using the CLI, follow these steps:

---

Step 1  Use the `show zoneset active` command to verify that you have an active zone set. If you do not have an active zone set, use the `zoneset activate` command to activate the zone set.

Step 2  Use the `show zoneset active` command to verify that the zone in Step 1 is not in the active zone set.

Step 3  Use the `zoneset name` command to enter the zone set configuration submode, and use the `member` command to add the zone to the active zone set.

```
switch(config)# zoneset name zoneset1 vsan 2
cr-9506(config-zoneset)# member NewZoneName
```

Step 4  Use the `zoneset activate` command to activate the zone set.

```
switch(config)# zoneset activate ZoneSet1 vsan 2
```

Step 5  Verify that the host and storage can now communicate.

---

### Troubleshooting Zone Set Activation

When you activate a zone set, a copy of the zone set from the full zone set is used to enforce zoning, and is called the active zone set. A zone that is part of an active zone set is called an active zone. Two main problems can occur with activating a zone set:

- No zone set is active.
Zone and Zone Set Issues

Zone set activation fails.

Zone activation can fail if a new switch joins the fabric. When a new switch joins the fabric, it acquires the existing zone sets. Also, large zone sets may experience timeout errors in Cisco MDS SAN-OS Release 1.3(4a) and earlier.

When a zone set activation fails, you may see the following system messages:

**Error Message**  ZONE-2-ZS_CHANGE_ACTIVATION_FAILED: Activation failed.

**Explanation**  The zone server cannot activate the zone set.

**Recommended Action**  Use the `zoneset activate` CLI command or similar Fabric Manager procedure to activate the zone set.

**Error Message**  ZONE-2-ZS_CHANGE_ACTIVATION_FAILED_RESN: Activation failed : reason [chars].

**Explanation**  The zone server cannot activate because of reason shown in the error message.

**Recommended Action**  No action is required.

If this message has the reason “FC2 sequence size exceeded”, then the zone database size has been exceeded. You must simplify the zone configuration, or, if full zone set distribution is enabled, then disable full zone set distribution and activate the zone set.


**Explanation**  The zone server cannot activate because of reason shown in the error message on the domain.

**Recommended Action**  No action is required.

**Troubleshooting Zone Activation Using Fabric Manager**

To verify the active zone set and active zones using Fabric Manager, follow these steps:

**Step 1**  Choose Zone > Edit Local Full Zone Database and select the VSAN you are interested in. Click on the active zone set, which is in bold.

**Step 2**  Verify that the needed zones are active. If a zone is missing from the active zone set, see the “Resolving Zone is Not in Active Zone Set Using Fabric Manager” section on page 14-6.

**Step 3**  Click Activate... to activate the zone set.

**Step 4**  If you are still experiencing zone set activation failure, use the `show zone internal change event-history vsan <vsan-id>` CLI command to determine the source of zone set activation problem.
Troubleshooting Zone Activation Using the CLI

To verify the active zone set and active zones using the CLI, follow these steps:

---

**Step 1** Use the `show zone analysis active vsan vsan-id` command to analyze the active zone set database. Verify that the formatted size does not exceed the 2048 KB limit shown. If it exceeds the limit, you must remove some zones or devices within a zone.

```bash
switch# show zone analysis active vsan 1
Zoning database analysis vsan 1
    Active zoneset: zs1 [*]
    Activated at: 08:03:35 UTC Nov 17 2005
    Activated by: Local [ GS ]
    Default zone policy: Deny
    Number of devices zoned in vsan: 0/2 (Unzoned: 2)
    Number of zone members resolved: 0/2 (Unresolved: 2)
    Num zones: 1
    Number of IVR zones: 0
    Number of IPS zones: 0
    Formattted size: 38 bytes / 2048 Kb
```

**Step 2** Use the `show zone analysis vsan vsan-id` command to analyze the full zone set database. Verify that the formatted size does not exceed the 2048 KB limit shown. If it exceeds the limit, you must remove some zones or devices within a zone.

```bash
switch# show zone analysis vsan 1
Zoning database analysis vsan 1
    Full zoning database
    Last updated at: 15:57:10 IST Feb 20 2006
    Last updated by: Local [ CLI ]
    Num zonesets: 1
    Num zones: 1
    Num aliases: 0
    Num attribute groups: 0
    Formattted size: 36 bytes / 2048 Kb
```

**Step 3** Use the `show zoneset active vsan-id` command to display the active zones.

```bash
switchA# show zoneset active vsan 2
zoneset name ZoneSet1 vsan 2
    zone name NewZoneName vsan 2
    * pwnn 22:35:00:00:0c:85:e9:d2:c2
    * pwnn 10:00:00:00:c9:32:8b:a8
```

**Step 4** Verify that the needed zones are active.

**Step 5** Optionally, use the `zoneset name Active ZonesetName vsan-id` command and the `member NewZone` command to add the zone to the active zone set in the VSAN.

```bash
switch(config)# zoneset name ZoneSet1 vsan 2
switch(config-zoneset)# member NewZoneAdded
```
Step 6  Use the `zoneset activate` command to activate the zone set.

```
switch(config)# zoneset activate ZoneSet1 vsan 2
```

Step 7  If you are still experiencing zone set activation failure, use the `show zone internal change event-history vsan <vsan-id>` command to determine the source of the zone set activation problem.

---

## Troubleshooting Full Zone Database Synchronization Across Switches

All switches in the Cisco MDS 9000 Family distribute active zone sets when new E port links come up or when a new zone set is activated in a VSAN. The zone set distribution takes effect while sending merge requests to the adjacent switch or while activating a zone set.

### Resolving Out of Sync Full Zone Database Using Fabric Manager

To verify if the full zone database is in sync across switches using Fabric Manager, follow these steps:

**Step 1**  Choose `Fabricxx > VSANxx > zonesetname` and select the Policies tab.

**Step 2**  Verify that the Propagation field is set to `FullZoneSet`. If it is not, select `FullZoneSet` from the drop-down menu.

**Step 3**  Click Apply Changes to save these changes.

### Resolving an Out of Sync Full Zone Database Using the CLI

To verify if the full zone database is in sync across switches using the CLI, follow these steps:

**Step 1**  Use the `show zone status` command to verify if the distribute flag is on.

```
switch# config t show zone status
VSAN: 1 default-zone: deny distribute: active only Interop: default
    mode: basic merge-control: allow session: none
    hard-zoning: enabled
Default zone:
    qos: low broadcast: disabled ronly: disabled
Full Zoning Database :
    Zonesets:3  Zones:7 Aliases: 9
Active Zoning Database :
    Name: ZoneSet1  Zonesets:1  Zones:2
Status:
This example shows that only the active zone set is distributed.
```

**Step 2**  Verify that the distribute flag is on.
Zone and Zone Set Issues

Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 14  Troubleshooting Zones and Zone Sets

Mismatched Default Zone Policy

If you are using basic zoning, you must verify that the default zone policy is the same for all switches in the VSAN. If the default zone policy varies, then you may experience zoning problems. If all switches in the VSAN have Cisco SAN-OS Release 2.0(1b) or later, you can use enhanced zoning. Enhanced zoning synchronizes your zone configuration across all switches in the VSAN, eliminating the possibility of mismatched default zone policies.

Resolving Mismatched Default Zone Policies Using Fabric Manager

To resolve mismatched default zone policies using Fabric Manager, follow these steps:

Step 1 Choose Fabricxx > VSANxx > zonesetname and select the Policies tab.

Step 2 View the Default Zone Behavior field for each switch in the VSAN to determine which switches have mismatched default zone policies.

Step 3 Click Apply Changes to save these changes.

Step 4 If you are using basic zoning, Select the same value from the Default Zone Behavior drop-down menu for each switch in the VSAN to set the same default zone policy.

Step 5 If you are using enhanced zoning, follow these steps:

a. Choose Fabricxx > VSANxx and view the Release field to verify that all switches are capable of working in the enhanced mode.
   All switches must have Cisco MDS SAN-OS Release 2.0(1b) or later. If one or more switches are not capable of working in enhanced mode, then your request to move to enhanced mode is rejected.

b. Choose Fabricxx > VSANxx > zonesetname and select the Policies tab and set Default Zone Behavior field to set the default zone policy.

c. Click Apply Changes to save these changes.

d. Select the Enhanced tab and select enhanced from the Action drop-down menu.

e. Click Apply Changes to save these changes.
   By doing so, you automatically start a session, acquire a fabric wide lock, distribute the active and full zoning database using the enhanced zoning data structures, distribute zoning policies, and then release the lock. All switches in the VSAN then move to the enhanced zoning mode.

Note

After moving from basic zoning to enhanced zoning (or vice versa), we recommend that you save the running configuration.
Resolving Mismatched Default Zone Policies Using the CLI

To resolve mismatched default zone policies using the CLI, follow these steps:

**Step 1**  
Issue the `show zone status` command.

```
v_188# show zone status
VSAN: 1 default-zone: deny  distribute: active only Interop: default
    mode: basic  merge-control: allow session: none
    hard-zoning: enabled
Default zone:
    qos: low broadcast: disabled ronly: disabled
Full Zoning Database :
    Zonesets:5  Zones:18 Aliases: 11
Active Zoning Database :
    Name: ZoneSet1  Zonesets:1  Zones:2
Status:
```

This example shows the default zone policy is deny, and the zone mode is basic.

**Step 2**  
If you are using basic zoning, follow these steps:

a. Repeat Step 1 for all switches in the VSAN to verify that they have the same zone mode. Use the `zone mode basic` command to change any switches that are not in basic mode.

b. Use the `zone default-zone` command on each switch in the VSAN to set the same default zone policy.

**Step 3**  
If you are using enhanced zoning, follow these steps:

a. Use the `show version` command on all switches in the VSAN to verify that all switches are capable of working in the enhanced mode.  
   All switches must have Cisco MDS SAN-OS Release 2.0(1b) or later. If one or more switches are not capable of working in enhanced mode, then your request to move to enhanced mode is rejected.

b. Use the `zone default-zone` command to set the default zone policy.

c. Use the `zone mode enhanced vsan-id` command to set the operation mode to enhanced zoning mode.
   By doing so, you will automatically start a session, acquire a fabric wide lock, distribute the active and full zoning database using the enhanced zoning data structures, distribute zoning policies, and then release the lock. All switches in the VSAN then move to the enhanced zoning mode.

```
switch(config)# zone mode enhanced vsan 3000
```

**Note**  
After moving from basic zoning to enhanced zoning (or vice versa), we recommend that you use the `copy running-config startup-config` command to save the running configuration.

### Zone Merge Failure

A zone merge request may fail because of the following configuration issues:

- Too many zone sets
- Too many aliases
Zone Merge Failure

Send documentation comments to mdsfeedback-doc@cisco.com

- Too many attribute groups
- Too many zones
- Too many LUN members
- Too many zone members

Use the `show zone internal merge event-history` CLI command to determine the cause of the zone merge failure.

You may see one or more of the following system messages after a zone merge failure:

**Error Message** ZONE-2-ZS_MERGE_ADJ_NO_RESPONSE: Adjacent switch not responding, Isolating Interface [chars] (VSAN [dec]).

**Explanation** Interface on the VSAN was isolated because the adjacent switch is not responding to zone server requests.

**Recommended Action** Flap the interface.

**Introduced** Cisco MDS SAN-OS Release 1.2(2a).

**Error Message** ZONE-2-ZS_MERGE_FAILED: Zone merge failure, Isolating interface [chars].

**Explanation** Interface isolated because of a zone merge failure.

**Recommended Action** Compare active zoneset with the adjacent switch or enter the `zone merge interface` CLI command or similar Fabric Manager/Device Manager command.

**Introduced** Cisco MDS SAN-OS Release 1.2(2a).

**Error Message** ZONE-2-ZS_MERGE_FULL_DATABASE_MISMATCH: Zone merge full database mismatch on interface [chars].

**Explanation** Full zoning databases are inconsistent between two switches connected by interface. Databases are not merged.

**Recommended Action** Compare full zoning database with the adjacent switch. Correct the difference and flap the link.

**Introduced** Cisco MDS SAN-OS Release 1.3(1).

**Error Message** ZONE-2-ZS_MERGE_FULL_DATABASE_MISMATCH: Zone merge full database mismatch on interface [chars].

**Explanation** Full zoning databases are inconsistent between two switches connected by the interface. Databases are not merged.

**Recommended Action** Compare full zoning database with the adjacent switch, correct the difference and flap the link.

**Introduced** Cisco MDS SAN-OS Release 1.2(2a).
Zone Merge Failure

Send documentation comments to mdsfeedback-doc@cisco.com

Error Message  ZONE-2-ZS_MERGE_UNKNOWN_FORMAT: Unknown format, isolating interface [chars].

Explanation  Interface isolated because of an unknown format in the merge request.

Recommended Action  Set the interoperability mode to the same value on both switches.

Introduced  Cisco MDS SAN-OS Release 2.0(1b).

Note  Zoning information exists on a per VSAN basis. Therefore, for a TE port, it may be necessary to verify that the zoning information does not conflict with any allowed VSAN.

Recovering from Link Isolation

When two switches in a fabric are merged using a TE or E port, the port may become isolated when the active zone set databases are different between the two switches or fabrics. When a TE port or an E port become isolated, you can recover that port from its isolated state using one of three options:

- Import the neighboring switch's active zone set database and replace the current active zone set.
- Export the current database to the neighboring switch.
- Manually resolve the conflict by editing the full zone set, activating the corrected zone set, and then bringing up the link.

If after verifying the Fibre Channel name server, you still experience FSPF problems (such as discovering remote switches and their attached resources), the fabric may have zone configuration problems. Examples of zone configuration problems are mismatched active zone sets and misconfigured zones within the active zone set.

Resolving a Link Isolation Because of a Failed Zone Merge Using Fabric Manager

Using the Zone Merge Analysis tool in Fabric Manager, the compatibility of two active zone sets in two switches can be checked before actually merging the two zone sets. Refer to the Cisco MDS 9000 Fabric Manager Configuration Guide for more information.

To perform a zone merge analysis using Fabric Manager, follow these steps:

Step 1  Choose Zone > Merge Analysis from the Zone menu.

You see the Zone Merge Analysis dialog box.

Step 2  Select the first switch to be analyzed from the Check Switch 1 drop-down list.

Step 3  Select the second switch to be analyzed from the And Switch 2 drop-down list.

Step 4  Enter the VSAN ID where the zone set merge failure occurred in the For Active Zoneset Merge Problems in VSAN Id field.

Step 5  Click Analyze to analyze the zone merge. Click Clear to clear the analysis data from the Zone Merge Analysis dialog box.
Resolving a Link Isolation Because of a Failed Zone Merge Using the CLI

The following CLI commands are used to resolve a failed zone merge:

- `zoneset import vsan-id`
- `zoneset export vsan-id`

To resolve a link isolation because of a failed zone merge using the CLI, follow these steps:

**Step 1**
Use the `show interface` command to confirm that the port is isolated because of a zone merge failure.

```
switch# show interface fc2/14
fc2/14 is down (Isolation due to zone merge failure)
Hardware is Fibre Channel, WWN is 20:4e:00:05:30:00:63:9e
vsan is 1
Beacon is turned off
40 frames input, 1056 bytes, 0 discards
0 runts, 0 jabber, 0 too long, 0 too short
0 input errors, 0 CRC, 3 invalid transmission words
0 address id, 0 delimiter
0 EOF abort, 0 fragmented, 0 unknown class
79 frames output, 1234 bytes, 16777216 discards
Received 23 OLS, 14 LRR, 13 NOS, 39 loop inits
Transmitted 50 OLS, 16 LRR, 21 NOS, 25 loop inits
```

An E port is segmented (isolation due to zone merge failure) if the following conditions are true:

- The active zone sets on the two switches differ from each other in terms of zone membership (provided there are zones at either side with identical names).
- The active zone set on both switches contain a zone with the same name but with different zone members.

**Step 2**
Verify the zoning information, using the following commands on each switch:

- `show zone vsan vsan-id`
- `show zoneset vsan vsan-id`

**Step 3**
You can use two different approaches to resolve a zone merge failure by overwriting the zoning configuration of one switch with the other switch’s configuration. This can be done with either of the following commands:

- `zoneset import interface interface-number vsan vsan-id`
- `zoneset export interface interface-number vsan vsan-id`

The `import` option of the command overwrites the local switch’s active zone set with that of the remote switch. The `export` option overwrites the remote switch’s active zone set with the local switch’s active zone set.
Step 4 If the zoning databases between the two switches are overwritten, you cannot use the import option. To work around this, you can manually change the content of the zone database on either of the switches, and then issue a shutdown/no shutdown command sequence on the isolated port.

Step 5 If the isolation is specific to one VSAN and not on an E port, the correct way to issue the cycle up/down, is to remove the VSAN from the list of allowed VSANs on that trunk port, and reinsert it.

Note Do not simply issue a shutdown/no shutdown command sequence on the port. This would affect all the VSANs crossing the EISL instead of just the VSAN experiencing the isolation problem.

Mismatched Active Zone Sets Within the Same VSAN

When merging switch fabrics, you must ensure that the zones in both active zone sets have unique names, or that any zones with the same name have exactly the same members. If either of these conditions is violated the E port connecting the two fabrics will appear in an isolated state.

For example, two switches may have the same zone set name, and the same zone names, but different zone members. As a result, the VSAN is isolated on the TE port that connects the two switches.

This issue can be resolved by doing one of the following:

- Modify the zone members on both zone sets to match and eliminate the conflict.
- Deactivate the zone set on one of the switches and restart the zone merge process.
- Explicitly import or export a zone set between the switches to synchronize them.

Resolving Mismatched Active Zone Sets Within the Same VSAN Using Fabric Manager

Mismatched active zone sets within the same VSAN result in that VSAN being segmented in Fabric Manager. To verify a mismatched active zone set within the same VSAN using Fabric Manager, follow these steps:

Step 1 Choose Zone > Edit Local Full Zone Database and select the segmented VSAN you are interested in. Click on the active zone set, which is in bold, to view the list of zones and zone members for this active zone set.

Step 2 Repeat Step 1 for the other segmented VSAN.

A mismatched active zone set may include zones with the same name but different members, or a missing zone within the zone set.
Step 3  Do one of the following to resolve the isolation problem:

- Change the membership of one of the zones to match the other zone of the same name. See the “Resolving Host and Storage Not in the Same Zone Using Fabric Manager” section on page 14-6.

- Discard one of the zone sets completely by deactivating it using the `no zoneset activate` command. If a VSAN does not have an active zone set, it automatically takes the active zone set of the other merging switch. See the “Deactivating a Zone Set and Restarting the Zone Merge Process Using Fabric Manager” section on page 14-20.

- Choose Zone > Copy Full Zone Database to overwrite the active zone set on one switch. This method is destructive to one of the active zone sets.

---

Resolving Mismatched Active Zone Sets Within the Same VSAN Using the CLI

To verify a mismatched active zone set within the same VSAN using the CLI, follow these steps:

**Step 1**  Use the `show zoneset active vsan-id` command to display the active zone set configuration of the first switch.

```
Switch1# show zoneset active vsan 99
zoneset name ZoneSet1 vsan 99
  zone name VZ1 vsan 99
  * fcid 0x7800e2 [pwwn 22:00:00:20:37:04:ea:2b]
  * fcid 0x7800d9 [pwwn 22:00:00:20:37:04:f8:a1]
```

**Step 2**  Use the `show zoneset active vsan-id` command to display the active zone set configuration of the second switch:

```
Switch2# show zoneset active vsan 99
zoneset name ZoneSet1 vsan 99
  zone name VZ1 vsan 99
  pwwn 22:00:00:20:37:04:fa:8a
  pwwn 22:00:00:20:37:0e:65:44
```

Even though the zones have the same name, their respective members are different.

**Step 3**  Issue the `show interface` command to view information about the TE port and the interface.

```
Switch2# show interface fc1/8
fc1/8 is trunking
  Hardware is Fibre Channel
  Port WWN is 20:08:00:05:30:00:5f:1e
  Peer port WWN is 20:05:00:05:30:00:86:9e
  Admin port mode is E, trunk mode is auto
  Port mode is TE
  Port vsan is 1
  Speed is 2 Gbps
  Receive B2B Credit is 255
  Receive data field size is 2112
  Beacon is turned off
  Trunk vsans (admin allowed and active) (1,99)
  Trunk vsans (up) (1)
  Trunk vsans (isolated) (99)
  Trunk vsans (initializing) ()
  5 minutes input rate 120 bits/sec, 15 bytes/sec, 0 frames/sec
  5 minutes output rate 88 bits/sec, 11 bytes/sec, 0 frames/sec
  10845 frames input, 620268 bytes, 0 discards
    0 CRC, 0 unknown class
    0 too long, 0 too short
```
Step 4 Use the `show port internal interface interface number` CLI command to get information about why the interface is isolated.

```
switch# show port internal info interface fc1/8
```

```
fcl/8 - if_index: 0x0109C000, phy_port_index: 0x3c
 Admin Config - state(up), mode(TE), speed(auto), trunk(on)
   beacon(off), snmp trap(on), tem(false)
 rx bb_credit(default), rx bb_credit multiplier(default)
 rxbufsize(2112), encap(default), user_cfg_flag(0x3)
 description()
 Hw Capabilities: 0xb
 trunk vsans (up) (1)
 .
 .
 trunk vsans (isolated) (99)
 TE port per vsan information
 fc2/29, Vsan 1 - state(up), state reason(None), fcid(0x690202)
   port init flag(0x38000), current state [TE_FSM_ST_E_PORT_UP]
 fc2/29, Vsan 99 - state(down), state reason(Isolation due to zone merge failure),
   fcid(0x000000)
   port init flag(0x0), current state [TE_FSM_ST_ISOLATED_VSAN_MISMATCH]
```

From this output, you can see the VSAN is isolated because of a zone merge failure.

Step 5 Do one of the following to resolve the isolation problem:

- Change the membership of one of the zones to match the other zone of the same name. See the “Resolving Host and Storage Not in the Same Zone Using Fabric Manager” section on page 14-6.
- Discard one of the zone sets completely by deactivating it using the `no zoneset activate` command. If a VSAN does not have an active zone set, it automatically takes the active zone set of the other merging switch. See the “Deactivating a Zone Set and Restarting the Zone Merge Process Using the CLI” section on page 14-20.
- Overwrite the active zone set on one switch using the `import` or `export` commands. This method is destructive to one of the active zone sets.

```
zoneset import interface interface-number vsan vsan-id
zoneset export interface interface-number vsan vsan-id
```

Step 6 Use the `show interface fcx/y trunk vsan-id` command to verify that VSAN 99 is no longer isolated:

```
Switch1# show interface fc1/5 trunk vsan 99
fc1/5 is trunking
   Vsan 99 is up, FCID is 0x780102
```
Deactivating a Zone Set and Restarting the Zone Merge Process Using Fabric Manager

To deactivate a zone set and restart the zone merge process using Fabric Manager, follow these steps:

Step 1  Choose Zone > Deactivate Zone Set to deactivate the zone set configuration.

**Caution**  This will disrupt traffic and cause the MDS 9000 switch to lose connectivity with the network.

Step 2  Choose Interfaces > FC Physical and select down from the Status Admin drop-down menu to shut down the connection to the zone to be merged. You may see the following system messages:

```
Nov 19 10:26:10 switch4 %LOG_PORT-5-IF_DOWN_CHANNEL_ADMIN_DOWN: Interface fc1/14 is down
(Channel admin down)
Nov 19 10:26:10 switch4 %LOG_PORT-5-IF_DOWN_CHANNEL_ADMIN_DOWN: Interface fc1/15 is down
(Channel admin down)
Nov 19 10:26:10 switch4 %LOG_PORT-5-IF_DOWN_CHANNEL_ADMIN_DOWN: Interface fc1/16 is down
(Channel admin down)
Nov 19 10:26:10 switch4 %LOG_PORT-5-IF_DOWN_PORT_CHANNEL_MEMBERS_DOWN: Interface port-channel 1 is down (No operational members)
Nov 19 10:26:10 switch4 %LOG_PORT-5-IF_DOWN_ADMIN_DOWN: Interface port-channel 1 is down
(Administratively down)
Nov 19 10:26:10 switch4 %LOG_PORT_CHANNEL-5-FOP_CHANGED: port-channel 1: first operational port changed from fc1/16 to none
```

Step 3  Choose Interfaces > FC Physical and select up from the Status Admin drop-down menu to enable the connection to the zone to be merged. You may see the following system messages:

```
Nov 19 10:28:11 switch4 %LOG_PORT_CHANNEL-5-FOP_CHANGED: port-channel 1: first operational port changed from none to fc1/15
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_UP: Interface port-channel 1 is up in mode TE
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_TRUNK_UP: Interface fc1/14, vsan 1 is up
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_TRUNK_UP: Interface fc1/15, vsan 1 is up
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_TRUNK_UP: Interface fc1/16, vsan 1 is up
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_TRUNK_UP: Interface fc1/14, vsan 1 is up
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_TRUNK_UP: Interface fc1/15, vsan 1 is up
Nov 19 10:28:21 switch4 %LOG_PORT-5-IF_TRUNK_UP: Interface fc1/16, vsan 1 is up
```

Step 4  Choose Zone > Edit Local Full Zone Database to verify the active zone set configuration. After deactivating the zone set on the first switch and performing a shutdown followed by a no shutdown on the ISL that connects it to the second switch, the zone merge is processed again. Because the first switch has no active zone set, it learns the active zone set from the second switch during the zone merge process.

Deactivating a Zone Set and Restarting the Zone Merge Process Using the CLI

To deactivate a zone set and restart the zone merge process using the CLI, follow these steps:

Step 1  Use the `no zoneset activate name zoneset-name vsan-id` command to deactivate the zone set configuration from the switch:

**Caution**  This will disrupt traffic and cause the MDS 9000 switch to lose connectivity with the network.
Send documentation comments to mdsfeedback-doc@cisco.com

14-21
Cisco MDS 9000 Family Troubleshooting Guide, Release 3.x

Chapter 14 Troubleshooting Zones and Zone Sets

Enhanced Zoning Issues

Enhanced zoning uses a session locking facility like CFS to prevent simultaneous zoning configuration changes by two users on the same or separate switches. When a user starts to make a zoning change on one switch for a VSAN, that switch will lock the fabric to prevent others from making zoning changes. The user must issue a commit to make the changes active and release the fabric wide lock.

Step 2 Use the show zoneset active command to confirm that the zone set has been removed.

Step 3 Use the shut down command to shut down the connection to the zone to be merged.

Step 4 Use the no shutdown command to reactivate the connection to the zone to be merged:

Step 5 Use the show zoneset active vsan-id commands to exit configuration mode and check the active zone sets.

After deactivating the zone set on switch 4 and performing a shutdown followed by a no shutdown on the ISL that connects it to switch 3, the zone merge is processed again. Because switch 3 has no active zone set, it learns the active zone set from switch 4 during the zone merge process.
Problems can occur when the lock is acquired, but not released. In this situation, you cannot configure zoning on that VSAN. If you are using the CLI, you see error messages when you attempt to enter the zoning configuration mode.

Troubleshooting CLI commands to use for enhanced zoning issues:

- `show zone internal change event-history`
- `show zone status vsan`
- `show zone pending-diff`
- `show zone pending vsan`

**Symptom**: Cannot configure zoning.

**Table 14-3 Cannot Configure Zoning**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot configure zoning.</td>
<td>Another user on the same switch is holding the enhanced zoning configuration lock. If you are using the CLI, you see a message stating that another session is active.</td>
<td>See the “Resolving Enhanced Zoning Lock Issues with Fabric Manager” section on page 14-23 or the “Resolving Enhanced Zoning Lock Issues with the CLI” section on page 14-23.</td>
</tr>
<tr>
<td></td>
<td>Another user on a different switch is holding the enhanced zoning configuration lock. If you are using the CLI, you see a message stating that the lock is currently busy.</td>
<td></td>
</tr>
</tbody>
</table>
Resolving Enhanced Zoning Lock Issues with Fabric Manager

To resolve a lock failure using Fabric Manager, follow these steps:

Step 1  Choose Fabricxx > VSANxx and select the zone set that you want to configure.

Step 2  Select the Enhanced tab from the Information pane and view the Config DB Locked By column to determine which switch and which user holds the enhanced zoning lock for this VSAN.

Step 3  Check the Config DB Discard Changes check box and click Apply Changes to clear the enhanced zoning lock.

Note  Verify that no valid configuration change is in progress before you clear a lock.

Resolving Enhanced Zoning Lock Issues with the CLI

To resolve a lock issue using the CLI, follow these steps:

Step 1  Use the show zone status vsan command to determine the lock holder. If the lock holder is on this switch, the command output shows the user. If the lock holder is on a remote switch, the command output shows the domain ID of the remote switch.

switch# show zone status vsan 16

VSAN: 16 default-zone: deny distribute: active only Interop: default
   mode: enhanced merge-control: allow session: cli [admin]     user admin has lock
   hard-zoning: enabled

Step 2  Use the no zone commit vsan command on the switch that holds the lock to release the lock if you are the holder of the lock.

Step 3  Use the no zone commit vsan <vsan id> force command on the switch that holds the lock to release the lock if another user holds the lock.

Note  Verify that no valid configuration change is in progress before you clear a lock.

Step 4  If problems persist, use the clear zone lock command to remove the lock from the switch. This should only be done on the switch that holds the lock.
Troubleshooting Distributed Device Alias Services

This chapter describes how to troubleshoot and resolve problems that might occur when using device aliases. It includes the following sections:

- Overview, page 15-1
- Initial Troubleshooting Checklist, page 15-1
- Merge Failure Issues, page 15-4
- Validation and Commit Failure Issues, page 15-11

Overview

When you configure different features for a Cisco MDS 9000 Family switch, such as zoning, DPVM, or port security, you must specify the correct device name each time. An inaccurate device name can cause unexpected results. You can circumvent this problem by defining and using device aliases.

A device alias is a user-friendly name for a port WWN (pWWN) that can be used in all configuration commands as required. All switches in the Cisco MDS 9000 Family support Distributed Device Alias Services (device aliases).

Initial Troubleshooting Checklist

Device alias problems may result in merge, commit, or validation failures, and resolution requires gathering information about the specific failure and the fabric configuration. Begin troubleshooting device alias issues by checking the following items:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify the device alias mode (basic or enhanced).</td>
<td></td>
</tr>
<tr>
<td>Verify that device alias distribution is enabled.</td>
<td></td>
</tr>
<tr>
<td>Verify that the fabric is not locked.</td>
<td></td>
</tr>
</tbody>
</table>
Note

See the “System Messages” section on page 1-10 for more information about using system (syslog) messages for troubleshooting purposes.

This section also identifies some of the system messages that are issued when device alias problems are encountered, and it includes the following topics:

- Merge Failure Messages, page 15-2
- Merge Validation Failure Messages, page 15-2
- Commit Failure Messages, page 15-3
- Verifying Device Alias Database Status Using the CLI, page 15-3
- Limitations and Restrictions, page 15-3

### Merge Failure Messages

When a device alias merge fails, review the syslog messages on the switch where the merge was issued (the merge manager). In Example 15-1, the syslog messages indicate that the merge failed as a result of a database mismatch.

**Example 15-1 Merge Failure Syslog Messages**

```
2007 Apr  9 15:52:42 switch-1 %CFS-3-MERGE_FAILED: Merge failed for app device-alias, local switch wwn 20:00:00:0d:ec:2f:c1:40, ip 172.20.150.38, remote switch wwn 20:00:00:0d:ec:04:99:40, ip 172.20.150.30
2007 Apr  9 15:52:42 switch-1 %DEVICE-ALIAS-3-MERGE_FAILED: Databases could not be merged due to mismatch.
```

### Merge Validation Failure Messages

When a device alias database fails validation during the merge process, review the syslog messages on the switch managing the merge and on the switch where the validation was rejected. In Example 15-2, the syslog message indicates that the validation failed on switch sWNN 20:00:00:0d:ec:04:99:40. Example 15-3 shows the syslog message received on the switch that rejected the validation. Both messages indicate that the merge validation failed because the merge would result in the definition of the same zone member in multiple VSANs.

**Example 15-2 Message on Switch Managing the Merge**

```
2007 Apr 9 16:41:22 switch-1 %DEVICE-ALIAS-3-MERGE_VALIDATION_FAILED: Failed SWNN: 20:00:00:0d:ec:04:99:40 Failed SAP: 110 Reason: inter-VSAN zone member cannot be in more than one VSAN Expln:
```

**Example 15-3 Message on Switch Rejecting the Validation**

```
2007 Apr 10 00:00:06 switch-2 %DEVICE-ALIAS-3-MERGE_VALIDATION_REJECTED: Failed SAP: 110 Reason: inter-VSAN zone member cannot be in more than one VSAN Expln:
```
Commit Failure Messages

When a device alias commit fails, review the syslog messages for the switch where the command was issued. Example 15-4 shows that SAP 110 (IVR) failed validation on switch sWWN 20:00:00:0d:ec:04:99:40, which caused the commit to fail. Example 15-5 shows the failure message.

Example 15-4 Commit Validation Failure Message

2007 Apr 10 11:54:24 switch-1 %DEVICE-ALIAS-3-VALIDATION_FAILED: Failed SWWN: 20:00:00:0d:ec:04:99:40 Failed SAP: 110 Reason: inter-VSAN zone member cannot be in more than one VSAN

Expln:

Example 15-5 Commit Failure Message

2007 Apr 10 11:54:24 switch-1 %DEVICE-ALIAS-3-COMMIT_FAILED: Failed to commit the pending database: inter-VSAN zone member cannot be in more than one VSAN

Verifying Device Alias Database Status Using the CLI

Table 15-1 lists several commands that can be used to verify the device alias database status.

<table>
<thead>
<tr>
<th>CLI Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show cfs merge status name device-alias</td>
<td>Displays information about the status of the CFS merge for the device alias database.</td>
</tr>
<tr>
<td>show device-alias database</td>
<td>Displays the entire device alias database.</td>
</tr>
<tr>
<td>show device-alias internal validation info</td>
<td>Displays information about the status of the validation process (part of a commit or merge).</td>
</tr>
<tr>
<td>show device-alias merge status</td>
<td>Displays the result of the device alias merge operation, and the reason for the result.</td>
</tr>
<tr>
<td>show device-alias session status</td>
<td>Returns the status of the last CFS command, such as clear, commit or abort. The last action result and reason fields help identify the reason for a failure.</td>
</tr>
<tr>
<td>show device-alias status</td>
<td>Displays configuration information for the device alias service, including whether fabric distribution is enabled, the number of device aliases in the database, lock information, and the database mode (basic or enhanced).</td>
</tr>
</tbody>
</table>

Limitations and Restrictions

The following limitations and restrictions are associated with the use of device aliases:

- Enhanced mode operation is only supported on switches running SAN-OS Release 3.1(1) or later.
- Interop mode VSANs do not accept enhanced mode (native alias-based) configurations.
When merging device alias databases, the combined number of device aliases in both databases cannot exceed 8K (8191 device aliases) in fabrics running SAN-OS Release 3.0(x) and earlier, and 20K in fabrics running SAN-OS Release 3.1(x) and later.

If the combined number of device entries exceeds the supported limit, then the merge will fail.

**Merge Failure Issues**

The most common device alias problems occur when merging databases. This section describes measures to take when a merge of two fabrics fails because the merge of the device alias databases fails. See Table 15-2.

**Symptom** Merge failed.

**Table 15-2 Device Alias Database Merge Fails**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge fails for device alias.</td>
<td>A device alias is configured with the same name but with a different pWWN on either side of the fabric.</td>
<td>Change the conflicting device alias name on one fabric. See the “Resolving Duplicate Device Alias Names” section on page 15-5.</td>
</tr>
<tr>
<td></td>
<td>The same pWWN is mapped to different device alias names on either side of the fabric.</td>
<td>Change the mapping so the pWWN is mapped to the same device alias name on both sides of the fabric. See the “Resolving Mapping a pWWN to Different Device Alias Names” section on page 15-6.</td>
</tr>
<tr>
<td></td>
<td>The device alias operation mode (basic or enhanced) is not the same for both fabrics.</td>
<td>Check the device alias mode. Both fabrics must be operating in the same device alias mode. See the “Resolving Mode Mismatch” section on page 15-6. Note Device alias enhanced mode is only supported on switches running SAN-OS Release 3.1(1) and later.</td>
</tr>
<tr>
<td></td>
<td>The size of the device alias database exceeds the limit supported by some switches in the fabric.</td>
<td>Upgrade the SAN-OS release for all switches to 3.1(1) or later. See the “Resolving Merge Failures in Mixed Fabric” section on page 15-7.</td>
</tr>
<tr>
<td></td>
<td>An application fails the validation of the merge database.</td>
<td>Analyze the problem from the application perspective and make the appropriate corrections. See the “Resolving a Validation Failure” section on page 15-8.</td>
</tr>
<tr>
<td>Merge remains in progress and does not complete.</td>
<td>A user is editing the application database.</td>
<td>Determine which application database is locked, and take the appropriate steps to unlock it. When the application database is unlocked, the merge should be automatically retried. See the “Resolving Merge in Progress Issues” section on page 15-9.</td>
</tr>
<tr>
<td></td>
<td>A user edited the application database and forgot to release the lock.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The application is busy handling its own merge.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The application database is locked due to a defect in the application.</td>
<td></td>
</tr>
</tbody>
</table>
Resolving Duplicate Device Alias Names

To verify that a duplicate device alias name exists in the fabrics, follow these steps:

**Step 1** Review the CFS or device alias merge failure syslogs to confirm that the merge failed. Optionally, you can issue the following CLI command to view the status of the merge:

```
switch-1# show cfs merge status name device-alias
  Local Fabric
  Switch WWN  IP Address
  -------------------------------
  20:00:00:0d:ec:2f:c1:40 172.20.150.38  [Merge Master] switch-1

  Remote Fabric
  Switch WWN  IP Address
  -------------------------------
  20:00:00:0d:ec:04:99:40 172.20.150.30  [Merge Master] switch-2

  Total number of switches = 1
```

**Step 2** Verify that the reason for the merge failure is a database mismatch by using the `show device-alias merge status` command.

```
switch-1# show device-alias merge status
  Result: Failure
  Reason: Databases could not be merged due to mismatch.
```

**Step 3** Identify the duplicate device alias name by using the `show device-alias database` command from the appropriate switch in each of the two fabrics. In this example, both databases have the same device alias, A1, mapped to different pWWNs.

```
switch-1# show device-alias database
  device-alias name A1 pwwn 21:01:01:01:01:01:01:01
  Total number of entries = 1

switch-2# show device-alias database
  device-alias name A1 pwwn 21:01:01:01:01:01:01:02
  Total number of entries = 1
```

**Step 4** Make the appropriate changes to the device alias database for one of the fabrics. Refer to the *Cisco MDS 9000 Family CLI Configuration Guide* for details.
Resolving Mapping a pWWN to Different Device Alias Names

To verify that the same pWWN is mapped to different device alias names in the fabrics, follow these steps:

**Step 1** Review the CFS or device alias merge failure syslogs to confirm that the merge failed. Optionally, you can issue the `show cfs merge status name device-alias` command to view the status of the merge.

**Step 2** Verify the reason for the merge failure by using the `show device-alias merge status` command.

```
switch-1# show device-alias merge status
Result: Failure
Reason: Another device-alias already present with the same pwwn.
```

**Step 3** Identify the pWWN that is mapped to two different device alias names by using the `show device-alias database` command from the appropriate switch in each of the fabrics. In this example, the pWWN 21:01:01:01:01:01:01:02 is mapped to device alias A3 on switch switch-1, and to device alias A1 on switch switch-2.

```
switch-1# show device-alias database
  device-alias name A3 pwwn 21:01:01:01:01:01:01:02
  Total number of entries = 1

switch-2# show device-alias database
  device-alias name A1 pwwn 21:01:01:01:01:01:01:02
  Total number of entries = 1
```

**Step 4** Make the appropriate changes to the device alias database for one of the fabrics. Refer to the *Cisco MDS 9000 Family CLI Configuration Guide* for details.

Resolving Mode Mismatch

The device alias feature can operate in either basic or enhanced mode. If the modes are different in the two fabrics, the CFS merge between those fabrics will fail.

To verify that the device alias mode is different in the two fabrics, follow these steps:

**Step 1** Review the CFS or device alias merge failure syslogs to confirm that the merge failed, or issue the `show cfs merge status name device-alias` command to view the status of the merge.

**Step 2** Verify that the reason for the merge failure is a mode mismatch by using the `show device-alias merge status` command. The reason is either “Databases could not be merged due to mode mismatch” or “One of the merging fabrics cannot support device-alias enhanced mode.”

```
switch-1# show device-alias merge status
Result: Failure
Reason: Databases could not be merged due to mode mismatch.
```

**Note** All switches in the fabric must be running SAN-OS Release 3.1(1) or later to support device alias enhanced mode operation.
Step 3 Verify the device alias mode for each of the fabrics by using the `show device-alias status` command. In this example, switch-1 is running in enhanced mode, while switch-2 is running in basic mode.

```bash
switch-1# show device-alias status
Fabric Distribution: Enabled
Database: - Device Aliases 2 Mode: Enhanced

switch-2# show device-alias status
Fabric Distribution: Enabled
Database: - Device Aliases 2 Mode: Basic
```

Step 4 Make the appropriate change to the device alias mode for one of the fabrics. Try doing a blank commit to change the mode. A blank commit occurs when you lock the fabric, but do not make any database definition changes, and then perform a commit. This results in the distribution of the effective database of the local switch to all other switches in the fabric. In this case, change the device alias mode only, and then commit that change.

Note If you need to change the device alias mode from enhanced to basic, and any application contains a device alias configuration in native format, the device alias mode cannot be changed until you explicitly remove all the native device alias configurations or replace all the device alias members with the corresponding pWWNs. Refer to the Cisco MDS 9000 Family CLI Configuration Guide for details.

---

**Resolving Merge Failures in Mixed Fabric**

A mixed fabric is a fabric consisting of switches running different software versions. Prior to SAN-OS Release 3.1(x), the limit for device aliases in a merged fabric was 8K. In Release 3.1(1) and later, this limit has been expanded to 20K. If you attempt to merge a fabric that includes switches running Release 3.0(x) or earlier with a fabric that includes switches running Release 3.1(x) or later, and the merged device alias database would exceed 8K, the merge will fail.

To verify that the mixed fabric merge is failing because of database size, follow these steps:

Step 1 Review the CFS or device alias merge failure syslogs to confirm that the merge failed, or issue the `show cfs merge status name device-alias` command to view the status of the merge.

```bash
switch-1# show cfs merge status name device-alias
Result: Failure
Reason: The merging fabrics have incompatible capabilities or configurations.
```

Step 2 Verify that the reason for the merge failure is incompatible capabilities or configurations by using the `show device-alias merge status` command.

```bash
switch-1# show device-alias merge status
Result: Failure
Reason: The merging fabrics have incompatible capabilities or configurations.
```

Step 3 Upgrade all switches in the problem fabric to SAN-OS Release 3.1(x) or later, and then attempt the merge again. Otherwise, if you must merge the fabrics, you will have to reduce the number of entries in the combined device alias database.
Resolving a Validation Failure

If the device alias databases can be merged without any conflicts, the resultant device alias database is validated with the registered applications on each switch in both fabrics being merged. If an application fails the validation of the merged database for any reason, the device alias merge fails.

To verify that the device alias database merge is failing because of an application validation failure, follow these steps:

**Step 1** Review the CFS or device alias merge failure syslogs to confirm that the merge failed, or issue the `show cfs merge status name device-alias` command to view the status of the merge.

**Step 2** Verify that the reason for the merge failure is an application validation failure by using the `show device-alias merge status` command.

```
switch-1# show device-alias merge status
Result: Failure
Reason: This is a non device-alias error.
```

**Step 3** Examine syslog messages. The syslog for the switch where the validation is rejected and the syslog for the switch managing the merge show relevant error messages.

**Example 15-6 Validation Rejection Syslog Message**

```
2007 Apr 10 00:00:06 switch-2 %DEVICE-ALIAS-3-MERGE_VALIDATION_REJECTED: Failed SAP: 110 Reason: inter-VSAN zone member cannot be in more than one VSAN
Expln:
```

**Example 15-7** shows a sample message on the switch where the validation is rejected.

**Example 15-7 Validation Failure Syslog Message**

```
2007 Apr 9 16:41:22 switch-1 %DEVICE-ALIAS-3-MERGE_VALIDATION_FAILED: Failed SWWN: 20:00:00:0d:ec:04:99:40 Failed SAP: 110 Reason: inter-VSAN zone member cannot be in more than one VSAN
Expln:
```

**Step 4** Examine the output of the `show device-alias internal validation-info` command, issued from the switch managing the merge. In this example, SAP 110 on switch 20:00:00:0d:ec:04:99:40 (switch-2) rejected the validation. The status message shows the reason for the failure, along with the system application (SAP) number.

```
switch-1# show device-alias internal validation-info
Validation timer: 0s
Per SAP Info Table:
====================
SAPS: 0

MTS Buffer Array Details:
========================
Buffers: 0

Local Status:
============
Num Reqs Sent: 0 20:00:00:0d:ec:04:99:40
Num SAPs Done: 0
Failed SAP : 0 Status: success
Expln:
```
Send documentation comments to mdsfeedback-doc@cisco.com

Remote Status:
================
CFS Resp Rcvd: TRUE
Failed SWWN: 20:00:00:0d:ec:04:99:40
SAP: 110 Status: inter-VSAN zone member cannot be in more than one VSAN <== Status

Expln:

Step 5 Find the application that has rejected the configuration by using the `show system internal mts sup sap number description` command on the switch that rejected the validation. In this example, the application that rejected the device-alias validation was the IVR process.

```
switch-2# show system internal mts sup sap 110 description
IVR-SAP
```

Step 6 Analyze the device alias validation failure. This process is dependent on the application that failed the validation, as well as the device alias database configuration.

In this example, IVR is failing the validation. To troubleshoot this problem, begin by reviewing the device alias databases that are being merged. Use the `show device-alias database` command from the switch managing the merge for each fabric.

```
switch-1# show device-alias database
device-alias name A1 pwwn 21:01:01:01:01:01:01:01
device-alias name A2 pwwn 21:01:01:01:01:01:01:02 => Pre-merge: A2 defined on switch-1
Total number of entries = 2

switch-2# show device-alias database
device-alias name A1 pwwn 21:01:01:01:01:01:01:01 => Pre-merge: A2 not defined on switch-2
Total number of entries = 1
```

Because IVR is enabled on switch-2, review the IVR zone set.

```
switch-2# show ivr zoneset
zoneset name s1
   zone name z1
      pwwn 21:01:01:01:01:01:01:02 vsan 1 autonomous-fabric-id 1
device-alias A2 vsan 2 autonomous-fabric-id 1
```

Prior to the database merge, device alias A2 is not defined on switch-2. Because of the merge between switch-1 and switch-2, device alias A2 becomes available on switch-2, and A2 is mapped to pWWN 21:01:01:01:01:01:02.

When this occurs, the device alias-based member A2 in the IVR zone z1 is resolved and mapped to pWWN 21:01:01:01:01:01:01:02, and is a member of VSAN 2. However, pWWN 21:01:01:01:01:01:01:02 is already a member of VSAN 1. The mapping that occurs because of the device alias merge makes the IVR configuration illegal; the same pWWN cannot be a member of multiple VSANs.

In this case, the pWWN in VSAN 2 is defined using the device alias (A2), while the member in VSAN 1 is defined using the actual pWWN. IVR detects this situation and rejects the device alias validation and the device alias merge fails.

---

**Resolving Merge in Progress Issues**

When a merge occurs, the merged device alias database is validated with the registered applications on each switch in both of the fabrics. During this process, an application database may be in a locked state. Common causes are listed in Table 15-2.
Chapter 15  Troubleshooting Distributed Device Alias Services

Send documentation comments to mdsfeedback-doc@cisco.com

Because the application is busy, it cannot validate the device alias database, and it returns a busy response to the device alias process. This information is propagated back to CFS. CFS then waits for the length of the defined retry time, and then automatically retries the device alias merge. During the defined retry time, the device alias merge status is shown as in progress. (See Example 15-8).

Example 15-8  Displaying Merge Status

```plaintext
switch-1# show cfs merge status na device-alias

Physical-fc  Merge Status: In Progress  ==> Status shows merge is still in progress

If the application lock is released within the defined CFS retry time, the device alias validation can be processed. Otherwise, the application returns a busy response to the process again, and CFS again waits for the length of the defined retry time before retrying the device alias validation again. This situation is repeated until the application lock is released.

This is not an uncommon situation. When the ISL comes up between two fabrics, it typically triggers a CFS merge of multiple applications. By the time the device alias merge moves to validation stage, other applications may be busy handling their own merge. This is a transient state, and the device alias merge would be backed off and retired after the defined retry time.

If, for any reason, the application database remains locked, the device alias merge remains in progress and cannot complete.

To verify a locked application database and to determine how to proceed, follow these steps:

Step 1  Use the show cfs merge status na device-alias command to see the merge status.

```plaintext
switch-1# show cfs merge status na device-alias

Physical-fc  Merge Status: In Progress  ==> The merge status shows in progress

Local Fabric

Switch WWN              IP Address
20:00:00:0d:ec:2f:c1:40 172.20.150.38        [Merge Master]

Total number of switches = 1

Remote Fabric

Switch WWN              IP Address
20:00:00:0d:ec:04:99:40 172.20.150.30        [Merge Master]

Total number of switches = 1

Step 2  Obtain more information about the progress of the merge by using the show device-alias internal validation-info command. In the following example, SAP 110 (IVR) on SWWN 20:00:00:0d:ec:04:99:40 (switch-2) has rejected the validation. The explanation indicates that the IVR application has rejected the validation because it is busy.

```plaintext
switch-1# show device-alias internal validation-info

Validation timer:    0s

Per SAP Info Table:

SAPS: 0

MTS Buffer Array Details:
```
buffers: 0

local status:

- num reqs sent: 0
- num saps done: 0
- failed sap: 0  status: success  expln:

remote status:

- cfs resp rcvd: true
- failed swwn: 20:00:00:0d:ec:04:99:40 ==> switch switch-2
- sap: 110  status: some of the registered modules are busy handling other requests. please retry the command after some time.
- expln: there is a pending action. check ivr status

step 3

get a clear picture of the ivr status by using the show cfs lock command from the switch-2 switch. in this example, the ivr database is locked by the user admin, and the device alias merge remains in progress.

switch-2# show cfs lock

application: ivr
scope : physical-fc

switch wwn   ip address       user name  user type
------------- ----------------------------------------
20:00:00:0d:ec:04:99:40 172.20.150.30 admin  cli/snmp v3

switch-2

total number of entries = 1

application: device-alias
scope : physical-fc

switch wwn   ip address       user name  user type
------------- ----------------------------------------
20:00:00:0d:ec:2f:c1:40 172.20.150.38 cfs  merge

total number of entries = 1

step 4

resolve the problem by unlocking the application database. in this example, when the user admin completes the edits and commits the changes, or otherwise unlocks the ivr database (via an ivr abort or ivr clear command), the device alias merge validation will proceed.

validation and commit failure issues

after making changes to the device alias database, you must issue a commit command to commit the changes. the commit process includes validation of the database change by all registered applications on all switches in the fabric. this section identifies the common problems that may cause validation and commit failures. see table 15-3.
**Symptom**  Commit or configuration failed.

### Table 15-3  Device Alias Database Commit Fails

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commit fails due to a validation failure</td>
<td>The device alias database conflicts with the application configuration.</td>
<td>Tune the device alias database or the application configuration to eliminate the conflict. See the “Resolving Database Conflicts” section on page 15-12.</td>
</tr>
<tr>
<td></td>
<td>The application is busy.</td>
<td>Verify that the application that failed the validation is no longer busy, and then retry the commit. See the “Resolving Application Busy Situations” section on page 15-13.</td>
</tr>
<tr>
<td>Commit or configuration fails.</td>
<td>The size of the device alias database exceeds the supported limit.</td>
<td>Reduce the number of entries in the device alias database, or upgrade the SAN-OS release for all switches to Release 3.1(1) or later. See the “Resolving Database Size Issues” section on page 15-14.</td>
</tr>
<tr>
<td></td>
<td>Enhanced mode is not supported on some switches in the mixed fabric.</td>
<td>Upgrade the SAN-OS release for all switches in the fabric to Release 3.1(1) or later, or change the device alias mode to basic. See the “Resolving Mode Issues” section on page 15-15.</td>
</tr>
</tbody>
</table>

### Resolving Database Conflicts

If an entry in the device alias database conflicts with the configuration of a registered application, the device alias database commit fails the validation process. You must either correct the device alias database or the application configuration.

To determine the application that failed the validation and the reason for the failure, follow these steps:

**Step 1**  View the output from the device-alias commit command. In this example, the commit fails because there is a conflict between the device alias database and an application configuration.

```
switch-1(config)# device-alias commit
inter-VSAN zone member cannot be in more than one VSAN => reason for commit failure
```

**Step 2**  Determine which application configuration is in conflict with the device alias database by reviewing the syslogs for the switch where the commit was issued. In this example, SAP 110 (IVR) on sWWN 20:00:00:0d:ec:04:99:40 (switch-2) has rejected the validation and therefore the device alias commit is failed.

```
2007 Apr 10 11:54:24 switch-1 %DEVICE-ALIAS-3-VALIDATION_FAILED: Failed =>Validation Status
SWWN: 20:00:00:0d:ec:04:99:40 Failed SAP: 110 Reason: inter-VSAN zone =>Switch and SAP
member cannot be in more than one VSAN Expln:

2007 Apr 10 11:54:24 switch-1 %DEVICE-ALIAS-3-COMMIT_FAILED: Failed to =>Commit status
commit the pending database: inter-VSAN zone member cannot be in more =>Reason
than one VSAN
```

**Step 3**  Review the syslog on the switch where the validation is rejected. In this example, the following syslog is printed on the switch switch-2:

```
2007 Apr 10 19:13:08 switch-2 %DEVICE-ALIAS-3-VALIDATION_REJECTED: Failed
SAP: 110 Reason: inter-VSAN zone member cannot be in more than one VSAN =>SAP and reason
Expln:
```
Step 4 Compare the existing device alias database (including the desired changes) and the application configuration to find the conflict.

This example uses the `show device-alias database` and `show ivr zoneset` commands, along with the console logs of the device alias database changes made prior to the commit. The comparison shows that the definition of the new device alias A2 would result in the resolution of enhanced device alias member A2 in IVR zone z1 to pWWN 21:01:01:01:01:01:01:02, which is already a member of zone z1. The pWWN is directly defined as a member of VSAN 1, while the enhanced device alias A2 is defined as a member of VSAN 2. This configuration is not allowed in IVR. IVR detects the configuration problem and rejects the device alias database validation.

```
switch-1# show device-alias database                  ===> existing device alias database
device-alias name A1 pwwn 21:01:01:01:01:01:01:01
Total number of entries = 1

switch-2# show ivr zoneset                           ===> display existing IVR zone set
zoneset name s1
zone name z1
  pwwn 21:01:01:01:01:01:01:02  vsan    1 autonomous-fabric-id  1
device-alias A2               vsan    2 autonomous-fabric-id  1

switch-1# conf t
Enter configuration commands, one per line. End with CNTL/Z.
switch-1(config)# device-alias database
switch-1(config-device-alias-db)# device-alias name A2 pwwn 21:01:01:01:01:01:01:02
switch-1(config-device-alias-db)# exit
switch-1(config)# device-alias commit
inter-VSAN zone member cannot be in more than one VSAN
```

Step 5 Correct the conflict by making adjustments to the application configuration, or by making changes to the device alias database, and then issuing the commit command again.

---

Resolving Application Busy Situations

A device alias commit can fail because an application is busy and cannot perform the requested validation. If that occurs, the device alias CFS lock is not released and the pending database contents remain unchanged. When the application is no longer busy, retry the commit request.

Example 15-9 shows the console output that occurs when an application busy situation causes the commit to fail.

**Example 15-9 Application Busy Console Output**

```
switch-2(config)# device-alias commit
Some of the registered modules are busy handling other requests. Please retry the command after some time.
```

Review the sylogs (Example 15-10) and use the `show device-alias` commands (Example 15-11) to gather additional details about the application that returned busy.

**Example 15-10 Application Busy Syslog Message**

```
2007 Apr 10 02:30:55 switch-2 %DEVICE-ALIAS-3-VALIDATIONFAILED: Failed SAP: Status
110 Reason: Some of the registered modules are busy handling other requests. Reason
Please retry the command after some time. Resolution
```
Validation and Commit Failure Issues

Check ivr status.

Example 15-11 show device-alias Command Output

switch-2# show device-alias internal validation-info
Validation timer: 0s

Per SAP Info Table:

SAPS: 2
  SAP: 18 Num Resp Rcvd: 1
  SAP: 110 Num Resp Rcvd: 1

MTS Buffer Array Details:

Buffers: 0

Local Status:

Num Reqs Sent: 1
Num SAPs Done: 2
Failed SAP: 110 Status: Some of the registered modules are busy => Status and reason handling other requests. Please retry the command after some time.
Explain: there is a pending action. Check ivr status

Remote Status:

CFS Resp Rcvd: FALSE
Failed SWWN: 00:00:00:00:00:00:00:00 SAP: 0 Status: success

The failed SAP in Example 15-11 is 110 (IVR). Unless the IVR lock is released, you cannot commit the device alias database changes.

Resolving Database Size Issues

The maximum size of the device alias database increased from 8K to 20K for switches running SAN-OS Release 3.1(1) or later. If the fabric includes switches running SAN-OS Release 3.0(x) or earlier and switches running Release 3.1(1) or later, the maximum size of the device alias database is limited to 8K. This is the limit imposed on the switches running Release 3.0(x) or earlier. Unless all of the switches are upgraded to Release 3.1(1) or later, you cannot configure more than 8K device aliases.

If you attempt to configure or commit a device alias database that exceeds the maximum size supported in the fabric, the configuration or the commit will fail. Example 15-12 shows the commit failure and Example 15-13 shows the configuration failure.

Example 15-12 Commit Failure Due to Database Size Limits

switch-1(config)# device-alias commit
Some of the switches in the fabric are running a version of software which cannot support either the issued command or maximum device-alias limits. Please fix those switches and retry the command.
Example 15-13 Configuration Failed Due to Database Size Limits

switch-1(config)# device-alias name test8193 pwn 21:01:01:01:01:01:01:01
Some of the switches in the fabric are running a version of software which cannot support either the issued command or maximum device-alias limits. Please fix those switches and retry the command.

Resolving Mode Issues

Device alias enhanced mode is available in switches running SAN-OS Release 3.1(1) and later. In a mixed fabric (a fabric that includes switches running Release 3.1(1) and switches running Release 3.0(x) or earlier), an attempt to enable device alias enhanced mode fails. Unless all of the switches in the fabric can be upgraded to Release 3.1(1) or later, you cannot enable device alias enhanced mode.

If you attempt to enable enhanced mode in a successfully merged mixed fabric, or to commit a device alias database that enables enhanced mode to resolve a merge failure in a mixed fabric, the configuration or the commit will fail. Example 15-14 shows the commit failure and Example 15-15 shows the configuration failure.

Example 15-14 Commit Failure Due to Mode Conflicts

switch-1(config)# device-alias commit
Some of the switches in the fabric are running a version of software which cannot support either the issued command or maximum device-alias limits. Please fix those switches and retry the command.

Example 15-15 Configuration Failure Due to Mode Conflicts

switch-1(config)# device-alias mode enhanced
Some of the switches in the fabric are running a version of software which cannot support enhanced mode. Please fix those switches and retry the command.
Send documentation comments to mdsfeedback-doc@cisco.com
Troubleshooting FICON

Fibre Connection (FICON) interface capabilities enhance the Cisco MDS 9000 Family by supporting both open systems and mainframe storage network environments. Inclusion of Control Unit Port (CUP) support further enhances the MDS offering by allowing in-band management of the switch from FICON processors.

This chapter includes the following sections:
- FICON Overview, page 16-1
- FICON Configuration Requirements, page 16-6
- Initial Troubleshooting Checklist, page 16-7
- FICON Issues, page 16-9

FICON Overview

The Cisco MDS 9000 Family supports the Fibre Channel, FICON, iSCSI, and FCIP capabilities within a single, high-availability platform. Fibre Channel and FICON are different FC4 protocols and their traffic are independent of each other. If required, devices using these protocols can be isolated using VSANs. The Cisco SAN-OS FICON feature supports high-availability, scalability, and SAN extension technologies including VSANs, IVR, FCIP, and PortChannels.

Tip
When you create a mixed environment, place all FICON devices in one VSAN (other than the default VSAN) and segregate the FCP switch ports in a separate VSAN (other than the default VSAN). This isolation ensures proper communication for all connected devices.

You can implement FICON on the following switches:
- Any switch in the Cisco MDS 9500 Series.
- Any switch in the Cisco MDS 9200 Series (including the Cisco MDS 9222i Multiservice Modular Switch).
- Cisco MDS 9134 Multilayer Fabric Switch.
- MDS 9000 Family 18/4-Port Multiservice Module.
**Note**

The FICON feature is not supported on Cisco MDS 9120, 9124 or 9140 switches, the 32-port Fibre Channel switching module, Cisco Fabric Switch for HP c-Class BladeSystem or Cisco Fabric Switch for IBM BladeCenter.

Refer to the Cisco MDS 9000 Family configuration guides for details about configuring FICON at one of the following websites:


**FICON Port Numbering**

With reference to the FICON feature, ports in Cisco MDS switches are identified by a statically defined 8-bit value known as the *port number*. A maximum of 255 port numbers are available. You can use the following port numbering schemes:

- Default port numbers based on the chassis type
- Reserved port numbers

The following guidelines apply to FICON port numbers:

- Supervisor modules do not have port number assignments.
- Chassis-wide unique port numbers should be reserved for trunking expansion (TE) ports since TE ports appear in multiple VSANs.
- Each PortChannel must be explicitly associated with a FICON port number.
- For individual ports in a PortChannel, the configuration of the port corresponding to the PortChannel is applied and not that of the individual port.
- Each FCIP tunnel must be explicitly associated with a FICON port number. If the port numbers are not assigned for PortChannels or for FCIP tunnels, the associated ports will not come online.

**Note**

When you assign, change, or release a port number, the port goes offline and then back online as a result of the change.

**Default FICON Port Numbering Scheme**

Default FICON port numbers are assigned by the Cisco MDS SAN-OS software based on the module and the slot in the chassis. The first port in a switch always starts with a zero (0).

Table 16-1 lists the default port number assignments for the Cisco MDS 9000 Family of switches and directors.
## Table 16-1  Default FICON Port Numbering in the Cisco MDS 9000 Family

<table>
<thead>
<tr>
<th>Product</th>
<th>Slot Number</th>
<th>Implemented Port Allocation To Ports</th>
<th>Implemented Port Allocation To PortChannel/FCIP</th>
<th>Unimplemented Ports</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco MDS 9200 Series</td>
<td>Slot 1</td>
<td>0 through 31</td>
<td>64 through 89</td>
<td>90 through 253 and port 255</td>
<td>Similar to a switching module.</td>
</tr>
<tr>
<td></td>
<td>Slot 2</td>
<td>32 through 63</td>
<td></td>
<td></td>
<td>The first 4, 12, 16, or 24 port numbers are used in a 4-port, 12-port, 16-port, or 24-port module, and the rest remain unused. Extra 16 ports on 48-port modules are not allocated port numbers.</td>
</tr>
<tr>
<td>Cisco MDS 9222i Series</td>
<td>Slot 1</td>
<td>0 through 31</td>
<td>64 through 89</td>
<td>90 through 253 and port 255</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 2</td>
<td>32 through 63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco MDS 9506 Director</td>
<td>Slot 1</td>
<td>0 through 31</td>
<td>128 through 153</td>
<td>154 through 253 and port 255</td>
<td>Supervisor modules are not allocated port numbers.</td>
</tr>
<tr>
<td></td>
<td>Slot 2</td>
<td>32 through 63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 3</td>
<td>64 through 95</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 4</td>
<td>96 through 127</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 5</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 6</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco MDS 9134 Director</td>
<td>Slot 1</td>
<td>0 through 33</td>
<td>34 through 59</td>
<td>60 through 253 and port 255</td>
<td></td>
</tr>
<tr>
<td>Cisco MDS 9509 Director</td>
<td>Slot 1</td>
<td>0 through 31</td>
<td>224 through 249</td>
<td>250 through 253 and port 255</td>
<td>The first 4, 12, 16, or 24 port numbers are used in a 4-port, 12-port, 16-port, or 24-port module, and the rest remain unused. Extra 16 ports on 48-port modules are not allocated port numbers.</td>
</tr>
<tr>
<td></td>
<td>Slot 2</td>
<td>32 through 63</td>
<td></td>
<td></td>
<td>Supervisor modules are not allocated port numbers.</td>
</tr>
<tr>
<td></td>
<td>Slot 3</td>
<td>64 through 95</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 4</td>
<td>96 through 127</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 5</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 6</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 7</td>
<td>128 through 159</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 8</td>
<td>160 through 191</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 9</td>
<td>192 through 223</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
FICON Overview

You can use the `ficon slot assign port-numbers` CLI command to use any excess ports by assigning numbers to the slots. Before you assign numbers to the slots however, we recommend that you review the default port number assignments for Cisco MDS 9000 switches shown in Table 16-1.

Only Fibre Channel, PortChannel, and FCIP ports are mapped to FICON port numbers. Other types of interfaces do not have corresponding port numbers.

### Reserved FICON Port Numbering Scheme

A range of 250 port numbers are available for you to assign to all the ports on a switch. Table 16-1 shows that you can have more than 250 physical ports on a switch and the excess ports do not have port numbers in the default numbering scheme. When you have more than 250 physical ports on your switch, you can have ports without port number assigned if they are not in a FICON VSAN, or you can assign duplicate port numbers if they are not used in the same FICON VSAN. For example, you can configure port number 1 on interface fc1/1 in FICON VSAN 10 and fc10/1 in FICON VSAN 20.

A VSAN can have a maximum of 250 port numbers.

FICON port numbers are not changed for ports that are active. You must first disable the interfaces using the `shutdown` CLI command.

### Table 16-1 Default FICON Port Numbering in the Cisco MDS 9000 Family (continued)

<table>
<thead>
<tr>
<th>Product</th>
<th>Slot Number</th>
<th>Implemented Port Allocation To Ports</th>
<th>Unimplemented Ports To PortChannel/FCIP</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco MDS 9513 Director</td>
<td>Slot 1</td>
<td>0 through 15</td>
<td>224 through 249</td>
<td>The first 4, 12 or 16 port numbers are used for a 4-port, 12-port or 16-port model, and the rest remain unused. Extra ports on 24-port, 32-port, and 48-port modules are not allocated port numbers.</td>
</tr>
<tr>
<td></td>
<td>Slot 2</td>
<td>16 through 31</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 3</td>
<td>32 through 47</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 4</td>
<td>48 through 63</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 5</td>
<td>64 through 79</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 6</td>
<td>80 through 95</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 7</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 8</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 9</td>
<td>96 through 111</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 10</td>
<td>112 through 127</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 11</td>
<td>128 through 143</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 12</td>
<td>144 through 159</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 13</td>
<td>160 through 175</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 2</td>
<td>16 through 31</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 3</td>
<td>32 through 47</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 4</td>
<td>48 through 63</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 5</td>
<td>64 through 79</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 6</td>
<td>80 through 95</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 7</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 8</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 9</td>
<td>96 through 111</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 10</td>
<td>112 through 127</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 11</td>
<td>128 through 143</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 12</td>
<td>144 through 159</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slot 13</td>
<td>160 through 175</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Send documentation comments to mdsfeedback-doc@cisco.com


**FICON Configuration Files**

You can save up to 16 FICON configuration files on each FICON-enabled VSAN (in persistent storage). The file format is proprietary to IBM. These files can be read and written by IBM hosts using the in-band CUP protocol. Additionally, you can use the Cisco MDS CLI or Fabric Manager applications to modify these FICON configuration files. When you enable the FICON feature in a VSAN, the switches always use the startup FICON configuration file, called IPL. This file is created with a default configuration immediately after FICON is enabled in a VSAN.

Multiple FICON configuration files with the same name can exist in the same switch, provided they reside in different VSANs. For example, you can create a configuration file named XYZ in both VSAN 1 and VSAN 3.

**Caution**

When FICON is disabled on a VSAN, all FICON configuration files are irretrievably lost.

FICON configuration files contain the following configuration options for each implemented port address:

- Block
- Prohibit mask
- Port address name

**Tip**

You cannot prohibit a PortChannel or an FCIP interface.

**Note**

If an interface is already configured in E or TE mode and you try to prohibit that port, your prohibit configuration is rejected. Similarly, if a port is not up and you prohibit that port, the port is not allowed to come up in E mode nor in TE mode.

**Note**

You can not directly assign a FICON port number to an interface. You assign a range of port numbers to the module.
CUP In-Band Management

The Control Unit Port (CUP) protocol configures access control and provides unified storage management capabilities from a mainframe computer. Cisco MDS 9000 FICON-enabled switches are fully IBM CUP standard compliant for in-band management using the IBM S/A OS/390 I/O operations console.

Note
The CUP specification is proprietary to IBM.

CUP is supported by switches and directors in the Cisco MDS 9000 Family. The CUP function allows the mainframe to manage the Cisco MDS switches.
Host communication includes control functions, such as blocking and unblocking ports, as well as monitoring and error reporting functions.

Note
You cannot block or prohibit the CUP port (0XFE).

Fabric Binding

The fabric binding feature ensures that ISLs are enabled only between specified switches in the fabric binding configuration. Fabric binding is configured on a per-VSAN basis.
This feature helps prevent unauthorized switches from joining the fabric or disrupting current fabric operations. It uses the Exchange Fabric Membership Data (EFMD) protocol to ensure that the list of authorized switches is identical in all switches in the fabric.
To enforce fabric binding, configure the switch world wide name (sWWN) to specify the xE port connection for each switch. Fabric binding policies are enforced on every activation and also when the port tries to come up. In a FICON VSAN, the fabric binding feature requires that all sWWNs are connected to a switch and that their persistent domain IDs are part of the fabric binding active database. In a Fibre Channel VSAN, only the sWWN is required; the domain ID is optional.
Use the show wwn switch CLI command to determine the sWWN to use for fabric binding.
The fabric binding feature must be enabled in each switch in the fabric that participates in the fabric binding.

FICON Configuration Requirements

Use the following best practices for implementing FICON for Cisco SAN-OS products:
- Use static domain IDs for all switches in the FICON fabric.
- Do not enable persistent FC IDs for the FICON-enabled VSAN.
- Enable in-order delivery for the FICON-enabled VSAN.
- Enable fabric binding for all FICON switches in the fabric.
- Use the source ID (SID)-destination ID (DID) load balancing scheme for the FICON-enabled VSAN.
- Set the VSAN interop value to default.
Send documentation comments to mdsfeedback-doc@cisco.com

Limit cascaded FICON switches to two switches between the host and storage.

Use the CLI FICON setup script or the Fabric Manager VSAN Wizard to configure FICON.

You cannot enable IVR NAT in a FICON VSAN.

FICON VSANs can only be in the default interop mode.

## Initial Troubleshooting Checklist

Begin troubleshooting FICON issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See <em>Cisco MDS 9000 Family Fabric Manager Configuration Guide</em>.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you enabled in-order delivery for the FICON-enabled VSAN.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have enabled fabric binding in all switches in the FICON fabric.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that all switches in the FICON fabric are in the fabric binding database.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have assigned static domain IDs for all switches in the FICON fabric.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have not enabled persistent FC IDs for the FICON-enabled VSAN.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the load balancing scheme is SID-DID.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the default zone is set to permit if you are not using the zoning feature.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the CUP (area FE) is in the correct zone if you are using zoning.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that conflicting persistent FC IDs do not exist in the switch.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the configured domain ID and requested domain ID match.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Chapter 16  Troubleshooting FICON

Common Troubleshooting Tools in Fabric Manager or Device Manager

Use the following procedures to troubleshoot FICON issues:

- Choose Fabric\textsubscript{xx} > VSAN\textsubscript{yy} > FICON in Fabric Manager to view the FICON configuration.
- Choose Fabric\textsubscript{xx} > VSAN\textsubscript{yy} > Fabric Binding in Fabric Manager to view the fabric binding configuration.
- Choose FICON > VSANs in Device Manager, and then highlight the FICON VSAN and click Director History to get a history of changes on this FICON VSAN.
- Choose Tools > Other > Flow Load Balance Calculator in Fabric Manager to determine the proper ISL configuration for FICON load balancing.
- Choose Device > Preferences > Label Physical Ports View With on Device Manager, check FICON, and click Apply to set the Device Manager display to use FICON port numbers.

Common Troubleshooting Commands in the CLI

Use the following CLI commands to troubleshoot FICON issues:

- `show ficon`
- `show ficon vsan vsan-id file ficon-file-name`
- `show ficon vsan vsan-id portaddress`
- `show ficon vsan vsan-id director-history`
- `show fabric-binding status`
- `show fabric-binding database`
- `show fabric-binding violations`
- `show in-order-guarantee`

Port Swapping

The FICON port swapping feature is only provided for maintenance purposes. Follow these guidelines when using the FICON port swapping feature:

- Port swapping is not supported for logical ports (PortChannels, FCIP links).
- Port swapping is not supported between physical ports that are part of a PortChannel.
- If the two ports involved in a port swap have incompatible configuration options, the port swap is rejected with an appropriate reason code. For example, if a port with BB\_credits as 25 is being swapped with an OSM port for which a maximum of 12 BB\_credits is allowed (not a configurable parameter), the port swapping operation is rejected.
Swapping Ports

To swap ports, except the port numbers, using the CLI, follow these steps:

Step 1  Issue the `ficon swap portnumber old-port-number new-port-number` command in EXEC mode.

**Note**  The `ficon swap portnumber` command might fail if more than one interface on the MDS switch has the same port number as the `old-port-number` or `new-port-number` specified in the command.

The specified ports are operationally shut down.

Step 2  Physically swap the front panel port cables between the two ports.

Step 3  Issue the `no shutdown` command on each port to enable traffic flow.

**Note**  If you specify the `ficon swap portnumber old-port-number new-port-number after swap noshut` command, the ports are automatically initialized.

---

To swap physical Fibre Channel ports, including the port numbers, using the CLI, follow these steps:

Step 1  Issue the `ficon swap interface old-interface new-interface` command in EXEC mode.

The specified interfaces are operationally shut down.

Step 2  Physically swap the front panel port cables between the two ports.

Step 3  Issue the `no shutdown` command on each port to enable traffic flow.

**Note**  If you specify the `ficon swap interface old-interface new-interface after swap noshut` command, the ports are automatically initialized.

---

FICON Issues

This section describes common FICON issues and includes the following topics:

- Cannot Enable FICON, page 16-10
- Switch ISL Isolated, page 16-10
- Fabric Manager or Device Manager Cannot Configure FICON, page 16-10
- Mainframe Cannot Configure FICON, page 16-11
- Cannot Enable FICON Port, page 16-11
- Cannot Configure FCIP or PortChannel for FICON, page 16-12
- FCIP fails for FICON, page 16-12
- FICON Tape Acceleration Not Working, page 16-12
Cannot Enable FICON

**Symptom** Cannot enable FICON.

<table>
<thead>
<tr>
<th>Table 16-2 Cannot Enable FICON</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Cannot enable FICON.</td>
</tr>
</tbody>
</table>

Switch ISL Isolated

**Symptom** Switch ISL is isolated.

<table>
<thead>
<tr>
<th>Table 16-3 Switch ISL Isolated</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Switch ISL is isolated.</td>
</tr>
</tbody>
</table>

Fabric Manager or Device Manager Cannot Configure FICON

**Symptom** Fabric Manager or Device Manager cannot configure FICON.

<table>
<thead>
<tr>
<th>Table 16-4 Fabric Manager or Device Manager Cannot Configure FICON</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Fabric Manager or Device Manager cannot configure FICON.</td>
</tr>
</tbody>
</table>
**Mainframe Cannot Configure FICON**

**Symptom** Mainframe cannot configure FICON.

<table>
<thead>
<tr>
<th>Table 16-5</th>
<th>Mainframe Cannot Control FICON</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>Mainframe cannot configure FICON.</td>
<td>Switch is configured to disallow Host control over FICON.</td>
</tr>
<tr>
<td></td>
<td>CUP is not in the correct zone.</td>
</tr>
</tbody>
</table>

**Cannot Enable FICON Port**

**Symptom** Cannot enable FICON port.

<table>
<thead>
<tr>
<th>Table 16-6</th>
<th>Cannot Enable FICON Port</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>Cannot enable FICON port.</td>
<td>Port is blocked.</td>
</tr>
<tr>
<td></td>
<td>TE or E port is prohibited.</td>
</tr>
<tr>
<td></td>
<td>Another port in the same VSAN has the same port number as this port.</td>
</tr>
</tbody>
</table>
FICON Issues

Cannot Configure FCIP or PortChannel for FICON

**Symptom** Cannot configure FCIP or PortChannel for FICON.

<table>
<thead>
<tr>
<th>Table 16-7 Cannot Configure FCIP or PortChannel for FICON</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Cannot configure FCIP or PortChannel for FICON.</td>
</tr>
</tbody>
</table>

FCIP fails for FICON

**Symptom** FCIP fails for FICON.

<table>
<thead>
<tr>
<th>Table 16-8 FCIP Fails for FICON</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>FCIP fails for FICON.</td>
</tr>
</tbody>
</table>

FICON Tape Acceleration Not Working

**Symptom** FICON tape acceleration not working.

<table>
<thead>
<tr>
<th>Table 16-9 FICON Tape Acceleration Not Working</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>FICON tape acceleration not working.</td>
</tr>
</tbody>
</table>
Troubleshooting RADIUS and TACACS+

The authentication, authorization, and accounting (AAA) mechanism verifies the identity of, grants access to, and tracks the actions of users managing a switch. All Cisco MDS 9000 Family switches use the Remote Access Dial-In User Service (RADIUS) and Terminal Access Controller Access Control System Plus (TACACS+) protocols to provide solutions using remote AAA servers.

This chapter includes the following sections:
- AAA Overview, page 17-1
- Initial Troubleshooting Checklist, page 17-1
- AAA Issues, page 17-2
- Troubleshooting RADIUS and TACACS+ With Cisco ACS, page 17-11

AAA Overview

Based on the user ID and password combination provided, switches perform local authentication or authorization using the local database or remote authentication or authorization using AAA server(s). A preshared secret key provides security for communication between the switch and AAA server(s). This secret key can be configured as a global key for all AAA servers or on a per AAA server basis. This security mechanism provides a central management capability for AAA servers.

Note

Users authenticated through a remote AAA server cannot create jobs using the command scheduler.

Initial Troubleshooting Checklist

Begin troubleshooting AAA issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the test aaa server CLI command to verify connectivity to your AAA server.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have assigned appropriate attributes on your AAA server for user roles.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the preshared key is the same on both the switch and the AAA server.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have no all-numeric users or passwords configured.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Common Troubleshooting Tools in Fabric Manager

Use the following Fabric Manager procedures to troubleshoot AAA issues:

- Choose **Switches > Security > AAA > RADIUS** to view the RADIUS configuration.
- Choose **Switches > Security > AAA > TACACS+** to view the TACACS+ configuration.
- Choose **Switches > Security > AAA** to view server group and AAA monitor deadtime values.

Common Troubleshooting Commands in the CLI

Use the following CLI commands to troubleshoot AAA issues:

- `show aaa authentication`
- `show user-account`
- `show radius status`
- `show radius-server`
- `show tacacs+ status`
- `show tacacs-server`

Use the following **debug** commands to determine the root cause of an issue:

- `debug radius aaa-request`
- `debug radius aaa-request-lowlevel`
- `debug tacacs+ aaa-request and`
- `debug tacacs+ aaa-request-lowlevel`

AAA Issues

This section describes common AAA issues and includes the following topics:

- **Switch Does Not Communicate with AAA Server**, page 17-2
- **User Authentication Fails**, page 17-8
- **User Is Not in Any Configured Role**, page 17-10
- **User Cannot Access Certain Features**, page 17-11

Switch Does Not Communicate with AAA Server

Multiple misconfigurations can result in an AAA server that the Cisco SAN-OS switch does not communicate with.
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Switch does not communicate with AAA server. | Incorrect authentication or accounting port configured. | Reconfigure the authentication or accounting ports to match those configured on the AAA server.  
For RADIUS servers, see the “Verifying RADIUS Configuration Using Fabric Manager” section on page 17-4 or the “Verifying RADIUS Configuration Using the CLI” section on page 17-4.  
For TACACS+ servers, see the “Verifying TACACS+ Configuration Using Fabric Manager” section on page 17-5 or the “Verifying TACACS+ Configuration Using the CLI” section on page 17-5. |
| Incorrect preshared key configured. | Reconfigure the same preshared key on the switch and the AAA server.  
For RADIUS servers, see the “Verifying RADIUS Configuration Using Fabric Manager” section on page 17-4 or the “Verifying RADIUS Configuration Using the CLI” section on page 17-4.  
For TACACS+ servers, see the “Verifying TACACS+ Configuration Using Fabric Manager” section on page 17-5 or the “Verifying TACACS+ Configuration Using the CLI” section on page 17-5. |
| AAA server monitor deadtime set to high. | Set the deadtime lower to bring AAA servers active more quickly.  
For RADIUS servers, see the “Verifying RADIUS Server Monitor Configuration Using Fabric Manager” section on page 17-6 or the “Verifying RADIUS Server Monitor Configuration Using the CLI” section on page 17-6.  
For TACACS+ servers, see the “Verifying TACACS+ Server Monitor Configuration Using Fabric Manager” section on page 17-7 or the “Verifying TACACS+ Server Monitor Configuration Using the CLI” section on page 17-7. |
| Timeout value too low. | Change server timeout value to ten seconds or higher.  
For RADIUS servers, see the “Verifying RADIUS Server Monitor Configuration Using Fabric Manager” section on page 17-6 or the “Verifying RADIUS Server Monitor Configuration Using the CLI” section on page 17-6.  
For TACACS+ servers, see the “Verifying TACACS+ Server Monitor Configuration Using Fabric Manager” section on page 17-7 or the “Verifying TACACS+ Server Monitor Configuration Using the CLI” section on page 17-7. |
Verifying RADIUS Configuration Using Fabric Manager

To verify or change the RADIUS configuration using Fabric Manager, follow these steps:

1. Choose **Switches > Security > AAA > RADIUS** and select the **Servers** tab. You see the RADIUS configuration in the Information pane.
2. Highlight the server that you need to change and click **Delete Row** to delete this server configuration.
3. Click **Create Row** to add a new RADIUS server.
4. Set the **KeyType** and **Key** fields to the preshared key configured on the RADIUS server.
5. Set the **AuthPort** and **AcctPort** fields to the authentication and accounting ports configured on the RADIUS server.
6. Set the **TimeOut** value and click **Apply** to save these changes.
7. Select the **CFS** tab and select **commit** from the Config Action drop-down menu and click **Apply Changes** to distribute these changes to all switches in the fabric.

Verifying RADIUS Configuration Using the CLI

To verify or change the RADIUS configuration using the CLI, follow these steps:

1. Use the **show radius-server** command to display configured RADIUS parameters.
   
   switch# show radius-server
   
   Global RADIUS shared secret:******
   retransmission count:5
   timeout value:10
   following RADIUS servers are configured:
   myradius.cisco.users.com:
     available for authentication on port:1812
     available for accounting on port:1813
   10.1.1.1:
     available for authentication on port:1812
     available for accounting on port:1813
     RADIUS shared secret:******
   10.2.2.3:
     available for authentication on port:1812
     available for accounting on port:1813
     RADIUS shared secret:******

2. Use the **radius-server host ip-address key** command to set the preshared key to match what is configured on your RADIUS server.
3. Use the **radius-server host ip-address auth-port** command to set the authentication port to match what is configured on your RADIUS server.
4. Use the **radius-server host ip-address acc-port** command to set the accounting port to match what is configured on your RADIUS server.
5. Use the **radius-server timeout** command to set the period in seconds for the switch to wait for a response from all RADIUS servers before the switch declares a timeout failure.
6. Use the **radius commit** command to commit any changes and distribute to all switches in the fabric.
Verifying TACACS+ Configuration Using Fabric Manager

To verify or change the TACACS+ configuration using Fabric Manager, follow these steps:

Step 1  Choose Switches > Security > AAA > TACACS+ and select the Servers tab. You see the TACACS+ configuration in the Information panel.

Step 2  Highlight the server that you need to change and click Delete Row to delete this server configuration.

Step 3  Click Create Row to add a new TACACS+ server.

Step 4  Set the KeyType and Key fields to the preshared key configured on the TACACS+ server.

Step 5  Set the AuthPort and AcctPort fields to the authentication and accounting ports configured on the TACACS+ server.

Step 6  Set the TimeOut value and click Apply to save these changes.

Step 7  Select the CFS tab and select commit from the Config Action drop-down menu and click Apply Changes to distribute these changes to all switches in the fabric.

Verifying TACACS+ Configuration Using the CLI

To verify or change the TACACS+ configuration using the CLI, follow these steps:

Step 1  Use the show tacacs-server command to display configured TACACS+ parameters.

switch# show tacacs-server
Global TACACS+ shared secret:*********
timeout value:30
total number of servers:3

following TACACS+ servers are configured:
  11.5.4.3:
    available on port:2
  cisco.com:
    available on port:49
  11.6.5.4:
    available on port:49
  TACACS+ shared secret:*****

Step 2  Use the tacacs-server host ip-address key command to set the preshared key to match what is configured on your TACACS+ server.

Step 3  Use the tacacs-server host ip-address port command to set the communications port to match what is configured on your TACACS+ server.

Step 4  Use the tacacs-server timeout command to set the period in seconds for the switch to wait for a response from all TACACS+ servers before the switch declares a timeout failure.

Step 5  Use the tacacs commit command to commit any changes and distribute to all switches in the fabric.
Verifying RADIUS Server Monitor Configuration Using Fabric Manager

To verify or change the RADIUS server monitor configuration using Fabric Manager, follow these steps:

1. Choose **Switches > Security > AAA > RADIUS** and select the **Servers** tab. You see the RADIUS configuration in the Information panel.
2. Highlight the server that you need to change and click **Delete Row** to delete this server configuration.
3. Click **Create Row** to add a new RADIUS server.
4. Set the **KeyType** and **Key** fields to the preshared key configured on the RADIUS server.
5. Set the **AuthPort** and **AcctPort** fields to the authentication and accounting ports configured on the RADIUS server.
6. Set the **Idle Time** to configure the time that the switch waits for a RADIUS server to be idle before sending a test message to see if the server is still alive.
7. Set the **TimeOut** value and click **Apply** to save these changes.
8. Select the **CFS** tab and select **commit** from the Config Action drop-down menu and click **Apply Changes** to distribute these changes to all switches in the fabric.
9. Choose **Switches > Security > AAA** and click **Create Row** to create a server group.
10. Check the list of switches that you want to configure server groups on.
11. Set the **Server List** field to a comma-separated list of RADIUS servers.
12. Set the **Deadtime** field to configure the time that the switch waits before retesting a dead server. and click **Apply** to save these changes.

Verifying RADIUS Server Monitor Configuration Using the CLI

To verify or change the RADIUS server monitor configuration using the CLI, follow these steps:

1. Use the **show running-config** command to view the RADIUS configuration for the server monitor.
   ```
   switch# show running-config | begin radius
   radius-server deadtime 40
   radius-server host 10.1.1.1 key 7 "VagwttFjq" authentication accounting timeout 20
   retransmit 5
   radius-server host 10.1.1.1 test idle-time 30
   ```
2. Use the **radius-server host ip address test idle-time** command to configure the time that the switch waits for a RADIUS server to be idle before sending a test message to see if the server is still alive.
3. Use the **radius-server deadtime** command to configure the time that the switch waits before retesting a dead server.
4. Use the **radius commit** command to commit any changes and distribute to all switches in the fabric.
Verifying TACACS+ Server Monitor Configuration Using Fabric Manager

To verify or change the TACACS+ server monitor configuration using Fabric Manager, follow these steps:

- **Step 1**: Choose **Switches > Security > AAA > TACACS+** and select the **Servers** tab. You see the TACACS+ configuration in the Information panel.
- **Step 2**: Highlight the server that you need to change and click **Delete Row** to delete this server configuration.
- **Step 3**: Click **Create Row** to add a new TACACS+ server.
- **Step 4**: Set the **KeyType** and **Key** fields to the preshared key configured on the TACACS+ server.
- **Step 5**: Set the **AuthPort** and **AcctPort** fields to the authentication and accounting ports configured on the TACACS+ server.
- **Step 6**: Set the **Idle Time** field to configure the time that the switch waits for a TACACS+ server to be idle before sending a test message to see if the server is still alive.
- **Step 7**: Set the **Timeout** value and click **Apply** to save these changes.
- **Step 8**: Select the **CFS** tab and select **commit** from the Config Action drop-down menu and click **Apply Changes** to distribute these changes to all switches in the fabric.
- **Step 9**: Choose **Switches > Security > AAA** and click **Create Row** to create a server group.
- **Step 10**: Check the list of switches that you want to configure server groups on.
- **Step 11**: Set the **Server List** field to a comma-separated list of TACACS+ servers.
- **Step 12**: Set the **Deadtime** field to configure the time that the switch waits before retesting a dead server. and click **Apply** to save these changes.

Verifying TACACS+ Server Monitor Configuration Using the CLI

To verify or change the TACACS+ server monitor configuration using the CLI, follow these steps:

- **Step 1**: Use the **show running-config** command to view the TACACS+ configuration for the server monitor.
  
  ```
  switch# show running-config | begin tacacs
  tacacs-server deadtime 40
  tacacs-server host 11.6.5.4 key 7 "VagwwtFjq"
  tacacs-server host 11.6.5.4 test idle-time 30
  ```

- **Step 2**: Use the **tacacs-server host ip address test idle-time** command to configure the time that the switch waits for a TACACS+ server to be idle before sending a test message to see if the server is still alive.

- **Step 3**: Use the **tacacs-server deadtime** command to configure the time that the switch waits before retesting a dead server.

- **Step 4**: Use the **tacacs commit** command to commit any changes and distribute to all switches in the fabric.
# AAA Issues

*Send documentation comments to mdsfeedback-doc@cisco.com*

## User Authentication Fails

**Symptom**  
User authentication fails.

### Table 17-2  
**User Authentication Fails**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User authentication fails.</td>
<td>Incorrect AAA method configured.</td>
<td>Verify that the AAA method configured lists the appropriate RADIUS or TACACS+ server-group as the first one.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For RADIUS servers, see the “Verifying RADIUS Configuration Using Fabric Manager” section on page 17-4 or the “Verifying RADIUS Configuration Using the CLI” section on page 17-4.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For TACACS+ servers, see the “Verifying TACACS+ Configuration Using Fabric Manager” section on page 17-5 or the “Verifying TACACS+ Configuration Using the CLI” section on page 17-5.</td>
</tr>
<tr>
<td>Incorrect authentication port configured or incorrect server timeout value.</td>
<td>Reconfigure the authentication port to match those configured on the AAA server or set a higher timeout value.</td>
<td>For RADIUS servers, see the “Verifying RADIUS Configuration Using Fabric Manager” section on page 17-4 or the “Verifying RADIUS Configuration Using the CLI” section on page 17-4.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For TACACS+ servers, see the “Verifying TACACS+ Configuration Using Fabric Manager” section on page 17-5 or the “Verifying TACACS+ Configuration Using the CLI” section on page 17-5.</td>
</tr>
<tr>
<td>User not configured on the AAA server.</td>
<td>Add the user name, password, and role to the AAA server. Refer to your server documentation.</td>
<td></td>
</tr>
<tr>
<td>AAA server not configured in the server group.</td>
<td>Add the appropriate AAA server to the configured server group.</td>
<td>For RADIUS servers, see the “Verifying RADIUS Server Groups Using Fabric Manager” section on page 17-9 or the “Verifying RADIUS Server Groups Using the CLI” section on page 17-9.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For TACACS+ servers, see the “Verifying TACACS+ Server Groups Using Fabric Manager” section on page 17-9 or the “Verifying TACACS+ Server Groups Using the CLI” section on page 17-10.</td>
</tr>
</tbody>
</table>
Verifying RADIUS Server Groups Using Fabric Manager

To verify or change the RADIUS server groups using Fabric Manager, follow these steps:

Step 1 Choose **Switches > Security > AAA** and click **Create Row** to create a server group.
Step 2 Check the list of switches that you want to configure server groups on.
Step 3 Set the Server List field to a comma-separated list of RADIUS servers.
Step 4 Set the Deadtime field to configure the time that the switch waits before retesting a dead server. and click **Apply** to save these changes.

Verifying RADIUS Server Groups Using the CLI

To verify or change the RADIUS server groups using the CLI, follow these steps:

Step 1 Use the **show running-config** command to view the RADIUS configuration for the server groups.

```
switch# show running-config | begin aaa
aaa group server radius RadiusGroup
 server 10.1.1.1
 server 10.2.3.4

aaa group server tacacs TacacsGroup
 server 11.5.4.3
 server 11.6.5.4
```

Step 2 Use the **aaa group server radius** command to configure the RADIUS servers that you want in this server group.

**Note** CFS does not distribute AAA server groups. You must copy this configuration to all relevant switches in the fabric.

Verifying TACACS+ Server Groups Using Fabric Manager

To verify or change the TACACS+ server groups using Fabric Manager, follow these steps:

Step 1 Choose **Switches > Security > AAA** and click **Create Row** to create a server group.
Step 2 Check the list of switches that you want to configure server groups on.
Step 3 Set the Server List field to a comma-separated list of TACACS+ servers.
Step 4 Set the Deadtime field to configure the time that the switch waits before retesting a dead server. and click **Apply** to save these changes.
Verifying TACACS+ Server Groups Using the CLI

To verify or change the TACACS+ server groups using the CLI, follow these steps:

Step 1 Use the `show running-config` command to view the TACACS+ configuration for the server groups.

```
switch# show running-config | begin aaa
aaa group server radius RadiusGroup
  server 10.1.1.1
  server 10.2.3.4

aaa group server tacacs TacacsGroup
  server 11.5.4.5
  server 11.6.5.4
```

Step 2 Use the `aaa group server tacacs` command to configure the TACACS+ servers that you want in this server group.

**Note** CFS does not distribute AAA server groups. You must copy this configuration to all relevant switches in the fabric.

Table 17-3 User Is Not In Any Configured Role

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User is not in any configured role.</td>
<td>User configuration on AAA server does not have role attributes set.</td>
<td>For RADIUS, configure the vendor-specific attributes on the server for the role using: <code>Cisco-AVPair = shell:roles=&quot;rolename1 rolename2&quot;</code>. For TACACS+, configure the attribute and value pair on the server for the role using: <code>roles=&quot;rolename1 rolename2&quot;</code>. Verify that all roles are defined on the switch.</td>
</tr>
</tbody>
</table>
User Cannot Access Certain Features

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User cannot access certain features.</td>
<td>User is assigned incorrect role.</td>
<td>For RADIUS, configure the vendor-specific attributes on the server for the role using: Cisco-AVPair = shell:roles=&quot;rolename1 rolename2&quot;. For TACACS+, configure the attribute/value pair on the server for the role using: roles=&quot;rolename1 rolename2&quot;. Verify that all roles are defined on the switch.</td>
</tr>
<tr>
<td>Role is not configured for appropriate access.</td>
<td>See Chapter 18, “Troubleshooting Users and Roles.”</td>
<td></td>
</tr>
</tbody>
</table>

Table 17-4  User Cannot Access Certain Features

Troubleshooting RADIUS and TACACS+ With Cisco ACS

To troubleshoot RADIUS and TACACS+ issues with Cisco ACS, follow these steps:

**Step 1** Choose Network Configuration using Cisco ACS and view the AAA Clients table to verify that the Cisco SAN-OS switch is configured as an AAA client on Cisco ACS.

**Step 2** Choose User Setup > User Data Configuration to verify that the user is configured.

**Step 3** View the Cisco IOS/PIX RADIUS Attributes setting for a user. Verify that the user is assigned the correct roles in the AV-pairs. For example, shell:roles="network-admin".

**Note** The Cisco IOS/PIX RADIUS Attributes field is case-sensitive. Verify that the role listed in the AV-pair exists on the Cisco SAN-OS switch.

**Step 4** If the Cisco IOS/PIX RADIUS Attributes field is not present, follow these steps:

a. Choose Interface > RADIUS (Cisco IOS/PIX).

b. Check the User and Group check boxes for the cisco-av-pair option and click Submit.

c. Choose User Setup > User Data Configuration and add the AV-pair to assign the correct role to each user.

**Step 5** Choose System Configuration > Logging to activate logs to look for reasons for failed authentication attempts.

**Step 6** Choose Reports and Activity to view the resulting logs.

**Step 7** On the Cisco SAN-OS switch, use the show radius-server command to verify that the RADIUS server timeout value is set to 5 seconds or greater.
Refer to the *User guide for Cisco Secure ACS* at the following website for more information:

Troubleshooting Users and Roles

This chapter describes procedures used to troubleshoot users and roles created and maintained in the Cisco MDS 9000 Family Switch products. It includes the following sections:

- **Overview, page 18-1**
- **Initial Troubleshooting Checklist, page 18-4**
- **User and Role Issues, page 18-4**
- **Troubleshooting Users and Roles with Cisco ACS, page 18-12**

**Overview**

The CLI and SNMP use common roles in all switches in the Cisco MDS 9000 Family. You can use the CLI to modify a role that was created using SNMP and vice versa. A user configured through the CLI can access the switch using SNMP (for example, Fabric Manager or Device Manager) and vice versa.

**User Accounts**

Every Cisco MDS 9000 Family switch user has the account information stored by the system. You can add up to 256 users to a switch. The authentication information, user name, user password, password expiration date, and role membership are stored in the user profile.

The most important aspect of a user is creating a strong password. Weak passwords are not accepted by Cisco SAN-OS, whether you try to configure them locally or attempt authentication using an AAA server.

A strong password has the following characteristics:

- Contains at least eight characters.
- Does not contain many consecutive characters (such as “abcd”).
- Does not contain many repeating characters (such as “aaabbb”).
- Does not contain dictionary words.
- Does not contain proper names.
- Contains both uppercase and lowercase characters.
- Contains numbers.

The following examples show strong passwords:
Overview

If a password is trivial (short, easy-to-decipher), your password configuration is rejected. Passwords are case-sensitive. The default password for any Cisco MDS 9000 Family switch is no longer “admin”. You must explicitly configure a strong password.

Note
Clear text passwords can only contain alphanumeric characters. Special characters such as the dollar sign ($) or the percent sign (%) are not allowed.

Tip
The following words are reserved and cannot be used to configure users: bin, daemon, adm, lp, sync, shutdown, halt, mail, news, uucp, operator, games, gopher, ftp, nobody, nscd, mailnull, rpc, rpcuser, xfs, gdm, mtsuser, ftpuser, man, and sys.

Caution
Cisco MDS SAN-OS does not support all numeric user names, whether created with TACACS+ or RADIUS, or created locally. Local users with all numeric names cannot be created. If an all numeric user name exists on an AAA server and is entered during login, the user is not logged in.

Role-Based Authorization

Switches in the Cisco MDS 9000 Family perform authentication based on roles. Role-based authorization limits access to switch operations by assigning users to roles. This kind of authentication restricts users to management operations based on the roles to which they have been assigned the user.

When you execute a command, perform command completion, or obtain context sensitive help, the switch software allows the operation to progress if you have permission to access that switch operation.

Each role can be assigned to multiple users and each user can be part of multiple roles. If a user has multiple roles, the user has access to a combination of roles. For example, if role1 users are only allowed access to configuration commands, and role2 users are only allowed access to debug commands, then if Joe belongs to both role1 and role2, he can access configuration as well as debug commands.

Note
If a user belongs to multiple roles, the user can execute a union of all the commands permitted by these roles. Access to a command takes priority over being denied access to a command. For example, suppose you belong to a TechDocs group and you were denied access to configuration commands. However, you also belong to the engineering group and have access to configuration commands. In this case, you will have access to configuration commands.

Tip
Any role, when created, does not allow user access to the required commands immediately. The administrator must configure appropriate rules for each role to allow user access to the required commands.
Rules and Features for Each Role

Up to 16 rules can be configured for each role. The user-specified rule number determines the order in which the rules are applied. For example, rule 1 is applied before rule 2, which is applied before rule 3, and so on. A user not belonging to the network-admin role cannot perform commands related to roles.

For example, if user A is permitted to perform all `show` commands, user A cannot view the output of the `show role` command if user A does not belong to the network-admin role.

The `rule` command specifies operations that can be performed by a specific role. Each rule consists of a rule number, a rule type (permit or deny), a command type (for example, `config`, `clear`, `show`, `exec`, `debug`), and an optional feature name (for example, FSPF, zone, VSAN, fcping, or interface).

---

**Note**

In this case, `exec` commands refer to all commands in the EXEC mode that do not fall in the `show`, `debug`, and `clear` categories.

The order of rule placement is important. For example, the first rule permits user access to all `config` commands and the next rule denies FSPF configuration to the user. As a result, the user can perform all `config` commands except `fspf` configuration commands.

---

**Note**

If you had swapped these two rules and issued the `deny config feature fspf` rule first and issued the `permit config` rule next, you would be allowing the user to perform all configuration commands because the second rule globally overrode the first rule.
Initial Troubleshooting Checklist

Begin troubleshooting user and role issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See Cisco MDS 9000 Family Fabric Manager Configuration Guide.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the passwords for all users follow the guidelines for strong passwords.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that no usernames are reserved words or all numeric.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that users with multiple roles are not assigned more access than planned.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have not assigned any empty roles to users.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify the order of the rules in each role.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

In Fabric Manager, choose **Switches > Security > Users and Roles** to access user and role configuration.

In Device Manager, use the following procedures to access user, role, and rule configurations:

- Choose **Security > Users** to access user configuration.
- Choose **Security > Roles** to access user configuration.
- Select a role from the Roles dialog box and click **Rules** to access the rules for this role.

*Note*

Rules can only be configured from Device Manager.

Common Troubleshooting Commands in the CLI

Use the following CLI commands to troubleshoot user and role issues:

- `show users`
- `show user-account`
- `show role`
- `show role status`
- `show role session status`

User and Role Issues

This section describes troubleshooting user and role issues and includes the following topics:

- **User Cannot Log into Switch**, page 18-5
- **User Cannot Create Roles**, page 18-7
- **User Cannot Create Other Users With Fabric Manager or Device Manager**, page 18-7
User Cannot Log into Switch

**Symptom**  User cannot log into the switch.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User cannot log into the switch</td>
<td>Weak password configured at the AAA server.</td>
<td>Create a stronger password. See the “User Accounts” section on page 18-1 for guidelines on strong passwords.</td>
</tr>
<tr>
<td></td>
<td>User name is a restricted word or all numeric.</td>
<td>Change your user name. See the “User Accounts” section on page 18-1 for guidelines on allowed user names.</td>
</tr>
<tr>
<td></td>
<td>User account has expired.</td>
<td>Choose <strong>Switches &gt; Security &gt; Users</strong> in Fabric Manager to view the user account expiration date. Or use the <strong>show user-account</strong> CLI command to verify the account expiration. Recreate the user if necessary.</td>
</tr>
</tbody>
</table>

Verifying User Login with System Messages Using Device Manager

To configure the switch logging to capture system messages when a user attempts to log into a switch, follow these messages:

**Step 1** Choose **Logs > Syslog > Setup** and select the **Severity Levels** tab.

**Step 2** Select **debug** from the Severity Level drop-down menu for auth, authPriv, and aaad. Click **Apply**. This sets the switch to log debug information for these facilities.
Select the **Switch Logging** tab, select **debug** from the LogFileMsgSeverity radio buttons, and click **Apply**.

This sets the switch to save system messages at the debug level or above in the switch log file. At this point, all future login attempts are tracked in the log file.

After a login attempt, choose **Logs > Switch Resident > Syslogs > Since Reboot, and** click **Last Page** to view the most recent messages. You should see messages such as:

```plaintext
2006 Mar  2 22:08:44 v_190 %AUTHPRIV-6-SYSTEM_MSG: START: telnet pid=10654 from=:ffff:161.44.67.125
2006 Mar  3 03:08:49 v_190 %AUTHPRIV-7-SYSTEM_MSG: Got user name <testUser>
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: user testUser authenticated
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: PAM login: updating snmpv3 USM for user testUser
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: PAM login: snmpv3 attribute value (null)
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: PAM login: updating snmpv3 USM success for user testUser
2006 Mar  3 03:08:53 v_190 %AUTH-6-SYSTEM_MSG: (login) session opened for user testUser by (uid=0)
2006 Mar  3 03:08:53 v_190 %AAA-6-AAA_ACCOUNTING_MESSAGE: start:/dev/pts/1_161.4.67.125:testUser:
```

**Verifying User Login with System Messages Using the CLI**

To configure the switch logging to capture system messages when a user attempts to log into a switch, follow these messages:

**Step 1** Use the **logging level** command to change the level to 7 (debug) for auth, authPriv, and aaad.

```
switch(config)# logging level aaa 7
```

This sets the switch to log debug information for these facilities.

**Step 2** Use the **logging logfile** command to set the logging level to 7 (debug) for system messages saved to the named log file.

```
switch(config)# logging logfile TestFile 7
```

This sets the switch to save system messages at the debug level or above in the TestFile log file. At this point, all future login attempts are tracked in the log file.
Step 3

After a login attempt, use the `show logging logfile | last` command to view the most recent messages. You should see messages such as:

```
2006 Mar  2 22:08:44 v_190 %AUTHPRIV-6-SYSTEM_MSG: START: telnet pid=10654 from=:ffff:161.44.67.125
2006 Mar  3 03:08:49 v_190 %AUTHPRIV-7-SYSTEM_MSG: Got user name <testUser>
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: user testUser authenticated
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: PAM login: updating snmpv3 US M for user testUser
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: PAM login: snmpv3 attribute value (null)
2006 Mar  3 03:08:53 v_190 %AUTHPRIV-7-SYSTEM_MSG: PAM login: updating snmpv3 US M success for user testUser
2006 Mar  3 03:08:53 v_190 %AUTH-6-SYSTEM_MSG: (login) session opened for user testFoo by (uid=0)
2006 Mar  3 03:08:53 v_190 %AAA-6-AAA_ACCOUNTING_MESSAGE: start:/dev/pts/1_161.44.67.125:testUser:
```

### User Cannot Create Roles

**Symptom**  
User cannot create roles.

**Table 18-2  User Cannot Create Roles**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User cannot create roles.</td>
<td>User not assigned network-admin role.</td>
<td>Assign network-admin role to the user. See the “Verifying Roles Using Device Manager” section on page 18-8 or the “Verifying Roles Using the CLI” section on page 18-9.</td>
</tr>
</tbody>
</table>

### User Cannot Create Other Users With Fabric Manager or Device Manager

**Symptom**  
User cannot create other users with Fabric Manager or Device Manager.

**Table 18-3  User Cannot Create Other Users with Fabric Manager or Device Manager**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| User cannot create other users. | User is not logged into Fabric Manager or Device Manager with a privacy password. | Log into Fabric Manager or Device Manager with a password and a privacy password. A privacy password is required to manage users via the GUI.  
**Note**  
If you have logged in as a network-admin using MDS authentication, Device Manager and Fabric Manager automatically provide the appropriate encryption for this task, even if you did not specify a specific privacy password. |
User and Role Issues

User Cannot Access Certain Features

Symptom User cannot access certain features.

| Table 18-4  User Cannot Access Certain Features |
|-----------------|-----------------|-----------------|
| Symptom | Possible Cause | Solution |
| User cannot access certain features. | User is assigned incorrect role. | For RADIUS, configure the vendor-specific attributes on the server for the role using Cisco-AVPair = "shell:roles = "<rolename>" ". For TACACS+, configure the attribute and value pair on the server for the role using roles="vsan-admin storage-admin". See the “Verifying Roles Using Device Manager” section on page 18-8 or the “Verifying Roles Using the CLI” section on page 18-9. |
| Role is not configured for appropriate access. | | See the “Verifying Roles Using Device Manager” section on page 18-8 or the “Verifying Roles Using the CLI” section on page 18-9. |

Verifying Roles Using Device Manager

To verify user role-based access using Device Manager, follow these steps:

**Step 1** Choose Security > Users... to view the roles assigned to the user.

**Step 2** Right-click a user and click Delete to delete the user.

**Step 3** Click Create to create a user. You see the Create User dialog box.

**Step 4** Set the username and password fields.

**Step 5** Check the role check boxes for each role that you want to assign to the user and click Create to create the user.

**Step 6** Choose Security > Roles... to view the roles.

**Step 7** Right-click a role and select Rules to view or modify the rules assigned to a role.

**Step 8** Check the feature check boxes for the features that you want this role to access and click Apply to save these changes.
Verifying Roles Using the CLI

To verify user role-based access using the CLI, follow these steps:

**Step 1**  Use the `show user-account` command to view the roles assigned to the user.

```
switch# show user-account user1
user:user1
   this user account has no expiry date
   roles: sangroup vsan-admin
   no password set. local login not allowed
   Remote login through RADIUS is possible
```

**Step 2**  Use the `username` command to modify the roles assigned to a user.

```
switch# no username user1 role vsan-admin
```

**Step 3**  Use the `show role` command to view the rules assigned to the role.

```
switch# show role sangroup
Role: sangroup
   Description: SAN management group
   vsan policy: permit

   Rule     Type   Command-type   Feature
   -----------------------------------------
   1.   permit config *
   2.     deny config fspf
   3.   permit debug zone
   4.   permit exec fcping
```

**Step 4**  Use the `role` command to modify the rules assigned to a role.

```
switch# role name sangroup
switch(config-role)# no rule 4
switch(config-role)# rule 4 deny exec feature fcping
```
User Has Too Much Access

Symptom  User has too much access.

Table 18-5  User Has Too Much Access

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User has too much access.</td>
<td>User is assigned incorrect role or overlapping roles.</td>
<td>For RADIUS, configure the vendor-specific attributes on the server for the role using <code>Cisco-AVPair = &quot;shell:roles = &quot;&lt;rolename&gt;&quot;.&quot;</code>. For TACACS+, configure the attribute and value pair on the server for the role using <code>roles=&quot;vsan-admin storage-admin&quot;</code>. See the “Verifying Roles Using Device Manager” section on page 18-8 or the “Verifying Roles Using the CLI” section on page 18-9.</td>
</tr>
<tr>
<td>Role is not configured for appropriate access.</td>
<td></td>
<td>See the “Verifying Roles Using Device Manager” section on page 18-8 or the “Verifying Roles Using the CLI” section on page 18-9.</td>
</tr>
</tbody>
</table>

User Cannot Configure Some VSANs

Symptom  User cannot configure some VSANs.

Table 18-6  User Cannot Configure Some VSANs

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User cannot configure some VSANs.</td>
<td>User is assigned a VSAN-restricted role.</td>
<td>See the “Verifying VSAN-Restricted Roles Using Fabric Manager” section on page 18-10 or the “Verifying VSAN-Restricted Roles Using the CLI” section on page 18-11.</td>
</tr>
</tbody>
</table>

Verifying VSAN-Restricted Roles Using Fabric Manager

To verify user role-based access using Fabric Manager, follow these steps:

**Step 1**  Choose **Switches > Security > Users and Roles** and select the **Roles** tab to view the roles.

**Step 2**  Check the **Scope Enable** check box to make the role VSAN-restricted.

**Step 3**  Add the range of VSANs that you want to allow this role to configure in the **Scope VSAN Id List** field.
Verifying VSAN-Restricted Roles Using the CLI

To verify user role-based access using the CLI, follow these steps:

Step 1 Use the `show user-account` command to view the roles assigned to the user.

```
switch# show user-account user1
user:user1
  this user account has no expiry date
  roles:sangroup vsan-admin
no password set. local login not allowed
Remote login through RADIUS is possible
```

Step 2 Use the `show role` command to view the rules assigned to the role.

```
switch# show role sangroup
Role: sangroup
  Description: SAN management group
  vsan policy: deny
  Permitted vsans: 10-30

---------------------------------------------
  Rule   Type    Command-type      Feature
---------------------------------------------
  1.   permit    config                   *
  2.     deny    config                fspf
  3.   permit      debug                zone
  4.   permit      exec              fcping
```

Step 3 Use the `role` command to modify the VSAN policy for a role.

```
switch# role name sangroup
switch(config-role)# vsan policy deny
switch(config-role)# permit vsan 1 - 30
```

User Cannot Configure E Ports

**Symptom** User cannot configure E ports.

<table>
<thead>
<tr>
<th>Table 18-7 User Cannot Configure E Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>User cannot configure E ports.</td>
</tr>
</tbody>
</table>
Troubleshooting Users and Roles with Cisco ACS

To troubleshoot user and role issues with Cisco ACS, follow these steps:

**Step 1** Choose **Network Configuration** using Cisco ACS and view the AAA Clients table to verify that the Cisco SAN-OS switch is configured as an AAA client on Cisco ACS.

**Step 2** Choose **User Setup > User Data Configuration** to verify that the user is configured.

**Step 3** View the Cisco IOS/PIX RADIUS Attributes setting for a user. Verify that the user is assigned the correct roles in the AV-pairs. For example, `shell:roles="network-admin"`.

**Note** The Cisco IOS/PIX RADIUS Attributes field is case-sensitive. Verify that the role listed in the AV-pair exists on the Cisco SAN-OS switch.

**Step 4** If the Cisco IOS/PIX RADIUS Attributes field is not present, follow these steps:

- a. Choose **Interface > RADIUS (Cisco IOS/PIX)**.
- b. Check the **User** and **Group** check boxes for the cisco-av-pair option and click **Submit**.
- c. Choose **User Setup > User Data Configuration** and add the AV-pair to assign the correct role to each user.

**Step 5** Choose **System Configuration > Logging** to activate logs to look for reasons for failed authentication attempts.

**Step 6** Choose **Reports and Activity** to view the resulting logs.

**Step 7** On the Cisco SAN-OS switch, use the `show radius-server` command to verify that the RADIUS server timeout value is set to 5 seconds or greater.

Refer to the *User guide for Cisco Secure ACS* at the following website for more information:


---

**Unexpected User Displayed in Logs**

**Symptom** Unexpected user displayed in logs.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unexpected user displayed in logs.</td>
<td>Temporary user created by SNMP, Fabric Manager, or Device Manager.</td>
<td>Temporary users are created by Fabric Manager, Device Manager, or other applications using SNMP. This is normal behavior. These temporary users have a one hour expiration time. If you have an unexpected user with different characteristics, you should investigate that user or use the <code>clear user</code> CLI command to terminate that user session.</td>
</tr>
</tbody>
</table>

---

Send documentation comments to mdsfeedback-doc@cisco.com
This chapter describes procedures used to troubleshoot Fibre Channel Security Protocol (FC-SP), port security, and fabric binding in Cisco MDS 9000 Family products. It includes the following sections:

- FC-SP Overview, page 19-1
- Port Security Overview, page 19-2
- Fabric Binding Overview, page 19-2
- Initial Troubleshooting Checklist, page 19-2
- FC-SP Issues, page 19-4
- Port Security Issues, page 19-7
- Fabric Binding Issues, page 19-15

**FC-SP Overview**

FC-SP capabilities provide switch-switch and host-switch authentication to overcome security challenges for enterprise-wide fabrics. Diffie-Hellman Challenge Handshake Authentication Protocol (DHCHAP) is an FC-SP protocol that provides authentication between Cisco MDS 9000 Family switches and other devices. You can configure FC-SP to authenticate locally or to use a remote AAA server for authentication.
Port Security Overview

Typically, any Fibre Channel device in a SAN can attach to any SAN switch port and access SAN services based on zone membership. Port security features prevent unauthorized access to a switch port in the Cisco MDS 9000 Family:

- Login requests from unauthorized Fibre Channel devices (Nx ports) and switches (xE ports) are rejected.
- All intrusion attempts are reported to the SAN administrator through system messages.

Fabric Binding Overview

The fabric binding feature ensures ISLs are only enabled between specified switches in the fabric binding configuration. Fabric binding is configured on a per-VSAN basis.

This feature helps prevent unauthorized switches from joining the fabric or disrupting current fabric operations. It uses the Exchange Fabric Membership Data (EFMD) protocol to ensure that the list of authorized switches is identical in all switches in the fabric.

Domain IDs are mandatory for FICON-based fabric binding and optional for non-FICON based fabric binding. For non-FICON based fabric binding, not specifying a domain ID means that the switch with the matching WWN can login with any domain ID.

Initial Troubleshooting Checklist

Begin troubleshooting FC-SP issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See Cisco MDS 9000 Family Fabric Manager Configuration Guide.</td>
<td></td>
</tr>
<tr>
<td>Verify that your installed HBAs support FC-SP.</td>
<td></td>
</tr>
<tr>
<td>Verify that you have configured MD5 for the hash algorithm if you are authenticating through a RADIUS or TACACS+ server. RADIUS and TACACS+ always use MD5 for CHAP authentication. Using SHA-1 as the hash algorithm may prevent RADIUS and TACACS+ usage—even if these AAA protocols are enabled for DHCHAP authentication.</td>
<td></td>
</tr>
<tr>
<td>Verify that your AAA server is functioning properly.</td>
<td></td>
</tr>
</tbody>
</table>

Begin troubleshooting port security issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that you have the ENTERPRISE_PKG license installed on all switches.</td>
<td></td>
</tr>
<tr>
<td>Verify that port security is activated and that the end devices are present in the port security active database.</td>
<td></td>
</tr>
<tr>
<td>Verify that no unauthorized devices (host or switch) are connected to a port. (One unauthorized pWWN prevents the port from being active and blocks all other devices on that port.)</td>
<td></td>
</tr>
</tbody>
</table>
Begin troubleshooting fabric binding issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that you have the ENTERPRISE_PKG or the MAINFRAME_PKG license installed on all switches.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have activated fabric binding.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that all switches in the fabric have the same fabric binding database settings.</td>
<td>☐</td>
</tr>
</tbody>
</table>

**Common Troubleshooting Tools in Fabric Manager**

Use the following Fabric Manager procedure to troubleshoot FC-SP issues:

- **Switches > Security > FC-SP**

Use the following Fabric Manager procedure to troubleshoot port security issues:

- **Fabricxx > VSANxx > Port Security**

Use the following Fabric Manager procedure to troubleshoot fabric binding issues:

- **Fabricxx > VSANxx > Fabric Binding**

**Common Troubleshooting Commands in the CLI**

Use the following CLI commands to troubleshoot FC-SP issues:

- `show fcsp interface`
- `show fcsp internal event-history errors`
- `show fcsp dhchap`
- `show fcsp dhchap database`

Use the following CLI commands to troubleshoot port security issues:

- `show port-security status`
- `show port-security database vsan`
- `show port-security database active vsan`
- `show port-security violations`
- `show port-security internal global`
- `show port-security internal info vsan`
- `show port-security internal state-history vsan`
- `show port-security internal commit-history vsan`
- `show port-security internal merge-history vsan`

Use the following CLI commands to troubleshoot fabric binding issues:

- `show fabric-binding status`
- `show fabric-binding database vsan`
- `show fabric-binding database active vsan`
- `show fabric-binding violations`
FC-SP Issues

This section describes troubleshooting FC-SP issues and includes the following topic:

- Switch or Host Blocked from Fabric, page 19-4

**Switch or Host Blocked from Fabric**

**Symptom**  Switch or host blocked from joining the fabric.

**Table 19-1  Switch or Host Blocked From Fabric**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch or host blocked from joining the fabric.</td>
<td>FC-SP not enabled on all switches.</td>
<td>Choose <strong>Switches &gt; Security &gt; FC-SP</strong>, set the command field to <strong>enable</strong>, and click <strong>Apply Changes</strong> on Fabric Manager to enable FC-SP. Or use the <code>fcsp enable</code> CLI command on all switches in your fabric.</td>
</tr>
<tr>
<td>Local switch FC-SP password does not match remote password.</td>
<td>Choose <strong>Switches &gt; Security &gt; FC-SP</strong>, select the <strong>General/Password</strong> tab, and set the <strong>GenericPassword</strong> field in Fabric Manager. Or use the <code>fcsp dhchap password</code> CLI command to set the local switch password.</td>
<td></td>
</tr>
<tr>
<td>FC-SP DHCHAP configuration does not match remote switch or host.</td>
<td>See the “Verifying FC-SP Configuration Using Fabric Manager” section on page 19-5 or the “Verifying FC-SP Configuration Using the CLI” section on page 19-5.</td>
<td></td>
</tr>
<tr>
<td>Switch or host not in authentication database.</td>
<td>Add switch or host to the local or remote FC-SP database. See the “Verifying Local FC-SP Database Using Fabric Manager” section on page 19-5 or the “Verifying Local FC-SP Database Using the CLI” section on page 19-6.</td>
<td></td>
</tr>
<tr>
<td>Host or switch does not support FC-SP.</td>
<td>Upgrade host or switch or use the auto-active or auto-passive DHCHAP mode. Choose <strong>Switches &gt; Interfaces &gt; FC logical</strong>, select the <strong>FC-SP</strong> tab, set the Mode field to <strong>autoActive</strong> or <strong>autoPassive</strong>, and click <strong>Apply Changes</strong> in Fabric Manager. Or use the <code>fcsp auto-active</code> or <code>fcsp auto-passive</code> CLI command in interface mode to set the DHCHAP mode.</td>
<td></td>
</tr>
</tbody>
</table>
Verifying FC-SP Configuration Using Fabric Manager

To verify the FC-SP configuration using Fabric Manager, follow these steps:

Step 1 Choose Switches > Security > FC-SP and select the General/Password tab to view the configured DHCHAP timeout value.

Step 2 Set the Timeout field to modify the timeout value.

Step 3 Set the DH-CHAP HashList field to modify the DHCHAP hash algorithm.

Step 4 Set the DH-CHAP GroupList field to modify the DHCHAP group settings.

Verifying FC-SP Configuration Using the CLI

To verify the FC-SP configuration using the CLI, follow these steps:

Step 1 Use the show fcsp command to view the configured DHCHAP timeout value.

switch# show fcsp
fc-sp authentication TOV:30

Step 2 Use the fcsp timeout command to modify the timeout value.

switch(config)# fcsp timeout 60

Step 3 Use the show fcsp dhchap command to view the hash algorithm and group

switch# show fcsp dhchap
Supported Hash algorithms (in order of preference):
  DHCHAP_HASH_MD5
  DHCHAP_HASH_SHA_1

Supported Diffie Hellman group ids (in order of preference):
  DHCHAP_GROUP_1536

Step 4 Use the fcsp dhchap hash command to modify the DHCHAP hash algorithm.

switch(config)# fcsp dhchap hash MD5

Step 5 Use the fcsp dhchap group command to modify the DHCHAP group settings.

switch(config)# fcsp dhchap group 2 3 4

Verifying Local FC-SP Database Using Fabric Manager

To verify the local FC-SP database using Fabric Manager, follow these steps:

Step 1 Choose Switches > Security > FC-SP and select the Local Passwords tab and the Remote Password tab to view the configured switches and hosts.

Step 2 Choose Switches > FC Services > WWN Manager to find the sWWN for the switch.

Step 3 Choose Switches > Interfaces > FC Logical and select the FLOGI tab to find the pWWN for the host that you want to add to the FC-SP local database.
Step 4  Choose **Switches > Security > FC-SP**, select the **Local Passwords** tab, and then click **Create Row** to add a host or switch to the local database.

Step 5  Fill in the WWN and password fields and click **Create**.

---

### Verifying Local FC-SP Database Using the CLI

To verify the local FC-SP database using the CLI, follow these steps:

---

#### Step 1
Use the `show fcsp dhchap database` command to view the configured switches and hosts.

```
switch# show fcsp dhchap database
DHCHAP Local Password:
   Non-device specific password: ********
   Password for device with WWN:29:11:bb:cc:dd:33:11:22 is ********
   Password for device with WWN:30:11:bb:cc:dd:33:11:22 is ********

Other Devices' Passwords:
   Password for device with WWN:00:11:22:33:44:aa:bb:cc is ********
```

#### Step 2
Use the `show wwn switch` command on the switch that you want to add to the FC-SP local database to find the sWWN.

```
MDS-9216# show wwn switch
Switch WWN is 20:00:00:05:30:00:54:de
```

#### Step 3
Use the `show flogi database interface` command to find the pWWN for the host that you want to add to the FC-SP local database.

```
switch# show flogi database interface fc1/7
--------------------------------------------------------------------------------------
Interface     VSAN   FCID               PORT NAME                 NODE NAME
--------------------------------------------------------------------------------------
fc1/7          1     0xd10fee     20:00:00:33:8b:00:00:00    20:00:00:33:8b:00:00:00
--------------------------------------------------------------------------------------
Total number of flogi = 1
```

#### Step 4
Use the `fcsp dhchap devicename` command to add a host or switch to the local database.

```
switch(config)# fcsp dhchap devicename 20:00:00:33:8b:00:00:00 password rtp9509
```
## Authentication Fails When Using Cisco ACS

**Symptom**  Authentication fails when using Cisco ACS.

### Table 19-2  Authentication Fails When Using Cisco ACS

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Authentication fails when using Cisco ACS.  | sWWN does not match ACS entry.                     | Verify the sWWN and ACS entry. Choose Switches > FC Services > WWN Manager in Fabric Manager to find the sWWN for the switch.  
Or use the show wwn switch CLI command.  
Use the show fcsp asciiwwn sWWN CLI command to get an ASCII equivalent of the sWWN.  
On the Cisco ACS server, choose User Setup. Search for the ASCII equivalent of the sWWN in the User column of the User List. |

## Port Security Issues

This section describes troubleshooting port security issues and includes the following topics:

- Device Does Not Log into a Switch When AutoLearn Is Disabled, page 19-8  
- Cannot Activate Port Security, page 19-12  
- Unauthorized Device Gains Access to Fabric, page 19-12  
- Port Security Settings Lost After Reboot, page 19-13  
- Merge Fails, page 19-14

### Note

After correcting a port security configuration issue, you do not have to disable the interface and reenable it. The port comes up automatically after a port security reactivation if the problem was fixed.
Device Does Not Log into a Switch When AutoLearn Is Disabled

Symptom  Device does not log into a switch when autolearn is disabled.

Table 19-3  Device Does Not Log into a Switch When Autolearn Is Disabled

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device does not log into a switch when autolearn is disabled.</td>
<td>Device pWWN not allowed on port.</td>
<td>Manually add the device to the configured port security database. See the “Verifying the Active Port Security Database Using Fabric Manager” section on page 19-9 or the “Verifying the Active Port Security Database Using the CLI” section on page 19-9.</td>
</tr>
<tr>
<td>Port not configured for any device.</td>
<td>Add a device to the port in the port security database or turn on autolearn. See the “Configuring Port Security with Autolearn Using Fabric Manager” section on page 19-14 or the “Configuring Port Security with Autolearn Using the CLI” section on page 19-15.</td>
<td></td>
</tr>
<tr>
<td>Device is configured for some other port.</td>
<td>Manually add the device to the configured port security database. See the “Verifying the Active Port Security Database Using Fabric Manager” section on page 19-9 or the “Verifying the Active Port Security Database Using the CLI” section on page 19-9.</td>
<td></td>
</tr>
<tr>
<td>Port is shut down because of port security violation.</td>
<td>Remove the device causing the port security violation or add that device to the database. See the “Verifying Port Security Violations Using Fabric Manager” section on page 19-10 or the “Verifying Port Security Violations Using the CLI” section on page 19-11.</td>
<td></td>
</tr>
</tbody>
</table>

Device Does Not Log into a Switch When AutoLearn Is Enabled

Symptom  Device does not log into a switch when autolearn is enabled.

Table 19-4  Device Does Not Log into a Switch When Autolearn Is Enabled

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device does not log into a switch when autolearn is enabled.</td>
<td>Device is configured for some other port.</td>
<td>Manually remove the device from the configured port security database. See the “Verifying the Active Port Security Database Using Fabric Manager” section on page 19-9 or the “Verifying the Active Port Security Database Using the CLI” section on page 19-9.</td>
</tr>
<tr>
<td>Port is shut down because of port security violation.</td>
<td>Remove the device causing the port security violation or add that device to the database. See the “Verifying Port Security Violations Using Fabric Manager” section on page 19-10 or the “Verifying Port Security Violations Using the CLI” section on page 19-11.</td>
<td></td>
</tr>
</tbody>
</table>
To verify the active port security database using Fabric Manager, follow these steps:

**Step 1** Choose Fabricxx > VSANxx > Port Security and select the Active Database tab to view the active entries in the database.

**Step 2** Select the Actions tab, check the CopyToConfig check box, and click Apply Changes to copy the active database to the configure database.

**Step 3** Select the CFS tab, if CFS is enabled, and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.

**Step 4** Select the Config Database tab and click Add Row to add a new entry into the configure database.

**Step 5** Fill in the WWNs and interface fields and click Create.

**Step 6** Select the CFS tab, if CFS is enabled, and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.

**Step 7** Select the Actions tab, select activate(TurnLearning off) from the Action drop-down menu, and click Apply Changes to copy the configure database to the active database and reactivate port security.

**Step 8** Select the CFS tab, if CFS is enabled, and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.

To verify the active port security database using the CLI, follow these steps:

**Step 1** Use the show port-security database active command to view the active entries in the database.

```
switch# show port-security database active
VSAN   Logging-in Entity               Logging-in Point     (Interface)         Learnt
----------------------------------------------------------------------------------------
3      21:00:00:e0:8b:06:d9:1d(pwwn)   20:0d:00:05:30:00:95:de(fc1/13)           Yes
3       50:06:04:82:bc:01:c3:84(pwwn)   20:0c:00:05:30:00:95:de(fc1/12)
4       20:00:00:05:30:00:95:df(swwn)   20:0c:00:05:30:00:95:de(port-channel 128)
5       20:00:00:05:30:00:95:de(swwn)   20:01:00:05:30:00:95:de(fcl1/1)
[Total 4 entries]
```

**Step 2** Use the port-security database copy command to copy the active database to the configure database. This ensures that no learned entries are lost.

```
switch# port-security database copy vsan 1
```

**Step 3** Use the port-security database command to add a new entry into the configure database.

```
switch(config)# port-security database vsan 3
switch(config-port-security)# pwwn 20:11:33:11:00:2a:4a:66 swwn 20:00:00:0c:85:90:3e:80
    interface fc1/13
```

**Step 4** Use the port-security activate command to copy the configure database to the active database and reactivate port security.

```
switch(config)# port-security activate vsan 1
```
Step 5 If CFS distribution is enabled, use the `port-security commit` command to distribute these changes.

```
switch(config)# port-security commit vsan 3
```

### Verifying Port Security Violations Using Fabric Manager

To verify port security violations using Fabric Manager, follow these steps:

**Step 1** Choose Fabricxx > VSANxx > Port Security and select the Violations tab to search for an interface that is shut down.

**Step 2** Optionally follow these steps to add the device to the port security database:

- a. Choose Fabricxx > VSANxx > Port Security and select the Actions tab.
- b. Check the CopyActive to Config check box and click Apply Changes to copy the active database to the configure database. This ensures that no learned entries are lost.
- c. Select the CFS tab, if CFS is enabled, and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
- d. Select the Config Database tab and click Add Row to add a new entry into the configure database.
- e. Fill in the WWNs and interface fields and click Create.
- f. Select the CFS tab, if CFS is enabled, and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
- g. Select the Actions tab, select activate(TurnLearning off) from the Action drop-down menu, and click Apply Changes to copy the configure database to the active database and reactivate port security.
- h. Select the CFS tab, if CFS is enabled, and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
Step 3  Optionally, remove the device from the switch, choose Switches > Interfaces > FC Physical and select up from the Admin Status drop-down menu to bring the port back online. Click Apply Changes.

Note  You may need to set the interface down and then up to bring it back online.

Verifying Port Security Violations Using the CLI

To verify port security violations using the CLI, follow these steps:

Step 1  Use the show port-security violations command and search for the interface that is shut down.

```
switch# show port-security violations
```

```
------------------------------------------------------------------------------------------
VSAN  Interface       Logging-in Entity               Last-Time          [Repeat count]
------------------------------------------------------------------------------------------
1     fc1/13          21:00:00:e0:8b:06:d9:1d(pwwn)   Jul 9 08:32:20 2003    [20]
     20:00:00:e0:8b:06:d9:1d(nwwn)
     50:06:04:82:bc:01:c3:84(nwwn)
2     port-channel 1 20:00:00:05:30:00:95:de(swwn)   Jul 9 08:32:40 2003    [1]
[Total 2 entries]
```

In this example, pWWN 21:00:00:e0:8b:06:d9:1d is causing interface fc1/13 to be shut down because of port security violations.

Step 2  Optionally follow these steps to add the device to the port security database:

a.  Use the port-security database copy command to copy the active database to the configure database. This ensures that no learned entries are lost.

```
switch# port-security database copy vsan 3
```

b.  Use the port-security database command to add a new entry into the configure database.

```
switch(config)# port-security database vsan 3
switch(config-port-security)# pwwn 20:11:33:11:00:2a:4a:66 swwn
       20:00:00:0c:85:90:3e:80 interface fc1/13
```

c.  Use the port-security activate command to copy the configure database to the active database and reactivate port security.

```
switch(config)# port-security activate vsan 3
```

d.  If CFS distribution is enabled, use the port-security commit command to distribute these changes.

```
switch(config)# port-security commit vsan 3
```

e.  Use the no shutdown command in interface mode to bring the port back online.

Step 3  Optionally, remove the device from the switch and use the no shutdown command to bring the port back online.
Cannot Activate Port Security

**Symptom** Cannot activate port security.

**Table 19-5 Cannot Activate Port Security**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot activate port security.</td>
<td>Autolearn is enabled.</td>
<td>See the “Disabling Autolearn Using Fabric Manager” section on page 19-13 or the “Disabling Autolearn Using the CLI” section on page 19-13.</td>
</tr>
<tr>
<td></td>
<td>Conflicting entries in the configure database.</td>
<td>Remove the conflicting entries. Conflicting entries are those that when activated will cause existing logged in devices to logout. See the “Verifying the Active Port Security Database Using Fabric Manager” section on page 19-9 or the “Verifying the Active Port Security Database Using the CLI” section on page 19-9.</td>
</tr>
<tr>
<td></td>
<td>Configure database is empty.</td>
<td>Choose Fabricxx &gt; VSANxx &gt; Port Security, select the Actions tab, check the CopyActive to Config check box, and click Apply Changes in Fabric Manager to copy the active database to the configure database. Or use the port-security database copy CLI command.</td>
</tr>
<tr>
<td></td>
<td>Not all members of a PortChannel are configured for port security.</td>
<td>Add the missing members. Make sure that the sWWNs are the same for all the members. See the “Verifying the Active Port Security Database Using Fabric Manager” section on page 19-9 or the “Verifying the Active Port Security Database Using the CLI” section on page 19-9.</td>
</tr>
</tbody>
</table>

Unauthorized Device Gains Access to Fabric

**Symptom** Unauthorized device gains access to fabric.

**Table 19-6 Unauthorized Device Gains Access to Fabric**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unauthorized device gains access to fabric.</td>
<td>Port security disabled.</td>
<td>See the “Configuring Port Security with Autolearn Using Fabric Manager” section on page 19-14 or the “Configuring Port Security with Autolearn Using the CLI” section on page 19-15.</td>
</tr>
<tr>
<td></td>
<td>Port security not activated in the VSAN.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Autolearn is enabled.</td>
<td>Disable autolearn. See the “Disabling Autolearn Using Fabric Manager” section on page 19-13 or the “Disabling Autolearn Using the CLI” section on page 19-13.</td>
</tr>
</tbody>
</table>
Disabling Autolearn Using Fabric Manager

To disable autolearn using Fabric Manager, follow these steps:

1. Choose **Fabricxx > VSANxx > Port Security** and select the **Actions** tab.
2. Select **activate (Turn Learning off)** from the Action drop-down menu, and click **Apply Changes** to copy the configure database to the active database and reactivate port security.
3. Select the **CFS** tab, if CFS is enabled, and select **commit** from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
4. Copy the running configuration to the startup configuration, using the fabric option. This saves the port security configure database to the startup configuration on all switches in the fabric.

Disabling Autolearn Using the CLI

To disable autolearn using the CLI, follow these steps:

1. Use the **no port-security auto-learn** command to disable autolearn.
   
   ```
   switch# no port-security auto-learn vsan 2
   ```
2. Use the **port-security database copy** command to copy the active database to the configure database. This ensures that no learned entries are lost.
   
   ```
   switch# port-security database copy vsan 2
   ```
3. If CFS distribution is enabled, use the **port-security commit** command to distribute these changes.
   
   ```
   switch(config)# port-security commit vsan 2
   ```
4. Copy the running configuration to the startup configuration, using the fabric option. This saves the port security configure database to the startup configuration on all switches in the fabric.

Port Security Settings Lost After Reboot

**Symptom**  Port security settings were lost after a reboot.

**Table 19-7  Port Security Settings Lost After Reboot**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port security settings were lost after a reboot.</td>
<td>Autolearn entries not saved to configure database and to startup configuration.</td>
<td>See the “Disabling Autolearn Using Fabric Manager” section on page 19-13 or the “Disabling Autolearn Using the CLI” section on page 19-13.</td>
</tr>
</tbody>
</table>
Send documentation comments to mdsfeedback-doc@cisco.com

Merge Fails

Symptom  Merge fails.

<table>
<thead>
<tr>
<th>Table 19-8  Merge Fails</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Merge fails</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Configuring Port Security with Autolearn Using Fabric Manager

To configure port security with autolearn using Fabric Manager, follow these steps:

1. Choose Fabricxx > VSANxx > Port Security and select the Control tab.
2. Select enable from the Command drop-down menu and click Apply Changes.
3. Select the CFS tab and select enable from the Admin drop-down menu and select enable from the Global drop-down menu to enable CFS distribution.
4. Select the CFS tab and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
5. Choose Fabricxx > VSANxx > Port Security, select the Actions tab, and select activate from the Actions drop-down menu.
6. Check the AutoLearn check box and click Apply Changes to enable autolearn.
7. Select the CFS tab and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
8. Uncheck the AutoLearn check box and click Apply Changes to disable autolearn after all entries are learned.
9. Select the CFS tab and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
10. Check the CopyActive to Config check box and click Apply Changes to copy the active database to the configure database. This ensures that no learned entries are lost.
11. Select the CFS tab and select commit from the ConfigAction drop-down menu to distribute these changes to all switches in the fabric.
12. Copy the running configuration to the startup configuration, using the fabric option. This saves the port security configure database to the startup configuration on all switches in the fabric.
Configuring Port Security with Autolearn Using the CLI

To configure port security with autolearn using the CLI, follow these steps:

**Step 1** Use the `port-security enable` command to enable port security.

```
switch(config)# port-security enable
```

**Step 2** Use the `port-security distribute` command to enable CFS distribution.

```
switch(config)# port-security distribute
```

**Step 3** Use the `port-security activate` command to activate port security and enable autolearn.

```
switch(config)# port-security activate vsan 2
```

**Step 4** If CFS distribution is enabled, use the `port-security commit` command to distribute these changes.

```
switch(config)# port-security commit vsan 2
```

**Step 5** Use the `no port-security auto-learn` command in EXEC mode to disable autolearn after all entries have been learned.

```
switch# no port-security auto-learn vsan 2
```

**Step 6** If CFS distribution is enabled, use the `port-security commit` command to distribute these changes.

```
switch(config)# port-security commit vsan 2
```

**Step 7** Use the `port-security database copy` command to copy the active database to the configure database. This ensures that no learned entries are lost.

```
switch# port-security database copy vsan 2
```

**Step 8** If CFS distribution is enabled, use the `port-security commit` command to distribute these changes.

```
switch(config)# port-security commit vsan 2
```

**Step 9** Copy the running configuration to the startup configuration, using the fabric option. This saves the port security configure database to the startup configuration on all switches in the fabric.

```
switch# copy running-config startup-config
```

Fabric Binding Issues

This section describes troubleshooting fabric binding issues and includes the following topic:

- Switch Cannot Attach to the Fabric, page 19-16
- Cannot Activate Fabric Binding, page 19-18
- Unauthorized Switch Gains Access to Fabric, page 19-19
- Fabric Binding Settings Lost After Reboot, page 19-19

**Note** After correcting a fabric binding configuration issue, you do not have to disable the interface and reenable it. The port comes up automatically after a fabric binding reactivation if the problem was fixed.
Switch Cannot Attach to the Fabric

**Symptom** Switch cannot attach to the fabric.

**Table 19-9  Switch Cannot Attach to the Fabric**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch cannot attach to the fabric.</td>
<td>Fabric binding not activated on local switch. (It is activated on only one side of the ISL).</td>
<td>Activate fabric binding. Choose Fabricxx &gt; VSANxx &gt; Fabric Binding and select the Actions tab, select activate from the Action drop-down menu, and click Apply Changes to copy the configure database to the active database and activate fabric binding. Or use the fabric-binding activate CLI command.</td>
</tr>
<tr>
<td>sWWN not present in fabric binding database.</td>
<td>Add sWWN to fabric binding database. See the “Verifying Fabric Binding Violations Using Fabric Manager” section on page 19-16 or the “Verifying Fabric Binding Violations Using the CLI” section on page 19-17.</td>
<td></td>
</tr>
<tr>
<td>Fabric binding database has sWWN with a different domain ID configured.</td>
<td>For non-FICON VSANs, you can remove the domain ID from the fabric binding database. Or update the domain ID in the fabric binding database (for FICON or NON-FICON VSANs). See the “Verifying Fabric Binding Violations Using Fabric Manager” section on page 19-16 or the “Verifying Fabric Binding Violations Using the CLI” section on page 19-17.</td>
<td></td>
</tr>
<tr>
<td>The local active fabric binding database is different from the other switches.</td>
<td>Update the fabric binding database and reactivate it. See the “Verifying Fabric Binding Violations Using Fabric Manager” section on page 19-16 or the “Verifying Fabric Binding Violations Using the CLI” section on page 19-17.</td>
<td></td>
</tr>
<tr>
<td>Switch blocked because of fabric binding violation.</td>
<td>Remove the device causing the fabric binding violation or add that device to the database. See the “Verifying Fabric Binding Violations Using Fabric Manager” section on page 19-16 or the “Verifying Fabric Binding Violations Using the CLI” section on page 19-17.</td>
<td></td>
</tr>
</tbody>
</table>

**Verifying Fabric Binding Violations Using Fabric Manager**

To verify fabric binding violations using Fabric Manager, follow these steps:

**Step 1** Choose Fabricxx > VSANxx > Fabric Binding and select the Violations tab to search for an interface that is shut down.

**Step 2** Optionally, remove the switch, choose Switches > Interfaces > FC Physical, and select up from the Admin Status drop-down menu to bring the port back online. Click Apply Changes.

**Note** You may need to set the interface down and then up to bring it back online.
Step 3 Optionally follow these steps to add the switch to the fabric binding database:
   a. Choose Fabricxx > VSANxx > Fabric Binding and select the Actions tab.
   b. Check the Copy Active to Config check box and click Apply Changes to copy the active database to the configure database. This ensures that no learned entries are lost.
   c. Select the Config Database tab and click Add Row to add a new entry into the configure database.
   d. Fill in the WWNs and Domain ID fields and click Create.
   e. Select the Actions tab, select activate from the Action drop-down menu, and click Apply Changes to copy the configure database to the active database and reactivate fabric binding.

Verifying Fabric Binding Violations Using the CLI

To verify fabric binding violations using the CLI, follow these steps:

Step 1 Use the show port-security violations command and search for the interface that is shut down.

```
switch# show fabric-binding violations
-------------------------------------------------------------------------------
VSAN Switch WWN [domain] Last-Time [Repeat count] Reason
-------------------------------------------------------------------------------
2 20:00:00:05:30:00:4a:1e [*] Nov 25 05:44:58 2003 [2] sWWN not found
3 20:00:00:05:30:00:4a:1e [0xeb] Nov 25 05:46:14 2003 [2] Domain mismatch
4 20:00:00:05:30:00:4a:1e [*] Nov 25 05:46:25 2003 [1] Database mismatch
```

In VSAN 2, the sWWN itself was not found in the list. In VSAN 3, the sWWN was found in the list, but has a domain ID mismatch.

Step 2 Optionally, remove the switch and use the no shutdown command to bring the ISL back online.

Step 3 Optionally follow these steps to add the switch to the fabric binding database:
   a. Use the fabric-binding database copy command to copy the active database to the configure database.

```
switch# fabric-binding database copy vsan 3
```

b. Use the fabric-binding database command to add a new entry into the configure database.

```
switch(config)# fabric-binding database vsan 3
switch(config-fabric-binding)# swwn 20:11:33:11:00:2a:4a:66
```

c. Use the fabric-binding activate command to copy the configure database to the active database and reactivate fabric binding.

```
switch(config)# fabric-binding activate vsan 3
```

d. Use the no shutdown command in interface mode to bring the port back online.
Cannot Activate Fabric Binding

**Symptom** Cannot activate fabric binding.

<table>
<thead>
<tr>
<th><strong>Table 19-10 Cannot Activate Fabric Binding</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Cannot activate fabric binding.</td>
</tr>
</tbody>
</table>

Verifying the Config Fabric Binding Database Using Fabric Manager

To verify the config fabric binding database using Fabric Manager, follow these steps:

- **Step 1** Choose Fabricxx > VSANxx > Fabric Binding and select the Config Database tab.
- **Step 2** Right-click on the conflicting entry and click Delete Row to remove this entry.
- **Step 3** Choose Fabricxx > VSANxx > Fabric Binding and select the Actions tab.
- **Step 4** Select activate from the Action drop-down menu, and click Apply Changes to copy the configure database to the active database and reactivate fabric binding.

Verifying the Config Fabric Binding Database Using the CLI

To verify the config fabric binding database using the CLI, follow these steps:

- **Step 1** Use the show fabric-binding database active command to view the active entries in the database.
- **Step 2** Use the fabric-binding database copy command to copy the active database to the configure database.

```
switch# fabric-binding database copy vsan 1
```

- **Step 3** Use the fabric-binding database command to remove an entry from the configure database.

```
switch(config)# fabric-binding database vsan 3
switch(config-port-security)# no swnn 20:00:00:0c:85:90:3e:80
```

- **Step 4** Use the fabric-binding activate command to copy the configure database to the active database and reactivate fabric binding.

```
switch(config)# fabric-binding activate vsan 1
```
Unauthorized Switch Gains Access to Fabric

**Symptom** Unauthorized switch gains access to fabric.

<table>
<thead>
<tr>
<th>Table 19-11 Unauthorized Switch Gains Access to Fabric</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Unauthorized switch gains access to fabric.</td>
</tr>
</tbody>
</table>

Fabric Binding Settings Lost After Reboot

**Symptom** Fabric binding settings were lost after a reboot.

<table>
<thead>
<tr>
<th>Table 19-12 Fabric Binding Settings Lost After Reboot</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Fabric Binding settings were lost after a reboot.</td>
</tr>
</tbody>
</table>

Configuring Fabric Binding Using Fabric Manager

To configure fabric binding using Fabric Manager, follow these steps:

1. **Step 1** Choose Fabricxx > VSANxx > Fabric Binding and select the Control tab.
2. **Step 2** Select enable from the Command drop-down menu and click Apply Changes.
3. **Step 3** Select the Config Database tab and click Add Row to add a new entry into the configure database.
4. **Step 4** Fill in the WWNs and Domain ID fields and click Create.
5. **Step 5** Select the Actions tab, select activate from the Action drop-down menu, and click Apply Changes to copy the configure database to the active database and reactivate fabric binding.
6. **Step 6** Copy the running configuration to the startup configuration, using the fabric option. This saves the port security configure database to the startup configuration on all switches in the fabric.
Fabric Binding Issues

Configuring Fabric Binding Using the CLI

To configure fabric binding using the CLI, follow these steps:

- **Step 1** Use the `fabric-binding enable` command to enable fabric binding.
  
  ```
  switch(config)# fabric-binding enable
  ```

- **Step 2** Use the `fabric-binding database` command to add new entries into the configure database.
  
  ```
  switch(config)# fabric-binding database vsan 3
  switch(config-port-security)# swwn 20:00:00:0c:85:90:3e:80
  ```

- **Step 3** Use the `fabric-binding activate` command to activate fabric binding.
  
  ```
  switch(config)# fabric-binding activate vsan 2
  ```

- **Step 4** Use the `fabric-binding database copy` command to copy the active database to the configure database.
  
  ```
  switch# fabric-binding database copy vsan 2
  ```

- **Step 5** Copy the running configuration to the startup configuration, using the fabric option. This saves the fabric binding configure database to the startup configuration on all switches in the fabric.
  
  ```
  switch# fabric-binding database copy vsan 2
  ```
Troubleshooting IP Storage Services

This chapter describes how to identify and resolve IP storage services problems that might occur in the Cisco MDS 9000 Family products. It includes the following sections:

- Overview, page 20-1
- Initial Troubleshooting Checklist, page 20-3
- IP Issues, page 20-5
- FCIP Issues, page 20-9
- iSCSI Issues, page 20-35
- iSCSI TCP Performance Issues, page 20-48
- iSLB Issues, page 20-58

Overview

Using open-standard, IP-based technology, the Cisco MDS 9000 Family IP Storage (IPS) module enables you to extend the reach of Fibre Channel SANs. The switch can connect separated SAN islands through IP networks using FCIP, and allow IP hosts to access Fibre Channel storage using the iSCSI protocol.

The IPS module allows you to use FCIP and iSCSI features. It supports the full range of features available on other switching modules, including VSANs, security, and traffic management. The IPS module can be used in any Cisco MDS 9000 Family switch and has eight Gigabit Ethernet ports. Each port can run the FCIP and iSCSI protocols simultaneously.

FCIP transports Fibre Channel frames transparently over an IP network between two Cisco MDS 9000 Family switches or other FCIP standards-compliant devices (see Figure 20-1). Using the iSCSI protocol, the IPS module provides IP hosts access to Fibre Channel storage devices. IP host-initiated iSCSI commands are encapsulated in IP, and sent to an MDS 9000 IPS port. There, the commands are routed from the IP network into a Fibre Channel network, and forwarded to the intended target.
Overview

Note

The iSCSI feature is specific to the IPS module and is available in Cisco MDS 9200 Switches or Cisco MDS 9500 Directors.

The Cisco MDS 9216i switch and the 14/2 Multiprotocol Services (MPS-14/2) module also allow you to use Fibre Channel, FCIP, and iSCSI features. The MPS-14/2 module is available for use in any switch in the Cisco MDS 9200 Series or Cisco MDS 9500 Series.

The iSCSI feature is not supported on the Cisco Fabric Switch for HP c-Class bladesystem and Cisco Fabric Switch for IBM BladeCenter.

iSCSI Restrictions

iSCSI has the following limits in Cisco SAN-OS Release 3.0(1) and later:

- Maximum iSCSI sessions on a switch — 5000
- Maximum iSCSI sessions per IPS port (not proxy initiator mode) — 500
- Maximum iSCSI sessions per IPS port (proxy initiator mode) — 500
- Maximum concurrent iSCSI session creations per port — 5

If more iSCSI sessions try to come up simultaneously on a port, the initiator gets a temporary error and then the initiator retries.

- if iSLB CFS is enabled, you must use Device Manager to commit any iSCSI global configuration changes made through Fabric Manager.

iSLB Restrictions

iSLB has the following restrictions in Cisco SAN-OS Release 3.0(1) and later:

- Maximum number of iSCSI sessions per IPS port in either transparent or proxy initiator mode — 500.
- Maximum number of switches in a fabric that can have iSLB with CFS enabled — 4.
- iSLB can be used without CFS distribution but if iSLB auto-zone feature is used, traffic disruption occurs when any zone set is activated.
- Maximum number of initiators in the pending configuration — 200. Before adding more initiators, you must commit the configuration first.
Send documentation comments to mdsfeedback-doc@cisco.com

- If there are more than 200 initiators in the running configuration, you must lower the number of initiators to below 200 before disabling iSCSI.
- If IVR and iSLB features are enabled in the same fabric, there should be at least one switch in the fabric that has both of these features enabled. That switch must do any zoning related configuration and activation (for normal zones, IVR zones, or iSLB zones) or there may be traffic disruption in the fabric.
- iSLB VRRP load balancing is based on the number of initiators and not on the number of sessions. If you configure an initiator to see more targets than other initiators (resulting in more sessions on this initiator), you should configure this initiator with a higher load metric.
- iSLB should not be configured with Fabric Manager. Use Device Manager, which supports iSLB with CFS distribution.

Initial Troubleshooting Checklist

Begin troubleshooting IP storage services issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See the <em>Cisco MDS 9000 Family Fabric Manager Configuration Guide</em>.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you are not configuring IPsec with IPv6.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that auto-zone and CFS distribution are enabled for iSLB.</td>
<td>☐</td>
</tr>
<tr>
<td>If an Ethernet PortChannel is configured between the IPS module and an Ethernet switch, verify that any VRRP load balancing policy on the Ethernet switch is based on source/destination IP address.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that iSCSI is enabled on the required switches in the fabric, and for the required Gigabit Ethernet interfaces. See the <em>Cisco MDS 9000 Family Fabric Manager Configuration Guide</em> for details.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

Use the following Fabric Manager procedures to access IP interfaces, FCIP, and iSCSI:
- Choose **Switches > Interfaces** to access IP interfaces.
- Choose **ISLs > FCIP** to access FCIP.
- Choose **End Devices > iSCSI** to access iSCSI.

Common Troubleshooting Commands in the CLI

Use the following commands to troubleshoot IP interface, FCIP, and iSCSI issues:
- `show ip`
- `show ips arp`
- `show ipv6 traffic`
- `show ips ipv6`
Use the following commands to troubleshoot iSLB issues:

- `show fcip`
- `show iscsi`

Use the following commands as directed by your customer support representative to further troubleshoot iSLB issues:

- `show ips internal event-history errors`—Displays the errors encountered by the IPS manager.
- `show ips internal event-history msgs`—Displays the message transaction events history for the IPS manager.

Use the following commands to troubleshoot the iSLB initiator and initiator target configuration:

- `show ips internal info islb initiator node-name`—Displays the internal data structure for the iSLB initiator.
- `show ips internal event-history iscsi initiator name`—Displays the initiator state machine transitions.
- `show ips internal info islb zoneset`—Displays the internal data structure for iSLB zone sets.
- `show ips internal info islb [fc-addr-list | fc-port | fc-port-wwn-tree | hashtable | initiator-mapping | mib-index | nv-pss | scsi-lu-ext]`—Displays the internal data structures for iSLB objects.

Use the following commands to troubleshoot iSLB CFS:

- `show ips internal info islb cfs`—Displays internal data structures for iSLB CFS.
- `show ips internal event-history islb`—Displays the iSLB CFS state machine transitions.

Use the following command to troubleshoot load balancing:

- `show ips internal info islb vrrp [assignment | interface | metric | session]`—Displays the internal data structures for the iSLB load balancing feature.

Use the following `debug` commands to gather more information for iSLB:
IP Issues

If you suspect that all or part of your IP connection has failed, you can verify that by performing one or more of the procedures in this section. Using these procedures, you can verify connectivity for IEEE 802.1Q, EtherChannel, and VRRP for iSCSI. This section includes the following topics:

- Verifying Basic Connectivity, page 20-5
- Verification of Switch Connectivity, page 20-7
- Verification of Static IP Routing, page 20-8
- Cannot Assign IP Address to an Interface, page 20-9

**Note**

If you configure secondary VRRP IPv6 addresses on an IPFC VSAN interface, before a downgrading to a release prior to Cisco Release 3.0(1), you must remove the secondary VRRP IPv6 addresses. This is required only when you configure IPv6 addresses.

Verifying Basic Connectivity

Use the procedures in this section to verify that you have IP connectivity.

Verifying Basic Connectivity Using Device Manager

To verify basic connectivity using Device Manager, follow these steps:

**Step 1** Choose IP > Routes to verify the static route to the remote device.

**Step 2** Choose Interface > Ethernet and iSCSI to verify that the Gigabit Ethernet interface is up.

Verifying Basic Connectivity Using the CLI

To verify basic connectivity using the CLI, follow these steps:

**Step 1** Use the ping or the ping ipv6 command to perform a basic check of host reachability and network connectivity.

```
switch# ping 11.18.185.121
PING 11.18.185.121 (172.18.185.121): 56 data bytes
64 bytes from 11.18.185.121: icmp_seq=0 ttl=128 time=0.3 ms
```
Step 2  If the ping fails, use the **traceroute** or the **traceroute ipv6** command to determine where connectivity is failing.

```bash
switch# traceroute 11.18.185.121
traceroute to 11.18.185.121 (11.18.185.121), 30 hops max, 38 byte packets
1  11.18.189.129 (11.18.189.129)  0.413 ms  0.257 ms  0.249 ms
2  11.18.0.33 (11.18.0.33)  0.296 ms  0.260 ms  0.258 ms
3  11.81.254.69 (11.81.254.69)  0.300 ms  0.273 ms  0.277 ms
4 * * *
5 * * *
```

Step 3  Use **show ip route** or the **show ipv6 route** command to verify the static route to the remote device.

```bash
switch # show ip route
Codes: C - connected, S - static
Default gateway is 11.18.185.97
C 11.18.185.96/27 is directly connected, mgmt0
C 11.18.189.128/26 is directly connected, gigabitethernet4/7
```

Step 4  Use the **clear ips arp** or **clear ipv6 neighbor** command to clear the Address Resolution Protocol (ARP) or neighbor cache to verify that the activity you are viewing is the most current.

```bash
switch# clear ips arp interface gigabitethernet 4/7
arp clear successful
```

Step 5  Use the **show ips arp** or the **show ips ipv6 neighbors** command to verify the hardware address for the remote device.

```bash
switch# show ips arp interface gigabitethernet 4/7
Protocol  Address   Age (min)   Hardware Addr  Type   Interface
Internet   172.18.185.97        0  00:d0:01:3b:38:0a  ARPA  GigabitEthernet4/7
Internet   172.18.189.156        0  00:08:02:b3:45:1b  ARPA  GigabitEthernet4/7
```

Step 6  Use the **show interface** command to verify that the Gigabit Ethernet interface is up.

```bash
GigabitEthernet4/7 is up
Hardware is GigabitEthernet, address is 0005.3000.9f58
Internet address is 172.18.189.156/26
MTU 1500 bytes, BW 1000000 Kbit
Port mode is IPS
Speed is 1 Gbps
Beacon is turned off
5 minutes input rate 688 bits/sec, 86 bytes/sec, 0 frames/sec
5 minutes output rate 312 bits/sec, 39 bytes/sec, 0 frames/sec
156643 packets input, 16859832 bytes
  0 multicast frames, 0 compressed
  0 input errors, 0 frame, 0 overrun 0 fifo
144401 packets output, 7805631 bytes, 0 underruns
  0 output errors, 0 collisions, 0 fifo
  0 carrier errors
```
Verification of Switch Connectivity

Use the procedures in this section to verify connectivity to a destination switch.

Note
The FC ID variable used in these procedures is the domain controller address; it is not a duplication of the domain ID.

Verifying Switch Connectivity Using Fabric Manager

To verify connectivity to a destination switch using Fabric Manager, follow these steps:

Step 1 Choose Fabricxx > VSANxx > Domain Manager to display the domain ID for the destination switch.
Step 2 Concatenate the domain ID with FFFC to obtain the domain controller address. For example, if the domain ID is 0xda(218), the concatenated ID is 0xffcda.
Step 3 Choose Tools > Ping... to verify reachability to the destination switch.

Verifying Switch Connectivity Using the CLI

To verify connectivity to a destination switch using the CLI, follow these steps:

Step 1 Use the show fcdomain domain-list vsan command to display the domain ID for the destination switch.

```
switch# show fcdomain domain-list vsan 200
Number of domains: 7
Domain ID WWN
--------- -----------------------
0x01(1) 20:c8:00:05:30:00:59:df [Principal]
0x02(2) 20:c8:00:0b:5f:d5:9f:c1
0x6f(111) 20:c8:00:05:30:00:60:df
0xda(218) 20:c8:00:05:30:00:87:9f [Local]
0x06(6) 20:c8:00:0b:46:79:4f:41
0x04(4) 20:c8:00:05:30:00:86:5f
0x6a(106) 20:c8:00:05:30:00:f8:e3
```

Step 2 Concatenate the domain ID with FFFC to obtain the domain controller address. For example, if the domain ID is 0xda(218), the concatenated ID is 0xffcda.
Step 3 Use the `fcping` command to verify reachability to the destination switch.

```bash
switch# fcping fcid 0xFFFCDA vsan 200
28 bytes from 0xFFFCDA time = 298 usec
28 bytes from 0xFFFCDA time = 260 usec
28 bytes from 0xFFFCDA time = 298 usec
28 bytes from 0xFFFCDA time = 294 usec
28 bytes from 0xFFFCDA time = 292 usec
5 frames sent, 5 frames received, 0 timeouts
Round-trip min/avg/max = 260/288/298 usec
```

**Verification of Static IP Routing**

Use the procedures in this section to verify static IP routing.

**Verifying Static IP Routing Using Device Manager**

Choose **IP > Routes** in Device Manager to verify the static IP routes.

**Verifying Static IP Routing Using the CLI**

To verify static IP routes using the CLI, follow these steps:

**Step 1** Use the `show ip route config` or the `show ipv6 route` command to verify the routes configured.

```bash
switch# show ip route config
Destination          Gateway             Mask Metric        Interface
default       172.17.8.1          0.0.0.0      0            mgmt0
11.2.36.0        11.3.36.1    255.255.252.0      0
11.2.56.0        11.3.56.1    255.255.252.0      0
11.3.36.0          0.0.0.0    255.255.252.0      0 GigabitEthernet8/7
11.3.56.0          0.0.0.0    255.255.252.0      0 GigabitEthernet8/8
172.17.8.0          0.0.0.0    255.255.255.0      0            mgmt0
```

**Step 2** Use the `show ip route` or the `show ipv6 route` command to verify that the IP routes are still present.

```bash
switch# show ip route
Codes: C - connected, S - static
Default gateway is 172.17.8.1
C 172.17.8.0/24 is directly connected, mgmt0
S 11.2.36.0/22 via 11.3.36.1, gigabitethernet8/7
C 11.3.36.0/22 is directly connected, gigabitethernet8/7
C 11.3.56.0/22 is directly connected, gigabitethernet8/8
S 11.2.56.0/22 via 11.3.56.1, gigabitethernet8/8
```
Cannot Assign IP Address to an Interface

You may encounter a problem when assigning an IP address to an interface. If that IP address is already in use by another interface (for example, a remote VRRP interface), you may see the following message:

Invalid configuration: this IP address overlaps with another interface in network

You can recover from this problem by using the `shutdown` CLI command on that VRRP interface, programming the IP address, and then using the `no shutdown` CLI command on that VRRP interface.

FCIP Issues

This section contains information on troubleshooting FCIP tunnels with and without special frames and includes the following topics:

- One-to-One FCIP Tunnel Creation and Monitoring, page 20-10
- One-to-Three FCIP Tunnel Creation and Monitoring, page 20-20
- FCIP Profile Misconfiguration Examples, page 20-21
- FCIP Interface Misconfiguration Examples, page 20-24
- FCIP Special Frame Tunnel Creation and Monitoring, page 20-30
- Special Frame Misconfiguration Example, page 20-33
- Troubleshooting FCIP Link Flaps, page 20-34
- Troubleshooting FCIP ISL Link Failures, page 20-34
- Troubleshooting FCIP and Compression, page 20-35

**Note**

FCIP Tape acceleration does not work if the FCIP port is part of a PortChannel or if there are multiple paths between the initiator and the target port. Such a configuration might cause SCSI discovery failure or broken write or read operations.
One-to-One FCIP Tunnel Creation and Monitoring

This section describes the configuration for one-to-one FCIP tunnel with FCIP debug activated (MDS2) and without debug activated (MDS1). Figure 20-2 shows the one-to-one topology used for configuration.

**Figure 20-2 One-to-One Topology**

![One-to-One Topology Diagram]

Configuring the First Switch with the CLI

To configure the first switch using the CLI, follow these steps:

1. Enter configuration mode.
2. Set the interface.
   ```
   MDS1(config)# interface gigabitethernet 2/8
   ```
3. Set the IP address.
   ```
   MDS1(config-if)# ip address 10.10.10.2 255.255.255.0
   ```
4. Enter no shutdown.
   ```
   MDS1(config-if)# no shutdown
   ```
5. Enter the profile number and profile mode.
   ```
   MDS1(config)# fcip profile 28
   ```
   The profile number can be any number between 1 – 255
6. Enter the IP address of the local GE port that will be the endpoint of the FCIP tunnel.
   ```
   MDS1(config-profile)# ip address 10.10.10.2
   ```
7. Exit profile mode.
   ```
   MDS1(config-profile)# exit
   ```
8. Set the FCIP interface and enter interface mode.
   ```
   MDS1(config)# interface fcip 28
   ```
   The interface FCIP can be any number between 1 – 255 and does not need to be the same as the profile number. In this example the same number is used for simplicity.
9. Specify a profile to use.
   ```
   MDS1(config-if)# use-profile 28
   ```
The FCIP interface will use the local FCIP profile. The FCIP profile binds the FCIP interface to the physical Gigabit Ethernet port and configures the TCP settings used by the FCIP interface.

MDS1(config-if)# peer-info ipaddr 10.10.11.2

The IP address in this example indicates the remote endpoint IP address of the FCIP tunnel.

MDS1(config-if)# no shutdown
MDS1(config-if)# end

Displaying the Default Values Using the CLI

The following example displays the default values from the `show running-config` command.

MDS1# show running-config

Building Configuration ...
fcip profile 28
ip address 10.10.10.2
port 3225
tcp keepalive-timeout 60
tcp max-retransmissions 4
tcp pmtu-enable reset-timeout 3600
tcp initial-retransmit-time 100
tcp window-size 64

vsan database
vsan 2 name grumpy_02

interface fcip28
no shutdown
use-profile 28
peer-info ipaddr 10.10.11.2

ip route 10.10.11.0 255.255.255.0 10.10.10.1

Setting the Static Route for FCIP Tunnels Using the CLI

The static route must be set for FCIP tunnels. This route could also be `ip route 10.10.11.0 255.255.255.0`

```
interface GigabitEthernet2/8
ip address 10.10.10.2 255.255.255.0
(This is the IP address used by the FCIP profile.)
no shutdown
```

Debugging the Configuration of the Second Switch Using the CLI

The following example shows the configuration of a switch (MDS2) with debug mode activated. To activate debug mode for this situation, run the `debug ips flow fcip` command on a separate terminal.

MDS2(config)# fcip profile 28
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 20  Troubleshooting IP Storage Services

FCIP Issues

Mar 10 21:41:04 ips: Dequeued mts msg MTS_OPC_IPS_FCIP_CMI_REQUEST (mts opc 3321, msg id 32222)
Mar 10 21:41:04 ips: Create Entity 28
Mar 10 21:41:04 ips: entity28: add to config pss

MDS2(config-profile)# ip address 10.10.11.2
Mar 10 21:41:15 ips: Dequeued mts msg MTS_OPC_IPS_FCIP_CMI_REQUEST (mts opc 3321, msg id 32258)
Mar 10 21:41:15 ips: entity28: IP address changed to 10.10.11.2
Mar 10 21:41:15 ips: entity28: Apply the entity config and save to config pss
Mar 10 21:41:15 ips: entity28: add to config pss

MDS2(config-profile)# exit

MDS2(config)# interface fcip 28
Mar 10 21:42:23 ips: Locked fcip_if_fsm for MTS_OPC_IPS_FCIP_CMI_REQUEST(msg id 32480)
Mar 10 21:42:23 ips: Unlocked fcip_if_fsm for MTS_OPC_IPS_FCIP_CMI_REQUEST(msg id 32480)

Displaying the Debug Output from FCIP Tunnel Supervisor Using the CLI

The following example shows the debug output from the supervisor of the FCIP tunnel.

MDS2(config-if)# interface fcip 28
MDS2(config-if)# no shutdown
- found data in FU_PSEL_Q_CAT_MTS queue, fd(3), usr_q_info(1)
Mar 10 22:59:46 ips: fu_priority_select_select_queue: round credit(0)
Mar 10 22:59:46 ips: Starting a new round
usr_q_info(1)
Mar 10 22:59:46 ips: Dequeued mts msg MTS_OPTS_PM_LOGICAL_PORT_STATE_CHANGE_RANGE(mts opc 3114, msg id 47540)
Mar 10 22:59:46 ips: MTS_OPTS_PM_LOGICAL_PORT_STATE_CHANGE_RANGE(msg_id 47540) dropped
Send documentation comments to mdsfeedback-doc@cisco.com

FU_PSEL_Q_CAT_MTS queue, fd(3), usr_q_info(1)
Mar 10 22:59:46 ips: fu_priority_select_select_queue: round credit(6)
Mar 10 22:59:46 ips: cur_q - FU_PSEL_Q_CAT_CQ, usr_q_info(3), priority(4), credit(3),
empty
usr_q_info(1)
Mar 10 22:59:46 ips: Dequeued mts msg MTS_OPC_PM_LOGICAL_PORT_STATE_CHANGE_RANGE(mts opc
3114, msg id 47589)
Mar 10 22:59:46 ips: ip8_mts_hdlr_pm_logical_port_state_change_range:
Mar 10 22:59:46 ips: Hndlr MTS_OPC_PM_LOGICAL_PORT_STATE_CHANGE_RANGE (mts_opc 3114 msg_id
47589)
Mar 10 22:59:46 ips: fu_fsm_execute_all: match_msg_id(0), log_already_open(0)
Mar 10 22:59:46 ips: fu_fsm_execute_all: null fsm_event_list
MTS_OPC_PM_LOGICAL_PORT_STATE_CHANGE_RANGE(msg_id 47589) dropped
FU_PSEL_Q_CAT_MTS queue, fd(3), usr_q_info(1)
Mar 10 22:59:46 ips: fu_priority_select_select_queue: round credit(4)
Mar 10 22:59:46 ips: cur_q - FU_PSEL_Q_CAT_CQ, usr_q_info(3), priority(4), credit(2),
empty
usr_q_info(1)
Mar 10 22:59:46 ips: Dequeued mts msg MTS_OPC_PM_LOGICAL_PORT_STATE_CHANGE_RANGE(mts opc
3114, msg id 47602)
Mar 10 22:59:46 ips: ip8_mts_hdlr_pm_logical_port_state_change_range:
Mar 10 22:59:46 ips: Hndlr MTS_OPC_PM_LOGICAL_PORT_STATE_CHANGE_RANGE (mts_opc 3114 msg_id
47602)
Mar 10 22:59:46 ips: fu_fsm_execute_all: match_msg_id(0), log_already_open(0)
Mar 10 22:59:46 ips: fu_fsm_execute_all: null fsm_event_list
MTS_OPC_PM_LOGICAL_PORT_STATE_CHANGE_RANGE(msg_id 47602) dropped

Displaying the Debug Output from the FCIP Tunnel IPS Module Using the CLI

The following example shows the debug output from the IPS module of the FCIP tunnel.
MDS2# attach module 2
module-2# debug ips fcip fsm port 8
(This is the Gigabit Ethernet port 2/8.)
Mar 13 19:18:19 port8: 2700:FCIP28: Received new TCP connection from peer:
10.10.10.2:65455
Mar 13 19:18:19 port8: 2701:FCIP: (fcip_de_create): DE = 0xdc02ca40
Mar 13 19:18:19 port8: 2702:FCIP28: Create a DE 0xdc02ca40 for this tunnel
Mar 13 19:18:19 port8: 2703:FCIP28: Bind the DE 0xdc02ca40 [1] to tunnel LEP 0x801ebac0
Mar 13 19:18:19 port8: 2704:FCIP28: Bind DE 1 to TCP-hdl 0xdc489800
Mar 13 19:18:19 port8: 2705:FCIP28: Bind DE 1 to eport 0x801eaaa0
Mar 13 19:18:19 port8: 2706:FCIP28: bind de 1 in eport 0x801eaaa0, hash = 1 num-conn: 2
Mar 13 19:18:19 port8: 2707:FCIP28: Received new TCP connection from peer:
10.10.10.2:65453
Mar 13 19:18:19 port8: 2708:FCIP: (fcip_de_create): DE = 0xdc02cb40
Mar 13 19:18:19 port8: 2709:FCIP28: Create a DE 0xdc02cb40 for this tunnel
Mar 13 19:18:19 port8: 2710:FCIP28: Bind the DE 0xdc02cb40 [2] to tunnel LEP 0x801ebac0
Mar 13 19:18:19 port8: 2711:FCIP28: Bind DE 2 to TCP-hdl 0xdc488800
Mar 13 19:18:19 port8: 2712:FCIP28: Bind DE 2 to eport 0x801eaaa0
Mar 13 19:18:19 port8: 2713:FCIP28: bind de 2 in eport 0x801eaaa0, hash = 2 num-conn: 2
Mar 13 19:18:19 port8: 2714:FCIP28: Send LINK UP to SUP
Mar 13 19:18:20 port8: 2715:FCIP28: *** Received eisl frame in E mode
Mar 13 19:18:20 port8: 2717:FCIP28: Change the operational mode to TRUNK
Verifying the Configuration of the Profiles Using the CLI

Use the `show fcip profile` command to verify that the configuration of the profiles are correct. The IP address and TCP port are the ports to listen on, and both are adjustable in the FCIP profile. The following example displays all the default values that are adjustable while configuring the FCIP profile.

```
MDS1# show fcip profile
-------------------------------------------------------------------------------
ProfileId   Ipaddr          TcpPort
-------------------------------------------------------------------------------
 28          10.10.10.2      3225
```  

```
MDS1# show fcip profile 28
FCIP Profile 28
Listen Port is 3225
TCP parameters
  SACK is disabled
  PMTU discover is enabled, reset timeout is 3600 sec
  Keep alive is 60 sec
  Minimum retransmission timeout is 100 ms
  Maximum number of re-transmissions is 4
  Advertised window size is 64 KB
```

Verifying the Establishment of the FCIP Tunnel Using the CLI

Use the `show interface fcip` command to verify that the FCIP tunnel is established and that traffic is passing through.

```
MDS1# show interface fcip 28
FCIP28 is trunking
  Hardware is GigabitEthernet
  Port WWN is 20:5e:00:05:30:00:59:de
  Peer port WWN is 20:5e:00:0b:5f:d5:9f:c0
  Admin port mode is auto, trunk mode is on
  Port mode is TE
  (The FCIP tunnel will be either E (ISL or TE (EISL) passing through multiple VSANs.)

vsan is 1
  Trunk vsans (allowed active) {1-2}
  Trunk vsans (operational) {1-2}
  Trunk vsans (up) {1-2}
  Trunk vsans (isolated) {}
  Trunk vsans (initializing) {}
  Using Profile id 28 (interface GigabitEthernet2/8)
  (This is the FCIP profile and the Gigabit Ethernet being used by the FCIP tunnel.)
```

```
Peer Information
  Peer Internet address is 10.10.11.2 and port is 3225
  (This is the remote endpoint’s IP address and listening port.)
```

```
Special Frame is disabled
  (The special frame for verification of a remote MDS is not being used.)
```

```
Maximum number of TCP connections is 2
  (The default is 2 TCP connections being used, one for class F and the other for class 2 and 3.)
  Time Stamp is disabled
```
B-port mode disabled

TCP Connection Information
2 Active TCP connections

Control connection: Local 10.10.10.2:3225, Remote 10.10.11.2:65519
(The above is class F traffic.)

Data connection: Local 10.10.10.2:3225, Remote 10.10.11.2:65521
(This is class 2,3 traffic.)

6 Attempts for active connections, 3 close of connections

TCP Parameters
Path MTU 1500 bytes
Current retransmission timeout is 100 ms <<< Default, adjusted under Round trip time: Smoothed 10 ms, Variance: 5
(This is the calculated round trip time of the FCIP tunnel. Large round trip times will require increasing the TCP window size under the FCIP profile.)

Advertized window: Current: 64 KB, Maximum: 64 KB, Scale: 1
(This is the local advertised TCP window size, and the default is 64 KB.)

Peer receive window: Current: 64 KB, Maximum: 64 KB, Scale: 1
(This is the remote endpoint advertised TCP window size.)

Congestion window: Current: 2 KB
(This is the minimum window size used during congestion, and it is not configurable.)

5 minutes input rate 136 bits/sec, 17 bytes/sec, 0 frames/sec
5 minutes output rate 136 bits/sec, 17 bytes/sec, 0 frames/sec
2288 frames input, 211504 bytes
2288 Class F frames input, 211504 bytes
0 Class 2/3 frames input, 0 bytes
0 Error frames
2288 frames output, 211520 bytes
2288 Class F frames output, 211520 bytes
0 Class 2/3 frames output, 0 bytes
0 Error frames 0 reas frames

---

MDS1# show interface fcip 28 brief

<table>
<thead>
<tr>
<th>Interface</th>
<th>Vsan</th>
<th>Admin Mode</th>
<th>Admin Trunk Mode</th>
<th>Status</th>
<th>Oper Mode</th>
<th>Profile</th>
<th>Port-channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>fcip28</td>
<td>1</td>
<td>auto</td>
<td>on</td>
<td>trunking</td>
<td>TE</td>
<td>28</td>
<td>--</td>
</tr>
</tbody>
</table>

MDS1# show interface fcip 28 counters brief

<table>
<thead>
<tr>
<th>Interface</th>
<th>(rate is 5 min avg)</th>
<th>(rate is 5 min avg)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Rate Mbits/s Frames</td>
<td>Rate Mbits/s Frames</td>
</tr>
<tr>
<td>fcp28</td>
<td>18 0</td>
<td>18 0</td>
</tr>
</tbody>
</table>

(These are the frames that averaged over 5 minutes and the total count of frames since the last clear counters command was issued, or since the last tunnel up.)
Verifying the Establishment of Default TCP Connections for Each Configured FCIP Tunnel Using the CLI

Verify that two default TCP connections are established for each FCIP tunnel configured, one for control traffic and one for data traffic.

MDS1# show ips stats tcp interface gigabitethernet 2/8
TCP Statistics for port GigabitEthernet2/8
Connection Stats
  6 active openings, 8 accepts
  6 failed attempts, 0 reset received, 8 established
Segment stats
295930 received, 1131824 sent, 109 retransmitted
(Excessive retransmits indicate possible core drops and/or that the TCP window size should be adjusted.)
  0 bad segments received, 0 reset sent
TCP Active Connections
Local Address        Remote Address        State      Send-Q   Recv-Q
10.10.10.2:3225       10.10.11.2:65519      ESTABLISH  0        0
(This is used for F control traffic only.)
10.10.10.2:3225       10.10.11.2:65521      ESTABLISH  87568    0
(Send-Q increasing during read-only test.)
10.10.10.2:3225       0.0.0.0:0             LISTEN     0        0
(The TCP listen port is ready for new TCP connections.)

You can use the following command to verify that traffic is incrementing on the Gigabit Ethernet port of the FCIP tunnel.

MDS1# show ips stats mac interface gigabitethernet 2/8
Ethernet MAC statistics for port GigabitEthernet2/8
Hardware Transmit Counters
  1074898 frame 1095772436 bytes
  0 collisions, 0 late collisions, 0 excess collisions
  0 bad frames, 0 FCS error, 0 abort, 0 runt, 0 oversize
Hardware Receive Counters
  33488196 bytes, 298392 frames, 277 multicasts, 16423 broadcasts
  0 bad, 0 runt, 0 CRC error, 0 length error
  0 code error, 0 align error, 0 oversize error
Software Counters
  298392 received frames, 1074898 transmit frames
  0 frames soft queued, 0 current queue, 0 max queue
  0 dropped, 0 low memory

Verifying the Statistics of the ASIC Chip on Each Gigabit Ethernet Port Using the CLI

Traffic statistics can be verified on the internal ASIC chip on each Gigabit Ethernet port.

MDS1# show ips stats flamingo interface gigabitethernet 2/8
Flamingo ASIC Statistics for port GigabitEthernet2/8
Hardware Egress Counters
  2312 Good, 0 bad protocol, 0 bad header cksum, 0 bad FC CRC
(Good frames and CRC error frames can be monitored.)
Hardware Ingress Counters
(Verify good increments on the active tunnel.)
  2312 Good, 0 protocol error, 0 header checksum error
  0 FC CRC error, 0 iSCSI CRC error, 0 parity error
Software Egress Counters
2312 good frames, 0 bad header cksum, 0 bad FIFO SOP
0 parity error, 0 FC CRC error, 0 timestamp expired error
0 unregistered port index, 0 unknown internal type
0 RDL, 0 RDL too big RDL, 0 TDL ttl_1
3957292257 idle poll count, 0 loopback, 0 FCC PQ, 0 FCC EQ
Flow Control: 0 [0], 0 [1], 0 [2], 0 [3]

Software Ingress Counters
2312 Good frames, 0 header cksum error, 0 FC CRC error
0 iSCSI CRC error, 0 descriptor SOP error, 0 parity error
0 frames soft queued, 0 current Q, 0 max Q, 0 low memory
0 out of memory drop, 0 queue full drop
0 RDL, 0 too big RDL drop
Flow Control: 0 [0], 0 [1], 0 [2], 0 [3]

Ethereal Screen Captures of the TCP Connection and FCIP Tunnels

Figure 20-3, Figure 20-4, and Figure 20-5 are screen captures taken with Ethereal of TCP connections being established, and of FCIP tunnels. Note that FCIP tunnel activation is the same as an FC EISL becoming active (such as ELP, ESC, and EFP). The following traces were captured after configuration on both MDS 9000 Family switches, and the last no shutdown was entered on switch MDS1. All settings are default (for example, SACK is disabled, and the TCP window is set to 64K).

Figure 20-3  First Capture of TCP Connection

Figure 20-4 shows more of the trace, with frame 13 being the first FCIP frame. This frame carries the FC Standard ELP.
# Chapter 20  Troubleshooting IP Storage Services

## FCIP Issues

Send documentation comments to mdsfeedback-doc@cisco.com

### Figure 20-4  Second Capture of TCP Connection

<table>
<thead>
<tr>
<th>No.</th>
<th>Time</th>
<th>Source</th>
<th>Destination</th>
<th>Protocol</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>10:15:18</td>
<td>10.10.1.2</td>
<td>10.10.2.2</td>
<td>TCP</td>
<td>32768 × 65535 [ACK] Seq=120001517 Ack=122049672 Win=337984 MB</td>
</tr>
<tr>
<td>13</td>
<td>10:15:18</td>
<td>10.10.1.2</td>
<td>10.10.2.2</td>
<td>TCP</td>
<td>32768 × 65535 [ACK] Seq=120001517 Ack=122049672 Win=337984 MB</td>
</tr>
<tr>
<td>14</td>
<td>10:15:18</td>
<td>10.10.1.2</td>
<td>10.10.2.2</td>
<td>TCP</td>
<td>32768 × 65535 [ACK] Seq=120001517 Ack=122049672 Win=337984 MB</td>
</tr>
<tr>
<td>15</td>
<td>10:15:18</td>
<td>10.10.1.2</td>
<td>10.10.2.2</td>
<td>TCP</td>
<td>32768 × 65535 [ACK] Seq=120001517 Ack=122049672 Win=337984 MB</td>
</tr>
</tbody>
</table>

### Figure 20-5  Third Capture of TCP Connection

<table>
<thead>
<tr>
<th>Src IP</th>
<th>Dst IP</th>
<th>Source Port</th>
<th>Destination Port</th>
<th>Seq</th>
<th>Ack</th>
<th>Len</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.10.1.2</td>
<td>10.10.2.2</td>
<td>65535</td>
<td>65535</td>
<td>1200</td>
<td>49672</td>
<td>337984 MB</td>
</tr>
</tbody>
</table>

Figure 20-5 shows the FC portion of the EISL initialization over the FCIP tunnel.
One-to-Three FCIP Tunnel Creation and Monitoring

Figure 20-6 shows the configuration of switch MDS1 for three tunnels from one Gigabit Ethernet port.

Displaying the Configuration of the First Switch Using the CLI

The following example shows the configuration of switch MDS1 for three tunnels from one Gigabit Ethernet port.

```
MDS1(config)# fcip profile 21
MDS1(config-profile)# ip address 10.10.10.2
MDS1(config-profile)# exit
MDS1(config)# interface fcip 21
MDS1(config-if)# use-profile 21
MDS1(config-if)# peer-info ipaddr 10.10.11.2
MDS1(config-if)# no shutdown
MDS1(config-if)# exit

MDS1(config)# ip route 10.10.11.0 255.255.255.0 10.10.10.1
MDS1(config)# ip route 10.10.11.0 255.255.255.0 interface gigabitethernet 2/1
```
Creating the FCIP Interface for the Second Tunnel Using the CLI

Now the interface FCIP is created for the second tunnel. The same FCIP profile is used for this example. A separate FCIP profile can be used for each FCIP interface if desired.

```
MDS1(config-if)#
MDS1(config-if)# interface fcip 23
MDS1(config-if)# use-profile 21
MDS1(config-if)# peer-info ipaddr 10.10.8.2
MDS1(config-if)# no shutdown
MDS1(config-if)# exit
MDS1(config)#
```

Now the FCIP interface is created for the third tunnel.

```
MDS1(config)# interface fcip 28
MDS1(config-if)# use-profile 21
MDS1(config-if)# peer-info ipaddr 10.10.7.2
MDS1(config-if)# no shut
MDS1(config-if)# end
MDS1(config)#
```

FCIP Profile Misconfiguration Examples

The examples in this section show FCIP profile misconfigurations.

Displaying Incorrect or Nonexistent IP Address for an FCIP Profile Using the CLI

```
MDS22(config)# fcip profile 21
MDS22(config-profile)# ip addr 1.1.1.1
MDS22(config-profile)# ip addr 34.34.34.34
MDS22(config-profile)# exit
MDS22(config)# exit
MDS22# show fcip profile 21
FCIP Profile 21
Internet Address is 34.34.34.34
(In this line, the interface Gigabit Ethernet port is not shown. This means the IP address is not assigned a Gigabit Ethernet port.)
Listen Port is 3225
TCP parameters
  SACK is disabled
  PMTU discover is enabled, reset timeout is 3600 sec
  Keep alive is 60 sec
  Minimum retransmission timeout is 300 ms
  Maximum number of re-transmissions is 4
  Advertised window size is 64 KB
MDS22# config t
Enter configuration commands, one per line. End with CNTL/Z.
MDS22(config)# interface gigabitethernet 2/5
MDS22(config-if)# ip addr 34.34.34.34 255.255.255.0
MDS22(config-if)# no shutdown
MDS22(config-if)# end
MDS22# show fcip profile 34
error: fcip profile not found
MDS22# show fcip profile 21
FCIP Profile 21
Internet Address is 34.34.34.34 (interface GigabitEthernet2/5)
(In this line, the Gigabit Ethernet port is now shown and the FCIP profile is bound to a physical port.)
Listen Port is 3225
TCP parameters
  SACK is disabled
  PMTU discover is enabled, reset timeout is 3600 sec
  Keep alive is 60 sec
  Minimum retransmission timeout is 300 ms
  Maximum number of re-transmissions is 4
  Advertised window size is 64 KB

The following example shows a configuration error when using multiple FCIP profiles on one physical Gigabit Ethernet port.

MDS2(config)# fcip profile 21
MDS2(config-profile)# ip address 10.10.11.2
error: fcip another profile exists with same port & ip

(Multiple FCIP profiles can be used on one physical Gigabit Ethernet port, but each profile must have a different listening port.)

MDS2(config-profile)# port 32
(Change the TCP listen port on the profile. The default is 3225.)
MDS2(config-profile)# ip address 10.10.11.2
(Change the IP address for the Gigabit Ethernet port 2/1 is now accepted, and two FCIP profiles are using the same Gigabit Ethernet port.)
MDS2(config-profile)# end
MDS2# show fcip profile 21
FCIP Profile 21
  Internet Address is 10.10.11.2 (interface GigabitEthernet2/1)
  Listen Port is 32
  (This is a new TCP listen port.)
TCP parameters
  SACK is disabled
  PMTU discover is enabled, reset timeout is 3600 sec
  Keep alive is 60 sec
  Minimum retransmission timeout is 300 ms
  Maximum number of re-transmissions is 4
  Advertised window size is 64 KB
MDS2# show fcip profile 28
FCIP Profile 28
  Internet Address is 10.10.11.2 (interface GigabitEthernet2/1)
  Listen Port is 3225
  (This is the default listen port.)
TCP parameters
  SACK is disabled
  PMTU discover is enabled, reset timeout is 3600 sec
  Keep alive is 60 sec
  Minimum retransmission timeout is 300 ms
  Maximum number of re-transmissions is 4
  Advertised window size is 64 KB

Displaying Configuration Errors When Bringing Up a Tunnel on a Selected Port Using the CLI

The following example shows a configuration error when bringing a tunnel up on the selected port. This could be either an FCIP profile issue or an FCIP interface issue. Both sides must be configured correctly.

MDS2(config)# fcip profile 21
MDS2(config-profile)# port 13
(Change the TCP listen port on switch MDS2.)
MDS2(config-profile)# end
MDS2(config)# interface fcip 21
MDS2(config-if)# passive-mode
(Put interface fcip 21 in passive mode to guarantee MDS1 initiates a TCP connection.)
module-2# debug ips fcip fsm port 1
Mar 14 23:08:02 port1: 864:FCIP21: SUP-> Port VSAN (1) already set to same value
Mar 14 23:08:02 port1: 865:FCIP21: SUP-> Trunk mode (1) already set to same value
Mar 14 23:08:02 port1: 866:FCIP21: SUP-> Enable tunnel ADMIN UP
Mar 14 23:08:02 port1: 867:FCIP21: Try to Bring UP the Tunnel
Mar 14 23:08:02 port1: 868:FCIP21: Start TCP listener with peer: 10.10.10.2:13
(This debug output from switch MDS2 shows that the FCIP tunnel will not come up because switch MDS2 is listening on port 13, and switch MDS1 is trying to establish the connection on the default port 3225.)
Mar 14 23:08:02 port1: 869:FCIP: Create a new listener object for 10.10.11.2:13
Mar 14 23:08:02 port1: 870:FCIP: Create FCIP Listener with local info: 10.10.11.2:13

MDS1(config)# interface fcip 21
MDS1(config-if)# peer-info ip 10.10.11.2 port 13
(The remote end FCIP interface must be configured to establish a TCP connection on a port that is being used as a TCP listen port.)
MDS1(config-if)# end
MDS1# show interface fcip 21
fcip21 is trunking
(The FCIP tunnel is now up.)

Hardware is GigabitEthernet
Port WWN is 20:42:00:05:30:00:59:de
Peer port WWN is 20:42:00:0b:5f:d5:9f:c0
Admin port mode is auto, trunk mode is on
Port mode is TE
vsan is 1
Trunk vsans (allowed active) (1-2)
Trunk vsans (operational) (1-2)
Trunk vsans (up) ()
Trunk vsans (isolated) ()
Trunk vsans (initializing) (1-2)
Using Profile id 21 (interface GigabitEthernet2/1)
Peer Information
Peer Internet address is 10.10.11.2 and port is 13
Special Frame is disabled
Maximum number of TCP connections is 2
Time Stamp is disabled
B-port mode disabled
TCP Connection Information
2 Active TCP connections
Control connection: Local 10.10.10.2:65188, Remote 10.10.11.2:13
(The port is 13 as configured.)

Data connection: Local 10.10.10.2:65190, Remote 10.10.11.2:13
174 Attempts for active connections, 5 close of connections

MDS2# show ips stats tcp interface gigabitethernet 2/1
TCP Statistics for port GigabitEthernet2/1
Connection Stats
  44 active openings, 2 accepts
  26 failed attempts, 0 reset received, 20 established
Segment stats
  2515 received, 2342 sent, 0 retransmitted
  0 bad segments received, 0 reset sent
TCP Active Connections
Local Address    Remote Address    State    Send-Q    Recv-Q
10.10.11.2:13   10.10.10.2:65188   ESTABLISH   0      0
(The port is 13 as configured.)
FCIP Interface Misconfiguration Examples

The examples in this section show FCIP interface misconfigurations.

Displaying FCIP Misconfiguration Examples Using the CLI

The following example shows that the peer-info IP address of the remote endpoint is missing. The debug output is from the IPS module.

```
Module-2# debug ips fcip fsm port 1
module-2# Mar 14 21:37:05  port1: 38:FCIP21: SUP-> Set Port mode 1
Mar 14 21:37:05  port1: 39:FCIP21: SUP-> Port VSAN (1) already set to same value
Mar 14 21:37:05  port1: 40:FCIP21: SUP-> Trunk mode (1) already set to same value
Mar 14 21:37:05  port1: 41:FCIP21: SUP-> Enable tunnel ADMIN UP
Mar 14 21:37:05  port1: 42:FCIP21: Try to Bring UP the Tunnel
Mar 14 21:37:05  port1: 43:FCIP21: Bring up tunnel Failed, peer-ip not set
(The peer IP address is not set.)
```

```
MDS2# show interface fcip 21
fcip21 is down (Link failure or not-connected)
   Hardware is GigabitEthernet
   Port WWN is 20:42:00:0b:5f:d5:9f:c0
   Admin port mode is auto, trunk mode is on
   vsan is 1
   Using Profile id 21 (interface GigabitEthernet2/1)
   Peer Information
      (This line shows the Peer Information as empty. The line should read “Peer Internet address is 10.10.2 and port is 3225.”)
       Special Frame is disabled
       Maximum number of TCP connections is 2
       Time Stamp is disabled
       B-port mode disabled
       TCP Connection Information
          0 Attempts for active connections, 0 close of connections
          5 minutes input rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
          5 minutes output rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
          0 frames input, 0 bytes
             0 Class F frames input, 0 bytes
             0 Class 2/3 frames input, 0 bytes
             0 Error frames
          0 frames output, 0 bytes
             0 Class F frames output, 0 bytes
             0 Class 2/3 frames output, 0 bytes
             0 Error frames 0 reass frames
```
Displaying the FCIP Interface as Administratively Shut Down Using the CLI

The following example shows that the FCIP interface is administratively shut down. The debug output is from the IPS module.

Module-2# debug ips fcip fsm port 1
Mar 14 21:32:27 port1: 1:FCIP21: Create tunnel with ifindex: a000014
Mar 14 21:32:27 port1: 2:FCIP21: Get the peer info from the SUP-IPS-MGR
Mar 14 21:32:27 port1: 3:FCIP21: SUP-> Disable tunnel: already in disable state
Mar 14 21:32:27 port1: 4:FCIP21: SUP-> Set Port mode 1
Mar 14 21:32:27 port1: 5:FCIP21: SUP-> Set port index: 21
Mar 14 21:32:27 port1: 6:FCIP21: Try to Bring UP the Tunnel
Mar 14 21:32:27 port1: 7:FCIP21: Tunnel in admin down state
(The tunnel needs no shut down on the FCIP interface.)

Mar 14 21:32:27 port1: 8:FCIP21: SUP-> Set port VSAN: 1
Mar 14 21:32:27 port1: 9:FCIP21: Try to Bring UP the Tunnel
Mar 14 21:32:27 port1: 10:FCIP21: Tunnel in admin down state
Mar 14 21:32:27 port1: 11:FCIP21: SUP-> Set port WWN: 0x2042000b5fd59fc0
Mar 14 21:32:27 port1: 12:FCIP21: Try to Bring UP the Tunnel
Mar 14 21:32:27 port1: 13:FCIP21: Tunnel in admin down state
(The tunnel needs no shut down on the FCIP interface.)

Mar 14 21:32:27 port1: 14:FCIP21: SUP-> Set trunk mode: 1
Mar 14 21:32:27 port1: 16:FCIP21: Try to Bring UP the Tunnel
Mar 14 21:32:27 port1: 17:FCIP21: Tunnel in admin down state
Mar 14 21:32:27 port1: 18:FCIP21: SUP-> Switch WWN: 0x2000000b5fd59fc0
Mar 14 21:32:27 port1: 19:FCIP21: Try to Bring UP the Tunnel
Mar 14 21:32:27 port1: 20:FCIP21: Tunnel in admin down state
Mar 14 21:32:27 port1: 21:FCIP21: SUP-> Response to SB's pull all tunnel info
Mar 14 21:32:27 port1: 23:FCIP21: peer port has same value, do nothing
Mar 14 21:32:27 port1: 24:FCIP21: Set number of tcp connection 2
Mar 14 21:32:27 port1: 25:FCIP21: SUP-> Set Local listen IP: 10.10.10.2 current ip
0.0.0.0
Mar 14 21:32:27 port1: 26:FCIP21: SUP-> Set Local listen Port: 3225 current port 3225
Mar 14 21:32:27 port1: 27:FCIP21: SUP-> Enable PMTU Discovery, timeout 3600
ms
Mar 14 21:32:27 port1: 29:FCIP21: SUP-> Set keep-alive time to 60 sec. current value 60
sec

MDS2# show interface fcip 21
fcip21 is down (Administratively down)
  Hardware is GigabitEthernet
  Port WWN is 20:42:00:0b:5f:d5:9f:c0
  Admin port mode is auto, trunk mode is on
  vsan is 1
  Using Profile id 21  (interface GigabitEthernet2/1)
  Peer Information
    Peer Internet address is 10.10.10.2 and port is 3225
    Special Frame is disabled
    Maximum number of TCP connections is 2

Local MDS trying to connect to remote end point on port 13 and remote end point set to
default listen port 3225
MDS2# show interface fcip 21
fcip21 is down (Link failure or not-connected)
  Hardware is GigabitEthernet
  Port WWN is 20:42:00:0b:5f:d5:9f:c0
  Admin port mode is auto, trunk mode is on
  vsan is 1
Using Profile id 21 (interface GigabitEthernet2/1)
Peer Information
Peer Internet address is 10.10.10.2 and port is 13

MDS1# show fcip profile 21
FCIP Profile 21
Internet Address is 10.10.10.2 (interface GigabitEthernet2/1)
Listen Port is 3225
TCP parameters
  SACK is disabled
  PMTU discover is enabled, reset timeout is 3600 sec
  Keep alive is 60 sec
  Minimum retransmission timeout is 300 ms
  Maximum number of re-transmissions is 4
  Advertised window size is 64 KB

Displaying the Debug Output from the Second Switch Using the CLI

The following debug output is from switch MDS2.

Mar 14 23:26:07 port1: 1340:FCIP21: Start TCP listener with peer: 10.10.10.2:3225
Mar 14 23:26:07 port1: 1341:FCIP: Create a new listener object for 10.10.11.2:3225
Mar 14 23:26:07 port1: 1342:FCIP: Create FCIP Listener with local info: 10.10.11.2:3225
Mar 14 23:26:07 port1: 1343:FCIP: Create a DE 0xd802d140 for this tunnel
Mar 14 23:26:07 port1: 1344:FCIP21: Bind the DE 0xd802d140 [1] to tunnel LEP 0x80111570
Mar 14 23:26:07 port1: 1345:FCIP21: Start the active connection [1] to 10.10.10.2:13
Mar 14 23:26:07 port1: 1346:FCIP21: Create a DE 0xd802c80 for this tunnel
Mar 14 23:26:07 port1: 1347:FCIP21: Bind the DE 0xd802c80 [2] to tunnel LEP 0x80111570
(The switch is attempting to create a TCP connection on port 13. The creation port must match the TCP listen port on the remote endpoint.)

Mar 14 23:26:07 port1: 1349:FCIP21: Active Connect creation FAILED [1]
Mar 14 23:26:07 port1: 1350:FCIP21: Delete the DE [1]0xd802d140
Mar 14 23:26:07 port1: 1351:FCIP21: Delete the DE object [1] 0xd802d140
Mar 14 23:26:07 port1: 1352:FCIP21: Try 7 to bring up the tunnel
Mar 14 23:26:07 port1: 1353:FCIP21: Start the bringup tunnel timer, timeout: 64000
Mar 14 23:26:07 port1: 1356:FCIP21: Set ldp operation state to DOWN
Mar 14 23:26:07 port1: 1358:FCIP21: Try 8 to bring up the tunnel
Mar 14 23:26:07 port1: 1359:FCIP21: Start the bringup tunnel timer, timeout: 128000

MDS2(config-if)# peer-info ipaddr 10.10.10.2 port 3225
(This changes the start active connection port to match the default port 3225.)

Or you can use this command:

MDS2(config-if)# no peer-info ipaddr 10.10.10.2 port 13
(Removing port 13 will also set it to the default of 3225.)

MDS2# show interface fcip 21
fcip21 is trunking
  Hardware is GigabitEthernet
  Port VWN is 20:42:00:0b:5f:d5:9f:c0
  Peer port VWN is 0x80111570
  Admin port mode is auto, trunk mode is on
  Port mode is TE
  vsan is 1
  Trunk vsans (allowed active) (1-2)
  Trunk vsans (operational) (1-2)
Displaying Passive Mode Set on Both Sides of the FCIP Tunnel with the CLI

In the following example, passive mode is set on both sides of the FCIP tunnel.

module-2# Mar 14 23:49:06  port1: 1870:FCIP21: SUP-> Set Port mode 1
Mar 14 23:49:06  port1: 1871:FCIP21: SUP-> Port VSAN (1) already set to same value
Mar 14 23:49:06  port1: 1872:FCIP21: SUP-> Trunk mode (1) already set to same value
Mar 14 23:49:06  port1: 1873:FCIP21: SUP-> Enable tunnel ADMIN UP
Mar 14 23:49:06  port1: 1874:FCIP21: Try to Bring UP the Tunnel
Mar 14 23:49:06  port1: 1875:FCIP21: Start TCP listener with peer: 10.10.10.2:3225
Mar 14 23:49:06  port1: 1876:FCIP: Create a new listener object for 10.10.11.2:3225
Mar 14 23:49:06  port1: 1877:FCIP: Create FCIP Listener with local info: 10.10.11.2:3225
Mar 14 23:49:06  port1: 1878:FCIP21: Passive mode set, don’t initiate TCP connection

(A TCP connection will not be established when passive mode is set. The Gigabit Ethernet port will only listen.)

MDS2# show interface fcip 21
fcip21 is down (Link failure or not-connected)
   Hardware is GigabitEthernet
   Port WWN is 20:42:00:0b:5f:d5:9f:c0
   Admin port mode is auto, trunk mode is on
   vsan is 1
   Using Profile id 21 (interface GigabitEthernet2/1)
   Peer Information
      Peer Internet address is 10.10.10.2 and port is 3225
      Passive mode is enabled

(Passive mode is set, so a TCP connection will not be established.)

Special Frame is disabled
MDS1# show interface fcip 21
fcip21 is down (Link failure or not-connected)
   Hardware is GigabitEthernet
   Port WWN is 20:42:00:05:30:00:59:de
   Admin port mode is auto, trunk mode is on
   vsan is 1
   Using Profile id 21 (interface GigabitEthernet2/1)
   Peer Information
      Peer Internet address is 10.10.11.2 and port is 3225
      Passive mode is enabled

(Both sides are set to passive mode. You must change one or both sides to no passive-mode under the FCIP interface.)

Special Frame is disabled
MDS2(config)# interface fcip 21
MDS2(config-if)# no passive-mode
Displaying a Time Stamp Acceptable Difference Failure Using the CLI

The following example shows a time stamp acceptable difference failure, or no NTP server connected to synchronize clocks. When using time stamps, the MDS switch must be a synchronized clock. NTP is configurable on the MDS 9000 switch.

```
MDS2(config)# interface fcip 21
MDS2(config-if)# time-stamp
MDS2(config-if)# debug ips fcip fsm port 1
```

Mar 15 00:01:35  port1: 3248:FCIP21: IPS-> Enable timestamp acceptable difference 1000
(Time stamp is enabled under the FCIP interface. The default acceptable difference is 1000.)

Mar 15 00:01:35  port1: 3249:FCIP21: IPS-> acc diff in sec: 0x1 frac: 0x0
Mar 15 00:01:35  port1: 3250:FCIP21: Sending response code: 0
Mar 15 00:01:48  port1: 3251:FCIP21: Time stamp tolerance check failed local time: 0x3e726d6c2db994b7 tolerance: 0x100000000 recv time: 0x3e7251ace20db73a
(The timestamp difference failed the acceptable difference.)

Mar 15 00:01:48  port1: 3252:FCIP21: Time stamp tolerance check failed local time: 0x3e726d6c2db994b7 tolerance: 0x100000000 recv time: 0x3e7251ace20db73a
Mar 15 00:01:48  port1: 3253:FCIP21: Time stamp tolerance check failed local time: 0x3e726d6c2db994b7 tolerance: 0x100000000 recv time: 0x3e7251ace20db73a
Mar 15 00:01:48  port1: 3254:FCIP21: time-stamp module-2# debug ips fcip fsm port 1
Mar 15 00:01:48  port1: 3255:FCIP21: (fcip_de_rcv): Previous partial packet - Concatenating
Mar 15 00:01:48  port1: 3256:FCIP21: Time stamp tolerance check failed local time: 0x3e726d6c2db994b7 tolerance: 0x100000000 recv time: 0x3e7251ace20db73a
Mar 15 00:01:48  port1: 3257:FCIP21: FCIP frame len 0x300 is not within correct range <<<
Mar 15 00:01:48  port1: 3258:FCIP21: Delete the DE [2] 0xd802d680
Mar 15 00:01:48  port1: 3259:FCIP21: replace the eport entry at index: 1
Mar 15 00:01:48  port1: 3260:FCIP21: DE [-670902656] 0x00000002 terminate tcp connection 0xd8072800
(The TCP connection is disconnected because the time stamp difference is too large.)

Mar 15 00:01:48  port1: 3261:FCIP21: Delete the DE object [2] 0xd802d680
Mar 15 00:01:48  port1: 3262:FCIP21: Delete the DE object [1] 0xd802cf00
Mar 15 00:01:48  port1: 3263:FCIP21: Unregister from flamingo port_index: 0x21
Mar 15 00:01:48  port1: 3264:FCIP21: Send Link down to SUP
Mar 15 00:01:48  port1: 3265:FCIP21: Start the bringup tunnel timer, timeout: 18470
Mar 15 00:01:48  port1: 3266:FCIP21: replace the eport entry at index: 0
Mar 15 00:01:48  port1: 3267:FCIP21: Set tep operation state to DOWN
Mar 15 00:01:48  port1: 3268:FCIP21: DE [-670904576] 0x000000001 terminate tcp connection 0xd8072c00
Mar 15 00:01:48  port1: 3269:FCIP21: Delete the DE object [1] 0xd802cf00
Mar 15 00:01:50  port1: 3270:FCIP21: Received new TCP connection from peer: 10.10.10.2:65066
(The TCP connection begins trying to reestablish the connection.)

Mar 15 00:01:50  port1: 3271:FCIP21: Tunnel is not ADMIN UP state, reject new TCP connection from 10.10.10.2:65066
Mar 15 00:01:50  port1: 3272:FCIP21: Received new TCP connection from peer: 10.10.10.2:65064
Send documentation comments to mdsfeedback-doc@cisco.com

Mar 15 00:01:50  port1: 3309:FCIP21: Tunnel is not ADMIN UP state, reject new TCP connection from 10.10.10.2:65064
Mar 15 00:01:56  port1: 3310:FCIP21: SUP-> Set Port mode 1
Mar 15 00:01:56  port1: 3311:FCIP21: SUP-> Port VSAN (1) already set to same value
Mar 15 00:01:56  port1: 3312:FCIP21: SUP-> Set trunk mode: 1
Mar 15 00:01:56  port1: 3313:FCIP21: SUP-> Enable tunnel ADMIN UP
Mar 15 00:01:56  port1: 3314:FCIP21: Try to Bring UP the Tunnel
Mar 15 00:01:56  port1: 3315:FCIP21: tunnel bring-up debounce timer set, wait for timer to pop

(Connect the NTP server or synchronized clocks, or increase the acceptable difference.)

module-2# debug ips fcip fsm port 1
module-2#
Jan 14 14:22:08  port1: 854886:FCIP21: IPS-> Enable timestamp acceptable difference 2000
Jan 14 14:22:08  port1: 854887:FCIP21: IPS-> acc diff in sec: 0x2 frac: 0x0

(The time stamp acceptable difference passes and the tunnel continues to be brought up.)

module-2# module-2# Jan 14 14:22:39  port1: 854932:FCIP21: Received new TCP connection from peer: 10.10.10.2:64170
Jan 14 14:22:39  port1: 854933:FCIP21: Create a DE 0xd802d5c0 for this tunnel
Jan 14 14:22:39  port1: 854934:FCIP21: Bind the DE 0xd802d5c0 [1] to tunnel LEP 0x80111570
Jan 14 14:22:39  port1: 854935:FCIP21: Bind DE 1 to TCP-hdl 0xd8071000
Jan 14 14:22:39  port1: 854936:FCIP21: Bind DE 1 to eport 0x80110550
Jan 14 14:22:39  port1: 854937:FCIP21: bind de 1 in eport 0x80110550, hash = 1 num-conn: 2
Jan 14 14:22:39  port1: 854938:FCIP21: Received new TCP connection from peer: 10.10.10.2:64170
Jan 14 14:22:39  port1: 854939:FCIP21: Create a DE 0xd802c900 for this tunnel
Jan 14 14:22:39  port1: 854940:FCIP21: Bind the DE 0xd802c900 [2] to tunnel LEP 0x80111570
Jan 14 14:22:39  port1: 854941:FCIP21: Bind DE 2 to TCP-hdl 0xd8070000
Jan 14 14:22:39  port1: 854942:FCIP21: Bind DE 2 to eport 0x80110550
Jan 14 14:22:39  port1: 854943:FCIP21: bind de 2 in eport 0x80110550, hash = 2 num-conn: 2
Jan 14 14:22:39  port1: 854944:FCIP21: Send LINK UP to SUP
Jan 14 14:22:39  port1: 854945:FCIP21: *** Received eisl frame in E mode
Jan 14 14:22:39  port1: 854947:FCIP21: Change the operational mode to TRUNK

MDS2# show interface fcip 21
fcip21 is trunking
    Hardware is GigabitEthernet
    Port WWN is 20:42:00:0b:5f:d5:9f:c0
    Peer port WWN is 20:42:00:05:30:00:59:de
    Admin port mode is auto, trunk mode is on
    Port mode is TE
    vsan is 1
    Trunk vsans (allowed active) (1-2)
    Trunk vsans (operational) (1-2)
    Trunk vsans (up) (1-2)
    Trunk vsans (isolated) ()
    Trunk vsans (initializing) ()
    Using Profile id 21 (interface GigabitEthernet2/1)
    Peer Information
    Peer Internet address is 10.10.10.2 and port is 3225
    Special Frame is disabled
    Maximum number of TCP connections is 2
    Time Stamp is enabled, acceptable time difference 2000 ms
    B-port mode disabled
    TCP Connection Information
Chapter 20  Troubleshooting IP Storage Services

FCIP Issues

Figure 20-7 shows a trace of time stamp difference failure.

**Figure 20-7  Trace of Time-stamp Difference Failure**

Figure 20-8 shows a trace of timestamp difference accepted.

**Figure 20-8  Trace of Time-stamp Difference Accepted**

FCIP Special Frame Tunnel Creation and Monitoring

The FCIP tunnel configuration (see the “One-to-One FCIP Tunnel Creation and Monitoring” section on page 20-10 and the “One-to-Three FCIP Tunnel Creation and Monitoring” section on page 20-20) must be completed before adding the FCIP special frame configuration. This section describes how to correctly configure and show an FCIP tunnel with a special frame.
Configuring and Displaying an FCIP Tunnel with Special Frame Using the CLI

To configure and display an FCIP tunnel with a special frame using the CLI, follow these steps:

---

**Step 1**  
Use the `show wwn switch` command to verify the WWN of each MDS 9000 Family switch end point.

```
MDS2# show wwn switch
Switch WWN is 20:00:00:0b:5f:d5:9f:c0
```

**Step 2**  
Use the `special-frame peer-wwn` command to enable the FCIP special frame that is used in creating the FCIP tunnel.

```
MDS2(config)# interface fcip 21
MDS2(config-if)# special-frame peer-wwn 20:00:00:05:30:00:59:de profile-id 1
```

---

**Step 3**  
Use the `show interface fcip` command to verify that a special frame is enabled.

```
MDS2# show interface fcip 21
fcip21 is trunking
  Hardware is GigabitEthernet
  Port WWN is 20:42:00:0b:5f:d5:9f:c0
  Peer port WWN is 20:42:00:05:30:00:59:de
  Admin port mode is auto, trunk mode is on
  Port mode is TE
```
Chapter 20  Troubleshooting IP Storage Services

Send documentation comments to mdsfeedback-doc@cisco.com

vsan is 1
Trunk vsans (allowed active) (1-2)
Trunk vsans (operational) (1-2)
Trunk vsans (up) (1-2)
Trunk vsans (isolated) ()
Trunk vsans (initializing) ()
Using Profile id 21 (interface GigabitEthernet2/1)

Peer Information
Peer Internet address is 10.10.10.2 and port is 3225
Special Frame is enabled
Peer switch WWN is 20:00:00:05:30:00:59:de
Maximum number of TCP connections is 2
Time Stamp is enabled, acceptable time difference 3000 ms
B-port mode disabled

TCP Connection Information
2 Active TCP connections
Control connection: Local 10.10.11.2:64792, Remote 10.10.10.2:3225
Data connection: Local 10.10.11.2:64794, Remote 10.10.10.2:3225
372 Attempts for active connections, 345 close of connections

TCP Parameters
Path MTU 1500 bytes
Current retransmission timeout is 300 ms
Round trip time: Smoothed 10 ms, Variance: 5
Advertized window: Current: 64 KB, Maximum: 64 KB, Scale: 1
Peer receive window: Current: 64 KB, Maximum: 64 KB, Scale: 1
Congestion window: Current: 2 KB, Slow start threshold: 1048560 KB

Step 4  Use the show wwn switch command on the remote switch to verify the peer switch WWN.

Figure 20-9 shows a trace of an FCIP tunnel with a special frame.

<table>
<thead>
<tr>
<th>No.</th>
<th>Time</th>
<th>Source</th>
<th>Destination</th>
<th>Protocol</th>
<th>RTT</th>
<th>HW Dest</th>
<th>Offset</th>
<th>Method</th>
<th>Name</th>
<th>Flags</th>
<th>CS</th>
<th>CK</th>
<th>Frame Type</th>
<th>Frame Duration</th>
<th>Flags</th>
<th>CK</th>
<th>HW Dest</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP (special frame)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP (special frame)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP (special frame)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TCP (special frame)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 20-9  Trace of FCIP Tunnel with a Special Frame
Special Frame Misconfiguration Example

The following example shows an incorrect peer WWN when using a special frame.

Example 20-1 Annotated Example of Incorrect Peer WWN with Special Frame Enabled

```
module=24  Jan 14 15:14:30  port1: 855278:FCIP21: SUP-> Set Port mode 1
Jan 14 15:14:30  port1: 855279:FCIP21: SUP-> Port VSAN (1) already set to same value
Jan 14 15:14:30  port1: 855280:FCIP21: SUP-> Trunk mode (1) already set to same
Jan 14 15:14:30  port1: 855281:FCIP21: Try to Bring UP the Tunnel
Jan 14 15:14:30  port1: 855282:FCIP21: Start TCP listener with peer: 10.10.10.2:3225
Jan 14 15:14:30  port1: 855284:FCIP: Create a new listener object for 10.10.11.2:3225
Jan 14 15:14:30  port1: 855286:FCIP21: Create a DE 0xd802d240 for this tunnel
Jan 14 15:14:30  port1: 855287:FCIP21: Bind the DE 0xd802d240 [1] to tunnel LEP 0x80111570
Jan 14 15:14:30  port1: 855288:FCIP21: Start the active connection [1] to 10.10.10.2:3225
Jan 14 15:14:30  port1: 855289:FCIP21: Create a DE 0xd802d200 for this tunnel
Jan 14 15:14:30  port1: 855290:FCIP21: Bind the DE 0xd802d200 [2] to tunnel LEP 0x80111570
Jan 14 15:14:30  port1: 855291:FCIP21: Start the active connection [2] to 10.10.10.2:3225
Jan 14 15:14:30  port1: 855292:FCIP21: Active Connect creation SUCCEEDED [1]
Jan 14 15:14:30  port1: 855293:FCIP21: Port 1 TCP-hdl 0xd8072c00
Jan 14 15:14:30  port1: 855294:FCIP21: Setup for Special Frame handling: I'm Originator
Jan 14 15:14:30  port1: 855295:FCIP21: Send the SF as Originator & wait for response
Jan 14 15:14:30  port1: 855296:FCIP21: Setup timer to wait for SF
Jan 14 15:14:30  port1: 855297:FCIP21: Active Connect creation SUCCEEDED [2]
Jan 14 15:14:30  port1: 855298:FCIP21: Port 2 TCP-hdl 0xd8072000
Jan 14 15:14:30  port1: 855299:FCIP21: Setup for Special Frame handling: I'm Originator
Jan 14 15:14:30  port1: 855300:FCIP21: Send the SF as Originator & wait for response
Jan 14 15:14:30  port1: 855301:FCIP21: Setup timer to wait for SF
Jan 14 15:14:30  port1: 855302:FCIP21: TCP Received a close connection [1] reason 1
Jan 14 15:14:30  port1: 855303:FCIP21: Delete the DE [1]0xd802d240
Jan 14 15:14:30  port1: 855304:FCIP21: DE [-670903744] 0x00000001 terminate tcp connection
0xd8072c00
Jan 14 15:14:30  port1: 855305:FCIP21: Delete the DE object [1]0xd802d240
Jan 14 15:14:30  port1: 855306:FCIP21: lep not bound, close only de [1]
Jan 14 15:14:30  port1: 855307:FCIP21: TCP Received a close connection [2] reason 1
Jan 14 15:14:30  port1: 855308:FCIP21: Delete the DE [2]0xd802d200
Jan 14 15:14:30  port1: 855309:FCIP21: Set lep operation state to DOWN
Jan 14 15:14:30  port1: 855310:FCIP21: Start the bringup tunnel timer, timeout: 38740
Jan 14 15:14:30  port1: 855311:FCIP21: DE [-670903808] 0x00000002 terminate tcp connection
0xd8072000
Jan 14 15:14:30  port1: 855312:FCIP21: Delete the DE object [2]0xd802d200
Jan 14 15:14:30  port1: 855313:FCIP21: lep not bound, close only de [2]
Jan 14 15:14:31  port1: 855314:FCIP21: Received new TCP connection from peer: 10.10.10.2:64050
Jan 14 15:14:31  port1: 855315:FCIP21: Create a DE 0xd802d080 for this tunnel
Jan 14 15:14:31  port1: 855316:FCIP21: Bind the DE 0xd802d080 [1] to tunnel LEP 0x80111570
Jan 14 15:14:31  port1: 855317:FCIP21: Bind DE 1 to TCP-hdl 0xd8072000
Jan 14 15:14:31  port1: 855318:FCIP21: Setup for Special Frame handling: I'm Responder
Jan 14 15:14:31  port1: 855319:FCIP21: Setup timer to wait for SF
Jan 14 15:14:31  port1: 855320:FCIP21: processing SF frame, I'm Responder
Jan 14 15:14:31  port1: 855321:FCIP21: Source FC fabric name in SF (0x02000005300059de) does not match LEP's peer fabric WWN (6e20010005300059de)
Jan 14 15:14:31  port1: 855322:FCIP21: Delete the DE [1]0xd802d080
Jan 14 15:14:31  port1: 855323:FCIP21: Set lep operation state to DOWN
Jan 14 15:14:31  port1: 855324:FCIP21: DE [-670904192] 0x00000001 terminate tcp connection
0xd8072000
Jan 14 15:14:31  port1: 855325:FCIP21: Delete the DE object [1]0xd802d080
Jan 14 15:14:31  port1: 855326:FCIP21: Received new TCP connection from peer: 10.10.10.2:64048
Jan 14 15:14:31  port1: 855327:FCIP21: Create a DE 0xd802d200 for this tunnel
```

Troubleshooting FCIP Link Flaps

If you have an FCIP link that flaps, adjust the TCP keepalive and max retransmission values. In Fabric Manager, choose ISLs > FCIP, select the Profiles tab and set the Keepalive field. In the CLI, use the `tcp keepalive-timeout` and `tcp max-retransmissions` commands in FCIP profile submode.

Troubleshooting FCIP ISL Link Failures

If you have an FCIP ISL link that experiences unexplained failures, the FCIP profile in use may not be configured to match the underlying physical link characteristics and the shared traffic constraints. For example, if you have a 200 Mbps physical link and you have configured two FCIP tunnels across that link, each with 155 Mbps traffic, link failures will occur because the physical connection cannot handle the traffic.
To resolve the problem, tune the TCP parameters in the FCIP profile to match the characteristic and constraints of the physical link and any other traffic shared on that link.

See “Verifying the Configuration of the Profiles Using the CLI” section on page 20-15 for details on the adjustable parameters in the FCIP profile.

### Troubleshooting FCIP and Compression

If you have an FCIP tunnel between an IPS module and a Cisco MDS 14/2, 9221i or MDS 18/4 module, use the same compression mode on both sides of the FCIP tunnel. In this specific configuration, avoid compression mode 1, because the Cisco MDS module could send compressed traffic faster than the IPS module could process.

### iSCSI Issues

This section contains information on troubleshooting iSCSI and includes the following topics:

- Troubleshooting iSCSI Authentication, page 20-35
- Displaying iSCSI Authentication Using Fabric Manager, page 20-36
- Displaying iSCSI Authentication Using the CLI, page 20-36
- Troubleshooting User Name and Password Configuration, page 20-37
- RADIUS Configuration Troubleshooting, page 20-38
- Troubleshooting RADIUS Routing Configuration, page 20-40
- Troubleshooting Dynamic iSCSI Configuration, page 20-41

### Troubleshooting iSCSI Authentication

iSCSI user login authentication is required with the Cisco MDS 9000 Family switch. There are two ways to authenticate iSCSI users: either locally in the switch’s configuration file or using the RADIUS server database.

Figure 20-10 shows a successful iSCSI login for the Windows 2000 driver.

**Figure 20-10 Successful iSCSI Login Status Window**
On Solaris systems, a successful login is found in the /var/adm/messages directory and should look similar to the following example:

Mar 14 12:53:23 ca-sun1 iscsid[12745]: [ID 702911 daemon.notice] discovery process for 172.22.91.223 finished, exiting
Mar 14 12:58:45 ca-sun1 iscsid[12802]: [ID 448557 daemon.notice] logged into DiscoveryAddress 172.22.91.223:3260 isid 023d0040
Mar 14 12:58:45 ca-sun1 iscsid[12802]: [ID 702911 daemon.notice] iSCSI target 2 = iqn.com.domainname.vrrp-11.gw.21000020375aff77 at0
Mar 14 12:58:45 ca-sun1 iscsid[12802]: [ID 702911 daemon.notice] iSCSI target 3 = iqn.com.domainname.vrrp-11.gw.21000020374baf02 at0

Figure 20-11 shows a failed iSCSI login for the Windows 2000 driver.

On Solaris systems, a failed login is found in the /var/adm/messages directory and should look similar to the following example:

Mar 14 11:44:42 ca-sun1 iscsid[12561]: [ID 702911 daemon.notice] login rejected: initiator error (01)
Mar 14 11:44:42 ca-sun1 iscsid[12561]: [ID 702911 daemon.error] Hard discovery login failure to 172.22.91.223:3260 - exiting
Mar 14 11:44:42 ca-sun1 iscsid[12561]: [ID 702911 daemon.notice] discovery process for 172.22.91.223 finished, exiting

Displaying iSCSI Authentication Using Fabric Manager

Whenever you experience a login failure, choose End Devices > iSCSI, select the Globals tab, and view the AuthMethod field to see if the iSCSI authentication is correctly defined.

Displaying iSCSI Authentication Using the CLI

Whenever you experience a login failure, use the show authentication command to see if the iSCSI authentication is correctly defined. This is an example of local authentication:

switch# show authentication
authentication method:none
    console:not enabled
telnet/ssh:not enabled
authentication method:radius
    console:not enabled
telnet/ssh:not enabled
Send documentation comments to mdsfeedback-doc@cisco.com

iscsi: not enabled
authentication method: local
console: enabled
telnet/ssh: enabled
iscsi: enabled

switch#

If iSCSI is configured for RADIUS authentication, it should look like this:

switch# show authentication
authentication method: none
console: not enabled
telnet/ssh: not enabled
authentication method: radius
console: not enabled
telnet/ssh: not enabled
iscsi: enabled
authentication method: local
console: enabled
telnet/ssh: enabled
iscsi: enabled

switch#

Troubleshooting User Name and Password Configuration

Check the client-side user name and password with either the switch’s local configuration file or the RADIUS server.

Verifying iSCSI User Account Configuration Using Fabric Manager

If iSCSI user authentication is through the switch’s local user database, choose Switches > Security > Users and Roles and select the Users tab to verify that the iSCSI users are configured correctly with the user name and password.

Note
The iSCSI password must be at least 16 characters.

Verifying iSCSI User Account Configuration Using the CLI

If iSCSI user authentication is through the switch’s local user database, use the show user-account command to verify that the iSCSI users are configured correctly with the user name and password.

Note
The iSCSI password must be at least 16 characters.

switch# show user-account iscsi
username: iscsi
secret: 1234567812345678
username: iscsiuser
secret: 1234567812345678
RADIUS Configuration Troubleshooting

If iSCSI authentication is through the RADIUS server, ping the RADIUS server to and from the switch to make sure it can be reached over IP.

Verifying RADIUS Key and Port for Authentication and Accounting

Choose **Switches > Security > AAA > RADIUS** in Fabric Manager to verify the RADIUS key and port for authentication.

Or use the **show radius-server** CLI command to verify that the RADIUS key and port for authentication and accounting are an exact match with what is configured on the RADIUS server.

```
switch# show radius-server
retransmission count:3
timeout value:5

following RADIUS servers are configured:
  171.71.49.197:
  available for authentication on port:1812
  available for accounting on port:1813
  RADIUS shared secret:radius
```

Adjust the RADIUS timeout and retransmission accordingly, as they have a default value of 1 second and 1 time.

**Figure 20-12** shows a Windows-based RADIUS server configuration.

**Figure 20-12**  Windows-Based RADIUS Server Configuration Dialog Box

If the items in **Figure 20-12** match your switch’s configuration, then verify that the client user name and password also match those in the RADIUS server.

The following example shows the output of the **debug security radius** command, if the iSCSI client logs in successfully.
Send documentation comments to mdsfeedback-doc@cisco.com

switch# Mar 4 23:16:20 securityd: received CHAP authentication request for user002
Mar 4 23:16:20 securityd: RADIUS is enabled, hence it will be tried first for CHAP authentication
Mar 4 23:16:20 securityd: reading RADIUS configuration
Mar 4 23:16:20 securityd: opening radius configuration for group:default
Mar 4 23:16:20 securityd: opened the configuration successfully
Mar 4 23:16:20 securityd: GET request for RADIUS global config
Mar 4 23:16:20 securityd: got back the return value of global radius configuration operation:success
Mar 4 23:16:20 securityd: closing RADIUS pss configuration
Mar 4 23:16:20 securityd: opening radius configuration for group:default
Mar 4 23:16:20 securityd: opened the configuration successfully
Mar 4 23:16:20 securityd: GET request for RADIUS global config
Mar 4 23:16:20 securityd: got back the return value of global radius configuration operation:success
Mar 4 23:16:25 securityd: closing RADIUS pss configuration
Mar 4 23:16:25 securityd: opening radius configuration for group:default
Mar 4 23:16:25 securityd: opened the configuration successfully
Mar 4 23:16:25 securityd: GETNEXT request for radius index:0 addr:
Mar 4 23:16:25 securityd: verified the response from:171.71.49.197
Mar 4 23:16:25 securityd: RADIUS server sent accept for authentication request for user002
Mar 4 23:16:25 securityd: received CHAP authentication request for user002
Mar 4 23:16:25 securityd: RADIUS is enabled, hence it will be tried first for CHAP authentication
Mar 4 23:16:25 securityd: reading RADIUS configuration
Mar 4 23:16:25 securityd: opening radius configuration for group:default
Mar 4 23:16:25 securityd: opened the configuration successfully
Mar 4 23:16:25 securityd: GETNEXT request for radius index:0 addr:
Mar 4 23:16:25 securityd: verified the response from:171.71.49.197
Mar 4 23:16:25 securityd: RADIUS server sent accept for authentication request for user002
Mar 4 23:16:25 securityd: got some reply from 171.71.49.197
Mar 4 23:16:25 securityd: verified the response from:171.71.49.197
Mar 4 23:16:25 securityd: RADIUS server sent accept for authentication request for user002
Mar 4 23:16:25 securityd: got some reply from 171.71.49.197
Mar 4 23:16:25 securityd: verified the response from:171.71.49.197
Mar 4 23:16:25 securityd: RADIUS server sent accept for authentication request for user002

The previous example shows that the iSCSI client has been authenticated three times, first for the switch login, and the second and third times for the iSCSI driver login. The switch sends RADIUS attributes 1, 3, 4, 5, 6, 60 and 61 to the RADIUS server. The RADIUS server only needs to respond with request accept or request reject.

The following example shows a RADIUS authentication.

639 2003y3m14d 15h12m48s -----------------------------------------------
640 2003y3m14d 15h12m48s Message Type=Access_Request
641 2003y3m14d 15h12m48s ID=243, Length=90
642 2003y3m14d 15h12m48s User name=user002
643 2003y3m14d 15h12m48s NAS IP address=2887147911
644 2003y3m14d 15h12m48s CHAP password=‰j÷<¸Wøøë-K–ëÙ<
645 2003y3m14d 15h12m48s CHAP challenge=n8NÝgø§"__Ó4}Ôx
646 2003y3m14d 15h12m48s NAS port=1426
647 2003y3m14d 15h12m48s NAS port type=5
648 2003y3m14d 15h12m48s Service type=8
649 2003y3m14d 15h12m48s User (user002) authenticate OK.
650 2003y3m14d 15h12m54s -------------------------------
651 2003y3m14d 15h12m54s Message Type=Access_Request
652 2003y3m14d 15h12m54s ID=60, Length=90
653 2003y3m14d 15h12m54s User name=user002
654 2003y3m14d 15h12m54s NAS IP address=2887147911
Troubleshooting RADIUS Routing Configuration

The switch sends the RADIUS authentication request from the mgmt0 interface, so the correct route to the RADIUS server must be defined. If no correct route is defined, the switch may send the RADIUS request from the Gigabit Ethernet port. In that case, the RADIUS server returns the accept to the Gigabit Ethernet port and the switch does not get the response.

Displaying the Debug Output for RADIUS Authentication Request Routing Using the CLI

The following example shows the output from the `debug security radius` command.

```
switch# Mar  5 00:51:13 securityd: received CHAP authentication request for user002
Mar  5 00:51:13 securityd: RADIUS is enabled, hence it will be tried first for CHAP authentication
Mar  5 00:51:13 securityd: reading RADIUS configuration
Mar  5 00:51:13 securityd: opening radius configuration for group:default
Mar  5 00:51:13 securityd: opened the configuration successfully
Mar  5 00:51:13 securityd: GET request for RADIUS global config
Mar  5 00:51:13 securityd: got back the return value of global radius configuration operation:success
Mar  5 00:51:13 securityd: closing RADIUS pss configuration
Mar  5 00:51:13 securityd: opening radius configuration for group:default
Mar  5 00:51:13 securityd: opened the configuration successfully
Mar  5 00:51:13 securityd: GETNEXT request for radius index:0 addr:
Mar  5 00:51:18 securityd: sending data to 171.71.49.197
Mar  5 00:51:18 securityd: waiting for response from 171.71.49.197
Mar  5 00:51:23 securityd: sending data to 171.71.49.197
Mar  5 00:51:23 securityd: waiting for response from 171.71.49.197
Mar  5 00:51:28 securityd: sending data to 171.71.49.197
Mar  5 00:51:28 securityd: waiting for response from 171.71.49.197
Mar  5 00:51:33 securityd: trying out next server
Mar  5 00:51:33 securityd: no response from RADIUS server for authentication user002
Mar  5 00:51:33 securityd: doing local chap authentication for user002
Mar  5 00:51:33 securityd: local chap authentication result for user002: user not present
```
Troubleshooting Dynamic iSCSI Configuration

A physical Fibre Channel target (target pWWN) presented as an iSCSI target, makes the physical target accessible to an iSCSI initiator. The IPS module presents physical Fibre Channel targets as iSCSI targets to iSCSI initiators in one of two ways: dynamic mapping or static mapping.

By default, the IPS module does not automatically import Fibre Channel targets. Either dynamic or static mapping must be configured before the IPS module makes Fibre Channel targets available to iSCSI initiators. When both are configured, statically mapped Fibre Channel targets have the configured name. Targets that are not mapped will be advertised with the name created by the conventions explained in this section.

Checking the Configuration

Use the following guidelines to verify the configuration of the Gigabit Ethernet interface.

- Ensure that you are configuring the proper slot or port.
- Ensure that the Gigabit Ethernet interfaces are not shut down. Each Gigabit Ethernet interface is “partnered” with a virtual iSCSI interface. For iSCSI to operate on a particular Gigabit Ethernet, the virtual iSCSI interface for that port must be in a “no shutdown” state:

  - Choose Switches > Interfaces > Gigabit Ethernet in Fabric Manager.

  - Or use the interface CLI command:

    ```
    interface Gigabit Ethernet 3/1
    no shutdown
    ..
    ..
    interface iscsi 3/1
    no shutdown
    ```

- Verify that the IP parameters are correct.
- Verify that the authentication on the Gigabit Ethernet interface (none or chap) matches the authentication configured on the iSCSI initiator.

  **Note** Configuring authentication at the interface level overrides the global authentication setting.

- Verify that the Gigabit Ethernet switchport parameters are correct (MTU, mode, and so on.).

Performing Basic Dynamic iSCSI Troubleshooting

Use the following guidelines to perform basic dynamic iSCSI troubleshooting:

- Enable dynamic mapping of Fibre Channel targets:

  - Choose End Devices > iSCSI, select the Initiators tab and check the Dynamic check box in Fabric Manager to allow iSCSI targets to be discovered by the logged-in iSCSI initiators.

  - Use the `iscsi import target fc` CLI command to allow iSCSI targets to be discovered by the logged-in iSCSI initiators.
Dynamic iSCSI configuration places all iSCSI initiators logging into the MDS 9000 switch into VSAN 1 by default.

Any zoning in effect on the default VSAN (VSAN1) will also be applied to iSCSI-connected devices.

### Useful Show Commands to Debug Dynamic iSCSI Configuration

The `show` commands in this section are used to debug dynamic iSCSI configuration. The following command output indicates correctly established iSCSI sessions. Run these commands on your switch and compare the output with these samples to help identify possible issues.

- `show iscsi session detail`
- `show iscsi remote-node initiator`
- `show iscsi stats`
- `show iscsi stats detail`
- `show iscsi local-node`
- `show fcns data vsan 1`
- `show flogi database vsan 1`

#### show iscsi session detail Command Output

```
switch# show iscsi session detail
Session #1 (index 2)
  Target iqn.com.domainname.IPS-TEST.02-07.gw.202300a080b14da
  VSAN 1, ISID 000000000000, TSID 134, Status active, no reservation
  Type Normal, ExpCmdSN 44, MaxCmdSN 53, Barrier 0
  MaxBurstSize 0, MaxConn 0, DataPDUInOrder No
  DataSeqInOrder No, InitialR2T Yes, ImmediateData No
  Registered LUN 0, Mapped LUN 0
  Stats:
    PDU: Command: 42, Response: 36
    Bytes: TX: 4960, RX: 0
  Number of connection: 1
  Connection #1
    Local IP address: 0xa021ec8, Peer IP address: 0xa021eca
    CID 0, State: LOGGED_IN
    StatSN 43, ExpStatSN 0
    MaxRecvDSLength 524288, our_MaxRecvDSLength 1024
    CSG 3, NSG 3, min_pdu_size 48 (w/ data 48)
    AuthMethod none, HeaderDigest None (len 0), DataDigest None (len 0)
    Version Min: 0, Max: 0
    FC target: Up, Reorder PDU: No, Marker send: No (int 0)
    Received MaxRecvDSLen key: Yes
```

#### show iscsi remote-node initiator Command Output

```
switch# show iscsi remote-node initiator
iSCSI Node name is iqn.1987-05.com.cisco.02.F984B8A7E08C307E2D87A099B2D452F3.FULLMOON 
  iSCSI alias name: FULLMOON
  Node WWN is 20:0c:00:0b:be:77:72:42 (dynamic)
  Member of vsans: 1
  Number of Virtual n_ports: 1
  Virtual Port WWN is 20:0d:00:0b:be:77:72:42 (dynamic)
  Interface iSCSI 2/7, Portal group tag: 0x86
```
![Send documentation comments to mdsfeedback-doc@cisco.com](Send%20documentation%20comments%20to%20mdsfeedback-doc@cisco.com)

VSAN ID 1, FCID 0x750105

show iscsi local-node Command Output

```
switch# show iscsi local-node
target: iqn.com.domainname.IPS-TEST.02-07.gw.202300a0b80b14da
    Port WWN 20:23:00:a0:b8:0b:14:da , VSAN 1
    Auto-created node
```

show fcns data vsan 1 Command Output

```
switch# show fcns data vsan 1
VSAN 1:
-----------------------------------------------------------------------
| FCID      | TYPE | PWWN                          | (VENDOR)       | FC4-TYPE:FEATURE |
-----------------------------------------------------------------------
0x750000   N   20:23:00:a0:b8:0b:14:da (SymBios) | scsi-fcp:target |
0x750102   N   10:00:00:00:c9:30:ba:06 (Emulex) | scsi-fcp:init   |
0x750105   N   20:00:00:00:be:be:77:2d:42 | scsi-fcp:init isc..w |
0x750201   N   50:08:05:f3:00:04:96:71 | scsi-fcp |
0x750301   N   50:08:05:f3:00:04:96:79 | scsi-fcp |
0x750400   N   20:00:00:02:3d:07:05:c0 (NuSpeed) | scsi-fcp:init |
```

show flogi database vsan 1 Command Output

```
switch# show flogi database vsan 1
-----------------------------------------------------------
| INTERFACE | VSAN | FCID                  | PORT NAME       | NODE NAME |
-----------------------------------------------------------
fc1/1      1   0x750400  20:00:00:02:3d:07:05:c0 | 10:00:00:02:3d:07:05:c0 |
fc1/6      1   0x750000  20:23:00:a0:b8:0b:14:da | 20:22:00:a0:b8:0b:14:d9 |
fc1/8      1   0x750102  10:00:00:00:c9:30:ba:06 | 20:00:00:00:c9:30:ba:06 |
fc1/9      1   0x750201  50:08:05:f3:00:04:96:71 | 50:08:05:f3:00:04:96:70 |
fc1/10     1   0x750301  50:08:05:f3:00:04:96:79 | 50:08:05:f3:00:04:96:70 |
iscsi2/7   1   0x750105  20:00:00:0b:be:77:72:42 | 20:00:00:0b:be:77:72:42 |
```

Virtual Target Access Control

Use the following guidelines when creating a virtual target:

- Did you specify the correct pWWN?
- If you are creating a virtual target from a subset of LUN(s) of a physical device, did you specify the correct Fibre Channel (physical) LUN(s) and iSCSI (virtual) LUN(s)?
- If using an access list to control access to the virtual target, did you specify the correct initiator(s)?
  - If you are not using an access list to restrict access, did you choose `End Devices > iSCSI`, select the `Targets` tab and check the `Initiator Access All` check box in Fabric Manager or use the `all-initiator-permit` CLI option to insure all initiators have access?
- If restricting access to a particular interface(s), did you specify the correct Gigabit Ethernet interface(s)?

Useful Show Commands to Debug Static iSCSI Configuration

The `show` commands in this section are used to debug static iSCSI configuration. The following command output indicates correctly established iSCSI sessions. Run these commands on your switch and compare the output with these samples to help identify possible issues.
Send documentation comments to mdsfeedback-doc@cisco.com

- show iscsi session detail
- show iscsi stats
- show iscsi stats detail
- show fcns data vsan 5
- show flogi data vsan 5
- show iscsi remote-node iscsi-session-detail tcp-parameters

show iscsi session detail Command Output

switch# show iscsi session detail
Initiator iqn.1987-05.com.cisco.02.8cb3c18879bf356ce18e09679103235f.my-kayak (MY-KAYAK)
Session #1 (index 84)
  Target iqn.com.domainname.IPS-TEST.02-08.gw.2200002037c52d6d
  VSAN 5, ISID 00023d000054, TSID 135, Status active, no reservation
  Type Normal, ExpCmdSN 1356, MaxCmdSN 1366, Barrier 0
  MaxBurstSize 0, MaxConn 0, DataPDUInOrder No
  DataSeqInOrder No, InitialR2T Yes, ImmediateData No
  Registered LUN 0, Mapped LUN 0
  Stats:
  PDU: Command: 13, Response: 13
  Bytes: TX: 1344, RX: 0
  Number of connection: 1
  Connection #1
    Local IP address: 0xa011d64, Peer IP address: 0xa011d65
    CID 0, State: LOGGED_IN
    StatSN 1356, ExpStatSN 0
    MaxRecvDSLength 524288, our_MaxRecvDSLength 1392
    CSG 3, NSG 3, min_pdu_size 48 (w/ data 48)
    AuthMethod none, HeaderDigest None (len 0), DataDigest None (len 0)
    Version Min: 0, Max: 0
    FC target: Up, Reorder PDU: No, Marker send: No (int 0)
    Received MaxRecvDSLen key: Yes
  Session #2 (index 85)
  Target iqn.com.domainname.IPS-TEST.02-08.gw.2200002037c52e2e
  VSAN 5, ISID 00023d000055, TSID 135, Status active, no reservation
  Type Normal, ExpCmdSN 1356, MaxCmdSN 1366, Barrier 0
  MaxBurstSize 0, MaxConn 0, DataPDUInOrder No
  DataSeqInOrder No, InitialR2T Yes, ImmediateData No
  Registered LUN 0, Mapped LUN 0
  Stats:
  PDU: Command: 13, Response: 13
  Bytes: TX: 1344, RX: 0
  Number of connection: 1
  Connection #1
    Local IP address: 0xa011d64, Peer IP address: 0xa011d65
    CID 0, State: LOGGED_IN
    StatSN 1356, ExpStatSN 0
    MaxRecvDSLength 524288, our_MaxRecvDSLength 1392
    CSG 3, NSG 3, min_pdu_size 48 (w/ data 48)
    AuthMethod none, HeaderDigest None (len 0), DataDigest None (len 0)
    Version Min: 0, Max: 0
    FC target: Up, Reorder PDU: No, Marker send: No (int 0)
    Received MaxRecvDSLen key: Yes
  Session #3 (index 86)
  Target iqn.com.domainname.IPS-TEST.02-08.gw.2200002037c52356
  VSAN 5, ISID 00023d000056, TSID 135, Status active, no reservation
  Type Normal, ExpCmdSN 1356, MaxCmdSN 1366, Barrier 0
MaxBurstSize 0, MaxConn 0, DataPDUInOrder No
DataSeqInOrder No, InitialR2T Yes, ImmediateData No
Registered LUN 0, Mapped LUN 0
Stats:
  PDU: Command: 13, Response: 13
  Bytes: TX: 1344, RX: 0
Number of connection: 1
Connection #1
  Local IP address: 0xa011d64, Peer IP address: 0xa011d65
  CID 0, State: LOGGED_IN
  StatSN 1356, ExpStatSN 0
  MaxRecvDSLength 524288, our_MaxRecvDSLength 1392
  CSG 3, NSG 3, min_pdu_size 48 (w/ data 48)
  AuthMethod none, HeaderDigest None (len 0), DataDigest None (len 0)
  Version Min: 0, Max: 0
  FC target: Up, Reorder PDU: No, Marker send: No (int 0)
  Received MaxRecvDSLen key: Yes

Session #4 (index 87)
  Target iqn.com.domainname.IPS-TEST.02-08.gw.2200000213c5260a
  VSAN 5, ISID 0002340000057, TSID 135, Status active, no reservation
  Type Normal, ExpCmdSN 1356, MaxCmdSN 1366, Barrier 0
  MaxBurstSize 0, MaxConn 0, DataPDUInOrder No
  DataSeqInOrder No, InitialR2T Yes, ImmediateData No
  Registered LUN 0, Mapped LUN 0
Stats:
  PDU: Command: 13, Response: 13
  Bytes: TX: 1344, RX: 0
Number of connection: 1
Connection #1
  Local IP address: 0xa011d64, Peer IP address: 0xa011d65
  CID 0, State: LOGGED_IN
  StatSN 1356, ExpStatSN 0
  MaxRecvDSLength 524288, our_MaxRecvDSLength 1392
  CSG 3, NSG 3, min_pdu_size 48 (w/ data 48)
  AuthMethod none, HeaderDigest None (len 0), DataDigest None (len 0)
  Version Min: 0, Max: 0
  FC target: Up, Reorder PDU: No, Marker send: No (int 0)
  Received MaxRecvDSLen key: Yes

**show iscsi stats Command Output**

```
switch# show iscsi stats iscsi2/7
iscsi2/7
  5 minutes input rate 3336 bits/sec, 417 bytes/sec, 0 frames/sec
  5 minutes output rate 120 bits/sec, 15 bytes/sec, 0 frames/sec
iscsi statistics
  4112871 packets input, 4022446380 bytes
  303100 Command pdus, 3740086 Data-out pdus, 3815901300 Data-out bytes, 0 fragments
  1283306 packets output, 778111088 bytes
  303069 Response pdus (with sense 3163), 195108 R2T pdus
  715480 Data-in pdus, 715214528 Data-in bytes
```

**show iscsi stats detail Command Output**

```
switch# show iscsi stats detail
iscsi2/7
  5 minutes input rate 3336 bits/sec, 417 bytes/sec, 0 frames/sec
  5 minutes output rate 120 bits/sec, 15 bytes/sec, 0 frames/sec
iscsi statistics
  4113028 packets input, 4022464380 bytes
  303140 Command pdus, 3740086 Data-out pdus, 3815901300 Data-out bytes, 0 fragments
  1283306 packets output, 778111088 bytes
  303069 Response pdus (with sense 3163), 195108 R2T pdus
  715480 Data-in pdus, 715214528 Data-in bytes
```
iSCSI Issues

Send documentation comments to mdsfeedback-doc@cisco.com

**iSCSI Issues**

fragments

1283382 packets output, 778114736 bytes
303109 Response pdu (with sense 3163), 195141 R2T pdus
715480 Data-in pdus, 715214528 Data-in bytes

iSCSI Forward:
Command: 303140 PDUs (Received: 303140)
Data-Out (Write): 3740200 PDUs (Received 3740200), 0 fragments, 3816015476 bytes
TMP Request: 0 (Received 28)

FCP Forward:
Xfer_rdy: 195141 (Received: 195141)
Data-In: 715480 (Received: 715622), 715214528 bytes
Response: 303109 (Received: 303322), with sense 3163
TMP Resp: 0

iSCSI Stats:
Login: attempt: 16726, succeed: 114, fail: 16606, authen fail: 0
Rcvd: NOP-Out: 36164, Sent: NOP-In: 36160
NOP-In: 0, Sent: NOP-Out: 0
TMF-REQ: 28, Sent: TMF-RESP: 0
Text-REQ: 39, Sent: Text-RESP: 0
SNACK: 0
Unrecognized Opcode: 0, Bad header digest: 0
Command in window but not next: 0, exceed wait queue limit: 0
Received PDU in wrong phase: 0

FCP Stats:
Total: Sent: 4110679
Received: 1281518 (Error: 0, Unknown: 0)
Sent: PLOGI: 66367, Rcvd: PLOGI_ACC: 71, PLOGI_RJT: 66296
PRLI: 71, Rcvd: PRLI_ACC: 71, PRLI_RJT: 0, Error resp: 0
LOGO: 0, Rcvd: LOGO_ACC: 0, LOGO_RJT: 0
ABTS: 87, Rcvd: ABTS_ACC: 0
TMF REQ: 0
Self orig command: 213, Rcvd: data: 142, resp: 213
LOGO: 197, Sent: LOGO_ACC: 111
PRLI: 0, Sent: PRLI_ACC: 0
ABTS: 183

iSCSI Drop:
Command: Target down 0, Task in progress 0, LUN map fail 0
CmdSeqNo not in window 0, No Exchange ID 0, Reject 0
Persistent Resv 0 Data-Out: 0, TMF-Req: 0

FCP Drop:
Xfer_rdy: 0, Data-In: 0, Response: 0

Buffer Stats:
Buffer less than header size: 48475, Partial: 2524437, Split: 3550971
Pullup give new buf: 48475, Out of contiguous buf: 0, Unaligned m_data: 0

show fcns database Command Output

```
switch# show fcns data vsan 5
VSAN 5:
------------------------------------------------------------------------
FCID | TYPE | PWWN | (VENDOR) | FC4-TYPE:FEATURE
------------------------------------------------------------------------
0x610002 | N | 20:00:00:00:be:77:72:42 | scsi-fcp:init isc..w
0x6101e1 | NL | 22:00:00:20:37:c5:2d:6d (Seagate) | scsi-fcp:target
0x6101e2 | NL | 22:00:00:20:37:c5:2e:2e (Seagate) | scsi-fcp:target
0x6101e4 | NL | 22:00:00:20:37:c5:23:56 (Seagate) | scsi-fcp:target
0x6101e8 | NL | 22:00:00:20:37:c5:26:0a (Seagate) | scsi-fcp:target
```
Total number of entries = 5

show flogi database Command Output

switch# show flogi data vsan 5

---- INTERFACE VSAN PCI D PORT NAME NODE NAME ----
----- -------------- ------ --------------- --------------- -----
fc1/12 5 0x6101e8 22:00:00:20:37:c5:26:0a 20:00:00:20:37:c5:26:0a
fc1/12 5 0x6101e4 22:00:00:20:37:c5:23:56 20:00:00:20:37:c5:23:56
fc1/12 5 0x6101e2 22:00:00:20:37:c5:2e:2e 20:00:00:20:37:c5:2e:2e
fc1/12 5 0x6101e1 22:00:00:20:37:c5:2d:6d 20:00:00:20:37:c5:2d:6d
iscsi2/8 5 0x610002 20:0b:00:0b:be:77:72:42 20:0a:00:0b:be:77:72:42

Total number of flogi = 5.

show iscsi remote-node iscsi-session-detail tcp-parameters Command Output

switch# show iscsi remote-node iscsi-session-detail tcp-parameters

iSCSI Node name is iqn.1987-05.com.cisco.02.8cb3c18879bf356ce18e09679103235f.my-kayak
iSCSI alias name: MY-KAYAK
Node WWN is 20:0a:00:0b:be:77:72:42 (dynamic)
Member of vsans: 5
Number of Virtual n_ports: 1
Virtual Port WWN is 20:0a:00:0b:be:77:72:42 (dynamic)
  Interface iSCSI 2/8, Portal group tag is 0x87
  VSAN ID 0, FCID 0x0
  No. of FC sessions: 1
  No. of iSCSI sessions: 1

  iSCSI session details
    Target node:
    Statistics:
      PDU: Command: 0, Response: 0
      Bytes: TX: 0, RX: 0
      Number of connection: 1
    TCP parameters
      Connection Local 10.1.29.100:3260, Remote 10.1.29.101:1026
      Path MTU 1500 bytes
      Current retransmission timeout is 310 ms
      Round trip time: Smoothed 179 ms, Variance: 33
      Advertized window: Current: 62 KB, Maximum: 62 KB, Scale: 0
      Peer receive window: Current: 63 KB, Maximum: 63 KB, Scale: 0
      Congestion window: Current: 63 KB
      VSAN ID 5, FCID 0x610002
      No. of FC sessions: 4
      No. of iSCSI sessions: 4

  iSCSI session details
    Target node: iqn.com.domainname.IPS-TEST.02-08.gw.2200002037c5260a
    Statistics:
      PDU: Command: 13, Response: 13
      Bytes: TX: 1344, RX: 0
      Number of connection: 1
    TCP parameters
      Connection Local 10.1.29.100:3260, Remote 10.1.29.101:1048
      Path MTU 1500 bytes
      Current retransmission timeout is 300 ms
      Round trip time: Smoothed 165 ms, Variance: 35
iSCSI TCP Performance Issues

Generally there are two segments that effect the iSCSI performance. First is the Fibre Channel side flow control mechanism, buffer to buffer credits (BB_credits), Fibre Channel maximum frame size. Second is the TCP/IP side segment.

As in all TCP/IP-related throughput issues, the most important criteria are the Receive/Send Window Sizes on both TCP endpoints, RTT (round trip time), actual available bandwidth between the TCP peers, the MSS (maximum segment size), and the support for higher MTUs between the peers.
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 20  Troubleshooting IP Storage Services

**Send documentation comments to mdsfeedback-doc@cisco.com**

### CLI Commands Used to Access Performance Data

Use the following CLI commands to access performance data.

- `show iscsi remote-node iscsi-session-detail tcp-parameters`
- `show ips stats tcp interface gigabitethernet slot/port detail`
- `show interface iscsi slot/port`
- `show interface gigabitethernet slot/port`
- `show interface fc slot/port`
- `show iscsi remote-node fcp-session-detail`

### Understanding TCP Parameters for iSCSI

The default MTU size of an Ethernet network is 1500, while the Fibre Channel networks generally support maximum frame sizes of 2148 bytes. This means that an iSCSI gateway must divide the Fibre Channel frames into two TCP segments or IP fragments while transferring from the Fibre Channel side to the IP side depending on how this division is implemented within the device.

This section refers to the scenario in Figure 20-13.

**Figure 20-13  IPS Window Scaling**

The IPS module adjusts the Receive Data Field Size that it advertises to its Fibre Channel partner, according to the MTU that is configured on the corresponding Gigabit Ethernet port of an iSCSI client.

If left to the default MTU size, the Fibre Channel frame size from the target device is decreased to match the maximum Ethernet frame size, so the switching of the packet through the switch is faster. One point of performance tuning is to increase the MTU of the IP network between the peers.

Jumbo support was enabled for the IPS ports, and the MTU for the VLAN corresponding to these ports was increased.

The second point of performance tuning is to increase the TCP window size of the iSCSI endpoints. Depending on the latency between the iSCSI client and the IPS, this will need fine tuning. The switch’s iSCSI configuration defines the TCP window size in kilobytes.
Any value starting with 64K (> 65535 = 0xFFFF bytes) will automatically trigger TCP window scaling according to RFC 1323. The IPS TCP window scaling begins only when the remote peer (iSCSI client in this case) requests it. This means that you need to configure the TCP stack of your client to trigger this functionality (see Figure 20-13).

For the Fibre Channel side, depending on the direction of the traffic, the BB_credit of the ports corresponding to the input interfaces (sending/receiving traffic to/from the iSCSI side) could be increased, especially in the case of local Gigabit Ethernet attached iSCSI clients.

**Lab Setup**

This is the lab setup that was used in collecting the performance-related information.

- The server was an IBM Pentium III server: Dual CPU @ 1.13 GHz.
- The TCP window size at both ends was set to 1MB (1024K).
- The IBM ESS Shark had a hardcoded BB_credit value of 64 (not configurable).
- The `fcrxbbcredit` on the corresponding switch port (fc1/3) was set to the same value.
- The C4 and C8 represented the corresponding port WWNs (pWWN) for the IBM Shark storage subsystem. The full pWWN is as follows:
  - C4 50:05:07:63:00:c4:94:4c (in VSAN 778)
  - C8 50:05:07:63:00:c8:94:4c (in VSAN 777)

**Configuring from the Bottom Switch Using the CLI**

The following example is the configuration for the 9216 switch shown in Figure 20-13.

```bash
iscsi initiator name iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas
pWNN 20:05:00:0c:30:6c:24:42
vsan 777
vsan 778

iscsi virtual-target name shark_nas
pWNN 50:05:07:63:00:c8:94:4c fc-lun 0000 iscsi-lun 0000 secondary-pwn
50:05:07:63:00:c4:94:4c
pWNN 50:05:07:63:00:c8:94:4c fc-lun 0001 iscsi-lun 0001 secondary-pwn
50:05:07:63:00:c4:94:4c
 initiator iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas permit

interface GigabitEthernet2/1
ip address 10.48.69.251 255.255.255.192
iscsi authentication none
no shutdown
vrrp 1
priority 110
address 10.48.69.250
(This is the iSCSI target IP address for the Windows iSCSI client.)

no shutdown
interface iscsi2/1
tcp pmtu-enable
 tcp window-size 1024
(To increase the receive window size of the IPS module (in kilobytes).)
tcp sack-enable
```
Verifying Connectivity Between Client and IPS iSCSI Service

The following example verifies the connectivity between the client and the IPS iSCSI service:

\[ \text{MDS\_BOTTOM}\# \text{ show ips stats tcp interface gigabitethernet 2/1} \]

TCP Statistics for port GigabitEthernet2/1

- Connection Stats:
  - 0 active openings, 24 accepts
  - 0 failed attempts, 0 reset received, 24 established

- Segment stats:
  - 7047380 received, 56080130 sent, 0 retransmitted
  - 0 bad segments received, 0 reset sent

TCP Active Connections

<table>
<thead>
<tr>
<th>Local Address</th>
<th>Remote Address</th>
<th>State</th>
<th>Send-Q</th>
<th>Recv-Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.48.69.250:3260</td>
<td>10.48.69.233:1026</td>
<td>ESTABLISH</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10.48.69.250:3260</td>
<td>10.48.69.233:1057</td>
<td>ESTABLISH</td>
<td>34560</td>
<td>0</td>
</tr>
<tr>
<td>0.0.0.0:3260</td>
<td>0.0.0.0:0</td>
<td>LISTEN</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

\[ \text{MDS\_BOTTOM}\# \text{ show flogi database vsan 777} \]

---------------------------------------------------------------------------
<table>
<thead>
<tr>
<th>INTERFACE</th>
<th>VSAN</th>
<th>FCID</th>
<th>PORT NAME</th>
<th>NODE NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>fcl/3</td>
<td>777</td>
<td>0x610000</td>
<td>50:05:07:63:00:c8:94:4c</td>
<td>50:05:07:63:00:c0:94:4c</td>
</tr>
<tr>
<td>iscsi2/1</td>
<td>777</td>
<td>0x610001</td>
<td>20:05:00:0c:30:6c:24:42</td>
<td>20:00:00:0c:30:57:5e:c2</td>
</tr>
</tbody>
</table>

Total number of flogi = 2.

\[ \text{MDS\_BOTTOM}\# \text{ show fcns database vsan 777} \]

VSAN 777:

<table>
<thead>
<tr>
<th>FCID</th>
<th>TYPE</th>
<th>PWWN</th>
<th>(VENDOR)</th>
<th>FC4-TYPE:FEATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x6100000</td>
<td>N</td>
<td>50:05:07:63:00:c8:94:4c</td>
<td>(IBM)</td>
<td>scsi-fcp:target fc..</td>
</tr>
<tr>
<td>0x6100001</td>
<td>N</td>
<td>20:05:00:0c:30:6c:24:42</td>
<td></td>
<td>scsi-fcp:init isc..w</td>
</tr>
</tbody>
</table>

Total number of entries = 2

\[ \text{MDS\_BOTTOM}\# \text{ show module} \]

<table>
<thead>
<tr>
<th>Mod</th>
<th>Ports</th>
<th>Module-Type</th>
<th>Model</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>16</td>
<td>1/2 Gbps FC/Supervisor</td>
<td>DS-X9216-K9-SUP</td>
<td>active *</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>IP Storage Module</td>
<td>DS-X9308-SMIP</td>
<td>ok</td>
</tr>
</tbody>
</table>

\[ \text{MDS\_BOTTOM}\# \text{ show module ports} \]

<table>
<thead>
<tr>
<th>Mod</th>
<th>Sw</th>
<th>Hw</th>
<th>World-Wide-Name(s) (WWN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.1(0.133c)</td>
<td>1.0</td>
<td>20:01:00:0c:30:57:5e:c0 to 20:10:00:0c:30:57:5e:c0</td>
</tr>
<tr>
<td>2</td>
<td>1.1(0.133c)</td>
<td>0.2</td>
<td>20:41:00:0c:30:57:5e:c0 to 20:48:00:0c:30:57:5e:c0</td>
</tr>
</tbody>
</table>

* this terminal session

\[ \text{MDS\_BOTTOM}\# \text{ show iscsi remote} \]

iSCSI Node name is iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas
iSCSI alias name: SHARK-NAS
Node WWN is 20:00:00:0c:30:57:5e:c2 (dynamic)
Member of vsans: 777, 778
Number of Virtual n_ports: 1
Virtual Port WWN is 20:05:00:0c:30:6c:24:42 (configured)
  Interface iSCSI 2/1, Portal group tag: 0x1001
  VSAN ID 778, FCID 0x7c0000
  VSAN ID 777, FCID 0x610001

MDS_BOTTOM# show iscsi local
target: shark_nas
  Port WWN 50:05:07:63:00:c8:94:4c

(This is the port of the Shark connected to MDS 9216_Bottom.)

Secondary PWWN 50:05:07:63:00:c4:94:4c
(This is the port of the Shark connected to MDS 9216_Top.)

Configured node
  No. of LU mapping: 2
    iSCSI LUN: 0000, FC LUN: 0000
    iSCSI LUN: 0001, FC LUN: 0001
  No. of initiators permitted: 1
    initiator iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas is permitted
    all initiator permit is disabled

MDS_BOTTOM#
MDS_BOTTOM# show interface iscsi 2/1

iscsis2/1 is up
  Hardware is GigabitEthernet
  Port WWN is 20:41:00:0c:30:57:5e:c0
  Admin port mode is ISCSI
  Port mode is ISCSI
  Speed is 1 Gbps
  Number of iSCSI session: 2, Number of TCP connection: 2
  Configured TCP parameters
    Local Port is 3260
    PMTU discover is enabled (default)

(This is especially required if there are devices without jumbo support in the path. The initial TCP 3-way
handshake will establish a session with a high MSS value (provided both the IPS module and the iSCSI
client are configured or capable) even if there are devices without jumbo frame support in the path.
Without PMTU discovery, there will be problems.)

  Keepalive-timeout 60
  Initial-retransmit-time 300

(If there is high delay between the peers, this parameter that can be adjusted. There’s no real formula;
instead use trial and error to find the optimum value for your network. Try lower values as well as higher
ones, and get hints from the show ips stats tcp output.)

  Max-retransmissions 8
  Window-size 1024000
  Sack is enabled
  Forwarding mode: pass-thru
  5 minutes input rate 410824 bits/sec, 51353 bytes/sec, 1069 frames/sec
  5 minutes output rate 581291520 bits/sec, 72661440 bytes/sec, 53302 frames/sec
  iSCSI statistics
    1072393 packets input, 51482588 bytes
    1072305 Command pdus, 0 Data-out pdus, 0 Data-out bytes, 0 fragments
    53430805 packets output, 72837086312 bytes
      1072273 Response pdus (with sense 9), 0 R2T pdus
      52358444 Data-in pdus, 70272402880 Data-in bytes

MDS_BOTTOM# show iscsi remote initiator iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas
iscsi tcp
iSCSI Node name is iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas
iSCSI alias name: SHARK-NAS
Node WWN is 20:00:00:0c:30:57:5e:c2 (dynamic)
Member of vsans: 777, 778
Number of Virtual n_ports: 1

Virtual Port WWN is 20:00:00:0c:30:57:5e:c2 (configured)
Interface iSCSI 2/1, Portal group tag is 0x1001
  VSAN ID 0, FCID 0x     0
  No. of FC sessions: 1
  No. of iSCSI sessions: 1

iSCSI session details

  Target node:
  Statistics:
    PDU: Command: 0, Response: 0
    Bytes: TX: 0, RX: 0
    Number of connection: 1
  TCP parameters
    Local 10.48.69.250:3260, Remote 10.48.69.233:1026
    Path MTU: 1500 bytes
    Retransmission timeout: 300 ms
    Round trip time: Smoothed 150 ms, Variance: 31
  Advertized window: Current: 998 KB, Maximum: 1000 KB, Scale: 4
  Peer receive window: Current: 1000 KB, Maximum: 1000 KB, Scale: 4
  Congestion window: Current: 12 KB

VSAN ID 777, FCID 0x610001
No. of FC sessions: 1
No. of iSCSI sessions: 1

iSCSI session details

  Target node: shark_nas
  Statistics:
    PDU: Command: 392051, Response: 392042
    Bytes: TX: 25692593152, RX: 0
    Number of connection: 1
  TCP parameters
    Local 10.48.69.250:3260, Remote 10.48.69.233:1057
    Path MTU: 1500 bytes
    Retransmission timeout: 300 ms
    Round trip time: Smoothed 2 ms, Variance: 1

(Watch out for these numbers. The output is for a TCP session that goes only through one Gigabit Ethernet switch. When there are multiple router hops, as well as WAN links in the middle, the RTT will grow, and the variance will fluctuate with higher values. You may need to adjust the retransmission timeout.)

  Advertized window: Current: 1000 KB, Maximum: 1000 KB, Scale: 4
  Peer receive window: Current: 1000 KB, Maximum: 1000 KB, Scale: 4

(This is the window size set on the Windows client. See Figure 20-14.)

(This is the window size set on the IPS iSCSI interface. See Figure 20-14.)
TCP Parameter Changes

To change TCP parameters in the Windows registry, use the registry parameters shown in Figure 20-14 as an example.

Setting the Tcp1323Opts (circled in green) to 3, sets two bits on, one for window scaling and the other for the time-stamp option. We are only interested in the window scaling here.

⚠️ Caution

Editing the registry is a very high risk operation, it can render the system unusable, requiring a reinstallation of the entire operating system. Only advanced users should perform this operation.

Displaying the Gigabit Ethernet Interface

Choose Switches > Interfaces > Gigabit Ethernet using Fabric Manager to view the Gigabit Ethernet status.

Or use the show interface CLI command to view the Gigabit Ethernet status (see Example 20-2).

**Example 20-2 Annotated Output of show interface gigabitethernet CLI Command**

```
MDS_BOTTOM# show interface gigabitethernet 2/1
GigabitEthernet2/1 is up
  Hardware is GigabitEthernet, address is 0005.3000.a85a
  Internet address is 10.48.69.251/26
  MTU 1500 bytes, BW 1000000 Kbit
  Port mode is IPS
  Speed is 1 Gbps
  Beacon is turned off
  5 minutes input rate 3957384 bits/sec, 494673 bytes/sec, 6716 frames/sec
```

Figure 20-14  Congestion Window: Current: 24 kB
Better throughput can be achieved if the MTU of both the client NIC and the IPS Gigabit Ethernet interface is changed to a higher MTU, provided the network in the middle supports jumbo frames.

Use the `show ips stats tcp` CLI command to view TCP statistics (see Example 20-3). If the retransmitted value in the segment continues to increase, it shows that either the IP network in the middle has issues or the TCP peer has problems acknowledging the data that the IPS sends to it. If the MTU of this interface is higher than the MSS of the iSCSI client, then the split packets value increases. For example, the client MTU default is 1500, which equates to an MSS value of 1460, but the IPS Gigabit Ethernet MTU changed to 2500.

**Example 20-3 show ips stats tcp Command Output**

```
MDS BOTTOM# show ips stats tcp interface gigabit 2/1 detail
TCP Statistics for port GigabitEthernet2/1
TCP send stats
  56252632 segments, 76746280484 bytes
  56100434 data, 152173 ack only packets
  1 control (SYN/FIN/RST), 0 probes, 24 window updates
  0 segments retransmitted, 0 bytes
  0 retransmitted while on ethernet send queue, 0 packets split
  3 delayed acks sent
TCP receive stats
  7068115 segments, 1061853 data packets in sequence, 54245464 bytes in sequence
  0 predicted ack, 187 predicted data
  0 bad checksum, 0 multi/broadcast, 0 bad offset
  0 no memory drops, 0 short segments
  0 duplicate bytes, 0 duplicate packets
  0 partial duplicate bytes, 0 partial duplicate packets
  0 out-of-order bytes, 0 out-of-order packets
  0 packet after window, 0 bytes after window
  0 packets after close
  7067879 acks, 76746255731 ack bytes, 0 ack too much, 21 duplicate acks
  0 ack packets left of snd_una, 0 non-4 byte aligned packets
  5980106 window updates, 0 window probe
  50 pcb hash miss, 0 no port, 0 bad SYN, 0 paws drops
TCP Connection Stats
  0 attempts, 24 accepts, 24 established
  22 closed, 2 drops, 0 conn drops
  0 drop in retransmit timeout, 0 drop in keepalive timeout
  0 drop in persist drops, 0 connections drained
TCP Miscellaneous Stats
  7054414 segments timed, 7067879 rtt updated
  0 retransmit timeout, 0 persist timeout
  0 keepalive timeout, 19 keepalive probes
TCP SACK Stats
  0 recovery episodes, 54218621 data packets, 77791012992 data bytes
  0 data packets retransmitted, 0 data bytes retransmitted
  1 connections closed, 0 retransmit timeouts
TCP SYN Cache Stats
  24 entries, 24 connections completed, 0 entries timed out
  0 dropped due to overflow, 0 dropped due to RST
  0 dropped due to ICMP unreachable, 0 dropped due to bucket overflow
```
iSCSI TCP Performance Issues

Chapter 20  Troubleshooting IP Storage Services

Send documentation comments to mdsfeedback-doc@cisco.com

0 abort due to no memory, 0 duplicate SYN, 2 no-route SYN drop
0 hash collisions, 0 retransmitted

TCP Active Connections

<table>
<thead>
<tr>
<th>Local Address</th>
<th>Remote Address</th>
<th>State</th>
<th>Send-Q</th>
<th>Recv-Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.48.69.250:3260</td>
<td>10.48.69.233:1026</td>
<td>ESTABLISH</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10.48.69.250:3260</td>
<td>10.48.69.233:1057</td>
<td>ESTABLISH</td>
<td>29296</td>
<td>0</td>
</tr>
<tr>
<td>0.0.0.0:3260</td>
<td>0.0.0.0:0</td>
<td>LISTEN</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Use the `show iscsi remote-node fcp-session-detail` CLI command to view details of the session status. (See Example 20-4.) The RcvDataFieldSize will be set to the maximum 2048 if the MTU is increased on the Gigabit Ethernet interface that corresponds to this iSCSI remote node. Use the Target FCID field to verify that the local port, rather than a remote port that is reached through an ISL link, is used for the storage target to avoid suboptimal access to storage.

Example 20-4  show iscsi remote-node fcp-session-detail Command Output

```
MDS_BOTTOM# show iscsi remote-node fcp-session-detail
iscsi Node name is iqn.1987-05.com.cisco:02.75af2f95624c.shark-nas
    iSCSI alias name: SHARK-NAS
    Node WWN is 20:00:00:0c:30:6c:24:42 (dynamic)
    Member of vsans: 777, 778
    Number of Virtual n_ports: 1
    Interface iSCSI 2/1, Portal group tag is 0x1001
    VSAN ID 0, FCID 0x610001
    No. of FC sessions: 1
    No. of iSCSI sessions: 1
    FCP Session details
        Target FCID: 0x000000 (S_ID of this session: 0x000000)
            pWWN: 00:00:00:00:00:00:00:00
            nWWN: 00:00:00:00:00:00:00:00
        Session state: INIT
        1 iSCSI sessions share this FC session
        Target:
            Negotiated parameters
                RcvDataFieldSize 2048 our_RcvDataFieldSize 1392
                MaxBurstSize 0, EMPD: FALSE
                Random Relative Offset: FALSE, Sequence-in-order: Yes
        Statistics:
            PDU: Command: 0, Response: 0
        VSAN ID 777, FCID 0x610001
        No. of FC sessions: 1
        No. of iSCSI sessions: 1
        FCP Session details
            Target FCID: 0x610000 (S_ID of this session: 0x610001)
                pWWN: 50:05:07:63:00:c8:94:4c
                nWWN: 50:05:07:63:00:c8:94:4c
            Session state: LOGGED_IN
            1 iSCSI sessions share this FC session
            Target: shark_nas
            Negotiated parameters
                RcvDataFieldSize 2048 our_RcvDataFieldSize 1392
                MaxBurstSize 0, EMPD: FALSE
                Random Relative Offset: FALSE, Sequence-in-order: Yes
            Statistics:
                PDU: Command: 0, Response: 1612007
```
Verifying that the Host Is Configured for High MTU or MSS with the CLI

To get the real benefit of an increased MTU and higher Fibre Channel frame size, the path between the iSCSI client and the IPS iSCSI interface (as well as the host NIC) has to be capable of supporting this high MTU.

If you do not have access to the host, one way to see if the host is also configured for high MTU/MSS (as well as the path in the middle) is to check the split packets field in the `show ips stats tcp` display.

However this is a generic display for all TCP sessions. That is, if you have some hosts with high MTU-capable NICs, and some others without, it may be difficult to assess which is which. (See Example 20-5.)

**Example 20-5  Sample Output for Low Packet Split Count**

```
MDS_Top# show ips stats tcp interface gigabitethernet 2/1 detail (truncated output)
TCP Statistics for port GigabitEthernet2/1
TCP send stats
  10 segments, 240 bytes
  5 data, 5 ack only packets
  0 control (SYN/FIN/RST), 0 probes, 0 window updates
  0 segments retransmitted, 0 bytes
  0 retransmitted while on ethernet send queue, 0 packets split

TCP Active Connections
Local Address        Remote Address        State      Send-Q   Recv-Q
10.48.69.250:3260     10.48.69.233:1026     ESTABLISH  0        0
10.48.69.250:3260     10.48.69.233:1040     ESTABLISH  0        0
0.0.0.0:3260          0.0.0.0:0             LISTEN     0        0
```

Afterward, traffic starts flowing from the FC storage towards the server that is connected via iSCSI to the IPS.

**Example 20-6  Sample Output for Large Packet Split Count**

```
MDS_Top# show ips stats tcp interface gigabitethernet 2/1 detail
TCP Statistics for port GigabitEthernet2/1
TCP send stats
  715535 segments, 943511612 bytes
  712704 data, 2831 ack only packets
  0 control (SYN/FIN/RST), 0 probes, 0 window updates
  0 segments retransmitted, 0 bytes
  0 retransmitted while on ethernet send queue, 345477 packets split
```


iSLB Issues

This section describes common troubleshooting issues for iSLB and includes the following topics:

- iSLB Configuration Not Distributed to All Switches in the Fabric, page 20-58
- iSCSI Initiator and Virtual Target Configuration Not Distributed, page 20-59
- iSLB Configuration, Commit, or Merge Failed—"VSAN ID is Not Yet Configured", page 20-59
- iSLB Configuration, Commit, or Merge Failed—"Failed to Allocate WWN", page 20-60
- iSLB Configuration, Commit, or Merge Failed—"Duplicate WWN Found as...", page 20-60
- iSLB Configuration, Commit, or Merge Failed—"Duplicate Node Name", page 20-60
- iSLB Configuration Failed—"Pending iSLB CFS Config Has Reached Its Limit...", page 20-61
- iSCSI Disable Failed—"Cannot Disable Iscsi - Large Iscsi Config Present...", page 20-61
- iSLB Commit Timeout, page 20-61
- Session Down—"pWWN in Use At Remote Switch", page 20-62
- Redirected Session Does Not Come Up, page 20-62
- iSLB Zones Not Present in Active Zone Set, page 20-63
- Traffic Description After iSLB Commit or Activation of Zone Set, page 20-63
- VRRP Master Overutilized, page 20-64
- iSLB Zone Set Activation Failed, page 20-64
- iSLB CFS Commit Fails, page 20-65
- Resolving an iSLB Merge Failure, page 20-65

iSLB Configuration Not Distributed to All Switches in the Fabric

**Symptom**  
iSLB configuration is not distributed to all switches in the fabric.

**Table 20-1  iSLB Configuration Not Distributed to All Switches in the Fabric**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB configuration not distributed to all switches in the fabric.</td>
<td>Not all switches are running Cisco SAN-OS Release 3.0(1) or later.</td>
<td>Update switches to Cisco SAN-OS Release 3.0(1) or later.</td>
</tr>
<tr>
<td></td>
<td>CFS distribution is not enabled for iSLB.</td>
<td>Enable CFS distribution for iSLB. Use the <code>show cfs application name islb</code> CLI command to determine if CFS distribution is enabled. Or use the <code>show cfs peers name islb</code> CLI command and check to see if any switches are missing from the output. Use the <code>islb distribute</code> CLI command to enable CFS distribution.</td>
</tr>
</tbody>
</table>
iSCSI Initiator and Virtual Target Configuration Not Distributed

Symptom  iSCSI initiator and virtual target configuration is not distributed to the fabric.

Table 20-2  iSCSI Initiator and Virtual Target Configuration Not Distributed

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| iSCSI initiator and virtual target configuration is not distributed to the fabric. | Normal operation. | Only the following iSCSI and iSLB configuration is distributed:  
- iSLB initiator and iSLB initiator targets  
- iSLB VRRP load-balancing configuration  
- iSCSI global authentication parameters (authentication algorithm and CHAP user name or password)  
- iSCSI dynamic initiator mode (iSCSI, iSLB, or deny) |

iSLB Configuration, Commit, or Merge Failed—“VSAN ID is Not Yet Configured”

Symptom  iSLB configuration, commit, or merge failed with error VSAN ID is not yet configured.

Table 20-3  iSLB Configuration, Commit, or Merge Failed—“VSAN ID is Not Yet Configured.”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| iSLB configuration, commit, or merge failed with error VSAN ID is not yet configured. | The VSAN ID for one of the initiators is not configured on all switches in the fabric. | Check the output of the show islb cfs-session status, show islb merge status, and show ips internal event-history error CLI command for details on which initiator VSAN ID is not configured on a switch.  
Use the vsan database vsan vsan-id CLI command to add the VSAN ID, or remove the VSAN ID from the initiator configuration. |
iSLB Issues

Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 20  Troubleshooting IP Storage Services

iSLB Configuration, Commit, or Merge Failed—"Failed to Allocate WWN"

Symptom  iSLB configuration, commit, or merge failed with error Failed to allocate WWN.

Table 20-4  iSLB Configuration, Commit, or Merge Failed—“Failed to Allocate WWN”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB configuration, commit, or merge failed with error Failed to allocate WWN.</td>
<td>The pWWN or nWWN for one for the initiators could not be reserved from the WWN manager. This implies that the particular WWN is already in use.</td>
<td>Check the output of the show islb cfs-session status, show islb merge status and show ips internal event-history error CLI commands for details on the specific WWN and initiator in error. To fix the problem, use another WWN or allow the system to assign one for the initiator using the static [nWWN</td>
</tr>
</tbody>
</table>

iSLB Configuration, Commit, or Merge Failed—"Duplicate WWN Found as..."

Symptom  iSLB configuration, commit, or merge failed with error Duplicate WWN found as ..

Table 20-5  iSLB Configuration, Commit, or Merge Failed—“Duplicate WWN Found as ...”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB configuration, commit, or merge failed with error Duplicate WWN found as ..</td>
<td>The pWWN or nWWN for one for the initiators is already in use by another initiator.</td>
<td>Check the output of the show islb cfs-session status, show islb merge status and show ips internal event-history error CLI commands for details on the specific WWN and initiator in error. To fix the problem, use another WWN or allow the system to assign one for the initiator using the static [nWWN</td>
</tr>
</tbody>
</table>

iSLB Configuration, Commit, or Merge Failed—"Duplicate Node Name"

Symptom  iSLB configuration, commit, or merge failed with error Duplicate node name.

Table 20-6  iSLB Configuration, Commit, or Merge Failed—“Duplicate Node Name”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB configuration, commit, or merge failed with error Duplicate node name.</td>
<td>Node name of one of the iSLB initiators is the same as an existing iSCSI initiator.</td>
<td>Check the output of the show islb cfs-session status, show islb merge status and show ips internal event-history error CLI commands for details on the specific initiator in error. To fix the problem, use a different node name.</td>
</tr>
</tbody>
</table>
Send documentation comments to mdsfeedback-doc@cisco.com

Chapter 20  Troubleshooting IP Storage Services

iSLB Issues

iSLB Configuration Failed—“Pending iSLB CFS Config Has Reached Its Limit...”

Symptom  iSLB configuration failed with error Pending iSLB CFS config has reached its limit.

Table 20-7  iSLB Configuration Failed—“Pending iSLB CFS Config Has Reached Its Limit...”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB configuration failed with error Pending iSLB CFS config has reached its limit.</td>
<td>The limit of 200 initiators in the pending database has been reached, so no more configuration is allowed.</td>
<td>Use the islb commit CLI command to commit the outstanding changes.</td>
</tr>
</tbody>
</table>

iSCSI Disable Failed—“Cannot Disable Iscsi - Large Iscsi Config Present...”

Symptom  iSCSI disable failed with error Cannot disable iSCSI - large iSCSI config present.

Table 20-8  iSCSI Disable Failed—“Cannot Disable Iscsi - Large Iscsi Config Present...”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSCSI disable failed with error Cannot disable iSCSI - large iSCSI config present.</td>
<td>There are more than 200 initiators in the running config, so iSCSI disable is not allowed.</td>
<td>Delete initiators from the configuration until you have less than 200 initiators. Then use the no iscsi enable CLI command to disable iSCSI.</td>
</tr>
</tbody>
</table>

iSLB Commit Timeout

Symptom  iSLB commit timeout.

Table 20-9  iSLB Commit Timeout

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB commit timeout.</td>
<td>When a large configuration is present, it is possible for the iSLB commit to take a long time.</td>
<td>Check the output of the show islb cfs-session status CLI command to get the status of the commit.</td>
</tr>
</tbody>
</table>
Session Down—“pWWN in Use At Remote Switch”

**Symptom**  Session down with error pWWN in use at remote switch.

### Table 20-10  Session Down—“pWWN in Use At Remote Switch”

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session down with error pWWN in use at remote switch.</td>
<td>An initiator pWWN can be used only once in the fabric.</td>
<td>If the same initiator tries to log in to two iSCSI ports at the same time, both ports will initially allow the sessions to come up and then try to reserve the pWWN in the fabric. If it is detected that this pWWN is already in use, the session will be destroyed. To fix the problem, use another WWN or allow the system to assign one for the initiator using the `static [nWWN</td>
</tr>
</tbody>
</table>

Redirected Session Does Not Come Up

**Symptom**  Redirected session does not come up.

### Table 20-11  Redirected Session Does Not Come Up

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redirected session does not come up.</td>
<td>Connection may be down, or initiator to interface mapping may be missing.</td>
<td>Use the <code>ping</code> CLI command to verify that the connection between the redirected port and initiator is up. Use the <code>show logging logfile</code> CLI command to check the system messages to determine what the session creation failure reason is if any. Use the <code>show interface brief</code> CLI command to verify that iSCSI and Gigabit Ethernet interfaces are up. Bring down and then bring up the initiator and try again to see if the error is persistent. There are times initiators do not attempt to make connections to the redirected interface. Use the <code>debug ips islb vrrp flow</code> CLI command to check if the redirection is performing correctly. Use the <code>show islb vrrp summary</code> CLI command to see if the initiator to the interface mapping is set up.</td>
</tr>
</tbody>
</table>
iSLB Zones Not Present in Active Zone Set

**Symptom**  
iSLB zones not present in active zone set.

<table>
<thead>
<tr>
<th>Table 20-12</th>
<th>iSLB Zones Not Present in Active Zone Set</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>iSLB zones not present in active zone set.</td>
<td>Active zone set not configured.</td>
</tr>
<tr>
<td>Zone set activation failed.</td>
<td></td>
</tr>
</tbody>
</table>

Traffic Description After iSLB Commit or Activation of Zone Set

**Symptom**  
Traffic description after iSLB commit or activation of zone set (normal, IVR, or iSLB).

<table>
<thead>
<tr>
<th>Table 20-13</th>
<th>Traffic Disruption After iSLB Commit or Activation of Zone Set</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
<td><strong>Possible Cause</strong></td>
</tr>
<tr>
<td>Traffic description after iSLB commit or activation of zone set (normal, IVR, or iSLB).</td>
<td>An iSLB commit must be done from the switch that has IVR configured.</td>
</tr>
<tr>
<td>Any zone set activation (normal, iSLB, or IVR) must be done from the switch that has IVR configured.</td>
<td></td>
</tr>
</tbody>
</table>
VRRP Master Overutilized

**Symptom**  
VRRP master is overutilized.

<table>
<thead>
<tr>
<th><strong>Table 20-14  VRRP Master Overutilized</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
</tbody>
</table>
| VRRP master is overutilized. | iSCSI interface parameters do not match the rest of the interfaces in the VRRP group. | Verify the interface parameters for all interfaces in the VRRP group.  
Or use the `show vrrp` CLI command to view which interfaces are in the VRRP group, then use the `show interface iscsi` CLI command. |
| Load metric needs to be adjusted. | | Raise the load metric.  
Use the `metric` CLI command in iSLB configuration mode. The default value is 1000. |

iSLB Zone Set Activation Failed

**Symptom**  
iSLB zone set activation failed.

<table>
<thead>
<tr>
<th><strong>Table 20-15  iSLB Zone Set Activation Failed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
</tbody>
</table>
| iSLB zone set activation failed. | iSLB auto-zone is enabled but CFS distribution is not enabled. | Enable CFS distribution for iSLB to share load across multiple switches.  
Use the `islb distribute` CLI command on each switch in the fabric. |
| Zone set activation is not from switch with IVR and iSLB enabled. | | Activate the zone set from a switch that has IVR and iSLB enabled.  
Use the `islb zoneset activate` CLI command. |
| Another zone set activation is in progress. | Only one zoning related action can occur at the same time (zone, IVR zone, or iSLB zone configuration or activation).  
Wait until the zone set activation completes and then retry the iSLB zone set activation. | |
| Zoning database is locked because a configuration is pending. | Only one zoning related action can occur at the same time (zone, IVR zone, or iSLB zone configuration or activation).  
Commit the existing configuration change or discard the changes.  
Use the `show islb status`, `islb commit`, or `islb abort` CLI command to view the status, to commit the changes or to discard the changes, respectively.  
Also, verify that no zone or IVR zone changes are pending. | |
iSLB Issues

Chapter 20  Troubleshooting IP Storage Services

Send documentation comments to mdsfeedback-doc@cisco.com

iSLB CFS Commit Fails

Symptom  iSLB CFS commit fails.

Table 20-16  iSLB CFS Commit Fails

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSLB CFS commit fails.</td>
<td>Zone set activation is not from the switch with IVR and iSLB enabled.</td>
<td>Activate the zone set from a switch that has IVR and iSLB enabled. Use the islb commit CLI command.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wait until the zone set activation completes and then retry the iSLB zone set activation.</td>
</tr>
<tr>
<td></td>
<td>Another zone set activation is in progress.</td>
<td>Commit the existing configuration change or discard the changes. Use the show islb status, islb commit, or islb abort CLI command to view the status, to commit the changes or use islb abort to discard the changes. Also, verify that no zone or IVR zone changes are pending.</td>
</tr>
<tr>
<td></td>
<td>Zoning database is locked because a configuration is pending.</td>
<td></td>
</tr>
</tbody>
</table>

Resolving an iSLB Merge Failure

To resolve an iSLB merge failure using the CLI, follow these steps:

Step 1  Determine the cause of merge failure using the output of the show islb merge status and the show ips internal event-history error commands.

Step 2  If the reason for the merge failure is the VSAN configuration, configure the VSAN on all the switches.

Step 3  Log in to the switch in the fabric whose running configuration you want to keep and issue the islb commit command.

Note  The iSLB configuration on other switches will be overwritten. A commit after a merge failure synchronizes the fabric configuration to the running-conf of the switch where the commit was performed.
Troubleshooting IP Access Lists

This chapter describes how to troubleshoot IPv4 and IPv6 access lists (IP-ACLs) created and maintained in the Cisco MDS 9000 Family. It includes the following sections:

- Overview, page 21-1
- Initial Troubleshooting Checklist, page 21-4
- IP-ACL Issues, page 21-4

Overview

IP-ACLs provide basic network security to all switches in the Cisco MDS 9000 Family. IP-ACLs restrict IP-related traffic based on the configured IP filters. A filter contains the rules to match an IP packet, and if the packet matches, the rule also stipulates if the packet should be permitted or denied.

Each switch in the Cisco MDS 9000 Family can have a maximum of 64 IP-ACLs and each IP-ACL can have a maximum of 256 filters.

An IP filter contains rules for matching an IP packet based on the protocol, address, and port. IPv4 filters can also match on an ICMP type and type of service (ToS).

This section includes the following topics:

- Protocol Information, page 21-1
- Address Information, page 21-2
- Port Information, page 21-2
- ICMP Information, page 21-3
- ToS Information, page 21-3

Protocol Information

You can specify the IP protocol in one of two ways:

- Specify an integer ranging from 0 to 255. This number represents the IP protocol.
- Specify the name of a protocol, restricted to Internet Protocol (IP), Transmission Control Protocol (TCP), User Datagram Protocol (UDP), and Internet Control Message Protocol (ICMP).
Address Information

For IPv4, specify the source and source-wildcard or the destination and destination-wildcard in one of two ways:

- Use the 32-bit quantity in four-part, dotted decimal format (10.1.1.2 0.0.0.0 is the same as host 10.1.1.2).
  - Each wildcard bit set to zero indicates that the corresponding bit position in the packet's IPv4 address must exactly match the bit value in the corresponding bit position in the source.
  - Each wildcard bit set to one indicates that both a zero bit and a one bit in the corresponding position of the packet's IPv4 address will be considered a match to this access list entry. Place ones in the binary bit positions you want to ignore and then convert to decimal. For example, use 0.0.255.255 to require an exact match of only the first 16 bits of the source. Wildcard bits set to one must be contiguous and at the end of the prefix. For example, a wildcard of 0.255.0.64 would not be valid.
- Use the any option as an abbreviation for a source and source-wildcard or destination and destination-wildcard (0.0.0.0 255.255.255.255)

For IPv6, specify the source or the destination IPv6 addresses in one of two ways:

- Use the 128-bit quantity in colon-separated hexadecimal <prefix>/<length> format. For example, use 2001:0DB8:800:200C::/64 to require an exact match of the first 64 bits of the source.
- Use the any option as an abbreviation for a source or destination.

Port Information

To compare the source and destination ports, use the eq (equal) option, the gt (greater than) option, the lt (less than) option, or the range (range of ports) option. Table 21-1 displays the port numbers recognized by the Cisco SAN-OS software for associated TCP and UDP ports for IPv4.

Note: IPv6-ACL CLI commands do not support TCP or UDP port names.

Table 21-1 TCP and UDP Port Numbers for IPv4

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>UDP</td>
<td>dns</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>tftp</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>ntp</td>
<td>123</td>
</tr>
<tr>
<td></td>
<td>radius accounting</td>
<td>1646 or 1813</td>
</tr>
<tr>
<td></td>
<td>radius authentication</td>
<td>1645 or 1812</td>
</tr>
<tr>
<td></td>
<td>snmp</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>snmp-trap</td>
<td>162</td>
</tr>
<tr>
<td></td>
<td>syslog</td>
<td>514</td>
</tr>
</tbody>
</table>
ICMP Information

IP packets can be filtered based on the following optional ICMP conditions:
- The icmp-type: The ICMP message type is a number from 0 to 255.
- The icmp-code: The ICMP message code is a number from 0 to 255.

Table 21-2 displays the value for each ICMP type.

<table>
<thead>
<tr>
<th>ICMP Type</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>echo</td>
<td>8</td>
</tr>
<tr>
<td>echo-reply</td>
<td>0</td>
</tr>
<tr>
<td>unreachable</td>
<td>3</td>
</tr>
<tr>
<td>redirect</td>
<td>5</td>
</tr>
<tr>
<td>time exceeded</td>
<td>11</td>
</tr>
<tr>
<td>traceroute</td>
<td>30</td>
</tr>
</tbody>
</table>

ToS Information

IPv4 packets can be filtered based on the ToS conditions—delay, monetary-cost, normal-service, reliability, and throughput.
Initial Troubleshooting Checklist

Begin troubleshooting IP-ACLs by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See <em>Cisco MDS 9000 Family Fabric Manager Configuration Guide</em>.</td>
<td></td>
</tr>
<tr>
<td>Verify that the access list has been applied to the interface.</td>
<td></td>
</tr>
<tr>
<td>Verify that the access list is not empty.</td>
<td></td>
</tr>
<tr>
<td>Verify the order of the rules in the access list.</td>
<td></td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

Choose **Switches > Security > IP ACL** to access IP-ACL configuration.

Common Troubleshooting Commands in the CLI

The following commands may be useful in troubleshooting IP-ACL issues:

- `show ip access-list`
- `show ipv6 access-list`
- `show interface`
- Use the `log-deny` option at the end of a filter condition to log information about packets that match dropped entries. The log output displays the ACL number, permit or deny status, and port information. Use the following CLI commands to ensure that the debug messages are logged to the logfile for the kernel and ipacl facilities:
  - `logging logfile SyslogFile 7`
  - `logging level kernel 7`
  - `logging level ipacl 7`

IP-ACL Issues

This section describes troubleshooting ACLs and includes the following topics:

- All Packets Are Blocked, page 21-5
- No Packets Are Blocked, page 21-7
- PortChannel Not Working with ACL, page 21-8
- Cannot Remotely Connect to Switch, page 21-8
All Packets Are Blocked

**Symptom**  All packets are blocked.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>All packets are blocked.</td>
<td>Access list is empty.</td>
<td>Remove the access list from the interface. Choose <strong>Switches &gt; Security &gt; IP ACL</strong> in Fabric Manager, select the <strong>Interfaces</strong> tab, and remove the ACL name from the ProfileName field. Click <strong>Apply Changes</strong>. Or use the <strong>no ip access-group</strong> or the <strong>no ipv6 traffic-filter</strong> CLI command in interface mode.</td>
</tr>
</tbody>
</table>

|  | A deny filter is too broad. | Delete the deny filter. Choose **Security > IP ACL** in Device Manager, right-click the access list, and click **Rules**. Right-click the filter you want to delete and click **Delete**. Or use the **no ip access-list** for IPv4-ACLs or **no ipv6 access-list** for IPv6, and use the **no deny** CLI command in IP-ACL configuration submode. |

|  | Deny filter is too high in the access list order. | Delete the access list and re-create. See the “Re-creating IP-ACLs Using Fabric Manager” section on page 21-5 or the “Re-creating IP-ACLs Using the CLI” section on page 21-6. |

|  | No existing permit filters match the packets. | Add an appropriate permit filter. Choose **Security > IP ACL** in Device Manager, right-click the access list, and click **Rules**. Click **Create**. Or use the **ip access-list** for IPv4-ACLs or **ipv6 access-list** for IPv6, and use the **permit** CLI command in IP-ACL configuration submode. |

**Re-creating IP-ACLs Using Fabric Manager**

To re-create an IP-ACL using Fabric Manager, follow these steps:

**Step 1**  Choose **Switches > Security > IP ACL** and select the **Interfaces** tab.

**Step 2**  Right-click all interfaces that have the IP-ACL you need to modify and remove the IP-ACL name from the ProfileName field.

**Step 3**  Click **Apply Changes** to save these changes.

**Step 4**  Click the **IP ACL wizard** icon. You see the IP-ACL wizard dialog box.

**Step 5**  Add the IP-ACL name in the name field and click **Add**.
**IP-ACL Issues**

**Step 6** Set the IP address, subnet mask, and protocol.

**Step 7** Select **permit** or **deny** from the Action drop-down menu and click **Next**.

**Step 8** Check the switches that you want to apply this ACL to and click **Finish**.

---

**Re-creating IP-ACLs Using the CLI**

To re-create an IP-ACL using the CLI, follow these steps:

**Step 1** Use the **show interface** command to determine which interfaces use the ACL.

```
switch# show interface gigabitethernet 2/1
GigabitEthernet2/1 is up
   Hardware is GigabitEthernet, address is 0005.3001.a706
   Internet address(es):
      4000::1/64
      fe80::205:30ff:fe01:a706/64
   MTU 2300 bytes
   Port mode is IPS
   Speed is 1 Gbps
   Beacon is turned off
   Auto-Negotiation is turned on
   ip access-group TCPAlow in
   5 minutes input rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
   5 minutes output rate 0 bits/sec, 0 bytes/sec, 0 frames/sec
   1916 packets input, 114960 bytes
   0 multicast frames, 0 compressed
   0 input errors, 0 frame, 0 overrun 0 fifo
   0 packets output, 0 bytes, 0 underruns
   0 output errors, 0 collisions, 0 fifo
   0 carrier errors
```

**Step 2** Use the **no ip access-group** or the **no ipv6 traffic-filter** command in interface mode to remove the ACL from the interface. Repeat this step for all interfaces found in **Step 1**.

```
switch(config)# interface gigabitethernet 2/1
switch(config-if)# no ip access-group TCPAlow
```

**Step 3** Use the **no ip access-list** or the **no ipv6 access-list** command to delete the access list and all filters associated with it.

```
switch(config)# no ip access-list TCPAlow
```

**Note** We recommend deleting an ACL and re-creating it because you cannot change the order of filters in an ACL.
Step 4 Use the `ip access-list` or the `ipv6 access-list` command to create an access list.

```
switch(config)# ip access-list List1 permit ip any any
```

**Tip** Add the filters in priority order. Add a fall-through filter in the case where no filter matches an incoming packet.

Step 5 Use the `ip access-group` or the `ipv6 traffic-filter` command in interface mode to add the ACL to the interface. Repeat this step for all interfaces found in Step 1.

```
switch(config)# interface gigabitethernet 2/1
switch(config-if)# ip access-group List1

switch(config)# interface gigabitethernet 2/2
switch(config-if)# ipv6 traffic-filter IPAlow
```

---

**No Packets Are Blocked**

**Symptom** No packets are blocked.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No packets are blocked.</td>
<td>A permit filter is too broad.</td>
<td>Delete the permit filter. Add an appropriate permit filter. Choose Security &gt; IP ACL in Device Manager, right-click the access list and click Rules. Right-click the rule and click Delete. Or use the <code>no ip access-list</code> for IPv4-ACLs or <code>no ipv6 access-list</code> for IPv6, and use the <code>no permit</code> CLI command in IP-ACL configuration submode.</td>
</tr>
<tr>
<td>Permit filter is too high in the access list order.</td>
<td>Delete the access list and re-create. See the “Re-creating IP-ACLs Using Fabric Manager” section on page 21-5 or the “Re-creating IP-ACLs Using the CLI” section on page 21-6.</td>
<td></td>
</tr>
</tbody>
</table>
PortChannel Not Working with ACL

**Symptom**  PortChannel not working with ACL.

**Table 21-5  PortChannel Not Working with ACL**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>PortChannel not working with ACL</td>
<td>ACL not applied to all interfaces in the PortChannel.</td>
<td>Add the ACL to all interfaces in the PortChannel. Choose <strong>Switches &gt; ISLs &gt; Port Channels</strong> to view the Members Admin field to find out which interfaces are part of the PortChannel. Choose <strong>Switches &gt; Security &gt; IP ACL</strong> on Fabric Manager, select the <strong>Interfaces</strong> tab, and add the ACL name to the ProfileName field. Click <strong>Apply Changes</strong>. Or use the <strong>show port-channel database</strong> CLI command to find out which interfaces are part of the PortChannel and then use the <strong>ip access-group</strong> or the <strong>ipv6 traffic-filter</strong> CLI command in interface mode to add the ACL to all interfaces in the PortChannel.</td>
</tr>
</tbody>
</table>

**Cannot Remotely Connect to Switch**

**Symptom**  Cannot remotely connect to switch.

**Table 21-6  Cannot Remotely Connect to Switch**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot remotely connect to switch</td>
<td>Incorrect ACL on mgmt0 interface</td>
<td>Connect to console port locally and delete the ACL. Use the <strong>no ip access-group</strong> or the <strong>no ipv6 traffic-filter</strong> CLI command in interface mode.</td>
</tr>
</tbody>
</table>
Troubleshooting IPsec

This chapter describes how to troubleshoot IP security (IPsec) and Internet Key Exchange (IKE) encryption in the Cisco MDS 9000 Family. It includes the following sections:

- Overview, page 22-1
- Initial Troubleshooting Checklist, page 22-4
- IPsec Issues, page 22-5

Overview

The IPsec protocol is a framework of open standards that provides data confidentiality, data integrity, and data authentication between participating peers. It was developed by the Internet Engineering Task Force (IETF). IPsec provides security services at the IP layer, including protecting one or more data flows between a pair of hosts, between a pair of security gateways, or between a security gateway and a host. IPsec is supported for iSCSI and FCIP using IKE and Encapsulated Security Protocol (ESP) in tunnel mode.

This section contains the following topics:

- IPsec Compatibility, page 22-1
- Supported IPsec and IKE Algorithms for Microsoft Windows and Linux Platforms, page 22-2
- IKE Allowed Transforms, page 22-3
- IPsec Allowed Transforms, page 22-4

IPsec Compatibility

IPsec features are compatible with the following Cisco MDS 9000 Family hardware:

- Cisco 14/2-port Multiprotocol Services (MPS-14/2) modules in Cisco MDS 9200 switches or Cisco MDS 9500 directors
- Cisco MDS 9216i Switch with the MPS-14/2 capability in the integrated supervisor module. Refer to the Cisco MDS 9200 Series Hardware Installation Guide for more information on the Cisco MDS 9216i Switch.
- The IPsec feature is not supported on the management interface.
Overview

Note IPsec and IKE are not supported by the Cisco Fabric Switch HP c-Class BladeSystem and the Cisco Fabric Switch for IBM BladeCenter.

IPsec features are compatible with the following fabric setup:

- Two connected Cisco MDS 9200 switches or Cisco MDS 9500 directors running Cisco MDS SAN-OS Release 2.0(1b) or later.
- A Cisco MDS 9200 switches or Cisco MDS 9500 directors running Cisco MDS SAN-OS Release 2.0(1b) or later connected to any IPsec compliant device.
- The following features are not supported in the Cisco SAN-OS implementation of the IPsec feature:
  - Authentication Header (AH).
  - Transport mode.
  - Security association bundling.
  - Manually configuring security associations.
  - Per host security association option in a crypto map.
  - Security association idle timeout
  - Dynamic crypto maps.
  - IPv6

Note Any reference to crypto maps in this document only refers to static crypto maps.

- For IPsec to interoperate effectively with Microsoft iSCSI initiators, specify the TCP protocol and the local iSCSI TCP port number (default 3260) in the IPv4-ACL. This configuration ensures the speedy recovery of encrypted iSCSI sessions following disruptions such as Gigabit Ethernet interfaces shutdowns, VRRP switchovers, and port failures. The following example of a IPv4-ACL entry shows that the MDS switch IPv4 address is 10.10.10.50 and remote Microsoft host running encrypted iSCSI sessions is 10.10.10.16:

  ```
  switch(config)# ip access-list aclmsiscsi2 permit tcp 10.10.10.50 0.0.0.0 range port 3260 3260 10.10.10.16 0.0.0.0
  ```

Note Cisco MDS IKEv2 will not interoperate with other IKEv2 implementations.

Supported IPsec and IKE Algorithms for Microsoft Windows and Linux Platforms

Table 22-2 lists the supported and verified settings for IPsec and IKE encryption authentication algorithms on the Microsoft Windows and Linux platforms.
Table 22-1  IPsec and IKE for Windows and Linux

<table>
<thead>
<tr>
<th>Platform</th>
<th>IKE</th>
<th>IPsec</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft iSCSI initiator, Microsoft IPsec implementation on Microsoft Windows 2000 platform</td>
<td>3DES, SHA-1 or MD5, DH group 2</td>
<td>3DES, SHA-1</td>
</tr>
<tr>
<td>Cisco iSCSI initiator, Free Swan IPsec implementation on Linux platform</td>
<td>3DES, MD5, DH group 1</td>
<td>3DES, MD5</td>
</tr>
</tbody>
</table>

IKE Allowed Transforms

Table 22-2 provides a list of allowed transform combinations for IKE.

Table 22-2  IKE Transform Configuration Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Accepted Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encryption algorithm</td>
<td>56-bit DES-CBC</td>
<td>3DES</td>
</tr>
<tr>
<td></td>
<td>168-bit DES (3DES)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>128-bit AES</td>
<td></td>
</tr>
<tr>
<td>Hash algorithm</td>
<td>SHA-1 (HMAC variant)</td>
<td>SHA-1</td>
</tr>
<tr>
<td></td>
<td>MD5 (HMAC variant)</td>
<td></td>
</tr>
<tr>
<td>Authentication method</td>
<td>Preshared keys</td>
<td>Preshared keys</td>
</tr>
<tr>
<td></td>
<td>RSA signatures in digital certificates</td>
<td></td>
</tr>
<tr>
<td>DH group identifier</td>
<td>768-bit DH</td>
<td>768-bit DH (1)</td>
</tr>
<tr>
<td></td>
<td>1024-bit DH</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1536-bit DH</td>
<td></td>
</tr>
</tbody>
</table>
Initial Troubleshooting Checklist

Begin troubleshooting IPsec issues by checking the following issues:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See <em>Cisco MDS 9000 Family Fabric Manager Configuration Guide</em>.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that IKE has been configured for IPsec.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify the digital certificates configuration if it is enabled for IPsec. See Chapter 24, “Troubleshooting Digital Certificates.”</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that there are matching IKE policies defined at each peer.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have refreshed SAs after any IKEv2 reconfiguration.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have configured mirror crypto map ACLs at the peer for every crypto map ACL configured locally.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

Choose **Switches > Security > IPsec** to access IPsec.
Choose **Switches > Security > IKE** to access IKE.
## Troubleshooting Commands in the CLI

Use the following commands to troubleshoot IPsec issues:

- `show crypto transform-set domain ipsec`
- `show crypto global domain ipsec`
- `show crypto global domain ipsec security-association lifetime`
- `show crypto sad domain ipsec`

Use the following internal commands to gather more information for IPsec issues:

- `show ipsec internal error` — Displays a log of error history.
- `show ipsec internal mem-stats detail` — Displays memory usage.
- `show ipsec internal event-history msgs` — Displays a log of message history.

Use the following commands to gather information from the hardware accelerator:

- `show ipsec internal crypto-accelerator interface gigabit 2/1 sad inbound/outbound sa-index` — Displays detailed information of an SA from the hardware accelerator.
- `show ipsec internal crypto-accelerator interface gigabit 2/1 stats` — Displays detailed information per interface from the hardware accelerator.

## IPsec Issues

This section provides the procedures required to troubleshoot IKE and IPsec issues in an FCIP configuration. Figure 22-1 shows a simple FCIP configuration where FCIP Tunnel 2 carries encrypted data between switches MDS A and MDS C.

### Figure 22-1 Simple FCIP Configuration

This section includes the following topics:

- Verifying IKE Configuration Compatibility, page 22-6
- Verifying IPsec Configuration Compatibility Using Fabric Manager, page 22-6
- Verifying IPsec Configuration Compatibility Using the CLI, page 22-7
- Verifying Security Policy Databases Compatibility, page 22-8
- Verifying Interface Status Using Fabric Manager, page 22-9
- Verifying Interface Status Using the CLI, page 22-9
- Verifying Security Associations, page 22-12
Verifying IKE Configuration Compatibility

To verify the compatibility of the IKE configurations of MDS A and MDS C shown in Figure 22-1, follow these steps:

**Step 1**
Ensure that the preshared keys are identical on each switch. Use the `show crypto ike domain ipsec key` CLI command on both switches. Command outputs for the configuration shown in Figure 22-1 follow:

**MDSA**

```
key ctct address 10.10.100.232
```

**MDSC**

```
key ctct address 10.10.100.231
```

**Step 2**
Ensure that at least one matching policy that has the same encryption algorithm, hash algorithm, and Diffie-Hellman (DH) group is configured on each switch. Issue the `show crypto ike domain ipsec policy` command on both switches. Example command outputs for the configuration shown in Figure 22-1 follow:

**MDSA**

```
Priority 1, auth pre-shared, lifetime 86300 secs, encryption 3des, hash md5, DH group 1
```

**MDSC**

```
Priority 1, auth pre-shared, lifetime 86300 secs, encryption 3des, hash md5, DH group 1
```

Verifying IPsec Configuration Compatibility Using Fabric Manager

To verify the compatibility of the IPsec configurations of MDS A and MDS C shown in Figure 22-1 using Fabric manager, follow these steps:

**Step 1**
Choose `Switches > Security > IPSEC` and select the `CryptoMap Set Entry` tab. Verify that the Peer Address, IpFilter, Lifetime, and PFS fields match for MDS A and MDS C.

**Step 2**
Select the `Transform Set` tab and verify that the transform set on both switches match.

**Step 3**
Select the `Interfaces` tab and verify that the crypto map set is applied to the correct interface on both switches.

**Step 4**
In Device Manager, choose `IP > ACLs` and verify that the ACLs used in the crypto map in Step 1 are compatible on both switches.
Verifying IPsec Configuration Compatibility Using the CLI

To verify the compatibility of the IPsec configurations of MDS A and MDS C shown in Figure 22-1 using the CLI, follow these steps:

**Step 1** Use the `show crypto map domain ipsec` command and the `show crypto transform-set domain ipsec` command. The following command outputs display the fields discussed in Step 2 through Step 7.

```
MDSA# show crypto map domain ipsec
Crypto Map "cmap-01" 1 ipsec
   Peer = 10.10.100.232
       IP ACL = acl1
           permit ip 10.10.100.231 255.255.255.255 10.10.100.232 255.255.255.255
       Transform-sets: tfs-02,
           Security Association Lifetime: 3000 gigabytes/120 seconds
       PFS (Y/N): Y
       PFS Group: group5
   Interface using crypto map set cmap-01:
   GigabitEthernet7/1

MDSC# show crypto map domain ipsec
Crypto Map "cmap-01" 1 ipsec
   Peer = 10.10.100.231
       IP ACL = acl1
           permit ip 10.10.100.232 255.255.255.255 10.10.100.231 255.255.255.255
       Transform-sets: tfs-02,
           Security Association Lifetime: 3000 gigabytes/120 seconds
       PFS (Y/N): Y
       PFS Group: group5
   Interface using crypto map set cmap-01:
   GigabitEthernet1/2
```

```
MDSA# show crypto transform-set domain ipsec
Transform set:tfs-01 {esp-3des null} will negotiate {tunnel}
   Transform set:tfs-02 {esp-3des esp-md5-hmac} will negotiate {tunnel}
   Transform set:ipsec_default_transform_set {esp-aes 128 esp-sha1-hmac} will negotiate {tunnel}

MDSC# show crypto transform-set domain ipsec
Transform set:tfs-01 {esp-3des null} will negotiate {tunnel}
   Transform set:tfs-02 {esp-3des esp-md5-hmac} will negotiate {tunnel}
   Transform set:ipsec_default_transform_set {esp-aes 128 esp-sha1-hmac} will negotiate {tunnel}
```

**Step 2** Ensure that the ACLs are compatible in the `show crypto map domain ipsec` command outputs for both switches.

**Step 3** Ensure that the peer configuration is correct in the `show crypto map domain ipsec` command outputs for both switches.

**Step 4** Ensure that the transform sets are compatible in the `show crypto transform-set domain ipsec` command outputs for both switches.

**Step 5** Ensure that the PFS settings in the `show crypto map domain ipsec` command outputs are configured the same on both switches.
Step 6 Ensure that the security association (SA) lifetime settings in the `show crypto map domain ipsec` command outputs are large enough to avoid excessive re-keys (the default settings ensure this).

Step 7 Ensure that the crypto map set is applied to the correct interface in the `show crypto map domain ipsec` command outputs for both switches.

---

**Verifying Security Policy Databases Compatibility**

To verify that the security policy databases (SPDs) are compatible on both switches, follow these steps:

**Step 1** Issue the `show crypto spd domain ipsec` command on both switches to display the SPD. The command outputs follow:

```
MDSA# show crypto spd domain ipsec
Policy Database for interface:GigabitEthernet7/1, direction:Both
#   0:     deny  udp any port eq 500 any <--------Clear test policies for IKE
#   1:     deny  udp any any port eq 500 <--------Clear test policies for IKE
#   2:     permit ip 10.10.100.231 255.255.255.255 10.10.100.232 255.255.255.255
# 127:     deny  ip any any <----------Clear test policy for all other traffic

MDSC# show crypto spd domain ipsec
Policy Database for interface:GigabitEthernet1/2, direction:Both
#   0:     deny  udp any port eq 500 any
#   1:     deny  udp any any port eq 500
#   2:     permit ip 10.10.100.232 255.255.255.255 10.10.100.231 255.255.255.255
# 127:     deny  ip any any
```

**Step 2** Issue the `show ipsec internal crypto-accelerator interface gigabitethernet slot/port spd inbound` command on both switches to display SPD information from the crypto-accelerator.

**Note** To issue commands with the internal keyword, you must have an account that is a member of the network-admin group.

The example command outputs follow:

```
MDSA# show ipsec internal crypto-accelerator interface gigabitethernet 7/1 spd inbound
Inbound Policy 0 :
Source IP Address :*
Destination IP Address :
Source port :500, Destination port :* Protocol UDP
Physical port:0/0, Vlan_id:0/0
Action cleartext

Inbound Policy 1 :
Source IP Address :*
Destination IP Address :
Source port :*, Destination port :500 Protocol UDP
Physical port:0/0, Vlan_id:0/0
Action cleartext

Inbound Policy 2 :
Source IP Address :10.10.100.232/255.255.255.255
Destination IP Address :10.10.100.231/255.255.255.255
Source port :*, Destination port :* Protocol *
Physical port:0/1, Vlan_id:0/4095
```
### Verifying Interface Status Using Fabric Manager

To verify the status of the interfaces using Fabric Manager, follow these steps:

**Step 1** Choose **Switches > Interfaces > GigabitEthernet** to verify that the interfaces are up and their IP addresses are correct.

**Step 2** Choose **ISLs > FCIP** and select the **Tunnels** tab. Verify that each interface is using the correct profile, the peer internet addresses are configured correctly, and the FCIP tunnels are compatible.

### Verifying Interface Status Using the CLI

To verify the status of the interfaces using the CLI, follow these steps:

```text
Action ipsec

Inbound Policy 127:
Source IP Address: *
Destination IP Address: *
Source port: *, Destination port: * Protocol *
Physical: 0/0, Vlan_id: 0/0
Action cleartext

MDSC# show ipsec internal crypto-accelerator interface gigabitethernet 1/2 spd inbound

Inbound Policy 0:
Source IP Address: *
Destination IP Address: *
Source port: 500, Destination port: * Protocol UDP
Physical: 0/0, Vlan_id: 0/0
Action cleartext

Inbound Policy 1:
Source IP Address: *
Destination IP Address: *
Source port: *, Destination port: 500 Protocol UDP
Physical: 0/0, Vlan_id: 0/0
Action cleartext

Inbound Policy 2:
Source IP Address: 10.10.100.231/255.255.255.255
Destination IP Address: 10.10.100.232/255.255.255.255
Source port: *, Destination port: * Protocol *
Physical: 1/1, Vlan_id: 0/4095
Action ipsec

Inbound Policy 127:
Source IP Address: *
Destination IP Address: *
Source port: *, Destination port: * Protocol *
Physical: 0/0, Vlan_id: 0/0
Action cleartext
```
Step 1  Issue the `show interface gigabitethernet` command on both switches. Verify that the interfaces are up and their IP addresses are correct. Issue the `no shutdown` command if necessary. The command outputs follow:

```
MDSA# show interface gigabitethernet 7/1
  GigabitEthernet7/1 is up
  Hardware is GigabitEthernet, address is 0005.3001.804e
  Internet address is 10.10.100.231/24
  MTU 1500 bytes
  Port mode is IPS
  Speed is 1 Gbps
  Beacon is turned off
  Auto-Negotiation is turned on
  5 minutes input rate 7728 bits/sec, 966 bytes/sec, 8 frames/sec
  5 minutes output rate 7968 bits/sec, 996 bytes/sec, 8 frames/sec
  7175 packets input, 816924 bytes
  0 multicast frames, 0 compressed
  0 input errors, 0 frame, 0 overrun 0 fifo
  7285 packets output, 840018 bytes, 0 underruns
  0 output errors, 0 collisions, 0 fifo
  0 carrier errors

MDSC# show interface gigabitethernet 1/2
  GigabitEthernet1/2 is up
  Hardware is GigabitEthernet, address is 0005.3001.7f0f
  Internet address is 10.10.100.232/24
  MTU 1500 bytes
  Port mode is IPS
  Speed is 1 Gbps
  Beacon is turned off
  Auto-Negotiation is turned on
  5 minutes input rate 7528 bits/sec, 941 bytes/sec, 8 frames/sec
  5 minutes output rate 7288 bits/sec, 911 bytes/sec, 8 frames/sec
  7209 packets input, 835518 bytes
  0 multicast frames, 0 compressed
  0 input errors, 0 frame, 0 overrun 0 fifo
  7301 packets output, 827630 bytes, 0 underruns
  0 output errors, 0 collisions, 0 fifo
  0 carrier errors
```

Step 2  Issue the `show interface fcip` command on both switches. Verify that each interface is using the correct profile, the peer internet addresses are configured correctly, and the FCIP tunnels are compatible. Issue the `no shutdown` command if necessary. The command outputs follow:

```
MDSA# show interface fcip 1
  fcip1 is trunking
  Hardware is GigabitEthernet
  Port WWN is 21:90:00:0d:ec:02:64:80
  Peer port WWN is 20:14:00:0d:ec:08:5f:c0
  Admin port mode is auto, trunk mode is on
  Port mode is TE
  Port vsan is 1
  Speed is 1 Gbps
  Trunk vsans (admin allowed and active) (1,100,200,302-303,999,3001-3060)
  Trunk vsans (up) (1)
  Trunk vsans (isolated) (100,200,302-303,999,3001-3060)
  Trunk vsans (initializing) ()
  Using Profile id 1 (interface GigabitEthernet7/1)
  Peer Information
    Peer Internet address is 10.10.100.232 and port is 3225
    FCIP tunnel is protected by IPSec
    Write acceleration mode is off
```
Chapter 22  Troubleshooting IPsec

Send documentation comments to mdsfeedback-doc@cisco.com

Tape acceleration mode is off
Tape Accelerator flow control buffer size is automatic
IP Compression is disabled
Special Frame is disabled
Maximum number of TCP connections is 2
Time Stamp is disabled
QoS control code point is 0
QoS data code point is 0
B-port mode disabled
TCP Connection Information
  2 Active TCP connections
    Control connection: Local 10.10.100.231:3225, Remote 10.10.100.232:65492
    Data connection: Local 10.10.100.231:3225, Remote 10.10.100.232:65494
  20 Attempts for active connections, 0 close of connections
TCP Parameters
  Path MTU 1400 bytes
  Current retransmission timeout is 200 ms
  Round trip time: Smoothed 2 ms, Variance: 3
  Advertized window: Current: 118 KB, Maximum: 14 KB, Scale: 6
  Peer receive window: Current: 128 KB, Maximum: 128 KB, Scale: 6
  Congestion window: Current: 14 KB, Slow start threshold: 204 KB
  Current Send Buffer Size: 14 KB, Requested Send Buffer Size: 0 KB
  CWM Burst Size: 50 KB
5 minutes input rate 2960 bits/sec, 370 bytes/sec, 4 frames/sec
5 minutes output rate 3184 bits/sec, 398 bytes/sec, 4 frames/sec
  3628 frames input, 340644 bytes
    3610 Class F frames input, 338396 bytes
    18 Class 2/3 frames input, 2248 bytes
    0 Reass frames
    0 Error frames timestamp error 0
  3624 frames output, 359140 bytes
    3608 Class F frames output, 357332 bytes
    16 Class 2/3 frames output, 1808 bytes
    0 Error frames

MDSC# show interface fcip 1
fcip1 is trunking
  Hardware is GigabitEthernet
  Port WWN is 20:14:00:0d:ec:08:5f:c0
  Peer port WWN is 21:90:00:0d:ec:02:64:80
  Admin port mode is auto, trunk mode is on
  Port mode is TE
  Port vsan is 1
  Speed is 1 Gbps
  Trunk vsans (admin allowed and active) {1}
  Trunk vsans (up) {1}
  Trunk vsans (isolated) ()
  Trunk vsans (initializing) ()
  Using Profile id 1 (interface GigabitEthernet1/2)
  Peer Information
    Peer Internet address is 10.10.100.231 and port is 3225
    FCIP tunnel is protected by IPSec
    Write acceleration mode is off
    Tape acceleration mode is off
    Tape Accelerator flow control buffer size is automatic
    IP Compression is disabled
  Special Frame is disabled
    Maximum number of TCP connections is 2
    Time Stamp is disabled
    QoS control code point is 0
    QoS data code point is 0
    B-port mode disabled
    TCP Connection Information
IPsec Issues

2 Active TCP connections
  Control connection: Local 10.10.100.232:65492, Remote 10.10.100.231:3225
  Data connection: Local 10.10.100.232:65494, Remote 10.10.100.231:3225
22 Attempts for active connections, 1 close of connections

TCP Parameters
  Path MTU 1400 bytes
  Current retransmission timeout is 200 ms
  Round trip time: Smoothed 2 ms, Variance: 3
  Advertized window: Current: 128 KB, Maximum: 14 KB, Scale: 6
  Peer receive window: Current: 118 KB, Maximum: 118 KB, Scale: 6
  Congestion window: Current: 15 KB, Slow start threshold: 204 KB
  Current Send Buffer Size: 14 KB, Requested Send Buffer Size: 0 KB
  CWM Burst Size: 50 KB

5 minutes input rate 3192 bits/sec, 399 bytes/sec, 4 frames/sec
5 minutes output rate 2960 bits/sec, 370 bytes/sec, 4 frames/sec
3626 frames input, 359324 bytes
  3610 Class F frames input, 357516 bytes
  16 Class 2/3 frames input, 1808 bytes
  1 Reass frames
  0 Error frames timestamp error 0
3630 frames output, 340828 bytes
  3612 Class F frames output, 338580 bytes
  18 Class 2/3 frames output, 2248 bytes
  0 Error frames

Verifying Security Associations

To verify security associations (SAs), follow these steps:

Step 1  Issue the **show crypto sad domain ipsec** command to verify the current peer, mode, and inbound and outbound index of each switch. The example command outputs follow:

```
MDSA# show crypto sad domain ipsec
interface: GigabitEthernet7/1
  Crypto map tag: cmap-01, local addr. 10.10.100.231
  protected network:
    local ident (addr/mask): (10.10.100.231/255.255.255.255)
    remote ident (addr/mask): (10.10.100.232/255.255.255.255)
  current_peer: 10.10.100.232
    local crypto endpt.: 10.10.100.231, remote crypto endpt.: 10.10.100.232
    mode: tunnel, crypto algo: esp-3des, auth algo: esp-md5-hmac
    tunnel id is: 1
    current outbound spi: 0x822a202 (136487426), index: 1
    lifetimes in seconds: 3600
    lifetimes in bytes: 483183820800
  current inbound spi: 0x0822a202 (136487426), index: 1
    lifetimes in seconds: 3600
    lifetimes in bytes: 483183820800

MDSC# show crypto sad domain ipsec
interface: GigabitEthernet1/2
  Crypto map tag: cmap-01, local addr. 10.10.100.232
  protected network:
    local ident (addr/mask): (10.10.100.232/255.255.255.255)
    remote ident (addr/mask): (10.10.100.231/255.255.255.255)
  current_peer: 10.10.100.231
    local crypto endpt.: 10.10.100.232, remote crypto endpt.: 10.10.100.231
```
Step 2  The SA index can be used to look at the SA in the crypto-accelerator. Issue the show ipsec internal crypto-accelerator interface gigabitethernet slot/port sad [inbound | outbound] sa-index command to display the inbound or outbound SA information. The hard limit bytes and soft limit bytes fields display the lifetime in bytes. The hard limit expiry secs and the soft limit expiry secs fields display the lifetime in seconds.

Note  To issue commands with the internal keyword, you must have an account that is a member of the network-admin group.

The command outputs follow:

MDSA# show ipsec internal crypto-accelerator interface gigabitethernet 7/1 sad inbound 1
sw172.22.48.91# show ipsec internal crypto-accelerator interface gigabitethernet 7/1 sad inbound 1
Inbound SA 1 :
  Mode :Tunnel, flags:0x492300000000000
  IPsec mode is ESP
  Encrypt algorithm is DES/3DES
  Auth algorithm is MD5
  Source ip address 10.10.100.232/255.255.255.255
  Destination ip address 10.10.100.231/255.255.255.255
  Physical port 0, mask:0x1
  Misc select 0 mask:0x0
  Vlan 0 mask:0xfff
  Protocol 0 mask:0x0
  Source port no 0 mask:0x0
  Dest port no 0 mask:0x0
  Hard limit 483183820800 bytes
  Soft limit 401042571264 bytes
  SA byte count 845208 bytes <----Elapsed traffic
  SA user byte count 845208 bytes <----Elapsed traffic
  Error count:auth:0, pad:0, replay:0
  Packet count 7032
  Hard limit expiry 1100652419 secs (since January 1, 1970), remaining 219 7 secs
  Soft limit expiry 1100652386 secs (since January 1, 1970), remaining 216 4 secs
  Sequence number:7033
  Antireplay window:0xffffffff.0xffffffff.0xffffffff.0xffffffff

MDSC# show ipsec internal crypto-accelerator interface gigabitethernet 1/2 sad inbound 513
Inbound SA 513 :
  Mode :Tunnel, flags:0x492300000000000
  IPsec mode is ESP
  Encrypt algorithm is DES/3DES
  Auth algorithm is MD5
  Source ip address 10.10.100.231/255.255.255.255
  Destination ip address 10.10.100.232/255.255.255.255
  Physical port 1, mask:0x1
  Misc select 0 mask:0x0
  Vlan 0 mask:0xfff
  Protocol 0 mask:0x0
Source port no 0 mask:0x0
Dest port no 0 mask:0x0
Hard limit 483183820800 bytes
Soft limit 420369924096 bytes
SA byte count 873056 bytes
SA user byte count 873056 bytes
Error count:auth:0, pad:0, replay:0
Packet count 7137
Hard limit expiry 1100652419 secs (since January 1, 1970), remaining 214 1 secs
Soft limit expiry 1100652394 secs (since January 1, 1970), remaining 211 6 secs
Sequence number:7138
Antireplay window:0xffffffff.0xffffffff.0xffffffff.0xffffffff

MDSA# show ipsec internal crypto-accelerator interface gigabitethernet 7/1 sad outbound 1
Outbound SA 1 :
SPI 136487426 (0x822a202), MTU 1400, MTU_delta 4
Mode :Tunnel, flags:0x92100000000000
IPsec mode is ESP
Tunnel options index:0, ttl:0x40, flags:0x1
Encrypt algorithm is DES/3DES
Auth algorithm is MD5
Tunnel source ip address 10.10.100.231
Tunnel destination ip address 10.10.100.232
Hard limit 483183820800 bytes
Soft limit 376883380224 bytes
SA byte count 874544 bytes
SA user byte count 874544 bytes
Packet count 7150
Hard limit expiry 1100652419 secs (since January 1, 1970), remaining 208 9 secs
Soft limit expiry 1100652384 secs (since January 1, 1970), remaining 205 4 secs
Outbound MAC table index:1
Sequence number:7151

MDSC# show ipsec internal crypto-accelerator interface gigabitethernet 1/2 sad outbound 513
Outbound SA 513 :
SPI 940863490 (0x38147002), MTU 1400, MTU_delta 4
Mode :Tunnel, flags:0x92100000000000
IPsec mode is ESP
Tunnel options index:0, ttl:0x40, flags:0x1
Encrypt algorithm is DES/3DES
Auth algorithm is MD5
Tunnel source ip address 10.10.100.231
Tunnel destination ip address 10.10.100.232
Hard limit 483183820800 bytes
Soft limit 449360953344 bytes
SA byte count 855648 bytes
SA user byte count 855648 bytes
Packet count 7122
Hard limit expiry 1100652419 secs (since January 1, 1970), remaining 206 4 secs
Soft limit expiry 1100652397 secs (since January 1, 1970), remaining 204 2 secs
Outbound MAC table index:125
Sequence number:7123
Security Associations Do Not Re-Key

A lifetime counter (in seconds and bytes) is maintained as soon as an SA is created. When the time limit expires, the SA is no longer operational and is automatically renegotiated (re-keyed) if traffic is present. If there is no traffic, the SA will not be re-keyed and the tunnel will go down.

The re-key operation starts when the soft lifetime expires. That happens approximately 20 to 30 seconds before the time-based lifetime expires, or when approximately 10 to 20 percent of the bytes are remaining in the bytes-based lifetime.

To troubleshoot this problem, follow these steps:

Step 1
Verify that traffic was flowing when the soft SA lifetime expired.

Step 2
Verify that the configurations are still compatible.

Clearing Security Associations

To clear a specific SA, obtain the SA index value and issue the `clear crypto sa domain ipsec interface gigabitethernet slot/port outbound sa-index` command.

To obtain the SA index value, issue the `show crypto sad domain ipsec` command.

Debugging the IPsec Process

Use the following commands to print debug messages to the console:

- `debug ipsec error` for error messages.
- `debug ipsec warning` for warning messages.
- `debug ipsec config` for configuration messages.
- `debug ipsec flow` for SA related messages.

Debugging the IKE Process

Use the following commands to show the internal state of the IKE process:

- `show crypto ike domain ipsec initiator`
- `show crypto ike domain ipsec sa`

Obtaining Statistics from the IPsec Process

To obtain statistics from the IPsec process, issue the `show crypto global domain ipsec` command and the `show crypto global domain ipsec interface gigabitethernet slot/port` command. The `show crypto global domain ipsec` command output displays statistics for all SAs. Command output follows:

```
MDSA# show crypto global domain ipsec
IPSec global statistics:
```

Number of crypto map sets: 1
IKE transaction stats: 0 num, 64 max
Inbound SA stats: 1 num
Outbound SA stats: 1 num

The `show crypto global domain ipsec interface gigabitethernet slot/port` command output displays interface level statistics. Example command output follows:

```
MDSA# show crypto global domain ipsec interface gigabitethernet 7/1
IPSec interface statistics:
    IKE transaction stats: 0 num
    Inbound SA stats: 1 num, 512 max
    Outbound SA stats: 1 num, 512 max
```
Troubleshooting SANTap

This chapter describes how to identify and resolve problems that might occur when implementing SANTap. This chapter includes the following sections:

- Overview, page 23-1
- Definitions, page 23-2
- Limitations, page 23-2
- Initial Troubleshooting Checklist, page 23-3
- SANTap Issues, page 23-6

Overview

SANTap is not supported in Release 3.3.1.

SANTap is an Intelligent Storage Services feature supported on the Storage Services Module (SSM). The SSM supports SANTap in Cisco MDS SAN-OS Release 2.0(2b) and later. The SANTap feature allows third-party data storage applications, such as long distance replication and continuous backup, to be integrated into the SAN.

SANTap has a control path and a data path. The control path services requests that create and manipulate replication sessions that are sent by an appliance. The control path is implemented using a SCSI-based protocol. An appliance sends requests to a control virtual target (CVT) which the SANTap process creates and monitors. Responses are sent to the control LUN on the appliance. SANTap also allows LUN mapping to appliance virtual targets (AVTs). You can have a maximum of 512 target LUNs.

When introducing SANTap-based applications, SANTap does not require reconfiguration of either the host or the target, and neither the host initiator nor the target is required to be directly connected to an SSM. This accomplished by assigning Cisco-specific WWNs to the virtual initiators (VIs) and data virtual targets (DVTs).

A host initiator or a target can be connected directly to an SSM. However, you must partition the SAN using VSANs. You must configure the host initiator and the DVT in one VSAN and configure the virtual initiator (VI) and the target in another VSAN.
Definitions

Table 23-1 includes brief definitions of some of the common SANTap acronyms and terms.

Table 23-1 SANTap Acronyms

<table>
<thead>
<tr>
<th>Acronym / Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVT</td>
<td>Appliance virtual target. The portal through which an appliance can complete its synchronization with the target LUN. AVT can be thought of as a host proxy for the appliance.</td>
</tr>
<tr>
<td>CVT</td>
<td>Control virtual target. The portal through which an appliance communicates with SANTap. An initiator port on the appliance sends out SANTap Control Protocol requests to the SANTap process. When the request is processed, the response is sent back by the Cisco VI (virtual initiator) to a target port on the appliance.</td>
</tr>
<tr>
<td>DVT</td>
<td>Data virtual target. A DVT is created for every port on a multi-ported target that is included in SANTap-based services. The DVT is created in the host VSAN. Once a DVT is created and a host logs into the DVT, SANTap installs a DVTLUN for every configured LUN on the target for this host.</td>
</tr>
<tr>
<td>ITL</td>
<td>Initiator/target/LUN tuple. Uniquely identifies a LUN on a target.</td>
</tr>
<tr>
<td>Session</td>
<td>A record/object that is created for every ITL whose WRITE I/Os the appliance is interested in. A session can be thought of as a target LUN that requires SANTap-based services.</td>
</tr>
<tr>
<td>VI</td>
<td>Virtual initiator. SANTap creates 9 VIs in the appliance and target VSANs. In the appliance, VIs are used to send responses to SANTap CP requests and also to send copies of WRITE I/Os. In the target, VIs are used when the appliance is down and one of the SANTap recovery tools (ARL, PWL-BPR) is enabled. Note: If the appliance implementation chooses not to use these recovery tools, the VIs are not used.</td>
</tr>
</tbody>
</table>

Limitations

This section describes SANTap limitations. Table 23-2 describes the component limitations by SAN-OS and SSI releases.

- One Recover Point Appliance (RPA) cluster can have only one target VSAN.
- SANTap does not support IVR. You cannot run SANTap and IVR together.

Table 23-2 SANTap Attribute Limitations

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Limitation</th>
<th>Cisco SAN-OS and SSI Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts per DVT</td>
<td>16</td>
<td>Prior to Cisco SAN-OS 3.2</td>
</tr>
<tr>
<td></td>
<td>32</td>
<td>Cisco SAN-OS 3.2</td>
</tr>
<tr>
<td>LUNs per host</td>
<td>256</td>
<td>All releases</td>
</tr>
<tr>
<td>LUNs per DVT</td>
<td>1500</td>
<td>Cisco SAN-OS 3.2</td>
</tr>
<tr>
<td></td>
<td>1024</td>
<td>Prior to Cisco SAN-OS 3.2</td>
</tr>
</tbody>
</table>
Interface Restrictions

When enabled on a per-port basis, SANTap must be enabled on a group of four ports on an SSM. The following restrictions apply:

- The fewest number of interfaces that can be SANTap enabled is four.
- The first interfaces in a group must be 1, 5, 9, 13, 17, 21, 25, or 29. (You can specify fc5 through fc8, but not fc7 through fc10.)
- The groups of four interfaces do not need to be consecutive. For example, you can specify fc1 through fc8 and fc17 through fc20.

Initial Troubleshooting Checklist

Troubleshooting a SANTap problem involves gathering information about the configuration and connectivity of the various SANTap components. Begin your troubleshooting activity as follows:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See Cisco MDS 9000 Family Fabric Manager Configuration Guide.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that SANTap is enabled on the SSM module of the selected switch.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify the VSAN configuration and zones for the appliance, using the configuration and verification tools for the specific appliance.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify the physical connectivity for any problem ports or VSANs.</td>
<td>☐</td>
</tr>
</tbody>
</table>
Common Troubleshooting Tools in Fabric Manager

Use the following Fabric Manager procedures to verify the VSAN configuration for the SANTap components.

- Choose Fabricxx > VSANxx to view the VSAN configuration in the Information pane.
- Choose Fabricxx > VSANxx and select the Host or Storage tab in the Information pane to view the VSAN members.

Common Troubleshooting Commands in the CLI

Use the show santap module command to display information about SANTap.

**Example 23-1  Display SANTap CVT Information**

```
switch# show santap module 2 cvt

CVT Information :
  cvt pwwn    = 23:4f:00:0d:ec:09:3c:02
  cvt mwwn    = 23:9d:00:0d:ec:09:3c:02
  cvt id      = 135895180
  cvt xmap_id = 135895212
  cvt vsan    = 8
  cvt name    =
```

**Example 23-2  Display SANTap DVT Information**

```
switch# show santap module 2 dvt

DVT Information :
  dvt pwwn        = 50:06:0e:80:03:81:32:36
  dvt mwwn        = 50:06:0e:80:03:81:32:36
  dvt id          = 136773180
  dvt mode        = 3
  dvt vsan        = 12
  dvt if_index    = 0x1080000
  dvt fp_port     = 1
  dvt name        = MYDVT
  dvt tgt-vsan    = 9
  dvt io timeout  = 10 secs
  dvt lun size handling = 0
  dvt app iofail behaviour = 1
  dvt quiesce behavior = 1
  dvt tgt iofail behavior = 0
  dvt appio failover time = 50 secs
  dvt inq data behavior = 0
```

**Example 23-3  Display SANTap DVT LUN Information**

```
switch# show santap module 2 dvtlun

DVT LUN Information :
  dvt pwwn       = 22:00:00:20:37:88:20:ef
  dvt lun        = 0x0
  xmap id        = 8
```
Example 23-4 Display SANTap Session Information

switch# show santap module 2 session

Session Information:

session id = 1
host pwwn = 21:00:00:e0:8b:12:8b:7a
dvt pwwn = 50:06:0e:80:03:81:32:36
dvt lun = 0x0
tgt pwwn = 50:06:0e:80:03:81:32:36
tgt lun = 0x0
adt lun = 0x0
cvt pwwn = 23:4f:00:0d:ec:09:3c:02
num ranges = 0
session state = 5
redirect mode = 0
mrl requested 1
MRL: vsan 8 RegionSize 4806720, DiskPWWN 0x234f000dec093c02, DiskLun 0x 1, startLBA 1
pwl requested 1
PWL: type 2, UpdatePol 2, RetirePolicy 4, pwl_start 1
iol requested 0

Example 23-5 Display SANTap AVT Information

switch# show santap module 2 avt

AVT Information:

avt pwwn = 2a:4b:00:05:30:00:22:25
avt nwwn = 2a:60:00:05:30:00:22:25
avt id = 12
avt vsan = 4
avt if_index = 0x108000
hi pwwn = 21:00:00:e0:8b:07:61:aa
tgt pwwn = 22:00:00:20:37:88:20:ef
tgt vsan = 1

Example 23-6 Display SANTap AVT LUN Information

switch# show santap module 2 avtlun

AVT LUN Information:

avt pwwn = 2a:4b:00:05:30:00:22:25
avt lun = 0x0
xmap id = 16
avt id = 12
tgt lun = 0x0
Example 23-7 Display SANTap Remote Virtual Terminal Information

switch# show santap module 2 rvt

RVT Information:
  rvt pwwn   = 2a:61:00:05:30:00:22:25
  rvt nwwn   = 2a:62:00:05:30:00:22:25
  rvt id     = 17
  rvt vsan   = 4
  rvt if_index = 0x1080000

Example 23-8 Display SANTap Remote Virtual Terminal LUN Information

switch# show santap module 2 rvtlun

RVT LUN Information:
  rvt pwwn   = 2a:61:00:05:30:00:22:25
  rvt lun    = 0x0
  xmap id    = 22
  rvt id     = 17
  app pwwn   = 22:00:00:20:37:39:b1:00
  app lun    = 0x0
  app vsan   = 1

Use the following commands to display more advanced troubleshooting information for SANTap.

- show tech-support
- show santap module 2 tech-support
- show isapi tech-support
- show santap vttbl dvt dvt-pwnn

Messages, Logs and Databases

The following log files and databases can provide helpful information when troubleshooting SANTap problems.

- Look for SSM_CRIT in Sup syslog messages.
- SANTap logs are available via the show isapi tech-support CLI command. Search for the strings “Error” and “failed” or “failure.”
- Review FCNS and FLOGI databases, using the show fcns and show flogi CLI commands.

SANTap Issues

This section includes the following topics:

- Host Login Problems, page 23-7
- ITL Problems, page 23-7
- Common Mismatch Problems, page 23-7
Host Login Problems

Host login problems can be caused by DVT limitations, connectivity, or other issues.

To diagnose host login problems, follow these steps:

Step 1: Use the `show santap vttbl dvt dvt-pwwn` command to display SANTap information for the DVT.

Step 2: Use the `show santap vttbl dvt dvt-pwwn host-pwwn` command to display SANTap information for the DVT and the host.

Step 3: Enable logging on the appropriate SSM module.

Step 4: Issue the following debug commands:
   a. `debug vsd vfc-felogin`
   b. `debug partner 0x92810000 d1`
   c. `debug partner 0x92810000 d2`

Step 5: Review the logs to determine the problem and then take the appropriate corrective action.

ITL Problems

An ITL problem may occur if the number of ITLs exceeds the limitations for the version of Cisco SAN-OS and SSI in use. For specific ITL limitations, see the “Limitations” section on page 23-2.

To diagnose and resolve ITL problems, follow these steps:

Step 1: Use the `show isapi dpp 4 queue` command to display DPP queue information.

Step 2: Verify that the number of ITLs on a DPP is within the limitations for the version of Cisco SAN-OS and SSI in use. Use the `show isapi dpp 4 queue incl LUN` and `show isapi dpp 4 queue count` commands.

Step 3: Verify that the number of ITLs on an SSM is within the limitations for the version of Cisco SAN-OS and SSI in use. Issue the `show isapi dpp all queue` command, using the `incl LUN` and `count` parameters.

Common Mismatch Problems

Problems are often caused by mismatching component versions, or using devices that are not supported by the interoperability matrix.

The following lists common mismatch situations:

<table>
<thead>
<tr>
<th>Table 23-3</th>
<th>Common SANTap Mismatch Problems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem</td>
<td>Description</td>
</tr>
<tr>
<td>Version mismatch between SSM and the RPA.</td>
<td>The version of SSM and the version of the replication appliance are not compatible.</td>
</tr>
<tr>
<td>Version mismatch between the Supervisor and the SSI image.</td>
<td>The version of the Sup and the SSI image are not compatible.</td>
</tr>
</tbody>
</table>
**Send documentation comments to mdsfeedback-doc@cisco.com**

Chapter 23  Troubleshooting SANTap

### Table 23-3  Common SANTap Mismatch Problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hosts, targets, HBAs or switches are not supported by the interoperability matrix.</td>
<td>Review the Cisco SANTap interoperability matrix at <a href="http://www.cisco.com/en/US/products/ps5989/products_device_support_tables_list.html">http://www.cisco.com/en/US/products/ps5989/products_device_support_tables_list.html</a>.</td>
</tr>
<tr>
<td>CVT is in the host VSAN.</td>
<td>The CVT is the portal through which the appliance communicates with SANTap, and cannot be in the host VSAN.</td>
</tr>
<tr>
<td>IVR and SANTap are being used together.</td>
<td>IVR and SANTap both perform straddling across VSANs and cannot be used together.</td>
</tr>
<tr>
<td>VIs in a DVT VSAN (CVT and DVT in the same VSAN).</td>
<td>This results in the creation of one CPP VI and eight DPP VIs in the DVT VSAN. The VIs attempt to login to DVT, resulting in non-deterministic behavior.</td>
</tr>
<tr>
<td>Overprovisioning, including:</td>
<td>When replication is enabled, AVT LUNs are created, and that can increase the ITL count over the limit. (See “Limitations” section on page 23-2.)</td>
</tr>
<tr>
<td>- Too many ITLs per SSM</td>
<td>If Reservation Support is not enabled on the RPA:</td>
</tr>
<tr>
<td>- Too many ITLs per DPP</td>
<td>- 26 AVT LUNs are created at a time.</td>
</tr>
<tr>
<td>- Too many ITLs per DPP</td>
<td>- The appliance completes recovery of these LUNs and then deletes them before creating more.</td>
</tr>
<tr>
<td></td>
<td>- This behavior does not significantly increase the ITL count.</td>
</tr>
<tr>
<td></td>
<td>If Reservation Support is enabled on the RPA:</td>
</tr>
<tr>
<td></td>
<td>- All AVT and AVT LUNs are permanently created.</td>
</tr>
<tr>
<td></td>
<td>- In RPA 2.3, only half the appliance posts are zoned with AVTs. This does not increase the ITL count significantly.</td>
</tr>
<tr>
<td></td>
<td>- In RPA 2.4, all appliance ports are zoned with AVTs. This behavior can increase the ITL count significantly.</td>
</tr>
<tr>
<td>Same pWWN occurs more than once in the same VSAN.</td>
<td>Misconfiguration can result in two DVTs (or two VIs) with the same WWN in the same VSAN.</td>
</tr>
<tr>
<td></td>
<td>For example, assume that two DVTs are created on different SSMs or on different DPPs. Both of these DVTs have the same back-end VSAN. When a host HBA logs into both DVTs, an attempt is made to create two VIs with the same WWN in the same back-end VSAN. This results in non-deterministic behavior.</td>
</tr>
</tbody>
</table>
### Table 23-3 Common SANTap Mismatch Problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A host is moved from the front-end VSAN to</td>
<td>There is a VI in the back-end VSAN with the same pWWN as the host. Before you can move the host:</td>
</tr>
<tr>
<td>the back-end VSAN.</td>
<td>• Shut the host port.</td>
</tr>
<tr>
<td></td>
<td>• Purge to remove VI from the back-end VSAN.</td>
</tr>
<tr>
<td></td>
<td>The host can now be safely moved.</td>
</tr>
<tr>
<td>Inaccurate zoning.</td>
<td>Zoning solutions differ, based on the Cisco SAN-OS and SSI versions in use.</td>
</tr>
<tr>
<td></td>
<td>• With SSI 3.0(2j), you must have default zoning in the back-end VSAN, or zone the target and VIs together in the back-end VSAN.</td>
</tr>
<tr>
<td></td>
<td>• With SSI 3.1(2), only the host VI and target need to be zoned together in the back-end VSAN.</td>
</tr>
<tr>
<td>Adding and removing hosts without performing a purge.</td>
<td>If you have 16 hosts and you remove one and add another, the new host will not see the LUNs. In this situation, perform a purge to clear one of the 16 entries after removing the host. Then you can add the new host to the DVT.</td>
</tr>
</tbody>
</table>
Troubleshooting Digital Certificates

This chapter describes how to troubleshoot digital certificates created and maintained in the Cisco MDS 9000 Family. It includes the following sections:

- Overview, page 24-1
- Initial Troubleshooting Checklist, page 24-3
- Digital Certificate Issues, page 24-4

Overview

Public Key Infrastructure (PKI) support provides the means for the Cisco MDS 9000 Family of switches to obtain and use digital certificates for secure communication in the network. PKI support provides manageability and scalability for IPsec/IKE and SSH.

Digital Certificates

Digital signatures, based on public key cryptography, digitally authenticate devices and individual users. In public key cryptography, each device or user has a key pair containing both a private key and a public key. Digital certificates link the digital signature to the remote device. A digital certificate contains information to identify a user or device, such as the name, serial number, company, department, or IP address. It also contains a copy of the entity’s public key. The certificate is itself signed by a certificate authority (CA), a third party that is explicitly trusted by the receiver to validate identities and to create digital certificates.

Certificate Authorities

The trust model used in PKI support is hierarchical with multiple configurable trusted CAs. Each participating entity is configured with a list of CAs to be trusted so that the peer’s certificate obtained during the security protocol exchanges can be verified, provided it has been issued by one of the locally trusted CAs. To accomplish this, the CA’s self signed root certificate (or certificate chain for a subordinate CA) is locally stored. The MDS switch can also enroll with a trusted CA (trust point CA) to obtain an identity certificate (for example, for IPsec/IKE).
Overview

RSA Key Pairs and Identity Certificates

You can generate one or more RSA key pairs and associate each RSA key pair with a trusted CA where the MDS switch intends to enroll to obtain an identity certificate. The MDS switch needs only one identity per CA, which consists of one key pair and one identity certificate per CA.

Peer Certificate Verification

The peer certificate verification process involves the following steps:

- Verifies that the peer certificate is issued by one of the locally trusted CAs.
- Verifies that the peer certificate is valid (not expired) with respect to current time.
- Verifies that the peer certificate is not yet revoked by the issuing CA.

CRLs and OCSP Support

Two methods are supported for verifying that the peer certificate has not been revoked: certificate revocation list (CRL) and Online Certificate Status Protocol (OCSP). The switch uses one or both of these methods to verify that the peer certificate has not been revoked.

CRLs are maintained by CAs to give information of prematurely revoked certificates, and the CRLs are published in a repository.

Cisco MDS SAN-OS allows the manual configuration of pre-downloaded CRLs for the trusted CAs, and then caches them in the switch bootflash (cert-store). During the verification of a peer certificate by IPsec or SSH, the issuing CA's CRL is consulted only if the CRL has already been cached locally and the revocation checking is configured to use CRL. Otherwise, CRL checking is not performed and the certificate is considered to be not revoked if no other revocation checking methods are configured.

OCSP facilitates online certificate revocation checking. You can specify an OCSP URL for each trusted CA.

Import and Export Support for Certificates and Associated Key Pairs

As part of the CA authentication and enrollment process, the CA certificate (or the entire chain in the case of a subordinate CA) and the identity certificates can be imported in standard PEM (base64) format.

The complete identity information in a trust point can be exported to a file in the password-protected PKCS#12 standard format. The information in a PKCS#12 file consists of the RSA key pair, the identity certificate, and the CA certificate (or chain).

PKI Enrollment Support

The PKI enrollment process for a switch involves the following steps:

1. Create a trust point and authenticate the CA to it.
2. Generate an RSA private and public key pair on the switch.
3. Associate the RSA key pair to the trust point.
4. Generate a certificate request in standard format and forward it to the CA.
Initial Troubleshooting Checklist

4. Might require manual intervention at the CA server by the CA administrator to approve the enrollment request when it is received by the CA.
5. Receive the issued certificate back from the CA, signed with the CA’s private key.
6. Write the certificate into a nonvolatile storage area on the switch (bootflash).

Cisco MDS SAN-OS supports certificate retrieval and enrollment using a manual cut-and-paste method. Cut-and-paste enrollment literally means you must cut and paste the certificate requests and resulting certificates between the switch (using a console, Telnet, or SSH connection) and the CA, as follows:
1. Create an enrollment certificate request, which is displayed in base64-encoded text form.
2. Cut and paste the encoded certificate request text in an e-mail message or in a web form and send it to the CA.
3. Receive the issued certificate (in base64-encoded text form) from the CA in an e-mail message or in a web browser download.
4. Cut and paste the issued certificate to the switch using the certificate import facility.

Maximum Limits

Table 24-1 lists the maximum limits for CAs and digital certificate parameters.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Maximum Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trust points declared on a switch</td>
<td>16</td>
</tr>
<tr>
<td>RSA key pairs generated on a switch</td>
<td>16</td>
</tr>
<tr>
<td>Identity certificates configured on a switch</td>
<td>16</td>
</tr>
<tr>
<td>Certificates in a CA certificate chain</td>
<td>10</td>
</tr>
<tr>
<td>Trust points authenticated to a specific CA</td>
<td>10</td>
</tr>
</tbody>
</table>

Initial Troubleshooting Checklist

Begin troubleshooting digital certificates issues by checking the following issues first:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that the fully qualified domain name (FQDN) has been configured on the switch.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that all the CA certificates in a CA chain for a trusted CA are added to the switch if the CA is not self-signed.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have installed your identity certificates.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have revoked your identity certificates if you delete the associated RSA key pairs.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

Choose Switches > Security > PKI to access digital certificates.
Common Troubleshooting Commands in the CLI

The following commands may be useful in troubleshooting digital certificate issues:

- `show crypto ca certificates`
- `show crypto key`
- `show crypto ca crl`
- `show crypto ca trustpoint`

Digital Certificate Issues

This section describes troubleshooting digital certificates and includes the following topics:

- CA Will Not Generate Identity Certificate, page 24-4
- Cannot Export Identity Certificate in PKCS#12 Format, page 24-5
- Certificate Fails at Peer, page 24-5
- PKI Fails After Reboot, page 24-10
- Cannot Import Certificate and RSA Key Pairs from Backup, page 24-10

CA Will Not Generate Identity Certificate

**Symptom**  CA will not generate an identity certificate.

**Table 24-2  CA Will Not Generate Identity Certificate**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA will not generate an identity certificate.</td>
<td>FQDN is not configured.</td>
<td>Configure the host name and the IP domain name. Choose <strong>Switches</strong> in Fabric Manager and set the LogicalName field to the host name. Choose <strong>Switches &gt; Interfaces &gt; Management &gt; DNS</strong> and set the DefaultDomainName field. Or use the <strong>hostname</strong> and the <strong>ip domain-name</strong> CLI commands.</td>
</tr>
<tr>
<td></td>
<td>Empty challenge password is specified.</td>
<td>Specify a non-empty challenge password during enrollment. Create exportable RSA keys. Choose <strong>Switches &gt; Security &gt; PKI</strong> in Fabric Manager and click the <strong>Trustpoint Action</strong> tab. Select <strong>certreq</strong> from the Command drop-down menu, fill in the URL field and enter the challenge password in the Password field. Click <strong>Apply Changes</strong>. Or use the <strong>crypto ca enroll</strong> CLI command and enter a challenge password during enrollment.</td>
</tr>
</tbody>
</table>
**Cannot Export Identity Certificate in PKCS#12 Format**

**Symptom** Cannot export identity certificate in PKCS#12 format.

<table>
<thead>
<tr>
<th>Table 24-3 Cannot Export Identity Certificate in PKCS#12 Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Cannot export identity certificate in PKCS#12 format.</td>
</tr>
</tbody>
</table>

**Certificate Fails at Peer**

**Symptom** Certificate fails at peer.

<table>
<thead>
<tr>
<th>Table 24-4 Certificate Fails at Peer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Certificate fails at peer.</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Configuring Certificates on the MDS Switch Using Fabric Manager**

To configure certificates on an MDS switch using Fabric Manager, follow these steps:

**Step 1** Choose Switches and set the LogicalName field to configure the switch host name.

**Step 2** Choose Switches > Interfaces > Management > DNS and set the DefaultDomainName field to configure the DNS domain name for the switch.

**Step 3** Follow these steps to create an RSA key pair for the switch:

a. Choose Switches > Security > PKI and select the RSA Key-Pair tab.
b. Click Create Row and set the name and size field.c. Check the Exportable check box and click Create.
Digital Certificate Issues

Step 4 Follow these steps to create a trust point and associate the RSA key pairs with it:

a. Choose Switches > Security > PKI and select the Trust Point tab.
b. Click Create Row and set the TrustPointName field.
c. Select the RSA key pairs from the KeyPairName drop-down menu.
d. Select the certificates revocation method from the RevokeCheckMethods drop-down menu.
e. Click Create.

Step 5 Choose Switches > Copy Configuration and click Apply Changes to copy the running-config to startup-config and save the trust point and key pair.

Step 6 Download the CA certificate from the CA that you want to add as the trustpoint CA.

Step 7 Follow these steps to authenticate the CA that you want to enroll to the trust point:

a. In Device Manager, choose Admin > Flash Files and select Copy and then select tftp from the Protocols radio button to copy the CA certificate to bootflash.
b. In Fabric Manager, choose Switches > Security > PKI and select the TrustPoint Actions tab.
c. Select cauth from the Command drop-down menu.
d. Click... in the URL field and select the CA certificate from bootflash.
e. Click Apply Changes to authenticate the CA that you want to enroll to the trust point.
f. Click the Trust Point Actions tab in the Information Pane.
g. Make a note of the CA certificate fingerprint displayed in the IssuerCert FingerPrint column for the trust point row in question. Compare the CA certificate fingerprint with the fingerprint already communicated by the CA (obtained from the CA web site). If the fingerprints match exactly, accept the CA by selecting the certconfirm trust point action. Otherwise, reject the CA by selecting the certnoconfirm trust point action.
h. If you selected certconfirm in step g, select the Trust Point Actions tab, select certconfirm from the Command drop-down menu and then click Apply Changes.
i. If you selected certnoconfirm in step g, select the Trust Point Actions tab, select certnoconfirm from the Command drop-down menu, and then click Apply Changes.

Step 8 Follow these steps to generate a certificate request for enrolling with that trust point:

a. Select the Trust Point Actions tab in the Information pane.
b. Select certreq from the Command drop-down menu. This generates a PKCS#10 certificate signing request (CSR) needed for an identity certificate from the CA corresponding to this trust point entry.
c. Enter the output file name for storing the generated certificate request. It should be specified in the bootflash:filename format and will be used to store the CSR generated in PEM format.
d. Enter the challenge password to be included in the CSR. The challenge password is not saved with the configuration. This password is required in the event that your certificate needs to be revoked, so you must remember this password.
e. Click Apply Changes to save the changes.

Step 9 Request an identity certificate from the CA.

Note The CA may require manual verification before issuing the identity certificate.
Step 10  Follow these steps to import the identity certificate:

a. In Device Manager, choose Admin > Flash Files and select Copy, then select tftp from the Protocol radio buttons to tftp copy the CA certificate to bootflash.

b. In Fabric Manager, choose Switches > Security > PKI and select the TrustPoint Actions tab.

c. Select the certimport option from the Command drop-down menu to import an identity certificate in this trust point.

Note  The identity certificate should be available in PEM format in a file in bootflash.

d. Enter the name of the certificate file that was copied to bootflash in the URL field in the bootflash:filename format.

e. Click Apply Changes to save your changes.

If successful, the values of the identity certificate and its related objects, like the certificate file name, are automatically updated with the appropriate values as per the corresponding attributes in the identity certificate.

Configuring Certificates on the MDS Switch Using the CLI

To configure certificates on an MDS switch using the CLI, follow these steps:

Step 1  Configure the switch FQDN.

```
switch# config t
Enter configuration commands, one per line. End with CNTL/Z.
switch(config)# switchname Vegas-1
Vegas-1(config)#
```

Step 2  Configure the DNS domain name for the switch.

```
Vegas-1(config)# ip domain-name cisco.com
Vegas-1(config)#
```

Step 3  Create a trust point.

```
Vegas-1(config)# crypto ca trustpoint myCA
Vegas-1(config-trustpoint)# exit
Vegas-1(config)# do show crypto ca trustpoints
trustpoint: myCA; key: revokation methods: crl
Vegas-1(config)#
```

Step 4  Create an RSA key pair for the switch.

```
Vegas-1(config)# crypto key generate rsa label myKey exportable modulus 1024
Vegas-1(config)# do show crypto key mypubkey rsa
key label: myKey
key size: 1024
exportable: yes
Vegas-1(config)#
```

Step 5  Associate the RSA key pair to the trust point.

```
Vegas-1(config)# crypto ca trustpoint myCA
```
**Digital Certificate Issues**

Send documentation comments to mdsfeedback-doc@cisco.com

Vegas-1(config-trustpoint)# rsakeypair myKey
Vegas-1(config-trustpoint)# exit
Vegas-1(config)# do show crypto ca trustpoints
trustpoint: myCA; key: myKey
revocation methods: crl
Vegas-1(config)#

**Step 6** Use the `copy running-config startup-config` command to save the trust point and key pair.

**Step 7** Download the CA certificate from the CA that you want to add as the trust point CA.

**Step 8** Authenticate the CA that you want to enroll to the trust point.

Vegas-1(config)# crypto ca authenticate myCA
input (cut & paste) CA certificate (chain) in PEM format; end the input with a line containing only END OF INPUT:

```plaintext
-----BEGIN CERTIFICATE-----
MIIC4jCCAgYAwIBAgIQBWDSiay0GZRPSRIjYK2OeO Accomplish the challenge password. You will need to verbally provide this password to the CA Administrator in order to revoke your certificate. For security reasons your password will not be saved in the configuration. Please make a note of it.
Password: nbv123
The subject name in the certificate will be:
Vegas-1.cisco.com

-----END CERTIFICATE-----
```

Do you accept this certificate? [yes/no]: y
Vegas-1(config)#

**Step 9** Generate a certificate request for enrolling with that trust point.

Vegas-1(config)# crypto ca enroll myCA
Create the certificate request...
Create a challenge password. You will need to verbally provide this password to the CA Administrator in order to revoke your certificate. For security reasons your password will not be saved in the configuration. Please make a note of it.
Password: nbv123

The subject name in the certificate will be: Vegas-1.cisco.com
Send documentation comments to mdsfeedback-doc@cisco.com

Include the switch serial number in the subject name? [yes/no]: no
Include an IP address in the subject name [yes/no]: yes
ip address: 172.22.31.162
The certificate request will be displayed...

-----BEGIN CERTIFICATE REQUEST-----
MIIBqzCCARQCAQAwHDEaMBgGA1UEAxMRVmYXctMS5jaXNjby5jb20wgw0gZw8wDQYJKzoJ
2PNJ8warz1r2s2Zg77En7y+PwMyWkgzi2bVjr+ragZVhGJ91Xtg4w0VkCzXvS8V
Q&YanEBaA6AGszGzgjkli9G9w0BQcxcCBMgEmz2MT1zMDYGQscG5S0r3bG
DjEpMcwwQYDVQR0AQH/BBswYIRVMvYXMs5jaXNjby5jb22HBKv0H61DQYJK
KoZiI9cMzE8bQdAYT06E96s8qy60DZXVHf3J28hZ6CtdZg99I1Fe
PtfrMcUE/pw6HayFQl2T3ecygNw21d1531YBF2bktExiU6188t0JxiXjja8
8a23ShDnpz98xrTaw6hwnrY3LVNUZEFJQxbyfjPmW7zcaC3US6eQle5bKytUk=-----END CERTIFICATE REQUEST-----

Vegas-1(config)#

Step 10
Request an identity certificate from the CA.

Note
The CA may require manual verification before issuing the identity certificate.

Step 11
Import the identity certificate.

Vegas-1(config)# crypto ca import myCA certificate
input (cut & paste) certificate in PEM format:

-----BEGIN CERTIFICATE-----
MIIEADCCA6qgAwIBAgIKCjOOoQAAAAAAdDANBgkqhkiG9w0BAQUFADCBkDEgMB4G
CSghGDBJEKDA8YH1bmrZUZaXnjby5jb20vC2A7BQVNBATYk1oMRwEAYD
VQ1BEwLYXKcQlRh02Ex0C6jAQcBqNBVAcTCUJhstdb9g2Y7EMsAvGAU1EChMQFjlz
Y28zEaARBGvNBsAc5n515dh05s3Jz2Rx6eAJqBvNVMBTMCifuYXduSBQDTeFw0v
NTExMTEwMzA5NDBmFwEzyNDNaMBowGjAgBqYyNBAMTEV112ZfLmTe
Y12lY8avy29wMIGfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQyQpBQ8zqj3pK84
rNfZL8PqZyZ76qZ6yTTRqBMjshvY2mMghxuymrZjy2A0Yhop5k7u6yXpV9EF
bhWmV1Y0j95MHiFbVgBNSbiEgQpc3y8aKaG6wjt7EVMx1sak1BBoLmLmLxOGW
p01J7Mn0q6WAwyK1c2C0z17neQAXKBBFhFbFbV86G15GSunVbT5cAlAUE
BBByMCwGEuJ4QBPBcFQbVNB4cc5Bb9FQYyTfESBAHAG1JERBDKcmPwZ2Fb3J1IQw4
DAYQVvKBEwLzXjo1h9MKA1UCxKhwB0c38rvmNzTESMHBHAl5nFQ4
hm51ZnBzAYKSFYh67rCQZ1i9WfM1R1666GwEAu3ldwRkdN1lVQaAOcCQEQ5h0mO6A
Ly9c29ut5DgRyv2DcVgvUe9cB6C9Fy4bXEml1NjBDQ55JcmwMDKauEcGkZpbGU6
Ly9cX9n2zQ0FX0KjZJKVSEy22xkXEFwVJlJyUFYyMENl8MzNBYDBCA1YKwYQQ
A0EE5f8hBnMDCgscAQQFBya2XCh9i96HRo1T8v3N17TA4O1L1CN1rFQh7vGbY8c3N1
L7A401FXWJc5YFU4MENl8MzNBYDA9BGdEbFQcwxOyXz1mzZ7oVLxnc3N17TA4
XEN1rFbnFjVbVxcnc3N17TA401FXWJlJyUFYyMENl8MzNBYDBCA1YKwYQQ
AANnADDB8gsbe7G7nLh9xe0TWEBnma24U61ZSudDDcOCCUU7qrpzTqVpPye7stfl
E36CIZ4u4wExEExrXqkbX8ycx7V5o=-----END CERTIFICATE-----

Vegas-1(config)#

Vegas-1(config)# do show crypto ca certificates
Trustpoint: myCA
subject: /CN=Vegas-1.cisco.com
issuers: /emailAddress=amandke@cisco.com/C=IN/ST=Karnataka/L=Bangalore/O=Cisco
=netstorage/CA=Aparna
serial=CA0334E1A000000000074
notBefore=Nov 12 03:02:40 2005 GMT
notAfter=Nov 12 03:12:40 2006 GMT
purposes: sslserver sslclient ike
PKI Fails After Reboot

**Symptom**  PKI fails after reboot.

**Table 24-5  PKI Fails After Reboot**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>PKI fails after a reboot.</td>
<td>Certificates not saved to NVRAM.</td>
<td>Save the running-config to startup- config to save the trust point to startup. Then reimport the certificates. See the “Configuring Certificates on the MDS Switch Using Fabric Manager” section on page 24-5 or the “Configuring Certificates on the MDS Switch Using the CLI” section on page 24-7.</td>
</tr>
</tbody>
</table>

Cannot Import Certificate and RSA Key Pairs from Backup

**Symptom**  Cannot import certificate and RSA key pairs from backup.

**Table 24-6  Cannot Import Certificate and RSA Key Pairs from Backup**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot import certificate and RSA key pairs from backup.</td>
<td>Configured trust point is not empty.</td>
<td>Delete the identity certificate, the CRL, and CA certificates, and then disassociate the RSA key pair from the trust point in that order. See the “Importing Certificate and RSA Key Pairs from Backup Using Fabric Manager” section on page 24-11 or the “Importing Certificate and RSA Key Pairs from Backup Using the CLI” section on page 24-11.</td>
</tr>
<tr>
<td>An RSA key pair exists with the same name as the trust point that the import failed for.</td>
<td>Delete the RSA key pair.</td>
<td>Choose <strong>Switches &gt; Security &gt; PKI</strong> in Fabric Manager. Right-click the RSA key pair that you want to delete and click <strong>Delete Row</strong>. Or use the no <strong>crypto key zeroize rsa</strong> CLI command</td>
</tr>
</tbody>
</table>
Chapter 24  Troubleshooting Digital Certificates

Digital Certificate Issues

Send documentation comments to mdsfeedback-doc@cisco.com

Importing Certificate and RSA Key Pairs from Backup Using Fabric Manager

To import certificates and RSA key pairs from a PKCS#12 backup file using Fabric Manager, follow these steps:

Step 1  Choose Switches > Security > PKI and select the TrustPointDetails tab to verify that the trust point is empty.

Step 2  Optionally, follow these steps to empty the trust point:

   a.  Choose Switches > Security > PKI and select the TrustPoint tab.
   b.  Delete the RSA key pair from the Key Pair Name field and click Apply Changes.
   c.  Choose Switches > Security > PKI and select the TrustPoint Actions tab.
   d.  Select cadelete from the Command drop-down menu and click Apply Changes to delete the CA certificate.
   e.  Select forcecertdelete from the Command drop-down menu and click Apply Changes to delete the identity certificates.

Step 3  In Device Manager, choose Admin > Flash Files and select Copy to copy the PKCS#12 format file to the switch bootflash.

Step 4  In Fabric Manager, choose Switches > Security > PKI and select the TrustPoint Actions tab.

Step 5  Select the pkcs12import option from the Command drop-down menu to import the key pair, identity certificate, and the CA certificate or certificate chain in PKCS#12 format to the selected trust point.

Step 6  Enter the input in bootflash:filename format, for the PKCS#12 file.

Step 7  Enter the required password. The password is set for decoding the PKCS#12 data. On completion, the imported data is available in bootflash in the specified file.

Step 8  Click Apply Changes to save the changes.

On completion the trust point is created in the RSA key pair table corresponding to the imported key pair. The certificate information is updated in the trust point.

Note  The trust point should be empty (no RSA key pair associated with it and no CA is associated with it using CA authentication) for the PKCS#12 import to succeed.

Importing Certificate and RSA Key Pairs from Backup Using the CLI

To import certificates and RSA key pairs from a PKCS#12 backup file using the CLI, follow these steps:

Step 1  Use the show crypto ca trustpoints command to verify that the trust point is empty.

Step 2  Optionally, use the delete ca-certificate command in trust point config submode to remove the CA certificate from the trust point.

switch(config)# crypto ca trustpoint myCA
switch(config-trustpoint)# delete ca-certificate
Digital Certificate Issues

**Step 3** Optionally, use the `delete certificate force` command in trust point config submode to remove the certificates from the trust point.

```
switch(config)# crypto ca trustpoint myCA
switch(config-trustpoint)# delete certificate force
```

**Step 4** Optionally, use the `no rsakeypair` command in the trust point config submode to remove the RSA key pairs from the trust point.

```
switch(config)# crypto ca trustpoint myCA
switch(config-trustpoint)# no rsakeypair SwitchA
```

**Step 5** Use the `copy tftp` command to copy the PKCS#12 format file to the switch.

```
switch# copy tftp:adminid.p12 bootflash:adminid.p12
```

**Step 6** Use the `crypto ca import` command to import the certificates and RSA key pairs to the trust point.

```
switch(config)# crypto ca import admin-ca pkcs12 bootflash:adminid.p12 nbv123
```
Troubleshooting Call Home

This chapter describes how to troubleshoot the Call Home feature in the Cisco MDS 9000 Family. It includes the following sections:

- **Overview, page 25-1**
- **Initial Troubleshooting Checklist, page 25-3**
- **Call Home Issues, page 25-4**

**Overview**

The Call Home functionality is available directly through the Cisco MDS 9000 Family. It provides multiple Call Home profiles (also referred to as *Call Home destination profiles*), each with separate potential destinations. You can define your own destination profiles in addition to using the predefined profiles.

The Call Home function can also leverage support from Cisco Systems or another support partner. Flexible message delivery and format options make it easy to integrate specific support requirements.

For those who have service contracts directly with Cisco Systems, automatic case generation with the Technical Assistance Center is possible by registering with the AutoNotify service. AutoNotify provides fast time to resolution of system problems by providing a direct notification path to Cisco customer support.

The AutoNotify feature requires you to configure several Call Home parameters including certain contact information, e-mail server, and an XML destination profile as specified in the Service Activation document found on the Cisco.com website at:


*Note*  
A cisco.com password is required for this website.

**Destination Profiles**

A destination profile contains the required delivery information for an alert notification. Destination profiles are typically configured by the network administrator. At least one destination profile is required. You can configure multiple destination profiles of one or more types.
You can use one of the predefined destination profiles or define a desired profile. If you define a new profile, you must assign a profile name.

### Alert Groups

An alert group is a predefined subset of Call Home alerts supported in all switches in the Cisco MDS 9000 Family. Different types of Call Home alerts are grouped into different alert groups depending on their type. You can associate one or more alert groups to each profile as required by your network.

The alert group feature allows you to select the set of Call Home alerts to be received by a destination profile (either predefined or user-defined).

You can associate a destination profile with multiple alert groups.

**Note**

A Call Home alert is sent to e-mail destinations in a destination profile only if that Call Home alert belongs to one of the alert groups associated with that destination profile.

### Customized Alert Group Messages

The predefined Call Home alert groups generate notification messages when certain events occur on the switch. You can customize predefined alert groups to execute additional valid `show` commands when specific events occur. The output from these additional `show` commands is included in the notification message along with that of the predefined `show` commands.

**Note**

You can assign a maximum of five user-defined `show` commands to an alert group. Only `show` commands can be assigned to an alert group.

**Note**

Customized `show` commands are supported for full text and XML alert groups only. Short text alert groups (short-txt-destination) do not support customized `show` commands because they only allow 128 bytes of text.

### Call Home Message Level Feature

The Call Home message level feature allows you to filter messages based on their level of urgency. Each destination profile (predefined and user-defined) is associated with a Call Home message level threshold. Any message with a value lower that the urgency threshold is not sent. The urgency level ranges from 0 (lowest level of urgency) to 9 (highest level of urgency), and the default is 0 (all messages are sent).

**Note**

Call Home does not change the syslog message level in the message text. The syslog message texts in the Call Home log appear as they are described in the *Cisco MDS 9000 Family System Messages Guide*. 

Table 25-1 shows the Call Home message level and how it relates to syslog message levels.
Initial Troubleshooting Checklist

Begin troubleshooting Call Home issues by checking the following issues first:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Check off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that you have configured the contact name, phone, and street address on the switch.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the switch has IP connectivity to your e-mail server.</td>
<td>☐</td>
</tr>
<tr>
<td>If Cisco AutoNotify is used, verify that you have an active service contract that covers the device being configured.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have configured at least one destination profile on the switch.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

Choose Switches > Events > Call Home to verify the Call Home configuration.

Common Troubleshooting Tools in Device Manager

You can test the Call Home alert messages. Choose Admin > Events > Call Home > Alerts > Test.

Common Troubleshooting Commands in the CLI

The following commands may be useful in troubleshooting Call Home issues:

- show callhome
- show callhome user-def-cmds
- callhome test
Call Home Issues

This section describes troubleshooting Call Home and includes the following topics:

- Not Receiving Call Home Alerts, page 25-4
- Not Receiving Call Home Alerts From All Configured Switches, page 25-6
- Receiving Too Many Call Home Alerts, page 25-8
- Not Receiving Syslog-based Call Home Alerts, page 25-8
- Periodic Inventory Notification Does Not Reflect Current Inventory, page 25-9

Not Receiving Call Home Alerts

Symptom: Not receiving Call Home alerts.

Table 25-2 Not Receiving Call Home Alerts

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not receiving Call Home alerts.</td>
<td>The alert is in an alert group that is not configured for the destination profile.</td>
<td>Add the alert group to the destination profile. See the “Configuring an Alert Group Using Fabric Manager” section on page 25-4 or the “Configuring an Alert Group Using the CLI” section on page 25-5.</td>
</tr>
<tr>
<td></td>
<td>The message level is not set correctly in the destination profile.</td>
<td>Set the message level. See the “Configuring the Message Level for a Destination Profile Using Fabric Manager” section on page 25-5 or the “Configuring the Message Level for a Destination Profile Using the CLI” section on page 25-5.</td>
</tr>
<tr>
<td>No e-mail server is configured.</td>
<td></td>
<td>Configure an e-mail server for Call Home. See the “Configuring an E-mail Server for Call Home Using Fabric Manager” section on page 25-6 or the “Configuring an E-mail Server for Call Home Using the CLI” section on page 25-6.</td>
</tr>
<tr>
<td>Firewall is blocking SMTP messages.</td>
<td></td>
<td>Verify that any firewall in the network path is configured to allow the SMTP server port number you configured. (The default is 25.)</td>
</tr>
</tbody>
</table>

Configuring an Alert Group Using Fabric Manager

To associate an alert group with a destination profile, follow these steps:

Step 1 Choose Switches > Events > Call Home in the Physical Attributes pane then click the Profiles tab in the Information pane.

Step 2 Click the Alert Groups column in the row for the profile you want to associate.

Step 3 Click an alert group to select it for association.

You see a check next to that alert group. To deselect it and remove the check, click it again.
Chapter 25  Troubleshooting Call Home

Configuring an Alert Group Using the CLI

To configure alert groups for a destination profile, follow these steps:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1         switch# config t</td>
<td>Enters configuration mode.</td>
</tr>
<tr>
<td>Step 2         switch(config)# callhome</td>
<td>Enters Call Home configuration submode.</td>
</tr>
<tr>
<td>Step 3         switch(config-callhome)# destination-profile</td>
<td>Configures user-defined destination message profile (test1) to receive Call Home notifications</td>
</tr>
<tr>
<td>test1 alert-group environmental</td>
<td>for power, fan, and temperature-related events.</td>
</tr>
<tr>
<td>switch(config-callhome)# destination-profile</td>
<td>Optional. Configures predefined short-text destination message profile to receive Call</td>
</tr>
<tr>
<td>short-txt-destination alert-group environmental</td>
<td>Home notifications for power, fan, and temperature-related events.</td>
</tr>
</tbody>
</table>

Configuring the Message Level for a Destination Profile Using Fabric Manager

To set the message level for each profile for Call Home, follow these steps:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose Switches &gt; Events &gt; Call Home and click the Profiles tab in the Information pane.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Set a message level for each switch using the drop-down menu in the MsgLevel column.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Apply Changes to save your changes or click Undo Changes to cancel your changes.</td>
</tr>
</tbody>
</table>

Configuring the Message Level for a Destination Profile Using the CLI

To configure message level settings for destination profiles, follow these steps:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1         switch# config t</td>
<td>Enters configuration mode.</td>
</tr>
<tr>
<td>Step 2         switch(config)# callhome</td>
<td>Enters Call Home configuration submode.</td>
</tr>
<tr>
<td>Step 3         switch(config-callhome)# destination-profile</td>
<td>Optional. Configures the message level urgency as 5 and above for the user-defined profile</td>
</tr>
<tr>
<td>test message-level 5</td>
<td>(test1).</td>
</tr>
<tr>
<td>switch(config-callhome)# no destination-profile</td>
<td>Removes a previously configured urgency level and reverts it to the default of 0 (all messages are</td>
</tr>
<tr>
<td>oldtest message-level 7</td>
<td>sent).</td>
</tr>
</tbody>
</table>
Configuring an E-mail Server for Call Home Using Fabric Manager

To configure general e-mail options and the SMTP server and port, follow these steps:

1. Select a switch in the Fabric pane.
2. Choose **Switches > Events > Call Home** in the Physical Attributes pane and click the **Email Setup** tab in the Information pane.
3. Select a switch in the Information pane.
4. Enter the general e-mail information.
5. Enter the SMTP server IP address type, IP address or name, and port.
6. Click **Apply Changes** to update the e-mail options.

Configuring an E-mail Server for Call Home Using the CLI

To configure the SMTP server and port, follow these steps:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>switch# config t</td>
<td>Enters configuration mode.</td>
</tr>
<tr>
<td>switch(config)# callhome</td>
<td>Enters Call Home configuration submode.</td>
</tr>
<tr>
<td>switch(config-callhome)# transport email smtp-server 192.168.1.1</td>
<td>Configures the DNS, IPv4 address, or IPv6 address of the SMTP server to reach the server. The port usage defaults to 25 if no port is specified.</td>
</tr>
<tr>
<td>switch(config-callhome)# transport email smtp-server 192.168.1.1 port 30</td>
<td>Note: The port number is optional and, if required, may be changed depending on the server location.</td>
</tr>
</tbody>
</table>

Not Receiving Call Home Alerts From All Configured Switches

**Symptom** Not receiving Call Home alerts from all configured switches.

**Table 25-3 Not Receiving Call Home Alerts From All Configured Switches**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not receiving Call Home alerts from all configured switches</td>
<td>CFS distribution used, but local Call Home contact is not configured.</td>
<td>Configure the Call Home contact locally on each switch. See the “Configuring Call Home Contact Information Using Fabric Manager” section on page 25-7 or the “Configuring Call Home Contact Information Using the CLI” section on page 25-7.</td>
</tr>
</tbody>
</table>
Configuring Call Home Contact Information Using Fabric Manager

To assign the contact information, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose <strong>Switches &gt; Events &gt; Call Home</strong> in the Physical Attributes pane.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the <strong>General</strong> tab and then assign contact information. You must enter an e-mail address that identifies the source of Call Home notifications.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click <strong>Apply Changes</strong>.</td>
</tr>
</tbody>
</table>

Configuring Call Home Contact Information Using the CLI

To assign the contact information, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>switch# config t</td>
<td>Enters configuration mode.</td>
</tr>
<tr>
<td>Step 2</td>
<td>switch# snmp-server contact <a href="mailto:personname@companyname.com">personname@companyname.com</a></td>
<td>Configures the SNMP contact name.</td>
</tr>
<tr>
<td>Step 3</td>
<td>switch(config)# callhome</td>
<td>Enters the Call Home configuration submode.</td>
</tr>
<tr>
<td>Step 4</td>
<td>switch(config-callhome)# email-contact <a href="mailto:username@company.com">username@company.com</a></td>
<td>Assigns the customer’s e-mail address. Up to 128 alphanumeric characters are accepted in e-mail address format.</td>
</tr>
</tbody>
</table>

**Note**
- You can use any valid e-mail address.
- You cannot use spaces.
Receiving Too Many Call Home Alerts

Symptom: Receiving too many Call Home alerts.

Table 25-4 Receiving Too Many Call Home Alerts

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving too many Call Home alerts</td>
<td>Too many alert groups are configured for the destination profile.</td>
<td>Remove unneeded alert groups from the destination profile or separate into independent destination profiles. See the “Configuring an Alert Group Using Fabric Manager” section on page 25-4 or the “Configuring an Alert Group Using the CLI” section on page 25-5.</td>
</tr>
<tr>
<td></td>
<td>The message level is not set correctly in the destination profile.</td>
<td>Reset the message level to allow only the more important messages. See the “Configuring the Message Level for a Destination Profile Using Fabric Manager” section on page 25-5 or the “Configuring the Message Level for a Destination Profile Using the CLI” section on page 25-5.</td>
</tr>
<tr>
<td></td>
<td>Message throttling is disabled.</td>
<td>Enable Call Home message throttling. Choose <strong>Switches &gt; Events &gt; Call Home</strong> in Fabric Manager, click the <strong>General</strong> tab, check the <strong>Duplicate Message Throttle</strong> check box, and then click <strong>Apply Changes</strong>. Or use the <strong>duplicate-message throttle</strong> CLI command.</td>
</tr>
</tbody>
</table>

Not Receiving Syslog-based Call Home Alerts

Symptom: Not receiving syslog-based Call Home alerts.

Table 25-5 Not Receiving Syslog-based Call Home Alerts

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not receiving syslog-based Call Home alerts</td>
<td>The syslog- group-port alert group is not configured for the destination profile.</td>
<td>Add the alert group to the destination profile. See the “Configuring an Alert Group Using Fabric Manager” section on page 25-4 or the “Configuring an Alert Group Using the CLI” section on page 25-5.</td>
</tr>
<tr>
<td></td>
<td>The message level is not set correctly in the destination profile.</td>
<td>Set the message level. See Table 25-1 for the relationship between syslog message levels and Call Home message levels. See the “Configuring the Message Level for a Destination Profile Using Fabric Manager” section on page 25-5 or the “Configuring the Message Level for a Destination Profile Using the CLI” section on page 25-5. Verify the syslog message level configured on the switch. Choose <strong>Switches &gt; Events &gt;Syslog</strong> in Fabric Manager and click the <strong>Severity Level</strong> tab. Or use the <strong>show logging level</strong> CLI command.</td>
</tr>
</tbody>
</table>
## Periodic Inventory Notification Does Not Reflect Current Inventory

**Symptom**  Periodic inventory notification does not reflect the current inventory.

### Table 25-6  Periodic Inventory Notification Does Not Reflect Current Inventory

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Periodic inventory notification does not reflect the current inventory</td>
<td>Inventory change occurred after the last system reboot.</td>
<td>The periodic inventory for Call Home is updated when the switch restarts. Initiate a nondisruptive reboot to update inventory notification.</td>
</tr>
</tbody>
</table>
This chapter contains some common issues you may experience while using Cisco Fabric Manager, and provides solutions.

This chapter contains the following sections:

- **Overview**, page 26-1
- **Guidelines**, page 26-2
- **Initial Troubleshooting Checklist**, page 26-2
- **Troubleshooting Fabric Manager Issues**, page 26-2
- **Tips for Using Fabric Manager**, page 26-4
- **Troubleshooting Fabric Manager Web Client**, page 26-7
- **Troubleshooting Performance Manager**, page 26-12
- **Troubleshooting Device Manager**, page 26-13

## Overview

Cisco Fabric Manager is a Java and SNMP-based network fabric and device management tool with a GUI that displays real-time views of your network fabric, including Cisco MDS 9000 and third-party switches, hosts, and storage devices.

In addition to complete configuration and status monitoring capabilities for Cisco MDS 9000 switches, Fabric Manager provides powerful Fibre Channel troubleshooting tools. These in-depth health and configuration analysis tools leverage unique MDS 9000 switch capabilities including Fibre Channel ping and traceroute.

---

**Note**

You must have the same release of Fabric Manager Client and Fabric Manager Server.
Guidelines

Consider the following guidelines when using Fabric Manager:

- Use SNMPv3 with authentication and privacy enabled for encrypted network management traffic.
- If you are running SAN-OS 3.1(3) or earlier, use the Accelerate Discovery check box when starting Fabric Manager.
- Log into Fabric Manager with a user that has network-admin or network-operator privileges to have a full view of your fabric.
- Do not use One Time Passwords with Fabric Manager.

Initial Troubleshooting Checklist

Begin troubleshooting Fabric Manager issues by checking the following issues first:

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Checkoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify licensing requirements. See Cisco MDS 9000 Family Fabric Manager Configuration Guide.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have a compatible version of Java installed. Refer to the release notes for the software version you installed to obtain the correct Java version.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that the necessary ports are open in your firewall if Fabric Manager Server is installed behind a firewall. Refer to the Cisco MDS 9000 Family Fabric Manager Configuration Guide for details on running Fabric Manager behind a firewall.</td>
<td>☐</td>
</tr>
<tr>
<td>Verify that you have installed the same version of Fabric Manager Client, Fabric Manager Server, and Fabric Manager Web Client.</td>
<td>☐</td>
</tr>
<tr>
<td>Open a browser window and put in your switch address in as the URL. Check the issues presented in the FAQ link.</td>
<td>☐</td>
</tr>
</tbody>
</table>

Common Troubleshooting Tools in Fabric Manager

Choose Admin on Fabric Manager or Fabric Manager Web Client to access Fabric Manager Server configuration options. See also the “Troubleshooting a Nondisruptive Upgrade on a Fabric Switch” section on page 2-4.

Troubleshooting Fabric Manager Issues

This section covers the following topics:

- Cannot Log Into Fabric Manager, page 26-3
- Cannot Upgrade Fabric Manager, page 26-3
- The Map Shows Two Switches Where Only One Switch Exists, page 26-3
- Old Devices Appear on the Map, page 26-3
- Red Line Through the Switch, page 26-4
Cannot Log Into Fabric Manager

Fabric Manager uses the SNMP user name/password combination to communicate with the switch. The SNMP user name is automatically synchronized with the CLI user names configured. If you use the administrator password recovery procedure, you must manually reset the administrative password on the switch to resynchronize the SNMP and CLI user name and password. See the “Recovering the Administrator Password” section on page 2-32.

Cannot Upgrade Fabric Manager

If you attempt to upgrade Fabric Manager by pointing your web browser at a switch running Cisco SAN-OS 3.0(1) through SAN-OS 3.1(3), you may encounter an issue where the upgrade does not complete. You should open the Java Web Start application on your desktop and disable HTTP proxy. If you are using Microsoft Windows, open Java Web Start and choose File > Preferences to access the HTTP proxy settings.

The Map Shows Two Switches Where Only One Switch Exists

If two switches show on your map, but you only have one switch, it may be that you have two switches in a non-contiguous VSAN with the same domain ID. The Fabric Manager uses the VSAN ID and domain ID to look up a switch, and this can cause the fabric discovery to assign links incorrectly between these errant switches.

The workaround is to verify that all switches use unique domain IDs within the same VSAN in a physically connected fabric. (The fabric configuration checker will do this task.)

Old Devices Appear on the Map

If you are running a SAN-OS 3.1(3) or earlier, and if old devices appear on your fabric map, it may be that you made changes to the fabric topology, such as changing a switch IP address or removing a device, but launched Fabric Manager with the Accelerate Discovery check box checked.

The workaround is to log out and then log back in without checking the Accelerate Discovery check box.
Red Line Through the Switch

If a red line shows through your switch, this means the Fabric Manager sees something wrong with the switch. Check the Switch->Inventory report. A module, fan, or power supply has failed or is offline and plugged in.

Dotted Orange Line Through the Switch

If a dotted orange line shows through your switch, this indicates a minor status warning for that switch. Usually it means an issue with one of the modules. The tooltip should display exactly what is wrong. Hold the mouse over the switch to see the tooltip.

Fabric Manager Not Receiving Traps

You can set SNMP traps to test a call home application without risking adverse impact to your production SAN. Traps for temperature, fans, and power supply monitoring are then received by Fabric Manager. If Fabric Manager is not receiving traps, verify that your switch is sending traps by using the following CLI commands:

- `test pfm test-SNMP-trap fan`
- `test pfm test-SNMP-trap powersupply`
- `test pfm test-SNMP-trap temp-sensor`

Tips for Using Fabric Manager

This section covers the following topics:

- Setting the Map Layout So It Stays After Restarting the Fabric Manager, page 26-4
- Fabric Manager Upgrade Without Losing Map Settings, page 26-5
- Restrictions When Using Fabric Manager Across FCIP, page 26-5
- Running Cisco Fabric Manager with Network Multiple Interfaces, page 26-5
- Configuring a Proxy Server, page 26-6
- Clearing Topology Maps, page 26-6
- Using Fabric Manager in a Mixed Software Environment, page 26-7

Setting the Map Layout So It Stays After Restarting the Fabric Manager

If you have configured the map layout and would like to “freeze” the map so that the objects stay as they are even after you stop Fabric Manager and restart it again, do the following:

**Step 1** Right-click on a blank space in the map. You see a pop-up menu.

**Step 2** Select Layout -> Fix All Nodes from the menu.
Fabric Manager Upgrade Without Losing Map Settings

When you upgrade from one version of Fabric Manager to another, there is a way to prevent the loss of map settings (enclosure names, placement on the map, etc.)

The MDS 9000/db directory and subfolders contain files for all the discovered fabrics (*.dat) and maps (*.map). These are upgradable between versions. If you need to clear the fabric cache, you should first export the enclosures to a file to avoid losing them. Everything else aside from enclosures and map coordinates are stored on the switch. The preferences, last opened, and site_ouis.txt format does not change from release to release.

Restrictions When Using Fabric Manager Across FCIP

Fabric Manager will work without any restrictions across an FCIP tunnel as long as the tunnel is up. However, Fabric Manager cannot automatically discover a Cisco SN5428 mgmt 0 IP address in the fabric. For that switch, it will display a red slash through an FCIP device because of a timeout error. It will still see all targets, initiators, and ISLs attached to a Cisco SN5428 (or any other switch) as long as they appear in the name server or FSPF.

To work around this, you can manually enter the IP address in the Switches table, and click Apply. If the community string is correct, the red slash will go away. Even if the community string is incorrect, double-clicking on the Cisco SN5428 will launch the web tool.

Running Cisco Fabric Manager with Network Multiple Interfaces

If your PC has multiple network interfaces (NICs), the Cisco Fabric Manager applications detect these interfaces automatically (ignoring loopback interfaces). Fabric Manager client and Device Manager detect all interfaces on your PC each time you launch them, and allow you to select one. Fabric Manager Server detects on initial install, and allows you to select one. You are not prompted again to choose an interface with these two applications.

There may be circumstances where you will want to change the interface you are using. For example:

- If you add an interface after you have installed Fabric Manager Server
- If you decide to use a different interface than the one you initially selected
- If for any reason one of the Cisco Fabric Manager applications did not detect multiple interfaces

See the following sections, depending on which application you want to recognize the interface.

- Specifying an Interface for Fabric Manager Server, page 26-5
- Specifying an Interface for Fabric Manager Client or Device Manager, page 26-6

Specifying an Interface for Fabric Manager Server

To specify an interface for Fabric Manager Server, follow these steps:

**Step 1**
Go to the MDS 9000 folder.

**Step 2**
Edit the server.properties file with a text editor.

**Step 3**
Scroll until you find the line `snmp.localaddress`.

**Step 4**
If the line is commented, remove the comment character.
Tips for Using Fabric Manager

To specify an interface for the Fabric Manager Client or Device Manager, follow these steps:

Step 1 Go to the MDS 9000/bin folder.
Step 2 Edit the DeviceManager.bat file or the FabricManager.bat file.
Step 3 Scroll to the line that begins with `set JVMARGS=.
Step 4 Add the parameter `-Device Managerds.nmsaddress=ADDRESS`, where ADDRESS is the IP address or interface name of the NIC you want to use.
Step 5 Save the file and relaunch Fabric Manager Client or Device Manager.

Clearing Topology Maps

If you have a switch that you have removed from the fabric, there will be a red X through the switch’s icon. You can clear this information from the Fabric Manager client, or from the Fabric Manager server (which will clear the information for all clients) without having to reboot the switch.

To clear information from topology maps, follow these steps:

Step 1 Click on the Refresh Map icon in the Fabric pane.
Step 2 From the Server menu, click Purge Down Elements.
This clears the information from the server.

**Note** Any devices not currently accessible (may be offline) are purged.

### Using Fabric Manager in a Mixed Software Environment

You can use Fabric Manager version 2.x to manage a mixed fabric of Cisco MDS 9000 Family switches. Certain 2.x feature tabs will be disabled for any switches running a software version that does not support those features.

### Troubleshooting Fabric Manager Web Client

Using Fabric Manager Web Client, you can monitor MDS switch events, performance, and inventory, and perform minor administrative tasks. Fabric Manager Web Client provides summary and drill down performance reports. These reports are only available if you create a collection using Performance Manager and start the collector.

This section includes the following topics:

- Cannot Access Fabric Manager Web Client, page 26-8
- Cannot Launch Fabric Manager Web Client, page 26-9
- Cannot Log Into Fabric Manager Web Client, page 26-11

**Note** You must log in with a network-access role to access the Admin tab in Fabric Manager Web Client.

### Cannot Download Fabric Manager Web Client

**Symptom** Cannot download Fabric Manager Web Client.

**Table 26-1 Cannot Access Fabric Manager Web Client**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot download Fabric Manager Web Client.</td>
<td>To download Fabric Manager Web Client, you must have network-admin role.</td>
<td>A network-admin can allow a network-oper to download the client. See the “Allowing network-open Users to Download Fabric Manager Web Client” section on page 26-8.</td>
</tr>
<tr>
<td></td>
<td>Java cache may contain damaged or incorrect files.</td>
<td>Empty Java cache and restart the download. See “Clearing Java Cache” section on page 26-8.</td>
</tr>
</tbody>
</table>
Allowing network-open Users to Download Fabric Manager Web Client

The Fabric Manager Server properties file (MDS 9000\server.properties) contains a list of properties that determine how the Fabric Manager Server will function. You can edit this file with a text editor, or you can set the properties through the Fabric Manager Web Services GUI, under the Admin tab.

A network-admin can modify the server.properties file to allow users with network-oper role to download the Fabric Manager Web Client by following these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Open the server.properties file in the Fabric Manager installation directory. On a Windows platform, this file is in C:\Program Files\Cisco Systems\MDS 9000 by default.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Set web.allowDownload4All=true. By default, this property is not set.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Save and exit the file.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Restart Fabric Manager.</td>
</tr>
</tbody>
</table>

Clearing Java Cache

If you encounter problems downloading Fabric Manager Web Client, the Java cache may contain damaged files or old versions of software. To correct this problem, clear Java cache.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Navigate to Control Panel &gt; Java, and double-click Java to open the Java Control Panel.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click View under Temporary Internet Files region to open the Java Cache Viewer.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Show application and applets, by selecting the appropriate item from the Show drop-down list.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the appropriate applications and applets and click the delete icon, or right-click and choose Remove Application from the shortcut menu.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Close.</td>
</tr>
</tbody>
</table>

Cannot Access Fabric Manager Web Client

Symptom: Cannot access Fabric Manager Web Client.

Table 26-2 Cannot Access Fabric Manager Web Client

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot access Fabric Manager Web Client</td>
<td>Using wrong TCP port.</td>
<td>Verify TCP port where Fabric Manager Web Client was installed. See the “Verifying TCP port for Fabric Manager Web Client” section on page 26-9.</td>
</tr>
<tr>
<td>TCP port blocked by firewall.</td>
<td>Open TCP port in your firewall. For more information on running Fabric Manager behind a firewall, see the Cisco MDS 9000 Family Fabric Manager Configuration Guide.</td>
<td></td>
</tr>
</tbody>
</table>
Verifying TCP port for Fabric Manager Web Client

To verify the TCP port used by Fabric Manager Web Client, view \tomcat\conf\server.xml from the directory where you installed Fabric Manager Web Client. You see the following lines after some copyright information:

```xml
<Connector className="org.apache.catalina.connector.http.HttpConnector"
    port="80" minProcessors="5" maxProcessors="75"
    enableLookups="false" redirectPort="8443"
    acceptCount="10" debug="0" connectionTimeout="60000"/>
</Connector>
```

Look for the Connector setting that is not commented out (that is, not preceded by <!---), and search for the port setting. This is the TCP port number used by Fabric Manager Web Client. You can edit this file if you need to change the TCP port number in use or if you need to use SSL.

## Cannot Launch Fabric Manager Web Client

### Symptom
Cannot successfully launch Fabric Manager Web Client.

### Table 26-3 Cannot Launch Fabric Manager Web Client

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Web Start not detected error message displays.</td>
<td>Appropriate version of Java may not be installed.</td>
<td>Install the appropriate version of the Java Runtime Environment. Cisco recommends Java version 1.5 or above, which includes Java Web Start. Refer to the installation instructions in the Cisco MDS 9000 Family Fabric Manager Configuration Guide, or the Release Notes for your specific Fabric Manager release.</td>
</tr>
<tr>
<td>The Java Runtime console may be disabled.</td>
<td></td>
<td>Enable the Java Runtime console. See “Enabling the Java Runtime Console” section on page 26-10.</td>
</tr>
<tr>
<td>Internet Explorer 7 blocks the Java Web Start ActiveX control.</td>
<td></td>
<td>Allow the browser to run the Java Web Start ActiveX control. See “Allowing the Java Web Start ActiveX Control to Run” section on page 26-10.</td>
</tr>
<tr>
<td>Cannot connect to a remote Fabric Manager server.</td>
<td>Internet Explorer 7 may block the pop-ups that are required to complete the connection.</td>
<td>Add the web site to your trusted sites list, and allow it to open pop-ups, including script-generated input dialog boxes. See “Trusting the Remote Fabric Manager Web Site” section on page 26-10.</td>
</tr>
</tbody>
</table>
Enabling the Java Runtime Console

If you are running the Microsoft Internet Explorer 7 browser, the Java Runtime console may be disabled by default.

To enable the Java Runtime console, follow these steps:

Step 1  Choose **Tools > Manage Add-ons > Enable or Disable Add-ons.**
You see the Manage Add-ons dialog box.

Step 2  Select the Java Runtime Console and then click the **Enable** radio button in the Settings area.

Step 3  Click **OK.**

Allowing the Java Web Start ActiveX Control to Run

If you are using Internet Explorer 7, you may be prompted to take action to allow the Java Web Start ActiveX control to run.

When you launch the Fabric Manager Web Client, a message appears on the browser information bar, indicating that the web site wants to run the Java Web Start ActiveX Control from Sun Microsystems.

To allow the web site to run the Java Web Start ActiveX control and launch the Fabric Manager Web Client, follow these steps:

Step 1  Click the **here** link on the Internet Explorer information bar.

Step 2  Select **Run ActiveX Control** from the choices shown.

Trust the Remote Fabric Manager Web Site

If you are launching the Fabric Manager Web Client and connecting to a remote Fabric Manager Server using Internet Explorer 7, pop-up dialog boxes may be disabled by default.

To allow the script-generated input dialog boxes required to connect to the Fabric Manager Server to appear, follow these steps:

Step 1  In the Internet Explorer 7 browser, choose **Tools > Internet Options.**
You see the Internet Options dialog box.

Step 2  Click the **Security** tab and then click the **Trusted sites** zone.

Step 3  Click **Sites.** You see the Trusted Sites dialog box.

Step 4  Enter the URL of the specific site that you want to trust in the Add this site to the zone field. If you are already viewing the web site that you want to trust, the URL will be shown automatically.

**Note**  If the web site is not encrypted with SSL, clear the **Require server verification (https:) for all sites in this zone** check box.

Step 5  Click **Add.** The URL or IP address appears in the Websites list.
Chapter 26  Troubleshooting Fabric Manager

Troubleshooting Fabric Manager Web Client

Send documentation comments to mdsfeedback-doc@cisco.com

Step 6  Click OK, and then click OK on the Security tab to exit.

Clearing Java Web Start Cache

To clear the Java Web Start cache, follow these steps:

Step 1  Start the Java Web Start Application Manager (javaws.exe or javaws).

Step 2  Go to File > Preferences > Advanced and clear the applications folder or cache. You can manually delete the .javaws or cache directory. On Windows, this directory is under Documents and Settings, and on UNIX, this directory is under $HOME.

Cannot Log Into Fabric Manager Web Client

Symptom  Cannot log into Fabric Manager Web Client.

Table 26-4  Cannot Access Fabric Manager Web Client

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot log into Fabric Manager Web Client.</td>
<td>Forgot password.</td>
<td>Reset the administrative password. See the “Recovering a Web Client Password” section on page 26-11.</td>
</tr>
<tr>
<td></td>
<td>Access set for RADIUS or TACACS+ but server is not responding.</td>
<td>Set for local authentication. See the “Setting Fabric Manager Authentication Method” section on page 26-12. After you verify the RADIUS or TACACS+ server, you can set the authentication method to use RADIUS or TACACS+.</td>
</tr>
<tr>
<td></td>
<td>No valid ID message displayed. Fabric Manager Server has not discovered the fabric.</td>
<td>Open Fabric Manager and rediscover the fabric.</td>
</tr>
</tbody>
</table>

Recovering a Web Client Password

Fabric Manager Web Client user passwords are encrypted and stored locally on the workstation where you installed the Web Client. If you forget a password, you can make a new network-admin user locally on the workstation where you installed the Web Client and then log in and delete the old user account under the Admin tab.

To create a user on the workstation where you installed the Web Client and delete the old user, follow these steps:

Step 1  Go to the Web Client installation directory and cd to the bin directory.

Step 2  Enter the following line to create a user:

addUser <userName> <password>
Troubleshooting Fabric Manager

Send documentation comments to mdsfeedback-doc@cisco.com

Step 3 Stop Fabric Manager Web Client if it is running. If you installed this on Windows, you can stop the service using Windows Services under Administrative Tools.

Step 4 Launch Fabric Manager Web Client.

Step 5 Click Admin > Configure > Web Users > Local Database.

You see the list of users in the local database.

Step 6 Select the user that you want to delete and click Delete to remove the old user.

Setting Fabric Manager Authentication Method

To set the authentication method used by Fabric Manager (including the Web Client), follow these steps:

Step 1 Go to the Fabric Manager installation directory and open cisco_mds9000\AAA.properties in an edit program (for example, Notepad on Microsoft Windows).

Step 2 Set authentication.mode=local.

Step 3 Restart Fabric Manager.

Troubleshooting Performance Manager

Performance Manager gathers network device statistics historically and provides this information graphically using a web browser. It presents recent statistics in detail and older statistics in summary. Performance Manager also integrates with external tools such as Cisco Traffic Analyzer.

The Performance Manager has three operational stages:

- Definition—The Flow Wizard sets up flows in the switches.
- Collection—Reads the configuration from the database, the flow configuration from the switches, and collects the desired information.
- Presentation—Generates web pages to present the collected data.

Performance Manager uses a round-robin database to hold the statistical data collected from the fabric. This data is stored based on the configured parameters in the collection configuration file. At each polling interval, Performance Manager gathers the relevant statistics and stores them in the round-robin database. This database is a fixed size and will not grow beyond its preset limits.

Performance Manager creates a series of archived data to hold summarized information present in the real-time round-robin database. This archived data is used to generate daily, weekly, monthly, and yearly consolidated reports. In this way, Performance Manager maintains significant historical data without the cost of an ever-increasing database size.

This section contains the following topics:

- Performance Manager Generates Java Error, page 26-13
- Performance Manager Not Working, page 26-13
Performance Manager Generates Java Error

**Symptom**  Performance Manager generates JAVA error.

<table>
<thead>
<tr>
<th><strong>Table 26-5  Performance Manager Generates JAVA Error</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Performance Manager generates JAVA error.</td>
</tr>
</tbody>
</table>

Performance Manager Not Working

**Symptom**  Performance Manager not working.

<table>
<thead>
<tr>
<th><strong>Table 26-6  Performance Manager Not Working</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symptom</strong></td>
</tr>
<tr>
<td>Performance Manager not working.</td>
</tr>
</tbody>
</table>

Troubleshooting Device Manager

While Fabric Manager provides real-time views of your network fabric, Device Manager provides a real-time graphic representation of a Cisco MDS 9000 Family switch chassis, including the installed switching modules, the supervisor modules, the status of each port within each module, the power supplies, and the fan assemblies.

Device Manager allows you to troubleshoot device-specific configuration issues by providing detailed information for verification. It also allows you to perform switch-level configurations, including:

- Configure zones for multiple VSANs
- Manage ports, PortChannels, and trunking
- Manage SNMPv3 and CLI security access to switches
- Manage alarms, events, and notifications
- Save and copy configuration files and software images
- View hardware configurations, chassis, modules, port status, and statistics

Device Manager uses the SNMP user name/password combination to communicate with the switch. The SNMP user name is automatically synchronized with the CLI user names configured. If you use the administrator password recovery procedure, you must manually reset the administrative password on the switch to resynchronize the SNMP and CLI user name and password. See the “Recovering the Administrator Password” section on page 2-32.
Wrong Version of Device Manager is Launched

Symptom: When launching Device Manager from the Fabric Manager Web Client, the wrong version is opened.

Table 26-7  Wrong version of Device Manager is opened

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
Appendix A

Before Contacting Technical Support

This appendix describes the steps to perform before calling for technical support for any Cisco MDS 9000 Family multilayer director and fabric switch. This appendix includes the following sections:

- Steps to Perform Before Calling TAC, page A-1
- Using Core Dumps, page A-5

Note: If you purchased Cisco support through a Cisco reseller, contact the reseller directly. If you purchased support directly from Cisco, contact Cisco Technical Support at this URL: http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Steps to Perform Before Calling TAC

At some point, you may need to contact your customer support representative or Cisco TAC for some additional assistance. This section outlines the steps that you should perform prior to contacting your next level of support, as this will reduce the amount of time spent resolving the issue.

Note: Do not reload the module or the switch at least until you have completed Step 1 below. Some logs and counters are kept in volatile storage and will not survive a reload.

To prepare for contacting your customer support representative, follow these steps:

Step 1: Collect switch information and configuration. This should be done before and after the issue has been resolved. The following three methods each provide the same information:

a. Select Tools > Show Tech Support in Fabric Manager. Fabric Manager can capture switch configuration information from multiple switches simultaneously. The file can be saved on the local PC.

b. Configure your Telnet or SSH application to log the screen output to a text file. Use the terminal length 0 CLI command and then use the show tech-support details CLI command.

c. Use the tac-pac <filename> CLI command to redirect the output of the show tech-support details CLI command to a file, and then gzip the file.

switch# tac-pac bootflash://showtech.switch1
Send documentation comments to mdsfeedback-doc@cisco.com

If no filename is specified, the file is created as volatile:show_tech_out.gz. The file should then be copied from the switch using the procedure outlined in the “Copying Files to or from the Switch” section on page A-3.

Step 2  If an error occurs in Fabric Manager, take a screen shot of the error. In Windows, press Alt+PrintScreen to capture the active window, or press only PrintScreen to capture the entire desktop. Then paste this into a new Microsoft Paint (or similar program) session and save the file.

Step 3  Capture the exact error codes you see in the message logs from either Fabric Manager or the CLI.
   a. Select the Logs tab in the Map pane in Fabric Manager or choose Switches > Events to see the recent list of messages generated.
   b. Copy the error from the message log, which can be displayed using either the show logging log CLI command or the show logging last number to view the last lines of the log.

Step 4  Answer the following questions before calling for technical support:
   • On which switch, host bus adapter (HBA), or storage port is the problem occurring?
   • Which Cisco SAN-OS software, driver versions, operating systems versions and storage device firmware are in your fabric?
   • What is the network topology? (In Fabric Manager, go to Tools > Show Tech Support and check the Save Map check box.)
   • Were any changes being made to the environment (zoning, adding modules, upgrades) prior to or at the time of this event?
   • Are there other similarly configured devices that could have this problem, but do not?
   • Where was this problematic device connected (which MDS switch and interface)?
   • When did this problem first occur?
   • When did this problem last occur?
   • How often does this problem occur?
   • How many devices have this problem?
   • Were any traces or debug output captured during the problem time? What troubleshooting steps have you attempted? Which, if any, of the following tools were used?
      – FC Analyzer, PAA-2, Ethereal, local or remote SPAN
      – CLI debug commands
      – FC traceroute, FC ping
      – Fabric Manager or Device Manager tools
Send documentation comments to mdsfeedback-doc@cisco.com

Step 5  Is your problem related to a software upgrade attempt?
   - What was the original Cisco SAN-OS version?
   - What is the new Cisco SAN-OS version?
   - Did you use Fabric Manager or the CLI to attempt this upgrade?
   - Please collect the output from the following commands and forward them to your customer support representative:
     - `show install all status`
     - `show system internal log install`
     - `show system internal log install details`
     - `show log nvram`

Step 6  If your problem is related to zoning, use the `show zone tech-support` CLI command to gather relevant information.

Copying Files to or from the Switch

It may be required to move files to or from the switch. These files may include log, configuration, or firmware files.

Copying Files Using Device Manager

To copy the configuration from the switch using Device Manager, follow these steps:

Step 1  Choose Admin > Copy Configuration. You see the Copy Configuration dialog box.
Step 2  Set the To field to the server where you want to copy the configuration file to.
Step 3  Set the From field to running or startup configuration.
Step 4  Select the protocol you want to use to copy the file from the switch.
Step 5  Select Apply to copy the file.

To copy files to the switch using Device Manager, follow these steps:

Step 1  Choose Admin > Flash Files. You see the list of files in the chosen device and partition.
Step 2  Select Copy to copy a file. You see the copy file dialog box.
Step 3  select the protocol you want to use to copy the file to the switch.
Step 4  Set the server address and the file that you want to copy.
Step 5  Select Apply to copy the file.
Copying Files Using the CLI

The CLI offers a broad range of protocols to use for copying to or from the switch. Note that the switch always acts as a client, such that an ftp/scp/tftp session will always originate from the switch and either push files to an external system or pull files from an external system.

File Server: 172.22.36.10
File to be copied to the switch: /etc/hosts

The *copy* CLI command supports four transfer protocols and 12 different sources for files.

```
ca-9506# copy ?
  bootflash: Select source filesystem
  core: Select source filesystem
  debug: Select source filesystem
  ftp: Select source filesystem
  licenses Backup license files
  log: Select source filesystem
  modflash: Select source filesystem
  nvram: Select source filesystem
  running-config Copy running configuration to destination
  scp: Select source filesystem
  sftp: Select source filesystem
  slot0: Select source filesystem
  startup-config Copy startup configuration to destination
  system: Select source filesystem
  tftp: Select source filesystem
  volatile: Select source filesystem
```

Use the following syntax to use secure copy (scp) as the transfer mechanism:

```
"scp://[[username@]server][/path]"
```

To copy /etc/hosts from 172.22.36.10 using the user user1, where the destination would be hosts.txt, use the following command:

```
switch# copy scp://user1@172.22.36.10/etc/hosts bootflash:hosts.txt
user1@172.22.36.10's password:
hosts 100% |*****************************| 2035 00:00
```

To back up the startup-configuration to a sftp server, use the following command:

```
switch# copy startup-config sftp://user1@172.22.36.10/MDS/startup-configuration.bak1
Connecting to 172.22.36.10...
User1@172.22.36.10's password:
switch#
```

**Tip**

Backing up the startup-configuration to a server should be done on a daily basis and prior to any changes. A short script could be written to be run on the MDS to perform a save and then backup of the configuration. The script only needs to contain two commands: *copy running-configuration startup-configuration* and then *copy startup-configuration tftp://server/name*. To execute the script use: *run-script* filename.
Using Core Dumps

Core dumps are available in situations where unknown problems exist. Dumps are sent to a TFTP server or to a Flash card in slot0: of the local switch. You should set up your switch to generate core dumps under the instruction of your customer support representative. Core dumps are decoded by technical support engineers.

Best practice is to set up core dumps to go to a TFTP server. Then these core dumps can be e-mailed directly to your customer support representative.

Setting Up Core Dumps Using the CLI

Use the `system cores` CLI command to set up core dumps on your switch.

```
switch# system cores tftp://10.91.51.200/jsmith_cores
switch# show system cores
Cores are transferred to tftp://10.91.51.200/jsmith_cores
```

**Note**

The file name (indicated by jsmith_cores) must exist in the TFTP server directory.
Troubleshooting Tools and Methodology

This appendix describes the troubleshooting tools and methodology available for the Cisco MDS 9000 Family multilayer directors and fabric switches. It includes the following sections:

- Using Cisco MDS 9000 Family Tools, page B-1
- Using Cisco Network Management Products, page B-24
- Using Other Troubleshooting Products, page B-27
- Using Host Diagnostic Tools, page B-28

Using Cisco MDS 9000 Family Tools

If the server does not see its storage and you cannot use the information available on the host side to determine the root cause of the problem, you can obtain additional information from a different viewpoint using the troubleshooting tools provided with the Cisco MDS 9000 Family switches. This section introduces these tools and describes the kinds of problems for which you can use each tool. It includes the following topics:

- Command-Line Interface Troubleshooting Commands, page B-2
- CLI Debug, page B-2
- FC Ping and FC Traceroute, page B-4
- Monitoring Processes and CPUs, page B-7
- Using On-Board Failure Logging, page B-10
- Fabric Manager Tools, page B-13
- Fibre Channel Name Service, page B-18
- SNMP and RMON Support, page B-19
- Using RADIUS, page B-21
- Using Syslog, page B-21
- Using Fibre Channel SPAN, page B-23
Command-Line Interface Troubleshooting Commands

The command-line interface (CLI) lets you configure and monitor a Cisco MDS 9000 Family switch using a local console or remotely using a Telnet or SSH session. The CLI provides a command structure similar to Cisco IOS® software, with context-sensitive help, show commands, multi-user support, and roles-based access control.

Use the show running interface CLI command to view the interface configuration in Cisco SAN-OS Release 3.0(1) or later. The interface configuration as seen in the show running-config CLI command is no longer consolidated.

CLI Debug

The Cisco MDS 9000 Family switches support an extensive debugging feature set for actively troubleshooting a storage network. Using the CLI, you can enable debugging modes for each switch feature and view a real-time updated activity log of the control protocol exchanges. Each log entry is time-stamped and listed in chronological order. Access to the debug feature can be limited through the CLI roles mechanism and can be partitioned on a per-role basis. While debug commands show realtime information, the show commands can be used to list historical information as well as realtime.

You can log debug messages to a special log file, which is more secure and easier to process than sending the debug output to the console.

By using the ‘?’ option, you can see the options that are available for any switch feature, such as FSPF. A log entry is created for each entered command in addition to the actual debug output. The debug output shows a time-stamped account of activity occurring between the local switch and other adjacent switches.

You can use the debug facility to keep track of events, internal messages, and protocol errors. However, you should be careful with using the debug utility in a production environment, because some options may prevent access to the switch by generating too many messages to the console or if very CPU-intensive may seriously affect switch performance.

We recommend that you open a second Telnet or SSH session before entering any debug commands. If the debug session overwhelms the current output window, you can use the second session to enter the undebug all command to stop the debug message output.

The following is an example of the output from the debug flogi event command:

```
switch# debug flogi event interface fc1/1
Dec 10 23:40:26 flogi: current state [FLOGI_ST_FLOGI_RECEIVED]
Dec 10 23:40:26 flogi: current event [FLOGI_EV_VALID_FLOGI]
Dec 10 23:40:26 flogi: next state [FLOGI_ST_GET_FCID]
Dec 10 23:40:26 flogi: fu_fsm_execute: ([1]21:00:00:e0:8b:08:96:22)
Dec 10 23:40:26 flogi: current state [FLOGI_ST_GET_FCID]
Dec 10 23:40:26 flogi: current event [FLOGI_EV_CONFIG_DONE_PENDING]
Dec 10 23:40:26 flogi: next state [FLOGI_ST_GET_FCID]
```
Dec 10 23:40:26 flogi: fu_fsm_execute: ([1]21:00:00:e0:8b:08:96:22)
Dec 10 23:40:26 flogi:     current state [FLOGI_ST_PERFORM_CONFIG]
Dec 10 23:40:26 flogi:     current event [FLOGI_EV_RIB_RESPONSE]
Dec 10 23:40:26 flogi:     next state    [FLOGI_ST_PERFORM_CONFIG]

The following is a summary of some of the common debug commands available Cisco SAN-OS:

Table B-1    Debug Commands

<table>
<thead>
<tr>
<th>Debug command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>aaa</td>
<td>Enables AAA debugging.</td>
</tr>
<tr>
<td>all</td>
<td>Enables all debugging.</td>
</tr>
<tr>
<td>biosd</td>
<td>Enables BIOS daemon debugging.</td>
</tr>
<tr>
<td>bootvar</td>
<td>Enables bootvar debugging.</td>
</tr>
<tr>
<td>callhome</td>
<td>Enables debugging for Call Home.</td>
</tr>
<tr>
<td>cdp</td>
<td>Enables CDP debugging.</td>
</tr>
<tr>
<td>cfs</td>
<td>Enables Cisco Fabric Services debugging.</td>
</tr>
<tr>
<td>cimserver</td>
<td>Enables CIM server debugging.</td>
</tr>
<tr>
<td>core</td>
<td>Enables core daemon debugging.</td>
</tr>
<tr>
<td>device-alias</td>
<td>Enables device alias debugging.</td>
</tr>
<tr>
<td>dstats</td>
<td>Enables delta statistics debugging.</td>
</tr>
<tr>
<td>ethport</td>
<td>Enables port debugging.</td>
</tr>
<tr>
<td>exceptionlog</td>
<td>Enables exception log debugging.</td>
</tr>
<tr>
<td>fc-tunnel</td>
<td>Enables Fibre Channel tunnel debugging.</td>
</tr>
<tr>
<td>fc2</td>
<td>Enables FC2 debugging.</td>
</tr>
<tr>
<td>fc2d</td>
<td>Enables FC2D debugging.</td>
</tr>
<tr>
<td>fcc</td>
<td>Enables Fibre Channel congestion debugging.</td>
</tr>
<tr>
<td>fcdomain</td>
<td>Enables fcdomain debugging.</td>
</tr>
<tr>
<td>fcfdw</td>
<td>Enables fcfdw debugging.</td>
</tr>
<tr>
<td>fens</td>
<td>Enables Fibre Channel name server debugging.</td>
</tr>
<tr>
<td>fcs</td>
<td>Enables Fabric Configuration Server debugging.</td>
</tr>
<tr>
<td>fdmi</td>
<td>Enables FDMI debugging.</td>
</tr>
<tr>
<td>flogi</td>
<td>Enables fabric login debugging.</td>
</tr>
<tr>
<td>fm</td>
<td>Enables feature manager debugging.</td>
</tr>
<tr>
<td>fspf</td>
<td>Enables FSPF debugging.</td>
</tr>
<tr>
<td>hardware</td>
<td>Enables hardware, kernel loadable module parameter debugging.</td>
</tr>
<tr>
<td>idehsd</td>
<td>Enables idehsd manager debugging.</td>
</tr>
<tr>
<td>ile_helper</td>
<td>Enables ile_helper debugging.</td>
</tr>
<tr>
<td>ipacl</td>
<td>Enables IP ACL debugging.</td>
</tr>
<tr>
<td>ipconf</td>
<td>Enables IP configuration debugging.</td>
</tr>
<tr>
<td>ipfc</td>
<td>Enables IPFC debugging.</td>
</tr>
<tr>
<td>klm</td>
<td>Enables kernel loadable module parameter debugging.</td>
</tr>
</tbody>
</table>
Using Cisco MDS 9000 Family Tools

FC Ping and FC Traceroute

**Note**

Use the Fibre Channel ping and Fibre Channel traceroute features to troubleshoot problems with connectivity and path choices. Do not use them to identify or resolve performance issues.

Ping and traceroute are two of the most useful tools for troubleshooting TCP/IP networking problems. The ping utility generates a series of echo packets to a destination across a TCP/IP internetwork. When the echo packets arrive at the destination, they are rerouted and sent back to the source. Using ping, you can verify connectivity to a particular destination across an IP routed network.

The traceroute utility operates in a similar fashion, but can also determine the specific path that a frame takes to its destination on a hop-by-hop basis.

---

<table>
<thead>
<tr>
<th>Debug command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>license</td>
<td>Enables license debugging.</td>
</tr>
<tr>
<td>logfile</td>
<td>Directs the debug command output to a logfile.</td>
</tr>
<tr>
<td>module</td>
<td>Enables module manager debugging.</td>
</tr>
<tr>
<td>ntp</td>
<td>Enables NTP debugging.</td>
</tr>
<tr>
<td>platform</td>
<td>Enables platform manager debugging.</td>
</tr>
<tr>
<td>port</td>
<td>Enables port debugging.</td>
</tr>
<tr>
<td>port-channel</td>
<td>Enables PortChannel debug.</td>
</tr>
<tr>
<td>qos</td>
<td>Enables QOS Manager debugging.</td>
</tr>
<tr>
<td>radius</td>
<td>Enables RADIUS debugging.</td>
</tr>
<tr>
<td>rib</td>
<td>Enables RIB debugging.</td>
</tr>
<tr>
<td>rlr</td>
<td>Enables RLIR debugging.</td>
</tr>
<tr>
<td>rscn</td>
<td>Enables RSCN debugging.</td>
</tr>
<tr>
<td>scsi-target</td>
<td>Enables scsi target daemon debugging.</td>
</tr>
<tr>
<td>security</td>
<td>Enables security and accounting debugging.</td>
</tr>
<tr>
<td>snmp</td>
<td>Enables SNMP debugging.</td>
</tr>
<tr>
<td>span</td>
<td>Enables SPAN debugging.</td>
</tr>
<tr>
<td>svc</td>
<td>Enables SVC debugging.</td>
</tr>
<tr>
<td>system</td>
<td>Enables System debugging.</td>
</tr>
<tr>
<td>tlport</td>
<td>Enables TL Port debugging.</td>
</tr>
<tr>
<td>vni</td>
<td>Enables virtual network interface debugging.</td>
</tr>
<tr>
<td>vrrp</td>
<td>Enables VRRP debugging.</td>
</tr>
<tr>
<td>vsan</td>
<td>Enables VSAN manager debugging.</td>
</tr>
<tr>
<td>wwn</td>
<td>Enables WWN manager debugging.</td>
</tr>
<tr>
<td>zone</td>
<td>Enables zone server debugging.</td>
</tr>
</tbody>
</table>
These tools have been migrated to Fibre Channel for use with the Cisco MDS 9000 Family switches and are called `FC ping` and `FC traceroute`. You can access FC ping and FC traceroute from the CLI or from Fabric Manager.

This section contains the following topics:

- Using FC Ping, page B-5
- Using FC Traceroute, page B-5

### Using FC Ping

The FC ping tool:

- Checks end-to-end connectivity.
- Uses an pWWN or FCID.

FC ping allows you to ping a Fibre Channel N port or end device. (See Example B-1.) By specifying the FCID or Fibre Channel address, you can send a series of frames to a target N port. Once these frames reach the target device’s N port, they are looped back to the source and a time-stamp is taken. FC ping helps you to verify the connectivity to an end N port. FC ping uses the PRLI Extended Link Service, and verifies the presence of a Fibre Channel entity in case of positive or negative answers.

The FC Ping feature verifies reachability of a node by checking its end-to-end connectivity.

- Choose **Tools > Ping** to access FC ping using Fabric Manager.
- Invoke the FC ping feature using the CLI by providing the FC ID or the destination port WWN information in the following ways:

  ```
  switch# fcping pwwn 20:00:00:2e:c4:91:d4:54
  switch# fcping fcid 0x123abc
  ```

**Example B-1  FC Ping Command**

```plaintext
switch# fcping fcid 0xef02c9 vsan 1
28 bytes from  0xef02c9  time = 1408 usec
28 bytes from  0xef02c9  time = 379 usec
28 bytes from  0xef02c9  time = 347 usec
28 bytes from  0xef02c9  time = 361 usec
28 bytes from  0xef02c9  time = 363 usec
5 frames sent, 5 frames received, 0 timeouts
Round-trip min/avg/max = 347/571/1408 usec
```

### Using FC Traceroute

Use the FC Trace feature to:

- Trace the route followed by data traffic.
- Compute inter-switch (hop-to-hop) latency.

FC traceroute identifies the path taken on a hop-by-hop basis and includes a timestamp at each hop in both directions. (See Example B-2.) FC ping and FC traceroute are useful tools to check for network connectivity problems or verify the path taken toward a specific destination. You can use FC traceroute to test the connectivity of TE ports along the path between the generating switch and the switch closest to the destination.

Choose **Tools > Traceroute** on Fabric Manager or use the `fctrace` CLI command to access this feature.
Use FC Trace by providing the FC ID, the N port, or the NL port WWN of the destination. The frames are routed normally as long as they are forwarded through TE ports. After the frame reaches the edge of the fabric (the F port or FL port connected to the end node with the given port WWN or the FC ID), the frame is looped back (swapping the source ID and the destination ID) to the originator.

If the destination cannot be reached, the path discovery starts, which traces the path up to the point of failure.

The FC Trace feature works only on TE Ports. Make sure that only TE ports exist in the path to the destination. If there is an E Port in the path:

- The FC Trace frame will be dropped by that switch.
- The FC Trace will time out in the originator.
- Path discovery will not start.

**Note**
FC traceroute will only work across EISL links.

### Example B-2  fctraceroute Command

```bash
switch# fctrace fcid 0xef0000 vsan 1
Route present for : 0xef0000
20:00:00:05:30:00:59:de(0xfffcee)
Latency: 0 msec
20:00:00:05:30:00:58:1e(0xfffc6c)
Timestamp Invalid.
20:00:00:05:30:00:59:1e(0xfffcef)
Latency: 0 msec
20:00:00:05:30:00:59:1e(0xfffcef)
Latency: 174860 msec
20:00:00:05:30:00:58:1e(0xfffc6c)
```

**Note**
The values rendered by the FC traceroute process do not reflect the actual latency across the switches. The actual trace value interpretation is shown in the example below.

### Example B-2  fctraceroute Command

```bash
switch# show fcns database vsan 600
VSAN 600
-------------------------------------------------------------------------
FCID        TYPE  PWWN                    (VENDOR)        FC4-TYPEFEATURE
-------------------------------------------------------------------------
0xeb01e8    NL    21000003767f7a2 (Seagate)       scsi-fcptarget
0xec00e4    NL    21000003767f48a (Seagate)       scsi-fcp
0xec00e8    NL    21000003767f507 (Seagate)       scsi-fcp
-------------------------------------------------------------------------
Total number of entries = 3
switch# fctrace fcid 0xeb01e8 vsan 600
Route present for 0xeb01e8
200000052027ade(0xfffcee) ---> MDS originating the trace
Latency 0 msec
20000000030575ec0(0xfffc6d) ---> first hop MDS towards destination FCID
Latency 30820 msec
20000000030575ec0(0xfffc6d) ---> MDS which connects directly to the traced FCID (0xeb01e8)
Latency 0 msec
20000000030575ec0(0xfffc6d) ---> idem, but looped around
Latency 0 msec
20000000030575ec0(0xfffc6d) ---> first hop MDS on the return path from traced FCID to origin
switch#
```

Send documentation comments to mdsfeedback-doc@cisco.com
Monitoring Processes and CPUs

There are features in both CLI and Device Manager for monitoring switch processes and CPU status and utilization.

This section contains the following topics:

- Viewing Running Processes on Device Manager, page B-7
- Using the show processes CLI Command, page B-8
- Viewing CPU Time In Device Manager, page B-9
- Using the show processes cpu CLI Command, page B-9
- Using the show system resource CLI Command, page B-10

Viewing Running Processes on Device Manager

Choose Admin > Running Processes on Device Manager to view information about the processes currently running on a switch. The Running Processes dialog box (See Figure B-1.)

The dialog display includes:

- Process ID
- The name associated with this process
- The sum of all dynamically allocated memory that this process has received from the system; this includes memory that may have been returned to the system
- The amount of CPU time the process has used, in microseconds
Using Cisco MDS 9000 Family Tools

Send documentation comments to mdsfeedback-doc@cisco.com

Figure B-1 Running Processes Dialog Box

Using the show processes CLI Command

Use the show processes command to identify the processes that are running and the status of each process. (See Example B-3.) The command output includes:

- **PID** = process ID.
- **State** = process state.
- **PC** = current program counter in hex format.
- **Start_cnt** = how many times a process has been started (or restarted).
- **TTY** = terminal that controls the process. A “-” usually means a daemon not running on any particular TTY.
- **Process** = name of the process.

Process states are:

- **D** = uninterruptible sleep (usually I/O).
- **R** = runnable (on run queue).
- **S** = sleeping.
- **T** = traced or stopped.
- **Z** = defunct (“zombie”) process.
- **NR** = not-running.
- **ER** = should be running but currently not-running.
The ER state typically designates a process that has been restarted too many times, causing the system to classify it as faulty and disable it.

### Example B-3  show processes Command

```
switch# show processes ?
cpu Show processes CPU Info
log Show information about process logs
memory Show processes Memory Info
```

```
switch# show processes
```

<table>
<thead>
<tr>
<th>PID</th>
<th>State</th>
<th>PC</th>
<th>Start_cnt</th>
<th>TTY</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>457</td>
<td>S</td>
<td>2abaa76f</td>
<td>1</td>
<td>-</td>
<td>portmap</td>
</tr>
<tr>
<td>1218</td>
<td>S</td>
<td>2acbac24</td>
<td>1</td>
<td>-</td>
<td>licmgr</td>
</tr>
<tr>
<td>1249</td>
<td>S</td>
<td>2ade633e</td>
<td>1</td>
<td>-</td>
<td>xbar_client</td>
</tr>
<tr>
<td>1250</td>
<td>S</td>
<td>2aca833e</td>
<td>1</td>
<td>-</td>
<td>wwn</td>
</tr>
<tr>
<td>1251</td>
<td>S</td>
<td>2aebbc24</td>
<td>1</td>
<td>-</td>
<td>vsan</td>
</tr>
<tr>
<td>1253</td>
<td>S</td>
<td>2ade433e</td>
<td>1</td>
<td>-</td>
<td>ttyd</td>
</tr>
<tr>
<td>1254</td>
<td>S</td>
<td>2ac51ef4</td>
<td>1</td>
<td>-</td>
<td>sysinfo</td>
</tr>
<tr>
<td>1255</td>
<td>S</td>
<td>2af7333e</td>
<td>1</td>
<td>-</td>
<td>span</td>
</tr>
</tbody>
</table>

### Viewing CPU Time In Device Manager

The Running Processes dialog display can be sorted based on any column header. To sort on CPU utilization, click the CPU column header. An arrow in the column header indicates the order of CPU utilization. Click the column header to toggle between ascending or descending order.

### Example B-4  CPU Time Column Header

![Running Processes](image)

### Using the show processes cpu CLI Command

Use the `show processes cpu` command to display CPU utilization. The command output includes:

- **Runtime(ms)** = CPU time the process has used, expressed in milliseconds.
- **Invoked** = number of times the process has been invoked.
- uSecs = microseconds of CPU time in average for each process invocation.
- 1Sec = CPU utilization in percentage for the last one second.

**Example B-5  show processes cpu Command**

```
switch# show processes cpu
```

<table>
<thead>
<tr>
<th>PID</th>
<th>Runtime(ms)</th>
<th>Invoked</th>
<th>uSecs</th>
<th>1Sec</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>1016</td>
<td>7</td>
<td>2</td>
<td>3714</td>
<td>0.0</td>
<td>tftpd</td>
</tr>
<tr>
<td>1017</td>
<td>20627</td>
<td>2921172</td>
<td>7</td>
<td>0.0</td>
<td>syslogd</td>
</tr>
<tr>
<td>1218</td>
<td>299</td>
<td>11710</td>
<td>25</td>
<td>0.0</td>
<td>licmgr</td>
</tr>
<tr>
<td>1219</td>
<td>25</td>
<td>38</td>
<td>676</td>
<td>0.0</td>
<td>fs-daemon</td>
</tr>
<tr>
<td>1220</td>
<td>1558</td>
<td>6985</td>
<td>223</td>
<td>0.0</td>
<td>feature-mgr</td>
</tr>
<tr>
<td>1221</td>
<td>263</td>
<td>11772</td>
<td>22</td>
<td>0.0</td>
<td>fcfwd</td>
</tr>
<tr>
<td>1223</td>
<td>512</td>
<td>8996</td>
<td>56</td>
<td>0.0</td>
<td>capability</td>
</tr>
<tr>
<td>1237</td>
<td>313</td>
<td>29072</td>
<td>10</td>
<td>0.0</td>
<td>syslogd</td>
</tr>
<tr>
<td>1249</td>
<td>912</td>
<td>18815</td>
<td>48</td>
<td>0.0</td>
<td>xbar_client</td>
</tr>
<tr>
<td>1250</td>
<td>1481</td>
<td>6214</td>
<td>238</td>
<td>0.0</td>
<td>wwn</td>
</tr>
<tr>
<td>1251</td>
<td>1460</td>
<td>68079</td>
<td>21</td>
<td>0.0</td>
<td>vsan</td>
</tr>
<tr>
<td>1253</td>
<td>457</td>
<td>29220</td>
<td>15</td>
<td>0.0</td>
<td>ttyd</td>
</tr>
<tr>
<td>1254</td>
<td>138</td>
<td>6309</td>
<td>21</td>
<td>0.0</td>
<td>sysinfo</td>
</tr>
</tbody>
</table>

**Using the show system resource CLI Command**

Use the `show system resources` command to display system-related CPU and memory statistics. The output includes the following:

- **Load**: The average reflects the system load over the past 1, 5, and 15 minutes.
- **Processes**: The number of processes, and how many are actually running when the command is issued.
- **CPU states**: The percentage of CPU usage in user mode, kernel mode, and idle time in the last one second.
- **Memory usage**: Total memory, used memory, free memory, memory used for buffers, and memory used for cache in KB. Buffers and cache are also included in the used memory statistics.

**Example B-6  show system resources Command**

```
switch# show system resources
```

```
Load average: 1 minute: 0.00 5 minutes: 0.00 15 minutes: 0.00
Processes: 152 total, 3 running
CPU states: 0.0% user, 0.0% kernel, 100.0% idle
Memory usage: 960080K total, 412900K used, 547180K free
2340K buffers, 292380K cache
```

**Using On-Board Failure Logging**

The Generation 2 Fibre Channel switching modules provide the facility to log failure data to persistent storage, which can be retrieved and displayed for analysis. This on-board failure logging (OBFL) feature stores failure and environmental information in nonvolatile memory on the module. This information will help in post-mortem analysis of failed cards.
The data stored by the OBFL facility includes the following:

- Time of initial power-on
- Slot number of the card in the chassis
- Initial temperature of the card
- Firmware, BIOS, FPGA, and ASIC versions
- Serial number of the card
- Stack trace for crashes
- CPU hog information
- Memory leak information
- Software error messages
- Hardware exception logs
- Environmental history
- OBFL specific history information
- ASIC interrupt and error statistics history
- ASIC register dumps

**Configuring OBFL for the Switch**

To configure OBFL for all the modules on the switch, follow these steps:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td></td>
</tr>
<tr>
<td>switch# config terminal</td>
<td>Enters configuration mode.</td>
</tr>
<tr>
<td>switch(config)#</td>
<td></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Enables all OBFL features.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard</td>
<td></td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard cpu-hog</td>
<td>Enables the OBFL CPU hog events.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard environmental-history</td>
<td>Enables the OBFL environmental history.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard error-stats</td>
<td>Enables the OBFL error statistics.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard interrupt-stats</td>
<td>Enables the OBFL interrupt statistics.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard mem-leak</td>
<td>Enables the OBFL memory leak events.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard miscellaneous-error</td>
<td>Enables the OBFL miscellaneous information.</td>
</tr>
<tr>
<td>switch(config)# hw-module logging onboard obfl-log</td>
<td>Enables the boot uptime, device version, and OBFL history.</td>
</tr>
<tr>
<td>switch(config)# no hw-module logging onboard</td>
<td>Disables all OBFL features.</td>
</tr>
</tbody>
</table>
Send documentation comments to mdsfeedback-doc@cisco.com

Use the `show logging onboard status` command to display the configuration status of OBFL.

```
switch# show logging onboard status
```

```
Switch OBFL Log:        Enabled
Module:  6 OBFL Log:    Enabled
  error-stats          Enabled
  exception-log        Enabled
  miscellaneous-error  Enabled
  obfl-log (boot-uptime/device-version/obfl-history)  Enabled
  system-health        Enabled
  stack-trace          Enabled
```

## Configuring OBFL for a Module

To configure OBFL for specific modules on the switch, follow these steps:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| **Step 1**
  `switch# config terminal`  
  `switch(config)#` | Enters configuration mode. |
| **Step 2**
  `switch(config)# hw-module logging onboard module 1` | Enables all OBFL features on a module. |
  `switch(config)# hw-module logging onboard module 1 cpu-hog` | Enables the OBFL CPU hog events on a module. |
  `switch(config)# hw-module logging onboard module 1 environmental-history` | Enables the OBFL environmental history on a module. |
  `switch(config)# hw-module logging onboard module 1 error-stats` | Enables the OBFL error statistics on a module. |
  `switch(config)# hw-module logging onboard module 1 interrupt-stats` | Enables the OBFL interrupt statistics on a module. |
  `switch(config)# hw-module logging onboard module 1 mem-leak` | Enables the OBFL memory leak events on a module. |
  `switch(config)# hw-module logging onboard module 1 miscellaneous-error` | Enables the OBFL miscellaneous information on a module. |
  `switch(config)# hw-module logging onboard module 1 obfl-log` | Enables the boot uptime, device version, and OBFL history on a module. |
  `switch(config)# no hw-module logging onboard module 1` | Disables all OBFL features on a module. |

Use the `show logging onboard status` command to display the configuration status of OBFL.

```
switch# show logging onboard status
```

```
Switch OBFL Log:        Enabled
Module:  6 OBFL Log:    Enabled
  error-stats          Enabled
  exception-log        Enabled
  miscellaneous-error  Enabled
  obfl-log (boot-uptime/device-version/obfl-history)  Enabled
  system-health        Enabled
  stack-trace          Enabled
```
Displaying OBFL Logs

To display OBFL information stored in CompactFlash on a module, use the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>show logging onboard boot-uptime</td>
<td>Displays the boot and uptime information.</td>
</tr>
<tr>
<td>show logging onboard cpu-hog</td>
<td>Displays information for CPU hog events.</td>
</tr>
<tr>
<td>show logging onboard device-version</td>
<td>Displays device version information.</td>
</tr>
<tr>
<td>show logging onboard endtime</td>
<td>Displays OBFL logs to an end time.</td>
</tr>
<tr>
<td>show logging onboard environmental-history</td>
<td>Displays environmental history.</td>
</tr>
<tr>
<td>show logging onboard error-stats</td>
<td>Displays error statistics.</td>
</tr>
<tr>
<td>show logging onboard exception-log</td>
<td>Displays exception log information.</td>
</tr>
<tr>
<td>show logging onboard interrupt-stats</td>
<td>Displays interrupt statistics.</td>
</tr>
<tr>
<td>show logging onboard mem-leak</td>
<td>Displays memory leak information.</td>
</tr>
<tr>
<td>show logging onboard miscellaneous-error</td>
<td>Displays miscellaneous error information.</td>
</tr>
<tr>
<td>show logging onboard module slot</td>
<td>Displays OBFL information for a specific module.</td>
</tr>
<tr>
<td>show logging onboard obfl-history</td>
<td>Displays history information.</td>
</tr>
<tr>
<td>show logging onboard register-log</td>
<td>Displays register log information.</td>
</tr>
<tr>
<td>show logging onboard stack-trace</td>
<td>Displays kernel stack trace information.</td>
</tr>
<tr>
<td>show logging onboard starttime</td>
<td>Displays OBFL logs from a specified start time.</td>
</tr>
<tr>
<td>show logging onboard system-health</td>
<td>Displays system health information.</td>
</tr>
</tbody>
</table>

Fabric Manager Tools

Fabric Manager provides fabric-wide management capabilities including discovery, multiple switch configuration, network monitoring, and troubleshooting. It provides the troubleshooting features described in the following topics:

- Fabric Manager and Device Manager, page B-14
- Analyzing Switch Device Health, page B-14
- Analyzing End-to-End Connectivity, page B-15
- Analyzing Switch Fabric Configuration, page B-16
- Analyzing the Results of Merging Zones, page B-16
- Alerts and Alarms, page B-17
- Device Manager: RMON Threshold Manager, page B-17

Note

For detailed information about using Cisco Fabric Manager, refer to the Cisco MDS 9000 Family Fabric Manager Configuration Guide.
Send documentation comments to mdsfeedback-doc@cisco.com

### Using Cisco MDS 9000 Family Tools

#### Fabric Manager and Device Manager

Fabric Manager provides a map of the discovered fabric and includes tables that display statistical information about the switches in the fabric. You can also select troubleshooting tools from the Fabric Manager Tools menu.

- **Note**: When you click on a zone or VSAN in Fabric Manager, the members of the zone or VSAN are highlighted on the Fabric Manager Map pane.

Device Manager provides a graphic display of a specific switch and shows the status of each port on the switch. From Device Manager, you can drill down to get detailed statistics about a specific switch or port.

**Figure B-2** shows the Device Manager Summary View window.

**Figure B-2  Cisco Device Manager Summary View**

The Summary View window lets you analyze switch performance issues, diagnose problems, and change parameters to resolve problems or inconsistencies. This view shows aggregated statistics for the active Supervisor Module and all switch ports. Information is presented in tabular or graphical formats, with bar, line, area, and pie chart options. You can also use the Summary View to capture the current state of information for export to a file or output to a printer.

#### Analyzing Switch Device Health

Choose the **Switch Health** option from the Fabric Manager Tools menu to determine the status of the components of a specific switch.
Figure B-3 Switch Health Analysis Window

The Switch Health Analysis window displays any problems affecting the selected switches.

Analyzing End-to-End Connectivity

Select Tools > End to End Connectivity option from Fabric Manager to determine connectivity and routes among devices with the switch fabric. The connectivity tool checks to see that every pair of end devices in an active zone can talk to each other, using a Ping test and by determining if they are in the same VSAN. This option uses versions of the ping and traceroute commands modified for Fibre Channel networks.

The End to End Connectivity Analysis window displays the selected end points with the switch to which each is attached, and the source and target ports used to connect it.

The output shows all the requests which have failed. The possible descriptions are:

- Ignoring empty zone—No requests are issued for this zone.
- Ignoring zone with single member—No requests are issued for this zone.
- Source/Target are unknown—No nameserver entries exist for the ports or we have not discovered the port during discovery.
- Both devices are on the same switch—The devices are not redundantly connected.
- No paths exist.
- Only one unique path exists.
- VSAN does not have an active zone set.
- Average time... micro secs—The latency value was more than the threshold supplied.
Select the Fabric Configuration option from the Fabric Manager Tools menu to analyze the configuration of a switch by comparing the current configuration to a specific switch or to a policy file. You can save a switch configuration to a file and then compare all switches against the configuration in the file.

Figure B-4  Fabric Configuration Analysis Window

You use a policy file to define the rules to be applied when running the Fabric Checker. When you create a policy file, the system saves the rules selected for the selected switch.

Analyzing the Results of Merging Zones

Cisco Fabric Manager provides a very useful tool for troubleshooting problems that occur when merging zones configured on different switches.

Select the Zone Merge option on the Fabric Manager Tools menu to determine if two connected switches have compatible zone configurations.
Appendix B  Troubleshooting Tools and Methodology

Send documentation comments to mdsfeedback-doc@cisco.com

Figure B-5  Zone Merge Analysis Window

The Zone Merge Analysis window displays any inconsistencies between the zone configuration of the two selected switches.

You can use the following options on the Fabric Manager Tools menu to verify connectivity to a selected object or to open other management tools:

- **Traceroute**—Verify connectivity between two end devices that are currently selected on the Map pane.
- **Device Manager**—Launch Device Manager for the switch selected on the Map pane.
- **Command Line Interface**—Open a Telnet or SSH session for the switch selected on the Map pane.

**Alerts and Alarms**

You can configure and monitor SNMP, RMON, Syslog, and Call Home alarms and notifications using the different options on the Device Manager Events menu. SNMP provides a set of preconfigured traps and informs that are automatically generated and sent to the destinations (trap receivers) that you identify. The RMON Threshold Manager lets you configure thresholds for specific events that trigger log entries or notifications. You can use either Fabric Manager or Device Manager to identify Syslog servers that will record different events or to configure Call Home, which can alert you through e-mail messages or paging when specific events occur.

**Device Manager: RMON Threshold Manager**

Use the options on the Device Manager Events menu to configure and monitor Simple Network Management Protocol (SNMP), Remote Monitor (RMON), Syslog, and Call Home alarms and notifications. SNMP provides a set of preconfigured traps and informs that are automatically generated and sent to the destinations (trap receivers) chosen by the user.
Using Cisco MDS 9000 Family Tools

Use the RMON Threshold Manager to configure event thresholds that will trigger log entries or notifications. Use either Fabric Manager or Device Manager to:

- Identify Syslog servers that will record events.
- Configure Call Home, which can issue alerts via e-mail messages or paging when specific events occur.

The RMON groups that have been adapted for use with Fibre Channel include the AlarmGroup and EventGroup. The AlarmGroup provides services to set alarms. Alarms can be set on one or multiple parameters within a device. For example, an RMON alarm can be set for a specific level of CPU utilization or crossbar utilization on a switch. The EventGroup allows configuration of events (actions to be taken) based on an alarm condition. Supported event types include logging, SNMP traps, and log-and-trap.

**Figure B-6  RMON Threshold Manager**

---

**Fibre Channel Name Service**

The Fibre Channel name service is a distributed service in which all connected devices participate. As new SCSI target devices attach to the fabric, they register themselves with the name service, which is then distributed among all participating fabric switches. This information can then be used to help determine the identity and topology of nodes connected to the fabric.
SCSI Target Discovery

The SCSI Target Discovery feature provides added insight into connected SCSI targets. This feature allows the switch to briefly log into connected SCSI target devices and issue a series of SCSI inquiry commands to help discover additional information. The additional information that is queried includes logical unit number (LUN) details including the number of LUNs, the LUN IDs, and the sizes of the LUNs.

This information is then compiled and made available to through CLI commands, through the Cisco Fabric Manager, and also via an embedded SNMP MIB which allows the information to be easily retrieved by an upstream management application. Using the SCSI Target Discovery feature, you can have a much more detailed view of the fabric and its connected SCSI devices.

The following is an example of output from the `discover scsi-target` command:

```
switch# discover scsi-target local remote
discovery started
switch# show scsi-target lun vsan 1
- ST318203FC from SEAGATE (Rev 0004)
  FCID is 0xef0f02b5 in VSAN 1, PWWN is 21:00:00:20:37:46:78:97
----------------------------------------------------------------------------
LUN  Capacity  Status  Serial Number    Device-Id
(MB)
----------------------------------------------------------------------------
 0x0  18210     Online  LR948730000007029 C:1 A:0 T:3 20:00:00:20:37:46:78:97
- ST318203FC from SEAGATE (Rev 0004)
  FCID is 0xef02b6 in VSAN 1, PWWN is 21:00:00:20:37:5b:cf:b9
----------------------------------------------------------------------------
LUN  Capacity  Status  Serial Number    Device-Id
(MB)
----------------------------------------------------------------------------
 0x0  18210     Online  LR948730000007029 C:1 A:0 T:3 20:00:00:20:37:5b:cf:b9
- ST318203FC from SEAGATE (Rev 0004)
  FCID is 0xef02b9 in VSAN 1, PWWN is 21:00:00:20:37:18:6f:90
```

For more information about SCSI target discovery, refer to the Cisco MDS 9000 Family Configuration Guide.

**Note**

This tool can be effective to find out the number of LUNs exported by a storage subsystem, but it may be ineffective when LUN Zoning/LUN Security tools are used.

SNMP and RMON Support

The Cisco MDS 9000 Family switches provide extensive SNMPv1, v2, and v3 support, including Management Information Bases (MIBs) and notifications (traps and informs).

The applications provided by Cisco that use SNMP include Fabric Manager and CiscoWorks RME. Also, the SNMP standard allows any third-party applications that support the different MIBs to manage and monitor Cisco MDS 9000 Family switches.

SNMPv3 provides extended security. Each switch can be selectively enabled or disabled for SNMP service. In addition, each switch can be configured with a method of handling SNMPv1 and v2 requests.
Note

During initial configuration of your switch, the system prompts you to define SNMP v1 or V2 community strings and to create a SNMP v3 username and password.

Cisco MDS 9000 Family switches support over 50 different MIBs, which can be divided into the following six categories:

- IETF Standards-based Entity MIBs (for example, RFC273 ENTITY-MIB)
  These MIBs are used to report information on the physical devices themselves in terms of physical attributes etc.

- Cisco-Proprietary Entity MIBs (for example, CISCO-ENTITY-FRU-CONTROL-MIB)
  These MIBs are used to report additional physical device information about Cisco-only devices such as their configuration.

- IETF IP Transport-oriented MIBs (for example, RFC2013 UDP-MIB)
  These MIBs are used to report transport-oriented statistics on such protocols as IP, TCP, and UDP. These transports are used in the management of the Cisco MDS 9000 Family through the OOB Ethernet interface on the Supervisor module.

- Cisco-Proprietary Storage and Storage Network MIBs (for example, NAME-SERVER-MIB)
  These MIBs were written by Cisco to help expose information that is discovered within a fabric to management applications not connected to the fabric itself. In addition to exposing configuration details for features like zoning and Virtual SANs (VSANs) via MIBs, discovered information from sources like the FC-GS-3 Name Server can be pulled via a MIB. Additionally, MIBs are provided to configure/enable features within the Cisco MDS 9000 Family. There are over 20 new MIBs provided by Cisco for this information and configuration capability.

- IETF IP Storage Working Group MIBs (for example, ISCSI-MIB)
  While many of these MIBs are still work-in-progress, Cisco is helping to draft such MIBs for protocols such as iSCSI and Fibre Channel-over-IP (FCIP) to be standardized within the IETF.

- Miscellaneous MIBs (for example, SNMP-FRAMEWORK-MIB)
  There are several other MIBs provided in the Cisco MDS 9000 Family switches for tasks such as defining the SNMP framework or creating SNMP partitioned views.

You can use SNMPv3 to assign different SNMP capabilities to specific roles.

Cisco MDS 9000 Family switches also support Remote Monitoring (RMON) for Fibre Channel. RMON provides a standard method to monitor the basic operations of network protocols providing connectivity between SNMP management stations and monitoring agents. RMON also provides a powerful alarm and event mechanism for setting thresholds and sending notifications based on changes in network behavior.

The RMON groups that have been adapted for use with Fibre Channel include the AlarmGroup and the EventGroup. The AlarmGroup provides services to set alarms. Alarms can be set on one or multiple parameters within a device. For example, you can set an RMON alarm for a specific level of CPU utilization or crossbar utilization on a switch. The EventGroup lets you configure events that are actions to be taken based on an alarm condition. The types of events that are supported include logging, SNMP traps, and log-and-trap.

Note

To configure events within an RMON group, use the Events > Threshold Manager option from Device Manager. See the “Device Manager: RMON Threshold Manager” section on page B-17.
Using RADIUS

RADIUS is fully supported for the Cisco MDS 9000 Family switches through the Fabric Manager and the CLI. RADIUS is a protocol used for the exchange of attributes or credentials between a head-end RADIUS server and a client device. These attributes relate to three classes of services:

- Authentication
- Authorization
- Accounting

Authentication refers to the authentication of users for access to a specific device. You can use RADIUS to manage user accounts for access to Cisco MDS 9000 Family switches. When you try to log into a switch, the switch validates you with information from a central RADIUS server.

Authorization refers to the scope of access that you have once you have been authenticated. Assigned roles for users can be stored in a RADIUS server along with a list of actual devices that the user should have access to. Once the user has been authenticated, then switch can then refer to the RADIUS server to determine the extent of access the user will have within the switch network.

Accounting refers to the log information that is kept for each management session in a switch. This information may be used to generate reports for troubleshooting purposes and user accountability. Accounting can be implemented locally or remotely (using RADIUS).

The following is an example of an accounting log entries.

```bash
switch# show accounting log
Sun Dec 15 04:02:27 2002:start:/dev/pts/0_1039924947:admin
Sun Dec 15 04:02:28 2002:stop:/dev/pts/0_1039924947:admin:vsh exited normally
Sun Dec 15 04:02:33 2002:start:/dev/pts/0_1039924953:admin
Sun Dec 15 04:02:34 2002:stop:/dev/pts/0_1039924953:admin:vsh exited normally
Sun Dec 15 05:02:08 2002:start:snmp_1039928528_172.22.95.167:public
Sun Dec 15 05:02:08 2002:update:snmp_1039928528_172.22.95.167:public:Switchname
```

**Note**
The accounting log only shows the beginning and ending (start and stop) for each session.

Using Syslog

The system message logging software saves messages in a log file or directs the messages to other devices. This feature provides the following capabilities:

- Logging information for monitoring and troubleshooting.
- Selection of the types of logging information to be captured.
- Selection of the destination of the captured logging information.

Syslog lets you store a chronological log of system messages locally or sent to a central Syslog server. Syslog messages can also be sent to the console for immediate use. These messages can vary in detail depending on the configuration that you choose.

Syslog messages are categorized into 7 severity levels from debug to critical events. You can limit the severity levels that are reported for specific services within the switch. For example, you may wish only to report debug events for the FSPF service but record all severity level events for the Zoning service.
Using Cisco MDS 9000 Family Tools

A unique feature within the Cisco MDS 9000 Family switches is the ability to send RADIUS accounting records to the Syslog service. The advantage of this feature is that you can consolidate both types of messages for easier correlation. For example, when you log into a switch and change an FSPF parameter, Syslog and RADIUS provide complimentary information that will help you formulate a complete picture of the event.

Log messages are not saved across system reboots. However, a maximum of 100 log messages with a severity level of critical and below (levels 0, 1, and 2) are saved in NVRAM. You can view this log at any time with the `show logging nvram` command.

### Logging Levels

The MDS supports the following logging levels:

- 0-emergency
- 1-alert
- 2-critical
- 3-error
- 4-warning
- 5-notification
- 6-informational
- 7-debugging

By default, the switch logs normal but significant system messages to a log file and sends these messages to the system console. Users can specify which system messages should be saved based on the type of facility and the severity level. Messages are time-stamped to enhance real-time debugging and management.

### Enabling Logging for Telnet or SSH

System logging messages are sent to the console based on the default or configured logging facility and severity values.

Users can disable logging to the console or enable logging to a given Telnet or SSH session.

- To disable console logging, use the `no logging console` command in CONFIG mode.
- To enable logging for telnet or SSH, use the `terminal monitor` command in EXEC mode.

---

**Note:** When logging to a console session is disabled or enabled, that state is applied to all future console sessions. If a user exits and logs in again to a new session, the state is preserved. However, when logging to a Telnet or SSH session is enabled or disabled, that state is applied only to that session. The state is not preserved after the user exits the session.
The `no logging console` command shown in Example B-7:

- Disables console logging
- Enabled by default

**Example B-7  no logging console Command**

```
switch(config)# no logging console
```

The `terminal monitor` command shown in Example B-8:

- Enables logging for telnet or SSH
- Disabled by default

**Example B-8  terminal monitor Command**

```
switch# terminal monitor
```

### Using Fibre Channel SPAN

You can use the Switched Port Analyzer (SPAN) utility to perform detailed troubleshooting or to take a sample of traffic from a particular application host for proactive monitoring and analysis. This utility is most helpful when you have a Fibre Channel protocol analyzer available and you are monitoring user traffic between two FC IDs.

When you have a problem in your storage network that you cannot solve by fixing the device configuration, you typically need to take a look at the protocol level. You can use debug commands to look at the control traffic between an end node and a switch. However, when you need to focus on all the traffic originating from or destined to a particular end node such as a host or a disk, you can use a protocol analyzer to capture protocol traces.

To use a protocol analyzer, you must insert the analyzer in-line with the device under analysis, which disrupts input and output (I/O) to and from the device. This problem is worse when the point of analysis is on an Inter-Switch Link (ISL) link between two switches. In this case, the disruption may be significant depending on what devices are downstream from the severed ISL link.

In Ethernet networks, this problem can be solved using the SPAN utility, which is provided with the Cisco Catalyst Family of Ethernet switches. SPAN has also been implemented with the Cisco MDS 9000 Family switches for use in Fibre Channel networks. SPAN lets you take a copy of all traffic and direct it to another port within the switch. The process is non-disruptive to any connected devices and is facilitated in hardware, which prevents any unnecessary CPU load. Using Fibre Channel SPAN, you can connect a Fibre Channel analyzer, such as a Finisar analyzer, to an unused port on the switch and then SPAN a copy of the traffic from a port under analysis to the analyzer in a non-disruptive fashion.

SPAN allows you to create up to 16 independent SPAN sessions within the switch. Each session can have up to four unique sources and one destination port. In addition, you can apply a filter to capture only the traffic received or the traffic transmitted. With Fibre Channel SPAN, you can even capture traffic from a particular Virtual SAN (VSAN).

To start the SPAN utility use the CLI command `span session session_num`, where `session_num` identifies a specific SPAN session. When you enter this command, the system displays a submenu, which lets you configure the destination interface and the source VSAN or interfaces.

```
switch2# config terminal
switch2(config)# span session 1 <<== Create a span session
switch2(config-span)# source interface fc1/8 <<== Specify the port to be spanned
```
Using Cisco Network Management Products

Using Cisco Network Management Products

This section describes network management tools that are available from Cisco and are useful for troubleshooting problems with Cisco MDS 9000 Family switches and connected devices and includes the following topics:

- Cisco MDS 9000 Family Port Analyzer Adapter, page B-24
- Cisco Fabric Analyzer, page B-25
- IP Network Simulator, page B-27

Cisco MDS 9000 Family Port Analyzer Adapter

The Cisco MDS 9000 Family Port Analyzer Adapter is a stand-alone adapter card that converts Fibre Channel frames to Ethernet frames by encapsulating each Fibre Channel frame into an Ethernet frame. This product is meant to be used for analyzing SPAN traffic from a Fibre channel port on a Cisco MDS 9000 Family switch.

The Cisco MDS 9000 Family Port Analyzer Adapter provides two physical interfaces:

- A Fiber Channel interface that connects to the SPAN port of a Cisco MDS 9000 Family switch
- A 100/1000 Mb/s Ethernet port that forwards the encapsulated Fibre Channel traffic with a broadcast destination MAC Address

The Cisco MDS 9000 Family Port Analyzer Adapter does not support half-duplex mode and for this reason, it will not work when connected to a hub.

The Cisco MDS 9000 Family Port Analyzer Adapter provides the following features:

- Encapsulates Fibre Channel frames into Ethernet frames.
- Sustains 32 maximum size Fibre Channel frames burst (in 100 Mbps mode).
- Line rate at 1Gbps (for Fibre Channel frames larger than 91 bytes).
- 64 KB of onboard frame buffer.
- Configurable option for Truncating Fibre Channel frames to 256 bytes (for greater burst).
Configurable option for Deep Truncating Fibre Channel frames to 64 bytes (best frames burst).

Configurable option for Ethernet Truncating Fibre Channel frames to 1496 bytes (maximum size E-net frames).

Configurable option for No Truncate Mode (sends jumbo frames on E-net side).

Packet Counter (Indicates number of previous packet drops).

SOF/EOF type information embedded.

100/1000 Mb/s Ethernet interface (option on board).

Auto Configuration on power up.

Fibre Channel and Ethernet Link up indicator LEDs.

Checks Fibre Channel frame CRC.

When used in conjunction with the open source protocol analyzer, Ethereal (http://www.ethereal.com), the Cisco MDS 9000 Family Port Analyzer Adapter provides a cost-effective and powerful troubleshooting tool. It allows any PC with an Ethernet card to provide the functionality of a flexible Fibre Channel analyzer. For more information on using the Cisco MDS 9000 Family Port Analyzer Adapter see the *Cisco MDS 9000 Family Port Analyzer Adapter Installation and Configuration Guide*.

### Cisco Fabric Analyzer

The ultimate tool for troubleshooting network protocol problems is the protocol analyzer. Protocol analyzers promiscuously capture network traffic and completely decode the captured frames down to the protocol level. Using a protocol analyzer, you can conduct a detailed analysis by taking a sample of a storage network transaction and by mapping the transaction on a frame-by-frame basis, complete with timestamps. This kind of information lets you pinpoint a problem with a high degree of accuracy and arrive at a solution more quickly. However, dedicated protocol analyzers are expensive and they must be placed locally at the point of analysis within the network.

With the Cisco Fabric Analyzer, Cisco has brought Fibre Channel protocol analysis within a storage network to a new level of capability. Using Cisco Fabric Analyzer, you can capture Fibre Channel control traffic from a switch and decode it without having to disrupt any connectivity, and without having to be present locally at the point of analysis.

The Cisco Fabric Analyzer consists of three main components:

- An agent embedded in the Cisco MDS 9000 Family switches. This agent can be selectively enabled to promiscuously capture designated control traffic.
- A text-based interface to the control and decoded output of the analyzer.
- GUI-based client application that you can install on any workstation to provide a full-function interface to the decoded data.

The text-based interface to the Cisco Fabric Analyzer is a CLI-based program for controlling the analyzer and providing output of the decoded results. Using the CLI, you can remotely access an Cisco MDS 9000 Family switch, using Telnet or a secure method such as Secure Shell (SSH). You can then capture and decode Fibre Channel control traffic, which offers a convenient method for conducting detailed, remote troubleshooting. In addition, because this tool is CLI-based, you can use roles-based policies to limit access to this tool as required.

The GUI-based implementation (Ethereal) can be installed on any Windows or Linux workstation. This application provides an easier-to-use interface that is more easily customizable. The GUI interface lets you easily sort, filter, crop, and save traces to your local workstation.
The Ethereal application allows remote access to Fibre Channel control traffic and does not require a Fibre Channel connection on the remote workstation.

The Cisco Fabric Analyzer lets you capture and decode Fibre Channel traffic remotely over Ethernet. It captures Fibre Channel traffic, encapsulates it in TCP/IP, and transports it over an Ethernet network to the remote client. The remote client then decapsulates and fully decodes the Fibre Channel frames. This capability provides flexibility for troubleshooting problems in remote locations.

The Cisco Fabric Analyzer captures and analyzes control traffic coming to the Supervisor Card. This tool is much more effective than the debug facility for packet trace and traffic analysis, because it is not very CPU intensive and it provides a graphic interface for easy analysis and decoding of the captured traffic.

```
switch# config terminal
switch(config)# fc analyzer local brief
Capturing on eth2
  0.000000  ff.ff.fd -> ff.ff.fd  SW_ILS 1  0x59b7 0xffff  0x7  ->  0xf HLO
  0.000089  ff.ff.fd -> ff.ff.fd  FC  1  0x59b7 0x59c9 0xff  ->  0x0 Link Ctl, ACK1
  1.991615  ff.ff.fd -> ff.ff.fd  SW_ILS 1  0x59ca 0xffff 0xff  ->  0x0 HLO
  1.992024  ff.ff.fd -> ff.ff.fd  FC  1  0x59ca 0x59b8 0x7  ->  0xf Link Ctl, ACK1
```

```
f analyzer example of fully decoded frame.
switch2(config)# fc analyzer local
Capturing on eth2
Frame 1 (96 bytes on wire, 96 bytes captured)
Arrival Time Jan 13, 2003 135038.787671000
Time delta from previous packet 0.000000000 seconds
Time relative to first packet 0.000000000 seconds
Frame Number 1
Packet Length 96 bytes
Capture Length 96 bytes
Ethernet II, Src 00000000000a, Dst 00000000ee00
Destination 00000000ee00 (00000000ee00)
Source 00000000000a (00000000000a)
Type Vegas FC Frame Transport (0xfcfc)
MDS Header(SOFf/EOFn)
    MDS Header
      Packet Len 66
      .... 0000 0001 11.. = Dst Index 0x0007
      .... ..00 1111 1111 = Src Index 0x00ff
      .... 0000 0000 0001 = VSAN 1
    MDS Trailer
      EOF EOPn (3)
    Fibre Channel
      R_CTL 0x02
      Dest Addr ff.fc.7e
      CS_CTL 0x00
      Src Addr ff.fc.7f
      Type SW_ILS (0x22)
      F_CTL 0x290000 (Exchange Originator, Seq Initiator, Exchg First, Seq Last,
      CS_CTL, Transfer Seq Initiative, Last Data Frame - No Info, ABTS - Abort/MS, )
      SEQ_ID 0x11
      DF_CTL 0x00
      SEQ_CNT 0
      OX_ID 0x5a06
      RX_ID 0x0000
      Parameter 0x00000000
    SW_ILS
      Cmd Code SW_RSCN (0x1b)
      0010 .... = Event Type Port is offline (2)
      .... 0000 = Address Format Port Addr Format (0)
      Affected Port ID 7f.00.01
      Detection Function Fabric Detected (0x00000001)
      Num Entries 1
```
Device Entry 0
Port State 0x20
Port Id 7f.00.01
Port WWN 1000000530005f1f (000530)
Node WWN 1000000530005f1f (000530)

However, the Cisco Fabric Analyzer is not the right tool for troubleshooting end-to-end problems because it cannot access any traffic between the server and storage subsystems. That traffic is switched locally on the linecards, and does not reach the Supervisor card. In order to debug issues related to the communication between server and storage subsystems, you need to use Fibre Channel SPAN with an external protocol analyzer.

There are two ways you can start the Cisco Fabric Analyzer from the CLI.

- **fcanalyzer local**—Launches the text-based version on the analyzer directly on the console screen or on a file local to the system.
- **fcanalyzer remote ip address**—Activates the remote capture agent on the switch, where *ip address* is the address of the management station running Ethereal.

For more information about using the Cisco Fabric Analyzer, refer to the *Cisco MDS 9000 Family Configuration Guide*.

### IP Network Simulator

Network simulators let you simulate various kinds of IP data network conditions. A simulator allows you to troubleshoot IP network problems, and can also help you understand the potential impact of additional traffic or specific network conditions to your existing network configuration.

Network simulator is a generic tool that provides simulation features for all Ethernet traffic, and handles full duplex Gigabit Ethernet traffic at full line rate. It is supported on the 8-port IP Storage Services (IPS-8) module and on the 4-port IP Storage Services (IPS-4) module only. It requires the SAN Extension Tuner, which is available in either the SAN extension over IP package for IPS-8 modules (SAN_EXTN_OVER_IP) or the SAN extension over IP package for IPS-4 modules (SAN_EXTN_OVER_IP_IPS4).

The network simulator tool can simulate the following network functions:

- Network delays (maximum network delays of 150 ms)
- Limiting maximum throughput to the given bandwidth
- Finite queue size
- Dropping packets
- Reordering packets

For more information about using the IP Network Simulator, refer to the *Cisco MDS 9000 Family CLI Configuration Guide*.

### Using Other Troubleshooting Products

This section describes products from other vendors that you might find useful when troubleshooting problems with your storage network and connected devices. It includes the following topics:

- Fibre Channel Testers, page B-28
- Fibre Channel Protocol Analyzers, page B-28
Using Host Diagnostic Tools

Send documentation comments to mdsfeedback-doc@cisco.com

Fibre Channel Testers

Fibre Channel testers are generally used to troubleshoot low-level protocol functions (such as Link Initialization). Usually these devices operate at 1- or 2-Gbps and provide the capability to create customized low-level Fibre Channel primitive sequences.

Fibre Channel testers are primarily used to ensure physical connectivity and low-level protocol compatibility, such as with different operative modes like Point-to-Point or Loop mode.

Fibre Channel testers and more generalized optical testers may used to spot broken cables, speed mismatch, link initialization problems and transmission errors. These devices sometimes incorporate higher-level protocol analysis tools and may bundled with generic protocol analyzers.

Fibre Channel Protocol Analyzers

An external protocol analyzer (for example from Finisar), is capable of capturing and decoding link level issues and the fibre channel ordered sets which comprise the fibre channel frame. The Cisco MDS 9000 Family Port Analyzer Adapter, does not capture and decode at the ordered set level.

A Fibre Channel protocol analyzer captures transmitted information from the physical layer of the Fibre Channel network. Because these devices are physically located on the network instead of at a software re-assembly layer like most Ethernet analyzers, Fibre Channel protocol analyzers can monitor data from the 8b/10b level all the way to the embedded upper-layer protocols.

Fibre Channel network devices (HBAs, switches, and storage subsystems) are not able to monitor many SAN behavior patterns. Also, management tools that gather data from these devices are not necessarily aware of problems occurring at the Fibre Channel physical, framing, or SCSI upper layers for a number of reasons.

Fibre Channel devices are specialized for handling and distributing incoming and outgoing data streams. When devices are under maximum loads, which is when problems often occur, the device resources available for error reporting are typically at a minimum and are frequently inadequate for accurate error tracking. Also, Fibre Channel host bus adapters (HBAs) do not provide the ability to capture raw network data.

For these reasons, a protocol analyzer may be more important in troubleshooting a storage network than in a typical Ethernet network. There are a number of common SAN problems that occur in deployed systems and test environments that are visible only with a Fibre Channel analyzer. These include the following:

- Credit starvation
- Missing, malformed, or non-standard-compliant frames or primitives
- Protocol errors

Using Host Diagnostic Tools

Most host systems provide utilities or other tools that you can use for troubleshooting the connection to the allocated storage. For example, on a Windows system, you can use the Diskmon or Disk Management tool to verify accessibility of the storage and to perform some basic monitoring and administrative tasks on the visible volumes.
Alternatively, you can use Iometer, an I/O subsystem measurement and characterization tool, to generate a simulated load and measure performance. Iometer is a public domain software utility for Windows, originally written by Intel, that provides correlation functionality to assist with performance analysis.

Iometer measures the end-to-end performance of a SAN without cache hits. This can be an important measurement because if write or read requests go to the cache on the controller (a cache hit) rather than to the disk subsystems, performance metrics will be artificially high. You can obtain Iometer from SourceForge.net at the following URL:

http://sourceforge.net/projects/iometer/

Iometer is not the only I/O generator you can use to simulate traffic through the SAN fabric. Other popular I/O generators and benchmark tools used for SAN testing include Iozone and Postmark. Iozone is a file system benchmark tool that generates and measures a variety of file operations. It has been ported to many systems and is useful for performing a broad range of file system tests and analysis.

Postmark was designed to create a large pool of continually changing files, which simulates the transaction rates of a large Internet mail server.

PostMark generates an initial pool of random text files in a configurable range of sizes. Creation of the pool produces statistics on continuous small file creation performance. Once the pool is created, PostMark generates a specified number of transactions, each of which consists of a pair of smaller transactions:

- Create file or Delete file
- Read file or Append file

Benchmarking tools offer a variety of capabilities and you should select the one that provides the best I/O characteristics of your application environment.

Utilities provided by the Sun Solaris operating system let you determine if the remote storage has been recognized and exported to you in form of a raw device or mounted file system, and to issue some basic queries and tests to the storage. You can measure performance and generate loads using the `iostat` utility, the `perfmeter` GUI utility, the `dd` utility, or a third-party utility like Extreme SCSI.

Every UNIX version provides similar utilities, but this guide only provides examples for Solaris. Refer to the documentation for your specific operating system for details.
Using Host Diagnostic Tools
The features supported by Cisco MDS SAN-OS have maximum configuration limits. For some of the features, we have verified configurations that support limits less that the maximum. Table C-1 lists the Cisco verified limits and maximum limits for switches running Cisco MDS SAN-OS Release 3.x.

### Table C-1  Cisco MDS SAN-OS Release 3.x Configuration Limits

<table>
<thead>
<tr>
<th>Feature</th>
<th>Verified Limit</th>
<th>Maximum Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device alias</td>
<td>8K per fabric.</td>
<td>20K per fabric.</td>
</tr>
<tr>
<td>Event Traps - forward via Email</td>
<td>Up to 10 destinations.</td>
<td></td>
</tr>
<tr>
<td>ISLB VRRP</td>
<td>20 per switch.</td>
<td>20 per switch.</td>
</tr>
<tr>
<td>NPV switches per NPV core switch</td>
<td>100 switches</td>
<td>100 switches</td>
</tr>
<tr>
<td>VSANs</td>
<td>80 VSANs per physical fabric.</td>
<td>4000 VSANs per physical fabric.</td>
</tr>
<tr>
<td>VSANs per NPV device</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>Switches in a single MDS physical fabric or VSAN</td>
<td>55 switches.</td>
<td>239 switches.</td>
</tr>
<tr>
<td>Switches in a mixed or open physical fabric or VSAN</td>
<td>32 switches.</td>
<td>239 switches.</td>
</tr>
<tr>
<td>Domains per VSAN</td>
<td>40 domains.</td>
<td>239 domains.</td>
</tr>
<tr>
<td>Zone members</td>
<td>16,000 zone members per physical fabric (includes all VSANs).</td>
<td>20,000 zone members per Physical Fabric (includes all VSANs).</td>
</tr>
<tr>
<td>Zones</td>
<td>8000 zones per switch (includes all VSANs).</td>
<td>8000 zones per switch (includes all VSANs).</td>
</tr>
<tr>
<td>Zone sets</td>
<td>500 zone sets per switch (includes all VSANs).</td>
<td>1000 zone sets per switch (includes all VSANs).</td>
</tr>
<tr>
<td>Supported hops for all major storage, server, and HBA vendors</td>
<td>7 hops (diameter of the SAN fabric).</td>
<td>12 hops.</td>
</tr>
</tbody>
</table>
### Table C-1 Cisco MDS SAN-OS Release 3.x Configuration Limits (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Verified Limit</th>
<th>Maximum Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>IVR zone members</td>
<td>4000 IVR zone members per physical fabric.</td>
<td>20,000 IVR zone members per physical fabric in Cisco SAN-OS Release 3.0(3) and later.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10,000 IVR zone members per physical fabric prior to Cisco SAN-OS Release 3.0(3).</td>
</tr>
<tr>
<td>IVR zones</td>
<td>1500 IVR zones per physical fabric.</td>
<td>8000 IVR zones per physical fabric in Cisco SAN-OS Release 3.0(3) and later.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2000 IVR zones per physical fabric prior to Cisco SAN-OS Release 3.0(3).</td>
</tr>
<tr>
<td>IVR zone sets</td>
<td>32 IVR zone sets per physical fabric.</td>
<td>32 IVR zone sets per physical fabric.</td>
</tr>
<tr>
<td>IVR service groups</td>
<td>16 service groups per physical fabric.</td>
<td>16 service groups per physical fabric.</td>
</tr>
<tr>
<td>ISL instances per switch</td>
<td>Up to 200 ISLs, each with 16 VSANs, for a total of 3200 port-VSAN instances.</td>
<td>Up to 200 ISLs, each with 16 VSANs, for a total of 3200 port-VSAN instances.</td>
</tr>
<tr>
<td></td>
<td>You can configure more than 200 ISLs with fewer than 16 VSANs, or fewer than</td>
<td>You can configure more than 200 ISLs with fewer than 16 VSANs, or fewer than</td>
</tr>
<tr>
<td></td>
<td>200 ISLs with more than 16 VSANs, within the total ports per VSAN instance</td>
<td>200 ISLs with more than 16 VSANs, within the total ports per VSAN instance</td>
</tr>
<tr>
<td></td>
<td>limit of 3200.</td>
<td>limit of 3200.</td>
</tr>
<tr>
<td>IP ports per switch</td>
<td>No limits.</td>
<td>No limits.</td>
</tr>
<tr>
<td>Fibre Channel modules vs. IPS modules</td>
<td>No limits.</td>
<td>No limits.</td>
</tr>
<tr>
<td>per switch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>iSCSI and iSLB sessions per IP port</td>
<td>500 sessions.</td>
<td>500 sessions.</td>
</tr>
<tr>
<td>iSCSI and iSLB sessions per switch</td>
<td>5000 sessions.</td>
<td>5000 sessions.</td>
</tr>
<tr>
<td>iSCSI and iSLB initiators supported in</td>
<td>2000 initiators.</td>
<td>2000 initiators.</td>
</tr>
<tr>
<td>physical fabric</td>
<td></td>
<td></td>
</tr>
<tr>
<td>iSCSI and iSLB targets per physical</td>
<td>6000 targets.</td>
<td>6000 targets.</td>
</tr>
<tr>
<td>fabric (virtual and initiator targets)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SANTap ITLs per DPP</td>
<td>1024</td>
<td>1024</td>
</tr>
<tr>
<td>(initiator/target/LUN tuple)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SANTap ITLs per SSM</td>
<td>1024</td>
<td>1024 in Cisco SAN-OS Release 3.0(2)).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2048 in Cisco SAN-OS Release 3.1(2m).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4080 in Cisco SAN-OS Release 3.1(3) and later.</td>
</tr>
</tbody>
</table>

1. Certain design considerations must be met to reach this limit. We recommend that you have the large Fabric design validated by Cisco Advanced Services.

2. This is the number of trunking-enabled ISL ports multiplied by the number of VSANs in the switch.

3. SANTap is not supported in SAN-OS Release 3.3(1).
INDEX

A
AAA 17-1
   initial checklist 16-7, 17-1
   troubleshooting with Cisco ACS 17-11
ACS
   troubleshooting AAA 17-11
   using with FC-SP 19-7
administrator password, recovering 2-32
authentication, authorization, and accounting. See AAA
AutoNotify
   registration 25-1
   service contract requirements 25-3

B
BB_credits 8-3, 8-8, 8-10
best practices
   software installation 2-2
   upgrading 2-2
   VSANs 11-1
BIOS 2-14
blank commit 15-7
blocking ports 16-6
bootflash
   recovering corrupted 2-14 to 2-15
   recovery from loader 2-16
   recovery using BIOS setup (procedure) 2-16
   recovery with dual supervisors 2-23
SSM 3-5
border switch fails 13-10
buffer-to-buffer credits
   See BB_credits

C
Call Home
   alert groups 25-2
   destination profiles 25-1
Call Home alert groups
   configuring 25-2
   customizing 25-2
Call Home contacts
   assigning information 25-7
Call Home messages
   configuring levels 25-2
CFS
   checking distribution status 7-9
   checking the configuration 7-3
   conditional service regions 7-11
   distribution failure 7-10
   lock failure 7-7
   merge fails 7-5
   overview 7-1
   partitioned fabrics 7-3, 7-5
   regions 7-10
   troubleshooting checklist 7-2
   verifying with CLI (procedure) 7-3
   verifying with Fabric Manager (procedure) 7-3
Cisco Fabric Services. See CFS
CLI
   common troubleshooting commands 1-4
   debug commands 8-2
   clock modules 4-12
   commit fails
      device alias 15-3, 15-11
      SDV 12-3
configuration limits
  description (table) C-1
connectivity
  basic 1-4
  end-to-end 1-5
  ports 1-6
  using Device Manager 1-6
  using Fabric Manager B-15
  verifying B-15
contact information
  assigning for Call Home 25-7
Control Unit Port. See CUP
core dumps A-5
CUP
  blocking restriction 16-6
  in-band management 16-1
CUP in-band management
  description 16-6
customer support, collecting information A-1

D

destination profiles
  configuring 25-1
device alias
  commands 15-3
  commit fails 15-11
  database conflicts 15-12
  database size limitations 15-4, 15-14
  enhanced mode limitations 15-3
  failure messages 15-2, 15-3
  merge fails 15-4
  merge limitations 15-4
  merging mixed fabrics 15-7
  troubleshooting checklist 15-1
  using blank commit 15-7
  validation fails 15-11
  VSAN limitations 15-3
Device Manager
  password issues 26-13
  port oversubscription 1-8
digital certificates
  configuring using Fabric Manager (procedure) 24-5
  configuring using the CLI (procedure) 24-7
  identity certificate 24-4
  importing using Fabric Manager (procedure) 24-11
  initial checklist 24-3, 25-3
  maximum limits 24-3
  overview 24-1
  PKCS#12 format 24-5
documentation
  additional publications i-xxx
domains
  domain ID failure 8-3
  domainID overlap 11-18
  domain manager disabled 8-3
  isolation due to overlap 8-3
  maximum number in a VSAN C-1
  switch isolated 11-18
DPVM
  autolearn not working 11-12
  cannot be configured 11-11
  cannot copy active database to config database 11-14
  config database not activating 11-14
  database not distributed 11-12
  guidelines 11-10
  merge failed 11-15
  no autolearn entries 11-13
  port suspended 11-15
  port VSAN not in database 11-13
  troubleshooting with CLI 11-11
  troubleshooting with Fabric Manager 11-10

E

EFMD 19-2
  fabric binding 16-6
EISLs
Send documentation comments to mdsfeedback-doc@cisco.com

PortChannel links 10-1
trunking 10-2
e-mail addresses
assigning for Call Home 25-7
EPLD images 3-9
E ports
isolation 8-3
Exchange Fabric Membership Data
see EFMD 19-2
Exchange Fabric Membership Data. See EFMD 16-6
extended ISL. See EISLs

F

Fabric Analyzer B-25
fabric binding
configuring using Fabric Manager (procedure) 19-19
configuring using the CLI (procedure) 19-20
EFMD 16-6
initial checklist 19-3
overview 19-2
verifying configuration using Fabric Manager
(procedure) 19-18
verifying configuration using the CLI
(procedure) 19-18
verifying violations using Fabric Manager
(procedure) 19-16
verifying violations using the CLI (procedure) 19-17
fabric configuration
analyzing with Fabric Manager B-16
status 1-5
Fabric Manager
checking in Fabric Manager Server license 6-10
map layout 26-4
problems 26-2
recommended JRE version (table) 2-5
troubleshooting tools 1-3
using over FCIP 26-5
using with multiple NICs 26-5
using with proxy server 26-6
will not start 2-5
Fabric Manager Web Client
passwords 26-11
fans
LED is red 4-8
not spinning 4-8
FC ID, changes after link reset 2-34
FCIP
ISL link failures 20-34
link down 2-33
one-to-three tunnels 20-20
reload causes reboot 2-33
special frame configuration 20-30
troubleshooting 20-9
FC-MAC driver
See ports
FC ping B-5
FC-SP
initial checklist 19-2
overview 19-1
using ACS 19-7
verifying configuration using Fabric Manager
(procedure) 19-5
verifying configuration using the CLI
(procedure) 19-5
verifying database using Fabric Manager
(procedure) 19-5
verifying database using the CLI (procedure) 19-6
FC timer
resolving with CLI 11-9
resolving with Fabric Manager 11-9
FC trace B-5
Fibre Channel Security Protocol
See FC-SP 19-1
Fibre Connection. See FICON
FICON
configuration files 16-5
configuring 16-1
CUP in-band management 16-6
Send documentation comments to mdsfeedback-doc@cisco.com

**FC4 protocols**  16-1

port numbering  16-2 to 16-5

port swapping  16-8 to 16-9

**FICON configuration files**

description  16-5

**FICON port numbers**

default numbering scheme  16-2

reserved numbering scheme  16-4

**FICON ports**

swapping  16-9

**Flow Wizard**  26-12

forgot a password  26-11

**FSPF**

mismatched dead interval  11-31

mismatched retransmit interval  11-30

region mismatch  11-32

traffic not being routed  11-28

troubleshooting  11-24

wrong hello interval  11-28

**iSCSI**

troubleshooting  4-13

**IKE**

allowed transforms (table)  22-3

debugging  22-15

overview  22-1

verifying configuration compatibility  22-6

images

See software

**in-band management**

CUP  16-6

**IP addresses**

SMTP server  25-6

**IP network simulator**  B-27

**IP ports**

maximum number in a switch  C-2

**IPsec**

allowed transforms  22-4

clearing SAs  22-15

compatibility  22-1

initial checklist  22-4

overview  22-1

SAs  22-12

SPD compatibility  22-8

statistics  22-15

supported platforms (table)  22-3

troubleshooting  22-5

verifying configuration  22-6, 22-7

**IP security. See IPsec**

**IP services**  20-5

iSCSI

---

**G**

**Generation 2 modules**

best practices  5-7

overview  5-1

port groups  5-2

port speeds  5-3

troubleshooting checklist  5-7

**grace period**

See licenses

guidelines

port swapping  16-8

**H**

**hardware**

overview  4-1

startup issues  4-2
Send documentation comments to mdsfeedback-doc@cisco.com

<table>
<thead>
<tr>
<th><strong>RADIUS</strong></th>
<th><strong>20-38</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>target discovery</td>
<td><strong>B-19</strong></td>
</tr>
<tr>
<td>TCP</td>
<td><strong>20-48</strong></td>
</tr>
<tr>
<td>troubleshooting authentication</td>
<td><strong>20-35</strong></td>
</tr>
<tr>
<td>troubleshooting dynamic configuration</td>
<td><strong>20-41</strong></td>
</tr>
</tbody>
</table>

| **username and passwords** | **20-37** |

<table>
<thead>
<tr>
<th><strong>iSCSI initiators</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number in a fabric</td>
</tr>
</tbody>
</table>

| **iSCSI initiator targets. See iSCSI targets** |

<table>
<thead>
<tr>
<th><strong>iSCSI sessions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number on a port</td>
</tr>
<tr>
<td>maximum number on a switch</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>iSCSI targets</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number in a fabric</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>iSLB initiators</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number in a fabric</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>iSLB initiator targets</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number in a fabric</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>iSLB sessions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number on a port</td>
</tr>
<tr>
<td>maximum number on a switch</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ISLs</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number in a switch</td>
</tr>
</tbody>
</table>

| **IVR** | **13-10** |
|----------|
| border switches | **13-2** |
| cannot enable | **13-7** |
| CFS merge failed | **13-15** |
| IVR Wizard | **13-15** |
| licenses | **13-6** |
| link isolated | **13-12** |
| locked CFS session | **13-13** |
| LUN | **13-13** |
| NAT fails | **12-4, 13-8** |
| no write access | **13-13** |
| overview | **13-1** |
| persistent FC IDs | **13-12** |
| release-specific support (table) | **13-5** |
| restriction | **23-2** |
| restrictions | **13-2** |

| **SDV limitations** | **12-2** |
|---------------------|
| traffic blocked | **13-11** |
| transit VSANs | **13-2** |
| troubleshooting checklist | **13-3** |
| verifying with CLI | **13-4** |
| verifying with Fabric Manager | **13-3** |
| zone set activation fails | **13-9** |

<table>
<thead>
<tr>
<th><strong>IVR zones</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number of members</td>
</tr>
<tr>
<td>maximum number of zones</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>IVR zone sets</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>maximum number</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>K</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>kickstart images</td>
</tr>
<tr>
<td>recovery for Supervisor-1</td>
</tr>
<tr>
<td>recovery for Supervisor-2</td>
</tr>
<tr>
<td>selecting for supervisor modules</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>L</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>licenses</td>
</tr>
<tr>
<td>checking in Fabric Manager Server license</td>
</tr>
<tr>
<td>displaying with CLI</td>
</tr>
<tr>
<td>displaying with Fabric Manager</td>
</tr>
<tr>
<td>displaying with Fabric Manager Web Services</td>
</tr>
<tr>
<td>feature-based</td>
</tr>
<tr>
<td>grace period</td>
</tr>
<tr>
<td>grace period expiration</td>
</tr>
<tr>
<td>incorrect number installed</td>
</tr>
<tr>
<td>initial checklist</td>
</tr>
<tr>
<td>missing</td>
</tr>
<tr>
<td>module-based</td>
</tr>
<tr>
<td>one-click install fails</td>
</tr>
<tr>
<td>serial numbers</td>
</tr>
<tr>
<td>transfer between switches</td>
</tr>
<tr>
<td>unexpected grace period warnings</td>
</tr>
</tbody>
</table>
limits
  description (table) C-1
lock failure
  See CFS
logs 1-13
  Device Manager 1-14

M
merge fails
  CFS 7-5
  SDV 12-6
  syslog messages 15-2
modules
  initialization 4-22
  not detected by supervisor 4-35
  powered down 4-26
  reinitialize using CLI 4-37
  reinitialize using Fabric Manager (procedure) 4-36
  reloaded 4-31
  resets 4-38
  troubleshooting 4-21
  troubleshooting (procedure) 4-25
  unknown state 4-34

N
network simulator B-27
NPV
  CLI commands 9-2
  core switch 9-6
  end device login 9-4
  initial checklist 9-2
  NPIV 9-5
  restrictions 9-2
  VSAN mismatches 9-5

O
OBFL
  configuring for a module B-12
  configuring for the switch B-11
  description B-10
  displaying configuration status B-12
  displaying logs B-13
  on-board failure logging. See OBFL
  oversubscription 1-8

P
PAA B-24
  passwords 26-11
Port Analyzer Adapter
  See PAA
PortChannels
  description 10-1
  initial checklist 10-2
  load balancing 10-1
  port groups 5-2
  port indexes 5-4
  freeing up indexes 5-6
  Generation 1 limitations 5-5
  Generation 2 maximum 5-6
  requirements (table) 5-6
  verifying with CLI (procedure) 5-9
  verifying with Device Manager (procedure) 5-8
Port Manager
  See ports
ports
  bounce between initializing and offline 8-26
  cycles through up and down states 8-31
  dedicated mode bandwidth (table) 5-3
  DPVM membership not in database 11-13
  ELP issues 8-27
  error disabled 8-31
Send documentation comments to mdsfeedback-doc@cisco.com

**Index**

- FC-MAC CLI commands 8-11
- FC-MAC driver 8-4
- flapping 8-21
- Fx failure 8-32
- initializing state 8-16
- isolation after zone merge 8-28
- link-failure state 8-14
- link initialization flow 8-23
- out of service 5-4
- oversubscription information 1-8
- overview 8-1
- port groups 5-2
- port indexes
  - description 5-4
- Port Manager 8-5
- restrictions 8-4
- shared mode bandwidth (table) 5-3
- speeds for Generation 2 modules 5-3
- suspended 11-15
- troubleshooting checklist 8-1, 9-2
- troubleshooting with CLI 8-10
- troubleshooting with Device Manager 8-6
- verifying bandwidth with Device Manager (procedure) 5-11
- verifying bandwidth with the CLI (procedure) 5-12
- port security
  - configuring using Fabric Manager (procedure) 19-14
  - configuring using the CLI (procedure) 19-15
  - disabling autolearn using Fabric Manager (procedure) 19-13
  - disabling autolearn using the CLI (procedure) 19-13
- initial checklist 19-2
- overview 19-2
- verifying database using CLI (procedure) 19-9
- verifying database using Fabric Manager (procedure) 19-9
- verifying violations using Fabric Manager (procedure) 19-10
- verifying violations using the CLI (procedure) 19-11
- power supplies
  - Fan ok LED is red 4-6
  - LED is red 4-5
  - LEDs off 4-4
  - output failed LED on 4-6
- troubleshooting 4-7
- processes, monitoring B-7
- process resets 2-26

**R**

- RADIUS B-21
  - configured parameters 17-4
  - verifying configuration using Fabric Manager (procedure) 17-4
  - verifying server groups using Fabric Manager (procedure) 17-9
  - verifying server groups using the CLI (procedure) 17-9
  - verifying server monitor using Fabric Manager (procedure) 17-6
  - verifying server monitor using the CLI (procedure) 17-6
  - related documents i-xxx

- RMON B-17
  - roles, admin 2-34

**S**

- SAN registration 1-5
- SANTap
  - acronyms 23-2
  - CLI commands 23-4
  - Fabric Manager tools 23-4
  - host login problems 23-7
  - initial checklist 23-3
  - interface restrictions 23-3
limitations 23-2
mismatch problems 23-7
restrictions 13-2
terms 23-2

SDV
commit fails 12-3
IVR limitations 12-2
merge fails 12-6
troubleshooting checklist 12-1
verifying with CLI 12-2
zone activation fails 12-6

security associations
See SAs

security policy databases
See SPDs

serial numbers 6-2
finding with CLI 6-7
finding with Fabric Manager 6-6

services modules
SSM 3-1

SNMP B-19
assigning contact names 25-7

software
core dumps A-5
corrupt image 2-14
disruptive upgrades 2-4
error state 2-14
incompatibility 2-7
installation best practices 2-2
install error 2-9
overview 2-1
power on or reboot fails 2-13
recognizing errors 2-26
recoverable restart 2-27
resets 2-26
unrecoverable restart 2-31
upgrading best practices 2-2
verifying installation 2-6
software images, selecting for supervisor modules 5-13

Software Installation Wizard (procedure) 2-10
SSI boot images
configuring with install ssi command 3-6
verifying 3-5
SSI boot variables
verifying configuration 3-7

SSM
description 3-1
Features per release (table) 3-2
initial checklist 3-3
modflash 3-5
nondisruptive upgrades (table) 3-2
overview 3-1
recovery after replacing CompactFlash 3-8
replacing (procedure) 3-8
upgrade or downgrade (procedure) 3-5
upgrade with install ssi command 3-6
upgrading ELPD image 3-9
verify SSI boot image (procedure) 3-5

statistics gathering 26-12
storage services module
See SSM 3-1

Supervisor-1 modules
selecting software images 5-13

Supervisor-2 modules
select software images 5-13

supervisors
active reboots 4-15
standby in powered-up state 4-19
standby not recognized 4-17
troubleshooting 4-14

switches
maximum numbers C-1
switch health analysis B-14

syslog
See system messages

system health failure 2-33
system images
selecting for supervisor modules 5-13
Send documentation comments to mdsfeedback-doc@cisco.com

system messages
  overview 1-10, B-21
  using CLI 1-12
  using Fabric Manager 1-11
  viewing from Device Manager 1-14

T

TACACS+
  verifying configuration using Fabric Manager (procedure) 17-5
  verifying configuration using the CLI (procedure) 17-5
  verifying server groups using Fabric Manager (procedure) 17-9
  verifying server groups using the CLI (procedure) 17-10
  verifying server monitor using Fabric Manager (procedure) 17-7
  verifying server monitor using the CLI (procedure) 17-7
TCP ports, ACLs 21-2
temperature violations 4-11
Threshold Manager B-17
trace route
  See FC trace
troubleshooting
  common CLI commands 1-4
  common Fabric Manager tools 1-3
  domain ID conflicts 11-17
  FCIP connections 20-9
  flowchart 1-9
  FSPF issues 11-24
  hardware problems 4-13
  IP services 20-5
  iSCSI issues 20-35
  modules 4-21
  overview 1-3
  power supplies 4-7
  SSM recovery 3-8

switching and services modules 4-20, 4-25
  symptoms 1-9
  VSAN isolation 11-7
trunking
  initial checklist 10-2
  overview 10-2
  TE port restrictions 10-2

U

unblocking ports 16-6
users and roles
  initial checklist 18-4

V

validation fails
  device alias 15-11
VSANs
  allowed-active 10-2
  best practices 11-1
  host cannot communicate with storage 11-3
  interop modes 11-9
  limits C-1
  mismatches 8-3
  rules and features 18-3
  switch isolated 11-18
  trunk-allowed 10-2
  xE port isolated 11-5
VSAN trunking. See trunking

W

WWNs, suspended connections 8-4

Z

zone
zones
  cannot configure enhanced zoning 14-22
  database distribution 14-11
  enhanced 14-21
  enhanced zoning lock issues 14-23
  host cannot communicate with storage 14-5
  link isolation 14-15
  maximum number in a switch C-1
  maximum number of members C-1
  merge failure 8-3, 14-13
  merging B-16
  mismatched active zone sets 14-17
  mismatched default zone policy 14-12
  port isolation 8-28
  troubleshooting checklist 14-1
  troubleshooting with CLI 14-2
  troubleshooting with Fabric Manager 14-2
  zone set activation 14-8